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About this Document

1. Screen Captures
This document features screen captures of the Minimal Arkoon Configuration (minarkconf) application.
Screen content may vary slightly in appearance depending on which model of the Arkoon FAST360 UTM
appliance series you are configuring.

2. Appliance Models
This guide provides information on how to configure the complete range of FAST360 appliances.
Information specific to the different models is highlighted as follows:
Information tagged with this marker is relevant only for A10 to A2100 appliances.
Information tagged with this marker is applicable only to Network Processing Appliances, Small, Medium
and Large, introduced in version 5.0 of the FAST360 UTM appliances.
Information tagged with this marker is specific to appliances A2200 and A5200.

3. Knowledge Base
Arkoon Knowledge Base is also available from the following address: http:\\client.arkoon.net. It provides
information on specific problems that cannot be handled in the current documentation.

Screen Captures
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Chapter 1. Security on FAST360 appliance
The following recommendations are designed to ensure maximum safety for you and your FAST360
appliance. Additional safety recommendations are also available in the First-Time Configuration Guide.

1.1. Security Instructions
Important
In case of a security issue, contact Arkoon security center : http://www.arkoon.net/-Securitycenter-.html

1.1.1. FAST360 Appliance Environment
Install your FAST360 in a secure room with the following characteristics:
• the room access must be authenticated, logged and controlled by the administrator
• the room must be locked with a key, digocode, card, etc
• the room must be protected against intrusion (alarm, secured windows, etc.)
• the room must respect the security standards regarding the electrical installation (executed by a
competent electrician)
• the room must be protected against fires
• the room must be equipped with air conditioning ensuring acceptable operating temperatures for the
appliance (see specifications)
• the electrical power must be regulated to protect the appliance against lightning, tension variations
and power cuts
• the environment must be organised in such a way no physical element put the users in jeopardy:
• the machines must be in a stable position
• the cables must not be across the way

1.1.2. Electrical Security
Respect the following electrical security instructions when installing or manipulating the FAST360
appliance:
• always stop and disconnect the appliance before moving it. The power cable and the power plugs
must be easily accessible at all times
• only the power cable provided with the appliance must be used
• the FAST360 appliance has no spare parts. The maintenance or repairs must only be executed by
qualified people who know the risks related to manipulating computer and electronic hardware

Security Instructions
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1.1.3. Physical Security
Respect the following physical safety practices regarding mechanical and physical aspects when
installing or manipulating the FAST360 appliance:
• to ensure its performance and integrity, the appliance must not be placed close to a source of heat or
into a humid environment and it shall be properly ventilated
• all the plugs of the connection cables must be screwed in or tightly fastened to the rack, under the
control of the FAST360 administrator
• the FAST360 appliance must be used in horizontal position
• the FAST360 appliance must not be used if the device has visible damage

Important
In this case, the FAST360 appliance must be unplugged and protected against any deliberate
action. The appliance must be left in an environment that is as safe as the operation
environment (physical access).
• all repairs must be executed only by the personnel authorized by ARKOON Network Security. In case of
problem or breakdown, contact your support reseller or Arkoon Technical Support if your maintenance
contract covers it.
• in case of technical failure, you must follow a customer service standard procedure by calling the
ARKOON Technical Support. The hardware will then be restored or replaced as per the terms of the
warranty.

1.2. Security Hypotheses
When using a FAST360 appliance, it is supposed the following security conditions are respected:
• the administrator can be trusted and he/she is a non hostile person trained to his tasks
• the FAST360 equipment as well as the supports containing the FAST360 parts must be in a secure room,
accessible only by the administrator
• the FAST360 environmnent must enable to authenticate the administrator for the appliance remote
accesses
• the administrator must regularly consult the audit logs generated by the firewall and he/she handles
the audits to avoid data loss
• the administrator must handle the alarms generated and sent by the firewall
• the administrator must regularly consult the audit logs generated by the VPN component and he/she
handles the audits to avoid data loss
• the administrator must control or regenerate the hardware and software firewall configuration
(services and goods) according to a reference state
• the administrator must control or regenerate the VPN component hardware and software
configuration (services and goods) according to a reference state
• the administrator must handle the alarms handled and sent by the VPN component
• the cryptographic keys generated outside the FAST360 appliance and uploaded into, must have
been generated according to the recommandations specified in the French Network and Information
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Security Agency (FNISA or ANSSI in French, standing for "Agence Nationale de la Sécurité des
Systèmes d’Information") reference documents for the standard resistance level

1.3. Security Rules
1.3.1. Password Security Rules
A safe password policy is required to ensure the security of your FAST360 appliance.
Passwords used on FAST360 devices must be at least 8 digits long and include at least three of the
following four different types of characters:
• lowercase characters [a-z]
• uppercase characters [A-Z]
• numbers [0–9]
• any special characters (@, #,$,...)

Important
Change the root password and the passwords of users with administrative rights frequently.
Keep passwords in memory or in a location with a level of security at least as high as the one for
the function for which they are intended (avoid post-its or saving them in an unsecured file).

Passwords used on FAST360 Appliance
Several password are used on the FAST360 appliance to protect or encypt accounts or files.
Root Password. The root password corresponds to the login for the root user, or superuser.

Warning
The root user, or superuser account is allowed to access and modify anything from the interface.
To avoid configuration damages as well as a weakness on the security level applied on FAST360
appliance, it is crucial to ensure only the authorized and reliable persons can get access.
PEM Phrase. Password that encrypts the private key of the Certification Authority (entity managing
the certificates). If this password is lost, a complete reset of the Certificate Authority (CA) is required.
A complete reset of the Certificate Authority (CA) impacts all devices or applications that request
certificates from the FAST360 appliance set as a Certificate Authority (CA). As a consequence, you will
have to create all the certificates again (appliance, administrator, VPN).

Note
If you initialize the FAST360 appliance using the desktop wizard, the PEM Phrase will be identical
to the root password.
Passwords for PKCS#12 files . Files containing PKCS#12 file passwords need to be stored in such a way
that only authorized users can access them. This applies to PKCS#12 files used in the following situations:
• authentication in administration with Arkoon Manager and Arkoon Monitoring .
• authentication in flow rules
• authentication for VPN connections

Security Rules

| 23

Chapter 1. Security on FAST360 appliance

• authentication of another FAST360 appliance

1.3.2. Administration Console
The remote administration console allows the authorized and authentified administrator to detect any
event related to the FAST60 appliance security and to consult the audit logs.

1.3.3. Admin from Console
The Admin from control option allows the administrator to define the IP address(es) allowed to remotely
manage the FAST360.

1.3.4. Access Information
The physical access to the FAST360 appliance shall be of a level of security superior or equivalent to the
level for access in the remote administration mode. To keep track of physical accesses to the FAST360
appliance, we recommend that you record all the characteristics of these manipulations in an installation
booklet.

1.3.5. Integrity Control for A range
—The following information is applicable only for appliances in the A10 to A2100 range.
The software integrity of your system can be checked after the installation by comparing the system
signature of your FAST360 appliance with the one calculated by the following command in terminal mode
on the device:
(cd / ; tar –cf - `ls | grep –v "config_card$\ | ^dev$\ | ^mnt$\ | ^os.backup$\ |
^proc$\ | ^tmp$\ | ^var$\ | ^vtmp$" ) | md5sum

Note
This procedure can only be used to verify the initial installation. It will not correctly verify the
system version following a system update.

1.3.6. Recommended initial configuration method
To guarantee the highest level of security, use the minarkconf (Minimal arkoon configuration) application.
For more details, refer to the First configuration guide.

1.4. Cryptographic Mechanisms
The FAST360 product allows a large number of cryptographic algorithms and key sizes for compatibility
with existing products. However, it is strongly recommended that only the algorithms and key sizes
considered the most robust to date. We recommend you only use the following algorithms:
• AES in CBC mode with 256-bit keys
• RSA with 4096-bit keys as a minimum
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• Diffie-Hellman with 2048-bit groups as a minimum
• HMAC SHA-2 or HMAC SHA-1

Cryptographic Mechanisms
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2.1. Introduction
2.1.1. Overview
FAST360 appliances are designed to protect your network from most of the threats due to your internet
connections. FAST360 appliances implement many security services detailed in this manual.
Before you start to configure the appliance, it is recommended to read the basic concepts and understand
how they are implemented in the architecture.

Configuration and management of FAST360 appliances
Arkoon provides a suite of GUI-based software tools, Arkoon Tools, to facilitate management, monitoring,
and maintenance of FAST360 appliances. Arkoon Tools is available for Windows and Linux and includes 3
programmes for FAST360 management. The configuration and management are based on objects. Hosts,
users, rules, timeslots, etc. are defined as objects that can be added to the configuration of individual
or multiple FAST360 appliances.
This approach greatly simplifies the configuration and management, particularly when deploying multiple
applications on the server. You simply need to identify once the users or specific hosts, such as the DNS
server, so that they are then "preconfigured" for the integration to the configuration of all network FAST360
appliances. The installation and use of Arkoon tools are described in details in the First Configuration
Guide and Section 3.5, “Using Arkoon Manager”.

2.1.2. Security Services Overview
The Arkoon FAST360 UTM appliances provide a set of security services that together protect your
network infrastructure and the information communicated through your network from a number of
different types of threat. FAST360 appliances incorporate application level (layer 7) and layer 3/4
stateful firewalling, dynamic routing, intrusion detection and prevention, email, web and FTP antivirus,
antispam, URL filtering, IPsec VPN (with optional IPsec acceleration on certain models) and bandwidth
management.
The following table lists the services provided by the FAST360 appliance. Each of these services is
described in more details in the following sections of this chapter.

Introduction

| 27

Chapter 2. Services overview

Table 2.1. FAST360 Appliance Services
Service

Description

Network layer security: Network Prevents IP addresses of devices on the internal network
Address Translation (NAT), Port Address from being visible externally, so that your network topology
Translation (PAT)
and individual devices cannot be detected.
Filtering rules

Sets rules for handling network traffic according parameters
including source and destination addresses, scheduling,
user IDs etc. Provides antispoofing.

FAST protocol analysis and filtering

Checks compliance with protocol definitions and standards.
Protects against non-standard information hidden within
data communicated.

Intrusion detection and prevention (IDPS) Detects and neutralizes attacks based on application
vulnerabilities.

28

ICMP flow management

Prevents the use of ICMP to detect information about your
network.

Proxy services

Enable content filtering (antivirus, antispam, etc.) and
authentication for network traffic using various applicationlevel protocols.

DNS Blacklists

Block communication with IP addresses known to be
sources of spam or other unwanted data.

User authentication

Verify the identity of the source of a communication. Protects
against masquerading.

Bandwidth management

Set limits on bandwidth that can be used by a data flow.
Protects against denial of service attacks by high volume.

Routing

Provide IP routing services.

Virtual Private Networking (VPN)

Use IPsec VPN tunnels for secure site-to-site or remote
connectivity.

Service updates

Download updates for antivirus, blocked addresses,
intrusion detection services, and for the FAST360 system.
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This chapter looks at the management software provided for FAST360 appliances, explaining how
to install the software, giving an overview of key features of the management software, and explaining
how to define administrative roles and maintain the security of your FAST360 management environment.

3.1. Introduction to Arkoon Tools
Arkoon provides a suite of GUI-based software tools, Arkoon Tools, to facilitate management, monitoring,
and maintenance of FAST360 appliances. Arkoon Tools includes three programmes for FAST360
management:
Arkoon Manager

Arkoon Manager is the interface for FAST360 appliance configuration.
It also includes modules for managing administrative roles and
sessions.

Arkoon Monitoring

Arkoon Monitoring is the interface for day-to-day monitoring of
FAST360 activity, including logs and alerts and real-time appliance
status monitoring (load, performance, etc).

Arkoon Reporting

Arkoon Reporting is used to consolidate FAST360 appliance activity
reports, with multiple options to filter data and generate graphical
summaries and visual indicators of network activity for reporting and
planning purposes.

For more details on Arkoon Tools installation, see the First-Time Configuration Guide.

3.2. Arkoon Manager Workflow
3.2.1. Disconnected Mode
In disconnected mode, only the Session Manager and the Offline Security Policy Manager menus are
available.

Introduction to Arkoon Tools
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Session Manager

Session Manager menu provides access to the Session Manager.
From the Session Manager, a successful Connect action takes the
administrator to the Connected menu.

Offline Security Policy Manager

A new configuration can be created or a local configuration loaded
using the Offline Security Policy Manager menu.

Note
A security policy which has been edited while disconnected can only be saved locally.

3.2.2. Connected Mode
In connected mode, the Online Security Policy Manager, Online Access Control Manager and
Certificate Authority Manager menus are available. The Session Manager is not available.
The administrator might not be authorized to access all applications depending upon their roles.
Online Security Policy Manager

A security policy is loaded from the appliance/
AMC server. Only an authenticated Security Officer
can load a local security policy. Hence, only an
authentified Security Administrator will be able to
apply a configuration file stored locally.

Roles Manager

The Roles Manager application is accessible only
if the authenticated administrator is a Security
Officer.

Certificate Authority Manager

The Certificate Authority Manager application is
accessible only if the authenticated administrator
is a Security Officer or a Security Administrator.

For more details on roles and administration rights, see Section 4.2, “Managing Administrator Rights”.

3.3. Arkoon Manager GUI Principles
This section describes the features that are common to the four sub-applications (Sessions,
Configurations, Roles, and Certificate Authentication) which make up Arkoon Manager .

3.3.1. Overview of the Interface
This section gives an overview of the interface, including:
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Menus

Application Menu
From the menu bar, click Application. From this menu, you can access the commands described below:
Command

Description

New document

This command is used to create a new configuration file. Click New document.

Note
When not connected to a FAST360 appliance or AMC server, this command can
be used to create a blank configuration file.
In connected mode, Arkoon Manager proposes to synchronize hardware and system
information available at the remote FAST360 appliance or AMC server. The following
parameters are synchronized:
• all known appliances, including slave appliances
• for each appliance synchronized:
• the hardware characteristics: CPU, RAM, Hard disk size, Serial number, Ethernet
interfaces
• system parameters: hostname, version, license, X.509 certificate
• network parameters: IP addresses and static routes, DNS servers, authorized
administration IP sources
• internet Accesses
• the clustering mode: HA, HA Cluster, HP Cluster
• the list of known IP services
• the list of known FAST modules
• the list of known IDPS profiles and signatures
Unless you wish to start with a new empty configuration, it is advisable to work
with the current configuration which is automatically highlighted in the list of remote
configurations.
Save encrypted

This command can be used to save a report of the current configuration encrypted by
a password. Click Save encrypted.

Import objects from file This command can be used to import objects from one configuration to the other. It only
imports one object level but all the references to other objects are deleted from imported
objects. This command is very useful to import hosts and networks.
Load
configuration
appliance
Download

legacy This command is used to either import a configuration from file or from a FAST360
from appliance.
In connected mode, this command is used to download a configuration file from the
firewall. Click Download.

Overview of the Interface
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Command

Description

Preferences

This command takes the administrator to the Preferences option; for more details, see
Section 3.3.4, “Customizing the Interface”.

Find Menu
The Find menu can be used to locate configuration objects. These features are described in detail in
Section 3.3.3, “Searching Configurations”.
Command

Description

Find origin item This command is used to find where the configuration object belongs in the explorer view.
Find
references
Find
items

This command is used to locate where configuration objects are used in the configuration.

unused This command is used to find unused items of a configuration.

Advanced
search

This command can be used to search by object type, name, description, etc.

Window Menu
The Window menu provides access to the different windows that make up the interface:
Workspace

From the Workspace menu, you can restore the default layout or take
a screenshot.

Explorers

From the Explorers menu, you can access all explorers, or
configuration tabs, of the application that you are working in.

Editors

From the Editors menu, you can access the editors, or configuration
forms, of objects which are open for editing.

Tools

From the Tools menu, you can access the window of any tools that are
open, e.g. the Check coherency window.

Actions Menu
The Actions menu features the following commands.
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Command

Description

Check
configuration

This command is used to check that the configuration is coherent before
deploying it. If the configuration is coherent, the Configuration ok dialog
box is displayed. If the configuration is incoherent, the errors, warnings
and information messages are displayed in a new window at the bottom
of the screen.

Deploy
configuration

This command is used to deploy the configuration on the network.

Advanced
This menu provides access to five advanced administration features; they
Administration are described in detail in Section 3.5.3, “Maintaining Appliances”.

Tools Menu
The Tools menu contains four commands useful for working with your configuration.
Command

Description

History
of This command is used to display the list of modifications to the
modifications configuration. Click on Tools > History of modifications to view the
operation, date and time that it was performed.
Clipboard

Click on Clipboard to view the configuration objects that have been placed
on the clipboard.

DNS resolution Click on DNS resolution to make direct and reverted DNS resolutions.
Console

Click on Console to view details of the latest configuration deployment.

Zones view

Click on Zones view to view a graphical representation of the
configuration.

Arkoon Menu
Command

Description

Launch Arkoon This command is used to launch the Arkoon Monitoring tool directly from
Monitoring
Arkoon Manager .
If you are in connected mode, the menu displays Open Arkoon Monitoring
by connecting to xxx.xxx.xxx.xxx. If you are not connected, Arkoon
Monitoring will be launched, but you must then connect to the required
IP address.

Note
To make this option available in the Actions menu, the Arkoon
Monitoring application executable file must be located in the
same directory as that of Arkoon Manager .

Overview of the Interface
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Command

Description

Launch Arkoon This command is used to launch Arkoon Reporting directly from Arkoon
Reporting
Manager .
If you are in connected mode, the menu displays Open Arkoon Reporting by
connecting to xxx.xxx.xxx.xxx. If you are not connected, Arkoon Reporting
will be launched, but you must then connect to the required IP address.

Note
To make this option available in the Actions menu, the Arkoon
Reporting application executable file must be located in the same
directory as that of Arkoon Manager .

Editing Configurations
Arkoon Manager provides various ways of editing configurations. You can select the objects you want
to configure:
• in the explorer view
• from the Window menu using the Explorers option
• directly inside the main explorer by right-clicking on required object icon, select Open explorer here
from the drop-down menu. For example, in the Network objects explorer view, right-click on the Host
folder in the explorer view, select Open explorer here; an additional Hosts explorer view rooted at the
Host root folder appears, replacing the Network objects explorer view.

Note
Although a configuration is presented through multiple windows and forms, an open document
is constantly being edited. You do not need to validate or cancel editing actions that you have
performed. Actions can be undone/redone at will.

History of Modifications
The History of modifications option is used to display the list of modifications to the configuration. Click
on Tools > History of modifications; a new window appears to the right of the interface displaying the list
of operations and the corresponding date and time at which they were performed. In this window, you
can select the last valid operation, thus undoing/redoing operations following/preceding that operation.

3.3.2. Defining and Organizing Configurations
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Object-based Configuration
FAST360 appliance configuration is object-based. Instead of entering a large number of parameters to
configure an appliance, you create objects which you drag-and-drop into the configuration.
For example, instead of entering the parameters for a DNS server directly into every FAST360 appliance
configuration, you create a “host” object with “DNS” capability, with its IP address, and with any other
relevant parameters; you give this object an arbitrary name (chosen to be relevant to your network
configuration). This DNS object can now be added to the configuration of multiple appliances by a simple
drag-and-drop action.

Creating/Editing Objects
The Arkoon Manager interface provides several ways to create and edit configurable objects.

Creating an Object
There are four different methods of creating an object in Arkoon Manager :
• Right-click on the folder for the object you want to create, select New > Object name. The configuration
tab for the newly created object appears on the right.
• Place the cursor on the folder for the object you want to create and press the Insert key. The
configuration tab for the newly created object appears on the right.
• Right-click in the blank field requiring a new object, select New > Object name from the drop-down
menu. The drop-down menu will list all relevant objects possibly required for that particular field; select
the required object from the list and its configuration tab appears instantaneously.
• Several rule objects can be created and directly assigned a priority in their corresponding rule table;
they are:
• filtering rules
• chaining rules
• HTTP rules
• SMTP anti-relaying rules
• SMTP applicative rules
To create a rule object directly in the descriptive view, right-click on an existing rule, select New before
> Rule or New after > Rule. The corresponding Rule configuration tab is displayed to the right; modify
the object's name and at least one of its settings.

Note
It is also possible to create an identical copy of an object; for more details on creating a duplicate
object, see the section called “Duplicating Objects”.

Editing an Object
There are three different methods of editing an object in Arkoon Manager :
• In the descriptive view, right-click the object to be edited, select Edit from the displayed drop-down
menu. The configuration tab for the selected object appears on the right.
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Note
The shortcut for this operation is Enter. You can also double-click on the object to be edited
to open it for editing.
• In the configuration tab, click on the up or down arrow in the top right edge to access the previous or
following object displayed in the descriptive view.
• Select Window > Editors and select the object you want to edit from the displayed drop-down list.

Note
You can also change the name of a selected object in the descriptive view or directly in a field.
Right-click on the object, select Modify this from the drop-down menu and amend the name in
the field now available for modification. Alternatively, select the object and press F2.

Duplicating Objects
Arkoon Manager enables you to quickly add new objects which share many parameters with an existing
object: to create an identical copy, right-click on the object in the descriptive view, select Duplicate from
the drop-down menu. The duplicated object appears in the descriptive view. Modify the object's name
and at least one of its settings.

3.3.3. Searching Configurations
Highlighting Objects
Explorer Search Bar
The explorer search bar can be used to perform a simple search using a simple string search. It is located
directly above the status bar at the bottom edge of the window. To display the explorer status bar:
• click on the light blue upward arrow directly above the status bar at the bottom edge of the window.
• alternatively, press Ctrl + F.

To perform a simple search using the explorer search bar:
1. Enter the search criterion in the free-text field.
2. Select Match case and/or Wrap options as appropriate.
3. Search through the configuration by selecting Find Next or Find Previous as required. Objects
matching the search criterion are highlighted in yellow.

Find Origin Item
Arkoon Manager enables you to localize an object in the configuration so that you can find which service
or element the object belongs to.
• in the explorer, the descriptive view or in a field, select the required object, select Find > Find origin
from the menu options; the explorer and descriptive view which the object belongs to appear on the
left of the window
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• select the required object in the appropriate view or field and press Ctrl + Home; the explorer and
descriptive view which the object belongs to appear on the left of the window

Advanced Search
The advanced search feature can be used to search by object type, name, description, etc. To perform
an advanced search:
1. From the menu options, select Find > Advanced search; the Search dialog box appears.
2. Select the search criteria as required from the drop-down lists and select the Find option.

Smart Find Feature
When configuring objects, you can use the Smart Find feature to find objects that correspond to the item
that configuring. For example, if you are configuring a FAST360 appliance with a DNS server, if you rightclick in the blank DNS field, select Smart find, the object that you are looking for, and its location, appears
in the Smart Find pop-up window that appears.

Note
The Smart Find feature only works if the object has been previously configured with the relevant
capability. For details on how to configure objects with capabilities.
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3.3.4. Customizing the Interface
In addition to the layout of the windows elements, other aspects of the Arkoon Manager interface can
be customized to your needs. To access the various options for customizing the interface, select the
Preferences option from the Application menu; the Preferences dialog box appears.

Appearance Preferences
The Appearance configuration form contains the parameters for setting the appearance of the interface
including:
• language selection
• label alignment
• icon size
Select from the options in the drop-down lists as required.

Note
When working with big configurations, selecting the small icon size option will improve
readability of the configuration.

Edition Preferences
The Edition configuration form contains the parameters for setting preferences for editing of new objects.
Select one of the three options for editing new objects as required:
• Select and Edit: newly created objects appear open for editing.
• Select and Rename: newly created objects appear in the descriptive view with the Name field open
for editing only.
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• Select Only: newly created objects appear only in the descriptive view and have to be manually opened
for editing.

Windows Preferences
The Window configuration form contains the parameters for setting the appearance of windows and
tabs in the interface. You can choose to dock/undock windows as well as their docked position in the
interface.

Messages Preferences
The Messages configuration form contains the parameters for displaying warning messages, tooltips,
and tip-of-the-day messages.
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Network Preferences
The Network configuration form contains the parameters for setting network connections.

1. In the Ping field, set the interval (in seconds) from when the last ping is sent by Arkoon Manager to
the server (and conversely) to check that the connection is still established. By default, this value is
5 seconds.
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2. In the Remote commands field, set the timeout value (in seconds) after which a command submitted
to a server (for example, for retrieving LDAP directories) is considered to have failed. By default, this
value is 10 seconds.
3. In the Configuration installation field, set the timeout value (in seconds) after which the command to
install a configuration is considered to have failed. By default, this value is 60 seconds.

3.4. Launching Arkoon Manager
Arkoon Manager can be launched with different allocated heap sizes.
The three heap sizes that can be allocated are:
• 256 Mb (initial size)
• 512 Mb
• 750 Mb
Choose the heap size you want by clicking on the Arkoon Manager icon from the programs bar.

Note
To check the allocatable size: once Arkoon Manager is started, click on Help > About. The
allocatable heap size is displayed at the bottom of the window.
To launch Arkoon Manager with Linux:
• /bin/akman.sh allows a maximal size of 256 Mb
• /bin/akman_512Mo.sh allows a maximal size of 512 Mb
• /bin/akman_750Mo.sh allows a maximal size of 750 Mb
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3.5. Using Arkoon Manager
When you open Arkoon Manager in not connected mode you will see the following screen:

From the not connected mode screen you can:
• create a new configuration offline and save it to a file
• load a configuration from a local file
• connect to a FAST360 appliance or AMC server
• complete a Quick Login with your last session parameters (if you have previously connected to an
appliance)
When you have connected to an appliance or AMC server you will see the following screen:
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• create a new configuration to retrieve the addressing network configured via Minimal Arkoon
Configuration or the Initialization Wizard
• configure a new, existing local or remote configuration
• manage Access Control configuration/Roles
• manage the Certificate Authority
This section explains the above operations in the order that they are performed by the administrator.

3.5.1. Managing Administration Sessions
Managing Sessions
To open, download or install a configuration on the FAST360 appliance or the AMC server, you need to
be connected to the appliance or to the AMC server; this is referred to as a session.

Caution
This is a secured connection (using the SSL v3 protocol). To connect to a FAST360 appliance or
to a AMC server, you must fulfil the following requirements:
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• The IP address of your administration machine must be authorized in the Admin from
parameter of the minarkconf program.
• You must know the IP address of the FAST360 interface or of the AMC server interface to
which you want to connect.
• You must have a PKCS#12 administration certificate and know the password protecting it (this
password is required for each connection). For more details about certificates and passwords,
see the First-Time Configuration Guide.

Caution
The PKCS#12 (Private Information Exchange Standard) management certificate provided to
FAST360 appliance administrators and users contains private information that is generated
during the creation of the certificate. Some of this information, such as the private key used for
authenticating and the negotiating SSL secured connections, is strictly confidential. Disclosing
such information to a third party will result in the certificate being revoked. The password
protecting the PKCS#12 file must be highly resistant and meet the password requirements of
minarkconf ; see the First-Time Configuration guide for more details. The file should be stored
in a location to which only the file owner has access. We generally name this file a PKCS#12
certificate.

Note
Two administrators cannot be connected concurrently to an appliance or AMC server with write
rights. Write rights will be denied to administrators who connect after the first administrator (with
write rights) connected to the appliance or AMC server.

Connecting to the FAST360 Appliance or to an AMC Server
There are two options for connecting to the FAST360 appliance or to an AMC server:
• Select a session: select a session to connect to the appliance or to AMC server.
• Quick Login: connect by reusing already defined connection settings from your last session.
The options are presented as shown below.
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Connecting via a New Session
1. Double-click on the Select a session icon; the Sessions screen replaces the Arkoon Manager main
menu window.

2. In the Session explorer, right-click on the Sessions folder, select New > Session from the drop-down
menu. The Session configuration form appears on the right.

3. Enter the name and a short description of this new session in the corresponding Name and Description
fields.
4. Enter the IP address of the FAST360 appliance or of the AMC server in the IP address field
5. Enter the connection port in the Port field. By default, this value is set to 1750.
6. Enter the file path (access path and the name of the file) of the PKCS#12 certificate in the X.509
Certificate field. Alternatively, click on the folder icon to locate the certificate file location.
7. Click on the Login option in the Session toolbar; the Login dialog box appears.
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8. Enter the certificate's password in the Password field and click on the Login button. The Connecting
dialog appears briefly.
• If your login is successful, the Connected mode screen will appear.
• If your login fails, the error dialog box appears. Select Retry and amend the login details as advised
by this error message.

Master/Slave Configuration Connections
In the case of a master/slaves configuration, and when the slave connects to the master for the first time,
the administrator has the option of:
• creating an object from scratch for this new FAST360 appliance, or
• associating the newly detected appliance with a previously provisioned appliance object in the
configuration

Connecting Using an Existing Session
1. Double-click on the Quick login icon; the Login dialog box appears with your last session details in
the corresponding fields.
2. Check that the session parameters taken from your last session connection are correct.
3. Enter the PKCS#12 password in the Password field and click on the Login button. The Connecting
dialog appears briefly.
• If your login is successful, the Connected mode screen will appear.
• If your login fails, the error dialog box appears. Select Retry and amend the login details as advised
by this error message.
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Note
When editing a configuration in connected mode, if the connection with the appliance has been
lost, it is possible to reconnect by clicking on the deconnection status icon.

Disconnecting from a FAST360 Appliance or from an AMC Server Active Session
To disconnect from an active session:
• From the main Connected mode screen, click on the green arrow Back to main menu and disconnect
in the bottom left-hand corner of the screen.

Caution
For security reasons, do not leave an open connection unattended.

Connected Mode Workflow
For a detailed explanation of what an administrator can do in connected mode, see Section 3.2.2,
“Connected Mode”.

3.5.2. Managing Security Policies
The Configure mode in Arkoon Tools is the key interface for managing network security policies
and configuring FAST360 appliances. The configuration interface has been designed around the use of
objects, individual configurable elements which can be copied and reused to build up a coherent network
security policy deployed across a network of FAST360 appliances.
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Configuration Tabs
The configuration tabs lined up vertically on the left side of the default window configuration allow you
to access different groups or classes of configuration objects. Configuration objects are grouped and
tabbed as follows:
Network Objects

This tab contains folders for the FAST360 appliances, host
systems, and networks in your deployment.

Services

This tab includes configuration for the protocol services which
are used in traffic filtering rules.

Schedules

In this tab you define scheduling rules which are used in
configuring traffic filtering rules.

URL Filtering Categories

This tab allows you to enter URLs or keywords for web filtering.

Authentication

This tab allows you to define and configure the various
authentication methods used on your deployment. This includes
X.509 certificate management, PKI configuration, and local user
login/password and/or certificate database management. See
Chapter 16, Authentication, PKI for more details on configuring
and managing authentication.

IDPS

This tab provides for configuration and management of the
optional FAST IDPS (Intrusion Detection and Prevention System).
See Section 12.2, “IDPS” for more details on FAST IDPS.

VPNs

This tab provides for configuring IPsec VPN tunnels on the
FAST360 appliance. See Chapter 13, Configuring IPsec VPN
Tunnels for more details on VPN configuration.

IP Filtering Rules

This tab allows you to create and manage traffic filtering rules.

QoS

This tab includes folders for managing and configuring QoS
parameters. See Section 19.4, “Quality of Service (QoS)” for more
details on configuring QoS.

FAST Policies

This tab includes folders for system-defined and user-defined
FAST policies

Policies

This tab includes folders for defining various management
policies for the FAST360 appliances on the network: ICMP
policies, log policies, reporting policies, updating policies, and
antispam policies.

Loading Security Policies
When you load a security policy in connected mode, the configuration is synchronized with the appliance
hardware configuration. Details of the synchronization can be viewed in the Hardware information dialog
box. For configurations with multiple FAST360 appliances, you can select the required appliance from the
Select this one drop-down list. In master/slave configurations, this dialog box can be used to check that
the slave machines are connected to the master.
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Opening a Locally Saved Configuration
Opening a locally saved configuration involves loading this configuration file from the administration
station.
1. Double-click on the Load from file icon; the Download dialog box appears.
2. Select the configuration file to be downloaded and click on Download.
•
•
•
•

The configuration master contains all the installed configuration versions.
The current configuration is automatically selected.
On a configuration slave appliance, only the last 3 configurations are saved.
If the configuration history takes time to load, you must select to configurations to delete and click
on Delete.

Downloading a Configuration Saved on the FAST360 Appliance or AMC Server
Downloading a configuration involves opening a configuration saved on the FAST360 appliance or AMC
server.
1. In connected mode, double-click on the Remote configuration icon; the Download dialog box appears.
2. Select the configuration file to be downloaded and click on Download. The download box presents
all configurations stored with a different name and their ancestors.

Saving Security Policies
Saving a Configuration Locally
Saving a configuration locally involves saving it on the administration machine. Two options are available
to save a configuration locally:
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Save
This option can be used to instantaneously save the modifications made on the current configuration.
1. From the Application menu, select Save. Alternatively, press Ctrl + S. The Save as dialog box appears.
2. Use the Look in: drop-down menu to select where the file is to be saved.
3. Enter the name of the file in the File name: field.
4. Select, if needed, the encryption mode using the Application menu. By default, the standard option
is enabled (no encryption). The two encryption options are 3DES and RSA. If one of these options is
selected, the Password dialog box appears. Enter and confirm a password and click OK.
5. Complete the operation by clicking OK.

Note
You can change the previously entered password by clicking Options.

Caution
For optimal security, you must encrypt configurations which are saved outside the FAST360
appliance. To encrypt the configuration you are saving locally: select Application > Save
encrypted; enter and confirm the password in the corresponding fields of the Password dialog
box and click OK to complete the operation.
Save as
This option can be used to locally save the current configuration file in another directory and/or under
another name than the original and to encrypt it if required.
1. From the Application menu, select Save as.
2. Complete the operation following the procedure outlined in the section called “Save”.

Saving a Configuration on the FAST360 Appliance
Saving a configuration involves saving it on the FAST360 appliance to which you are connected.
1. From the Application menu, select Save as.
2. Complete the operation following the procedure outlined in the section called “Save”.

Note
Saving the configuration on the appliance does not mean that the FAST360 appliance takes it
into account. Indeed, the configuration must be deployed to be taken into account.
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Auditing Security Policies
Checking the Coherency of a Configuration
It is essential to check the coherency of the configuration before deploying it. Arkoon Manager
automatically checks for coherency errors before deploying any configuration.

Caution
Checking the coherency of a configuration guarantees that the FAST360 appliance understands
the configuration file. It detects most cases where:
• an undefined object is referenced by another object
• a field contains an incorrect or unacceptable value
• a functionality is defined in an incomplete or contradictory way
• the routing and addressing of the FAST360 appliance does not allow it to join all the referenced
objects
It does not detect:
• problems with the order of rules including filtering rules, antispam rules, applicative rules, QoS
rules
• general problems of addressing and routing logic
To check the coherency of a configuration:
• click the Check toolbar button in the toolbar directly beneath the menus
• from the menu, select Actions > Check configuration
• deploy the configuration to force an automatic coherency check
The result of this check can be viewed in the Check coherency window.

This Check coherency window displays three different types of messages:
• errors
• warnings
• information messages
The explorer view of the Check coherency window summarizes how many different types of error
messages have been detected during the coherency check. To view the details of the messages, click on
the relevant message type icon in the explorer view; the details of the errors are displayed on the right.
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• Errors (color-coded red): errors prevent you from successfully deploying the configuration on the
appliance. The error message indicates the name of the problematic object and provides a short
explanation. Right-clicking the error displays a shortcut to where in the configuration the errors need
be resolved.

• Warnings (color-coded orange): warnings do not prevent you from deploying the configuration but you
should take corrective action to resolve the issue. The warning message indicates the name of the
problematic object and provides a short explanation. Right-clicking the warning displays a shortcut to
where in the configuration the errors need be resolved.

• Information messages (color-coded blue): information messages provide useful information about the
configuration that you are about to deploy if relevant; they do not require you to take any action.

Caution
Only the presence of error messages in the coherency check will prevent you from deploying
the configuration.

Note
The coherency of your configuration is also checked when you attempt to delete an object to
prevent you from deleting an object that is linked to another object in the configuration. If the
object is linked, a warning displays which other objects reference the object you are trying to
delete.

Deploying Security Policies
Deploying a Configuration
1. Connect to the required FAST360 appliance. For detailed information on how to connect to an
appliance, see the section called “Connecting to the FAST360 Appliance or to an AMC Server”.
2. Complete a coherency check of the configuration; for more details on checking the coherency of your
configuration, see the section called “Checking the Coherency of a Configuration”.
3. Click on the Deploy toolbar button directly beneath the menus. Alternatively, select Actions > Deploy
configuration. The Apply dialog box appears.
4. In the Apply dialog box, check that the configuration details are correct and click on Apply. The details
of the configuration deployment are displayed in the Console window at the bottom of the screen.
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Deploying a Multi-FAST360 Appliance Configuration
There are several options available to you if you have a multi-FAST360 appliance configuration:
• to install a configuration on all FAST360 appliances in your configuration, select the corresponding
option
• to install the configuration only on certain FAST360 appliances:
1. Select the required FAST360 appliances from the list displayed in the dialog box.
2. Click on the Selective Install button.

3.5.3. Maintaining Appliances
Arkoon Manager provides administrators with a set of features that facilitate appliance maintenance.
These features are available from the Actions menu when editing a security policy configuration in
connected mode.

Backing-up System Configuration
This feature allows administrators to backup configuration data stored in the appliance configuration
directory. Configuration data include minarkconf parameters such as Admin From, Certificate
Authority data, current Access Control and Security Policies. Backing-up the configuration
directory will help you to recover rapidly from a potential disaster.
1. In connected mode, open a Security Policy.
2. Select Actions > Advanced Administration > Configuration card backup. The Select Fast360 to
backup configcard dialog box appears.
3. In the Select Fast360 to backup configcard dialog box:
a. Click on the FAST360 appliance object whose system configuration you want to back up.
b. Click on the Select button at the bottom of the dialog box.
4. Select where the backup configuration data file is to be stored.

Caution
Backing-up the system configuration creates an archive that may contain confidential
information such as passwords, network topology, shared secrets, etc. This data should be
stored securely.

Obtaining Diagnostic Data
To quickly and easily obtain diagnostic data, complete the following procedure.
1. In connected mode, open a Security Policy.
2. Select Actions > Advanced Administration > Get diagnostic data. A Warning dialog box appears,
warning you that the script will collect information from your system and create a result archive
containing confidential information; click Continue if you agree. The Select FAST360 appliance to get
diagnostic data from dialog box appears.
3. In the Select FAST360 appliance to get diagnostic data from dialog box:
a. Click on the FAST360 appliance object that you want to get diagnostic data for.
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b. Click on the Select button at the bottom of the dialog box.
4. Select where the diagnostic data file is to be stored.

Caution
Obtaining diagnostic data of the system configuration creates an archive that may contain
confidential information such as passwords, network topology, shared secrets, etc. This data
should be stored securely.

Note
The diagnostic data script can run for several minutes and can affect performance of the
appliance whilst retrieving data.

Installing Licenses
Obtaining a License Request from a FAST360 Appliance
To generate a license request for a FAST360 appliance:
1. In connected mode, open a Security Policy.
2. Select Actions > Advanced Administration > License request. The Select Fast360 to make license
request dialog box appears.
3. In the Select Fast360 to make license request dialog box:
a. Click on the FAST360 appliance object for which you want to make a license request for.
b. Click on the Select button at the bottom of the dialog box.
c. Enter the user information in User/Organisation dialog box that appears and click Validate to
confirm.
4. Select where the license request file is to be stored.

Installing a License on a FAST360 Appliance
1. In connected mode, open a Security Policy.
2. Select Actions > Advanced Administration > Install License.
3. Select the FAST360 appliance the license is to be installed on.
4. Select the file containing the license.
5. Consult the Console window for confirmation of license information.

Deploying Certificate Revocation Lists
1. In connected mode, open a Security Policy.
2. Select Actions > Advanced Administration > Install PEM Certificates Revocation List file.

Setting VPN certificate
This option allows you to install a certificate used to establish the appliance VPN tunnels.
1. In connected mode, go to Actions > Advanced Administration > Set VPN certificate...
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2. Select the certificate to import, and click on Open.
3. Close the configuration and re-open it.
4. Accept the synchronization information for the new certificate to be taken into account.

3.6. Using Arkoon Monitoring
Arkoon Monitoring is the interface for day-to-day monitoring of FAST360 activity, including logs and
alerts and real-time appliance status monitoring (load, performance, etc.). Note, access rights apply to
the Arkoon Monitoring application.
Information on the Arkoon Monitoring application is provided in the relevant sections of this guide which
document the features where it is used; log management is documented in Section 18.6, “Managing Logs
and Alerts”.

3.7. Using Arkoon Reporting
Arkoon Reporting is used to consolidate FAST360 appliance activity reports, with multiple options to
filter data and generate graphical summaries and visual indicators of network activity for reporting and
planning purposes. Note, access rights apply to the Arkoon Reporting application.
For more information on Arkoon Reporting, see Section 18.1, “Monitoring an Appliance”.
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and Administrator Rights
4.1. Managing Authentication Certificates
To access the Certification Authority Manager:
1. In connected mode, double-click on the Certificate Authority | Manage the Certificate Authority icon
in the Connected mode main screen.
2. The Retrieving certificate activity dialog box appears for short time followed by the Certification
authority window.

Note
If a cluster node possesses an Authentication Certificate (CA), this authority is not replicated to
the other cluster node. Only the node with the CA is able to administer the CA. If a CA is configured
on a cluster, it is recommended to place it on the master node.

The Certification authority folder contains three sub-folders:
• Valid certificates: lists all valid certificates owned by the CA.
• Expired certificates: lists all expired certificates owned by the CA.
• Revoked certificates: lists all revoked certificates owned by the CA.
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Basic details of the certificates (name, description, type and validity period) can be viewed in the
descriptive view. To view the details, click on the relevant folder in the explorer view; all the certificates
in that folder and their corresponding details are displayed in the descriptive view.
You can create new certificates (administrator certificates, certificates for appliances or end users for
VPN, IP filtering), send sign requests and export and revoke certificates.

Note
The CA’s password (which is used to protect access to the CA and is different from passwords
used to protect a given PKCS#12 file) is required for all CA operations.
Passwords used on FAST360 devices must be at least 6 digits long and include at least three of
the following four different types of characters:
• lowercase characters [a-z]
• uppercase characters [A-Z]
• numbers [0–9]
• any special characters (@, #,$,...)

Important
Change the root password and the passwords of users with administrative rights
frequently. Either memorize passwords or keep them in a location with a level of security
at least equivalent to the security level as for the function for which they are intended.
For more details on the password security policy, see the First-Time Configuration Guide.

4.1.1. Creating New Certificates
1. Create a new certificate by:
• right-clicking on Valid certificates folder in the explorer view
• right-clicking on the blank area in the descriptive view of the Valid certificates folder
• right-clicking on one of the certificates in the descriptive view
Select New certificate from the drop-down menu. The New certificate configuration form is displayed
on the right.
• clicking on the New Certificate icon in the Certification authority toolbar. The New certificate
configuration form is displayed on the right

Caution
The certificate generated is a PKCS#12 certificate file with ADMIN rights. A PKCS#12 file contains
more than just a certificate. It contains strictly personal data (among which the user private key).
A unique certificate should be created for each administrator and administrators should keep
that certificate in a place with a security level at least equivalent to the security level of the
certificate use.
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4.1.2. Signing a CSR
A CSR (Certificate Signing Request) is a message sent from an applicant to the CA, requesting a digital
identity certificate.
1. Open the signing form by:
• right-clicking on one of the certificate folders in the explorer view
• right-clicking on the blank area in the descriptive view of one of the certificates folder
• right-clicking on one of the certificates in the descriptive view
• rlicking on the Sign request icon in the Certification authority toolbar
The Sign request configuration form is displayed on the right.
• clicking on the Sign request icon in the Certification authority toolbar. The Sign request
configuration form is displayed on the right
2. Provide the following parameters:
a. the path to the CSR on the local machine
b. the type and validity period of the generated certificate
c. the output format (DER or PEM) and the path of the generated certificate on the local machine
3. Click on the Sign button and authenticate by providing the CA password.
A new certificate corresponding to the CSR is created. It is visible in the Valid certificates folder.
The certificate is exported to the local machine according to the parameters provided.

4.1.3. Exporting a Certificate
Exporting certificates applies to valid certificates as these are the certificates used by users to prove
their identity. Certificates can be exported in different ways:
• DER: data is encoded according to the Distinguished Encoding Rules method
• PEM: data is sent in the Privacy Enhanced Mail format.
• Text: data is sent as a text file.
In the descriptive view, right-click on the certificate that you want to export and select Export > Export
as , selecting the required export method from the drop-down list.

4.1.4. Revoking a Certificate
Certificates can be irreversibly revoked and placed on a Certificate Revocation List (CRL) if the user's
private key has been compromised or the CA's policy has been violated. A complete list of the reasons
for revoking a certificate can be found in the RFC 3280.
1. In the descriptive view, right-click on the certificate that you want to revoke and select Revoke from
the drop-down list. The Authenticate dialog box appears.
2. In the Authenticate dialog box, enter the CA password in the corresponding field and click on the
Proceed option. The Retrieving certificate activity dialog box appears.
3. The revoked certificate now appears in the Revoked certificates folder.
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4.1.5. Updating the CRL on an appliance
The lifetime of the CRL of an appliance is 10 years by default. If the CRL is no longer valid, you cannot
connect to Arkoon Manager. The following error message displays: Your certificate is not valid yet or your
CRL is expired. To update your CRL, use minarkconf/Certificates/Update Certificate Revocation List (CRL).
Each time a certificate is added or revoked, the period of 10 years starts again. It is also possible to
regenerate the CRL from minarkconf using the menu Certificates>Update Certificate Revocation List
(CRL):
1. Connect to the appliance in SSH.
2. Launch minarkconf.
3. In the menu Certificates, click Update Revocation List (CRL) and type the password of the Certification
Authority (CA).

4.2. Managing Administrator Rights
To access the Administrator Rights Manager:
1. In connected mode, double-click on the Administration rights | Manage administration rights icon in
the Connected mode main screen; the Download dialog box appears.
2. In the Download dialog box, select an access control policy from the list displayed in the Download
tab and click on the Download button.
3. The Downloading access control policy activity dialog box appears briefly followed by the
Administrator Rights screen.
Controlling access to administration features involves:
• authenticating users
• controlling access to administration features based on what authenticated users are authorized, or
not, to do
An administrator might not be authorized to access all the applications in Arkoon Manager depending
on their role(s). You need to be connected to a remote AMC platform or FAST360 appliance to manage
administrator rights.

Warning
When assigning a root account (or superuser), it is important to ensure security measures are
respected. For more information, refer to Section 1.3, “Security Rules”.
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4.2.1. Configuring Administrator Rights
The Administrators folder in the Administrator rights folder contains the default administrator which is
generated on initialization of the appliance.
The default Administrator is pre-configured with the appropriate X.509 certificate and the default Role All
Permissions. You need to complete the identification and contact details in the AdministratorData and
Contact configuration forms; for more details, see the section called “Adding New Administrators”.

Adding New Administrators
1. In the Administrator Rights explorer view, right-click on the Administrators folder, select New >
Administrator. The Administrator configuration form is displayed on the right.

2. In the Properties configuration form, enter a name and short description of the administrator in the
corresponding fields.
3. In the Administrator Data configuration form, enter the full name and address of the administrator.
4. In the Contact configuration form, enter the email address and telephone number of the administrator
in the corresponding fields.
5. In the X.509 Certificate configuration form, import a X.509 certificate:
• To import the certificate from file, click on the Import from file option.
• To import the certificate from CA, click on the Import from CA option. The Retrieving certificate
dialog box appears followed by the Certification authority dialog box.
a. In the explorer view, click on the Valid certificates folder to display the certificates in the
descriptive view of the dialog box.
b. In the descriptive view, right-click on the required certificate, select Import. The selected
certificate is imported and its details are displayed in the X.509 Certificate field.
6. In the Roles configuration form, drag and drop the appropriate Role objects into the corresponding
field. For the complete list of the different administrator roles and responsibilities, see Table 4.1, “Role
Descriptions”.

Note
By default, the Role All Permissions is assigned to newly created administrators.

Configuring Administrator Rights
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4.2.2. Managing Administration Access Control Policies
Authorization is performed based on roles associated to administrators.
The Administrator rights folder contains two sub-folders:
• Administrators: lists all administrators including the default administrator.
• Roles: lists all administration roles; see Table 4.2, “Role Permissions” for the complete list of roles and
their corresponding responsibilities.
As an administrator may need to interact with CA, the Certificate Authority tab is visible in the top, righthand corner of the Roles/Administrator rights window.

Warning
The default administrator account has all the administrator rights, in particular the right to
connect to the appliance. Keeping this account can make the roles management useless since
an account with all rights would remain active. Thus, it is recommended to deactivate the default
administrator account as soon as the appliance is put into production.

Note
Administration access control policies can only be edited remotely and not on the administration
workstation. The access control database is initialized from minarkconf administration interface
on the appliance.

4.2.3. Administration Roles
A security infrastructure can contain several FAST360 appliances which may require different
administrators, with different roles, to intervene on them. The FAST360 appliance's administration tools
enable a security officer to distribute administration responsibilities according to seven defined roles.
An administrator can combine several of these roles.

Table 4.1. Role Descriptions
Role Name

Role Description

Security Officer

This role is assigned to the person who creates the other administrators.
Consequently, the person linked to this role has no administration or supervision
responsibilities but only linked SSL certificates to one or several administration
roles.

Network and System This role is assigned to the person in charge of both the network and the
Administrator
system parameters. This person is able to read the security policy and manage
the system logs. Responsible for system management, the network and system
administrator can update the FAST360 software version and licensing.
Network and System This role is linked to a person who checks the system status and the network
Supervisor
events.
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Security
Administrator

This role is assigned to the person in charge of security. This person is able to
define all the configuration parameters related to the security context and is also
able to monitor the security logs.

Security Supervisor

This role is linked to the person who follows security events and checks/deletes
the security alerts.

Auditor

Role Auditor
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Role Name

Role Description

Role All Permissions This role will be used in organizations where only one person is in charge of the
FAST360 appliance.

Warning
The role All Permissions must be used with caution because it allows total control over the
administration operations. As described in the table above, it is recommended to use this role
only if one administrator is in charge of the administration of the appliance.
The following table summarizes the rights associated with the seven different roles.

Table 4.2. Role Permissions
Permissions / Roles

Security Network Network Security Security Auditor Role All
Officer
and
and
Admin Supervisor
Permissions
System System
Admin Supervisor

CA Management
Get a X.509 list of the Arkoon PKI

X

X

X

X

Revoke a certificate on the
Arkoon PKI

X

X

Get a X.509 certificate from the
Arkoon PKI

X

X

Sign a Certificate Signing
Request (CSR) with the Arkoon
PKI Certificate Authority

X

X

X

Create a new certificate and
private key signed by the Arkoon
PKI Certificate Authority

X

X

X

Send and record a Certification
Revocation List

X

X

Apply to the CRL to the Arkoon
PKI

X

X

X
X

X

Access Control
Get the list of role configuration
files recorded on the appliance
or the AMC server

X

X

X

Get a defined role configuration
file recorded on the appliance
or the AMC server

X

X

X

Get all the versions of a defined
role configuration file recorded
on the appliance or the AMC
server

X

X

X

Get the current applied role
configuration file name

X

X

X

X

X

Administration Roles
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Permissions / Roles

Security Network Network Security Security Auditor Role All
Officer
and
and
Admin Supervisor
Permissions
System System
Admin Supervisor

Save
(record)
configuration file

a

role

Apply a role configuration file

X

X

Remove a configuration file

X

X

Hardware
Configuration File

System

Get the hardware
configuration files list

system

X

X

X

X

Get one hardware
configuration file

system

X

X

X

X

Get the next hardware system
configuration file

X

X

X

X

Update the hardware system
file information

X

X

X

X

X

Get the FAST360 appliance
configuration list

X

X

X

X

X

Get a defined FAST360
appliance configuration

X

X

X

X

X

Get all the version of a file
defined by its name

X

X

X

X

X

Get a current version list of a
defined file

X

X

X

X

X

FAST360
Configuration

Appliance

Save the configuration currently
in the editor on the appliance

X

X

Apply a saved configuration to
the FAST360 appliance

X

X

Apply a saved configuration to a
specific FAST360 appliance

X

X

Get all groups from a LDAP or a
NT server

X

X

Get all users' DN from a LDAP or
NT server

X

X

External User Management

IDPS Rules
Get all IDPS rules
Configuration Directory Backup
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Permissions / Roles

Security Network Network Security Security Auditor Role All
Officer
and
and
Admin Supervisor
Permissions
System System
Admin Supervisor

Start to build a configuration
directory snapshot.

X

X

X

X

Get the available configuration
snapshot

X

X

X

X

Start to build a FAST360
diagnostic snapshot.

X

X

X

X

X

Get
FAST360
snapshot.

X

X

X

X

X

Get Diagnostic Data

diagnostic

License Management
Start the process to get the
FAST360 appliance license.

X

X

Get the FAST360 appliance
license request

X

X

Send the license to the FAST360
appliance

X

X

Install the sent license on the
FAST360 appliance

X

X

Arkoon Reporting Permissions
Get a XML bulk of data from
the log database to generate
statistics
Arkoon
Permissions

X

X

X

X

X

X

Monitoring

Actions group related to
monitoring of the alerts (read
only)

X

X

X

Actions group related to the
supervision of the alerts (write)
Actions group related to the
monitoring of the system and
database logs (read only)

X
X

X

X

Actions group related to the
supervision of the system and
database logs (write)
Actions group related to the
monitoring of the HTTP events
(read only)
Actions group related to the
supervision of the HTTP events
(write)

X

X
X

X

X

X

X

X

X

X

X

X
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Permissions / Roles

Security Network Network Security Security Auditor Role All
Officer
and
and
Admin Supervisor
Permissions
System System
Admin Supervisor

Actions group related to the
monitoring of the IDPS system
(read only)

X

X

X

Actions group related to the
supervision of the IDPS system
(write)
X

Actions group related to the
supervision of the Mail and
SMTP (write)
X

X

X
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X

X

X

X

X

X

X

X

X

X

X

X

X

X
X

X

X

X

X

X

X

X

Actions group related to
the Authentication system
supervision (write)
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X

X

X

Actions group related to
the Authentication system
monitoring (read only)

to

X

X

Actions group related to
the Virtual Private Network
supervision (write)

Actions group related
FAST360 software updates

X

X

Actions group related to the
network supervision
Actions group related to
the Virtual Private Network
monitoring (read only)

X

X

X

X

Actions group related to the
supervision of the Operating
and Application systems (write)
Actions group related to the
network monitoring (read only)

X

X

Actions group related to the
monitoring of the Mail and
SMTP system (read only)

Actions group related to the
monitoring of the Operating
and Applications systems (read
only)

X

X

X

X

X

X

X
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4.2.4. Loading Administration Access Control Policies
1. Connect to Arkoon Manager following the procedure outline in the section called “Connecting to the
FAST360 Appliance or to an AMC Server”.
2. In the connected mode screen, double-click on the Administration rights | Manage administration
rights icon. The Downlaod dialog box appears.
3. In the Download tab, check that the details of the access control configuration file are correct and
click on the Download button. The Administrator Rights view is displayed.

4.2.5. Saving Administration Access Control Policies
Saving an administration access control policy involves uploading it to the FAST360 appliance to which
you are connected.
1. In the Administrator Rights window, select the Application > Upload. The Upload dialog box appears.
2. Check that the details in the Name and Description fields are correct and click on Upload.
3. The Upload successful dialog box appears to advise you that the “configuration access_control has
been correctly uploaded”. Click Continue to return to the Administrator Rights window.

4.2.6. Deploying Administration Access Control Policies
1. In the Roles window, click on the Apply toolbar button. The Apply dialog box appears.
2. Check that the details in the Name and Description fields are correct and click on Apply. The Applying
roles_access_control activity dialog box appears.
3. To view details of the deployment, refer to the Console window now visible at the bottom of the window
which displays a text report of the deployment operation.

Note
On an AMC server, it is necessary a slave to be already connected to the AMC server for the
Administration Access Control Policies deployment to be functional.

Loading Administration Access Control Policies
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Chapter 5. FAST360 Network Configuration
This chapter covers the network configuration of the appliance FAST360 and describes the steps to
obtain a consistent configuration.

5.1. Configuring Interfaces
The Interfaces folder contains all the physical interfaces detected in the published appliance (refer to
the First-Time Configuration Guide, section Configuring interfaces of the FAST360 appliance for more
details). This section describes the settings configuration of the most common interfaces to configure
the communication of the FAST360 appliance with the network.

5.1.1. Ethernet Interfaces
To create an Ethernet interface:
1. Select the Interface tab, then enable the interface, enter the network IP address and define the subnet
mask.

2. Select the Advanced tab, then check the options Ignore broadcast traffic and Ignore multicast traffic
are enabled.
• Ignore broadcast traffic prevents the broadcast traffic from LAN to be forwarded by the interface
(uncheck this interface when using the relay function or DHCP server).
• Ignore multicast traffic prevents the interface to listen to multicast traffic (uncheck this option if
this interface must listen to multicast traffic, for example for dynamic routing protocols).
3. If the topology exists, check the Custom MTU option and modify the MTU (1500 by default). The
MTU (Maximum Transmission Unit) is the size in bytes of the largest packet that a given layer of a
communications protocol can transmit.

Note
The Ethernet media field defines the type of media on which the Ethernet interface works. By
default it is set to Automatic. It is recommended to use this setting. It is also recommended that
the remote network equipment connected to the interface of the FAST360 uses this setting.
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5.1.2. VLAN Interfaces
A Virtual LAN (VLAN) is a method to create independent logical networks within a physical network.
Logical networks are identified by a unique ID between 0 and 4095 (included) called VLAN ID.

Note
It is recommended to use the IDs between 2 and 4095. IDs 0 and 1 are rarely used as recognized
by all the hardware, so do not use them.
To create a VLAN interface:
1. In the explorer view, right-click on the Interfaces folder.
2. Select Create > VLAN Interface . A new tab to configure a VLAN interface is displayed on the right
side of the screen.

3. Select the Interface configuration form , then drag and drop the object of the corresponding Ethernet
interface (that will be used as a support for the virtual interface) in the Base interface field .
4. In the VLAN ID field, define the interface VLAN identifier.
5. Select the Advanced configuration form:
a. Do no uncheck the Ignore broadcast traffic option to avoid logging the broadcasts generated by
the machines connected to the FAST360 appliance.
b. Uncheck the Ignore multicast traffic option if this interface must listen to multicast traffic, for
example for dynamic routing protocols.
c. If the topology requires it, check the Custom MTU option and modify the MTU value (1500 by
default).

5.1.3. Bonding Interfaces
The bonding interface (also called aggregation of Ethernet links) consists in gathering together several
Ethernet interfaces.
The mechanism used on the FAST360 appliance to implement the functionality of interfaces aggregation
(bonding) is a "Round Robin" algorithm (equal load distribution over several links) It is not the 802.3ad
standard.
• On XPA 4.2, XLarge 4.2, XPA 5.0: the bonding interface has the address of the first aggregated interface
as a MAC address.

70

| VLAN Interfaces

Chapter 5. FAST360 Network Configuration

• On XLarge 5.0, NPA 5.0) the bonding interface has an address randomly generated by the kernel. as
a MAC address.
The settings usually available on an Ethernet interface can be configured globally for all aggregated
interfaces and then forwarded to all aggregated interfaces . Once the new bonding interface is
configured, the aggregated interfaces are no longer usable in the configuration (such as listening
interface relays).
To create a bonding interface:
1. In the explorer view, right-click on the Interfaces folder, then select Create > Bonding interface from
the menu.
A new Bonding interface configuration tab is displayed.
2. Click on the Interface tab and enter the IP address and the subnet mask in the corresponding field.
3. Drag and drop the Ethernet interfaces to aggregate them in the Bonded interfaces field: you must only
aggregate the Ethernet interfaces of the same type (for example: do not aggregate a 10/100 interface
with a Gigabit interface).
4. Select the Advanced tab and uncheck the Ignore multicast traffic option if the interface to create mus
listen to the multicast traffic, for example for dynamic routing protocols.

5. Do no uncheck the Ignore broadcast traffic option to avoid logging the broadcasts generated by the
machines connected to the FAST360 appliance.
6. If needed, check the Interface bandwith option and define (in Mb/s) the bandwidth of the flow passing
through the interface in Mbs/s using the drop-down menu (this interface can then be selected as QoS
filter at bandwidth window level).

5.1.4. Creating an Alias
Creating an alias allows an interface to have a different IP address.

Note
In the case of a cluster, it is not possible de create an alias for an ethernet interface but it is
possible de create a virtual IP address. To create a virtual IP address, refer to Section 14.3.1,
“Initializing a High Availability (HA) Cluster”. It is possible de create several virtual IP addresses
for the same interface but only the first one can be used to configure a VPN tunnel.
To create an alias:
1.

Select the interface for which you want to create an alias, and then click on the Alias tab.

Creating an Alias
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2.

Right-click in the empty zone of the Alias table, then click on Create > Alias.
An alias entry appears in the table.

3.

To configure the alias, enter the name of the new alias in the Name field, then enter the network IP
address and the subnetwork mask in the IP address and Netmask fields.

Note
It is not possible to use an ethernet interface alias to create a VPN tunnel.

5.2. Main Internet Access - Default Gateway
5.2.1. Configuring the Internet Access
There are three ways to create an Internet access: by router, by ADSL interface or by cable interface.

Configuring an Internet access by router
To create an Internet access by routeur:
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1.

Create a host representing the default gateway by selecting the Hosts object, then right-click on
Create > New > Host.

2.

Click on the Network tab, then enter the host IP address.

3.

Click on the Services tab and activate its Router capacity.

4.

In the tree of the Appliances object, create an Internet access by selecting Internet access, then
right-click and select New > Internet access.

5.

Click on the General tab, then drag and drop the host that represents the default gateway as a Router.
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Configuring an Internet access by ADSL interface
Two types of ADSL interfaces can be configured: internal and external. An internal ADSL modem is an
integral part of a device while external modems are physically separate.

Configuring an internal ADSL interface
1. In the explorer view, right-click on the Interfaces folder.
2. From the displayed list, select New > ADSL Interface. A new ADSL Interface configuration tab is
displayed on the right.

3. Select the Interface configuration form:
a. Drag and drop a zone object into the Zone field.

b. Select the type of connection:
• To use the standard connection protocol, check the Standard option.
i. Enter your network access name in the Login field.
ii. Enter your network access password in the Password field and confirm it in the
corresponding field.
iii. Check the Fixed IP address option and enter the public IP address, if you have one, which
was assigned to you by your provider in the corresponding field. If you do not have an IP
address, leave this field blank.

Configuring the Internet Access

| 73

Chapter 5. FAST360 Network Configuration

• Check the Routed over IP over ATM (RFC 1483/2684) option if your provider uses this protocol. In
this case, you must create an Internet access of the type LS/Router by entering a host with the
Internet router IP address supplied by your provider.
c. If the topology requires, check the Custom MTU option and modify the MTU value.
4. If you are using the ATM protocol, select the PCI configuration form:
a. Enter the VPI and VCI values, communicated to you by your provider, in the corresponding fields.
b. Check the Modulation option and select the type of modulation from ANSI, G.Lite, G.DMT, or
multimode.
5. In the tree of the Appliances object, create an Internet access by selecting Internet access, then
right-click and select Create > Internet access.
6. Click on the General tab, then drag and drop the internal ADSL interface in ADSL modem.

Configuring an external ADSL interface
Two types of external ADSL interface configuration are possible: PPTP (Point-to-Point Tunneling
Protocol) or PPPoE (Point-to-Point Protocol over Ethernet).

Note
These interfaces cannot be managed by a cluster solution.
1. In the explorer view, right-click the Interfaces folder.
2. From the displayed list, select New > External ADSL device. A new external ADSL interface
configuration tab is displayed on the right.

3. In the External ADSL device configuration tab, select the Interface configuration form:
a. Drag and drop a zone object into the Zone field.
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b. Enter your network access name in the Login field.
c. Enter your network access password in the Password field and confirm it in the corresponding
field.
d. Check the Fixed IP address option and enter the public IP address, if you have one, which was
assigned to you by your provider in the corresponding field. If you do not have an IP address, leave
this field blank.
e. Select the appropriate protocol for your connection:
• For a PPTP connection, check the PPTP option and then drag and drop the corresponding host
object (configured with PPTP modem capacity and the modem's IP address) into the Modem
field.
• For a PPPoE connection, check that option and then drag and drop the corresponding Ethernet
interface object (the Ethernet interface connected to the ADSL modem) into the Interface field.

Note
When configuring PPPoE, you do not need to assign an IP address to the Ethernet
interface connected to the modem. If the Ethernet interface has previously been
configured with an IP address, you must disconnect it.
f. If the topology requires, check the Custom MTU option and modify the MTU value.
4. In the tree of the Appliances object, create an Internet access by selecting Internet access, then
right-click and select Create > Internet access.
5. Click on the General tab, then drag and drop the external ADSL interface in ADSL modem.
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Configuring an Internet access by cable interface (DHCP)
A cable interface is an interface which gets its IP address via DHCP.
To create a cable interface:
1. In the explorer view, right-click on Interfaces.
2. Select New > Cable modem interface from the drop-down menu. A new cable interface and its
settings are displayed in the Cable interface configuration form on the right side of the screen.
3. Select the Interface tab:
a. Drag and drop the interface object in the Base interface field.
b. If you have a public IP address, check the Fixed IP option and enter the public IP address your
provided sent you in the corresponding field.
4. In the tree of the Appliances object, create an Internet access by selecting Internet access, then
right-click and select Create > Internet access.
5. Click on the General tab, then drag and drop the cable interface in Cable modem.

5.2.2. Configuring the Internet Access as Main Access
When multiple Internet accesses have been defined, it is possible to choose one to be used as the
primary/main connection (any connection to the Internet will then be operated by default from this
access).
A non-primary Internet access is not used by default and must be explicitly involved in a flow rule or a
VPN to be used.
To define the Internet access as main access:
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1.

Click on the Internet access object.

2.

Select the Internet access object you created, then right-click and select Define as main.

The selected access is defined as main access and it can be seen in the Appliance object, Network
tab:

5.2.3. Configuring the secondary/backup Internet Access
A secondary (backup) Internet access is not used by default and must be explicitly involved in a flow
rule or VPN to be used. This feature must be configured with explicit flow rules to manage the various
Internet accesses.
To create a secondary/backup Internet access:
1.

Create an Internet access and name it, for example, Secondary access or Backup access.

2.

Specify the secondary/backup access in a flow rule (object Flow rules > Create > Flow rule > tab
Action) and define the priority.

Important
The implicit flow rules use only the primary Internet access. To fully manage the backup/
secondary access, you must create flow rules to overload these implicit flows rules.

Configuring the secondary/backup Internet Access
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5.2.4. Rejecting Private IP Addresses
By default, the Deny private addresses option is enabled when creating a new Internet access from
Arkoon Manager. This improves the safety of traffic of IP addresses by checking the source addresses
in two ways:
• For packets with a private source IP address that should be hidden: if the FAST360 appliance has a
public IP address, this option ensures that no private address goes on the Internet and the routing of
the back flow can be made.
• For incoming packets from the Internet access, they must have an IP address from a public source
to prevent address spoofing.
Consequently, if the FAST360 appliances has no public IP address:
1.

Select the Internet access object you already created.

2.

Click on the Security tab and uncheck Deny private addresses.

5.3. Adding Static Routes
The Static Routes folder contains all the static routes of the edited appliance. From this folder, you can
define the routes to the networks or hosts that cannot be seen directly by the appliance.

Warning
It is recommended not to set the default gateway with a static route to a network 0.0.0.0/0 but
rather to define it as an Internet access.
To add static routes:
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1.

Create a network representing the network you want to reach (right click on the object Networks
> Create > Network).

2.

Click on the Network tab, then enter the IP address and subnet mask.
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3.

Then, create a host representing the gateway that provides access to the network (right click on
the object Hosts > Create > Host).

4.

Click on the Network tab, then enter the host IP address and activate its IP router capacity from
the Services tab.

5.

Select the Appliances object.

6.

Click on the Network tab and select Static routes.

7.

Right-click on the empty part of the table and click on Create > Static route.

8.

In the Destination field, drag and drop the network to reach.

9.

From the Gateway field, drag and drop the gateway allowing to reach the network.

10. From the Metric field, remember to set the priority of the static route.

Adding Static Routes
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5.4. Configuring DNS Servers used by the Appliance
The DNS folder contains all the DNS (Domain Name System) servers of the edited FAST360 appliance. In
this folder, you can choose the hosts that the appliance will query when sending its DNS requests. This
selection of hosts generates the creation of implicit rules allowing the FAST360 appliance to issue DNS
requests to these hosts and simplifies configuration.
To configure DNS servers:
1.

Create hosts representing the DNS servers by selecting the Hosts object then right-clicking on
Create > Host.

2.

Click on the Network tab, then enter the host IP address.

3.

Click on the Services tab and enable its DNS server capacity.

4.

Open the Appliance object, then click on the Network tab.

5.

Click on DNS and drag and drop the hosts as DNS servers in the DNS servers zone.

Note
The system integrates a DNS cache service, which improves the performance of the
resolution that is perceptible at the HTTP, FTP and SMTP relays level.
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The operation mode of the DNS resolution is the following:
1.

Initial state (following the start of the service or appliance):
• The cache queries all the servers.
• The first server that responds is "elected" as the fastest.
• The answer is taken into account and provided to the service that queried the cache (e.g. HTTP
relay).

2.

Normal operating state:
• The cache only queries the DNS server that has been elected as the fastest.
• It only takes into account the answers of this server.

3.

Malfunction: If the cache does not receive a response from the "elected" server in the allotted time,
then it returns to the initial state (1) to query again all configured servers and determine again the
fastest.

5.5. Configuring NTP servers used by the appliance
The NTP folder contains all the NTP (Network Time Protocol) servers interrogated by the FAST360
appliance for time synchronization. In this folder, you can select the objects (hosts in this case) that will
be interrogated by the FAST360 appliance when performing NTP requests.

Note
Selecting hosts in the NTP folder generates implicit rules authorizing the FAST360 appliance to
broadcast NTP requests to these hosts. For more details, see the section called “Implicit vs.
Explicit Filtering Rules”.
To configure NTP servers:
1.

Create hosts representing the NTP servers by selecting the Hosts object then right-clicking on New
> Host.

2.

Click on the Network tab, then enter the host IP address.

3.

Click on the Services tab and enable the NTP Server service.
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4.

Open the Appliance object, then click on the Network tab.

5.

Click on NTP and drag and drop the hosts as NTP servers in the NTP Servers zone.

5.6. Particular Cases
5.6.1. Defining the Level of Protection against Attacks to a DoS
To define the level of protection against attacks to a Dos:
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1.

Click on the Security tab of the Internet access object.

2.

Check the Enable TCP SYN DoS prevention option and set the value of the maximum number of TCPSYN packets per second to limit the number of TCP connection requests received from the Internet
on the specified access.

3.

Check the Enable ICMP SYN DoS prevention option and set the value of the maximum number of
ICMP packets per second to limit the number of ICMP packets received from the specified Internet
access.
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5.6.2. Monitoring the Internet Access by Ping
To monitor the Internet access by ping:
1.

Create hosts representing the machines for which you need to ping.

2.

Click on the Advanced tab of the Internet access object.

3.

Check the Test connectivity option.

It is possible to generate regular pings destined for a machine on the Internet. When the appliance
does not receive response from these pings, it switches to the Internet access backup set in the
flow rules or the VPN.
4.

Drag and drop hosts to respond to ping in the Test targets area .

Note
It is recommended to define at least three different hosts to avoid the verification is based only
on the remote host.

5.6.3. Activating Dynamic Routing
FAST360 appliances support dynamic routing in implementing IP routing protocols according to accepted
standards. The dynamic routing protocols detect changes in the network and react by changing their
routing tables without administrator intervention. In a network designed on the basis of a dynamic routing
protocol, each router broadcasts information about IP networks on which it is connected to its neighbors.
The choice of the best route through the networks is set according to an analysis of data defined by the
protocol.
For a detailed description of the major internet routing protocols (RIP, OSPF and BGP), refer to
Section 19.3, “Dynamic Routing”.
Dynamic routing must first be activated by the Arkoon Manager tool and configured with the minarkconf
tool:
1. Select the created FAST360 appliance and then the Network tab.
2. Select the Dynamic routing folder and open the tree.
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3. From the displayed list, select the required dynamic routing protocol (RIP, OSPF, or BGP). A new
window appears on the right. By selecting a protocol, you enable dynamic routing.
4. In the right window, check Enable dynamic routing corresponding to the protocol selected to activate
the window.
a. Select the Peering option corresponding to the protocol to enable or disable the peers filtering
(hosts, other appliances and FAST360 networks, etc) according to the needs.
b. Drag and drop the interface that will implement this dynamic routing protocol on your system in
the Interfaces field .
c. Drag and drop FAST360 appliances from which you will accept the dynamic routing that uses the
protocol in the VPN gateways field.
You must now configure dynamic routing:
5. Start minarkconf and go to the Dynamic routing menu via the following path: minarkconf >
Configuration > Dynamic routing to configure the routing. You can create a file containing all the
changes that can then be applied to the appliance in a single operation.
For the configuration of dynamic routing with minarkconf to be properly taken into account by the
FAST360 appliance, the Arkoon Manager configuration must be reinstalled from Arkoon Manager,
even if no changes have occurred.

Important
Static routes must be configured in Arkoon Manager.

Important
You can also configure the dynamic routing with the following command line/usr/zebra/vtysh
for XPA appliances or 6vty for XLarge and NPA appliances. If routing changes are made outside
minarkconf using the command line interface, they are automatically detected by minarkconf
suggesting to save a file.
Using the command line interface is recommended only for experienced network administrators.
If you do not have this skill, it is recommended to use the minarkconf tool.
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5.6.4. Ident protocol
The Ident protocol (Identification protocol) is used by different servers such as POP3, FTP, and by HTTP
in particular. When a client attempts to connect to the server, the server sends an Ident request to port
113 of the client machine requesting information about this client (OS, etc.). If the client does not reply,
the server will attempt to establish a connection three more times. If the timeout is exceeded, the server
replies to the initial request of the client (POP3, FTP, HTPP, etc.). The FAST360 appliance prevents sensitive
information from being transmitted from a client to a server. The FAST360 appliance submits an RST
packet to the server when it submits an Ident request. This behavior is dynamic: it only happens with
the FAST360 appliance for configured protocols (indicated in the Ident table in the Security configuration
form).
1. In the Network objects explorer view, double-click on the FAST360 appliance icon. The FAST360
appliance configuration form is displayed on the right.
2. Select the Security configuration form.
3. Select the Ident filtering option. The Ident filtering table is displayed on the right.
4. Right-click in the blank area of the table to enter the port(s) on which the FAST360 appliance will refuse
Ident requests.

Ident protocol
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6.1. Hosts
The Hosts folder in the Network objects explorer view contains all the hosts created by the administrator.
This section describes how to create and configure a new host in your network.

6.1.1. Host services
A host can supply a FAST360 appliance with a number of services. These services are referred to as
capabilities. A host configured with a specific capability can then be used to configure the different
functionalities of a FAST360 appliance. Some services require the configuration of several parameters;
others simply require the service to be enabled by checking the corresponding capability. Capabilities
are configured in the Host Services configuration form of the Host configuration tab.
Host objects greatly simplify configuration of the FAST360 appliance. For example, instead of entering the
parameters for a DNS server directly into every FAST360 appliance configuration, you create a “Host”
object with “DNS” capability, with its IP address, and with any other relevant parameters; you give this
object an arbitrary name (chosen to be relevant to your network configuration). This DNS object can now
be added to the configuration of multiple appliances by a simple drag-and-drop action.
The following table lists the different types of host capabilities and indicates where they are used in the
various configuration tabs and forms of Arkoon Manager.

Table 6.1. Use of Host Capabilities in Arkoon Manager
Host capability

Location of host in Arkoon Manager interface

LDAP Server

FAST360 appliance/Web/HTTP/Authentication
FAST360 appliance/Web/FTP/Authentication

NT Server

FAST360 appliance/Web/HTTP/Authentication
FAST360 appliance/Web/FTP/Authentication

RADIUS Server

FAST360appliance/Web/HTTP/Authentication
FAST360 appliance/Web/FTP/Authentication

DNS Server

FAST360 appliance/Network/DNS
FAST360 appliance/Network /DHCP Server/Pools

DHCP Server

FAST360 appliance/Network/DHCP Relay/ Network
FAST360 appliance/Security/VPN

NTP Server

FAST360 appliance/Network/NTP

Hosts
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Host capability

Location of host in Arkoon Manager interface
FAST360 appliance/Network
Address Pools

/DHCP

Server/

WinsServer

FAST360 appliance/Network
Address Pools

/DHCP

Server/

Update Server

Policies/Update Policy/Update Server

Router

Internet Access/General
FAST360 appliance/ Network/Static Routes

Syslog Server

Policies/Log Policies/Log Policy

SNMP Server

Policies/Log Policies/Log Policy

SMTP Server

FAST360
appliance/Mail/SMTP/Mail
Domain Route

HTTP Proxy

FAST360 appliance/Web/HTTP/Chaining

routes/

FAST360 appliance/Update
FTP Proxy

FAST360 appliance/Web/FTP/Chaining

ICAP Server

FAST360 appliance/Web/HTTP/URL Filtering

SpamAssassin Server

FAST360 appliance/Mail/Antispam
Policies/ Antispam Policies/External
Antispam Policy/General

PPTP Modem

Server

Interface/External ADSL device/Interface

6.1.2. Creating a host
1. In the explorer view, right-click on the Hosts folder.
2. From the displayed list, select New > Host. A Host configuration tab is displayed on the right.
3. In the Properties configuration form, enter the name of the host and a short description in the
corresponding fields.
4. In the Network configuration form, indicate how the host is identified on the IP network:

IP adressing
To define the host addressing by a fixed IP address, enter the IP address in the IP address field.
• If you need this IP address to be assigned dynamically by a DHCP server, check the IP address is
assigned by DHCP option and enter the MAC address in the corresponding field.
• If you require Network Address Translation (NAT), check the Static NAT option.
a. Enter the host's public IP address in the Translated IP field.
b. Drag and drop the translating FAST360 appliance into the Translating appliance field.
For detailed information on NAT and other IP masquerading methods implemented by the FAST360
appliance, see Section 10.1, “Network Address Translation (NAT) and Port Address Translation
(PAT)”.
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Hostname
To define the host by its Fully Qualified Domain Name, enter the host name in the corresponding field.

Note
This feature is useful in the following two cases only:
• Definition of an update server
• Definition of a secure LDAP authentication server

Dynamic IP addressing
To use the host with a VPN tunnel and if the host IP is unknown or dynamic. A host object of nomad
type will only be selected into VPN tunnels groups, network VPN gateways and shared keys.
5. The VPN form is used to configure VPN tunnels, described in details in Chapter 13, Configuring IPsec
VPN Tunnels.
6. The Services form is used to configure the host with a specific capability. In this form, you select the
required capability and configure the corresponding parameters, if required. For example, to configure
a host as a DNS server, check DNS Server in the Services configuration form. The preconfigured host
object can then be included in the configuration of FAST360 appliances by a drag and drop action.

6.2. Networks
The Networks folder in the Network objects explorer view contains all the networks created by the
administrator. This section describes how to create and configure a new network.

6.2.1. Creating a network
1. In the explorer view, right-click on the Networks folder.
2. From the displayed list, select New > Network. A Network configuration tab is displayed on the right.
3. In the Properties configuration form, enter the name and a short description in the corresponding
fields.
4. Select the Network configuration form:
a. In the IP address field, enter the IP address of the network.
b. In the Netmask field, enter the subnet mask.
c. If you require Network-to-Network Translation:
i. Check the Enable static NAT option to activate this option.
ii. Drag and drop the FAST360 appliance handling the translation into the Translating appliance
field.
iii. Enter the translation address for the network in the Translated address field.

Note
The network IP address and the translation IP address share the same netmask.
d. Drag and drop a zone object into the Zone field.
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5. In the VPN form, drag and drop the VPN server which will encrypt and decrypt the flows for this
network into the VPN Gateway field.

6.3. Network object groups
Arkoon Manager allows you to group hosts, networks, or both, in order to obtain more readability in the
configuration, and particularly filtering rules. This folder contains all the host/network groups created by
the administrator. This section describes how to create a new group and how to group network objects
within it.

6.3.1. Creating a new group
1. In the Network objects explorer view, right-click on the Network objects groups icon and select New
> Network Object Group.
2. Expand the folder to view the new Network Object Group in the explorer view.
3. Drag and drop the objects (host or network) from their respective descriptive view into the Network
Object Group folder in the explorer view. To view all the grouped objects in the descriptive view, click
on the Network Object Group.
4. To identify the group of network objects, right-click on the Network Object Group folder in the explorer
view and select Edit. The Network Object Group configuration tab is displayed on the right.
a. Enter a name for the group of network objects in the Name field.
b. Enter a short description in the Description field.

6.4. Zones
Zone objects are used to show which part of the network a host, IP network or a FAST360 appliance
interface is connected to. Zone objects make it possible to visualize the complete network topology
to which the security policy is being applied. The zone parameter in a host, IP network or FAST360
appliance interface is optional. However, if this parameter is not completed, you will only have a partial
representation of the network's topology. All objects that belong to a zone have the same trust, or security,
level. Therefore, a flow going from one zone to another will be filtered by the FAST360 appliance.
The Zones folder in the Network objects explorer view contains all the zones created by the
administrator.
1. In the Network objects explorer view, right-click the Zones icon and select New > Zone. The Zone
configuration tab is displayed on the right.
2. Select the Properties configuration form:
a. Enter a name for the zone object in the Name field.
b. Enter a short description in the Description field.
The zone object name and description appear in the descriptive view.
3. Drag and drop the zone object from the descriptive view into the relevant host, IP network and FAST360
appliance interfaces.

90

| Network object groups

Chapter 6. Network objects presentation

4. To view the network topology, highlight the zone object in the descriptive view and select Tools > Zones
view from the “Configure” Mode Menu. The Zone pop-up window displays the network topology and
where the zones feature in it.

6.5. IP addresses format
The possible IP addresses for the parameters below are:
• Networks: 0.0.0.0 up to 255.255.255.255.
• Hosts: 1.1.1.1 up to 255.255.255.255.
• Appliance interfaces: 0.0.0.1 up to 255.255.255.255.
• The relay servers for SMTP are considered as hosts (see above).
• The transmitting or recipient addresses for anti-spam rules can be hosts, networks or appliances (see
above).
• The transmitting or recipient addresses for SMTP relay applicative rules can be hosts, networks or
appliances (see above).

IP addresses format
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Chapter 7. SmartSSL service configuration
Arkoon SmartSSL is a software client able to connect to a presentation server via the SSL protocol.
This server, hosted by the Cloud Datacenter Arkoon, then mounts a VPN IPSEC tunnel with the company
network where the accessed servers and applications are.

7.1. SmartSSL service configuration
The SmartSSL configuration form contains information to configure the authentication and access rights
of SmartSSL feature.

Important
Ensure with Arkoon you have the SmartSSL option.
1. Open the Appliance object, select the Smart tab and activate the SmartSSL option.

2. Enter the DNS SmartSSL name provided by Arkoon production service.
This name must be: identifier.smartssl.arkoon.net
3. The authentication base contains the identifiers/passwords of users using the service. You have two
types of authentication:
• For a local authentication, you must create users (with login and password), then users groups in
the Authentication part of Arkoon Manager.
• For a remote authentication, you must define a host with the NT server capacity (for example, an
Active directory server).

Note
The groups of users can be imported and then associated to applications (Web, remote
access) in the SmartSSL configuration portal which URL and identifier/password will be
provided when activating the service. In case of non import of these groups, all authentified
users of your authentication database will access the service(s) they need.
4. In Servers reachable via SmartSSL, create one or several access rules to allow the access to internal
servers.
• In Name: enter the access rule name.
• In Server: drag a single host.
• In Service: drag a unique service (http-factory for example).

Note
In an access rule, a server is associated to a unique server and vice versa.

SmartSSL service configuration
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5. Log on the Web SmartSSL administration portal to end the publishing of your applications.
See SmartSSL Management Console administration guide to get more details on SmartSSL.
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Chapter 8. Configuring DHCP Server and Relay
DHCP (Dynamic Host Configuration Protocol) is a network protocol used to dynamically assign IP
addresses to clients on a LAN. The DHCP server hosts a list of predefined or dynamic IP addresses
configured by the administrator. This server then allocates these addresses to the machines connecting
to the LAN.

8.1. Configuring DHCP Server
To configure the DHCP server:
1.

Open the Appliance object, then select the Network tab and activate the DHCP server.

2.

Select the Listening interfaces folder, then drag and drop the interfaces that receive and respond
to DHCP requests.

3.

In the interfaces defined as listening interfaces, make sure you disable the blocking of IP broadcast
by unchecking the Ignore IP broadcast traffic option in the Advanced tab.

Configuring DHCP Server
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4.

Create a DHCP pool by selecting DHCP pool then click on New > DHCP pool.

5.

Drag and drop the network that includes the subnet including the IP addresses to distribute.

6.

In the Addressable IP address ranges zone, right-click and select New > Addressable range then
enter the address range for distribution in the network.

7.

In the Options zone, drop the gateway (usually the appliance to be assigned to DHCP clients) in
Default gateway .

8.

Then specify the DNS servers to be assigned to DHCP clients (usually the same as those of the
appliance).
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8.2. Configuring DHCP Relay
A DHCP relay is a proxy that relays DHCP messages between DHCP clients and DHCP servers in different
IP networks. The DHCP relay listens for DHCP and BOOTP queries and responses. When a query is
received from a client, it is forwarded to the specified DHCP server(s). When a reply is received from a
server, it is forwarded to the client who made the initial request. DHCP servers and DHCP proxies cannot
run at the same time.
1. Open the Appliance object, select the Network tab and activate the DHCP Relay.

2. Select the level of logging for the DHCP relay from the options in the Log level drop-down list:
• Select Normal to log DHCP messages (DHCPDISCOVER, DHCPOFFER...) in system files /var/log/
messages and /var/log/debug. To view the system logs, you must login and enter the following
command: tail –f /var/log/messages.
• Select Full to log all requests and leases in the alerts log in Arkoon Monitoring.
3. Expand the DHCP Relay tree.
4. Select the Network folder.
a. Drag and drop the host objects that will serve as DHCP servers into the DHCP servers field; DHCP
requests will be sent to these addresses. Note, you should have already defined the hosts with the
DHCP server capability. For more detailed information on configuring hosts with capabilities, see
Section 6.1.1, “Host services”.
b. Drag and drop the interfaces to which clients are connected into the Listening interfaces field;
DHCP requests will be expected in these interfaces.
c. Drag and drop the hosts or network objects configured with the addresses from which DHCP
packets are accepted into the Allow queries from field.

Note
Packets sent with IP address 0.0.0.0/32 will always be accepted.
5. Select the Advanced folder.
6. Specify whether a reply that could not be matched to a known request is to be forwarded regardless
by checking the option Drop replies when Agent Id does not match.

Configuring DHCP Relay
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Chaining the DHCP Proxy
In network configurations where there are multiple DHCP proxy agents between DHCP clients and
servers, it can be useful to chain the proxies. Each of the proxy agents adds its own information, its Agent
Information Option to each DHCP request before forwarding it to the server.
1. Configure the DHCP proxy as described in the previous section.
2. Select the Advanced folder.
3. Select the way the proxy handles the “Agent Information Option” from the following options:
• Select Append relay agent-id to add the proxy's own Agent Information Option to the option list.
Select this option for standard proxy chaining.
• Select replace to replace all Agent Information Option with the proxy's own. Select this option if
you want to hide all previous DHCP proxies in a proxy chaining context.
• Select forward to forward incoming packets containing an Agent Information Option; the packets
will be forwarded unchanged. Select this option for transparent DHCP proxy chaining.
• Select discard to block incoming packets containing an Agent Information Option. Select this option
to forbid DHCP proxy chaining.

Note
The Agent Information Option must not be changed in DHCP over IPsec configurations.
4. Define the maximum size of the DHCP data when the proxy appends its own Agent Information Option
to the option list in the Maximum packet size field. The minimum value is 576 bytes of DHCP data;
the maximum is 1472. Note, if the DHCP message size is set in the incoming packet, it is ignored and
unchanged by the proxy, and it is not added.

Note
If an incoming packet already exceeds the value set in Maximum packet size, it will be
forwarded regardless (i.e. without the proxy's Agent Information Option).

8.3. Configuring an IP Address determined by the MAC
Address
To facilitate the administration of the network, you can define mappings between IP addresses and MAC
addresses. The MAC address always receives the IP address set while the remaining MAC addresses
never receive that IP address. This configuration allows the filtering of specific flows for a machine by
its IP address
1.
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Create hosts representing the IP addresses assigned by selecting the Hosts object and right-click
on Create > Host.

| Chaining the DHCP Proxy

Chapter 8. Configuring DHCP Server and Relay

2.

Click on the Network tab and enter the host IP address and the MAC IP address.

Important
IP addresses must belong to an address range defined in a DHCP pool and should not have
been excluded from the range.

Configuring an IP Address determined by the MAC Address
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Chapter 9. Basic Traffic Filtering Using Filtering
Rules
This chapter looks at how to configure the FAST360 appliance to filter network traffic according to
defined filtering rules, how to create your own filtering rules, as well as how to manage ICMP traffic.

9.1. Understanding Filtering Rules and Services
The FAST360 appliance acts as a stateful inspection firewall, examining each packet and tracking
network and transport-layer information for each connection. The FAST360 engine checks incoming
packets against a state table and the information in the IP filtering rules to determine whether the data
packet is legitimate as part of an existing, or new connection. The packet is then processed according
to the filtering rule security policy. The filtering rule contains both the set of filtering attributes and the
set of actions.
The filtering attributes in an IP filtering rule are:
•
•
•
•

IP source and destination addresses
Service
User
Date and/or time range

The actions that can be applied to the IP packet are:
•
•
•
•
•

Accept/Block/Reject
Translate
Route via Internet access
Secure via IPsec tunnel
Log

9.2. Implicit and Explicit Filtering Rules
FAST360 appliances filter network traffic, allowing or blocking connections, according to defined filtering
rules. There are two types of filtering rules:
• Default rules, or implicit rules: these are filtering rules automatically defined on the FAST360 appliance
as a result of configuration choices made by the administrator. For example, when you configure the
HTTP/FTP proxy the necessary filtering rules can be automatically generated from the configuration.
• Explicit rules: You can define and configure specific filtering rules for your own requirements.
The available criteria are:
• IP source (host, network, group of network objects)
• Source TCP port
• IP destination (host, network, group of network objects)

Understanding Filtering Rules and Services
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•
•
•
•

Service (Transport protocol, and port or range of ports)
Protocol rules (linked with the FAST module)
User (associated with the authentication module)
Schedule (daily, weekly schedule, etc.)

Rules are read in a pre-determined sequence. The last rule in the sequence is always a implicit filtering
rule which denies all non-explicitly authorized flows.

9.2.1. Implicit Filtering Rules
This section introduces the implicit filtering rules: these are filtering rules automatically installed on
the FAST360 appliance by the configuration installation service and which correspond to the activated
functionality.
The implicit filtering rules simplify installation. You do not have to install rules related to services provided
by the FAST360 appliance. Particularly, some rules are directly derived from the configuration of the
FAST360 appliance's functionality.

Implicit vs. Explicit Filtering Rules
There are filtering rules automatically generated by the FAST360 appliance when the administrator
configures certain characteristics. These rules are called implicit rules while the explicit rules are those
created by the administrator in the Rules folder.

Caution
By default, there is one implicit rule which blocks everything and which is located after all the
other filtering rules. This rule cannot be deleted.

Example 9.1. Activating the HTTP/FTP Proxy
When activating the HTTP/FTP proxy, you do not have to create the related filtering rules. Configure the
proxy with the:
• port
• interface
• networks authorized to use the proxy
With this information, the FAST360 appliance is able to create the filtering rule allowing proxy
interrogation.
• Also set the ports and protocols on which the FAST360 appliance can make queries.
This allows the FAST360 appliance to create the filtering rule authorizing the queries of the proxy to the
Internet.
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Implicit Rules Automatically Installed by the FAST360 Appliance
Depending on the settings configured in Arkoon Manager , the rules which can be implicitly created are:
• Antispoofing rules: refer to Section 9.2.3, “Antispoofing Default Rules” for detailed information on how
to create these rules.
• Administration rules: when the administrator defines the Admin from parameter in the minarkconf
program, he implicitly defines a rule authorizing the specified machines to connect to the FAST360
appliance on the administration ports 822, 1750 and 1751.
• Rules for DNS: when the administrator selects hosts from the DNS folder, he implicitly defines a rule
authorizing the FAST360 appliance to connect to the specified hosts with the DNS services (UDP 53
and TCP 53).
• Rules for NTP servers: when the administrator selects hosts from the NTP folder, he implicitly defines
a rule authorizing the FAST360 appliance to connect to the specified hosts with the NTP services (UDP
123).
• Rules for update:
• when the administrator configures the update, he implicitly defines a rule authorizing the FAST360
appliance to connect to the Internet with the akupdate service.
• if the FAST360 appliance is defined as proxy for updating other FAST360 appliances, an implicit rule
will be created to authorize these FAST360 appliances to connect to the main FAST360 appliance
with the akupdate service.
• Rules for HTTP/FTP proxy: when the administrator configures the HTTP/FTP proxy, he defines the
following implicit rules: from the FAST360 appliance to the Internet on ports FTP, HTTP, HTTPS and
Gopher specified in the General tab; from the hosts or selected networks (in Authorized networks) to
the FAST360 appliance on the port specified in the General tab.
• Rules for SMTP relay: when the administrator configures the SMTP relay, he defines the two following
implicit rules; from the FAST360 appliance to the Internet with the SMTP service; from the Internet to
the FAST360 appliance with the SMTP service.
• Rules for POP3: when the administrator activates the POP3 proxy, he implicitly defines a rule
authorizing the FAST360 appliance to connect to the Internet with the POP3 service.
• Rules for VPNs:
• when the administrator configures the authorized VPN servers of the VPN module, he defines the
following implicit rules: from the FAST360 appliance to the authorized VPN servers with the ESP
and ISAKMP servers; from the authorized VPN servers to the FAST360 appliance with the ESP and
ISAKMP services.
• if NAT-Traversal is activated, the UDP 4500 service will also be authorized in both rules.
• Rules for authentication servers: when the administrator selects authentication servers from the
Authentication folder, he implicitly defines a rule authorizing the FAST360 appliance to connect to the
LDAP, Radius or NT server defined as main PDC.
• Rules for authentication for filtering rules:
• a rule is automatically created to authorize the FAST360 appliance to send authentication requests
to the authentication agents with the UDP 9271 service.
• when the FAST360 appliance sends an authentication request to an agent, he dynamically adds an
implicit rule permitting the agent to send a TCP flow on the 1755 port; this rule disappears when the
timeout expires.
• Rules for master/slave:
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• when the administrator configures a FAST360 appliance as the master, he implicitly defines a rule
authorizing the slaves with specified IP addresses to connect to the FAST360 appliance with the
akslave service (TCP 1754).
• when the administrator configures a FAST360 appliance as a slave, he implicitly defines a rule
authorizing this FAST360 appliance to connect to the master with the akslave service (TCP 1754).
• Rules for primary/secondary:
• when the administrator configures as a primary one, he implicitly defines a rule authorizing
the secondary ones with specified IP addresses to connect to the FAST360 appliance with the
akgetlicense service (TCP 1753);
• when the administrator configures a FAST360 appliance as the secondary appliance, he implicitly
defines a rule authorizing this FAST360 appliance to connect to the primary with the akgetlicense
service (TCP 1753).
• Rules for High Availability: when the administrator configures a FAST360 appliance with High
Availability, he implicitly defines rules authorizing the flows UDP 694 (heartbeat), TCP 1756, UDP 123
(NTP), (akupdate) and SMTP between both HA FAST360 appliances.
• Rules for High Availability (Axx appliances): when the administrator configures a FAST360 Axx-type
appliance with High Availability, he implicitly defines rules authorizing the flows UDP 694 (heartbeat),
TCP 1756 (configuration management), UDP 123 (NTP), (akupdate) and SMTP between both HA
FAST360 appliances.
• Rules for High Availability (NPA/Performance, XLARGE appliances): when the administrator
configures a FAST360 NPA/Performance or XLarge-type appliance with HA or HP clustering, he
implicitly defines rules authorizing the flows UDP 1760 (connection state synchronization), IP protocol
112 (VRRP), TCP 1756 (configuration management), UDP 123 (NTP).

9.2.2. Implicit Rule Parameters
For each implicit filtering rule, you will find the following information:
• Name of the rule, as it is shown in the IP logs of Arkoon Monitoring;
• Input interface;
• Source IP address;
• Destination IP address;
• Service (destination port);
• Action (accept, block or reject);
• Logging (none, standard or complete).
The different types of implicit filtering rules and their parameters are detailed in Appendix E, Implicit
Filtering Rules.
An implicit filtering rule includes the same characteristics as a filtering rule defined by the Administrator
in Arkoon Manager and allows you to specify the input interface.

Rule Reading Order
Implicit and specific filtering rules are read in the following order:
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• Antispoofing default rules;
• Administration default rules;
• Specific rules created in Arkoon Manager;
• Arkoon Manager's default rules (proxy, update, etc.);
• Default blocking rules.
This order is essential for applying the security policy configured by the Administrator, since the rules
are read sequentially by the FAST360 engine. The first rule that matches the packet of a new connection
is applied and the FAST360 appliance stops reading the rules.
Since antispoofing default rules are blocking rules, they are read first.
The administration rules come before those configured in Arkoon Manager. It is therefore impossible for
a specific filtering rule to invalidate them, whether intentionally or not.
Since the implicit filtering rules created by the activation of functions in Arkoon Manager are read
after the specific rules, you can customize them, if needed. To do so, define a rule in Arkoon Manager
containing the same filtering attributes as one of the implicit filtering rules and modify the actions to be
applied on the flow (logging, FAST module options, etc.).
The last blocking rules enable the normal operation of a firewall: anything that is not specifically
authorized is blocked.

9.2.3. Antispoofing Default Rules
It is not possible to verify that a packet coming from the Internet originates from the IP address it claims
to have. However, the FAST360 appliance can carry out the two following types of checks:
• Antispoofing over the transmitted packets: given that an interface of the FAST360 appliance belongs
to a network x.x.x.x with the mask y.y.y.y, all packets with a source address belonging to this network
x.x.x.x with the mask y.y.y.y will be blocked if they come from a FAST360 appliance interface other than
the one which belongs to the x.x.x.x network.
• Antispoofing over the packets intended for the FAST360 appliance: given an ethx interface, all packets
arriving by the ethx interface will be blocked if their destination is a FAST360 interface other than the
ethx interface.
Within the framework of a standard topology, the few examples below illustrate the behavior of the
antispoofing rules:
Source
address

IP Input interface

Destination
address

IP Action of antispoofing rules

10.0.0.1

eth2

194.2.0.20

blocked

10.0.0.1

eth3

194.2.0.20

not blocked

10.0.0.1

eth3

192.168.1.254

blocked

10.0.0.1

eth3

10.0.0.254

not blocked

Note
By default, antispoofing is activated. Antispoofing rules are automatically generated as soon as
the interfaces are configured (implicit rules); they are read first (before the filtering rules defined
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in Arkoon Manager). For more details about the reading of filtering rules, see the section called
“Rule Reading Order”.
When antispoofing protection is enabled, it is possible to select which logs can be viewed in Arkoon
Monitoring .
1. In the Network objects explorer view, double-click on the FAST360 appliance icon. The FAST360
appliance configuration tab is displayed on the right.
2. Select the Security configuration form.
3. Select the Antispoofing option. Two options are displayed on the right.
• Enable the Log received traffic option to generate logs (and thus alerts and SNMP traps) that only
concern IP packets with the FAST360 appliance as their unique destination.
• Enable the Log forwarded traffic option to generate logs (and thus alerts and SNMP traps) that only
concern IP packets with everything except the FAST360 appliance as their destination.

Note
When the antispoofing protection is enabled, you can choose either the first or second option
for creating logs, both of neither of them. By default, packets blocked by the antispoofing option
are logged.
For the full list of antispoofing rules and their parameters, see Section E.1, “Default Antispoofing Rules”.

Adding/Removing Authorized Addresses
For a specific interface, Arkoon Manager allows you to define a list of authorized addresses that do not
belong to the subnetworks of the interface is explicitly attached to.
This functionality allows you to implicitly create new antispoofing rules. If you add a network to the
authorized addresses on this interface the packets coming from this network can only arrive through the
specified interface.

Figure 9.1. FAST360 Appliance Connected to a LAN with a Router Connected to Another
LAN

Within the framework of our topology, if you want to connect a new addressing network (192.168.2.0/24)
behind a router present on the 192.168.1.0/24 network, you need to add the 192.168.2.0/24 network to the
authorized addresses on this interface on eth0: thus, packets with a source IP address belonging to the
192.168.2.0/24 network will be blocked if they arrive through an interface other than eth0.
1. In the descriptive view, double-click on the desired interface. Its parameters are displayed in its
configuration tab on the right.
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2. In the Antispoofing configuration form, drag and drop the chosen network object into the Connected
networks field.

9.2.4. Administration Default Rules
Administration default rules authorize the connections:
• intended for the FAST360 appliance to the administration tools:
• minarkconf
• Arkoon Manager
• Arkoon Monitoring
• between various FAST360 appliances for a Multi-FAST 360 solution.
For a full list of default administration rules and their parameters, see Section E.2, “Default Administration
Rules”.

9.2.5. Specific Rules of the Arkoon Manager
These are the rules defined in Arkoon Manager .

9.2.6. Various Implicit Filtering Rules
Various implicit filtering rules refers to rules that allow the various options configured on the FAST360
appliance to work (proxy, HA, VPN, etc.). They are implemented only when the corresponding service
is activated.
For the full list of these various implicit filtering rules and their parameters, see Section E.3, “Various
Implicit Filtering Rules”.

9.2.7. Default Blocking Rules
Principle
These rules block any flows that were not accepted by one of the previous rules. It is not possible to
remove these default blocking rules.
For a full list of default blocking rules and their parameters, see Section E.4, “Default Blocking Rules”.

9.3. Defining Your Own IP Filtering Rules
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9.3.1. Creating an IP Filtering Rule
The Rules folder is used to define the IP filtering rules which are essential elements for the configuration
of the firewall. These filtering rules include different criteria: sources, destinations, users, schedules,
translations, encryption, Internet connection used, installation on the FAST360 appliance(s), and
advanced settings.
This section describes how to:
• Define a new IP filtering rule
• Activate or deactivate a filtering rule
• Modify the priority order of the filtering rules
• Insert a new IP filtering rule

Note
If you add your own rules for VoIP protocols, be aware that they are bi-directional and so you
must configure filtering rules for each direction.

Reading Order of Filtering Rules
A filtering rule is applied as soon as its characteristics (source, destination, schedule, user and service)
correspond to those of the received packet.
For any packet which could not be associated with a connection, the filtering rules are read in the
following order:
1. Antispoofing implicit rules
2. Administration implicit rules
3. Explicit rules written by the administrator in the Rules folder
4. Implicit rules for updates
5. Implicit rules for DNS
6. Implicit rules for the SMTP relay
7. Implicit rules for the HTTP proxy
8. Implicit rules for VPNs
9. Implicit rules for authenticating filtering rules
10.Implicit rules for authentication servers
11.Implicit rules for master/slave
12.Implicit rules for primary/secondary
13.Implicit rules for High Availability
14.The implicit rule blocking everything by default

Caution
Because the last implicit rule blocks everything, the FAST360 appliance rejects any explicitly
unauthorized packet.
The explicit rules are read, from top to bottom, in the order displayed in Arkoon Manager .
This basic principle has a direct effect on the order of filtering rules. The strictest rules must be located
above the more general rules.
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Example 9.2. Order of Authentication Rules
Let's suppose we are within the framework of the typical topology and there is a station reserved for
visitors on the LAN. We do not want this "Visitors Station" to have too many rights: particularly, it must not
be authorized to send emails via the mail server. Among other rules, the following ones are installed:
Number

Sources

Destinations Services

1

LAN

Serveur Mail ping,
POP3

2

Visitor Station DMZ

Action
SMTP,

SMTP, POP3

Accept
Block

The rules read in the order shown above allow the Visitor Station to send SMTP and POP3 flows to the
mail server. To obtain the desired behavior and only authorize the ping from the Visitor Station to the mail
server, the rule n°2 must be moved to first position.

Note
It is interesting to note that a LAN is included in the network (0.0.0.0/0). A network to LAN rule
placed before a LAN to LAN rule (with address translation, for instance) would be taken into
account to the detriment of the LAN to LAN rule.

Note
During the creation of a new configuration, an implicit filtering rule, blocking all flows from
any source to any destination, is visible in the Rules folder. This rule is there to remind the
administrator that the default behavior of the FAST360 appliance is to block everything. It is
important to note that this rule is not necessary: even if it is removed, the default implicit rule in
last position (and which blocks all filtering rules not authorized previously) is still there.

Creating a New Filtering Rule
1. In the default layout, select the Rules navigation tab from the left hand side of the main window.
2. In the explorer view, create a new filtering rule by right-clicking on the Rules folder, select New >
Rule. The Rule configuration tab is displayed on the right.

Configuring Basic Settings
1. Select the Properties configuration form:
a. Enter the name of the filtering rule in the Name field.
b. Enter a comment in the Description field.
2. Select the General configuration form:
a. To temporarily deactivate the filtering rule (for example, when testing), unselect the Enable this
rule option.

Note
The filtering rule is activated by default.
b. Select the level of detail of logs from the three options in the Logging drop-down list:
• Select Nothing if you do not want the FAST360 appliance to generate logs. This is the default
logging setting.
• Select Standard if you want the FAST360 appliance to generate logs only concerning IP packets
headers. These logs can subsequently be viewed in Arkoon Monitoring .
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• Select Full if you want the FAST360 appliance to generate logs concerning both the header and
the packet payload. These logs can subsequently be viewed in Arkoon Monitoring .

Configuring Filtering Rules Criteria
1. Select the Criteria configuration form:
a. Drag and drop the sources object into the Sources field.
b. Drag and drop the destination objects into the Destinations field.

Note
The source or destination objects selected in the Rule configuration form can be firewalls.

Note
When selecting Arkoon objects, the FAST360 appliance must be explicitly selected for a
filtering rule to accept it as source or destination. For example, configuring a network
which the FAST360 appliance belongs to as source or destination of a rule, is equivalent
to selecting all this network except the FAST360 appliance. This working mode is used in
particular to limit the maximum number of filtering rules opening access to the FAST360
appliance.
c. Drag and drop the services objects into the Service field. Protocol analysis is automatically
performed at levels 3 and 4. It will be carried out at the applicative level only if you select a service
implicating a FAST module.
d. Drag and drop the users objects into the Users field (the users have been previously defined).

Note
When a filtering rule involves a user that has not been authenticated yet, the FAST360
appliance immediately sends an authentication request to the authentication agent
(AKauth).
e. Drag and drop the schedules during which the filtering rule is authorized into the Schedules field
(the schedules have been previously defined in theSchedules folder). Note, the selected schedule
is checked in relation to the FAST360 time. The schedule selected in the filtering rule is checked
for each packet matching this filtering rule or part of a connection created by this filtering rule.

Note
Empty fields are equivalent to a wildcard. For example, leaving the Sources field blank is
equivalent to accepting any source IP address.

Configuring Actions
1. Select the Action configuration form.
2. Select the type of action to be performed on the IP packets transmitted by the defined IP flow from
the three options:
• Check the Block option to make the FAST360 appliance block the IP flow.
• Check the Reject option to make the FAST360 appliance block the flow and send a packet to the
submitter to advise that the flow has been rejected (by default, this is a “destination unreachable
– communication administratively prohibited” ICMP packet).
• Check the Accept option to make the FAST360 appliance accept the IP flow.
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Note
In the default configuration, the Block option is checked by default. The type of message
sent when the flow is rejected can be modified if needed.
Configuring a Translation Rule
1. If you have chosen for the FAST360 appliance to accept the flow, create a translation rule by rightclicking in the Rule translations blank table, select New > Translation Element. The Translation
Element dialog box appears and the entry in displayed in the table.
a. Drag and drop the FAST360 appliance to carry out the translation into the Translating appliance
field.
b. Check the Source translation option to activate translation on the source IP address and choose
the type of source translation:
• Select Masquerading to enable the FAST360 appliance to replace the source IP address with
the address of the output interface used for this flow.
• Select IP address and then specify in the corresponding field which address the FAST360
appliance is to replace the source IP address of the packet with.
c. Check the Destination translation option to activate translation on the destination IP address and
choose the type of translation:
• Check IP address translation for the selected appliance to implement port translation on the
selected port and IP address for the connections described by the filtering rule.
• Check Interface translation and drag and drop an interface into the Interface field. This
translation type is similar to the port IP translation option except that it allows you to select an
interface rather than typing its IP address.

Note
Masquerading or port translations can only be applied on unidirectional filtering rules.

Caution
The port translation must specify only one service (UDP or TCP specifying one single port)
in the Services field. On the contrary, several hosts can be specified in the Destinations
field. The Load Balancing mechanism is then applied. For more information, refer to the
section called “PAT Configuration on Several IP Addresses”.
Configuring Internet Connection Rules
By default, the FAST360 appliance uses the Internet connection defined in the Internet Access
configuration folder. If you have multiple Internet connections available, this dialog box allows you to
configure service balancing or load balancing.
• Service balancing: the flow goes through an Internet access other than the main one; the access
defined with the priority 1 has the most important priority.
• Load balancing: the flow is sent with an equivalent load on two Internet connections; in this case, both
connections are defined with priority 1.
1. Check the Accept option.
2. Check the Internet Access option.
3. Create a new Internet connection rule by right-clicking in the blank table, select New > Internet
Access with priority. The Internet Access with priority pop-up window appears and the entry is
displayed in the table.
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4. Drag and drop an Internet access object to which you want to assign a priority number into the Internet
Access field.
5. Define the selected object's priority number in the Priority field.
Configuring Encrypted Segments
The Encrypted segments table is used to associate the filtering rule with an already configured tunnels
group. By default, a FAST360 appliance will try to encrypt a given connection if VPN tunnels are available.
1. If you have chosen for the FAST360 appliance to accept the flow, create an encryption rule by rightclicking in the Encrypted segments blank table, select New > Encrypted Segment. The Encrypted
Segment pop-up window appears and the entry is displayed in the table.
2. Define where the encrypted segment is located:
• If the encrypted segment is located between the source and the FAST360 appliance, drag and drop
a source object into the Source field and the FAST360 appliance into the Destination field.
• If the encrypted segment is located between the FAST360 appliance and the destination, drag and
drop the FAST360 appliance into the Source field and a destination object into the Destination field.

Note
You must select at least one FAST360 appliance insofar as it is located at one of the
extremities of the encrypted segment.

Note
For a Master/Slave configuration, you can select a FAST360 object in both the Source and
Destination fields.
• It is also possible to select as a source or destination of an encryption segment a folder of
appliances or a group only containing appliances. This helps you to configure the inter-LAN flow
rules via VPNs.

Warning
It is possible to select a folder of appliances or a group as a source AND destination of the
same encryption segment.
3. Select the encryption mode from Not encrypted, Encrypted through any defined tunnel, or Encrypted
through specified tunnels. VPN encryption is the most common choice of encryption mode.
• Not encrypted: explicitly requires that connections matching the filtering rule are not encrypted on
a given segment.
• Encrypted through any defined tunnel: encrypts connections matching the filtering rule on a given
segment, whatever the VPN tunnel used.
• Encrypted through specified tunnels: encrypts connections matching the filtering rule on a given
segment, using the specified VPN tunnel.
4. If you have selected VPN encryption, drag and drop the concerned VPN tunnel group into the VPN
Tunnels field.
Configuring Advanced Settings
1. Check the Masquerade TCP sequence numbers option to enable the FAST360 appliance to generate
random sequence numbers for servers that do not have this facility.
2. Check the Maximum number of connections option and set the value in the corresponding field of the
maximum number of connections authorized on the same flow. This option is very useful to protect
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a specific server against certain attacks (such as Denial of Service attacks). You must then refer to
the server's characteristics for many connections it can support. When the number of authorized
connections has been reached, subsequent connection attempts are blocked and logged by the
FAST360 appliance.
3. Check the Maximum number of waiting connections option and set the value of the maximum number
of TCP pending connections to protect against SYN flood and similar attacks.
An established connection can be characterized as follows:
A: SYN to B
B: SYN ACK to A
A: ACK to B
If one (or both) of the last conditions described above are not fulfilled, the connection is pending.

Note
The value set here depends on the operating system of the servers you are trying to protect.
4. Check the Custom MSS option and set the value in the corresponding field of the maximum segment
size a machine can receive in one TCP-SYN packet. By reducing this default value (1500), it is possible
to skip MTU problems which occur when the ICMP Fragmentation Needed packets are blocked by
certain routers/firewalls

Configuring Deployment of Filtering Rules
The Deployment configuration form is only used in the case of master/slave configurations.
By default, the FAST360 appliance automatically deploys the filtering rules in a master/slave
configuration. However, you can force it as described below. It is yet possible to force the FAST360
appliance, according to the procedure described below.
1. Unselect the Automatic installation option.
2. Choose to either include or exclude FAST360 appliances from having the filtering rules installed on
them:
• To install the filtering rules, check Include these appliances and drag and drop the FAST360
appliances into the corresponding Included appliances field. The installation is displayed on the
appliances of the list, and the other appliances do not install the rule.
• To prevent the filtering rules from being installed, check Automatic installation and exclusion of the
following appliances and drag and drop the FAST360 appliances into the corresponding Excluded
appliances field. If needed, there is an arkoon_config key to switch to the former mode.

Activating or Deactivating Filtering Rules
By default, a newly created IP filtering rule is enabled. However, when testing, temporarily deactivating
a filtering rule can be useful.
• To deactivate a filtering rule, unselect the Enabled check box for the desired filtering rule in the
descriptive view. The rule entry is greyed out. To activate the rule, check the Enabled option. A tick
appears in the check box in the descriptive view.
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• Alternatively, check the Enable this rule option in the General configuration form to activate the
filtering rule, and unselect to disable the rule. Your selection is reflected in the descriptive view by a
tick or empty Activated check box.

Modifying the Priority Order of the IP Filtering Rules
In the Rules descriptive view, the order of priority is from top to bottom. For instance, the first filtering
rule in the descriptive view would be taken into account first, followed by the second rule in the list and
so on with more rules. However, you can modify the priority order of previously defined filtering rules.
1. In the Rules descriptive view, right-click on the entry for the filtering rule whose priority order you
want to change.
2. From the displayed pop-up menu, select either Move > Up or Move > Down to assign to the filtering
rule a priority number higher or lower than its current one. This modification is immediately displayed
in the descriptive view.

Caution
The reading order of the filtering rules, that's to say the way the FAST360 appliance interprets
them, is a basic criteria regarding their use. For more information see the section called “Reading
Order of Filtering Rules ”.

Inserting a New Filtering Rule
It is possible to define a new filtering rule in the descriptive view and assign it directly at the correct
position in the list provided that there is at least one existing entry in the table.
1. In the Rule descriptive view, right-click on a filtering rule immediately preceding or following the rule
to be inserted.
2. From the displayed pop-up menu, select either New before > Rule or New after > Rule to insert the
new filtering rule before or after the selected entry.
3. To configure the rule, follow the procedure outlined in the section called “Creating a New Filtering
Rule”.

9.4. ICMP Traffic Management
There are two types of ICMP messages:
• Information messages (echo request, echo reply, etc.), which are processed in the same way as
services, usable in the filtering rule
• Error messages (destination unreachable, redirect, etc.), which are managed with the ICMP policy
defined on the FAST360 appliance

Note
By default, ICMP information messages are not authorized. You must configure appropriate
filtering rules if you wish to authorize ICMP messages. ICMP error messages are handled
according to the options configured in the ICMP policy object. For detailed information on
managing ICMP traffic, see Section 9.4, “ICMP Traffic Management”.
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9.4.1. Information Message Management
Information message management is done through filtering rules. By default, no ICMP information
messages are accepted. To authorize ICMP flows, you need to create filtering rules corresponding to the
specific ICMP packets.
Information messages come in pairs: each question has an answer. Thus, the echo request, router
solicitation, timestamp request and information request messages correspond to the echo
reply, router advertisement, timestamp reply and information reply messages respectively.

Important
FAST analysis allows you to manage ICMP pseudo-connections. You can authorize the
“question” so that the “answer” is automatically matched to this pseudo-connection and,
therefore, accepted.
If needed, define new services by selecting the ICMP protocol and entering in the port field the type of
the ICMP question message.

9.4.2. Error Message Management
To manage ICMP error messages, the FAST360 appliance uses ICMP policy objects. There is a default
ICMP policy, implicitly used by the FAST360 appliance. With Arkoon Manager , you can create
customised ICMP policy objects. These policies can be associated with FAST360 objects to replace the
default policy.

Warning
The FAST360 appliance checks first that the ICMP message received corresponds to an active
connection. If the ICMP message refers to a connection that does not exist in the active
connection table, it is immediately rejected and logged.
The ICMP policy allows packets to be processed differently depending on their direction. ICMP packets
going from an internal network to another one are usually accepted, although only a few outbound
messages are sent.

9.4.3. Managing ICMP Policies
To manage ICMP error messages, the FAST360 appliance uses ICMP policy objects. A default ICMP policy
is available and is used by default by the FAST360 appliance. From Arkoon Manager , you can create
customized ICMP policy objects. These policies can be associated with FAST360 objects to replace the
default policy.
1. In the Network objects explorer view, double-click on the FAST360 appliance icon. The FAST360
appliance configuration tab is displayed on the right.
2. Select the Security configuration form.
3. Select the ICMP Filtering option. The ICMP policy options are displayed on the right.
4. Check the Customer IMCP policy option and drag and drop the ICMP policy object into the ICMP
policy field.

Note
The FAST360 appliance first checks that the received ICMP message correspond to an active
connection. If the ICMP message refers to a connection which does not exist in the active
connections table, it is immediately denied and logged.
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The ICMP policy processes the packets differently according to their direction. So, the ICMP packets
going from an internal network to another internal network will generally be accepted while the messages
toward an external network will generally be denied.

9.4.4. Creating a New ICMP Policy
1. In the default layout, select the Policies navigation tab from the left hand side of the main window.
2. In the explorer view, create a new ICMP policy by right-clicking on the ICMP Policies folder, select
New > ICMP Policy. The ICMP Policy configuration tab is displayed on the right.
3. In the Properties configuration form, enter a short description in the Description field.
4. Select the ICMP code you want to configure by clicking on the corresponding configuration form and
option within the form, if applicable. Select from the following actions as required. Note, “external
network” refers to packets going through an interface on which an Internet access has been defined.
“Internal network” refers to interfaces on which there is no Internet access defined and also include
the FAST360 appliance as source or destination.
• In To In: the ICMP message submitted from an internal network to an internal network is accepted.
• In To Out: the ICMP message submitted from an internal network to an external network is accepted.
• Out To In: the ICMP message submitted from an external network to an internal network is accepted.
• Log on Reject: the rejected ICMP message is logged.
• Log on Accept: the accepted ICMP message is logged.
• Custom ICMP connection timeout: the timeout for a TCP connection, associated with the ICMP
message, is set to 5 seconds. The timeouts of ICMP and UDP pseudo-connections are not modified
by the receipt of ICMP messages.

Note
The timeout value, set by default to 5 seconds, can be modified with the command line defined
in the /proc/sys/arkoon/timeout_icmp_unreach file. However, restarting the FAST360
appliance will reinitialize this value.
ICMP messages coming from an external network and going to an external network are rare. They are
dealt with the same way as messages coming from an external network and going to an internal network.

Note
For the FAST360 appliance to apply the ICMP policy you must associate it with the corresponding
FAST360 object, see Section 9.4.5, “Default ICMP Policy” for more information.

9.4.5. Default ICMP Policy
A default ICMP policy is applied if you do not create a customized ICMP policy. When you create a new
ICMP policy object, the initial values of the object are those of the default ICMP policy.
This default policy denies any message associated with a connection of an internal network to an external
network (type 3 code 4 : Destination unreachable – Fragmentation needed and DF set). This message is
required for the connection and does not allow you to filter sensitive information.
You can display the parameters of the default ICMP policy in Arkoon Manager . To create a default ICMP
policy, follow steps 1–3 of Section 9.4.4, “Creating a New ICMP Policy”.
To display the parameters of the default policy, click on the code folders within the different configuration
forms in the ICMP Policy configuration tab.
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9.4.6. Practical Case
Example
In the following topology, an FAST360 appliance is connected to a LAN (LAN1) that has a router connected
to another LAN (LAN2).

Figure 9.2. FAST360 Appliance Connected to a LAN with a Router Connected to Another
LAN

Here is the routing:
• The FAST360 appliance is the default gateway of the LAN's stations.
• The FAST360 appliance has a default route toward the Internet and a static route toward LAN2, with
the router as a gateway.

Problem Description
The IP logs show blocked redirect ICMP messages.
This is a type 5 code 1 ICMP message (redirect for the host) sent by the FAST360 appliance to a
station of the LAN.

Explanation and Resolution
This message always follows a packet sent from the station of LAN1 toward LAN2. The station of LAN1
sends the packet to its default gateway, i.e. the FAST360 appliance, that will transport the packet to the
router. Then, the FAST360 appliance sends a redirect for the host ICMP message to the station of
LAN1 to inform it that the shortest path to LAN2 is to send the packets directly to the router.
The FAST360 appliance's default ICMP policy denies any "redirect-type" packets. If you want the FAST360
appliance to send this type of message to internal networks, a new ICMP policy must be created to
authorize redirection from one internal network to another internal network.

Implementation of the New ICMP Policy
1. In the explorer view, create a new ICMP policy by right-clicking on the ICMP Policies folder, select
New > ICMP Policy. The ICMP Policy configuration tab is displayed on the right.
2. In the Properties configuration form, enter a short description in the Description field.
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3. Select the Type 5 —Redirect datagrams configuration form.
a. Select the 1: For the host folder. The parameters to be configured are displayed on the right.
b. Check the Log on Accept option to log if the ICMP message is accepted, and so validate that this
policy is working properly.
4. To associate this new ICMP policy with the FAST360 object, double-click on the FAST360 object in the
Network objects explorer view. The FAST360 configuration tab is displayed.
a. In the Security configuration form, check the ICMP Filtering folder.
b. Drag and drop the ICMP policy previously created into the ICMP policy field.

Note
Once you have tested this new ICMP policy, you can modify it to stop logging acceptedredirect
messages. If you see unsequenced packets coming from the station of LAN1 once this new ICMP
policy has been implemented, this means that this machine did not acknowledge the redirect
messages. The best solution is to declare a static route toward LAN2 on the station of LAN1.
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Chapter 10. Network Address Translation
10.1. Network Address Translation (NAT) and Port
Address Translation (PAT)
IP address translation makes it possible to hide the IP addresses of nodes on a private network from
public network hosts. The address of a private network host is called a private address. The translation
address is called a public address.
FAST360 appliances implement five types of IP translation:
• Static translation, also called static NAT (Network Address Translation)
• Masking
• N-1 translation
• Network-to-network translation
• PAT (Port Address Translation), also called redirection
In this section we will take a closer look at how and when to use the different types of address translation.
Static NAT is configured when configuring host objects in Arkoon Manager . Masking, N-1 translation,
and PAT are configured as part of filtering rules, described in Chapter 9, Basic Traffic Filtering Using
Filtering Rules. Network-to-network translation is configured on Network objects.

10.1.1. Static Translation (Static NAT)
Static NAT allows for external publication of a protected address outside of a system making it
correspond to an external address. It requires that a private address be replaced by a public address. The
static NAT function applies to inbound and outbound connections. This type of translation is 'symmetric'.

Example
On the local area network (192.168.1.0/24), the server 192.168.1.1 is published with the routable address
194.3.2.5. Any connection coming to the FAST360 appliance and intended for the address 194.3.2.5 is
forwarded toward the server 192.168.1.1, whichever port is contacted.

Figure 10.1. Static NAT

Thus, for an input connection, the FAST360 appliance makes the following modifications to the destination
addresses:
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Table 10.1. Packets Received
Source address

Destination address

Source port

Destination port

All

194.3.2.5

All

All

Table 10.2. Transmitted Packets
Source address

Destination address

Source port

Destination port

All

192.168.1.1

All

All

Advantages and Disadvantages
Static NAT works with the input connections as well as the output connections. It is used mainly with
input connections toward servers in DMZ.
It has two advantages over PAT in the case of an input connection:
• It simplifies the writing of the filtering rules if several services are activated on the server (with PAT,
you must write a filtering rule for each related services).
• It allows for translating applications that do not rely on TCP or UDP.
Nevertheless, it has an inconvenience: the destination port cannot be changed.

Configuration
The static NAT function is configured with Arkoon Manager when declaring a host. Note that the host's
IP address is its private address, and the translation address, its public address.
In order to activate the static NAT, you must use this host in a filtering rule.

Note
It is possible to assign several static translations on a machine, i.e. to create several host objects
with the same private IP address but with different public addresses. However, you must select
the appropriate host in the filtering rule.

Note
It is even possible to use the FAST360 appliance's public address as a static NAT address. This
allows the static NAT to be used even if you only have a single public address and it is assigned
to the FAST360 appliance.

10.1.2. Masking
Masking is an asymmetric translation technique in which internal (private) network addresses translate
to a single public IP address. Masking is typically used for client PCs initiating connections with external
servers (web browsing, for example, or thin client deployments). Masking does not permit incoming
connections to be established.
When a client on the private network opens an outbound connection, the source address of the outbound
packets is translated to the FAST360 appliance's output interface address. In order to reroute the return
packets towards the initiating private host, the FAST360 appliance translates the source port (UDP, TCP)
of the outbound packets and maintains a translation table that binds this port to the private host. This
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translation requires a single public address for N private addresses. It allows the available IP addressing
space to be saved.
Note that in High Availability configurations the public address is the virtual address of the HA
deployment. See Chapter 15, High Availability for XPA appliances for more information on High Availability
configurations.

Example
On the local area network, two customers 192.168.1.1 and 192.168.1.2 wish to communicate with the same
public server 196.5.4.8 on the destination port TCP 80 (HTTP query) with the same source port TCP 1092.

Figure 10.2. Masking

The FAST360 appliance makes the following modifications to the source addresses and ports:

Table 10.3. Packets Received
Source address

Destination address

Source port

Destination port

192.168.1.1

196.5.4.8

1092

80

192.168.1.2

196.5.4.8

1092

80

Table 10.4. Transmitted Packets
Source address

Destination address

Source port

Destination port

194.3.2.1

196.5.4.8

4378

80

194.3.2.1

196.5.4.8

4379

80

The table of active connections allows the return packets to be matched to the current connections and
to route them to the correct port:
1. The server returns packets intended for 194.3.2.1:4378
2. The FAST360 appliance translates them and routes them toward 192.168.1.1:1092
3. The packets arriving on port 4379 are rerouted toward 192.168.1.2:1092.

Configuring Masking
Masking is activated and configured in filtering rules. See Chapter 9, Basic Traffic Filtering Using Filtering
Rules for more information on configuring filtering rules.

Note
In a multi-appliances configuration, to mutualize the use of a flow rule on several appliances, it
is possible to apply a masking translation to a group/folder of appliances.
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10.1.3. N-1 translation
N-1 translation is similar to masking, except that you can choose the IP address used to mask the source
address. This allows you to use a different translation address for a flow intended for a specific group of
servers, for example, if a partner asks you to connect to their server with a specific IP address.

Configuration
The N-1 masking function can be activated and parameterized flow by flow with Arkoon Manager .

10.1.4. Network-to-Network Translation
Network-to-network translation provides similar functionality to static NAT, but applies to all hosts on the
defined network. It works by translating the network part of the IP address, while retaining the host part
of the address constant. Network-to-network translation requires that both the protected network and
the translation network have the same subnet mask.

Example
The LAN to be protected has the IP address 192.168.0.0/24, and includes three nodes, 192.168.0.12,
192.168.0.29, and 192.168.0.121. The destination (translation) network is 2.21.0.0/24. The translated
addresses for the three nodes will be 2.21.0.12, 2.21.0.29, and 2.21.0.121.

10.1.5. Port Address Translation (PAT)
Port address translation (or redirection) allows a specific service (TCP/UDP port) to be published from
a server of the network that is otherwise to be protected on the unprotected domain. This translation
is asymmetric. It is applied to incoming connections only. The public destination address or port of the
incoming packets are then translated into the private destination address or port. The reverse translation
is applied to the source address or port of the output packets. This translation mode allows the public
network to be masked from the other ports of the private machine that can be open.

Example
A web server (192.168.1.10) is on the local area network (192.168.1.0/24). It can be accessed from the
outside on port TCP 80 (HTTP) with a filtering rule using PAT. For security reasons, the server listens to
a non-standard port TCP 8081.

Figure 10.3. PAT

The client (196.5.4.3) initiates a connection towards 194.3.2.1:80:
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Table 10.5. Packets Received
Source address

Destination address

Source port

Destination port

196.5.4.3

194.3.2.1

1001

80

The FAST360 appliance makes the following modifications to the destination addresses and ports of the
IP header:

Table 10.6. Transmitted Packets
Source address

Destination address

Source port

Destination port

196.5.4.3

192.168.1.10

1001

8081

A table of connections allows the return packets to be matched with the active connections and to route
them on the correct port:
• The server returns packets intended to 196.5.4.3:1001 with 192.168.1.10:8081 as a source.
• The FAST360 appliance routes them toward 196.5.4.3:1001 with 194.3.2.1:80 as a source.

Special Case
In the case of HA FAST360 appliance, the translation public address is the virtual address of the selected
interface.

Advantages and Disadvantages
PAT can be used with incoming connections only. Its main interest consists in allowing modification of
the destination port, which is impossible with static NAT.

PAT Configuration on an IP Address
The redirection function is activated with Arkoon Manager . The filtering rule must be:
• Unidirectional
• Applied to a single service
To configure a filtering rule with PAT, refer to the subsection Configuring a translation rule in the section
called “Configuring Actions”.

PAT Configuration on Several IP Addresses
The redirection function is activated with Arkoon Manager in the filtering rule. It is possible to define
several hosts as destination of the rule in order to balance the load. This is the mechanism of PAT with
Load Balancing.
In this case, a destination server is selected for a new connection and the following server is selected for
the following connection. Connections openings are thus uniformly distributed between all destination
servers.
To manage a possible failure of one or more servers, the system monitors the status of the machines. If
a problem occurs, it is able to redirect new connections in order to avoid a defective server which is no
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longer eligible for the Load Balancing mechanism. The current connections on the defective server are
lost. The client needs to send again the request which is distributed to another server.
On the contrary, when a disconnected server can be accessed again, it is available again in the
destination list for PAT mechanism.
A system monitoring (sysmon) monitors servers in filtering rules using PAT with Load Balancing. For more
details, refer to Section 18.1.1, “Machines monitoring”.
The filtering rule must be:
• Unidirectional
• Applied to a single service
To configure a filtering rule with PAT, refer to the subsection Configuring a translation rule in the section
called “Configuring Actions”.

PAT Configuration on an Interface
It is also possible to configure PAT by choosing the interface on which the FAST360 appliance listens. This
configuration will have the same effect as configuring PAT by entering the IP address of the interface.

10.1.6. Special Cases
Translation Combinations
It is possible to combine translations in a same filtering rule as long as they are coherent. You can combine
a translation on the source with a translation on the destination.
Is possible to combine:
• Static NAT on the source and PAT
• Masquerading and static NAT on the destination.
• N-1 Translation and static NAT on the destination.
However you cannot combine static NAT on the destination and PAT: this information is either redundant
or contradictory.
Nevertheless, combining static NAT and masquerading is possible, as described below.

Static NAT on the Source and Masquerading
In case a filtering rule is configured with static NAT on a source host, as well as with masquerading or
N-1 translation, the static NAT has priority over masquerading and N-1 translation.
In such an example, the behavior could be:
• The source IP address of the FTP 1 server is replaced by the address of the output interface of the
FAST360 appliance.
• The source IP address of the FTP 2 server is replaced by the address 234.1.2.3, configured in the static
NAT.
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NAT in HP Clusters
To avoid addressing conflicts on the attached networks, only some Network Address Translation
mechanisms are implemented in this cluster mode, they are:
• Source translation: masquerading with interface virtual IP address
• Destination translation: Port Address Translation with interface virtual IP address

Note
On an active-active node, translation uses a masquerading address based on the node's
configured virtual IP addresses.

Translations and Transparent Proxies
It is possible to configure translation on the destination (Static NAT or PAT) on a filtering rule redirecting
toward a transparent proxy (HTTP or POP3).

Example 10.1. Translations and Transparent Proxies
A mail server can be reached in POP3 from the outside via the public address of the FAST360 appliance.
To activate the transparent POP3 proxy on this input flow, you must:
1. Write the following filtering rule (instead of static NAT, you can also choose PAT).
2. Activate the POP3.

10.1.7. Limitations of Various Transport or Inter-application
Protocols
Various transport (level 4) or inter-application (level 7) protocols cannot work - or work in fail soft mode
- when address translation is used. In the case of inter-application protocols, secondary connections
often must be opened.

Inter-application Protocols with FAST (FTP, RTSP, H323, NetBios, etc.) Module
When a FAST module is available, it changes the addresses found in the bloc of inter-application data and
dynamically opens the secondary connections to optimize the passage of the protocol through address
translation. This is the case of the data connections of the FTP protocol (active or passive mode), for
instance.

Important
It is very important to specify the corresponding services in the filtering rule. If you do not specify
the service with the related FAST module, the flow will be considered a classic TCP or UDP
connection, and the inter-application protocol will not be analyzed.

Inter-application Protocols with FAST Module
If no FAST module is available for an inter-application protocol, it may be impossible to optimize the
application transit. This is the case of PPTP, MSN Messenger, etc.

Limitations of Various Transport or Inter-application Protocols
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Network Protocols
TCP and UDP
FAST manages the TCP and UDP protocols entirely through all types of address translation.
ICMP
Furthermore, FAST manages various ICMP packets (ping in particular).
VPN (IPsec)
In the case of a VPN (IPsec), you have two possibilities:
• Apply a static translation of the ESP (or AH) protocol
• Use the NAT-Traversal functionality that encapsulates ESP packets in UDP packets, when the two ends
of the tunnel support it.
Others
For all other protocols, the only possibility is to use static translation: a private address related to a public
address.
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This chapter explains how to configure proxy servers to provide antivirus checking of communications
before passing the data (email or files) to the user. The FAST360 appliance provides proxy servers for
traffic using the HTTP, FTP, SMTP, and POP3 protocols.

11.1. HTTP Proxy Configuration
To activate an HTTP proxy, you must:
• Define the DNS of the FAST360 appliance so that it can send DNS requests.
• Set the proxy characteristics (at least activate the proxy and the define the authorized networks and
interfaces).
The HTTP folder is also used to:
• Set the cache's size, activate the antivirus, and personalize error codes.
• Create applicative rules to filter pages requested by users.
• Chain the FAST360 proxy on to another proxy.
• Set the HTTP proxy to work in transparent mode.

11.1.1. Setting the HTTP Proxy
Defining the characteristics of an HTTP proxy is a multi-step procedure.
The following HTTP proxy configuration parameters are described in detail in this section:
• Access port and interfaces/networks
• Target ports
• Antivirus analysis
• Authentication
• URL filtering
• Proxy chaining
• Error code redirection
• Advanced parameters
• Applicative rules

Configuring Access Port and Interfaces/Networks
1. In the Network objects explorer view, double-click on the FAST360 appliance icon. The FAST360
appliance configuration tab is displayed on the right.
2. Select the Web configuration form.
3. Check the HTTP folder. In the Listening Port field now available on the right, define the port value (80
by default).
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4. Expand the HTTP tree and select the Authorized Networks option. The fields to be configured are now
available on the right.
a. In the Interfaces field, drag and drop the interfaces which the authorized machines will connect to.

Note
You must have already defined the interfaces in the Interfaces folder.
b. In the Networks field, drag and drop the network objects (representing networks, machines and
machines groups) authorized to use the proxies' functionality.

Note
You must have already defined the network objects in the Hosts folder (for machines), in
the Networks folder or in the Network objects group folder (for networks or groups of
machines).

Note
Specifying authorized networks and connection interfaces defines an implicit rule authorizing
the networks to access the FAST360 appliance on the port 80 (by default). This implicit rule is
read after the rules defined in Arkoon Manager .

Configuring Target Ports
1. Select the Authorized Ports option to define the possible authorized ports other than those authorized
by default. These authorized ports are defined according to the protocol type (FTP, HTTP, HTTPS and
Gopher).
2. To enter the port number in the appropriate protocol table, right-click in the blank table, select New
> Port. An entry is displayed in the relevant protocol table.
3. Right-click in the port column; select Modify Port, and enter the port number.

Note
Specifying an authorized port defines in itself an implicit rule authorizing the FAST360 appliance
to connect to the Internet using the defined port.

Configuring Antivirus Analysis
The Antivirus option in the HTTP folder enables you to set parameters for antivirus analysis of files
transferred using HTTP.
1. Select the Antivirus option from the HTTP tree.
2. Select the files for antivirus analysis:
• To enable antivirus analysis of all files by the proxy, check the Enable antivirus option.
• To disable antivirus analysis of files over a specific size, check the Maximum size for analyzed
files option (to disable the antivirus analysis by applicative rule see page 133 the section called
“Creating an Applicative Rule”).

Note
From the Advanced section in the HTTP relay field, it is possible to prohibit the download
of a file with a size superior to the defined value (the maximum value for this option is 2 Gb
(2048 Mb) by clicking on Maximum size for downloaded files.
• To enable antivirus analysis of specified file types, check the Enable antivirus and Enable restricted
analysis options.
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a. In the Restriction drop-down list, select either To Analyze or Do not analyze from the drop-down
list to include or exclude the file types defined in the MIME types table.
b. To specify the file types, right-click in the blank area of the table and select New > MIME. A
blank entry appears in the MIME types table.
c. Right-click on the entry in the Mime column, select Modify MIME and then type the entry in the
accessible field.

Important
The file size limit for the antivirus analysis on SMALL, P-XS3 and P-S4 appliances is 10 Mo and
2Go for SMALL 250 series. If these limits are not respected, only the appliance will generate an
error during the installation of the configuration..

Configuring Authentication
1. Select the Authentication folder.
2. Check the Guarantee unique option to verify that a single user name is not used by two users at the
same time.

Note
In HP clusters, unique authentication is enforced per node, but not on the cluster as whole.
For an NT-like server (Windows 2000, 2003 or NT), it is possible to configure NTLM (Windows NT LAN
Manager). NTLM technology secures the authentication and at the same time realizes it transparently
(users do not need to use their password).

Note
The client stations must use Internet Explorer, higher than Windows 98.
Three modes are available:
• BASIC: the passwords circulate transparently in the network and users must enter their password
in the displayed pop-up window.
• NTLM: this mode is the most secure and user-friendly for users who have NTLM supporting
browsers.
• NTLM + Basic: this mode first proposes NTLM and then displays a pop-up window for NTLM nonsupporting browsers.
• LDAP: this is the protocol used between the appliance FAST360 and the authentication server,
either in transparent mode (port TCP/389), or in secure mode (LDAPS, port TCP/686). The password
circulate transparently between the browser and the appliance, as in BASIC mode. The users must
enter their password in the contextual window.
• RADIUS: this is the protocol used between the appliance FAST360 and the authentication server
(port UDP/1812). The password circulate transparently between the browser and the appliance, as
in BASIC mode. The users must enter their password in the contextual window. This RADIUS mode
is rarely used.
3. Check the Transparent option to facilitate authentication for web clients accessing a server protected
by the FAST360 appliance in transparent reverse proxy configurations.

Note
A transparent reverse proxy configuration is not compatible with and not supported for
network clients on protected networks seeking to connect to Internet web servers.
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4. Check the Use external authentication server option and then drag and drop the server object (host)
into the Authentication server field. Note, the host object should have been previously configured with
the corresponding server capability in its Host Services configuration form.
5. Select the type of authentication server from the Authentication type drop-down list. This choice must
match the server capability of the host selected in the Authentication server field.

Configuring URL Filtering
The URL Filtering option in the HTTP folder allows you to identify an external ICAP (Internet Content
Adaptation Protocol) server that the HTTP proxy will use for web content filtering.
1. Select the URL Filtering option from the HTTP tree.
2. Check the Enable URL Filtering option and drag and drop a host into the ICAP Server field.

Note
Activating the Enable URL filtering option defines an implicit rule authorizing the FAST360
appliance to use an external ICAP server for web content filtering.
3. To configure the host with ICAP server capacity, double-click on its icon. The Host configuration tab
is displayed.
4. In the Properties configuration form, enter the name of the server and a short description in the
corresponding fields.
5. Select the Services configuration form and check the ICAP Server option. The parameters to be
configured are displayed on the right.
a. In the Listening port field, specify the number of the port to be used for the connection to this server.
b. In the Query timout field, specify the maximum time interval, in seconds, that the FAST360 appliance
must wait for the server's response to a filtering request before declaring a timeout.
c. In the Connection timeout field, specify the maximum time interval, in seconds, that the FAST360
appliance must wait for a communication from the server before declaring a loss of connection.
d. In the Path field, specify the path on the ICAP server of the directory where the required filtering
application is kept.
e. In the Query field, specify the name of the application on the ICAP server that corresponds to the
filtering query.

Configuring Proxy Chaining
Configuring proxy chaining involves connecting proxy servers in a pyramid model so that they interrogate
each other in a hierarchical way when servicing requests from client workstations for Internet content.
Chained proxy servers interrogate the local proxy server's cache first. If the local server's cache does
not contain the information, the request is sent further up the chain, up to the master proxy server. If
the master proxy server does not contain the required information, it retrieves it from the Internet and
then sends the information back down the line. On the journey back down the chain, the information is
written to each involved proxy server's cache for future use, before it is passed to the client workstation
that requested it.
1. Select the Chaining option. The chaining table is displayed on the right.
2. To define as a host the proxy to be chained, right-click in the blank table.
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3. From the displayed list, select New > HTTP Proxy Chaining. The HTTP Proxy Chaining dialog box
appears and the entry is displayed in the table.
a. Enter a name and short description for the HTTP proxy in the corresponding fields.
b. In the Destination field, enter the URLs that must be redirected to this proxy. To specify that all URLs
must be redirected to this proxy, enter the * meta-character.
c. In the Chained HTTP Proxy field, drag and drop the host that must serve as proxy. The host should
be configured with a HTTP proxy capability and the port on which the connection will be made (80
by default) in the Services configuration form.

Note
Specifying the host serving as a proxy defines an implicit rule authorizing the FAST360
appliance to connect to this proxy on the specified port. For more information on implicit rules,
see Section 9.2, “Implicit and Explicit Filtering Rules”

Modifying the Priority Order of Proxy Chains
In the chaining table, the order of priority is from top to bottom. For instance, the first proxy chain defined,
#1, would be considered the highest priority rule, followed by the second rule, #2, and so on with more
rules. However, you can modify the priority order of previously defined proxy chains.
1. In the Chaining table, right-click on the entry for the chain whose priority order you want to change.
2. From the displayed pop-up menu, select either Move > Up or Move > Down to assign to the chain
a priority number higher or lower than its current one. This modification is immediately displayed in
the chaining table.

Configuring Error Code Redirection
The Error Redirection option in the HTTP folder enables you to personalize certain error messages seen
by your users in response to connectivity problems with the proxy server. This feature can be used to
deliver clearer, more explicit information to users in place of standard messages, to deliver translated
messages for international users, or to mask error messages as a security measure.

Note
Most Web browsers do not support personalized error codes pages when an HTTPS connection
is blocked by an applicative rule.
1. Select the Error Redirection option. The options are displayed on the right.
2. To activate error code redirection, check the Enable error redirection option.
3. Select the default message:
• Check the Blank message option for the default message to deliver a blank page.
• Check the Appliance default message option for the default message to deliver a locally-stored
HTML page on the FAST360 appliance. See the section called “Using HTML Pages” for more
information on using your own HTML page for this configuration.
• Check the Defined message option to edit a personalized message, including HTML tagging. The
preview window allows you to check the result.
4. To define personalized responses for individual error codes, select the error code in the Message
Tuning table.
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5. To configure the personalized message for that error code, right-click on the number of the table entry,
select Edit from the drop-down menu. A dialog box is displayed.
6. Select the message for the error code from the following options:
• Check the Default Message option to deliver the default message corresponding to the error code.
• Check the System Message option to deliver the system message corresponding to the error code
(checked by default).
• Check the Appliance Message option to deliver a locally-stored HTML page on the FAST360
appliance, corresponding to the error code. See the section called “Using HTML Pages” for more
information on using your own HTML page for this configuration.
• Check the Defined message option to edit a personalized message corresponding to the error code.
This option supports HTML tagging; the preview window allows you to check the result.

Note
The personalized is fixed and can not appeal to variables depending on the context of use.
Thus, in the case of error code 490, it is not possible to indicate the category to the origin of
filtering.

Using HTML Pages
If you choose to use your own HTML pages for error code redirection, the pages need to be generated
externally and copied to the /var/http/ErrorDocument/ directory. Graphics are not supported in these
pages.
The HTML file for the default message must be named default.html. Personalized message files must
be named with the corresponding error code: 490.html, 500.html, etc.
To copy files to the /var/http/ErrorDocument/ directory, open a console command line session on the
appliance using the SSH tool.

Configuring Advanced Parameters
1. Select the Advanced option in the HTTP tree. The fields to be configured are now available to the right.
2. In the Cache capacity field, define the capacity of the cache (in Mbytes).

Note
It is recommended to configure the storage capacity of the cache to 0 Mbytes. Indeed, it is
always faster to search the web pages on the Internet than to look in the cache. It also relieves
the disk of the appliance that has not to cache and read the cache.
3. In the Process management fields, define the processes used by the HTTP proxy. These processes
are permanently available and are automatically enabled when the HTTP proxy is in use. To improve
the access speed to the Internet, high values must be set, bearing in mind that the requirements of
the CPU resources will be higher.
a. In the Initial number of processes field, define the number of HTTP processes at the initialization
of the service.
b. In the Minimum number of waiting processes field, define the number of waiting processes at the
HTTP level.
c. In the Maximum number of waiting processes field, define the number of waiting processes at the
HTTP level. This parameter is directly linked to Minimum number of waiting processes and is an
auto-regulating parameter.
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d. In the Maximum number of processes field define the maximum number of processes to be carried
out at the HTTP level.

Configuring Applicative Rules
Once you have defined the basic characteristics of the proxy, you can add filtering functions by adding
applicative rules. These rules can be used to accept or block URLs according to the following criteria:
• Category
• User
• Schedule
• Source IP address

Note
The default implicit rule authorizes all criteria/URLs. Rules are read in the order that they are
created and the first rule that corresponds to the request will be applied. The implicit rule
authorizing all criteria/URLs is always the last rule: if you want to force users to authenticate
themselves, you have to write a rule blocking all criteria/URLs at the end.

Creating an Applicative Rule
1. Select the HTTP Filtering Rules option. The HTTP filtering rules table is displayed on the right.
2. To create a new rule, right-click in the blank table. From the displayed list, select New > HTTP Rule.
The HTTP Rule dialog box appears and the entry is displayed in the table.
3. Enter a name and short description of the new rule in the corresponding fields.
4. In the Clients field, drag and drop host(s) or network(s) objects to which the action will be applied.
5. In the Categories field, drag and drop the possible categories to which the action will be applied.
There are two types of category: blacklists retrieved from a dedicated server and updated every two
weeks, and blacklists made by the administrator. Both category types are defined in the Categories
folder and are based on URLs and keywords.
6. In the Schedules field, drag and drop the schedule(s) during which the action will be applied. Note,
you must have already defined the schedules in the Schedules folder.
7. Check the Authenticate users option to enable authentication on the entire user base. This base can
be located either locally or on an authentication server.
• In the Users field, drag and drop the user(s) who must be subjected to the action. Note, you should
have already defined the users in the Users folder of the Authentication folder.
8. Select whether or not to allow packets through the proxy:
• Check the Reject option to prevent any packets from going through the proxy.
• To allow packets through the proxy, check the Accept option and then choose from the following
three options:
• Disable Java Applets, to allow packets through provided Java applets are deactivated.
• Disable JavaScripts, to allow packets through provided Java scripts are deactivated.
• Disable ActiveX and VB Controls, to allow packets through provided ActiveX and VB controls
are deactivated.
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• Disable the antivirus analysis to disable the antivirus for HTTP requests that have matches with
the applicative rule.
9. Check the Log matching requests option to create logs tracing the requests (you can then visualize
these logs using the Arkoon Monitoring tool).

Modifying the Order of Applicative Rules
In the Rule table, the order of priority is from top to bottom. For instance, the first rule defined, #1, would be
considered the highest priority rule, followed by the second rule, #2, and so on with more rules. However,
you can modify the priority order of previously defined rules.
1. In the HTTP Filtering Rules table, right-click on the entry for the applicative rule whose priority order
you want to change.
2. From the displayed pop-up menu, select either Move > Up or Move > Down to assign to the rule a
priority number higher or lower than its current one. This modification is immediately displayed in the
rule table.

Inserting a New Applicative Rule
It is possible to define a new applicative rule in the rule table by assigning it directly a priority number
provided there is at least one existing rule in the table.
1. In the HTTP Filtering Rules table, right-click on an applicative rule with a priority number immediately
preceding or following that of the rule to be inserted.
2. From the displayed pop-up menu, select either New before > HTTP Rule or New after > HTTP Rule to
insert the new rule before or after the selected applicative rule.

11.1.2. Categories
Arkoon Manager enables URLs and keywords (detected in the URLs) to be applied to the applicative
rules of the HTTP proxy. Categories are used to define these URLs and keywords.

Creating a New Category
Note
The category name is limited to 42 characters and the number of categories is limited to 256 in
the applicative rules.
1. In the default layout, select the URL Filtering Categories navigation tab from the left hand side of the
main window. The URL Filtering Categories tree is displayed.
2. In the explorer view, select the Custom Categories folder.
3. Create a new category by right-clicking on the folder, select New > Category. The Custom Category
configuration tab is displayed on the right.
4. In the Properties configuration form, enter a name and short description of the category in the
corresponding fields.
5. Select the General configuration form.
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6. Select the category type (URL or keyword) from the Type drop-down menu.
7. To create a new entry in the Keyword table, right-click in the blank table, select New > Keyword. A
keyword entry is displayed in the table.
a. Right-click on the blank entry in the keyword column and select Modify from the drop-down menu.
The field is now accessible.
b. Enter the keywords or URLs for the category.
To deny or accept access to the whole domain of a site, type only the site name followed by the
domain classification. To accept or deny access to a specific page, enter the whole URL and path
of the specific page. To indicate all the sub-domains of a site, you can use the * meta-character,
that replaces any character; a “*” replaces any character present 0 or X times, a “?” replacing
one and only character.

Note
The use of the * joker is very resource-consuming, its use must be limited.
The following tables provide examples for URL and keywords categories.
URL categories:
Need

Detected (if not indicated in http, Not detected
https, ftp protocols)

Accept/Block all web pages • sub-part.my-site.com
from the domain my-site.com • sub-part.my-site.com/part1/
my-page.fr
Keyword: my-site.com
• my-site.com/index.htm
• my-site.com:443
site.com)

(https://my-

Accept/Block the specific • www.my-site.fr
domain www.my-site.fr
• www.my-site.fr/part1/mypage.fr
Keyword: www.my-site.fr
• foo.www.my-site.fr
• www.my-site.fr:443/part1/mypage.fr
(https://www.mysite.fr/part1/my-page.fr
Accept/Block a part of a • my-site.fr/part1
specific domain my-site.fr/ • my-site.fr/part1/photos
part1
• my-site.fr/part1/blog/
index.html
Keyword: my-site.fr/part1

• an-other-site.com/part1/mysite.com
• my-site.com.
an-other-site.com
• fakemy-site.com/
• sub-part.my-site.fr
• sub-part.my-site.fr/part1/mypage.fr
• www.my-site.fr.
an-other-site.fr

• my-site.fr/part2
• an-other-site.fr/my-site.fr/
part

• sub-part.my-site.fr/part1/
forum
• my-site.fr/:443/part1/blog/
index.html (https://my-site.fr/
part1/blog/index.html
Accept/Block all the web • my-site.com
pages for all domains of my- • http://my-site.org

• foo.my-site.com
• http://foo.my-site.com
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site (my-site.fr, my-site.com, • http://my-site.fr/whatever
• http://foo.my-site.com/
my-site.eu, …)
• http://my-site:443.org (https:// whatever
my-site.org)
Keyword: my-site.*
Accept/Block all the web • sub-part.my-site.fr
• an-other-site.fr/part1/mypages for all domains • sub-part.my-site.fr/root/part1/
site.fr
and sub-domains of my-site my-page.fr
• fakemy-site.fr/root
(my-site.fr, my-site.com, my• sub-part.my-site.org/part1
• my-site.fr/part1
site.eu, …)
• sub-part.my-site:443.fr
Keyword: *.my-site.*
(https://sub-part.my-site.fr)
Accept/Block all the web • sub-part.my-site.fr/root/
pages for all domains index.htm
and sub-domains of my-site • sub-part.my-site.fr/root/
(my-site.fr, my-site.com, my- partie1/may-page.fr
site.eu, …)
• sub-part.my-site:443.fr/root/
partie1/may-page.fr (https://
Keyword: *.my-site.*/root/*
sub-part.my-site.fr/root/
partie1/may-page.fr)

• an-other-site.fr/part1/mysite.fr

Accept/Block all the web • ftp://my-site.fr
pages of a domain for a • ftp://my-site.fr/part1/myparticular protocol
page.html

• http://my-site.fr

• fakemy-site.fr/root
• sub-part.my-site.root
• sub-part..my-site.fr/
fake/root/my-page.fr
• my-site.fr/part1

• ftp://www.my-site.fr

Keyword: ftp://my-site.fr
Accept/Block a part of • http://my-site.fr/part1
a specific domain for a • http://my-site.fr/part1/myparticular protocol
page.html
Keyword:
part1

http://my-site.fr/

Accept/Block a domain in sub-part.my-site.com:443
HTTPS
https://my-site.com/part1/myKeyword: my-site.com:443
page.html

• ftp://my-site.fr/part1
• http://www.my-site.fr/part1
• http://www.my-site.fr/part1/
my-page.html
http://my-site.com
https://foo.com/my-site.com

Keyword categories:
Need

Detected (if not indicated in http, Not detected
https, ftp protocols)

Accept/Block the URLs • key-word.fr/part1/mypage.fr
containing the keyword key- • www.an-other-site.fr/keyword
wordhere/my-page.fr
• www.an-other-site.fr/
part1/key-wordhere.fr mykeyword.fr/part1
• www.research.com/search?
q=key-wordhere
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• www.research.com/keyword?foo=bar
Accept/Block the URLs • www.an-other-site.fr/*keycontaining the keyword *key- word*/my-page.fr
word*
• www.an-other-site.fr/part1/
*key-word*.fr

• key-word.fr/part1/mypage.fr
• www.an-other-site.fr/keyword/my-page.fr
• www.an-other-site.fr/
part1/key-word.fr

Modifying an Existing Category
1. In the descriptive view, right-click the category to be modified. Select Edit from the displayed pop-up
menu. The Custom Category configuration form is displayed on the right.
2. To remove a URL or a keyword, select it in the Keyword table and press Delete.

11.1.3. Transparent HTTP Proxy Configuration
In “normal” proxying, the client web browser (Internet Explorer, Firefox, etc.) needs to be reconfigured
with the IP address and port number of the proxy server; all web requests then pass through the proxy.
With transparent proxying on a FAST360 appliance, there is no need to reconfigure the browsers of all
your network users.
1. Configure the HTTP proxy as described in the section called “Configuring Access Port and Interfaces/
Networks”.
2. In the default layout, select the Services navigation tab from the left hand side of the main window.
The Services tree is displayed.
3. In the explorer view, expand the Custom Services folder.
4. Create a new TCP service by right-clicking on the TCP services folder, select New > Custom TCP
Service. A new Custom TCP Service configuration tab is displayed on the right.
5. In the Properties configuration form, enter a name for the service and short description in the
corresponding fields.
6. Select the General form.
a. Set the From and To fields in the Destination ports section to 80.
b. Check the Redirect to option and select HTTP Proxy from the drop-down list.
7. Return to the default layout and select the Rules navigation tab from the left hand side of the main
window.
8. In the explorer view, create a new rule by right-clicking on the Rules folder, select New > Rule. A new
Rule configuration tab is displayed on the right.
9. In the Properties configuration form, enter an appropriate name for the rule and a short description
in the corresponding fields.
10.In the General form, select Nothing from the Log drop-down list (connections will be logged as part
of HTTP logging, so it is unnecessary to log the filtering rule).
11.In the Criteria form, drag and drop relevant client-side (protected) networks into the Sources field, and
add the TCP user service (previously created in step 4) into the Services field. Leave the Destinations
field empty.
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Note
Do not configure authentication by the proxy for transparent proxy configurations. Most
browsers do not accept HTTP response code 407 (proxy authentication required) if they are not
configured to work in proxy mode and so authentication will fail.

11.1.4. Transparent Reverse HTTP Proxy
The HTTP proxy of a FAST360 appliance can be used in transparent reverse proxy mode. This
configuration is typically used to provide additional security for locally-hosted web servers accessed by
external clients. Configuration is similar to that of a transparent HTTP proxy, except that:
• The Sources field in the Criteria form of the Rule configuration tab is left empty.
• The Destinations field in the Criteria form of the Rule configuration tab contains a host object
corresponding to the HTTP server.
If you want users to be authenticated by the proxy, not the server, select the Transparent option
in the Authentication folder of the HTTP proxy configuration (as described in the section called
“Configuring Access Port and Interfaces/Networks”). The HTTP proxy then sends HTTP code 401 (server
authentication required) instead of 407 (proxy authentication required), as if it was the server requiring
authentication.

Note
This is a general configuration that changes the behavior for all the requests handled by the
proxy.

11.2. FTP Proxy Configuration
To activate an FTP proxy, you must:
• Define the DNS of the FAST360 appliance so that it can send DNS requests.
• Set the proxy characteristics.

11.2.1. Setting the FTP Proxy
Defining the characteristics of an FTP proxy is a multi-step procedure.
The following FTP proxy configuration parameters are described in detail in this section:
• Access port and connection values
• Authorized port
• Authorized networks/interfaces
• Proxy chaining
• Antivirus analysis
• Authentication
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Configuring Access Port and Connection Values
1. In the Network objects explorer view, double-click on the FAST360 appliance icon. The FAST360
appliance configuration tab is displayed on the right.
2. Select the Web configuration form.
3. Check the FTP folder. In the Listening Port field now available to the right, enter the port of the FTP
proxy.
4. Expand the FTP tree and select the Advanced option. The fields to be configured are now available
on the right.
a. Set the command timeout in the corresponding field. This value is the time (in seconds) after which
a command submitted to a server is considered to have failed. By default, this value is 300 seconds.
b. Set the transfer timeout in the corresponding field. This value is the time (in seconds) after which
a transfer from a server is considered to have failed. By default, this value is 200 seconds.

Note
Both timeouts are also used if the FTP client or FTP server are inactive.
c. In the Maximum number of processes field, specify the maximum number of simultaneous
connections on the FTP server.

Note
By default, port 21 is the only authorized port on the final FTP server. To define other ports,
see the section called “Configuring Authorized Port”.
d. Select the log level from the drop-down list.

Configuring Authorized Port
By default, port 21 is the only authorized port on the final FTP server. It is possible to specify other
authorized ports.
1. Select the Authorized Ports option.
2. To specify authorized ports other than port 21, check the Authorize customer FTP ports option.
3. Right-click in the empty Custom FTP ports table, select New > Port. A port entry is displayed in the
table.
4. Right-click on the entry in the port column, select Modify Port and enter the port number.

Note
Specifying the authorized ports defines in itself an implicit rule authorizing the FAST360 appliance
to connect to the FTP server by the defined ports. For more information on implicit rules, see the
section called “Implicit vs. Explicit Filtering Rules”.
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Configuring Authorized Networks/Interfaces
1. Select the Authorized Networks option.
2. In the Interfaces field, drag and drop the interfaces which the authorized machines will connect to.
Note, the interfaces have been previously configured in the Interfaces folder.
3. In the Networks field, drag and drop the network objects (representing networks, machines and
machines groups) authorized to use the proxy's functionality. Note the network objects have been
previously defined in the Hosts folder (for machines), in the Networks folder or in the Network objects
groups folder (for networks or groups of machines).

Note
Specifying the authorized networks and connection interfaces defines an implicit rule authorizing
the networks to access the FAST360 appliance on port 2370 by default. This implicit rule is read
after rules defined in Arkoon Manager . For more information on implicit rules, see the section
called “Implicit vs. Explicit Filtering Rules”.

Configuring Proxy Chaining
1. Select the Chaining option.
2. Check the FTP proxy chaining option.
3. In the Chained FTP proxy field, drag and drop the host that will serve as a proxy.
4. Double-click on the host object. The Host configuration tab is displayed.
5. Select the Services configuration form.
6. Check the FTP Proxy option and select the port on which the connection is to be established.

Configuring Antivirus Analysis
1. Select the Antivirus option.
2. To apply antivirus analysis of all files transferred via the FTP proxy, check the Enable FTP antivirus
analysis option.
3. To allow encrypted files through without antivirus checking, check both the Enable FTP antivirus
analysis and Allow Encrypted Files options.

Configuring Authentication
1. Select the Authentication option.
2. To activate authentication for the FTP proxy, check the Enable Authentication option.
• To use a local server, check the Use local server option.
• To use a specific server:
a. Check the Use external authentication server option and then drag and drop the server object
(host) into the Authentication servers field. Note, the host object should have been previously
configured with the corresponding server capability in its Services configuration form.
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b. Select the type of authentication server from the Authentication type drop-down list. This choice
must match the server capability of the host selected in the Authentication servers field.

Note
The authentication settings for the FTP proxy are:
Login: server_user@firewall_user@serveur-ftp.com
Password: server_password@firewall_password

11.3. SMTP Proxy Configuration
To set the SMTP relay, you must:
• Define the DNS of the FAST360 appliance so that it can send DNS requests.
• Activate the relay.
• Configure domain routing.
• Configure the antirelaying rules.
This folder is also used to:
• Configure ID masquerading, antivirus and other characteristics.
• Create applicative rules to filter emails.

11.3.1. Setting the SMTP Relay
Configuring Basic Settings of the Relay
1. In the Network objects explorer view, double-click on the FAST360 appliance icon. The FAST360
appliance configuration tab is displayed on the right.
2. Select the Mail configuration form.
3. Check the SMTP folder to activate the SMTP relay.

Note
Activating the SMTP relay defines two implicit rules: one authorizes the FAST360 appliance
to transmit a SMTP flow towards any machine; the other authorizes any machine to transmit
a SMTP flow to the FAST360 appliance. These broad rules are then limited by the anti-spam
rules. For more information on implicit rules, see the section called “Implicit vs. Explicit
Filtering Rules”.
In addition, the SMTP relay uses the default internet access to send emails. It is not possible
to change this behavior.
4. Check the Restrict email size option to limit the size of emails forwarded by the SMTP proxy.
a. Adjust the Maximum email size value to alter the maximum size allowed for an email.
b. To prevent the SMTP connection from being reset as soon as an incoming email passes the
specified size limit, check the Notify remote SMTP server if email exceeds maximum size option.
The email is then downloaded and dropped, and an error message is returned to the originating
server.
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5. Check the Enable spam filtering option to enable antispam analysis. You will also need to configure
detailed antispam analysis parameters in the Antispam folder of this Mail configuration form. See
Section 11.6, “Antispam Analysis” for more information.

Configuring Antirelaying Rules
Defining DNSBL domains
The DNSBL (DNS-based Blackhole List) are blacklists of IP addresses known for spreading spam. These
blacklists are queried using the DNS protocol. The SMTP relay queries the lists to accept or not a
message coming from this machine.

Note
The use of DNSBL is based on public servers. Consequently, it is your decision whether to use
them or not. Using DNSBL transfers a part of the email processing policy to an external entity.
1. Select the Antirelaying option from the SMTP tree.
2. Check Enable DNSBL filtering.
3. In the Blacklisting threshold field, define the threshold (minimum 1) from which the IP address is
considered as blacklisted, bearing in mind that using a high threshold lets all messages through while
monitoring suspicious IP addresses (as well as associated scores in SMTP logs in Arkoon Monitoring
).

Note
When several DNSBL domains are used, this option can be used to match up information
across the lists and avoid false positives (false positives are alerts which are generated
mistakenly when the threshold is too sensitive and blocks legitimate messages).
4. Check the Test private addresses option to test using a private address, bearing in mind that they are
never defined on public DNSBL servers and that such a query could cause an information leak.
5. Check the Take multiple replies into account option so that each record increases the score if the
server sends back several records to test an IP address.
6. Right-click in the empty DNSBL domains table, select New > DNSBL Domains. The DNSBL Domains
dialog box appears and a new entry is displayed in the DNSBL domains table.
a. Enter the domain name in the DNSBL Domain field.
b. Enter a value in the Weight field to grade the importance of the domain relative to the other domains.

Note
The DNSBL domains must be used in antirelaying rules in order to be taken into account.

Typical Configuration of DNSBL Domains
A typical configuration of DNSBL domains defines several DNSBL domains to match up the replies. A
greater importance is given to the list.dsbl.org server.
The blacklisting threshold is set to 2 to prevent many false positives.

Caution
You must configure the antirelaying rules on the FAST360 appliance's relay so that it is not used
as a spam relay. This configuration is part of the security, so that there is a default implicit rule
which blocks everything.
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Creating an Antirelaying Rule
1. Right-click in the blank Antirelaying rules table, select New > SMTP Antirelaying Rule. The
Antirelaying rules table dialog box appears and the entry is displayed in the table.
a. Enter the name and a short description of the antirelaying rule in the corresponding fields.
b. Drag and drop the host(s) and/or network(s) from which emails are sent, and to which the action
will be applied, into the Clients field. Select the type of source object from the corresponding dropdown list from the following options:
• List
• Exclude
• DNSBL
c. In the From field, add possible addresses of submitter mails to which the action will be applied
by right-clicking in the blank table, select New > Email pattern type, and enter the email address.
Select the submitter type, Include or Exclude, from the corresponding drop-down list.
d. In the To field, add addresses of recipient mails to which the action will be applied. Right-click in
the blank table, select New > Email pattern type, and enter the email address. Select the recipient
type, Include or Exclude, from the corresponding drop-down list.
e. Select the behavior of the antirelaying rule from the Action drop-down menu from one of the three
options:
• Select Accept to accept emails.
• Select Deny to reject emails (a warning is sent to the email submitter).
• Select Deny without warning to reject emails (no message is sent to the email submitter).

Typical Case of Antirelaying Rule Configuration
This example assumes the framework of the typical topology of this manual. This architecture presents
the following characteristics:
• The mail server is hosted on the DMZ.
• The LAN machines are configured to send their emails to the mail server.
The actions which must be authorized by the antirelaying rules are:
• Authorizing the internal mail server to send emails with internal domains for submitter.
• Authorizing the internal mail server to send emails with <> empty fields for source.
• Blocking any email which does not come from an internal IP address with an internal domain for
source.
• Blocking anything from the LAN with a submitter which does not belong to the internal domain.
• Authorizing emails with internal domains for destination.
• Blocking all other actions.

Note
The implicit rule blocking everything remains the last rule in the table.
For the typical case of DNSBL, see the section called “Using DNSBL in an Antirelaying Rule”.
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Disabling/Activating an Antirelaying Rule
To disable an antirelaying rule, uncheck the General box in the corresponding entry of the Antirelaying
rules table. Alternatively, uncheck the Enable this rule option in the SMTP Antirelaying Rule dialog box.

Modifying the Order of Priority of Antirelaying Rules
In the Antirelaying rules table, the order of priority is from top to bottom. For instance, the first antirelaying
rule defined, #1, would be considered the highest priority rule, followed by the second rule, #2, and so on
with more rules. However, you can modify the priority order of previously defined antirelaying rules.
1. In the Antirelaying rules table, right-click on the entry for the rule whose priority order you want to
change.
2. From the displayed pop-up menu, select either Move > Up or Move > Down to assign to the rule a
priority number higher or lower than its current one. This modification is immediately displayed in the
antirelaying rule table.

Inserting a New Antirelaying Rule
It is possible to define a new antirelaying rule in the rule table and assign it directly a priority number
provided there is at least one existing rule in the table.
1. In the Antirelaying rules table, right-click on an antirelaying rule with a priority value immediately
preceding or following that of the rule to be inserted.
2. From the displayed pop-up menu, select either New before > SMTPAntirelaying Rule or New after >
SMTP Antirelaying Rule to insert the new rule before or after the selected antirelaying rule.
3. To edit the rule, follow the procedure outlined in the section called “Creating an Antirelaying Rule”.

Using DNSBL in an Antirelaying Rule
To activate an antirelaying behavior of the blacklisted IP addresses, the use of DNSBL must be configured
in the antirelaying rules. For this, a rule with DNSBL as source must be created.
1. Create an antirelaying rule following the procedure outlined in the section called “Creating an
Antirelaying Rule”.
2. Select DNSBL from the Type drop-down menu directly above the Clients field.
3. Drag and drop the host(s) and/or network(s) from which emails are sent into the Clients field.
4. Select Deny from the Action drop-down menu.

Note
Selecting the DNSBL option defines the use of DNSBL and also allows you to restrict their action
by selecting source IP addresses (for instance, a whitelist).
You can configure a whitelist group containing legitimate servers which are often blacklisted on DNSBL
servers. For example, this is the case of the following French providers:
• mx.laposte.net
• mail[1-3].caramail.com
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• relay[1-4].clb.oleane.net
• smtp[1-6].wanadoo.fr

Note
It is very important to position this antirelaying rule correctly. It must be positioned after the
rules concerning outgoing emails (there is no point in querying DNSBL for internal addresses)
and before those concerning incoming emails (as in the example below). See the section called
“Typical Case of Antirelaying Rule Configuration” for information on how to order antirelaying
rules.

Note
You can use Arkoon Monitoring to monitor (SMTP logs window) the working mode of the DNSBL
and modify its configuration in Arkoon Manager if needed.

Configuring Antivirus Analysis
1. Select the Antivirus option. Options for setting email analysis are displayed on the right.
2. Check the Enable antivirus analysis option to make the different settings available.
3. From the Infected file or failed analysis options, select the process to be performed in the case of
an infected file:
• Activate Correct infected file to correct infected files.
• Activate Remove file to remove infected files.
• Activate Reject email to reject infected emails.
• Activate Quarantine to process the file later. To correct the quarantined file later, check Repair
infected file.
4. From the Custom failed analysis options drop-down lists, select the action to be performed on:
• Encrypted file: any type of encrypted file.
• Non-analysable file: files that the antivirus could not analyze.

Configuring Applicative Rules
Once you have set the SMTP relay, you can add filtering functions by adding applicative rules. These
rules can be used to accept or block emails according to the following criteria:
• Mail address of submitter
• Mail address of recipient
• Keywords present in subject or text
• MIME type of attached files
• File name of attached files
• File extension of attached files
• Size of attached files

Note
The default, implicit rule authorizes all emails. When adding rules, email must not be blocked by
any of them to be transmitted. When configuring several criteria in a rule, complete all of the
criteria so that the action selected in the rule is applied.
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To translate an AND condition, the different criteria must be configured in a same rule. To translate an
OR condition, several rules must be configured.
1. If required, in the Disclaimer field enter the message to be added to every outgoing (or incoming)
email. This message will only be added to emails if this feature is enabled in the Applicative rule table
entry.
2. Right-click in the blank Applicative rule table, select New > SMTP Applicative Rule. The SMTP
Applicative Rule dialog box appears and a new entry is displayed in the Applicative rule table.
3. Enter the name of the applicative rule and a short description in the corresponding fields.
4. Select the filtering criteria against which the email will be examined.
• To filter the email according to the submitter's email address, enter the email pattern type in the
From table.
• To filter the email according to the recipient's email address, enter the email pattern type in the
To table.
• To filter the email according to the MIME type of attached files, enter the MIME file in the MIME
Types table.
To filter the email according to keywords in its content or header, enter the keywords in the
Keywords table.
• Select the All option if the file type is not of importance.
• Select the By name option and enter one of several file names in the corresponding field.
• Select the By type option and enter one of several file types in the corresponding field.
• To accept attached files until a certain size limit, check the Maximum file size option and enter
this size (in Kb) in the corresponding field.
5. Select the action to be performed on the emails from the Action options:
• Check Accept, to accept the attached file. Check the Append disclaimer to emails option if you
wish to add a disclaimer message; this message should be previously defined in the Disclaimer
field, see step 1 for details.
• Check the Reject option to reject the attached files. Check the Quarantine option to process the
file later.

Note
• Reject: the e-mail is blocked (not sent to the recipient) and it is deleted (alerts can be sent
to the recipient/submitter/postmaster according to the configuration defined in the Alerts
tab, to keep them informed about the reject.
• Quarantine: the email is blocked (not sent to the recipient) and put in quarantine (alerts
can be sent to the recipient/submitter/postmaster according to the configuration defined
in the Alerts tab, to keep them informed about the reject in quarantine.
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Modifying the Order of Priority of the Applicative Rules
In the Applicative rule table, the order of priority is from top to bottom. For instance, the first applicative
rule defined, #1, would be considered the highest priority rule, followed by the second rule, #2, and so on
with more rules. However, you can modify the priority order of previously defined applicative rules.
1. In the Applicative rule table, right-click on the entry for the rule whose priority order you want to
change.
2. From the displayed pop-up menu, select either Move > Up or Move > Down to assign to the rule a
priority number higher or lower than its current one. This modification is immediately displayed in the
applicative rule table.

Inserting a New Applicative Rule
It is possible to define a new applicative rule in the rule table and assign it directly a priority number
provided there is at least one existing rule in the table.
1. In the Applicative rule table, right-click on an applicative rule with a priority value immediately
preceding or following that of the rule to be inserted.
2. From the displayed pop-up menu, select either New before > SMTP Applicative Rule or New after >
SMTP Applicative Rule to insert the new rule before or after the selected applicative rule.
3. To edit the rule, follow the procedures outlined in the section called “Configuring Applicative Rules”.

Configuring Alerts
1. Select the Alerts option. Options for setting the warning messages are displayed on the right.
2. Select the language of the warning message (independent from the interface language) from the
Language drop-down menu.
3. Select the recipients of the warning message by checking the desired options. By default, Notify
sender and Notify postmaster are checked.
4. To de-activate the option that advises the sender of either a non conform email or that their email has
been removed from quarantine, check the corresponding Override system message option.

Note
Both Receipt of non conform email and Email removed from quarantine notification options
are checked by default.

Note
A non conform email is:
• non analyzable ;
• with a virus
An encrypted email is considered as non conform and it is not analyzed with the antivirus.
5. To modify the standard text in the email subject header or message body type directly in the Subject
or Message fields of the appropriate warning message.
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| 147

Chapter 11. Proxies and Content Analysis

Configuring ID Masking
1. Select the Identity masking option.
2. To mask the IP address of the message's submitter (normally present in the SMTP packet), drag and
drop the hosts or networks into the Masked hosts field. The FAST360 appliance masks the IP address
by replacing the source IP address with x.x.x.x.

Note
The hosts and networks that you drag and drop into the Masked hosts field have been previously
defined in the Hosts and Networks folders in the Network objects explorer view.

Configuring Advanced Parameters
1. Select the Advanced option.
2. Set the value for the number of mails that can be analyzed simultaneously in the Maximum number
of concurrent analysis field.
3. Select one of the three options for setting the Resubmit Frequency of waiting emails:
• Every mn, for the frequency expressed in minutes
• Every h at th minute, for the frequency expressed in hours and minutes
• Check every day at, for a specific time expressed in hours and minutes within 24 hours
4. To generate a copy of quarantined files to be put in the code, check the Archive emails out of the
quarantine box in the Advanced option. This will copy the quarantined file to the following directory:
/var/mail/badmails.

Note
It is not possible to access this directory from Arkoon Manager or Arkoon Monitoring .

11.3.2. Domain Routing for the SMTP Proxy
Certain network topologies may require you to specify domain routing rules for SMTP traffic. For example,
if your mail server is hosted by your ISP you will need to define a domain routing rule to ensure that
the SMTP proxy forwards emails to the ISP-based server, rather than routing mails directly to their
destination domains.
You can specify multiple routing rules to manage the routing of mail from different domains.
1. In the Mail configuration form, select the Mail routes folder.
2. Right-click in the blank SMTP routes table, select New > Domain route. The Domain route dialog box
appears and a new entry is displayed in the SMTP routes table.
a. Enter the name of the route and a short description in the corresponding fields.
b. Select the domain routing rule from the Domain options:
• Check Default route to route all mails (unless covered by another domain-specific routing rule)
to the server to be specified in the SMTP server field.
• Check the Custom domain option and enter the domain name to route mails for the specified
domain to the server specified in the SMTP server field. Enter the name in the form example.com.
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To include all sub-domains (e.g. server1. example.com, server2. example.com, etc.) include a full
stop before the domain name: .example.com.
c. Select the server to which mail will be routed, using one of two methods:
• Check the SMTP server option and then drag and drop a host object into the corresponding field.
• Check the Hostname option and enter the full-qualified domain name of the server in the
corresponding field. If required by your network topology, check the Resolve using MX field
(Mail Exchange records).

Examples
1. You run an internal mail server at IP address 10.0.0.21, for your corporate domain “example.com” (e.g.
email for any.user@example.com). A single domain routing rule is needed:
• In the Custom domain field, enter “example.com” as the domain name.
• Select the SMTP server option and drag and drop a host object for your mail server at 10.0.21
The SMTP proxy will transfer mail for example.com users to your mail server, and route all other
mail according to DNS lookup.
2. Your e-mail is hosted by your ISP at address 192.168.10.10, with SMTP relaying with hostname smtp.myisp.com. You want to route all mails from the proxy through your ISP server. A single domain routing
rule is needed:
• Select the Default route domain routing option.
• Check the Hostname option and enter “smtp.my-isp.com” in the corresponding field.

11.4. POP3 Proxy Configuration
This section describes the working mode of the transparent POP3 proxy. This proxy is used for antivirus
analysis of the POP3 flows on the fly. It exists only in transparent mode.
This section presents:
• The mechanisms of the POP3 proxy
• The configuration parameters
• The information logged in Arkoon Monitoring

11.4.1. Mechanisms of the POP3 Proxy

POP3 Proxy Configuration
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Proxy in Transparent Mode
The POP3 proxy works in transparent mode. This means that the POP3 clients are configured to
interrogate the POP3 server. The FAST360 appliance, between the client and the server, intercepts these
flows and redirects them towards the POP3 proxy that processes them. Thus, the POP3 proxy interrogates
the server (and not the client). The proxy transmits the answers to the POP3 client according to its
configuration.

Synchronous, Asynchronous and Hybrid Modes
The POP3 proxy can have several different behaviors in relation to the client:
• In synchronous mode, the proxy submits the data to the client as soon as it receives it from the server;
it submits the final data only when it has confirmed that the message is not infected.
• In asynchronous mode, the proxy completes the analysis first before submitting the entire message
to the client.
• In hybrid mode, the proxy operates in asynchronous mode on messages smaller than a pre-set
threshold.
The following example shows a POP3 connection with an Outlook Express client.
+OK POP3 server ready
USER test
+OK User name accepted, password please
PASS password
+OK Mailbox open, 2 messages
STAT
+OK 2 4428
LIST
+OK Mailbox scan listing follows
1 1476
2 1476
.
RETR 1
+OK 1476 octets
Return-path: <test@formation.arkoon.net>
[...]
.
RETR 2
+OK 1476 octets
Return-path: <test@formation.arkoon.net>
[...]
.
DELE 1
+OK Message deleted
DELE 2
+OK Message deleted
QUIT
+OK

The following sections detail the proxy's behavior, in synchronous and in asynchronous mode, if a virus
is detected in the second downloaded mail.

Characteristics of the Synchronous Mode
If a virus is detected in the second mail and the FAST360 appliance has already begun to submit the
data to the client, the FAST360 appliance aborts the connection on the client side. Since the client only
received a part of the message, the virus is not effective. The proxy also requests the server to delete
the infected mail (this corresponds to the Quarantine default option).
The following diagram shows the exchange of commands in synchronous mode.
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Figure 11.1. Exchange of Commands in Synchronous Mode

This mode has the following consequences:
• The POP3 proxy cannot send the client a warning mail notifying the presence of a virus as the POP3
proxy has already begun to send the data to the client; if a virus is detected, the only solution is to
abort the connection.
• With some mail clients, mails can be received twice. In the example above, mail #1 was received, but
the connection with the client was aborted before it submitted the DELE 1 suppression command. This
mail will thus be retrieved again at the next connection. This problem does not occur in the case of a
mail client which submits the DELE command after each RETR command.

Characteristics of the Asynchronous Mode
In asynchronous mode, if a virus is detected in the second mail no mail data is sent to the client when
the antiviral analysis detects the presence of the virus. The POP3 proxy submits a warning mail notifying
that the mail is infected. The connection continues normally.
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Figure 11.2. Exchange of Commands in Asynchronous Mode

The warning mail submitted by the proxy has postmaster@domaine.fr as default submitter where
“domaine.fr” corresponds to the domain name indicated in the hostname of the FAST360 appliance (of
myArkoon.domain.fr type).

Note
It is not possible to deactivate the submit of a warning mail to the client; The client expects to
receive a message after the submit of its RETR command.
Asynchronous mode is more manageable for the client than synchronous mode but can sometimes
timeout on the client side if the antiviral analysis of mail takes too long. The possibility of a timeout
depends on:
• The size of the mail to be analyzed
• The timeout value of the mail client
• The throughput of the connection available to the FAST360 appliance for downloading the mail from
the server
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Characteristics of Hybrid Mode
Hybrid mode combines the benefits of asynchronous and synchronous modes. In hybrid mode, you define
a hybrid mode threshold. This enables the POP3 proxy to change its behavior depending on message size.
The POP3 proxy starts out in asynchronous mode but switches to synchronous mode when it receives
messages larger than the threshold. This avoids some of the drawbacks linked to synchronous mode
(timeouts, duplicate mails, and so on).

Note
Most messages containing SPAM or viruses are small. In hybrid mode these messages are
blocked transparently, as they are below the threshold size, so the proxy is operating in
asynchronous mode. However, there is no risk of losing larger mails – for example, mails with
attachments – as the proxy switches to synchronous mode for these larger mails.

Cases of Typical Architectures
It is possible to implement the POP3 proxy for output connections (from local network to the Internet
for instance) and for input connections (from the Internet to a hosted server for example). For an input
connection, the filtering rule used to implement the transparent POP3 proxy can include a PAT- or Static
NAT-translation on a destination host.

11.4.2. Setting the POP3 Proxy
As the proxy works in transparent mode, you must write a filtering rule to intercept the POP3 flow sent to
the server and to redirect it towards the proxy. In the filtering rule, select a POP3 service for which the
FAST module, and the redirection towards the transparent POP3 proxy, have been activated.

Note
For an input flow, the filtering rule can also include a PAT- or Static NAT-translation on a
destination host. Selecting a masquerading translation has no effect on the way it works since
the proxy of the FAST360 appliance initiates a new connection toward the POP3 server.
The following proxy characteristics must be defined:
• Choice of mode (synchronous or asynchronous)
• Options for antiviral analysis (quarantining, etc.)
Configuring the antivirus POP3 proxy is a multi-step procedure that includes the following steps:
• Defining an appropriate service
• Defining an appropriate flow filtering rule
• Activating and configuring the POP3 proxy

Setting the POP3 Proxy
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11.4.3. Antivirus POP3 Proxy
Defining a Flow for the POP3 Connection
The first step in the configuration of the antivirus POP3 proxy is to define a flow to intercept the flow sent
by the client to the POP3 server and redirect it to the POP3 proxy.
1. In the default layout, select the Rules navigation tab from the left hand side of the main window.
2. In the explorer view, create a new rule by right-clicking on the Rules folder, select New > Rule. The
Rule configuration tab is displayed on the right and the entry is displayed in the descriptive view.
3. In the Properties configuration form:
a. Enter the name of the rule (for example, POP3_in) in the Name field.
b. Enter a comment in the Description field.
4. In the Criteria configuration form:
• Drag and drop the destination LAN into the Sources field.
• Drag and drop the Internet object into the Destinations field.
• Drag and drop the POP3_with_proxy service previously created into the Services field.

Note
The Internet and LAN objects have been previously created in the Networks folder of the
Network objects folder.
5. In the Action configuration form:
a. Check the Accept option.
b. Right-click in the blank area of the Rule translations table, select New > Translation Element from
the drop-down menu. The Translation Element dialog box appears.
c. Check the Source translation and Masquerading options.

Note
It is not possible to place a rule authorizing the TCP protocol on the 110 port before the newly
created rule. For more detailed information on this topic, see the section called “Reading
Order of Filtering Rules ”.

Activating the Antivirus POP3 Proxy
You must set the proxy to work in either synchronous, hybrid or asynchronous mode, particularly if the
FAST360 appliance is located between the POP3 proxy and the client.

Note
Activating the POP3 proxy creates an implicit rule authorizing the FAST360 appliance to send a
POP3 flow to the Internet.
1. In the Mail configuration form, select the POP3 folder. The options to be configured are displayed on
the right.
• Check the Hybrid option to set the proxy to work in hybrid mode. In hybrid mode the proxy works first
in asynchronous mode (modifying the mail or returning an error) and then switches to synchronous
mode (avoiding timeout problems with large mail) as soon as the mail size is greater than the
threshold.
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• Set the threshold in the Asynchronous until field. The threshold value is defined in Kbytes.
• Check the Repair infected email option if required.
• Check the Enable spam filtering option to embed the POP3 proxy with antispam filtering (to set
this antispam filtering, see Section 11.6, “Antispam Analysis”).
• Check the Synchronous option to set the proxy to work in synchronous mode. Synchronous mode
allows the client to receive messages in real time (there is no need to wait until the FAST360
appliance has reassembled the IP packets). The drawback is the connection will be interrupted
every time an infected file is detected.
• Check the Asynchronous option to set the proxy to work in asynchronous mode. In this mode the
FAST360 appliance has to reassemble the IP packets before delivering the message to the client.
Thus, the message will be delivered to the client mail only if it is virus-free. Its drawback is that
the client mail does not receive any other data while the FAST360 appliance is recuperating the
message. Depending on the application used, the client mail generates a timeout if the message is
too big. If the message is rejected, the recipient receives a warning message.
• Check the Repair infected email option if required.
• Check the Enable spam filtering option to embed the POP3 proxy with antispam filtering (to set
this antispam filtering, see Section 11.6, “Antispam Analysis”).
• Check the Quarantine option to quarantine the email.
• Check the Remove rejected emails from POP3 server option to completely remove (message and
possible attached file(s)) problematic emails (generally containing a virus). Because some packets
are already loaded by the client mail, corrective action cannot always be performed.
• Check Notify the postmaster to activate this option. The postmaster must be previously defined in
the Postmasters table in the General folder of the Mail configuration tab.
• Select the action you want the proxy to perform on encrypted email from the options in the Allow
encrypted files drop-down list.
• Select the action you want the proxy to perform on emails which cannot be analyzed from the
options in the Allow non-analyzable files drop-down list.

Note
Even when activated, the quarantine feature cannot perform corrections or automatic routing.
Therefore, the administrator must do it using the Arkoon Monitoring tool. Further, as it is often
not possible to open encrypted and non-analyzable files to check their content (as they are often
password protected), the administrator must choose how to treat them using Arkoon Monitoring .

11.5. Antivirus Analysis
11.5.1. Transparent POP3 Proxy
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| 155

Chapter 11. Proxies and Content Analysis

Checking the Proxy
There is no log for the POP3 proxy. To check that the POP3 flow has been correctly redirected towards
the proxy, see the IP logs to verify that the output interface of the POP3 proxy is logged.

In Case of Virus
When a virus is detected, a Virus detected alert is created. If quarantining has been configured, and
provided it is not full, the mail appears in the Quarantine window of the Arkoon Monitoring tool.

11.6. Antispam Analysis
11.6.1. Email Security Challenges
Network administrators face ever-increasing numbers of sophisticated email-borne threats to their
networks. Spam emails infiltrate your users' Inbox with unsolicited, often offensive mail, and in the
case of phishing messages are sent with the express intent to defraud. Spammers are more numerous,
more devious, and more malicious, constantly re-inventing ways to evade existing spam detection
systems. Spam outbreaks, whether for commercial or criminal purposes, are characterized by outbreaks
of extremely large amounts of mail messages, released within a short period of time from a network of
“zombie” machines.
The outbreak can contain different types of spam messages, as well as individual messages that combine
a number of anti-detection methods in the same message to complicate the detection process. Common
methods to evade content filters based on lexical analysis include masking the originator or sending
machine of the spammers, manipulating or hiding commercial URLs, use of non-English words and
phrases, use of images.
The FAST360 appliance provides two types of antispam analysis:
• Heuristic antispam analysis
• Real-time antispam analysis
Heuristic spam analysis uses multiple analysis techniques, including DNS Blacklists, database rules,
language recognition, etc., to filter and block spam messages according to their content. Real-time
antispam analyzes emails for a unique value which identifies them as part of a spam outbreak. This
section will describe both methods, their relative advantages and disadvantages, and how to configure
the FAST360 appliance to perform these types of antispam analysis.
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11.6.2. DNS Blacklists
This section describes the FAST360 DNSBL functionality (DNS-based Blacklists), its principles as well
as its implementation.
DNS blacklists are lists of IP addresses known for propagating spam. They can be queried using the DNS
protocol. The FAST360 SMTP relay can query the list as to whether it should accept or not a mail coming
from a given IP address.

DNSBL Operation
DNSBL Querying
DNSBL querying is done by a simple DNS query. If the address is blacklisted, the server will return as
many records as the number of reasons to blacklist this address: open SMTP relay, open HTTP proxy, etc.
These records contain the reason the address has been blocked as well as a URL providing more details.

Example 11.1. DNSBL record
"Blacklisted by dnsbl-domain.zzz (OpenRelay)- http://..."

DNSBL Servers
There are many DNSBL servers available on the Internet. They do not all have the same policy or the
same methods for adding or removing entries into the blacklist. Therefore, it is important to choose them
carefully.
Depending on the server, IP addresses can be blacklisted for the following reasons:
• Open Proxy Servers (HTTP, SOCKS, etc.)
• Open SMTP Relay
• DialUp Networks
• Vulnerable servers (WWW, RPC, etc.)
• Known spammers

Caution
It is essential that the anti-relaying rules of your FAST360 SMTP relay are well configured;
otherwise, there is a risk that it will be detected as an open relay by one of the servers and then
blacklisted.

Note
The use of the DNS blacklists is based on public servers. It is your decision whether to use them
or not, bearing in mind that a part of the mail processing policy is transferred to an external entity.

Use of DNS Blacklists by FAST360 Appliances
The use of DNSBL servers is integrated into the SMTP relay and makes it possible to block mails relayed
from a questionable origin (blacklisted IP address). This enables you to:
• Refrain from testing some IP addresses (internal servers, for instance)
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• Add a whitelist system to avoid blocking legitimate servers that are regularly blacklisted
• Not use DNS blacklists for mails intended for some users

Behavior in the Case of a Blacklisted Address
If the FAST360 appliance denies relaying a mail because of an anti-relaying rule that forbids using
blacklisted addresses, it will generate an SMTP error.

Example 11.2. SMTP Error
220 arkoon hi there
HELO ml
250 arkoon pleased to meet you, ml
MAIL FROM:<user@domain1.com>
250 sender is <user@domain1.com>, sender OK
RCPT TO:<user@domain2.com>
550-Your IP (192.168.1.1) is blacklisted by DNSBL:
550- dnsbl1.zzz [Blacklisted by dnsbl1.zzz - http://...]
550- dnsbl2.zzz [Blacklisted by dnsbl2.zzz (Open Relay) - http://...]
550 Access Denied (mail from <user@domain1.com> to <user@domain2.com>)
QUIT
221 Closing connection

Normally, the transmitting server sends an error message to the mail transmitter indicating that the mail
was denied and gives the reason. This enables the transmitter to take the required measures so that the
IP address of its SMTP relay is no longer blacklisted.

Example 11.3. SMTP Error Message
This message was created automatically by mail delivery software
(Exim).
A message that you sent could not be delivered to one or more of its
recipients.
This is a permanent error. The following address(es) failed:
user@domain2.com
SMTP error from remote mailer after RCPT TO:<user@domain2.com>:
host arkoon [192.168.100.10]: 550-Your IP (192.168.1.1) is blacklisted
by DNSBL:
550- dnsbl1.zzz [Blacklisted by dnsbl1.zzz - http://...]
550- dnsbl2.zzz [Blacklisted by dnsbl2.zzz (Open Relay) - http://...]
550 Access Denied (mail from <user@domain1.com> to <user@domain2.com>)

11.6.3. Heuristic Antispam Analysis
Arkoon FAST360 UTM appliances include an optional heuristic antispam engine. When the SMTP or POP3
proxy receives a message, it can be analyzed and scored as spam on a probability basis by the heuristics.
As the administrator, you can program the type of response (tag, quarantine, or reject) on the basis of
the scores set by the heuristics.

Note
The heuristic antispam feature is being deprecated.
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Heuristic Antispam Technology
The Arkoon FAST360 heuristic antispam engine uses multiple analysis techniques to increase the
accuracy of the spam detection engine:
•
•
•
•
•
•
•
•

Heuristic filtering on message headers
Heuristic filtering on subject line
Heuristic filtering on message body
Language recognition
DNSBL verification
URL analysis
Black and whitelist management
Analysis based on pre-defined rules

Heuristic filtering involves detecting elements commonly found in spam mails. The FAST360 antispam
analysis carries out approximately one hundred such tests on each message. These tests include
checking for the presence of particular words (or variants), certain fonts, and the presence of JavaScript.
The outcome of these tests is used to allocate a score to the message. The score is weighted depending
on the likelihood that a particular feature means that the message is spam.
The Arkoon FAST360 heuristic antispam engine also checks which language the mail is written in and
can reject those written in a language that has been defined as “undesirable” by the administrator
The Arkoon FAST360 heuristic antispam engine checks external databases by sending DNS requests both
to DNS Blacklists (DNSBLs ) — databases providing IP addresses known to propagate spam — and to
Spam URI Realtime Block Lists (SURBLs) – lists of sites used by spammers or for phishing. The presence
of either an IP address in the From field or of a URL in the message body increases a message’s score.

Note
DNS blacklists are external information sources used to fight against spam. There are a large
number of them and they are of variable quality. Arkoon constantly monitors blacklist servers to
ensure the heuristic antispam engine is using the most accurate and relevant ones. The antispam
engine does not use DNSBLs in a binary way – in other words, the presence of a listed IP address
on its own is not enough to classify a mail as spam; this reduces the number of incorrectly blocked
mails.
Finally a meta-engine evaluates the test results and determines the final score.

Note
The heuristics used by the Arkoon FAST360 antispam engine are updated automatically. Update
frequency depends on changes in spamming techniques.

Configuring the Heuristic Antispam Engine
1. In the default layout, select the Policies navigation tab from the left hand side of the main window.
2. In the explorer view, create a new heuristic antispam policy by right-clicking on the Antispam Policies
folder, New > Heuristic antispam. Three levels of filtering are available, with pre-configured tagging,
reject and quarantine values:
• Heuristic antispam (Aggressive)
• Tagging threshold is set to 4.0 by default.
• Reject threshold is set to 8.0 by default.
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• Quarantine threshold is set to 4.0 by default.
• Heuristic antispam (Normal)
• Tagging threshold is set to 6.0 by default.
• Reject threshold is set to 12.0 by default.
• Quarantine threshold is set to 6.0 by default.
• Heuristic antispam (Low)
• Tagging threshold is set to 8.0 by default.
• Reject threshold is set to 16.0 by default.
• Quarantine threshold is set to 8.0 by default.
3. In the Properties configuration form of the desired heuristic antispam policy, enter an appropriate
name and short description in the corresponding fields.
4. In the General configuration form:
a. Define the maximum size of the message analyzed by the antispam engine in the Maximum email
size field. Most spam is less than 64 kB (spam merchants do not want to overload their own servers
by sending out large files). Note, the setting of this threshold has a slight impact on the process
time of the antispam engine.
b. In the Threshold field, alter if required the default value above which mail is tagged as spam.
Any mail scoring less than this value is forwarded without any further treatment by the FAST360
appliance.
c. Check the Reject threshold option to enable the FAST360 appliance to immediately reject the
receipt of a mail scoring above the reject threshold. If the email address is legitimate, the submitter
will receive a bounce message notification submitted by the mail gateway which attempted to
submit the mail (reject reason is notified: considered as spam). This option prevents abusive use of
resources (forwarding, antivirus analysis, submit of DNS if the recipient does not exist, etc.) when
there is a strong probability that the message is spam.
d. Check the Redirect spam to a quarantine mail address (SMTP only) option:
i. In the Quarantining threshold field, specify the threshold above which mail is forwarded to
the quarantine mailbox instead of being forwarded to the intended recipients. The quarantine
threshold must be equal to or greater than the tagging threshold.
ii. Enter the quarantine mailbox address in the corresponding field. Note, mail is sent to the
quarantine mailbox tagged as spam because the quarantine threshold is equal or greater than
the tagging threshold. The RCPT TO header is modified with the address of the quarantine
mailbox, and all the original recipients' addresses, including “hidden” (i.e. cc, bcc) recipients
are listed in a customer XSpamRcpt header.

Note
As spam mailers are constantly using new techniques to avoid detection, you may have
to adjust the sensitivity thresholds, depending on results, to find the appropriate level of
spam rejection which does not result in false positives or the rejection of legitimate mail.
e. Check the Enable external queries (DNSBL, SURBL ...) option to enable the antispam engine to
consult external knowledge bases. The antispam engine sends DNS requests to DNS Blacklists and
also to URL bases (SURBL) pointing to spammers or phishing sites. The presence of IP addresses
(in the Received from: headers) and URLs (in the body of a message) increase the global score
of the analyzed mail. This option is recommended because it considerably increases the spam
capture rate.
5. In the Tagging configuration form:
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a. Check the Add a prefix to the email subject option and select either the default text [SPAM] or add
text in the corresponding field to appear in the mail subject if desired.
b. Check the Encapsulate email option to enable the antispam engine to rewrite messages
considered as spam and encapsulate the original message in an attached file. When a spam
message is encapsulated, a new multipart message is generated. Its subject is modified with a
prefix if the AddPrefix option is enabled. The message contains a generic text (that can be modified,
see below). The multipart message is followed by a report detailing the technical rules which
deemed the message to be spam. The original message is appended as an attached file.
i. Check the Customize default report option and add the text in the corresponding field to
customize the standard explanation for mail encapsulation.

Note
Encapsulating spam increases security and protection against spam. By placing the
spam content in an attached file, images can only be seen if specifically desired.
External/attached HTML objects are not downloaded either.
6. In the Enable language filtering configuration form, check the Enable language filtering option.
a. Select the type of action to be performed on mails identified according to the selected languages:
• Check Deny the following languages to reject all mails in the selected languages.
• Check Accept the following languages to accept all mails in the selected languages.
b. Check the languages to be detected by the antispam engine.

Note
Language analysis is independent of antispam analysis. A mail identified as written in an
unauthorized language is rejected, even if the mail is not considered as spam by the engine.
Further, some mails can be incorrectly identified, for instance mails containing little text or
mails containing multilingual disclaimers.
7. In the White/Black lists configuration form:
a. Drag and drop the sources (host, networks, etc.) from which mails will not be analyzed by the
antispam engine or the language module into the IP Sources field of the Whitelist section.
b. Add the email address of submitter(s) from which mails will not be analyzed by the anti-spam engine
or the language module into the From table in the Whitelist section. Enter domains using * metacharacter (for example, *@arkoon.net).

Note
Using a white list is an important addition to the filtering capability. It enables you to set
the filter more aggressively while avoiding classifying legitimate messages as spam.
c. Drag and drop the sources (host, networks, etc.) from which mails will be systematically rejected
by the antispam engine or the language module into the IP Sources field of the Blacklist section.
d. Add the email address of submitter(s) from which mails will be systematically rejected by the
antispam engine or the language module into the From table in the Blacklist section. Enter domains
using * meta-character (for example, *@arkoon.net).

Note
Submit addresses and domain names can be easily forged in the mail box. The more popular
or well-known domains have a greater likelihood of being usurped by spammers. Further, as
spammers change their submit addresses very frequently, this technique is not very efficient
at reducing spam. Blacklists are best to act against punctual spam attacks or mail bombing.
8. Select the Mail configuration form from the FAST360 appliance configuration tab.
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9. Select the Antispam folder.
10.Drag and drop the previously configured Heuristic antispam policy from the descriptive view into the
Antispam policy field of the Antispam folder.

Configuring an External Antispam Server
1. In the Network objects explorer view, configure a host with external Spam Assassin capacity:
a. Create a host object.
b. In the Services configuration form, check the SpamAssassin Server option. The fields to be
configured are displayed on the right.
c. If required, redefine the TCP port for the connection to the Spam Assassin server in the Listening
port field. The default port is 783.
d. If required, check the Enable SSL connection option to enable a Secure Sockets Layer connection.

2.

3.
4.
5.

6.

7.

If required for the SSL connection, check the Authenticate server certificate option and select
the authentication mode:
• Select either a server certificate or a CA certificate from the Trusted X.509 certificate drop-down
list.
• Drag and drop the required certificate into the X.509 Certificate field.
In the Policies explorer view, create a new antispam policy by right-clicking on the Antispam Policies
folder, New > External Server Antispam Policy. A new external server antispam policy configuration
tab is displayed on the right.
In the Properties configuration form, enter a name for the policy and a short description in the
corresponding fields.
In the General configuration form, drag and drop the host previously configured with Spam Assassin
server capability into the Spamd server field.
If desired, define the maximum size of messages to be analyzed by the antispam engine in the
Maximum size of messages to be analyzed field. Most spam is less than 64 Kb. Setting this threshold
has a slight impact on the antispam engine's processing time.
In the Reject spam messages field, set the value at which the SMTP proxy will deny the receipt of a
mail with a score greater than this reject threshold. If the email address is legitimate, the submitter
will receive a bounced message notification emitted by the mail gateway that attempted to emit the
mail (this notification quotes the deny reason: considered as spam). This option avoids the excessive
use of resources (forwarding, antivirus analysis, submitting of a DNS query, in case the recipient does
not exist) when the probability is high that the message is spam.
Check the redirect spam to a quarantine mail address (SMTP only) option:
a. In the Quaranting threshold field, specify the threshold above which mail is forwarded to the
quarantine mailbox instead of being forwarded to intended recipients. The quarantine threshold
must be equal or greater than the tagging threshold.
b. Enter the quarantine mailbox address in the corresponding field. Note, mail is sent to the quarantine
mailbox tagged as spam because the quarantine threshold is equal or greater than the tagging
threshold. The RCPT TO header is modified with the address of the quarantine mailbox, and all the
original recipients' addresses, including “hidden” (i.e. cc, bcc) recipients are listed in a customer
XSpamRcpt header.

Note
Analyzing and filtering email for spam is not an exact science, and spam mailers are
constantly using new techniques to avoid detection. For these reasons, you may have to
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adjust the sensitivity thresholds, depending on results, to find the appropriate level of spam
rejection which does not result in false positives or the rejection of legitimate mail.
8. Select the FAST360 appliance configuration tab.
9. In the Mail configuration form, check the Antispam option.
10.Drag and drop the previously configured external server antispam policy into the Antispam policy
field.

Note
You could use the Open-Source project SpamAssassin server as an external SPAMD server
(http://www.spamassassin.org).

11.6.4. Real-time Antispam Analysis
The FAST360 appliance also offers a real-time antispam engine to filter and block spam email. The engine
uses a central datacenter which collects and analyzes message patterns in email messages in order to
rate their “spam score”.

Real-time Antispam Technology
The FAST360 real-time antispam mechanism uses message patterns to detect mails belonging to part
of a spam outbreak. Although spammers use a combination of mails composed of different spamming
techniques to avoid content filters, all messages within the same spam attack share at least one unique
value that can be used to identify them as belonging to that outbreak. For example, different spam attacks
launched from the same network of zombie machines and phishing messages leading recipients to the
same faked URLs would be classified as recurring values, “message patterns” of typical outbreaks.

FAST360 Real-time Antispam Mechanism
The antispam engine extracts the message patterns from the message envelope, headers, and body. As
the mechanism does not rely on message content analysis, it can detect spam and phishing methods
in any language or format, including images, HTML etc. The antispam engine then classifies both
distribution patterns (way it is distributed to the recipients) and structure (volume of the distribution)
patterns to determine whether the message poses a threat or not. This information is stored in the
datacenter's repository of threat patterns. New messages arriving at the SMTP server are passed
to the antispam engine for analysis. The antispam engine sends a query containing a collection of
hash signatures representing patterns of the message to the datacenter. The datacenter classifies
the message patterns and sends this classification (“spam score”) back to the antispam engine. The
antispam engine applies predefined rules (tag, reject, quarantine) to the message according to its
classification:
• Confirmed Spam: spam messages from known spam sources, e.g. zombies.
• Bulk: spam messages from sources that are not confirmed spammers.
• Suspected Spam: legitimate messages that are sent to a slightly larger than average distribution or
are unidentified spam messages in the first few seconds of a massive spam outbreak.
• Unknown: messages for which the antispam engine does not have any incriminating information, and
are therefore assumed to represent legitimate correspondence.
• Non-Spam: messages that are confirmed, without doubt, as coming from trusted source. Note, this
classification is rarely used.
The antispam engine stores the information in a local detection cache which makes future local
classification more efficient and also can be used in case communication with the datacenter is
temporarily unavailable when incoming messages still need to be classified. Note, information from the
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messages handled by the antispam engine is not conveyed transparently between the FAST360 appliance
and the datacenter repository as the antispam engine only sends a hash of the message, from which the
actual information cannot be reconstructed.
Customer privacy is protected as the datacenter processes are fully automated, require no manual or
human intervention and do not hold or reuse any information from the message content to improve
its performance. For customers who wish an enhanced privacy solution, the antispam engine can be
configured to hash descriptive information about the message in the one-way hashing, MD5 algorithm.
Further, no data from the query is stored on any server or database at the datacenter unless explicitly
requested.
The following diagram illustrates a typical case of inbound email analysis by the antispam engine.

Figure 11.3. Inbound Email Analysis by the Antispam Engine

Note
The following information is added to any analyzed email in the form of SMTP headers:
• Version of the antispam engine, for example:
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X-F360-PVer: 0000001
• Spam classification result, for example:
X-F360-Spam: Confirmed
In case of classification error, the following X-F360-Spam header is used (the others remain
empty):
X-F360-Spam: Analysis Error
• Reference ID of the current spam analysis. This ID will be used if the email later requires
reclassification. For example:
X-F360_REFID: str=0001.0A090204.43D8B3EB.0038,ss=4,vl=2,fgs=0

Benefits of Real-time Antispam Technology
The immediate response of the real-time antispam engine means that it is very effective at limiting the
damage that spam attacks can cause as typically it is able to classify and block any messages before
they reach recipients within the first few minutes of the outbreak. As the mechanism does not analyze
the content of the message, the number of false positives is greatly reduced.
Using our real-time antispam technology, the Arkoon FAST360 appliance provides:
• High detection rates, due to the real-time database
• Effective protection against all types of spam, including HTML, UTF-16, Chinese characters, etc.
• Detection and protection against “image spam”.

Configuring the Real-time Antispam Engine
1. In the default layout, select the Policies navigation tab from the left hand side of the main window.
2. In the explorer view, create a new real-time antispam policy by right-clicking on the Antispam Policies
folder, New > Real-time antispam. Three levels of filtering are available, with pre-configured tagging,
reject and quarantine settings:
• Real-time antispam (Agressive)
• Tagging threshold is set to “suspected spam” by default.
• Reject threshold is set to “bulk” by default.
• Quarantine threshold is set to “bulk” by default.
• Real-time antispam (Normal)
• Tagging threshold is set to “bulk” by default.
• Reject threshold is set to “confirmed spam” by default.
• Quarantine threshold is set to “bulk” by default.
• Real-time antispam (Low)
• Tagging threshold is set to “confirmed spam” by default.
• Reject threshold is set to “confirmed spam” by default.
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• Quarantine threshold is set to “bulk” by default.
3. In the Properties configuration form of the desired real-time antispam policy, enter an appropriate
name and short description in the corresponding fields.
4. In the General configuration form:
a. Define the maximum size of the message analyzed by the antispam engine in the Email maximum
size field. Most spam is less than 64 kB (spam merchants do not want to overload their own servers
by sending out large files). Note, the setting of this threshold has a slight impact on the process
time of the antispam engine.
b. In the Threshold field, alter if required the default setting to tag mail according to the policy.
Any mail scoring less than this value is forwarded without any further treatment by the FAST360
appliance.
c. Check the Reject option to enable the FAST360 appliance to immediately reject the receipt of a mail
scoring above the reject threshold. If the email address is legitimate, the submitter will receive a
bounce message notification submitted by the mail gateway which attempted to submit the mail
(reject reason is notified: considered as spam). This option prevents abusive use of resources
(forwarding, antivirus analysis, submit of DNS if the recipient does not exist, etc.) when there is a
strong probability that the message is spam.

Note
Tagging is only available with the POP3 mail proxy.
d. Check the Enable quarantine option:
i. In the Quarantine threshold field, specify the threshold above which mail is forwarded to the
quarantine mailbox instead of being forwarded to intended recipients. The quarantine threshold
must be equal or greater than the tagging threshold.
ii. Enter the quarantine mailbox address in the corresponding field.

Note
Mail is sent to the quarantine mailbox tagged as spam because the quarantine threshold
is equal or greater than the tagging threshold. The RCPT TO header is modified with the
address of the quarantine mailbox, and all the original recipients' addresses, including
“hidden” (i.e. cc, bcc) recipients are listed in a customer XSpamRcpt header.
5. In the Tagging configuration form:
a. Check the Add prefix to email subject option and select either the default text [SPAM] or add text
in the corresponding field to appear in the mail subject if desired.
b. Check the Encapsulate mail option to enable the antispam engine to rewrite messages considered
as spam and encapsulate the original message in an attached file. When a spam message is
encapsulated, a new multipart message is generated. Its subject is modified with a prefix if the
Add prefix to email subject option is enabled. The message contains a generic text (that can be
modified, see below). The multipart message is followed by a report detailing the technical rules
which deemed the message to be spam. The original message is appended as an attached file.
i. Check the Customize default report option and add the text in the corresponding field to
customize the standard explanation for mail encapsulation.

Note
Encapsulating spam increases security and protection against spam. By placing the
spam content in an attached file, images can only be seen if specifically desired.
External/attached HTML objects are not downloaded either.
6. Select the Proxy configuration form:
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a. If desired, check the Use HTTP proxy option and drag and drop a host object to serve as a proxy to
contact the datacenter into the HTTP proxy field. Note, the HTTP proxy capacity must be configured
in the Services configuration form of the host serving as the proxy.
b. Check the Enable authentication option and enter the user's name, password and confirm the
password in the corresponding fields.
7. Select the Mail configuration form from the FAST360 appliance configuration tab.
8. Select the Antispam folder.
9. Drag and drop the previously configured Real-time antispam policy from the descriptive view into the
Antispam policy field of the Antispam folder.

11.6.5. Configuring Email Clients to Manage Tagged Spam
The FAST360 antispam engine tags the subject line of suspect emails. This means that email clients can
identify and filter them automatically. The default tag is « [SPAM] » - you can change this using Arkoon
Manager

Note
If you have users who do not want to use the antispam facility, do not set a message rejection
threshold for them, and do not configure their mail client to filter out potential spam. In this way,
your remaining users continue to benefit from antispam filtering.
It is easy to configure mail clients to move messages tagged as spam to a specified directory. Below are
two examples – most mail clients behave in a similar way.

Configuring a Thunderbird (V. 1.0.2) Message Client
1. Choose Message Filters from the Tools menu
2. Click New. Give your filter a name, for example « antispam filter ». Choose subject, contains from the
drop-down menus, and enter the appropriate tag in the next field.
3. Check Copy to folder and select or create a directory.

Configuring an Outlook ® 2003 Client
1. Choose Rules and Alerts from the Tools menu, then click on New rule.
2. Next choose Start creating a rule from a template and Move messages with specific words to a
folder. In the bottom pane, click on Specific words.
3. Enter the prefix you configured using the Arkoon Manager (for example [SPAM]) in the Specify words
or phrases to search for in the subject field of the Search text window.
4. Then specify the folder to move the mail to, for example Junk Email.

Note
Some mail clients have a built-in antispam capability. Trying to combine FAST360 antispam with
a mail client’s antispam can lead to confusion in filtering rules and is not recommended.
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Chapter 12. FAST and IDPS
This chapter looks at how to configure the FAST360 appliance to provide advanced traffic filtering
using Fast Applicative Shield Technology for real-time contextual analysis of network traffic at the
application layer.

12.1. FAST Analysis
An Arkoon FAST360 appliance contains Fast Applicative Shield Technology (FAST) providing contextual
analysis of traffic at the application layer, in real time. FAST modules protect the security of your network
by providing three types of analysis:
• RFC conformance
Checks that traffic conforms with the relevant RFC; protects against threats using data that does not
conform, including redirection, call interception, denial of service on VOIP, and Trojan horse attacks
with binary data in HTTP headers.
• Normal use of protocol
Checks that traffic not only conforms to the RFC but also meets the normal usage patterns for the
protocol; protects against attacks or intrusive behaviors that do not violate RFCs. Such threats include
insertion of malicious data in URLs, masquerading through the use of hidden scripts in HTTP requests,
and abuse of encapsulated protocols.
• Additional rules on protocol
Checks traffic against a set of limits or rules, providing additional protection against attacks. You can
configure rules to ban or limit commands in a protocol, limit the size of commands or parameters, and
to filter downloaded files.
The analysis of a packet is done automatically up to layers 3 and 4, which form the Transport layer.
However, it is done at the application layer for the services on which a FAST module is selected.
Therefore, it is essential that the filtering rule acknowledging the packet specifies this service.
FAST modules are available for the following application layer protocols: DNS (TCP), DNS (UDP), FTP,
H323, HTTP, IMAP4, MGCP, Netbios Datagram Service (UDP), Netbios Name Service (UDP), Netbios
Session Service (TCP), NNTP, POP3, RTSP, SSL/TLS, SIP, SMTP, SNMP and SQL*NET/Net9.
The FAST360 appliance provides standard FAST modules to handle common protocols. They are listed in
the Arkoon FAST policies in the FAST policies navigation tab. You can also create your own FAST module,
as described in Section 12.1.1, “Creating a custom FAST module”.
See Section 12.1.2, “Standard FAST modules” for detailed information on the behavior of the standard
FAST modules and how to configure them.
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12.1.1. Creating a custom FAST module
This section describes the main four stages of the creation of a custom FAST module:
1. Creating a custom service.
2. Activating the FAST analysis in the custom service.
3. Creating a custom FAST policy and configuring the FAST reaction in case of protocol violation.
4. Configuring the FAST IDPS protection (optional). For more information, refer to Section 12.2, “IDPS”.

Creating a Custom Service
The Services navigation tab in Arkoon Manager is used to manage services. The services indicate
network/transport level (TCP, UDP, ICMP, etc.) or applicative (FTP, SMTP, etc.) protocols.
Many services are already configured on the FAST360 appliance, but you can also create new ones
according to your needs.
1. In the default layout in Arkoon Manager, select the Services navigation tab from the left hand side
of the main window.
2. In the explorer view, expand the Custom Services tree.
3. Create a new service by right-clicking on the desired transport protocol (TCP, UDP, ICMP) or Other
services, select New > Custom Protocol Name Service . The Custom Protocol Name Service
configuration tab is displayed on the right.
4. In the Properties configuration form, enter a name and a short description.
5. Configure the port for the service:
• For transport protocols TCP and UDP, select the General configuration form.
a. Enter the port number to attribute to the defined service in the From and To fields of the
Destination ports section. Enter the same value twice, or configure a ports range with two
different values.
b. Enter the ports' source number/range in the From and To fields of the Source ports section if you
need to force the source ports of certain specific applications.
c. If required for the TCP protocol, check the Redirect to option and select which relay to use in
transparent mode (HTTP, FTP or POP3).
• When configuring the ICMP service, select the ServiceIcmp configuration form, enter the type of
message and code in the corresponding fields. There is no value in creating services for ICMP error
messages as they are managed by the ICMP policy. For more information on the ICMP policy, refer
to Section 9.4.3, “Managing ICMP Policies”.
• If you are configuring a service other than TCP/UDP/ICMP, enter the protocol number in the
corresponding field of the Protocol configuration form.
6. Select the Security configuration form.
a. To disable the checksum, check the corresponding option.

Caution
Disabling the checksum reduces the security controls performed by the layer 4 protocol
analysis. This option must be enabled if requested by the Arkoon support in very specific
cases.
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b. To establish another active connection timeout than the default one, enable the Custom connection
timeout option and define its value in the corresponding field.

Note
By default, the connection closes if it inactive. Redefining the timeout allows you to reduce
or increase this value.

Configuring the FAST Analysis (TCP and UDP services only)
The FAST analysis is automatically done up to layers 3 and 4 (transport layer). It is carried out at the
applicative level only for the services for which a FAST module is selected.
The FAST modules are available for the following applicative protocols: DNS (TCP), DNS (UDP), FTP, H323,
HTTP, IMAP4, MGCP, Netbios Datagram Service (UDP), Netbios Name Service (UDP), Netbios Session
Service (TCP), NNTP, POP3, RTSP, SSL/TLS, SIP, SMTP, SNMP v1, v2c and v3 (UDP) and SQL*NET/Net9.

Note
In the default configuration, the protocols for which a FAST module exists are predefined with
the FAST module enabled.

Caution
The FAST analysis is performed up to the applicative level only if the filtering rule accepting the
packet specifies a service with a FAST module.
Each FAST module presents specific options which can be parameterized for two distinct purposes:
• To fit the behavior of the FAST analysis to drop an application (which does not respect the RFC
recommendations).
• To improve the FAST analysis to face specific vulnerabilities.
1. Select the FAST configuration form in the relevant TCP or UDP custom service.
2. Check the Enable FAST analysis option.
3. Drag and drop the FAST policy object into the FAST Policy field.
4. To modify the FAST policy, double-click its icon in the FAST Policy field. The FAST Policy configuration
tab is displayed.

Creating a Custom FAST Policy and Configuring the FAST Reaction
1. In the default layout in Arkoon Manager, select the FAST Policies navigation tab from the left hand
side of the main window.
2. In the explorer view, expand the Custom FAST Policies tree.
3. Drag and drop the Arkoon FAST policy you want to customize in the folder Custom FAST Policies.
Double-click the policy to edit.
4. In the Properties configuration form, enter a name and short description in the corresponding fields.
This form also contains the FAST module type.
5. In the FAST Policy configuration form, configure the reaction implemented by the FAST360 appliance
in case of protocol violation. Select the reaction from the three options of the drop-down list:
• RESET (TCP protocol only): a TCP RST packet is sent to both the attacker and the target.
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The RESET response is recommended in the case of a safe connection. If a user has entered a
command not authorized in the RFCs, it is better to close the connection with an error message
than obtain a timeout. However, a RESET response may also alert the attacker to the presence of
the IDPS defence, allowing them to alter their attack. For more information about IDPS, refer to
Section 12.2, “IDPS”.
• DROP: the connection status becomes DROPPED on both attacker and attacked sides; packets sent
later that correspond to this connection are ignored.
If IDPS is used, the DROP response silently aborts the connection without betraying the IDPS
presence to the attacker. However, it does not free the resources associated with the connection
on the attacked machine's side (since the connection remains open).

Note
When a connection is in DROPPED status, it remains in this status for 60 minutes before
disappearing from the connections table.
• HALF-DROP (TCP protocol only): the connection status becomes DROPPED only on the attacker's
side; packets sent later by the attacker are ignored while a TCP RST packet is sent to the attacked.
If IDPS is used, the HALF-DROP reaction is a compromise between the two previous reactions. It
frees the resources of the attacked host without betraying the IDPS presence.
6. To modify a FAST option:
a. In the FAST Options table, right-click on the option that you want to modify, select Edit from the
drop-down menu. A pop-up window is displayed.
b. Modify the value in the Parameters field.

Configuring the FAST IDPS Protection
For information about IDPS, refer to Section 12.2, “IDPS”.
1. In the IDPS configuration form of the relevant FAST Policy object, check the IDPS option.
2. Drag and drop the IDPS profile into the Profiles field. The IDPS profile has been created previously in
the Profiles folder of the IDPS navigation tab.
3. To use the default IDPS mode, uncheck the IDPS Custom Mode option. To use a specific mode, check
this option:
• If you do not want alerts, check the Warn only option
• To receive alerts, check the Abort connection when threshold is reached option and define the
alert threshold in the corresponding Threshold field.

Note
The default mode has a threshold of 40 alerts.
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Grouping Services
Arkoon Manager allows you to group services, for instance, you can group services used by the same
application.
1. In the Services explorer view, drag and drop the services to be grouped from the descriptive view
into the Services groups folder.
2. To view the grouped services, click on the Services groups folder in the explorer view; the group
services are displayed in the descriptive view.

12.1.2. Standard FAST modules
FAST DNS Module
General Behavior
The DNS protocol can be used on TCP and UDP protocols at the same time and always appears the same
way. The FAST module allows you to manage the DNS protocol on these two transport protocols.

Table 12.1. DNS Header
Identification

Parameters

Number of Questions (Queries)

Number of Answers

Number of Authorities

Number of
information

Additional

pieces

of

The DNS header analyzes the rest of the packet that contains the various Queries, Answers and
Additional pieces of information. The Identification field relates the answers to the queries.
The FAST module analyzes the header's validity as well as the DNS information and ensures that the
packet is coherent with the data that has already been transferred. In particular, it checks if an answer
corresponds to an emitted query . For the UDP protocol (not connected), the active connection is closed
as soon as the server has sent all the answers.
Example of Communication

Example 12.1. DNS Query for www.arkoon.net
Domain Name System (query)
Transaction ID: 0x0002
Flags: 0x0100 (Standard query)
0... .... .... .... = Response: Message is a query
.000 0... .... .... = Opcode: Standard query (0)
.... ..0. .... .... = Truncated: Message is not truncated
.... ...1 .... .... = Recursion desired: Do query recursively
.... .... ...0 .... = Non-authenticated data OK: Non-authenticated data
is unacceptable
Questions: 1
Answer RRs: 0
Authority RRs: 0
Additional RRs: 0
Queries
www.arkoon.net type A, class inet
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Example 12.2. DNS Answer for www.arkoon.net
Domain Name System (response)
Transaction ID: 0x0002
Flags: 0x8580 (Standard query)
1... .... .... .... = Response: Message is a query
.000 0... .... .... = Opcode: Standard query (0)
.... .1.. .... .... = Authoritative: Server is an authority for domain
.... ..0. .... .... = Truncated: Message is not truncated
.... ...1 .... .... = Recursion desired: Do query recursively
.... .... 1... .... = Recursion available: Server can do recursive
queries
.... .... ..0. .... = Answer authenticated: Answer/authority portion
was not authenticated by the server
.... .... .... 0000 = Reply code: No error (0)
Questions: 1
Answer RRs: 2
Authority RRs: 3
Additional RRs: 3
Queries
www.arkoon.net type A, class inet
Answers
www.arkoon.net type A, class inet, addr 195.167.226.90
www.arkoon.net type A, class inet, addr 195.167.226.91
Authoritative nameservers
arkoon.net: type NS, class inet, ns ns02.arkoon.net
arkoon.net: type NS, class inet, ns ns03.arkoon.net
arkoon.net: type NS, class inet, ns ns01.arkoon.net
Additional records
ns ns02.arkoon.net: type A, class inet, addr 195.167.226.90
ns ns03.arkoon.net: type A, class inet, addr 195.167.226.91
ns ns01.arkoon.net: type A, class inet, addr 62.161.237.194

Specific Actions
Description of the Connection
The FAST module matches a description to an active connection. This description can be seen in the
Active connections window of Arkoon Monitoring . The description used by the DNS module recalls the
information specific to the current query. It can evolve during the exchange and can have the following
format:
[DNS] Request type 1 for www.arkoon.net.
[DNS] Request type 12 for 1.0.168.192.in-addr.arpa.

Implicitly Authorized Types and Classes
The only types of queries that are implicitly authorized are those that are known and concerned by the
IANA (Internet Assigned Numbers Authority): from 1 to 42 and from 249 to 255.
Protocol Options
The protocol options (defined at the service object level in Arkoon Manager ) allow you to define the
behavior of the module more accurately. The following options can be used for the TCP version of the
FAST DNS module:
• type_allow
Types of authorized queries in addition to default ones. type_only_allow and type_forbidden
options override type_allow.
Format: list of integers.
• type_only_allow

174

| Standard FAST modules

Chapter 12. FAST and IDPS

Only types of authorized queries. The others provoke an inter-application.
Format: list of integers.
• type_forbidden
Types of forbidden queries. They provoke a protocol violation. type_forbidden option
overridestype_only_allow (a type defined in both options will be denied).
Format: list of integers.
• class_allow
Authorized classes in addition to default ones. class_only_allow and class_forbidden options
override class_allow.
Format: list of integers.
• class_only_allow
Only classes authorized. The others provoke a protocol violation when used.
Format: list of integers.
• class_forbidden
Forbidden classes. They provoke a protocol violation. class_forbidden option overrides
class_only_allow (a class defined in both options will be denied).
Format: list of integers.
The following options can be used for the TCP version of the FAST DNS module:
• no-rand-snat-port
Used to disable the default behavior that randomizes the source port used to masquerade FAST DNSUDP connections for static translations when the source port is modified.
Format: Boolean
• rand-query-id
Used to replace each DNS request ID by a new and properly randomized ID. This option can be used
if clients or servers use weak DNS implementations which lead to predictable IDs. Option disabled
by default.
Format: Boolean
• max-subseq-unknown-id
Used to suppress all pending DNS requests in case too many unsolicited answers are received. This
option makes it possible to detect and block a cache poisoning attempt by cancelling all pending DNS
requests sharing the same connection parameters (IP/ports). Option disabled by default.
Format: String
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Protocol Violations of the DNS Analysis
The FAST DNS module can cut the connection during the DNS analysis in the cases listed below. The
message(s) that will appear in the IP Logs Description column, as well as in the Alerts, are indicated in
parentheses.
• DNS header or content too short (DNS packet too short (xx bytes) / Bad DNS Packet – too short(xx) /
DNS message too short (xx bytes))
• DNS packet (UDP) too long (DNS packet too long (xx bytes))
• Invalid DNS packet (decode_packet returned BAD Packet / Bad DNS packet)
• Answer without a query (DNS Packet response without any query [id=xx])
• Exchange invalid state (Wrong DNS packet [xxx] / Unknown DNS state: xx)
• Unknown type (Unknown type xx)
• Unknown class (Unknown class xx)

Violations of the Protocol Options
The FAST DNS module can cut the connection depending on the protocol options configured in the case
listed below. The messages that appear in the IP Logs Description column as well as in the Alerts are
indicated in parentheses.
• Packet denied by the protocol options (decode_packet returned denied by options / DNS packet denied
by options)

Example of Configuring the Protocol Options
In general, zone transfers should only be accepted once the DNS is authorized.
This way, you can create two dnstcp services:
• dnstcp with zone transfer: this is the standard FAST DNSTCP module
• dnstcp without zone transfer: the option type_forbidden is configured with the query number 252 (AXFR
type, which corresponds to a complete zone transfer).
The filtering rules will then have to specify the appropriate service depending on the specific source and
destinations.

Standards Documents
The DNS protocol is described in the following documents:
• RFC 1034 - Domain Names - Concept and facilities - November 1987
• RFC 1035 - Domain Names - Implementation and specification - November 1987
• RFC 2671 - Extension Mechanisms for DNS (EDNS0) - August 1999
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FAST FTP Module
General Behavior
Controls over the Client-to-Server Data
Each FTP command sent from the client to the server has the following format: command + optional
parameter (separated by a space) + CR + LF.

Example 12.3. Client-to-Server Data
HELP\r\n
USER anonymous\r\n
TYPE I\r\n

The FAST module executes the following controls over the Client-to-Server data:
1. Verify the general format of the command (command, arguments, CR+LF).
2. Verify if the command is authorized.
3. Verify the delimiter and the arguments used depending on the command.
The list of the implicitly authorized commands is extracted from the various RFCs and drafts:
• RFC 959: USER, PASS, ACCT, CWD, CDUP, SMNT, QUIT, REIN, PORT, PASV, TYPE, STRU, MODE, RETR, STOR,
STOU, APPE, ALLO, REST, RNFR, RNTO, ABOR, DELE, RMD, MKD, PWD, LIST, NLST, SITE, SYST, STAT, HELP
and NOOP
• RFC 765: XMKD, XRMD, XPWD and XCUP
• FTPEXT: MDTM, SIZE, FEAT, MLST, MLSD and OPTS
The commands specified for RFC 765 correspond to the commands eliminated in RFC 959 but that are still
used by some FTP clients. The list of authorized commands can be modified with the protocol options
cmd_allow, cmd_forbidden and cmd_refuse.
Verification of Server-to-Client Data
The answers sent by the server always have three digits, a space or a hyphen (-), text and CR+LF endof-line characters.
The text is intended for the user only and does not intervene in the protocol (except for the PASV
command). The hyphen allows the same answer to be sent on several lines (only the last one uses the
space character).

Example 12.4. Server-to-Client Data
220 ProFTPD Server [ftp.arkoon.net]\r\n
214-The following commands are recognized\r\n
214- USER PASS ACCT ...\r\n
214-[..snip..]\r\n
214 Direct comments to test@arkoon.net\r\n

The first digit of the answer (that must be between 1 and 5) identifies the answer.
1yz

Preliminary positive answer
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2yz

Definitive positive answer

3yz

Intermediate positive answer

4yz

Temporary negative answer

5yz

Definitive negative answer

Any command initiated by the client must finish with a type 2, 4 or 5 answer. This allows the exchange to
be tracked and to differentiate between successful and unsuccessful commands.

Note
When connected, the server sends an answer in the form of a home banner.
Exchange Tracking
The exchange tracking (command/answer) executed by the FAST module adds a specific control on
various commands.
PORT
The PORT command is used to connect active data, i.e. the data connection is established by the server.
The command parameters contain the IP address and the port to which the server will connect. Even if
the client can (RFC765/957) indicate another IP address than its own, this is often used to launch "bounce"
attacks (RFC2577). Thus, the FAST module forbids the use of another IP address than the client's and the
use of a port below 1024.
In the case of a connection that translates the client's IP address or port, the FAST module modifies the
parameters of the PORT command so that the connection is established.
PASV
The PASV command is used to implement connection of passive data, i.e. the data connection is
established by the client. The IP address and the port are transmitted to the client in the answer to the
PASV command (this is the only case where the text of the answer intervenes with the protocol).

Example 12.5. PASV
227 Entering passive mode (10,10,1,40,4,41)

As for the PORT command, the FAST module forbids the use of another IP address than the server's and
the use of a port below 1024.
For a connection that translates the server's IP address or port, the FAST module modifies the parameters
of the PASV command so that the connection is established.
To avoid any data leak in the case where the client could desynchronize the server's answers
(possible with some implementations), the FAST module implicitly forbids (except when using the
option allow_everything_in_reply) a PASV-type answer in an answer that does not correspond to a
command PASV.
USER
The USER command, used to authenticate on the server, is analyzed when the protocol options
user_allow or user_refuse are used. If an unwanted user tries to authenticate, the FAST module
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rejects the authentication attempt (500 user refused) without transmitting it to the server. This filters the
authorized users at the FAST360 level.
RETR/STOR/STOU/APPE/LIST/NLST
These commands indicate a data transfer via a data connection established by the PORT or PASV
commands. Thus, the FAST module can match the data connection with the type (and eventually the file
name) of transiting data.
REIN
The REIN command resets the exchange. If the command is accepted, the FAST module cancels all the
current negotiations (user authenticated and data connection negotiated).
SYST
The answer of the SYST command can contain information on the nature of the server. If the option
hide_syst is used, the FAST module can replace the server's answer by one determined by the
Administrator.
Telnet Interruptions
The client can send Telnet interruption characters in the command connection instead of a command
(for instance, to order the server to interrupt a transfer). These Telnet interruption characters contain
two bytes, the first of which is 0xFF. The FAST module accepts these interruption characters and lets
them go through.

Example of Standard Connection
The example below illustrates the download of a file called README on the ftp server ftp2.proxad.net.
220 ProFTPD 1.2.1 Server (ProFTPD) [ftp2.proxad.net]
USER anonymous
331 Anonymous login ok, send your complete email address as your
password.
PASS ftpvuser@unknown.com
230 Anonymous access granted, restrictions apply.
PWD
257 "/" is current directory.
TYPE I
200 Type set to I.
PORT 172,20,33,1,14,99
200 PORT command successful.
RETR README
150 Opening BINARY mode data connection for README (98 bytes).
226 Transfer complete.Received 98 bytes.
Transfer buffer size 5 120 bytes.
Transfer time: 00:00:04; 24,50bytes/sec
QUIT
221 Goodbye.

Specific Actions
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Data Connections
The FAST module creates and closes the active transfer connections during the exchange. If a data
connection is not used while another is negotiated, the first is cut. When the command connection is
closed (by the client or during an protocol violation) any unused data connection is also cut.
In the case of the PORT command, the connection is created between the server's IP address + the client's
default port and IP address + the port specified as a parameter. The server's default port corresponds
to the one that is immediately below the command connection port (except when using the option
active_ftp_force_sport). The connection is created while the client sends a transfer command.
In the case of the PASV command, the connection is created between the client's IP address and the
server's IP address + the port specified in the answer. The connection is created while the server sends
the answer to the PASV command.
Description of the Connection
The FAST module matches a description to an active connection. This description can be seen in
the Active connections window of the Arkoon Monitoring . The description used by the FTP module
recalls the authentication information for the command connection and the transfer information for
the data connection. In the case of an anonymous connection (anonymous user or ftp), the password
(corresponding to the email address) appears.

Example 12.6. FTP Connection
[FTP] user
[FTP] user
[FTP-DATA]
[FTP-DATA]
[FTP-DATA]

test
anonymous [test@arkoon.net]
LIST
RETR rfc-959.gz
STOR arkoon-3_0.tar.gz

Protocol Options
The protocol options (defined at the service object level in the Arkoon Manager ) allow you to control
the behavior of the module more accurately. Here are the available options:
• cmd_allow
Additional commands to be authorized by the module. This option allows authorizing proprietary
commands used by some editors. The options cmd_only_allow and cmd_forbidden override
cmd_allow.
Format: list of character strings (commands).
• cmd_only_allow
Only commands authorized by the module. All the others are considered an protocol violation and the
connection will be cut.
Format: list of character strings (commands).
• cmd_forbidden
Commands (standard) that should not be used. The FAST FTP module considers the use of one of these
commands as an protocol violation and cuts the connection. The option cmd_forbidden overrides the
options cmd_only_allow (a command appearing in both will be forbidden) and cmd_refuse.
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Format: list of character strings (commands)
• cmd_refuse
Commands that should not be transmitted to the server but that must not cut the connection. In such
a case, the FAST module sends a negative answer (500 command refused) to the client. No trace is
generated in this case.
Format: list of character strings (commands).
• user_allow
List of the only users authorized to connect. Others are denied (500 user refused) by the FAST FTP
module.
Format: list of character strings (login names).
• user_refuse
List of the users unauthorized to connect. The FAST module sends a negative answer (500 user refused)
to the client. No trace is generated in this case.
Format: list of character strings (login names).
• hide_banner
Hides the home banner sent by the server via a string chosen by the Administrator.
Format: character string to be used as a banner.
• hide_syst
Hides the answer to the SYST command via a string chosen by the Administrator.
Format: character string (answer to the SYST command to be sent back)
• max_command_size
Maximum size authorized for a command and its parameters.
Format: integer (maximum size).
• allow_everything_in_reply
Deactivates the protection against information leak (PASV type) in an answer that does not correspond
to a PASV command.
Format: boolean.
• active_ftp_force_sport
Changes the default port used by the server in the case of the PORT command. If the 0 value is used,
all the source ports will be accepted.
Format: integer (source port to be used or 0 for all the ports)
• max_failed_auth
Specifies a maximum number of accepted authentication failures. Beyond this limit, the connections
is cut. The number of accepted failures by default is 5.

Standard FAST modules

| 181

Chapter 12. FAST and IDPS

Format: integer (0 to disable the control).
• max_transfer_size
Specifies the possible maximum size (in Kb) through the FAST FTP. For example to forbide the transfer
of a file with a size higher than 10 Mb, you can specify 10000 as maximum transfer size. This control
is disabled by default.
Format: integer.
• dirs_forbidden
List of forbidden directories (searching on subchains: "foo" will forbide "hellofoo", "1foo2" as well as
"foo"). This applicative option allows you to forbide all operations related to directories (creating,
deleting, listing content, moving in a directory) for forbiddent names. However, it does not prevent
operations related to files transfer (download / upload) contained in a forbidden directory. Do not
place in a tree (more than 2 directories), for example: "dir1/dir2" will not work.You must write "dir1",
puis "dir2" to block both directories. To limit operations on files, you must use the applicative option
files_forbidden.
Format: list of character strings (patterns).
• files_forbidden
List of forbidden file names (searching on subchains). This option allows to forbide all operations
related to file transfer (download / upload via FTP) for forbidden names.
Format: list of character strings(patterns).
• allow_lowport_pasv
Allows the server to a port lower than 1024 in response to a PASV command.
Format: boolean.
• allow_invalid_ftp_reply
Allows invalid responses from the server (no code with the response, responde with non command, ...).
Format: boolean.
• allow_client_no_cr
Allows the client to use LF as a character at the end of line (instead of CR+LF).
Format: boolean.
• allow_server_no_cr
Allows the server to use LF as a character at the end of line (instead of CR+LF).
Format: boolean.
• allow_client_susp_cr
Deactivates the check for suspect \r character (not followed with \n) in a command.
Format: boolean.
• allow_server_susp_cr
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Deactivates the check for suspect \r character (not followed with \n) in a response.
Format: boolean.
• max_subsequent_port_pasv
Maximum number of PORT/PASV commands for which the data connection is not used.
Protocol Violations of the FTP Analysis
The FAST FTP module can cut the connection during the FTP analysis in the case listed below. The
messages that appear in the IP Logs Description column as well as in the Alerts are indicated in
parentheses.
• Invalid format of a command (can't find end of command (\r) / can't find end of command (\n-1))
• Impossible to find the command (can't find command (x char))
• Use of an unknown command (invalid command xxx)
• No space or end of line after a command (garbage behind command xxx)
• Use of parameters for a command that does not accept them (No params allowed for cmd xxx)
• No parameter for a command requiring one (Params needed for cmd xxx)
• Invalid format of the PORT parameters (Invalid PORT param)
• Invalid IP address in the PORT command (Invalid PORT dest IP: xx.xx.xx.xx)
• Invalid port in the PORT command (Invalid PORT dest port: xx)
• Invalid format of the answer to the PASV command (Invalid PASV reply)
• Invalid IP address in the answer to the PASV command (Invalid PASV dest IP: xx.xx.xx.xx)
• Invalid port in the answer to the PASV command (Invalid PASV dest port: xx)
• Information leak detected ((xx,xx,xx,xx,xx,xx) detected in reply yyy). This verification can be
deactivated by using the option allow_everything_in_reply.
Violations of the Protocol Options
The FAST FTP module can cut the connection depending on the protocol options configured in the case
listed below. The messages that appear in the IP Logs Description column as well as in the Alerts are
indicated in parentheses.
• Use of a forbidden command (command xxx forbidden)
• Maximum size authorized (max_command_size) is reached (command line too long (xx bytes /
max:yy))

Example of Configuring the Protocol Options
This paragraph shows several examples of configuring protocol options of the FAST FTP module.
Defining protocol options allows you to:
• authorize an FTP application with proprietary commands;
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• forbid potentially dangerous commands;
• limit the access to the server for "normal" use only;
• hide sensitive information.
In any case, you should create several FTP services to select, in the specific filtering rules, the service
with the adequate options.
Authorize Proprietary Commands
If you use a client or an FTP server using proprietary commands, you must add these commands in the
option cmd_allow.
For instance, the client NCFTP uses the command CLNT that you can authorize by entering 'CNLT' in the
option cmd_allow.
Forbid Potentially Dangerous Commands
The SITE FTP command allows commands to be executed remotely. This mode of action is not safe.
Moreover, buffer overflows using the SITE command occur on some servers.
To forbid the command SITE, you must enter SITE in the option cmd_forbidden.
Limit the Access to the Server
As a preventive measure, you should limit the server access to a minimum. The limitations can be
specified at the server level, but it is recommended to specify them at the FAST360 level.
This way, you can:
• limit the authorized commands: you can refuse the suppression of files and directories by entering
DELE, RMD, XRMD in the option cmd_refuse;
• filter the users: to authorize only the users “ftp” and “anonymous”, enter “ftp, anonymous” in the option
user_allow.

Hide Sensitive Information
The default configuration of some servers leaves sensitive information unhidden, like the server's
software version or the operating system.
The FAST360 appliance can hide such sensitive information if you configure the corresponding options:
• in the option hide_banner, enter the new home banner label that should appear;
• in the option hide_syst, enter the new label that should appear for the operating system (for instance,
“Unknown”).

Standards Documents
The FTP protocol, its extensions and use are described in the following documents:
• RFC 765 - File Transfer Protocol (FTP) - June 1980
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• RFC 959 - File Transfer Protocol (FTP) - October 1985
• RFC 2577 - FTP Security Considerations - May 1999
• draft-ietf-ftpext-mlst-xx.txt: Extensions to FTP

FAST HTTP Module
General Behavior
The HTTP protocol (all versions included) is validated by FAST360 appliance with a finite state automaton
having a state for each end of the connection: HTTPC_xx for the client side and HTTPS_xx for the server
side.
The methods accepted by the FAST module depend on the version of the HTTP protocol used by the
client. The authorized methods are the following:
• HTTP/0.9: GET
• HTTP/1.0: GET, POST, HEAD and CONNECT
• HTTP/1.1: GET, POST, HEAD, CONNECT, OPTIONS, PUT, DELETE and TRACE.

Example 12.7. Standard Connection
The example below corresponds to the query for the page http://www.voila.fr.
GET http://www.voila.fr/ HTTP/1.0
Accept: image/gif, image/x-xbitmap, image/jpeg, image/pjpeg,
application/vnd.ms-powerpoint, application/vnd.ms-excel,
application/msword, */*
Accept-Language: fr
Cookie: e=PcDbzqwWAW8AACIUYcg
User-Agent: Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 5.0)
Host: www.voila.fr
Proxy-Connection: Keep-Alive
HTTP/1.1 200 OK
Date: Thu, 18 Sep 2003 08:27:16 GMT
Server: Apache/1.3.27 (Unix)
Content-Type: text/html
X-Cache: MISS from test.arkoon.net
Connection: close
<HTML>
<HEAD>
<TITLE>Welcome to Voila</TITLE>
[content of the HTML page]

Specific Actions
Description of the Connection
The FAST module can match a description with an active connection. This description can be seen in the
Active connections window of Arkoon Monitoring . The description used by the HTTP module recalls
the information related to the method and the URI currently exchanged.

Example 12.8. HTTP Connections
[HTTP] GET http://www.arkoon.net/index.html
[HTTP] POST /formulaire.php
[HTTP] CONNECT support-https.arkoon.net
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Protocol Options
The protocol options (defined at the service object level in Arkoon Manager ) allow a more accurate
control of the module's behavior.
Here are the available options:
• methods_allow
List of authorized methods in addition to default methods. The options methods_only_allow and
methods_forbidden override methods_allow.
Format: list of character strings (methods).
• methods_only_allow
List of the only authorized methods. The FAST HTTP module cuts the connection if the client uses
another one.
Format: list of character strings (methods).
• methods_forbidden
List of forbidden methods. The FAST HTTP module cuts the connection if the client uses one. The option
methods_forbidden overrides the option methods_only_allow (a method appearing in both will be
denied).
Format: list of character strings (methods).
• methods_no_version_restrict
List of methods for which no check is done if the method corresponds to the version used.
Format: list of character strings (methods).
• maxsize_url
URL maximum size. The FAST HTTP module cuts the connection in case of overflow.
Format: integer (maximum size).
• words_forbidden
List of forbidden words in a URL. The FAST module cuts the connection if one of these words is present.
Format: list of character strings.
• cli_headers_allow
List of authorized parameters for the client. The FAST module cuts the connection if the client uses
another one.
Format: list of character strings (parameters).
• cli_headers_forbidden
List of forbidden parameters for the client. The FAST module cuts the connection if the client uses
another one.
Format: list of character strings (parameters).
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• cli_headers_remove
List of parameters sent by the client to be removed. The FAST module deletes these parameters from
the exchange; the server will not see them.
Format: list of character strings (parameters).
• cli_hdrline_max
Maximum size for a parameter line (name + data) sent by the client. The FAST module cuts the
connection in case of overflow.
Format: integer (maximum size).
• srv_headers_allow
List of authorized parameters for the server. The FAST module cuts the connection if the server uses
another one.
Format: list of character strings (parameters).
• srv_headers_forbidden
List of forbidden parameters for the server. The FAST HTTP module cuts the connection if the server
uses another one. The option srv_header_forbidden overrides the option srv_headers_allow (a
parameter appearing in both is denied).
Format: list of character strings (parameters).
• srv_headers_remove
List of parameters sent by the server to be removed. The FAST module deletes these parameters from
the exchange; the client will not see them.
Format: list of character strings (parameters).
• srv_hdrline_max
Maximum size for a parameter line (name + data) sent by the server. The FAST module cuts the
connection in case of overflow.
Format: integer (maximum size).
• disable-ssl-tls-analysis
Disables the SSL/TLS analysis for the CONNECT method.
Format : boolean.
For more information, see the section called “FAST SSL/TLS Module”.
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Protocol Violations of the HTTP Analysis
The FAST HTTP module can cut the connection during the HTTP analysis in the cases listed below. The
messages that appear in the IP Logs Description column or in the Alerts are indicated in parentheses.
• Size of the method too long (Method too long)
• Forbidden characters present in the method (Invalid method (invalid token))
• Unknown method (Unknown method: xxx)
• Method unauthorized in this version (method xxx not allowed in HTTP/x.y)
• No URI in the query (No URI after method)
• Invalid HTTP version (Bad HTTP Version: xxx / Invalid HTTP Server version / Incomplete HTTP Version)
• Wrong parameter in the header (Bad Header: xxx)
• Invalid status (HTTP Status-code too long: xx, HTTP Status-code too short: xx, Invalid HTTP Statuscode: xx)
• Invalid header for the chunked encoding (Invalid chunk (size too long / invalid size / no LF after size
+CR / no CRLF after chunk-data))
• Invalid header for the multipart/byteranges (Invalid byteranges CRLF / Invalid byteranges boundary /
Invalid byteranges header / No Content-range in byteranges headers / Invalid byteranges Contentrange)
Violations of the Protocol Options
The FAST HTTP module can cut the connection depending on the protocol options configured in the case
listed below. The messages that appear in the IP Logs Description column or in the Alerts are indicated
in parentheses.
• Use of an unauthorized method by the option methods_allow (Method not allowed by options: xxx)
• Use of a forbidden method by the option methods_forbidden (Method forbidden by options: xxx)
• Size of the URL exceeds the limit of maxsize_url (URL too long (at least xx bytes, max=yy))
• Presence of a forbidden word in the URL (Word (xxx) forbidden in URL: yyyy)
• Size of the parameter too long for the options (Client header line too long: at least xx bytes, max xx
bytes / Server header line too long: at least xx bytes, max xx bytes)
• Unauthorized parameter (Client header not allowed by options: xx / Server header not allowed by
options: xx)
• Forbidden parameter (Client header forbidden by options: xx / Server header forbidden by options: xx)

Example of Configuring the Protocol Options
This paragraph shows several examples of configuring protocol options of the FAST HTTP module in
order to counter various attacks.
Code Red
CodeRed uses a buffer overflow (.ida) on some IIS servers. It is a query of the following type:

Example 12.9. CodeRed
GET /default.ida?NNNNNNNNNNNNN[...]
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The most general protection consists in limiting the size of the URL. To counter Code Red, the size of the
URL must not be larger than 370 bytes. However, some attacks are sustained by buffer overflows whose
URLs are of a smaller size. We recommend that you limit the size of the URL to 200 bytes, provided that
your server does not use longer legitimate URLs.
Enter the chosen value in the option max_urlsize.
You can also block the keyword default.ida (if you do not use it). To do so, enter it in the option
words_forbidden.
Nimda
Nimda tries to exploit servers infected by Code Red by using root.exe and cmd.exe, with a command of
the following type:
GET /scripts/root.exe?/c+dir

You can block it by forbidding the keywords cmd.exe and root.exe in the URL: enter them in the option
words_forbidden.
Apache Chunked-encoding
These write operations can be detected and stopped because they use very long headers. The attacks
are of the following type:

Example 12.10. Apache Chunked-encoding
GET / HTTP.1.1
[...]
X-CCCCCCC: AAAAAAAAAAAA[...][shellcode]
Transfer-Encoding: chunked

The protection consists in limiting the size of the headers emitted by the client to a “reasonable” size.
This can also constitute an additional protection against other attacks. We recommend that you limit
the maximum size of the headers emitted by the client to 1,200 bytes. Enter this value in the option
cli_hdrline_max.

Standards Documents
The different versions of the HTTP protocol are described in the following documents:
• RFC 1945 - Hypertext Transfer Protocol -- HTTP/1.0 - May 1996
• RFC 2068 - Hypertext Transfer Protocol -- HTTP/1.1 - January 1997
• RFC 2616 - Hypertext Transfer Protocol -- HTTP/1.1 - June 1999

FAST SMTP Module

Standard FAST modules

| 189

Chapter 12. FAST and IDPS

General Behavior
Verification of Client-to-Server Data
Each SMTP command sent from the client to the server contains the same elements: command + optional
parameter + CR + LF. The delimiter between the command and its parameters is the space, except for
some commands for which it is the ':' character.

Example 12.11. Client-to-Server Data
HELP\r\n
HELO myarkoon.arkoon.net\r\n
MAIL FROM:<test@arkoon.net>\r\n

The FAST module executes the following controls over the Client-to-Server data:
1. Controlling the command's general format (command, arguments, CR+LF);
2. Controlling if the command is really authorized;
3. Controlling the delimiter and the arguments used depending on the command.
The list of implicitly authorized commands is the one extracted from the various RFCs, except for the TURN
command (implicitly denied):
• RFC 821: HELO, MAIL FROM, RCPT TO, DATA, RSET, SEND FROM, SOML FROM, SAML FROM, VRFY, EXPN,
NOOP, HELP and QUIT
• RFC 1869: EHLO
• RFC 1985: ETRN
• RFC 2487: STARTTLS
• RFC 2554: AUTH
The SEND FROM, SOML FROM, SAML FROM and TURN commands are considered obsolete following RFC 2821.
The TURN command is implicitly denied because it is never used and it lowers the protocol's security by
allowing the exchange direction to be changed.
The list of authorized commands can be modified with the protocol options cmd_allow, cmd_forbidden
and cmd_refuse.
Verification of Server-to-Client Data
The answers sent by the server have three digits, a space or a hyphen (-), a text and CR+LF end-of-line
characters. The text is intended for the user only and does not intervene in the protocol. The hyphen
allows the answer to be sent on several lines (only the last one uses the space character).

Example 12.12. Server-to-Client Data
220 myarkoon.arkoon.net SMTP server ready.\r\n
214-This is sendmail version 8.12.0\r\n
214-Topics:\r\n
214- HELO EHLO MAIL RCPT\r\n
214-[..snip..]\r\n
214 End of HELP info\r\n

The first digit of the answer (that must be between 1 and 5) identifies the result of the answer.
1yz
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2yz

Definitive positive answer

3yz

Intermediate positive answer

4yz

Temporary negative answer

5yz

Definitive negative answer

Any command initiated by the client must finish with a type 2, 4 or 5 answer. This allows the exchange to
be tracked and to differentiate between the successful and unsuccessful commands.

Note
When connecting, the server sends an answer in the form of a home banner.
Exchange Tracking
The exchange tracking (command/answer) executed by the FAST module a specific control to be imposed
on various commands.
HELO/EHLO
The HELO and EHLO commands are used at the beginning of the exchange and allow client identification.
The FAST module ensures that this command is emitted (and accepted by the server) before a mail is
sent. Otherwise, the connection is cut.
MAIL/RCPT/SEND/SOML/SAML
These commands specify the transmitter or the recipient of a mail. The connection is cut if the format of
the transmitter is invalid. If the protocol option strict_path is activated, the address must be included
between the < and > characters otherwise the connection will be cut by an protocol violation error.
DATA
This command begins sending a mail. Once the server has sent an intermediate positive answer (3yz),
the client can send the mail. The end of the mail is detected by the presence of the CR+LF+.+CR+LF
characters. The DATA command can be used only if the server accepts the transmitter and at least one
recipient. Otherwise, the connection is cut.
AUTH
This command allows the use of a specific authentication mechanism. The client is authorized to send
its authentication data until the server answers. No control is done over these data because they are
specific to the mechanism used between the client and the server. As soon as the server sends its answer
(negative or positive), the authentication data exchange is finished.
STARTTLS
This command allows the continuation of the exchange in a TLS session (encrypted). If the server accepts
the command, the remainder of the exchange is not controlled. If TLS mode cannot be allowed, it is
possible to refuse the command using the protocol option cmd_refuse.

Example of Standard Connection
The example below corresponds to a mail sent from the “station” machine, using the smtp.relay.fr
SMTP relay, intended to the smtp.dest.fr server SMTP, with test@arkoon.net as emitting address
and intended totest@dest.fr.
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220 smtp.dest.fr ESMTP Postfix (Release 20010228) (Linux-Mandrake)
EHLO smtp.relay.fr
250-smtp.dest.fr
MAIL From:<test@arkoon.net> SIZE=2282
250 Ok
RCPT To:<test@arkoon.net>
250 Ok
DATA
354 End data with <CR><LF>.<CR><LF>
Received: (from uucp@localhost)
by smtp.relay.fr (8.12.8p1/8.12.8) id h8ICTFhJ004514
for <test@dest.fr>; Thu, 18 Sep 2003 14:29:15 +0200
Received: from UNKNOWN(172.16.33.1), claiming to be "station"
via SMTP by smtp.relay.fr, id smtpdB9OQHo; Thu Sep 18 14:29:14 2003
Message-ID: <002001c37dde$f9dfa0a0$012114ac@station>
From: "Test Account" <test@arkoon.net>
To: <test@dest.fr>
Subject: Re: Test
Date: Thu, 18 Sep 2003 14:18:31 +0200
MIME-Version: 1.0
Content-Type: multipart/alternative;
boundary="----=_NextPart_000_001D_01C37DEF.BCE07BF0"
X-Priority: 3
X-MSMail-Priority: Normal
X-Mailer: Microsoft Outlook Express 6.00.2600.0000
X-MimeOLE: Produced By Microsoft MimeOLE V6.00.2600.0000
This is a multi-part message in MIME format.
[mail data]
.
250 Ok: queued as F2ED55FEC3
QUIT
221 Bye

Specific Actions
Description of the Connection
The FAST module can match a description with an active connection. This description can be seen in the
Active connections window of Arkoon Monitoring . The description used by the SMTP module recalls the
information specific to the source and destination (email or TDM). It can evolve during the transmission
and can have the following format:
[SMTP]
[SMTP]
[SMTP]
[SMTP]
[SMTP]
[SMTP]
[SMTP]

[] -> []
[] -> [smtp.domain.com]
[myarkoon.arkoon.net] -> [smtp.domain.com]
<test@arkoon.net> -> [smtp.domain.com]
<test@arkoon.net> -> <user@domain.com>
<test@arkoon.net> -> 2 recipients
<test@arkoon.net> -TLS-> 2 recipients

Protocol Options
The protocol options (defined at the service object level in the Arkoon Manager ) allow you to control
the behavior of the module more accurately. Here are the available options:
• cmd_allow
Additional commands to be authorized by the module. This option authorizes some proprietary
commands used by various editors. The options cmd_only_allow and cmd_forbidden override
cmd_allow.
Format: list of character strings (commands).
• cmd_only_allow
Only commands authorized by the module. All the others are considered a protocol violation and the
connection is cut.
Format: list of character strings (commands).
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• cmd_forbidden
Commands (standard) that should not be used. The FAST module will consider the use of one of these
commands as a protocol violation and will cut the connection. The option cmd_forbidden overrides
the options cmd_only_allow (a command appearing in both will be forbidden) and cmd_refuse.
Format: list of character strings (commands).
• cmd_refuse
Commands that should not be transmitted to the server but that must not cut the connection. In such
a case, the FAST module sends a negative answer (500 Syntax error, command unrecognized) to the
client. No trace is generated in this case.
Format: list of character strings (commands).
• strict_path
Cuts the connection if the client does not use the < > characters to begin and end the email address
when using the MAIL FROM and RCPT TO commands.
Format: boolean.
• hide_banner
Allows concealing the home banner sent by the server via a string chosen by the Administrator.
Format: list of character strings (banner to be used).
• max_command_size
Maximum size authorized for a command and its parameters.
Format: integer (maximum size).
• disable-ssl-tls-analysis
Disables the SSL/TLS analysis for the CONNECT method.
Format : boolean.
For more information, see the section called “FAST SSL/TLS Module”.
Protocol Violations of the SMTP Analysis
The FAST SMTP module can cut the connection during the SMTP analysis in the case listed below. The
message(s) that appear in the IP Logs Description column, and the Alerts are indicated in parentheses.
• Invalid format of a command (can't find \r / can't find \n-1)
• Use of an unknown command (invalid command 'xxx')
• No space or end of line after a command (garbage behind command xxx)
• Use of parameters for a command that does not accept them (No params allowed for cmd xxx)
• No parameter for a command requiring one (Params needed for cmd xxx)
• Use of the TURN command (command TURN forbidden)
• Resending of the HELO/EHLO command (already got helo/ehlo)
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• Begins the sending of a mail without having used HELO/EHLO (client has not said hello)
• Invalid transmitter/recipient (forward path invalid / reverse path invalid)
• Sending of a mail without transmitter (got no MAIL FROM)
• Sending of a mail without recipient (DATA without any recipient (RCPT TO))
• Sending of a mail without valid recipient (DATA without any valid recipient - xx invalid 'RCPT TO' seen)
• Invalid format of the answer (I was waiting a reply number: xyz / reply too short)
Violations of the Protocol Options
The FAST SMTP module can cut the connection depending on the protocol options configured in the
case listed below. The message(s) that will appear in the IP Logs Description column, and the Alerts are
indicated in parentheses.
• Use of a forbidden command (command xxx forbidden)
• Maximum size authorized (max_command_size) is reached (command too long (xx bytes))
• Invalid transmitter/recipient (forward path invalid / reverse path invalid) related to the option
strict_path.

Example of Configuring the Protocol Options
This paragraph shows several examples of configuring protocol options of the FAST SMTP module.
Defining protocol options can allow you to:
• forbid potentially dangerous commands;
• limit the access to the server for "normal" use only;
• hide sensitive information.
Forbid Potentially Dangerous Commands
The EXPN and VRFY commands can be used to get information about the SMTP server. The HELP command
is not used by a standard SMTP client: it can reveal a user who sends commands to the server manually.
To refuse these commands, enter them separated by a comma in the option cmd_refuse.
Limit the Access to the Server
As a preventive measure, it is best to limit the access to the server to a minimum. The limitations can be
specified at the server level, but it is recommended to specify them at the FAST360 level.
Then, you can limit the authorized commands: you can forbid the SEND FROM, SOML FROM and SAML FROM
commands (obsolete commands that allow to directly send a mail on the user terminal) by entering them
in the option cmd_forbidden.
Hide Sensitive Information
The default configuration of some servers leaves sensitive information unhidden in the home banner.
The FAST360 appliance can hide such sensitive information: in the option hide_banner, enter the new
home banner label that should appear.
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Standards Documents
The SMTP protocol and its extensions are described in the following documents:
• RFC 821 - Simple Mail Transfer Protocol - August 1982
• RFC 1869 - SMTP Service Extensions - November 1995
• RFC 1985 - SMTP Service Extensions - ETRN - August 1996
• RFC 2487 - SMTP Service Extensions for Secure SMTP over TLS - January 1999
• RFC 2554 - SMTP Service Extensions for Authentication - March 1999
• RFC 2821 - Simple Mail Transfer Protocol - April 2001

FAST SNMP module
The FAST SNMP module supports SNMPv1, SNMPv2c and SNMPv3 over UDP (but not over TCP).

General Behavior
The SNMP protocol allows commands of the types set and get to be issued, as well as SNMP traps. The
FAST SNMP module analyzes SNMP (versions 1, 2c and 3) traffic for violations of the protocol.
An SNMPv1 or SNMPv2c message contains:
• an SNMP protocol version number
• an SNMP community name
• a PDU (Protocol Data Unit)
An SNMPv3 message contains:
• an SNMP protocol version number
• a header
• security parameters
• a PDU
The FAST SNMP module performs protocol checks in three stages:
1. ASN.1 checks
2. Version check
3. Content checks
These stages are described below.
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ASN.1 Checks
The first level of checking looks at the requirements of ASN.1 parsing. Each UDP packet contains exactly
one SNMP message that is an ASN.1-SEQUENCE. The following rules are applied:
• If the payload of the UDP packet does not start with an ASN1-SEQUENCE message, the packet is
rejected and the following error message is displayed: SNMP packet is not encoded in an ASN.1
SEQUENCE.
• If the payload of the UDP packet does not contain enough data for the entire ASN.1-SEQUENCE object,
the packet is rejected and the following error message is displayed: Incomplete SNMP message in
UDP packet.
• If there is still data remaining after the ASN.1-SEQUENCE, the packet is rejected and the following
error message is displayed: Unexpected data after the SNMP message.
Version Check
• For an SNMP message to pass through the FAST360 firewall, the message must first correspond to
one of the SNMP protocol versions supported by the FAST module: SNMPv1, SNMPv2c or SNMPv3.
If the version number is not one of these, the message is rejected and an error message of the following
type is displayed: SNMP version (xx) unsupported.
Content Checks
Each protocol version supports its own set of PDUs (Protocol Data Units), detailed in the table below.
Only these PDUs are permitted by the FAST SNMP module. Checks are performed on these PDUs.

Table 12.2. Protocol Version and PDU
Protocol Version

PDU

SNMPv1

SNMPv1-GetRequest-PDU
SNMPv1-GetNextRequest-PDU
SNMPv1-GetResponse-PDU
SNMPv1-SetRequest-PDU
SNMPv1-Trap-PDU

SNMPv2c

SNMPv2c-GetRequest-PDU
SNMPv2c-GetNextRequest-PDU
SNMPv2c-Response-PDU
SNMPv2c-SetRequest-PDU
SNMPv2c-GetBulkRequest-PDU
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Protocol Version

PDU
SNMPv2c-InformRequest-PDU
SNMPv2c-SNMPv2-Trap-PDU
SNMPv2c-Report-PDU

SNMPv3

SNMPv3-GetRequest-PDUSN
MPv3-GetNextRequest-PDUS
NMPv3-Response-PDU
SNMPv3-SetRequest-PDUSN
MPv3-GetBulkRequest-PDUS
NMPv3-InformRequest-PDUS
NMPv3-SNMPv2-Trap-PDUS
NMPv3-Report-PDU

Description of the Connection
The connection description must contain information on the:
• SNMP version
• current operation (if known)
• community/username (if known)
These are shown in the following examples:

Example 12.13. SNMP Connection
[SNMPv1] TRAP .1.3.6.1.4.1.8628.1.1 (public)
[SNMPv1] SET .1.3.6.1.2.1.1.5.0 (john-doh)
[SNMPv2c] GET .1.3.6.1.2.1.1, .1.3.6.1.2.1.2 (admin)
[SNMPv3] GET .1.3.6.1.2.1.1 (billy-the-kid)
[SNMPv3] <encrypted-PDU> (admin)
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Parameters
The parameters that can be used to enforce or modify the FAST SNMP protocol checks are listed and
described in the table below.

Table 12.3. Parameters Used with FAST SNMP Protocol
Parameter

Type

Description

forbid-SNMP-v1

Boolean

Forbids the transmission of SNMPv1 messages.
An SNMPv1 message is rejected and the
following error message is displayed: Forbidden
SNMPv1 message.

forbid-SNMP-v2c

Boolean

Forbids the transmission of SNMPv2c messages.
An SNMPv2c message is rejected and the
following error message is displayed: Forbidden
SNMPv2c message.

forbid-SNMP-v3

Boolean

Forbids the transmission of SNMPv3 messages.
An SNMPv3 message is rejected and the
following error message is displayed: Forbidden
SNMPv3 message.

forbid-get-requests

Boolean

Forbids the transmission of get requests:
SNMPv1-GetRequest
SNMPv1-GetNextRequest
SNMPv2c-GetRequest
SNMPv2c-GetNextRequest
SNMPv2c-GetBulkRequest
SNMPv3-GetRequest
SNMPv3-GetNextRequest
SNMPv3-GetBulkRequest

SNMP messages which contain these PDUs
are rejected and an error message of the
following type is displayed: Forbidden SNMPxxXxxxxxRequest

(example: Forbidden SNMPv2c-GetRequest)
forbid-set-requests
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Parameter

Type

Description
SNMPv1-SetRequest
SNMPv2c-SetRequest
SNMPv3-SetRequest

SNMP messages which contain these PDUs
are rejected and an error message of the
following type is displayed: Forbidden SNMPxSetRequest
forbid-inforequests

Boolean

Forbids the transmission of info requests:
SNMPv2c-InformRequest
SNMPv3-InformRequest

SNMP messages which contain this PDU
are rejected and an error message of the
following type is displayed: Forbidden SNMPvxInformRequest
forbid-traps

Boolean

Forbids the transmission of traps:
SNMPv1-Trap
SNMPv2c-Trap
SNMPv3-Trap

SNMP messages which contain these PDUs are
rejected and an error message of the following
type is displayed: Forbidden SNMPx-Trap
forbid-reports

Boolean

Forbids the transmission of reports (SNMPv2cReport). SNMP messages that contain these
PDUs are rejected and the following error
message is displayed: Forbidden
SNMPxReport

forbid-community

Strings list

Forbids the transmission of an SNMP message
with a community name in the specified list.
These messages are rejected and an error
message of the following type is displayed:
Forbidden community xxxxx (where xxxxx is
the community name)
An empty string (in the strings list) can be used to
forbid the use of an empty community.
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Parameter

Type

Description

forbid-emptycommunity

Boolean

Forbids the transmission of an SNMP message
with an empty community name. These
messages are rejected and the following error
message is displayed: Forbidden usage of an
empty community

only-allowcommunity

Strings list

Forbids the transmission of an SNMP message
with a community name not in the specified
list. These messages are rejected and an error
message of the following type is displayed:
Forbidden community xxxxx (where xxxxx is
the community name)

forbid-objectid

Strings list

Forbids the transmission of an SNMP message
which is related to an Object-ID (or a subtree) in
the specified list. Each Object-ID in the list must
be a string representing the full object path in
terms of digits and dots.
Example: ".1.3.6.1.2.1.1" (system)
The Object-IDs that must be checked against
the specified list are all the Object-IDs that are
included in the variable lists of all PDUs and the
Enterprise-ObjectID in SNMPv1-Trap-PDU.
For SNMPv2c-Trap, SNMPv2c-InformRequest,
SNMPv3-Trap and SNMPv3-InformRequest,
the first two variables (sysUpTime.0 and
snmpTrapOID.0) must not be checked, but the
Object-ID in the value of snmp-TrapOID.0 must be
checked.
These messages are rejected and an error
message of the following type is displayed:
Forbidden Object-ID .x.x.x.x.x (where
.x.x.x.x.x is the Object-ID requested)

only-allow-objectid

Strings list

Forbids the transmission of an SNMP message
which is related to an Object-ID (or a subtree)
that is not in the specified list. Each Object-ID in
the list must be a string which represents the full
object path in terms of digits and dots. Example:
".1.3.6.1.2.1.1" (system)
The Object-IDs which must be checked against
the list are the same as for the forbid-objectid
option.
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Parameter

Type

Description
These messages are rejected and an error
message of the following type is displayed:
Forbidden Object-ID.x.x.x.x.x
(where
.x.x.x.x.x is the Object-ID requested).

disable-nathandling

Boolean

Disables NAT handling (i.e. does not modify an IP
address, if any, in the SNMP message).

Standards Documents
The above versions of the SNMP protocol and their extensions are described in the following documents:
SNMPv1
• RFC 1157 - A Simple Network Management Protocol (SNMP) - May 1990
SNMPv2c
RFC 1901 - Introduction to Community-based SNMPv2 - January 1996
RFC 1905 - Protocol Operations for Version 2 of the Simple Network Management Protocol (SNMPv2) January 1996
Other relevant documents (for both versions) are:
• RFC 3416 - Version 2 of the Protocol Operations for the Simple Network Management Protocol (SNMP)
- December 2002
• RFC 3584 - Coexistence between Version 1, Version 2, and Version 3 of the Internet-standard Network
Management Framework - August 2003

FAST SQLNET Module
The FAST SQLNET module is concerned with the following security functions applied to exchanges of
SQL requests and data (that use the SQL*NET/Net9 protocol) with an Oracle database:
• Protocol filtering
• Address translation
• Conformity checks with the SQL*NET/Net9 protocol rules

Note
The FAST SQLNET module only supports Oracle 10g.
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General Behavior
Control over Client-to-Server Data
The first command sent from the SQL*NET/Net9 client to the server contains a data field which includes
the parameters needed to establish the connection.

Example 12.14. Client-to-Server Data
(DESCRIPTION=
(ADDRESS_LIST=
(ADDRESS=(PROTOCOL=TCP)(HOST=database.corporate.com)(PORT=1521))
(CONNECT_DATA=(SERVICE_NAME=o817)(CID=(PROGRAM=)(HOST=ora52)(USER=ora101))
)
)

The FAST SQLNET module performs the following checks on the client-to-server data:
• Checks the general format of the command
• Checks that the command is properly authorized
• Checks the command’s parameters for establishing the connection
The FAST SQLNET module can only process a command concerned with establishing a connection. This
analysis allows the evolution of a dynamic connection to be followed. The server’s response will contain
information on any eventual change of port.
Control over Server-to-Client Data
The first server response to the client contains either the same data (as the client-to-server command)
together with a change of port or simply a positive response.
Exchange Tracking
The FAST module’s exchange tracking (command/response) mechanism allows checks that are specific
to establishing a dynamic connection to be performed. The monitored parameters are described below.
PORT Parameter
The PORT parameter is returned by the server in the case of a change of port and can be controlled by
the FAST SQLNET module. This parameter is used to authorize the next client-to-server connection on
the specified port, when the same protocol (TCP/UDP) is used.
USER Parameter
The USER parameter is used by the client to establish a connection with the server. This parameter
contains the session login information needed to access the database. This field is limited to 32
characters (maximum).
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HOSTS Parameters
These two parameters contain the names of the client’s machine and the server. These names do not
need to be modified for address translation to work, since address translation is transparent for the
SQL*Net protocol (the connections are always established in the same direction and the IP address is
not checked by the server).
Parameter SERVICE_NAME
The SERVICE_NAME parameter is used by the client to establish the connection with the server. The
parameter contains the name of the Oracle server as specified in the server’s configuration file
(listener.ora).
This field is limited to 128 characters (maximum).

Note
This parameter only exists for Oracle 8.1 and above. It is equivalent to the parameter SID in earlier
versions.

Specific Actions
Dynamic Connections
The FAST SQLNET module creates and closes dynamic connections throughout the exchange. When a
dynamic connection is set up, the initial connection is destroyed.
Description of Connection
The FAST SQLNET module processes all packets that are accepted by a filtering rule which incorporates
FAST SQL*NET/Net9 analysis. Where possible, the module reports the contents of the description field
of the active connection associated with the packet or packets being analyzed. This report includes
authentication information for the initial connection and transfer information for the dynamic connection.

Example 12.15. SQLNET Connection
[SQLNET] user ora101 SID o817

Protocol Options
The protocol options (defined at the service object level in Arkoon Manager ) allow more specific control
of the module’s operation.
These options are included in the configuration file of the FAST360. When this file is installed, the
configuration generation tool gencfg analyzes these options and includes them as rules (in AKPF pseudocode) in the security filtering policy. When a new active connection is accepted by the AKPF filtering
engine, these FAST SQLNET options are associated with the connection.
The following options are available:
• user_allow
List of users authorized to be connected. All other users are rejected by the FAST SQLNET module.

Standard FAST modules

| 203

Chapter 12. FAST and IDPS

Format: list of character strings (login names)
• user_refuse
List of users not authorized to be connected. For these users, the FAST SQLNET module sends a
negative response to the client, but no trace is generated.
Format: list of character strings (login names)
• sid_allow
List of authorized database services. All other services are rejected by the FAST SQLNET module.
Format: list of character strings
• sid_refuse
List of non-authorized database services. For these services, the FAST SQLNET module sends a
negative response to the client, but no trace is generated.
Format: list of character strings

Example 12.16. Protocol Options
user_allow(ora101)

Protocol Violations (SQL*NET/Net9 analysis)
The FAST SQLNET module can cut the connection during SQL*NET/Net9 protocol analysis in the cases
listed below. For each case, the log message is shown (in brackets). These error messages can be found
in the IP logs or in the alerts.
• Command with invalid format (Invalid Command format)
• Response with invalid format (Invalid Response from server)
• PORT parameters with invalid format (Badly formatted PORT parameter in server response,
Too long PORT parameter in server response, Invalid character found in PORT parameter
in server response)

• USER parameters with invalid format (No USER parameter found in client request, Badly
formatted USER parameter in client request, Too long USER parameter in client request)
• SERVICE_NAME parameters with invalid format (No SERVICE_NAME nor SID parameter in client
request, Badly formatted SERVICE_NAME or SID parameter in client request, Too long
SERVICE_NAME or SID parameter in client request)

• Invalid port in PORT parameter (Bad PORT value in server response)
Protocol Violations (FAST options)
The FAST SQLNET module can cut the connection according to the FAST options used in the case shown
below. The log message is shown (in brackets). This error message can be found in the IP logs or in the
alerts.
• Maximum number of failed authentications reached (Max number of failed authentications
reached)
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Standards Documents
The FAST SQLNET module applies to security functions applied to exchanges of SQL requests that
conform to the SQL*NET/Net9 protocol.

FAST RTP/RTCP Module
General Behavior
The FAST RTP/RTCP module allows the RTP (Real Time Protocol) or RTCP (Real Time Control Protocol)
part of a VoIP call to be made secure. RTP/RTCP is used in the data transfer (audio/video) phase of a
VoIP call.

Important
The action of the module FAST RTP/RTCP is transparent to the users. RTP and RTCP protocols
are protected by the modules FAST SIP, FAST MGCP, FAST RTSP and FAST H323.
This module cannot be configured in Arkoon Manager. The configuration options are available
in the modules FAST SIP, FAST MGCP, FAST RTSP and FAST H323.
The main security threat during a VoIP call comes in the SIP/MGCP-based set-up and tear-down phases
of the call (protected by the FAST SIP or FAST MGCP module), but an attack can also be mounted using
covert RTP channels in the data transfer phase. The FAST RTP/RTCP module minimizes the risk of an
attack via such covert channels.

Specific Actions
The FAST RTP/RTCP module provides the functionality described below to counter attacks mounted
through RTP and RTCP.
Codec Check
When establishing a VoIP call, as well as negotiating an RTP/RTCP channel for data transfer, a set of
codecs is negotiated that could potentially be used for encoding and numbering the session. The list of
supported codecs is communicated to the FAST RTP/RTCP module. This allows the module to check that
the codec used for a received RTP/RTCP packet is a valid one; the codec used is identified in the packet
payload and compared with the list of supported codecs.
Format Checks
The FAST RTP/RTCP module performs a number of checks on RTP/RTCP packets received.
• RTP headers: The module checks that RTP packet headers are correctly formatted. Checks are
performed to ensure that:
• The packet header conforms to RFC 3550.
• The packet size does not exceed the specified maximum (in order to avoid buffer overflow).
• The packet payload is of an agreed and supported type.
• Timestamps are valid
• RTCP headers: The module checks that RTCP packet headers are correctly formatted. Checks are
performed to ensure that:
• The packet header conforms to RFC 3550.
• The packet size does not exceed the specified maximum (in order to avoid buffer overflow).
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• RTCP commands (packet payloads) are valid.
The authorized commands are: PT=200 — Sender Report, PT=201 — Receiver Report, PT=202 —
Source Description, PT=203 — BYE.
The command PT=204 — APP is not authorized.
Configuration Options
The following configuration options are available among the configuration options of the modules FAST
SIP, FAST MGCP, FAST RTSP and FAST H323.
• allow_codecs
This option configures the module to accept unknown codecs; that is, codecs which are not in the list
of supported codecs. By default, such a codec is forbidden. Format: array of integers.
• allow_app_msg
This option authorizes RTCP messages of the type APP=204, which are forbidden by default. Format:
Boolean
• allow_rtcp_single_packet
This option authorizes single RTCP packets; that is, non-compound RTCP packets, such as those used
in H.263.
• allow_rtcp_pt
This option is used to authorize payload types; by default, 200, 201, 202 and 203 payloads are authorized.
Format: array of strings.
• QoS_value
This option allows the TOS field of RTP packets over VoIP to be set in a non-destructive way. This
modification is only applied if the TOS field is not already set. The setting is specified in decimal by the
administrator. The value is typically 46; that is, “Expedited Forwarding” (no jitter, no loss of packets).

Standards Documents
The RTP and RTCP protocols are defined in the following documents:
• RFC3550/STD0064 - RTP: A Transport Protocol for Real-Time Applications - July 2003
• RFC3611 - RTP Control Protocol Extended Reports (RTCP XR) - November 2003

FAST SIP Module
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General Behavior
The FAST SIP module allows a VoIP network operating via SIP (Session Initiation Protocol) to be made
secure. SIP can be used for VoIP call set-up and tear-down. Between these phases, voice data is
exchanged via one or more RTP/RTCP flows (secured using the FAST RTP/RTCP module).
SIP System Architecture
A VoIP call established using SIP involves at least two User-Agent (UA) network objects; these
correspond to the calling party and called party. In the simplest call scenario, SIP messages are
exchanged directly between these two parties.
The call could alternatively be routed via a Proxy Server, which acts as an intermediary between the
UAs in establishing a VoIP call, relaying SIP messages between the calling and called parties. Thus, the
calling and called parties deal only with the Proxy Server during call set-up and tear-down. The Proxy
Server must therefore be able to act as a client, as well as a server.
Sometimes a Redirection Server may deal with the calls; for example, when redirecting the call towards
the Voicemail of the called party.
SIP Message Exchanges
A VoIP call that is set up using SIP always starts with a SIP INVITE message from the calling party to the
called party. The following is an example of the sequence of events to establish a call via a Proxy Server:
1. The caller sends an INVITE message to another user, the called party.
2. This request is intercepted by a SIP Proxy Server, which forwards the message to the SIP domain
server for the called party.
3. The SIP domain server contacts the computer of the called party.
4. The computer alerts the user (by “ringing” the telephone) and returns the message 180 RINGING to
the caller.
5. The called party answers the call, then the message 200 OK is returned and accepted by the caller.
6. An RTP communication is established between the two parties.
There are many more SIP messages and responses, in addition to those mentioned above.
SIP Security Issues
A VoIP call involves signaling and data exchanges between two parties, and is vulnerable to attacks;
for example:
• Eavesdropping
• Call hijacking
• Sniffing
• Call interruption
• Billing fraud
• Spam attacks
• Spoofing
• Harvesting
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Specific Actions
The FAST SIP module provides the functionality described below to counter attacks mounted through SIP.

Note
The FAST SIP module is able to deal with SIP messages transported on UDP only.
Header Checks
The module checks that SIP headers are correctly formatted and conform to RFC 3261.
The lengths of command lines in the SIP message can be limited to reduce the risk of buffer overflow. The
module can also check that the command line is correctly formatted and that all fields are correctly filled.
The sequence numbers of requests can be checked to detect unsolicited responses (to commands that
were not sent).
A check is made for format strings, to ensure that there are none present.
NAT
The module implements the same NAT functions as all other FAST360 modules. The module therefore
translates NAT addresses in the body of SIP messages.
The corresponding addresses for RTP/RTCP are translated in the same way.
Configuration Options
The following configuration options are available.
• deny_reinvite
This option refuses messages of the type re-INVITE.
• session_timeout
This option specifies the timeout period (in seconds) of a session. A 100 Trying request resets the
timeout counter to zero. A 180 Ringing or 200 OK response must then be received within the timeout
period. A response received after the timeout period will be refused by the FAST SIP module. Format:
integer (default value: 180).
• prack_with_auth
This option refuses a PRACK message if no header authentication is present.
• change_ua_with
This option modifies the User-Agent with the specified parameter value. Format: string.
• max_line_size
This option specifies the maximum permissible line length of a SIP message. By default, the maximum
authorized length of a line is 256 characters. Format: integer.
• allow_sip_header
This option allows a list of SIP headers to be specified that are to be supported in addition to those
currently recognized by the FAST SIP module. Format: array of strings.
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• allow_sip_verb
This option allows a list of non SIP verbs (INVITE, etc) to be specified that the FAST SIP module is to
accept. Format: array of strings.
• open_rtp_on_ok
In normal SIP behavior, the RTP flow only starts on receiving an ACK message. The RTP flow is sent
out on receiving a 200 OK response. This option allows the transfer of RTP packets before the ACK
message is received (and therefore violates the RFC).
• deny_custom_header
Certain implementations can use SIP headers that start with “X-”. This option forbids packets
containing this type of header.
• allow_any_via_ip
The first Via line must contain the address of the source of the packet. If the specified address is an
IP address and does not correspond to the source or destination of the packet, the packet is rejected.
This option allows a packet of this type to be accepted.
• allow_reply_codes
This option allows acceptable return codes to be added to the default list. Format: array of integers.
• deny_tel_uri
This option refuses URIs of the typetel:XYZ.
• deny_modem_uri
This option refuses URIs of the type modem:XYZ.
• deny_fax_uri
This option refuses URIs of the type fax:+331XYZ.
• user_agent_only_allow
This option allows a list of User-Agent header values to be specified that are to be accepted by
the module. If this option is present, all messages with User-Agents not specified in the list will be
refused. The search is done on a sub-string; thus, the value “Cisco” authorizes the User-Agents CiscoCP7940G/7.5, Cisco-MyCisco, etc. Format: array of strings.
• allow_unspecified_body
A message containing an unspecified body is normally forbidden. This option removes this restriction.
• allow_message_type
Normally in a packet of type MESSAGE, only text/cpim and text/plain are authorized. This option allows
this list to be extended. Format: array of strings.
• allow_parameter
In the headers Via, From and To, the list of parameters (for example, “;ttl”) is restricted. This option
allows this list of authorized parameters to be extended. Format: array of strings.
• allow_any_chars
By default, only certain characters are authorized. This option removes this restriction.
• skip_strict_header_check
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This option reduces the tests performed on headers. This is useful since certain softphones
systematically add headers that violate the RFC.
• deactivate_flooding_protection
Disables flood testing on packet reception.
• deactivate_sequence_check
Disable SIP message sequence checking

Note
Also

refer
to
the
RTP/RTCP
options
allow_codecs,
allow_rtcp_single_packet, allow_rtcp_pt, QoS_value described in
“FAST RTP/RTCP Module”.
List of accepted audio codecs
The audio codecs accepted by default are as follows:
• Codec 00: "G.711 PCMU"
• Codec 01: "1016"
• Codec 02: "G721"
• Codec 03: "GSM"
• Codec 04: "G723"
• Codec 05: "DVI4"
• Codec 06: "DVI4"
• Codec 07: "LPC"
• Codec 08: "G.711 PCMA"
• Codec 09: "G722"
• Codec 10: "L16"
• Codec 11: "L16"
• Codec 12: "QCELP"
• Codec 13: "CN"
• Codec 14: "MPA"
• Codec 15: "G728"
• Codec 16: "DVI4"
• Codec 17: "DVI4"
• Codec 18: "G729"
• Codec 25: "CelB"
• Codec 26: "JPEG"
• Codec 28: "nv"
• Codec 31: "H261"
• Codec 32: "MPV"
• Codec 33: "MP2T"
• Codec 34: "H263"
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• Codec 96 : "dynamic"
• Codec 127: "dynamic"
SDP Options
The SDP options that can be used in SIP and MGCP are as follows:
• rtp_disable_fast
Secondary media connections are opened with a udp_generic module instead of a FAST module. This
gives an improved performance in the case where the FAST RTP module takes too much time, but the
QoS setting and codec control are no longer assured. This does not affect the RTCP channel.

Important
If the SIP negotiation does not open an RTCP channel to control the flow, on receiving a BYE
the FAST SIP module cannot find the RTP channel (since it does not exist) and refuses the BYE.
This problem does not occur for a negotiated RTCP channel.
• sdp_max_port_card
It is possible to open several pairs of ports in a single line m=. By default, this is limited to a maximum
of 10 pairs. This option modifies the maximum.
• force_rtp_path
This option allows an RTP flow to be forced to cross the FAST360 appliance, even if the flow could
pass alongside the firewall.
• allow_unassigned_profile
The list of IANA profiles leaves ranges of values free for the negotiation of “dynamic” codecs. This
option allows the use of codecs in these ranges (required for Cisco telephones).
• allow_any_attributes
The (a=) attributes are the norm in SDP but in certain cases it is possible to use other attributes. This
option removes this contraint.
• sdp_max_line_size
This option specifies the maximum size of an SDP line. By default, the lines are limited to 256 characters.
• sdp_odd_port
This option authorizes the negotiation of odd and even RTCP ports.

Standards Documents
The SIP protocol is defined in the following documents:
• RFC3261 - SIP: Session Initiation Protocol - June 2002
• RFC3265 - Session Initiation Protocol (SIP) - Specific Event Notification - June 2002
• RFC3853 - S/MIME Advanced Encryption Standard (AES) Requirement for the Session Initiation
Protocol (SIP) - July 2004
• RFC4320 - Actions Addressing Identified Issues with the Session Initiation Protocol's (SIP) Non-INVITE
Transaction - January 2006
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FAST MGCP Module
General Behavior
The FAST MGCP module allows VoIP communication which passes through media gateways to be made
secure; for example, VoIP calls that pass between two networks, such as a telephone network and IP
network.

Specific Actions
Header Checks
The module checks that MGCP headers are correctly formatted and conform to RFC 3435.
The lengths of command lines in the MGCP message can be limited to reduce the risk of buffer overflow.
The module can also check that the command line is correctly formatted and that all fields are correctly
filled.
The sequence numbers of requests can be checked to detect unsolicited responses (to commands that
were not sent).
A check is made for format strings, to ensure that there are none present.
Data Checks
The module first checks that the lines of SDP headers are correctly formatted and then checks that the
SDP data parameters are coherent with the configuration made by the firewall administrator. The module
will then be capable of producing trace information on the RTP flows between gateways.
Refer to the section called “FAST SIP Module” for a list of the available SDP options.
NAT
The module implements the same NAT functions as all other firewall modules. The module therefore
translates NAT addresses in the body of MGCP messages.
Call-Agent and Gateway Restrictions
The module can authorize or forbid a gateway or Call-Agent to communicate with it, according to the
standard filtering rules of the firewall. The ACLs required for system security are generated at IP level
and not at naming space level. In addition, gateways can be filtered according to IDPS rules.
Authorized and Forbidden RTP/RTCP Flows
The module can authorize or forbid RTP/RTCP flows across the firewalls. The FAST RTP/RTCP module is
associated with each RTP data flow.
Configuration Options
The following configuration options are available.
• packet_max_size
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This option specifies the maximum permissible size of an MGCP packet transferred by the module. A
packet with a size that exceeds this limit is dropped.
• line_max_size
This option specifies the maximum permissible size of a line sent by a gateway or Call-Agent (excluding
CR/LF). Format: integer.
• session_timeout
This option specifies the timeout period (in seconds) of a pseudo MGCP session. Format: integer
(default value: 180 seconds).
• allow_connection_mode
This option allows you to specify the connection methods to be accepted, in addition to the default
methods.
• allow_reply_codes
This option allows you to specify the return codes to be accepted, in addition to the default codes.
Format: array of integers.
• allow_mgcp_verbs
This option allows you to specify the MGCP verbs to be accepted, in addition to the default verbs.
Format: array of strings.
• allow_any_chars
Disables testing for special characters and format strings
• relax_domain_names
Allow less rigorous testing on end point domain names

Note
Also

refer

to

the

RTP/RTCP

options
allow_codecs,
allow_app_msg,
allow_rtcp_single_packet, allow_rtcp_pt, QoS_value described in the section called
“FAST RTP/RTCP Module” and to the SDP options described in the section called “FAST SIP
Module”.

Standards Documents
The MGCP protocol is defined in the following documents:
• RFC3435 - Media Gateway Control Protocol (MGCP) Version 1.0 - January 2003
• RFC3661 - Media Gateway Control Protocol (MGCP) Return Code Usage - December 2003

FAST RTSP Module
General Behavior
The FAST RTSP module allows for filtering of RTSP media and protocol parameters during connection
negotiation. It does not block RTSP negotiation, but prevents the negotiation of secondary connections
which do not respect the filtering rules.
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Configuration Options
The following configuration options are available:
• no_tcp
This option prevents negotiating for media streaming over TCP.
• no_udp_rtp
This option prevents negotiation of media streaming connections using RTP over UDP.
• no_udp_rdt
This option prevents negotiation of media streaming connections using Real Networks RDT protocol
over UDP

Note
Also

refer
to
the
RTP/RTCP
options
allow_codecs,
allow_rtcp_single_packet, allow_rtcp_pt, QoS_value described in

allow_app_msg,
the section called

“FAST RTP/RTCP Module”.

FAST SSL/TLS Module
Overview
Secure Sockets Layer/Transport Layer Security Protocols
The Secure Sockets Layer (SSL) and Tranport Layer Security (TLS) protocols are two closely related
protocols designed to provide secure, authenticated communications channels over the Internet
between web clients and servers.
SSL was developed by Netscape Communications Corp. in the early 1990's and has been widely
implemented in web browsers since, becoming a de facto standard. In 1999 the IETF published RFC 2246
defining TLS 1.0, which builds on SSL 3.0 and is sometimes referred to as SSL 3.1. In April 2006 this
document was revised by RFC 4346, introducing TLS 1.1.
The FAST SSL/TLS module checks that SSL/TLS connections conform to the relevant protocols as defined
in the following standards:
• SSL 2.0: SSLv2 Protocol Draft Specification, Netscape Communications Corp, Feb 9th 1995 (http://
wp.netscape.com/eng/security/SSL_2.html).
• SSL 3.0: SSLv3 Protocol Draft Specification, Netscape Communications Corp., Nov. 18th, 1996 (http://
wp.netscape.com/eng/ssl3/draft302.txt).
• TLS 1.0: RFC 2246: The TLS Protocol Version 1.0 — January, 1999 (http://www.faqs.org/rfcs/
rfc2246.html)
• TLS 1.1: RFC 4346: The TLS Protocol Version 1.1 — April, 2006 (http://www.faqs.org/rfcs/rfc4346.html)
It is important to note that the FAST SSL/TLS module only analyzes unencrypted protocol fields. Encrypted
communications are not decrypted and analyzed by the FAST module.

Note
In the default configuration the FAST SSL/TLS module will block connections with sites for which
it cannot validate X.509 certificates – see the section called “X.509 Certificate Validation” for
details. The FAST SSL/TLS module also blocks, by default, any traffic using an SSL port if the
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traffic does not conform to SSL protocols. This will impact the following applications (amongst
others):
• Skype
• Google Talk (standalone client)
• Certain distributed workload clients (worldcommunitygrid.org, …)
X.509 Certificate Validation
The FAST SSL/TLS module uses the FAST360 appliance's authentication subsystem (described in
Chapter 16, Authentication, PKI) to validate X.509 certificates issued by clients and servers during
the SSL/TLS handshake. Certificates are validated against a preloaded database of trusted certificate
authorities and CRLs, regularly updated as part of the standard remote update processes of the FAST360
appliance.

Important
The default configuration of this module blocks SSL/TLS connections to sites which have nonverifiable certificates.
This means certain sites will be unreachable, for example if they use self-signed certificates or the
certificate has expired. In addition to HTTPS connections, SMTP, POP3 and IMAP4 connections using
TLS and filtered by the corresponding FAST SMTP, POP3, or IMAP4 module will be impacted; connections
are automatically switched to the FAST SSL/TLS module for analysis if TLS negotiation is initiated. HTTP
proxy traffic is also impacted, as the FAST HTTP module is enabled in an implicit filtering rule used by
the proxy.
If necessary you can import certificates for the FAST360 appliance configuration, to ensure they are
recognized as trusted certificates by the FAST SSL/TLS module. See Section 16.6, “Importing Certificates
for FAST SSL/TLS Authentication” for the procedure.
The FAST SSL/TLS module implements a number of options allowing you to override the appliance's
authentication subsystem for the specific needs of SSL/TLS connections. These options are detailed
below.
SSL 2.0 Handshake Analysis

Note
SSL 2.0 connections are blocked by default by the FAST SSL/TLS module. If you wish to allow
SSL 2.0 you must set the allow-SSL-2.0 option described below.
In SSL, all data sent is encapsulated in a record, an object which is composed of a header and some nonzero amount of data. An SSL 2.0 Record is used for SSL 2.0 connections but can also be used by an SSL
3.0/TLS 1.x client with support for SSL 2.0, for backward compatibility.
During the handshake, SSL 2.0 records are sent in clear text and can be analyzed. The FAST SSL/TLS
module analyzes these exchanges and ensures they conform to standard behavior as defined in the
protocol and that they respect the configured options.
Handshake messages must strictly follow the expected order as described in the following figures. The
abbreviated handshake must be followed if the server has set the SESSION-ID-HIT value (non-zero) in
the SERVER_HELLO message. Otherwise the full handshake must be used.
Client
CLIENT_HELLO

-------->

Server

SERVER_HELLO
<-------[SESSION-ID-HIT == 0]
CLIENT_MASTER_KEY
-------->
{ encrypted handshake records }
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SSL 2.0 Full Handshake Sequence
Client
CLIENT_HELLO

-------->

Server

SERVER_HELLO
<-------[SESSION-ID-HIT != 0]
{ encrypted handshake records }

SSL 2.0 Abbreviated Handshake Sequence
When the clear-text handshakes have been completed, all records are encrypted with the negotiated
secret key. The FAST SSL/TLS module will then only be able to analyze record headers.
SSL 3.0 and TLS Handshake Analysis
In SSL 3.0 and TLS, only Handshake, ChangeCipherSpec and Alert messages are allowed until a
connection state has been fully negotiated. Handshake messages must strictly follow the expected order
as described in the figure below. The abbreviated handshake must be used if the client has specified a
Session-ID and the server has sent the same ID. Otherwise the full handshake must be used.
Client
CLIENT_HELLO

Certificate*
ClientKeyExchange
CertificateVerify*
[ChangeCipherSpec]
Finished

-------->

<--------

-------->
<--------

Server
SERVER_HELLO
Certificate*
ServerKeyExchange*
CertificateRequest*
ServerHelloDone

[ChangeCipherSpec]
Finished

SSL 3.0/TLS 1.X Full Handshake Sequence. An “*” indicates optional or context-dependent messages
which are not always sent.
Client
CLIENT_HELLO

[ChangeCipherSpec]
Finished

-------->
<--------

Server
SERVER_HELLO
[ChangeCipherSpec]
Finished

-------->

SSL 3.0/TLS 1.X Abbreviated Handshake Sequence
Once the connection state has been negotiated, all records are encrypted with the negotiated connection
state. The FAST SSL/TLS module will then only be able to check record headers.

FAST SSL/TLS Module Optional Parameters
The optional parameters supported by the FAST SSL/TLS module are divided into two groups. The first
group is principally concerned with restricting parameters negotiated during handshaking. The second
group concerns handling of X.509 certificates.
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Handshake Negotiation Options
• allow-SSL-2.0
Allows SSL 2.0 connections (disabled by default). If this option is not set, SSL 2.0 connections are
blocked by the FAST module.

Note
This option has no impact on SSL 2.0 compatiblity mode connections in later SSL/TLS
protocols.
• forbid-SSL-3.0
Forbid the use of SSL 3.0. If this option is set, SSL 3.0 records are rejected with the error "Forbidden
SSL 3.0 record" and a fatal handshake_failure alert is sent to the sender.
• forbid-TLS-1.0
Forbid the use of TLS 1.0. If this option is set, TLS 1.0 records are rejected with the error "Forbidden
TLS 1.0 record" and a fatal insufficient_security alert is sent to the sender.
• forbid-TLS-1.1
Forbid the use of TLS 1.1. If this option is set, TLS 1.0 records are rejected with the error "Forbidden
TLS 1.1 record" and a fatal insufficient_security alert is sent to the sender.
• forbid-abbreviated-handshake
Prevent abbreviated handshaking. In SSL 2.0, if the server sends a SERVER_HELLO record with
the SESSION-ID-IT value set (non-zero), the packet is rejected with the error "Forbidden SSL 2.0
abbreviated handshake".In SSL 3.0/TLS 1.x, if the server sends a ServerHello record with the same
session-ID as the client, the packet is rejected with the error "Forbidden SSL/TLS abbreviated
handshake" and a fatal handshake_failure alert is sent to both peers.
• min-cipher-key-size
Sets a minimum length (number of bits) for the negotiated cipher. If the effective key size is lower than
the specified value, the packet is rejected with the error "Forbidden cipher key size of xxx bits" and a
fatal insufficient_security alert is sent to both peers.

Note
This option cannot be enforced with abbreviated handshake in SSL 2.0.
• forbid-cipher-algorithm
This option allows you to identify specific encryption algorithms that will not be allowed during
negotiation. The following algorithms are supported for this option:
• NULL
• RC4
• RC2
• DES
• 3DES
• IDEA
• AES
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• CAMELLIA
• SEED
If a peer tries to negotiate a forbidden algorithm, the packet is rejected with the error "Forbidden cipher
algorithm XXX" and a fatal insufficient_security alert is sent to both peers.

Note
This option cannot be enforced with abbreviated handshake in SSL 2.0.
• only-allow-cipher-algorithm
This option allows you to identify specific encryption algorithms as the only algorithms allowed for
negotiation. See the option forbid-cipher-algorithm (above) for supported algorithms. If a peer tries
to negotiate an algorithm other than the allowed algorithms, the packet is rejected with the error
"Forbidden cipher algorithm XXX" and a fatal insufficient_security alert is sent to both peers.

Note
This option cannot be enforced with abbreviated handshake in SSL 2.0.
• forbid-hash-algorithm
Specify one or more hash algorithms as forbidden. Supported options are NULL, MD5, and SHA1. If a
peer attempts to negotiate a forbidden hash algorithm, the packet is rejected with the error Forbidden
hash algorithm XXX and a fatal insufficient_security alert is sent to both peers.

Note
This option cannot be enforced with abbreviated handshake in SSL 2.0.
• only-allow-hash-algorithm
Restrict hash algorithm negotiation so only algorithms specified in this list are permitted (supported
options are NULL, MD5, and SHA1). If a peer attempts to negotiate an unlisted hash algorithm, the
packet is rejected with the error Forbidden hash algorithm XXX and a fatal insufficient_security alert
is sent to both peers.

Note
This option cannot be enforced with abbreviated handshake in SSL 2.0.
• forbid-key-exchange-method
This option allows you to identify specific key exchange methods that will not be allowed during
negotiation. The following key exchange methods are supported for this options:
• NULL
• RSA
• DH_DSS
• DH_RSA
• DHE_DSS
• DHE_RSA
• DH_anon
• KRB5
• PSK
• DHE_PSK
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• RSA_PSK
• ECDH_ECDSA
• ECDHE_ECDSA
• ECDH_RSA
• ECDHE_RSA
• ECDH_anon
If a peer tries to negotiate a forbidden key exchange method, the packet is rejected with the error
Forbidden key exchange method XXX and a fatal insufficient_security alert is sent to both peers.

Note
This option cannot be enforced with abbreviated handshake in SSL 2.0.
• only-allow-key-exchange-method
This option allows you to identify key exchange methods as the only methods allowed for negotiation.
See the option forbid-key-exchange-method (above) for supported algorithms. If a peer tries to
negotiate a key exchange method other than the allowed methods, the packet is rejected with the
error Forbidden key exchange method XXX and a fatal insufficient_security alert is sent to both peers.

Note
This option cannot be enforced with abbreviated handshake in SSL 2.0.
• forbid-export-cipher
Enable this option to prevent peers negotiating exportable encryption algorithms and/or key exchange
methods.
• forbid-client-anonymity
Enable this option to require clients to identify themselves with a certificate prior to the
ClientKeyExchange phase of the handshake.

Note
This option cannot be enforced with abbreviated handshake in SSL 3.0/TLS 1.x.
• forbid-server-anonymity
Enable this option to require servers to identify themselves with a certificate following the ServerHello
phase of the handshake.

Note
This option cannot be enforced with abbreviated handshake in SSL 3.0/TLS 1.x.
• allow-unknown-cipher
Use this option to allow unknown ciphersuites, which are blocked by default if an unknown ciphersuite
is chosen. If this option is enabled the following options are not enforceable:
• min-cipher-key-size
• forbid-cipher-algorithm
• only-allow-cipher-algorithm
• forbid-hash-algorithm
• only-allow-hash-algorithm
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• forbid-key-exchange-method
• only-allow-key-exchange-method
• forbid-export-cipher
X.509 Certificate Validation Options
• disable-x509-verification
This options disables verification of client or server X.509 certificates by the FAST360 appliance's PKI
module.
• forbid-x509-client-dn
This option allows you to enter a list of DNs which, if detected in client certificates, will result in a fatal
insufficient_security alert being sent to both parties.

Note
This option cannot be enforced with abbreviated handshake in SSL 2.0.
• forbid-x509-server-dn
This option allows you to enter a list of DNs which, if detected in server certificates, will result in a
fatal insufficient_security alert being sent to both parties.
• allow-x509-untrusted-client-cert
• allow-x509-untrusted-server-cert
• allow-x509-expired-client-cert
• allow-x509-expired-server-cert
• allow-x509-notyet-client-cert
• allow-x509-notyet-server-cert
These six options allow you to permit connections in certain situations in which the X.509 certificate
is not valid.
• forbid-x509-selfsigned-client-cert
Prevent clients using self-signed X.509 certificates. If a client tries to negotiate a connection using a
self-signed certificate, a fatal insufficient_security alert is sent to both parties.

Note
This option cannot be enforced with abbreviated handshake in SSL 2.0.
• forbid-x509-selfsigned-server-cert
Prevents servers using self-signed X.509 certificates. If a server tries to negotiate a connection using
a self-signed certificate, a fatal insufficient_security alert is sent to both parties.
• forbid-x509-expired-crl
Prevents authentication when the certificate which has not been revoked is tested against an expired
certificate revocation list. A fatal insufficient_security alert is sent to both parties.
• forbid-mixed-hello-versions
Allows to check the SSL/TLS versions are identical in ClientHello and ServerHello packets.
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12.2. IDPS
12.2.1. Intrusion Detection and Prevention
IDPS is an extension of the FAST technology which detects and neutralizes application layer attacks with
or without protocol violation while taking the context of the analyzed active connections into account.
FAST analysis blocks attacks regardless of application layer protocols. This protection is enhanced with
ARKOON in line IDPS (based on a database of signatures of application layer attacks).
To implement an intrusion detection system, the following points need to be considered:
• How can the number of false positives (or false alerts) be limited?
• What is the appropriate response to a potential attack?
The FAST modules follow the application layer protocol status of each connection and provide the IDPS
with very accurate information helping to define the context of the connection. This limits false positives
(analysis is done in relation to the connection's applicative status) while focusing on detecting attacks in
relation to a limited and targeted signatures base (enabling a significant improvement in performance).

Mechanisms
FAST and IDPS
The IDPS functionality uses the information determined by the FAST applicative analysis. There are three
analysis stages:
• First stage: the IP packets are filtered by FAST at the application layer. FAST checks for protocol
conformity and tracks the status of active connections. If packets violate the protocol, the connection
is stopped. If the packets pass, they go through to the second analysis stage: IDPS.
• Second stage: the IDPS filters the packets authorized by FAST by searching signatures of application
layer attacks in the flow. For each analysis, only the relevant signatures in relation to the protocol
and the connection status associated with an active connection are searched. So the IDPS takes the
analysis context into account, which optimizes performance and filtering.
• Third stage: If an attack is detected by FAST or by the IDPS (in the first or second stages), the third
stage consists of triggering which will block the attack (see the section called “Creating a Custom
FAST Policy and Configuring the FAST Reaction”).

WPM Technology
The WPM (Weighted Pattern Matching) technology limits false alerts because of its flexible behavior.
When an IP packet contains a recognized attack signature, the IDPS does not automatically trigger the
alert and the associated response because an attack often corresponds to a combination of actions,
which are not individually dangerous.
With the WPM technology, the IDPS behaves as follows:
• A score is assigned to each signature.

IDPS
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• For a given active connection, each time the IDPS detects an attack signature (match), the connection
alert level is implemented with the score assigned to the signature.
In this way, false positives are minimized, ensuring better network connectivity and performance for
users.

Note
If an internal server is attacked, it is considered more vulnerable. It is then called "Compromised
host" and the connections towards this server have a non-nil initial alert level (bonus taking its
liabilities into account). This behavior is detailed in the Compromised hosts section below.

"Warn only" Mode
In "Warn only" mode the IDPS analysis scores can be viewed in Arkoon Monitoring without triggering
alerts or responses. It corresponds to the "Active response" in common intrusion detection systems.
When working in "Warn only" mode, there is no alert threshold (dedicated to the “Abort” mode).
The “Warn only” and “Abort” modes are configured in the IDPS configuration form of the Custom FAST
policy object. For more information, refer to the section called “Configuring the FAST IDPS Protection”.

Note
Even in 'Warn only' mode, FAST checks the conformity of the applicative protocols. An active
connection which violates protocol rules is blocked.

Applicative Profiles
Attack signatures are grouped in applicative profiles, that are associated with a service which is then
implemented in filtering rules. This allows connections to be filtered in relation to an adapted context
by only selecting the appropriate profile for a given flow. In this way, the search operation done by the
IDPS is limited.

Compromised Hosts
An internal server is considered a compromised host if it has received packets which caused an IDPS
alert.
A compromised host is considered more at risk of future attacks. Consequently, the connections towards
this host have a non-nil initial alert level. This initial alert level is a percentage of the global alert threshold
(configurable in Arkoon Manager ).
A compromised host keeps this status for 12 hours. It remains "under monitoring".
The list of these compromised hosts can be viewed in Arkoon Monitoring . The number of compromised
hosts stored in the list can be set by the administrator. If this number is exceeded (new compromised
host while the list is full), the new compromised host is not stored. Ensure that the number of possible
hosts is well sized.

Update
The IDPS update is performed in the same way as other updates. It includes the download of new IDPS
signatures and new applicative profiles. These are automatically taken into account when the download
has finished.
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Note
To benefit from the IDPS updates, the FAST360 appliance must have the proper license and
include an IDPS update flag.
An appliance which does not have this flag cannot use the signatures and the profiles provided
by the FAST360 (although they are visible on the Arkoon Manager interface).
You can update signatures in disconnected mode. To do so, download the last IDPS update file from http://
client.arkoon.net, copy it to the FAST360 (in /tmp for instance):
• for XPA appliances, type the command /usr/arkupdate/IDPS_upgrade/tmp/IDPS_date.gz.
• for NPA appliances, type the command /opt/arkoon/share/arkupdate/IDPS_upgrade/tmp/
IDPS_date.gz.
This checks the file signature before installing it.

IDPS and Performance
The IDPS performance can be measured in two ways:
• filtering throughput
• limitation of false positives
The kernel mode, the use of applicative profiles for signatures bases and the FAST context analysis with
applicative status' follow-up optimizes the IDPS performance in terms of pure throughput as well as limit
false alerts.
The IDPS filtering performance increased since the IDPS configuration fits the context (use of applicative
profiles). The IDPS context analysis not only optimizes the filtering time but it also limits false positives.

Note
In any case, the activation of the IDPS technology has a very low impact on the FAST filtering
throughputs (20% maximum in the worst case).

12.2.2. Configuring in-line IDPS
IDPS configuration is done in Arkoon Manager . The IDPS functionality comes into play as soon as a
filtering rule filters an applicative service for which the IDPS is configured.
Five stages must be followed for its configuration:
• The general settings of the IDPS
• The configuration of the signatures management
• The applicative profiles configuration
• The IDPS setting in the applicative services
• The use of services configured in the filtering rules

General Settings of IDPS Use
The first stage of the IDPS configuration consists in defining its use settings for an FAST360. These
settings determine the parameters and the working mode chosen for a firewall in all the services using
the IDPS.

Configuring in-line IDPS
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Note
In Master/Slave mode, it is necessary to set the working mode of the master and the one of the
slaves separately since they can be very different.

Signature Management
The IDPS is based on an attacks signature base provided by Arkoon Network Security. They can be
accessed in 'Read' mode in Arkoon Manager . They are classified according to a logical tree-view, by
type of applicative protocol and then applicative status.
An attack signature is always linked with its applicative context. It is thus essential to an applicative
protocol and to an applicative status of this protocol.
A signature is defined by:
• Its name.
• The applicative protocol it is associated with.
• Its applicative status when searched.
• Its ID (signatures generated by the administrator have an ID #100 000).
• Its pattern (searched character string).
• The pattern type:
• CS = case sensitive, in pattern search, distinguish upper and lower cases.
• CI = case insensitive, in pattern search, not distinguish upper and lower cases.
• Joker = in the character string, the administrators enters one or several * . In search, these * can
be replaced by any other character. One * replaces a single character.
• The references, which are descriptions or links toward the signature's root, its explanation, etc.
• The score, which is defined according to the abort threshold in the IDPS configuration form of the FAST
policy object. For more information, refer to the section called “Configuring the FAST IDPS Protection”.
It is possible for the administrator to create customized applicative signatures to face attacks which
patterns are not already defined in the Arkoon IDPS signatures. To be able to define the pattern matching
an attack, it is recommended to capture your network traffic and to identify packets to block.
1. In the default layout of Arkoon Manager, select the IDPS navigation tab from the left hand side of the
main window.
2. In the explorer view, expand the Signatures tree and then the Custom IDPS Signatures tree.
3. Select the applicative protocol.
4. Right-click the applicative status you want and select New > DefaultIdpsSignatureUser. The Custom
IDPS Signature configuration tab is displayed on the right.
5. In the Properties configuration form, enter a name and a short description.
6. In the General configuration form, select the Pattern Type as described above and enter the pattern.

Caution
It is important to write a pattern which precisely matches packets to block in order not to
disturb the legitimate traffic. If the packet to block is defined by binary data, enter the matching
hexadecimal values between vertical bars.
7. Select the score according to the abort threshold in the IDPS configuration form of the Custom FAST
policy object.
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Note
It is not required to fill the references for a custom IDPS signature.

Applicative Profiles Management
In order to implement the context analysis, the signatures are grouped in applicative profiles. You can
view the applicative profiles from the Profiles subfolder of the IDPS navigation tab in Arkoon Manager .
It is possible to manually create applicative profiles in addition to the ones created by Arkoon Network
Security:
1. In the Profiles tree, right-click the Custom IDPS Profiles folder and then select New >
DefaultIdpsProfileUser. The Custom IDPS Profile configuration tab is displayed on the right.
2. In the IDPS Signatures configuration form, select the appropriate objects. A profile can regroup
signatures and/or other profiles. This allows you to group the signatures which correspond to your
type of server and its applicative files.

Assigning Profiles to Applicative Services
In order to use applicative profiles in the IDPS filtering, it is necessary to assign profiles to services,
which are then implemented in filtering rules. To do so, follow the procedure described in the section
called “Configuring the FAST IDPS Protection”.

Overload on the IDPS Working Mode of the FAST360 Appliance
For each service, the Arkoon in line IDPS working mode can follow the working mode of the FAST360
appliance on which it is used or follow its own working mode (directly settable). This takes the mode
'Warn only or Active response' into account.
The IDPS Custom Mode option is in the IDPS configuration form of the object Custom FAST policy. Refer
to the section called “Configuring the FAST IDPS Protection”.

FAST Reactions in case of Protocol Violation
The FAST360 appliance reaction in case of protocol violation (see the section called “Creating a Custom
FAST Policy and Configuring the FAST Reaction” above) is configured at the FAST policy level.

Important
Important: the configuration of a given reaction on a service will release this reaction if the
connection is blocked by the FAST analysis and if the total score of the connection releases an
IDPS alert (in 'Active response' mode).

Configuring in-line IDPS
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13.1. Terminology
VPN (Virtual Private Network)
A virtual private network, or VPN, is a network that allows a public telecommunications infrastructure
such as the Internet to be used to provide secure connectivity between different sites or between
remote clients and centralized sites. A VPN ensures that communications over the public network remain
private by using specific authentication techniques, to identify peers establishing communications, and
encryption techniques, so that data being transferred cannot be intercepted by unauthorized users.
Arkoon FAST360 appliances implement the IPsec (Internet Protocol Security) protocol set to establish
secure communications tunnels over public networks.

VPN Gateway
A VPN gateway manages setting up VPN tunnels, authenticating peer gateways or VPN clients,
negotiating security and encryption parameters, and encrypting/decrypting incoming and outgoing
communications. Arkoon FAST360 appliances can be configured as VPN gateways, as described in this
chapter, interoperating with remote FAST360 appliances, but also with third-party VPN gateways and
clients implementing the IPsec protocols and algorithms listed in Section 13.12, “Supported Protocols
and Algorithms”.

VPN Client
A VPN client is a remote computer running VPN client software (Security BOX® VPN or other),
connecting over the Internet to a VPN gateway for secure remote access to corporate information
resources. VPN client software installed must implement the IPsec protocols and algorithms as
described in Section 13.12, “Supported Protocols and Algorithms”. Using VPN client connections to a
VPN gateway, secure remote connectivity is possible for on-the-road users connecting from remote
offices, third-party (customer, partner, etc.) sites, hotel rooms, wireless hotspots, etc.
VPN gateways and VPN clients are both “VPN devices”. When a VPN tunnel is created, the data flow
is only encrypted between VPN devices.

IPsec
As stated by RFC (Request For Comments) 4301, IPsec is designed to provide interoperable, high quality,
cryptographically-based security for IP protocols. The set of security services offered includes access
control, connectionless integrity, data origin authentication, detection and rejection of replays (a form of
partial sequence integrity), confidentiality (via encryption), and limited traffic flow confidentiality. These
services are provided at the IP layer, offering protection in a standard fashion for all protocols that may
be carried over IP (including IP itself). Most of the security services are provided through use of two
traffic security protocols, the Authentication Header (AH) and the Encapsulating Security Payload (ESP),
and through the use of cryptographic key management procedures and protocols.

Terminology
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SA (Security Association)
As stated by RFC 4301, an SA is a simplex “connection” that affords security services to the traffic
carried by it. Security services are afforded to an SA by the use of AH, or ESP, but not both. If both AH
and ESP protection are applied to a traffic stream, then two SAs must be created and coordinated to
effect protection through iterated application of the security protocols. To secure typical, bi-directional
communication between two IPsec-enabled systems, a pair of SAs (one in each direction) is required.
IKE explicitly creates SA pairs in recognition of this common usage requirement.

IKE (Internet Key Exchange)
Widespread deployment and use of IPsec requires an Internet-standard, scalable, automated, SA
management protocol. Such support is required to facilitate use of the anti-replay features of AH and ESP,
and to accommodate on-demand creation of SAs, e.g. for user- and session-oriented keying. The default
automated key management protocol selected for use with IPsec is IKEv2. The IKE protocol initialization
consists of two phases. Phase 1 (Main Mode) establishes administrative tunnels for SA management.
Phase 2 (Quick Mode) establishes tunnels and corresponding SAs for secure communication (excerpt
from RFC 4301).

13.2. Types of Tunnel
The configuration of a VPN tunnel depends on the topology to be installed. The VPN tunnel can only be
set up if both VPN devices (VPN gateway/client) agree on the topology. Not only are the VPN devices and
authentication type defined, but also the source and final destination objects which are to communicate
through the VPN.
FAST360 appliances can be configured as a VPN gateway for both conventional VPN topologies:
• LAN-to-LAN VPN for connecting two remote networks
• Host-to-LAN for connecting the network to a particular host

13.2.1. LAN-to-LAN Tunnel
This type of tunnel is used to connect two subnetworks securely. Here is a classic example of the use of
a VPN tunnel for protecting flows between a Head Office and branch office or partner LANs:

where the flows are encrypted between:
• The head office FAST360 appliance and the remote partner's VPN gateway for communication
between the head office LAN and the remote partner LAN
• FAST360 head office and FAST360 branch for communication between LAN head office and LAN
branch
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Note
In the Arkoon Monitoring VPN tunnel window and system logs, this topology will be represented
as:
Central LAN IP address === FAST360 IP address ... remote FAST360 IP address
=== remote LAN IP address

(see Chapter 18, Monitoring, Logging, Error Messages for more information on
Monitoring ).

Arkoon

The IPsec protocol is very strict and the endpoints which need to communicate via the VPN tunnel must
be specified precisely. When a VPN tunnel is defined, it is important to differentiate between the VPN
gateway (FAST360 appliance or other VPN gateways) and other devices which will have the right to
communicate through this VPN tunnel (LAN1 and LAN2).
If several LANs are protected by the FAST360 appliance – for example, LANs on multiple ports of the
appliance, or one LAN connected via a router to the LAN connected to the appliance – you need to
configure a VPN tunnel for each endpoint LAN pair, as shown in the following two examples:

In this example, you need to configure one tunnel for communications between LAN1 and LAN3, and
another tunnel for communications between LAN2 and LAN3.

In this example, you need to configure one tunnel for communications between LAN3 and LAN2, and
another tunnel for communications between LAN1 and LAN2.

13.2.2. Host-to-LAN Tunnel

In the Arkoon Monitoring VPN tunnel window and system logs, this topology will be represented as:
Central LAN IP address === FAST360 IP address ... remote client IP address

(see Chapter 18, Monitoring, Logging, Error Messages for more information on Arkoon Monitoring ).

Host-to-LAN Tunnel
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13.3. Configuring a VPN Tunnel
13.3.1. Ports and Protocols
The following ports and protocols are used in setting up a VPN (IPsec) tunnel with a FAST360 appliance:
• UDP/500 port for negotiating the tunnel's session keys (IKE protocol)
• 50/IP protocol for encapsulating the encrypted flows (ESP protocol)
• UDP/4500 port if you use NAT Traversal mode negotiation (if at least one network device carries out IP
translation between the FAST360 appliance and the remote VPN gateway).
If you encounter problems in setting up a VPN tunnel or passing flows through an existing tunnel you may
need to ask your Internet Service Provider (ISP) if these ports and protocols are definitely accepted and
routed. Certain ISPs implement firewall services which may by default block these flows.

13.3.2. Configuring FAST360 Objects for VPN Tunnels
Note
A VPN tunnel only works if it is based on an Internet access defined in the configuration and
related to the VPN tunnel configuration. Moreover, to configure a VPN tunnel on a LAN, it is
necessary to create a false Internet access in order to use the VPN tunnel on the LAN side.
Setting up IPsec VPN tunnels requires the following steps:
1. Define host and network objects corresponding to the gateways, hosts and networks entities which
will be involved in VPN communication. Additionally you may need to configure individual users
connecting as remote VPN clients.
2. Activate IPsec VPN and configure appliance specific parameters on every FAST360 appliance
implementing tunnels. VPN policy objects allow the administrator to share VPN parameters among
several FAST360 appliances.
3. Define simple, star or mesh VPN topologies and authentication mode using VPN communities objects.
4. Define VPN tunnels using VPN tunnel objects. VPN tunnel objects specify the connection mode,
topology, algorithms, backup and load balancing links, and advanced parameters for a tunnel.
5. Use the VPN tunnels inside filtering rules objects, specifying which IP connections should be secured
by VPN tunnels and how.

Note
A complete description of configuring user, user group, network, and host object configuration
is given in Chapter 5, FAST360 Network Configuration; this section only covers specific
requirements for VPN configurations.
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13.3.3. LAN-to-LAN Tunnel Configuration
Configuring VPN Gateway Entities
For LAN-to-LAN VPNs, remote VPN gateways need to be configured as host objects, if not FAST360 slaves
configuration appliances.
1. In the Network objects explorer view, create a host object by right-clicking on the Hosts folder, select
New > Host.
2. Select the Network configuration form.
• If the VPN client has a fixed IP address, check the IP address option and enter this address in the
corresponding field.
• If the VPN client does not have a fixed IP address, check the Dynamic IP addressing option.
3. Select the VPN configuration form.
• For authentication using an X.509 certificate, check the Use X.509 Certificate option and drag and
drop the appropriate certificate into the X.509 Certificate field. In this case, the IPsec ID used will
be the full DN of the certificate.

Note
You cannot use the same certificate to negotiate a VPN tunnel with a FAST360 appliance
from two remote gateways with different IP addresses at the same time.
For more details of importing and creating certificates, see Chapter 16, Authentication, PKI.
• For configurations requiring a specific IPsec ID, check the Custom IPsec ID option and enter the
ID in the corresponding field.
• If you are using an RSA key, enter it in theRSA Key field. See Section 13.11.9, “RSA Key” in
Section 13.11, “Advanced VPN Topologies” for more details.

Configuring LAN Entities
In the configuration window of the LAN which is to communicate using VPN flows, the VPN gateway
used must be configured.
1. In the Network objects explorer view, create a network object by right-clicking on the Networks
folder, select New > Network. The Network configuration tab is displayed on the right.
2. Select the VPN configuration form.
• For a local LAN situated behind the FAST360 appliance, drag and drop a FAST360 appliance object
into the VPN Gateway field.
• For a remote LAN, select the host previously configured in the section called “Configuring VPN
Gateway Entities” as the VPN gateway by a drag-and-drop action into the VPN Gateway field.
• For a VPN tunnel defined between FAST360 appliances operating in master/slave mode, drag and
drop the FAST360 appliance object which directly protects the network into the VPN Gateway field.

LAN-to-LAN Tunnel Configuration
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13.3.4. Host-to-LAN Tunnel Configuration
There are three types of configurable object for identifying the VPN client:
• User
• User group
• Host
The following table shows the features available for each type of object:
IP

Authentication
DN

NT/LDAP
Import

Y

Y

Y

Y

Y

Y

Fixed

Dynamic

Certificate

RSA key

Y

Y

Y

Y

User

Y

User group

Y

Host

Note
Authentication by DN enables authentication by certificate to be implemented even if the
certificate of the client is not available on the FAST360 appliance. The following checks will be
carried out on the certificate presented by the VPN client:
• DN configured in the host object corresponds to the one in the certificate presented.
• The certificate presented is signed by a trusted CA.
• The certificate presented is not on a CRL (Certificate Revocation List).
You cannot use the same certificate to negotiate a VPN tunnel with a FAST360 appliance from 2
nomads with different IP addresses at the same time.
Only one of these three objects will be required to set up a VPN tunnel with a VPN client.

Configuring Users and User Groups
For a new user, the authentication type must be either:
• A certificate
• A DN

Note
The user name is required but is not used in setting up the VPN tunnel. This identifier is used in
displaying the VPNs available in Arkoon Monitoring VPN Tunnels window. A user with password
authentication cannot be used to set up a nomad VPN tunnel. This type of user authentication is
used in other cases (HTTP proxy, FAST360 appliance authentication, etc.).
When the certificate is presented by the VPN client, a request is sent to the authentication server to
check that the certificate presented belongs to the group authorized to set up the VPN tunnel. If the user
does not belong to this group, authorization to set up the VPN tunnel is rejected.
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Configuring Users
1. In the Authentication explorer view, create a new user by right-clicking on the Users folder, select
New > User. The User configuration tab is displayed on the right.
2. In the Properties configuration form, enter a name and short description for the user in the
corresponding fields.
3. Select the General configuration form.
4. Enter a user name for the user in the Login field.
5. Select the authentication type from one of the three options in the Credentials type section:
• For authentication by a password, enter it in the Password field and confirm it in the corresponding
field.
• For authentication by certificate, check the X.509 certificate option and drag and drop the certificate
into the X.509 certificate field.
• For authentication by domain name, check the DN option and enter the name in the corresponding
field.

Configuring User Groups of Users
A group brings together a number of nomad VPN users. If several nomad users need to set up VPN tunnels
with the same topology, use of a user group can simplify configuration.
1. In the Authentication explorer view, create a new user group by right-clicking on the Group of Users
folder, select New > User Group. The User Group configuration tab is displayed on the right.
2. In the descriptive view, enter a name and short description for the user in the corresponding fields.
3. Drag and drop the users you want to group from the Authentication descriptive view into the User
Group folder in the explorer view.

Importing Users/User Groups from an Authentication Server
No additional configuration is required for users/user groups imported from an authentication server.

Note
For more details on importing and creating certificates, see Chapter 16, Authentication, PKI.
For user groups imported from an authentication server, certificates and user accounts from this group
are not imported together.

Configuring Host Entities
For VPN clients with a fixed IP or with authentication by RSA key, a host object must be created.
1. In the Network objects explorer view, create a host object by right-clicking on the Hosts folder, select
New > Host.
2. Select the Network configuration form.
• If the VPN client has a fixed IP address, check the IP address option and enter this address in the
corresponding field.

Host-to-LAN Tunnel Configuration
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• If the VPN client does not have a fixed IP address, check the Dynamic IP addressing option.
3. Select the VPN configuration form.
• For authentication using an X.509 certificate, check the Use X.509 Certificate option and drag and
drop the appropriate certificate into the X.509 Certificate field. In this case, the IPsec ID used will
be the full DN of the certificate.

Note
You cannot use the same certificate to negotiate a VPN tunnel with a FAST360 appliance
from two remote gateways with different IP addresses at the same time.
For more details of importing and creating certificates refer to Chapter 16, Authentication, PKI.
• For configurations requiring a specific IPsec ID, check the Custom IPsec ID option and enter the
ID in the corresponding field.
• If you are using an RSA key, enter it in the RSA Key field. See Section 13.11.9, “RSA Key” in
Section 13.11, “Advanced VPN Topologies” for more details.

Configuring LAN Entities
The nomad VPN client will set up a VPN tunnel in order to communicate with a specific LAN.
1. In the Network objects explorer view, create the specific network by right-clicking on the Networks
folder, select New > Network. The Network configuration tab is displayed on the right.
2. In the VPN configuration form, drag and drop the FAST360 appliance object which directly protects
this network into the VPN Gateway field.

13.4. Configuring IPsec VPN Service on FAST360
Appliances
Parameters for IPsec VPN services in FAST360 appliance objects include:
• A VPN policy
• Interfaces/networks from which VPN access is allowed
• Authentication credentials (RSA/X.509)
The VPN policy is used to configure the parameters which will be applied to all VPN tunnels for
the FAST360 appliance. This section explains first how to configure the VPN policy (including crossreferences to sections explaining the different mechanisms involved) and then how to configure IPsec
VPN services on the FAST360 appliance.
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13.4.1. Properties of the VPN Policy
VPN policies enable the following parameters to be shared between FAST360 appliance objects:
•
•
•
•

NAT traversal support
DHCP virtual addressing support
External PKI support
Authorized/forbidden virtual IP addresses

NAT Traversal Support
NAT traversal is implemented according to RFCs 3947 (Negotiation of NAT-Traversal in the IKE ) and 3948
(UDP Encapsulation of IPsec ESP Packets).
The implementation also complies with the following drafts:
•
•
•
•
•
•
•
•

draft-ietf-ipsec-nat-t-ike-00.txt
draft-ietf-ipsec-nat-t-ike-01.txt
draft-ietf-ipsec-nat-t-ike-02.txt
draft-ietf-ipsec-nat-t-ike-03.txt
draft-ietf-ipsec-udp-encaps-00.txt
draft-ietf-ipsec-udp-encaps-01.txt
draft-ietf-ipsec-udp-encaps-02.txt
draft-ietf-ipsec-udp-encaps-03.txt

By default, an IPsec VPN uses the ESP protocol (protocol 50) over IP. This protocol does not have the
concept of “port”: it cannot therefore traverse a router carrying out port translation. One solution in this
case is to use NAT traversal. This mechanism consists of encapsulating the ESP flows in UDP 4500 or
UDP 500 packets.
To use NAT traversal, both VPN devices must have this feature enabled. Furthermore, NAT traversal will
only be used if necessary: if both VPN devices have the feature, they only use it if there is a device
between them (most often a router) carrying out port translation.
The translating device redirects the UDP 500 and 4500 ports to the entity at the end of the VPN tunnel for
flows initiated by the FAST360 appliance.
The translating device carries out a masking-type translation on flows initiated by the entity at the end
of the VPN tunnel.
The operation in greater detail is as follows:
1. Negotiation of NAT traversal by the two VPN devices
2. Detection of a device carrying out the translation of addresses via the sending of NAT-D messages
(NAT Discovery)
3. If a change of IP address has been detected, the negotiation continues using the UDP 4500 port.

Note
The use of port 4500 port avoids an analysis of port 500 carried out by certain IPsecPassthrough devices which causes problems when using NAT traversal. The use of the draft-
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ietf-ipsec-nat-t-ike-00/01 version which does not switch to port 4500 is supported by FAST360
appliances if the other end only supports this version.
4. The tunnel is then negotiated during phase 2. (Quick Mode). The ESP packets will be encapsulated in
UDP packets using the same ports as those used for ISAKMP negotiation (UDP 4500).
5. Periodically, “keep-alive” packets are sent to force the translation devices to preserve the translation
inputs (IP address of the port) of the UDP 4500 connection. These packets are not used and cannot
be used to test the operation of the tunnel.

Note
The correct operation of the tunnel can be tested by using the Dead-Peer-Detection feature
details of which are given in the rest of this section.

DHCP Virtual Addressing Support
See the section called “Allocating an Address via DHCP over IPsec” in Section 13.10, “Features
Dependant on the Type of Tunnel” for information on configuring DHCP virtual addresses.

External PKI Support
The PKI feature enables the FAST360 appliance to be integrated into an existing PKI architecture.
For more information on configuring an external PKI server see Section 13.11.4, “Managing VPN
authentication and permission with an external PKI”.

Authorized/Forbidden Virtual IP Addressing
See the section called “Allocating a Virtual IP Address” in Section 13.10, “Features Dependant on the
Type of Tunnel” for information on configuring authorized/forbidden virtual IP addresses.

13.4.2. Configuring the VPN Policy
1. In the VPN explorer view, create a new VPN policy by right-clicking on the VPN Policies folder, select
New > VPN Policy. The VPN Policy configuration tab is displayed on the right.
2. In the Properties configuration form, enter a name and short description for the VPN policy in the
corresponding fields.
3. Select the Settings configuration form.
• Check the Enable NAT Traversal option if one of the VPNs managed by the FAST360 appliance has
to traverse devices carrying out port translation. If necessary, change the value of the Keepalive
timeout. This parameter may be required in the rare case of a VPN using a non-permanent Internet
connection, for example ISDN.

Note
If Keepalive timeout is not checked, the default timeout is applied (20 seconds).
• To allow a nomad to use an address assigned by a DHCP server situated on the LAN as a virtual
address, check the Enable DHCP option and drag and drop the corresponding host object into the
DHCP Server field.

Note
The host object should be previously configured with the DHCP server capability; for more
information on configuring hosts with capabilities.
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• To authenticate using an external PKI server, check the Use External PKI and drag and drop the
PKI server object into the corresponding field.
4. In the Virtual IP addresses configuration form:
a. Drag and drop the network objects configured with the IP address or the virtual LAN of nomad
clients allowed to set up a VPN tunnel into the Authorized virtual IP addresses field.
b. Drag and drop the network objects configured with IP addresses which are not allowed to be
used by nomad workstations or remote VPN gateways (typically internal networks protected by a
FAST360 appliance) into the Forbidden virtual IP addresses field.

13.4.3. Configuring IPsec VPN Service on the FAST360 Appliance
1. In the Security configuration form of the FAST360 appliance configuration tab, select the VPN folder.
The parameters to be configured are displayed on the right.
2. Drag and drop the previously configured VPN policy into the VPN Policy field.
3. Drag and drop the listening interfaces which are to take encrypted flows into the Interfaces field in
the Authorized VPN gateways section.

Note
Specifying listening interfaces defines one implicit rule authorizing ISAKMP and ESP flows
from specified servers to FAST360 appliances. This implicit rule is read after the rules defined
in Arkoon Manager .

Warning
The IPSec service must be restarted from Arkoon Monitoring (button Maintenance/
Diagnostis...) once the IP address of the cable interface obtained.
4. Define the IP addresses of the VPN gateways and clients with which the FAST360 appliance is to
establish VPN tunnels by dragging and dropping the appropriate object into the Networks field in the
Authorized VPN gateways section. The object depends on the configuration scenario:
• In the conventional case, select the remote VPN device
• If the VPN gateway or remote nomads have a dynamic address, the Internet network must be
selected (0.0.0.0/0).
• In FAST360 master/slave configurations, select the corresponding FAST360 appliance object.
5. Define the authentication credentials in the RSA Policy section:
a. Enter either the RSA key or X.509 certificate in the corresponding field.
b. Enter the relevant IPsec ID in the corresponding field.
• If a RSA key has been used, enter its corresponding IPsec ID.
• If a X.509 certificate has been used, the DN of the certificate is the IPsec ID.

Configuring IPsec VPN Service on the FAST360 Appliance

| 237

Chapter 13. Configuring IPsec VPN Tunnels

on HA/HP Cluster Appliances
Configuring IPsec VPN Service in HA Clusters
In HA cluster mode, the IPsec VPN service is started only on the active node and the tunnels are
established using the virtual IP address(es). After failover, the new active node immediately starts the
VPN service and tries to establish all tunnels..
It is mandatory to use the same certificate for both nodes when using X.509 authentication in HA clusters
to avoid complications when configuring.
When the administrator requests one node to be passive, its IPsec VPN service must be turned off.
To create a certificate of FIREWALL type for IPsec VPN service via Minarkconf tool:
1. For the active node, connect in SSH on the administration virtual IP that the node owns.
2. For the passive node, connect in SSH on the real IP corresponding on the administration connection.
3. Launch minarkconf and go to Certificates > Import external certificate for VPN, then provide the .p12
file. This FIREWALL certificate will previously be generated by the cluster's CA or by an external PKI.
To create a certificate of FIREWALL type for IPsec VPN service via Arkoon Manager:
1. Connect on the active node.
2. Click on Actions > Advanced administration > Apply a VPN certificate.
3. Select the desired appliance and choose the certificate file to create.
4. Connect on the passive node and repeat steps 2 and 3.
This FIREWALL certificate will previously be generated by the cluster's CA or by an external PKI.

Configuring IPsec VPN Service in HP Clusters
In HP cluster mode, both modes are active and IPsec VPN service is started on each node. The tunnels
are established via the virtual IP addresses. It is mandatory to use the same certificate for both nodes
when using the X.509 authentication in order to avoid any configuration problem. Configuring IPsec VPN
Service in HP Clusters is identical to HA clusters: refer to the section called “Configuring IPsec VPN
Service in HA Clusters”.
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13.5. VPN Communities
Arkoon Manager lets you create three different types of VPN community. These communities enable
topologies from the simplest to the most complex to be put in place quickly.

13.5.1. Simple Tunnel
This conventional scenario consists of connecting two LANs together:

One VPN tunnel is defined on the FAST360 appliance:
LAN1 === FAST360_1 … FAST360_2 === LAN2

For a VPN client, there is a comparable topology – one VPN tunnel is defined on the FAST360 appliance:
LAN1 === FAST360_1 … remote client

13.5.2. Mesh Tunnel Community
The meshing tunnel is used if multiple entities need to communicate with each other in a “peer-to-peer”
topology. For example, to interconnect four LANs distributed over three sites as in this example, five VPN
tunnels are defined:

LAN1 === FAST360_Central … FAST360_Agency1 === LAN3
LAN1 === FAST360_Central … FAST360_Agency2 === LAN4
LAN2 === FAST360_Central … FAST360_Agency1 === LAN3
LAN2 === FAST360_Central … FAST360_Agency2 === LAN4
LAN3 === FAST360_Agency1 … FAST360_Agency2 === LAN4

VPN Communities
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13.5.3. Star Tunnel Community
A star community is typically used for multiple remote connections to a central site, for example for
remote clients — though the remote connections could also be VPN gateways at remote offices or
partner sites.
In this example three remote clients form a star community:

Three tunnels are defined:
LAN === FAST360 … remote_client_1
LAN === FAST360 … remote_client_2
LAN === FAST360 … remote_client_3

13.5.4. End Entities of the Tunnel
For a LAN-to-LAN VPN, the two LANs must be selected from the list of network objects.
For a VPN with a nomad, a LAN must be selected on one side and the remote host(s) and/or user(s) and/
or user group(s) selected on the other.
If a company LAN needs to be accessed by a group of nomad users, you can create just one tunnel group
to include all the users concerned. A VPN tunnel will be created for each user.
For a simple topology, select the two entities of the simple tunnel.
For a star topology, select the central entity of the star in the Hub field; the other entities which will be
arranged around the central entity are in the Entity field.
For a mesh topology, select the various entities of the VPN mesh to be installed.
For more details on configuring end entities, see step 3 of Section 13.5.5, “Configuring VPN Communities”.
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13.5.5. Configuring VPN Communities
1. In the VPN explorer view, create a new VPN community by right-clicking on the VPN Communities
folder, select New > VPN Community. The VPN Community configuration tab is displayed on the right.
2. In the Properties configuration form, enter a name and short description for the VPN community in
the corresponding fields.
3. Select the Entities configuration form.
• Drag and drop the end entities of the tunnel into the Entities field.
• To configure a star tunnel community, check the Star community option and drag and drop the
central entity of the star community into the Hub entity field.
• It is also possible to configure a group of networks:
• as the central entity of the star community ;
• as the end entity of a VPN mesh community.
4. In the Authentication configuration form, select the authentication method for this VPN tunnel group:
• To use a shared key, check the Shared key option and enter the key in the corresponding field.
• To use a X.509 certificate, check the corresponding option.
• To use a RSA key, check the corresponding option.

13.6. VPN Tunnel Groups
13.6.1. Configuring VPN Tunnel Groups
The VPN Tunnels folder contains all the groups of VPN tunnels defined by the administrator. VPN tunnel
groups are used to define the characteristics of a VPN: algorithms, topology of the VPN, etc.
A VPN tunnel group allows you to simply configure a collection of VPN topologies with identical
characteristics.

Configuring Basic Settings
In the General configuration form you define the topology of the VPN including the type of tunnel and
community the FAST360 appliance is to implement, the authentication mode to be used, and the end
entities which will communicate through this VPN tunnel.
1. In the VPN explorer view, create a new VPN tunnel by right-clicking on the VPN Tunnels folder, select
New > VPN Tunnel. The VPN Tunnel configuration tab is displayed on the right.
2. In the Properties configuration form, enter a name and short description for the VPN tunnel in the
corresponding fields.
3. In the General configuration form, select the operating mode of the tunnel group from the Type dropdown list:
• Select the Permanent tunnel type if you want the FAST360 appliance to try continuously to contact
the end of the VPN tunnel. The remote VPN device must have a fixed IP.
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• Select the On Demand tunnel type if you want the FAST360 appliance to listen for a connection
request from the remote VPN device.
4. Drag and drop the VPN community into the Communities field.

Configuring Algorithm Parameters
1. In the VPN Tunnel configuration tab, select the Algorithm configuration form.
2. If required by your VPN topology, define the lifetime of IPsec keys in the four associated fields.
a. Define the lifetime of IKE keys, in seconds, in the IKE Key lifetime field. IKE is a key negotiation
which uses its own key. IKE identifies the two machines using shared keys, RSA keys or X.509
certificates.
b. Define the lifetime of IPsec keys, in seconds, in the IPsec Key lifetime field.
c. Define the time, in seconds, before renegotiation in the Negotiation lifetime field. This time
corresponds to the time during which the keys will be regenerated. For example, if you set this time
to 540 seconds, i.e. 9 minutes, the keys will be regenerated during the last 9 minutes of their life.
d. Define the random renegotiation rate in the Random renegotiation field. This option is very useful
where there are a large number of connections as it enables key renegotiations to be shared.
The percentage defined refers to the time before renegotiation. If you set random renegotiation to
100%, the program will try to renegotiate the keys over a period of time equal to the time before
renegotiation.

Note
The default parameters may be kept in most cases. These parameters are explained in detail
in Section 13.11, “Advanced VPN Topologies”.
3. Define the list of algorithms for the first VPN negotiation phase shown by the FAST360 appliance in
the IKE algorithms table.

Note
If you select no algorithm, the FAST360 appliance will suggest by default the encryption
algorithms 3DES and AES (128 bits) and the authentication algorithms MD5 and SHA1.
However, when using the FAST360 appliances in “integrated security” mode, you must specify
the algorithms used to AES (256 bits) and SHA-2 (256 bits). These two values are available
by default.
a. Create a new entry in the IKE algorithms table by right-clicking in the blank area of the table, select
New > VPN Phase. The VPN Phase dialog box appears.
b. In the Encryption drop-down menu, choose between the 3DES, AES and DES encryption modes.
c. In the Authentication drop-down menu, choose between the MD5 and SHA1 authentication modes.

Note
If a VPN tunnel is defined for managing nomad workstations, the encryption algorithms
proposed must be identical on the FAST360 appliance for all the VPN tunnels containing
nomads as well as for the nomad VPN clients.
4. Define the list of algorithms for the second VPN negotiation phase shown by the FAST360 appliance
in the ESP algorithms table.

Note
If you do not select an algorithm, the FAST360 appliance will give the 3DES and AES (128 bit)
encryption algorithms and the MD5 and SHA1 authentication algorithms as default options.
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a. Create a new entry in the IKE Algorithm table by right-clicking in the blank area of the table, select
New > VPN Phase. The VPN Phase dialog box appears.
b. In the Encryption drop-down menu, choose between the 3DES, AES and DES encryption modes.
c. In the Authentication drop-down menu, choose between the MD5 and SHA1 authentication modes.

Configuring Tunnels Linking Multiple FAST360 Appliances
The VPN Links configuration form is used to configure the features of the backup and load balancing VPN
tunnel. For a detailed explanation of the parameters configured in this form, see Section 13.11, “Advanced
VPN Topologies”.
1. In the VPN Links configuration form, create a new entry in the VPN Links table by right-clicking in the
blank area of the table, select New > VPN Links. The VPN Links dialog box appears.
2. In the Gateway A field, drag and drop the appliance interface serving as the source gateway.
3. Select the destination gateway from the Gateway B options:
• To use the default destination gateway, check the Automatic option.
• To define a specific destination gateway, check the Gateway option and drag and drop the
appliance interface into the corresponding field.
• To use a host, check the Host option and drag and drop a host object into the corresponding field.
4. Set the priority of the links in the Priority field. Note, the highest priority is priority 1 (9 is the lowest
priority). The different VPN tunnels of links are established permanently both for backup and VPN load
balancing.
5. To keep the flow unencrypted, check the Unencrypted option.
6. To keep the flow uncompressed, check the Uncompressed option.

Configuring Advanced Parameters
The Advanced configuration form contains five parameters for advanced VPN tunnel configurations.
They are:
• Enable Perfect Forward Secrecy (PFS)
• Use hardware encryption
• Enable compression
• Enable DHCP over IPsec
• Enable Dead Peer Protection
The Enable Perfect Forward Secrecy (PFS) and Use hardware encryption options are checked by
default.
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Perfect Forward Secrecy
The use of PFS (Perfect Forward Secrecy) mode makes the various keys of a VPN session independent
of one another.
To dissociate the various session keys from one another, check the Enable Perfect Forward Secrecy
(PFS). With this option enabled, even if a hacker breaks one session key, he will not be able to break the
other keys. DH2 and DH5 groups are used in PFS.

Note
Activating this encryption option uses a large proportion of the system resources for the machine
concerned. This option is checked by default.

Hardware Encryption
If your FAST360 appliance is fitted with an ASIC VPN card, encryption is carried out automatically by
this optional card. Otherwise, encryption is carried out directly by the FAST360 appliance causing an
additional load.
To allow the VPN group to benefit from hardware acceleration, check the Use hardware encryption
option. The option is enabled by default.

Note
This option is useful for giving priority to one group of tunnels (priority for the administrator) over
another.

Compression of Encrypted Flows
The operation of the FAST360 appliance meets the following standards:
• RFC 1951 - DEFLATE Compressed Data Format Specification version 1.3
• RFC 2393 - IP Payload Compression Protocol (IPComp)
• RFC 2394 - IP Payload Compression Using DEFLATE
Compression in an IPsec tunnel uses the Deflate algorithm with the IPComp protocol.
The tunnel negotiation initiator (Quick Mode) suggests the use of compression it is configured for. The
result of the negotiation depends on the configuration of the initiator and the respondent. The following
table lists the negotiation rules.
Initiator

Respondent

Result of the negotiation

COMP

COMP

Compression negotiated

COMP

Negotiation
fails.
Message
"compression proposed by x.x.x.x,
but policy for "conn.xx" forbids it"
COMP

No compression negotiated
No compression negotiated

If the bandwidth between the VPN tunnels is too narrow, check the Enable compression (deflate) option
to compress the flows going through the VPN and so increase the bit rate, provided that the remote VPN
device supports compression mode
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DHCP over IPsec
The Enable DHCP over IPsec option is described in detail in the section called “Allocating an Address
via DHCP over IPsec”.

Dead Peer Detection
The Enable Dead Peer Protection feature detects loss of a Security Association (SA) between two VPN
devices. The method used for the FAST360 appliance is based on the method described in RFC 3706
(formerly draft-ietf-ipsec-dpd-03).
It works as follows:
1. Negotiation and use of Dead-Peer-Detection by basing on a specific VID.
(AF-CA-D7-13-68-A1-F1-C9-6B-86-96-FC-77-57-01-00). Both VPN devices must therefore have the
feature enabled in order to detect the loss of SAs.
2. Each end periodically sends a ISAKMP R_U_THERE packet when the tunnel is not in use.
The other end responds with a ISAKMP R_U_THERE_ACK packet. The frequency with which these
packets are sent is set via the parameter dpd_delay which was previously negotiated.
3. If there is no response and no traffic in the tunnel for a certain period of time (set by the dpd_timeout
parameter), the tunnel is considered as dead. If the tunnel is permanent, it is automatically re-initiated.
You are advised to Enable Dead Peer Protection in all cases (except for an Internet connection of the
RNIS type):
• In the case of a “permanent” VPN, this enables the negotiation to be re-initiated automatically.
• For an “on demand” VPN, this enables, in particular, a new connection arriving with the same
certificate but from another IP address to be accepted. The FAST360 appliance does not accept VPN
connection requests from two VPNs with the same certificate but a different VPN address. In this case,
the FAST360 appliance rejects the second connection, hence the advantage in checking Enable Dead
Peer Protection so that you know when the first VPN connection has dropped out.
Two values may be configured when the Enable Dead Peer Protection option is enabled:
• Delay: this parameter defines the frequency with which Dead-Peer-Detection packets are sent; it must
be greater than or equal to 10 seconds. The default value is 30 seconds.
• Timeout: this parameter defines the timeout interval from which the tunnel is considered as dead. This
value must be greater than or equal to 30 seconds. The default value is 120 seconds.

13.7. Filtering Rules for VPN Tunnels
This section explains how to configure filtering rules for VPN tunnels, specifically:
• Configuring the output flow
• Configuring the input flow
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• Configuring a bi-directional flow
For a more general description of filtering rules, see Chapter 9, Basic Traffic Filtering Using Filtering Rules.
You configure these flows in the Encrypted segments table in the Action configuration form of the Rule
configuration tab.

Note
You can access the Encrypted Segment dialog box of the Encrypted segments table only when
the Accept option has been checked.
A VPN tunnel is established between VPN devices independently of filtering rules. The VPN
tunnel is used to ensure confidentiality of data - the filtering rules filter this data.
By default, encryption is Not encrypted: this means that if a tunnel has been set up corresponding to the
other characteristics of the filtering rule, the flow will not be encrypted.
The encryption options are:
• Not encrypted: the packets accepted by this filtering rule may not be encrypted.
• Encrypted through any defined tunnel: packets accepted by this filtering rule must be encrypted
according to one of the available VPN tunnels; the FAST360 appliance automatically chooses the
appropriate tunnel.
• Encrypted through specified tunnels: the packets accepted by this filtering rule must be encrypted in
accordance with the selected VPN tunnel group.
In the Encrypted Segment dialog box, you must also select the encrypted segment. The FAST360
appliance object must be defined as Source if it has to encrypt the input packet; it is defined as
Destination if it has to decrypt the input packet.

Note
When the FAST360 appliance is the start of the encrypted segment, the encryption constitutes
an action on the packet. When the FAST360 appliance is the end of the encrypted segment,
the encryption is a characteristic of the input packet: if the encryption of the packet does not
correspond to that of the filtering rule, this filtering rule is judged unsuitable and further flow
rules are read.

13.7.1. Configuring the Output Flow
1. In the Rules folder, create a new filtering rule for the LAN protected by the FAST360 appliance to
the remote network(s) or nomad(s) by selecting the desired services. For detailed information on
configuring a new rule, see the section called “Creating a New Filtering Rule”.
2. Select the Action configuration form.
3. Check the Accept option. The Encrypted segments rule table is now accessible.
4. Create an encryption rule by right-clicking in the Encrypted segments blank table, select New >
Encrypted Segment. The Encrypted Segment dialog box appears.
5. Define that the encrypted segment is located between the FAST360 appliance at the head office and
the destination:
a. Drag and drop the FAST360 appliance into the Source field.
b. Drag and drop a destination object into the Destination field.
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c. Check the Encrypted through specified tunnels option.
d. Drag and drop the VPN tunnel group for this filtering rule into the VPN Tunnels field.

Note
For a master/slave configuration, if the destination is protected by another FAST360 appliance,
the FAST360 appliance object concerned must be selected as destination.

13.7.2. Configuring the Input Flow
1. In the Rules folder, create a filtering rule for the LAN protected by the FAST360 appliance to the remote
LAN/nomad by selecting the desired services. For detailed information on configuring a new rule, see
the section called “Creating a New Filtering Rule”.
2. Select the Action configuration form.
3. Check the Accept option; the Encrypted segments rule table is now accessible.
4. Create an encryption rule by right-clicking in the Encrypted segments blank table, select New >
Encrypted Segment. The Encrypted Segment dialog box appears.
5. Define that the encrypted segment is located between the FAST360 appliance at the head office and
the destination:
a. Drag and drop a source object into the Source field.
b. Drag and drop the FAST360 appliance head office object into the Destination field.
c. Check the Encrypted through specified tunnels option.
d. Drag and drop the VPN tunnel group for this filtering rule into the VPN Tunnels field.

Note
For a master/slave configuration, if the source is protected by another FAST360 appliance, the
FAST360 appliance object concerned must be selected as source.

13.7.3. Configuring a Bi-directional Rule
1. In the Rules folder, create a new filtering rule with the LAN protected by the FAST360 appliance and
the remote LAN/nomad as source and destination by selecting the desired services. For detailed
information on configuring a new rule, see the section called “Creating a New Filtering Rule”.
2. Select the Action configuration form.
3. Check the Accept option. The Encrypted segments rule table is now accessible.
4. Create an encryption rule by right-clicking in the Encrypted segments blank table, select New >
Encrypted Segment. The Encrypted Segment dialog box appears.
5. Define that the encrypted segment is located between the FAST360 appliance and the object:
a. Drag and drop a FAST360 appliance object into the Source field.
b. Drag and drop a destination object into the Destination field.
c. Check the Encrypted through specified tunnels option.
d. Drag and drop the VPN tunnel group for this filtering rule into the VPN Tunnels field.

Note
For a master/slave configuration, if the destination is protected by another FAST360 appliance,
the FAST360 appliance object concerned must be selected as destination.
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6. Configure the VPN tunnel by double-clicking on the VPN Tunnel icon. The VPN Tunnel configuration
form appears.
a. Drag and drop a source object into the Source field.
b. Drag and drop a FAST360 appliance object into the Destination field.
c. Check the Encrypted through specified tunnels option.
d. Drag and drop the VPN tunnel group for this filtering rule into the VPN Tunnels field.

Note
For a master/slave configuration, if the source is on another FAST360 appliance, the FAST360
appliance object concerned must be selected as source.

13.8. Revoking a VPN access
To delete a VPN access to a user (VPN Host-to-LAN) or a remote gateway (VPN LAN-to-LAN):
• in the case of a tunnel with an authentication with the X.509 certificate in the CA part, revoke the user
certificate or the remote gateway certificate
• in the configuration, delete the VPN tunnel and the community referencing the user, the remote
gateway or the network whose VPN gateway is the remote gateway.
In the case of a community that references more than two extreme entities, you must remove the
extreme entity referencing the user, the remote gateway or network with a VPN gateway is the remote
gateway.

13.9. Using a CRL with VPN Tunnels
13.9.1. Generating the CRLVPN
Within a VPN, the CRL is managed through the external PKI server and is provided to FAST360 appliances
by administrators via a HTTP URL or LDAP

13.9.2. Retrieving the CRL VPN with appliances
The CRL is retrieved from an external URL configured in Arkoon Manager (at a frequency which is also
configured) in the Certificate object representing the CA of the external PKI. This certificate is referenced
by the External PKI object, which is also referenced in the VPN policy of appliances.

13.9.3. Implementing grace periods for CRL VPN
You must provide the /config_card/etc/arkoon-config.local file with the following keys (the values
must be adjusted to the security policy):
# Propose a grace period before CRL really expires
ipsec.crl-grace-days = 7
# .. and impose expiration to become strict
ipsec.strictcrlpolicy = yes
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13.10. Features Dependant on the Type of Tunnel
13.10.1. LAN-to-LAN Tunnel
IP of VPN gateway masked by a router in Master/Slave architecture

Defining the Authorized VPN Server
1. In the Network objects explorer view, create a new host object.
2. In the Network configuration form, enter the public IP of the router as the fixed IP address in the
corresponding field.
3. Go to the Security configuration form of the FAST360 appliance configuration tab.
4. Select the VPN folder. The parameters to be configured are displayed on the right.
5. Drag and drop the appropriate host masking the VPN gateway into the Networks field in the
Authorized networks section.

Specifying the Public IP Address
You also need to specify the public IP address of the FAST360 appliance which is hidden by a router.
1. In the Network objects explorer view, expand the FAST360 appliance folder. The Internet Access
folder is displayed in the explorer view.
2. In the Internet Access configuration form, select the Advanced configuration form.
3. Check the Configure public IP address and Fixed options and the public IP address of the router
masking the VPN gateway in the corresponding field.

13.10.2. Host-to-LAN Tunnel
Allocating a Virtual IP Address
The FAST360 appliance allows a virtual address to be assigned to a VPN client. This virtual address must
not belong to one of the internal networks known by the FAST360 appliance for routing reasons.
The assignment of a virtual IP address has the advantage of:
• Making the nomad visible on the internal network with a given IP address (in general private).
• Enabling specific filtering rules to be written for nomads by specifying their virtual address as source
or destination.
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• Identifying connections associated with each nomad in the IP logs even if it uses a different public
address each time.
When using a virtual IP, the FAST360 appliance acts as an ARP proxy for this address. In the case of the
DHCP-over-IPsec (or manual assignment of a LAN address), this mechanism makes the nomad visible
on the LAN.

1. In the Virtual IP addresses configuration form of the VPN Policy configuration tab:
a. Drag and drop the network objects configured with the IP address or the virtual LAN of nomad
clients allowed to set up a VPN tunnel into the Authorized virtual IP addresses field.
b. Drag and drop the network objects configured with IP addresses which are not allowed to be
used by nomad workstations or remote VPN gateways (typically internal networks protected by a
FAST360 appliance) into the Forbidden virtual IP addresses field.

Allocating an Address via DHCP over IPsec
The implementation uses the RFC 3546 (Dynamic Host Configuration Protocol (DHCPv4) - Configuration
of IPsec Tunnel Mode).
The 'DHCP-over-IPsec' feature enables a nomad to use an address assigned by a DHCP server situated
on the LAN as virtual address.
This works as follows:
1. The nomad negotiates a DHCP SA.

Note
In Arkoon Monitoring , the DHCP SA appears in the VPN window and you will see a line of
the type:
Any :17/68=0.0.0.0/017/67
2. The nomad sends a DHCP request via the DHCP tunnel.
3. The FAST360 appliance modifies the request to set the Agent Circuit Id sub-option to the value 'ipsec'
then it sends it to the DHCP server.
4. The FAST360 appliance proxies the response from the DHCP server, containing among other things,
the IP address assigned.
5. The nomad negotiates the tunnel using the IP address assigned.
6. Subsequently, if its IP address is renewed, the nomad uses the tunnel already set up without creating
a new DHCP SA. The DHCP server must support the DHCP Relay Agent Information option to work
in this mode.
The DHCP server from the Internet Software Consortium (ISC) has been validated in this context.
The Agent Circuit Id sub-option can be used in the configuration of the server to define the address range.
IP assigned to the VPN nomads. This can be useful for restricting the virtual addresses authorized to this
range and to prevent a nomad from taking an address normally intended for a LAN.
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# vpn client class class "vpn-clients"
{match if option agent.circuit-id = "ipsec";}
subnet 192.168.0.0 netmask 255.255.254.0
{[...]
pool {
deny members of "vpn-clients";
range 192.168.0.100 192.168.0.254;
[...]
}
pool {
allow members of "vpn-clients";
range 192.168.1.100 192.168.1.254;
[...]
}
}

Defining the DHCP Server
To allow a nomad to use an address assigned by a DHCP server situated on the LAN as a virtual address,
complete the following procedure.
1. In the Network objects explorer view, create a new host object.
2. In the Network configuration form, enter the internal IP address to which the FAST360 appliance can
connect in the corresponding field.
3. In the Services configuration form, check the DHCP Server option to configure the host with the DHCP
server capability.
4. Select the VPN Policy configuration tab.
5. In the Settings configuration form:
a. Check the Enable DHCP option.
b. Drag and drop the host, previously configured with the DHCP capability, into the DHCP Server field.
6. In the Virtual IP addresses configuration form, drag and drop the network object configured with the
IP address range used by the DHCP server into the Authorized virtual IP addresses field.
To enable a remote client to use an address assigned by a DHCP server situated on the LAN as a virtual
address, check the Enable DHCP over IPsec option in the Advanced configuration form of the VPN Tunnel
configuration tab.

DHCP over IPsec Special Filtering Rule
The implementation of the DHCP over IPsec feature requires a special filtering rule authorizing DHCP
requests from the nomad destined for the DHCP server to be implemented.
1. In the Rules explorer view, create a new rule. For detailed information on configuring rules, see the
section called “Creating a New Filtering Rule”.
2. In the Rule configuration tab, select the Criteria configuration form.
3. Drag and drop a source object “Internet” network object configured with 0.0.0.0/0 as the IP address
into the Sources field.
4. Drag and drop the destination “DHCP server” host object with the IP address of the DHCP server into
the Destinations field.
5. Drag and drop the DHCP (service defined with UDP protocol, destination port 67 and source port 68)
service object into the Services field.
6. In the Action configuration form configure a segment encrypted from “source” to the FAST360
appliance, encrypted with a suitable VPN tunnel group. For detailed information on configuring
encrypted segments, see “Configuring Encrypted Segments” in the section called “Configuring
Actions”.
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Authentication by an External PKI Architecture
Where the certificates of the external CA are stored on an LDAP server, it is extremely advantageous to
use the LDAP groups to manage the rights of the users of the VPN. Part of the management of the VPN
policy is therefore transferred to the LDAP server.

13.11. Advanced VPN Topologies
13.11.1. VPN Backup and Load Balancing
The backup and load balancing functionalities depend on the existence of multiple VPN tunnels between
peer gateways.
Each link corresponds to a different VPN topology. Thus, for each link, a VPN tunnel is set up when the
FAST360 appliance boots up.
A link is defined by the following items:
• A source gateway: a FAST360 appliance and its interface/Internet access
• A destination gateway (optional): A FAST360 appliance (master/slave configuration) or a remote VPN
gateway
• A priority
• Properties (encrypted link, compressed link, lifetime of link).
The VPN flow travels across a link according to the priority of this link and whether links with higher
priorities are operating properly or not.
The encryption and compression properties of the flow in the VPN Links table of the VPN Links
configuration form have priority over the properties entered in the Algorithms and Advanced
configuration forms of the VPN tunnel group.
The difference between the load balancing and backup VPN is in the priority of the links:
• If multiple links have the same priority, the network packets are sent equally on each link. This is “load
balancing”.
• If multiple links have different priorities, the link with the highest priority is used exclusively. When this
link goes down, the VPN will use the lowest priority link. This is “VPN backup”.

Note
The highest priority is priority 1 (9 is the lowest priority).

Backup VPN
You can define a main link used to set up the VPN tunnel and one or more backup links.
When the main link is detected to be unavailable (using the Enable Dead Peer Detection feature), the
secondary link is used. When the main VPN link becomes operational again, it is used once more, and
the secondary link is no longer in use.
If the backup link is a private line (specialized line or other), flows may not be encrypted.
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Load Balancing
VPN flows may be distributed between multiple VPN links. Thus packets to be transmitted are sent equally
between the various active VPN links. If a load balancing link becomes unavailable, the VPN flow is
distributed between the various remaining links. When the link becomes operational again, the VPN flow
once again uses all the VPN tunnels.

Note
In case of VPN backup or load balancing, the VPN topology prevents using more than one link
with a dynamic IP address.

Example Configuration
The Enable Dead Peer Detection option must be checked in the Advanced configuration form of the
VPN tunnel group. Other aspects of these features are configured in the VpnLink table of the ListLink
configuration form of the VPN tunnel group being configured.
Here is an example of the application of these features.
A company has two Internet access connections at its head office and at a branch office.
The head office and the branch are also connected via a leased line.

We shall only deal with the configuration of these links. They are configured in the Priority field in the VPN
Links table. This table is in the VPN Links configuration form of the VPN tunnel group being configured.
Here is an example of the application of these features.
LINK NO.

VPN GATEWAY A

VPN GATEWAY B

PRIORITY

1

FAST360
HEAD INTERNET ACCESS 1
OFFICE / INTERNET 1
/FAST360
ACCESS 1
BRANCH

2

FAST360
HEAD INTERNET ACCESS 1
OFFICE / INTERNET 2
/FAST360
ACCESS 2
BRANCH

3

FAST360
HEAD ETH3/
FAST360 2
OFFICE / ETH3
BRANCH

OPTION

NON-ENCRYPTED
LINK

Once this configuration has been applied, we have the following behaviors:
• 3 VPN tunnels are set up (1 per link)

VPN Backup and Load Balancing
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• Load balancing operates between links 1 and 2 as they have the same priority
• Link no. 3 (the leased line) is not normally used as its priority is lower.

Example of Behavior
If Internet access 1 of the “FAST360 head office” is no longer operational, link no. 1 is no longer
operational:
• All traffic moves to link 2.
• Link no. 3 is not used as its priority is lower.

If link 2 also became unavailable:
• Link 3 takes over

13.11.2. Setting up a VPN Tunnel to a Specific IP Destination on a LAN
To set up a VPN tunnel to a specific and exclusive IP destination on a LAN protected by the FAST360
appliance, an object of type LAN must be created with the IP address of the host to be reached, a 32 bit
network mask and the FAST360 appliance object as VPN gateway.
This is represented by the following example topology:
Host_IP_address == FAST360_Central…..FAST360_remote === Remote_LAN_IP_address
In this case only the specified host IP can be contacted by devices on the remote LAN.

13.11.3. Algorithm Parameters for a Tunnel Group
Algorithm parameters for the tunnel group are configured in the Algorithms configuration form of the
VPN Tunnel configuration tab.
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This section explains the parameters in detail. To configure these parameters, see the section called
“Configuring Algorithm Parameters”.
IKE key lifetime: IKE is a key negotiation which uses its own key. IKE identifies the two machines using
shared keys, RSA keys or X.509 certificates. The IKE Key Lifetime is defined in seconds.
IPsec key lifetime: IPsec keys regenerate themselves automatically; Arkoon Manager lets you define
their lifetime (in seconds).
Negotiation lifetime: the time, in seconds, during which the keys will be regenerated. For example, if you
set this time to 540 seconds, i.e. 9 minutes, the keys will be regenerated during the last 9 minutes of their
life.
Random renegotiation: defined as a percentage, it refers to the time before renegotiation. If you set
random renegotiation to 100%, the program will try to renegotiate the keys over a period of time equal
to the time before renegotiation. This option is very useful where the are a large number of connections
as it enables key renegotiations to be shared.

13.11.4. Managing VPN authentication and permission with an
external PKI
The Private Key Infrastructure (PKI) feature enables FAST360 appliances to delegate VPN authentication
and permission to an existing PKI. It is also possible to use this feature to authenticate users flows.
To configure it:
1. From Authentication, right-click on the PKI folder, and then choose Create > PKI.
The PKI configuration tab is displayed.
2. Select the Properties configuration form.
a. Enter the server name in Name.
b. Enter any comment in Description.
3. From the Certificates form of the PKI object, create an X.509 certificate object and import the
certification authority certificate into PEM or DER format. This CA certificate will be considered as a
warrant of identity for the customers displaying a X.509 certificate it signed.
The CA maximal hierarchy level must be configured if the certification authority has several levels. It
defines the certification depth you want to accept.
For example:
• You have a certification authority with two levels, the root certification authority is named “Root CA”
and the intermediate certification authority is named “Delegate CA” and is signed by the “Root CA”.
• You import a trusted certificate (containing the “Root CA” certificate) into your PKI object.
• You configure your “CA maximal hierarchy level” to 1. If a customer provides an X.509 certificate
signed by the “Delegate CA”, it will not be considered as trusted. However, if a client provides an
X.509 certificate signed by the “Root CA”, it will be considered as trusted.
• For a certificate signed by the “Delegate CA”, to be trustful, you must:
• configure the “CA maximal hierarchy level” to 2.
Managing VPN authentication and permission with an external PKI
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• configure the “CA maximal hierarchy level” to 1 but import both certification authority certificates
into the “trusted certificate” section of the PKI object, that is “Root CA” and “Delegate CA”.
4. If a CRL is available, select the CRL configuration form, then select the corresponding box to
automatically retrieve the CRL(s), and determine the number of minutes between two retrievals in the
corresponding Periodically retrieve the CRLs field.
You must define the location for these CRLs from the certificate field representing the trusted
certificate previously created and selected. To retrieve a CRL, you can use HTTP and LDAP protocols.
In both cases, it is necessary to create a dedicated flow allowing the FAST360 appliance to establish
the connection necessary to retrieve the CRL.

Note
An LDAP URL can contain various and complete filtering parameters. Refer to RFC/2255 for
more details.
5. Drag and drop the external PKI server into the form:
• If integrating an external PKI for the VPN module: into a VPN policy which will be associated to
the appliance.
• If integrating an external PKI to authenticate the user's flows: into the Security > Authentication >
External PKI > PKI server of your FAST360 appliance.

13.11.5. Integrating a FAST360 appliance within an external PKI with
an LDAP server
If you want to delegate the authentication and permission management to an external PKI, it is necessary
to have an LDAP server associated with an external PKI.

Warning
It is recommended to know the functioning and configuration of the LDAP server, as well as own
an LDAP server to accurately access its content.
Within the LDAP infrastructure, you must:
• have one or several groups of users objects.
• a group of users references a bunch of users. For each user contained within this group, it is necessary
to have a “member” LDAP attribute which represents the LDAP DN representing the user.
• for example, onto an LDAP server, a group object which DN is CN = group2, DC = Arkoon,DC = Net
references two users. There will be two member attributes which value is:
• member = "CN = User 1, OU = Users, DC = Arkoon, DC = Net "
• member = "CN = User 2, OU = Users, DC = Arkoon, DC = Net"
• Warning: within groups, it is essential to have the member attribute, which will reference the user's DN.
• This attribute is then named “member attribute”.
These objects representing the groups of users in the Arkoon Manager configuration, are named “VPN
groups”.
1. Find a unique and common identifier for certificates distributed by the PKI and objects representing
the users within the LDAP tree, among the following choices:
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a. DN (Distinguished Name): the Distinguished Name included into the user's certificate must be
strictly identical to the user's DN within the LDAP database.
b. Certificate: within the objects representing the users in the LDAP tree, you must have an attribute
containing the exact replica of the certificate provided by the user.
c. RDN (Relative DN): this term defines the various fields contained within the user's certificate
DN. For example, the UID (user id), CN (Common Name) or E (Email) field. Within the objects
representing the users in the LDAP tree, you must have an LDAP attribute containing the exact
replica of the value contained in the field.

Note
This mode is the easiest and the most used.
2. Depending on the common attribute you previously chose, activate the retrieval of LDAP groups from
the LDAP groups form of the PKI object, and then select one choice: DN, Certificat or RDN.

Note
Regarding RDN, if the selected attribute contained within the certificate, is not named like the
attribute from the LDAP server, you must use the following syntax: <attribute name in the
certificate DN>/<attribute name in LDAP object>. For example: “CN/Uid” if the CN
field value in the certificate is systematically equal to the Uid attribute value representing the
user in the LDAP tree.
3. Create a host object with the LDAP server capacity and then:
• in User object Class, enter the “object class” corresponding to the objects representing your users
within your LDAP tree. In this case, the User ID LDAP atttribute field is not used.
• in Groups:
• in Group object Class , enter the “object class” corresponding to the objects representing your
group of users within your LDAP tree.
• fill in the Group ID LDAP atttribute field according to the LDAP attribute which will be used to
name VPN groups objects in the configuration.
• fill in the group member LDAP attribute with the chosen “member attribute”.
4. Drag and drop the LDAP server into the LDAP groups form of the PKI object as well as the Security
> Authentication > Authentication form of your FAST360 appliance.
5. Install the configuration and retrieve automatically the groups from the LDAP server object you
previously created. You must only retrieve the “VPN groups” created on your LDAP server.
6. It is necessary to create objects representing VPN users into the configuration. From now, to allow a
new user to negociate a VPN tunnel with the FAST360 appliance, you must:
a. provide the user with a certificate signed by the trusted CA specified within the PKI object.
b. within the LDAP server, reference the object representing the user in the VPN group object.
c. configure the imported group of users into the appliance corresponding to the VPN group, as an
entity of the chosen VPN community object .
d. after the configuration installation, the user can negociate a VPN with the FAST360 appliance.
e. all the users which will be referenced later within the LDAP VPN group and with the correct
certificate, will be able to negociate a VPN tunnel with the appliance with no direct administration
action on the FAST360 appliance.
This configuration enables to move the VPN users authentication and permission to the external PKI.
There is no need to import certificates or users into Arkoon Manager configuration anymore.
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When negociating a VPN tunnel, the debug logs can be accessed via the system logs file.

13.11.6. Integrating a FAST360 appliance within an external PKI
without an LDAP server
If you only want to delegate authentication management to the external PKI:
1. From the external PKI object, do not modify the LDAP groups configuration form.
2. Do not import the customers certificates into the configuration.
From now, to allow a user to authenticate onto the appliance, you must:
• provide the user with a certificate signed by the trusted CA specified within the PKI object.
• create a User object, and then within Parameters, select DN and complete the user's certificate
Distinguished Name.
• for VPN, select directly the user or via a group of users as an entity of the chosen VPN community
object.
• for flow authentication, select directly the user or via a group of users from the flow rule Users
section.
• after the configuration installation, this user will be able to authenticate onto the FAST360 appliance.

13.11.7. Using a Specific Certificate for Authenticating the FAST360
Appliance
By default the FAST360 appliance uses its own certificate (the same one that is used for administration
connections) to authenticate itself during the establishment of VPN tunnels.
However, you can configure the use of another certificate for establishing VPNs. This certificate must be
imported via minarkconf (SSH connection, Certificates-Import-External certificate for VPN menu). The
certificate provided by the external CA must be in PKCS#12 format and contain the following items:
• Private key
• Certificate
• CA certificate
The Key Usage attribute of the certificate must include the following values: Digital Signature, Non
Repudiation, Key Encipherment.
This feature is often used when user authentication is based on an external PKI.
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13.11.8. PSK Shared Key
Configuring Authentication by Shared Key
1. In the VPN explorer view, create a new shared key object by right-clicking on the VPN Communities
folder, select New > VPN Community. The VPN Community configuration tab is displayed on the right.
2. In the Properties configuration form, enter a name and short description for the shared key in the
corresponding fields.
3. In the Entities configuration form, drag and drop the end entities of the tunnel into the Entities field.
4. In the Authentication configuration form, check the Shared key option and enter the authentication
code for the key in the corresponding field.
The authentication code is a series of characters which may be made up of letters, digits and symbols
according to the administrator's choice.

Note
The configuration of a VPN tunnel in shared key mode with a remote host whose IP address is
masked by another device is a special case explained in article KB 768 in our knowledge base
(http://client.arkoon.net)

Important
IKE protocol “Main” mode imposes a limitation on the use of shared keys. All VPN communities
of a same Fast360 appliance must use the same shared key.

13.11.9. RSA Key
Authentication by RSA key is only given for interoperability with systems which only offer this type of
authentication. In other cases the use of X.509 certificates is strongly recommended. The key to use is
determined according to the IPsec ID provided. This may be one of a number of types:
• ID IPV4 ADDR (192.168.10.5)
• ID FQDN (@arkoon-foo)
• ID USER FQDN (bob@arkoon.net)
• ID DER ASN1 DN (CN=..., O=..., C=...)
• ID KEY ID (@#xxxxxxxxxx)

Configuring Authentication by RSA Key
1. In the Network objects explorer view, create a host object. For detailed information on creating a
host object.
2. Select the VPN configuration form.
3. Check the Custom IPsec ID option and enter the IPsec ID in the corresponding field.
4. Enter the RSA key in the corresponding field.
5. In the VPN Community configuration tab, select the Authentication configuration form.

PSK Shared Key
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6. Check the RSA key option to specify that the authentication used in the VPN community is based on
the RSA key.

13.12. Supported Protocols and Algorithms
13.12.1. IPsec Protocols
Negotiation of Session Keys
This is automatic and carried out using IKE protocol. The modes supported are “Main mode” and “Quick
mode”.
“Aggressive mode” is not supported.

IPsec Protocol
ESP — Provides an encryption and authentication feature.

Diffie-Hellman
• Group1 - MODP768b (only in DES mode)
• Group2 - MODP1024b
• Group5 - MODP1536b
• Group14 - MODP2048b
• Group15 - MODP3072b
• Group16 - MODP4096b

13.12.2. Authentication Methods
Implementing a VPN tunnel enables communications to be established securely. To achieve this, the
two entities which negotiate the VPN tunnel must firstly authenticate themselves. The authentication
methods available on the FAST360 appliance are given below.

X.509 Certificate
The use of X.509 certificates is the solution which gives the best level of security for establishing VPN
tunnels. The DN (Distinguished Name) of the certificate is then used as IPsec ID (ID DER ASN1 DN).

Warning
The robustness of this method of authentication relies in particular on the method used for
generating the X.509 certificate. When generating a certificate in PKCS#12 format, it is important
to choose a robust password for protecting the certificate. Indeed, certain information, such
as the private key used for authenticating and negotiating secure SSL connections, is strictly
confidential. If divulged to a third party, the certificate could be revoked. The password protecting
access to the PKCS#12 file must be suitably strong and follow the rules for constructing
passwords required by minarkconf .
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Shared Key (PSK)
The use of a shared key (or shared secret) is the simplest authentication method to implement, but also
the least secure: an attack “by dictionary” is always possible. The IPsec ID used is the IP address of
the FAST360 appliance.

Warning
The robustness of the authentication method depends on:
• How strong the password is (strength against attack “by dictionary”).
• How safe the method for transferring the shared key is.

RSA Key
Authentication by RSA key is only given for interoperability with systems which only offer this type of
authentication. In other cases the use of X.509 certificates is strongly recommended. The key to use is
determined according to the IPsec ID provided. This may be one of a number of types:
• ID IPV4 ADDR (192.168.10.5)
• ID FQDN (@arkoon-foo)
• ID USER FQDN (bob@arkoon.net)
• ID DER ASN1 DN (CN=..., O=..., C=...)
• ID KEY ID (@#xxxxxxxxxx)

13.12.3. Authentication Algorithms
• HMAC MD5
• HMAC SHA1
• SHA256

13.12.4. Encryption Algorithms
• DES (56 bits)
• 3DES (168 bits)
• Blowfish (128 bits)
• AES (128, 192, 256 bits)

Authentication Algorithms
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The clustering function is available on the following platforms:
• Performance P-1206, P-1808, P-2508 and P-3008 ;
• Small, Medium and Large Network Processing Appliance (NPA) ;
• XLarge A2200 and A5200
Chapter 15, High Availability for XPA appliances gives information on High Availability implementation
for XPA appliances (A10 to A2100).

14.1. Introduction
Business-critical applications must be continuously available to an organization and secure at the same
time. Cluster implementations can be used to improve the availability of such services provided by the
network. Redundancy can be provided by different network configurations according to an organization
requirements.
The FAST360 appliance clustering feature provides two options for high availability of services.
• High availability (HA) mode:
One appliance is in active mode and the other is in passive mode, on standby to take over in case of
failure of the active node.
• High performance (HP) mode:
Both appliances are active at the same time, working in active/active mode. If one of the active
FAST360 appliances fails, the other takes over to handle all of the network traffic.

Note
It is possible to use each of these modes if there are linked via the license used on each
appliance.

14.2. Clustering Principles
This section describes the concepts, terminology, and mechanisms involved in clustering FAST360
appliances.
Appliances can share logs or connection status, for example to restore services in case of dysfunction
of the appliance. A cluster is composed of two appliances named nodes.

Important
Clustering involves implementing two identical appliances (equipment and sytem version must
be identical). These appliances provide identical functional services and, to some extent, share
the same configuration. Several generations of the same appliance (for example M500) had a
different RAM. Consequently, it is essential to check both appliances of a cluster have the same
RAM. RAM quantity can be checked via Arkoon Monitoring or via the free command.

Introduction
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The appliances may share such information as audit traces (i.e. logs) or connection states to recover
services in case of the failure of one node. A cluster is made of two appliances also called nodes.
Clustering can be configured in two different working modes: High Availability (HA) and High
Performance (HP).

14.2.1. High Availability (HA)
In the High Availability mode, one node is active while the other one is passive, waiting to resume services
in case the first node fails. If performance was 100% of a single node before failure, it remains 100%
of a single node after failure. Failover, i.e. downtime, duration is a key performance indicator of a high
availability cluster. This mode is also referred to as Active/Passive mode.
The figure below illustrates active/passive mode. One FAST360 appliance acts as master and the other as
a backup of the master. The master propagates all its configurations, logs and current active connections
to the backup. If the active FAST360 appliance fails, the backup appliance is promoted to active, and
takes over the traffic processing.

Figure 14.1. Network Architecture for HA Mode

Master
Active
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14.2.2. High Performance (HP)
In High Performance mode, both nodes of the cluster are active at the same time. This configuration
emulates a high performance appliance. In case of a node failure, the other node may recover the failed
node's serviced connections.

Important
High performance is not exactly high availability as service level is degraded to some extent
when a node fails. To increase the availability level fo a HP cluster, it is recommended to have
a spare appliance identical to the other two appliances. The administrator can manually insert
this appliance into the cluste in case of prolonged node failure.
The figure below illustrates active/active mode. Both FAST360 appliances are configured to be active.
Each FAST360 appliance is responsible for a part of the network traffic (distributed by an external loadbalancing device, for example). If one FAST360 appliance fails, the other one handles all the traffic.

Figure 14.2. Network Architecture for HP Mode

Node 1
Active

Node 2
Active

Node 1
Failure

Node 2
Active

Load Balancing for High Performance (HP) cluster
The FAST360 HP cluster solution does not implement itself load balancing between two nodes. This must
be implemented by the network administrator.
For more information about integrating an HP cluster, see Section 14.10.1, “Integrating a HP Cluster”.

High Performance (HP)
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14.2.3. Comparison of High Availability and High Performance
The following figure illustrates differences between high availability and high performance modes.

Figure 14.3. Comparison of High Availability and High Performance Modes

14.2.4. IP Addressing
Real IP Addresses

Real IP addresses are IP addresses assigned to one specific cluster node. They are always active on this
node when the appliance works and they will never be assigned to the other node, even in case of failure.
Virtual IP Addresses

Virtual IP addresses are IP addresses used by the cluster to interoperate with other network devices and
services. These addresses can be active on any cluster node depending on the node state. Indeed, a
virtual IP address can be assigned to any node during the cluster's life. However, you will need to define
the node to which it will preferably be assigned: if both nodes are in a correct state, this assigned node
will receive the virtual IP address.

14.2.5. Cluster Master Node
The cluster master node is the cluster node that must be used when connecting to the cluster with
Arkoon Manager. This node is responsible for relaying management requests to the other node as well
as replication for configuration files.
In a master/slave architecture, the cluster master node is responsible for the cluster communication with
the other nodes of the architecture.

Note
It is recommended to use only the cluster master node to manage the cluster in order to avoid
the loss of administration data. A configuration installed on a non-master node is not replicated
on the master node.

Note
Each node in the cluster can be monitored individually using Arkoon Monitoring connected on
real IP addresses.
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14.2.6. Determining Cluster Master Node
In a configuration, the role of the cluster master node is attributed to the node with a particular virtual
IP address defined by the administrator. This IP address is named Cluster master node Address. In
normal functioning, the cluster master node will probably be the node on which the virtual IP address
is assigned.
If this virtual IP address goes to the other node, this node automatically becomes the new cluster master
node. You can see this Cluster Master Node status in the Cluster section into Arkoon Monitoring.

Important
The virtual IP address of the cluster master node must be a virtual IP address held by the
same cluster. This IP address must be held by an Ethernet interface (VLAN, bonding, or bridge
interfaces are not supported).
The node interface is then named Cluster master node interface.
This interface can be used to
• replicate configuration files and roles database between both cluster nodes.
• synchronize audit traces (logs from different sources) between both cluster nodes

Note
The HA master node always try to be the master.

14.3. Implementing High Availability (HA) Clustering
14.3.1. Initializing a High Availability (HA) Cluster
Initializing a cluster involves three principal stages:
1. Initializing the first cluster node.
2. Initializing a second node into the cluster.
3. Publishing parameters towards the second appliance of the cluster.
4. Failover test for High Availability (HA). This step is optional.

Prerequisite
In the following procedure, the first appliance has been initialized to be administered : IP address, CA
firewall and admin firewall, role base, license to activate the clustering.

1st step: initializing the First Appliance of a Cluster
The first stage of the initialization process involves configuring the first appliance in the cluster.
1.

Connect Arkoon Manager to the appliance. See the section called “Connecting to the FAST360
Appliance or to an AMC Server”.

2.

Load the current remote configuration or create a new one (see the First-Time Configuration Guide).

Determining Cluster Master Node
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3.

Right-click on the Appliance object and select Switch to cluster from the drop-down menu to
convert the appliance to a cluster.

The created cluster keeps the appliance name before the conversion and contains a nodes folder
with the a node corresponding to the currently connected appliance. This node is named the cluster
first node.

Note
It is recommended to rename this node to add clarity to the configuration, by selecting Edit
in the contextual menu. This name is not linked with the system hostname.

Important
The IP addresses initially configured on the standalone FAST360 appliance are used as
virtual IP addresses. Cluster mechanisms use virtual interfaces and thus the alias previously
configured are not kept.

Important
Once the cluster is implemented, it is necessary to update the appliance admin from
if the interface name was precised. For example, replace 192.168.0.254 (ethX) by
192.168.0.254 (vrrpv2gY)
4.

Create the second node by right-clicking on Nodes > New > Node > Insert.

5.

In the explorer view, select the first Node object.
The node real interfaces are displayed in the descriptive view and are for each interface to
configure.

6.

Double-click the node interface to open the Node Interface configuration form to the right.

In this form:
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a.

Enter the node's real IP address in the corresponding field.

b.

Enter the netmask in the corresponding field.

Note
It is recommended you configure the real IP addresses of a cluster interface within the
same network addressing map than its virtual IP addresses.
7.

In the explorer view, select the second Node object.
The node real interfaces are displayed in the descriptive view. For each interface to configure,
repeat the steps described above.

8.

In the explorer view, select the cluster Interfaces folder. The cluster's virtual interfaces can be seen
in the configuration form.

9.

In the descriptive view, double-click on the desired interface.

The Cluster Ethernet Interface configuration form opens on the right.
10. In the Cluster Ethernet Interface configuration form:
a.

Check the Enable this interface box to enable the selected interface.

b.

Double-click on the existing entry in the Virtual IP Addresses table to open the Virtual IP
Address pop-up window.

c.

Update the netmask.

d.

Update the virtual IP address in the corresponding field.

Note
Different virtual IP addresses can be configured for the same interface. In this case,
only the first virtual IP address can be used to configure a VPN tunnel.
e.

Into the Cluster Node field, drag and drop the node that this virtual address will be assigned
to. Considering that the first node is the one acting as the Certification Authority, it is strongly
advised to drag and drop the first node here. As a consequence, it will become the default
Cluster Master Node.

f.

Repeat the two previous steps for each interface which must holds a virtual address, including
the interfaces used for data synchronization protocols.

Initializing a High Availability (HA) Cluster
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The Advanced and Anti-spoofing tabs enable to configure the interfaces. These parameters will
apply in the same way to the cluster nodes interfaces.
11. Double-click on the cluster object previously created to open the appliance configuration form.
12. Select the Cluster tab and define the HA cluster parameters.
a.

Select High Availability as the cluster mode in the Cluster drop-down list.

b.

In the Cluster Master Node Address field, enter the management IP address with the same
value as defined for a virtual IP address.
13. Check that the configuration is coherent by clicking on the Check button on the toolbar.
• If the configuration is coherent, click the Deploy button to apply the configuration.
• If the configuration is not coherent, modify the parameters as indicated in the list of error
messages in the Check coherency window at the bottom of the screen and then repeat the
checking and configuration operation
The configuration is then taken into account by the first node.

Important
All the configured interfaces must be connected on both nodes before this operation.

2nd step: initializing the Second Appliance of a Cluster
The second stage of the initialization process involves physically plugging the new node into the cluster
architecture, and creating its PKCS#12 certificate.

Important
The second node must have within its initial configuration the following configured IP addresses:
• The IP address which will be used for publication via Arkoon Manager.
• An IP address configured in the same sub-network than the interface of the cluster master
node.

Note
Both IP addresses can be identical.
1.

Initialize the second appliance using the FAST360 Installer.

2.

Configure a first interface with an IP address on the same IP network as the PC running Arkoon
Manager.

Warning

3.

All the configured interfaces must be connected before the publication of the second node.
If one interface for the first or second node has no network connectivity, the cluster will
not be installed.
Create a new PKCS#12 FIREWALLS certificate for the second node by using the same Certification
Authority as the one used to create the first node's certificate. This certificate is required in the
section called “3rd step: publishing Parameters to the Second Appliance of a Cluster” (cautiously
keep the password protecting the private key).

Caution
A PKCS#12 file contains more than just a certificate. It contains strictly confidential data
(among which the firewall private key). A unique certificate should be created for each
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firewall. The certificate must only be stored onto the firewall or in a place with a security
level at least equivalent to the security level of the certificate use.
4.

If you do not have it yet, retrieve the license for the second appliance on http://license.arkoon.net.

3rd step: publishing Parameters to the Second Appliance of a Cluster
The third stage in initializing a cluster involves publishing configuration data to the second node.
The first appliance must be configured and ready to welcome a new cluster node. All the configured
interfaces must be connected at both nodes level.

Note
The administration console running Arkoon Manager must be authorized to connect to the
second cluster appliance using the SSH protocol on port 822. This can be configured in the Admin
From parameter in minarkconf.

Important
The Publish new node process will delete the second node certification authority and role
database, if they exist.
1.

From the view, right-click on the second item Node, then select Publish this node from the dropdown menu. The Publish the node dialog box is displayed.

2.

In the Login field, enter the system administrator's login (root by default).

3.

Enter the system administrator's password in the Password field (arkoon69! by default).

4.

Enter the second node IP address in the corresponding field (192.168.100.1 by default on the
ethernet interface).

5.

Enter the path of the newly created second node's PKCS#12 file in the Certificate field. The second
node's certificate must be a FIREWALLS certificate.

6.

Enter the password for the certificate.

7.

Enter the path of the license file of the new node.

8.

Click Publish to validate.
The Hardware information dialog box appears at the end of publication.

9.

Click on Apply to synchronize the configuration with the nodes' hardware configuration.

10. Click on Install to deploy the configuration to the cluster clicking.
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The two nodes are now published and the configuration contains both nodes hardware data.

Note
The first synchronization may take a while.

4th step: Failover Test for High Availability (HA)
The last step of initialization is not mandatory. It permits to validate the second node does take in charge
all the clusters functionalities in case the first node is unavailable.
1.

Connect on the first node with Arkoon Monitoring by using one virtual IP address.

2.

Open the Maintenance/Diagnosis window.

3.

Click on the Stop icon. The appliance stops and you are not logged onto Arkoon Monitoring anymore.

4.

Connect on the second node by using one virtual IP address.

5.

Open the General information window, select Cluster, and then check the second node is Working.

6.

Using the IP logs/HTTP relays/Alerts, check the flows are correctly handled while the first node is
stopped.

7.

Restart the first node to go back to normal.

14.3.2. Configuring Services on a High Availability (HA) Cluster
The following table lists the reference sections for the specific information to take into account when
configuring services on a High Availability (HA) cluster.

Table 14.1. Configuring FAST360 Appliance Services on a High Availability (HA) Cluster
Feature

Reference Section

Authentication

See the section called “Authentication in HA/
HP Cluster Configurations” and Section 16.3,
“Windows”

Certificate authority

See Section 4.1, “Managing Authentication
Certificates”.

Dynamic routing

See Section 19.3.2, “Constraints Imposed by
Dynamic Routing”.

HTTP proxy

See
the
section
Authentication”.

IPsec

See the section called “ on HA/HP Cluster
Appliances”.

called

“Configuring

Note
It is necessary to import a certificate for
VPN.
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Master/slave architecture

See the section called “Master/Slave Management
in HA/HP Clusters”.

SNMP

See Section 18.7, “SNMP Agent”.
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Feature

Reference Section

Update

See the section called “Installing System Updates
on NPA/Performance, XLarge and Virtual Edition
appliances”.

14.4. High Availability (HA) Audit
Managing a cluster involves configuring and monitoring state information and audit traces.
Each node has the following state information:
• Hardware information
• Configuration
• System monitoring state
• Node clustering state
There are 3 different clustering node states:
• Working — the node is running with virtual IP addresses and services up.
• Standby — the node is running, with no virtual IP address up. The node provides no service. This
state is the default state of the passive node in a High Availability (HA) cluster. It can also be triggered
by the administrator from Arkoon Monitoring or by the system monitoring feature.
• Disconnected — the node is faulty.
The nodes states are replicated and stored on each appliance. Each node advertises its state to the other
one at a configurable interval. The state advertisement interval can be configured in Arkoon Manager.
The default value is 1 second.
The cluster state is displayed in Arkoon Monitoring.
When all the nodes in the cluster have been booted and are functioning correctly, the IP address of the
cluster is the one specified in the configuration
Audit traces are stored in a database on each appliance node. There are several types of logs:
• Alerts
• IP logs (IP logs in standard log policy)
• IDPS logs
• HTTP proxy logs
• SMTP proxy logs
In both cluster modes, each Working or Standby node exchanges its database logs with the other
Working or Standby node. The logs are exchanged via the interface marked as Cluster master node
address from the Cluster tab in the appliance configuration form. If a node is in the Disconnected state,
the other node stores its logs in a queue (on the hard disk). When the disconnected node returns to
Working or Standby state, the other node sends the queued logs to this node.
Audit traces are displayed in Arkoon Monitoring. Audit traces can be filtered to display only one node's
logs.

High Availability (HA) Audit

| 273

Chapter 14. HA and HP Clustering

14.4.1. Failover Examples for High Availability (HA) Cluster
This section provides examples of how to manage traffic in a High Availability (HA) cluster, including
failover from the active to the passive node, recovery of traffic handling by the failed node, and manual
failover.

Example 14.1. Failover from Active Appliance 1 to Passive Appliance 2
The Standby node, referred to as appliance 2, is running normally but not handling traffic. The
Working node, appliance 1, is running and handles all the traffic. Both nodes are functional and data
synchronization is working properly.
1. Appliance 2 detects no activity from appliance 1 (electrical stop or disconnecting a cable on appliance
1).
2. Appliance 2 decides to take over appliance 1 traffic.
3. Appliance 2 starts the related services to handle the traffic.
After failover has occurred, appliance 2 handles the traffic.

Example 14.2. Appliance 1 Returns to Working State
Appliance 2 is running and handling all the traffic. Appliance 1 is out of order.
1. Appliance 1 returns to a Working state and broadcasts its availability (restarting appliance 1 or
replugging cable).
2. Appliance 2 detects that appliance 1 is available and decides to release traffic handling to appliance 1.
3. Appliance 1 is responsible for handling traffic.
After recovery has occurred, appliance 1 handles all the traffic.

Example 14.3. Active Appliance 1 Set to Standby State
Appliance 2 is running but not handling traffic. Appliance 1 is running and handles all the traffic. Both
nodes have a coherent state and data synchronization is working properly.
1. The administrator manually sets appliance 1 to standby state from Arkoon Monitoring.
2. Appliance 2 detects no activity from appliance 1.
3. Appliance 2 decides to take over appliance 1 traffic.
4. Appliance 1 starts the related services to handle the traffic.
After appliance 1 is set to standby, appliance 2 handles all the traffic.

Example 14.4. Standby Appliance 1 is set to Working
Appliance 1 is working and in Standby state and does not handle traffic.
Appliance 1 is cluster master appliance. Appliance 2 is working and handles traffic. Both nodes have a
coherent state and data synchronization is working correctly.
1. The administrator manually changes the state of appliance 1 from Standby to Working, clicking on
Reactivate from Arkoon Monitoring in Cluster window.
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2. Appliance 1 starts the related services to take over traffic.
3. Appliance 2 detects appliance 1 is available and decides appliance 1 will handle traffic.
4. Appliance 1 is responsible for handling the traffic.
After reactivation, appliance 1 handles all the traffic.

14.4.2. Monitoring a High Availability (HA) Cluster
Arkoon Monitoring is used to monitor the cluster as a whole and its individual nodes. The Cluster window
in Arkoon Monitoring is accessible by:
• Clicking on General Information, then Cluster tab, or
• Going to the Arkoon tree view then right click on the Cluster object
The Cluster window in Arkoon Monitoring displays the following information:
• List of cluster nodes
• Cluster version
• For each node, the following information is displayed:
• Node Id : node system identifier
• State: Working or Standby or Disconnected
• Configured interfaces
For each configured interface:
• Real IP address
• Current virtual IP address(es)
• Arkoon Monitoring indicates for each node the alerts found by VRRP (link failure, etc.)
In an AMC architecture, the cluster appliance is shown in the Arkoon Monitoring hierarchical view.
Nodes in the cluster are shown as children of the appliance with their GOR state (Green Orange Red).
Arkoon Monitoring can also be used to attribute nodes in standby mode.
Other logs are listed in /var/log/messages using syslog. These logs can be useful for advanced
administration or diagnosting needs.
For information on alerts generated by VRRP and synchronization protocols of the FAST360 appliance,
see Section 18.13, “Alerts”. These alerts are auditable via the Alerts window in Arkoon Monitoring.

14.5. Integrating High Availability (HA) Cluster into the
Network Environment
The Arkoon clustering solution can be deployed in different types of environment where the Active/
Passive solution is required.
Network management of an Active/Passive deployment is straightforward as all traffic is handled by
one node, while the other node is on standby.

Monitoring a High Availability (HA) Cluster
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Note
With VLAN interfaces, the corresponding circuits must be defined at the switch level. Moreover,
the untagged VLAN corresponding to the nodes primary interfaces (ethernet) must be activated
on the connected ports for VRRP exchanges to work.

Note
All the IP addresses of the cluster master node real interfaces automatically have a /32 netmask
(255.255.255.255). This type of mask does not support route configuration. As a consequence, a
request on this port systematically results in an ARP request. If the request succeeds, an answer
is sent. Otherwise, the sequence ends. Real IP addresses of a cluster master node are thus
reachable only if the source IP address of the flow belongs to the local network of the relevant
interface. To reach a real IP address of a master node from another network than the sub-network
of one of the interfaces, it is necessary to configure masking on the router establishing the link
to the cluster network.

14.6. High Availability (HA) Synchronization Mechanisms
The clustering feature implements specific mechanisms to ensure proper collaboration of the cluster
nodes.

14.6.1. Active Connection Synchronization
Active connection synchronization secures and maintains the connection of network flows throughout
the appliance.

Operational Principle
Connection tables with applicative analysis data, including IDPS and Fast360 information, are
synchronized between the cluster nodes.
The active node continuously forwards TCP/FAST/IDPS status changes of affected active connections.
Thus, in case of failure of the active node, the connection table of the new active node is already uptodate. The latter immediately manages network packets of existing active connections.
This feature uses mechanisms and a proprietary protocol developed by Arkoon Network Security.
Synchronization is performed using the Unicast communication mode via TCP 1760 port of the interface
configured in Arkoon Manager. The synchronization mechanism can be encrypted and/or authenticated.
For security reasons, the synchronization protocol can be protected using a shared key that is set in
Arkoon Manager.
Flows with the cluster as source or destination are not synchronized (HTTP proxy, SMTP proxy, VPN,
administration connections, etc.).
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Configuration
Synchronization can be enabled in the Cluster field of the appliance object. You must specify a flow
synchronization interface. We recommend that you dedicate a gigabit interface for this specific use.
By default, active connections of filtering rules using services with a disabled synchronization are not
synchronized. All other flows are. For some connections, you may disable synchronization in network
service settings. This reduces the network load and optimizes synchronization of critical flows.

Note
By default, synchronization is disabled for a new user service. It is also disabled for Arkoon
services identified as non-critical.

Recommendations
To optimize the appliance performances, you must use this feature only for critical flows having a long
lifetime (higher than 1 minute: Citrix, TSE, business flows). Synchronizing short flows (DNS, NTP) is
resource-consuming and is not beneficial to the user. This type of synchronization must be banned.
We recommend to configure filtering rules without active connection synchronization for non-critical
services. Thus, if a flow rule does not specify any service, all flows using this rule are synchronized.
You must take special care with this type of rule. You may create specific rules aiming at deactivating
synchronization for non-critical flows.

Statistics
The system command cat/proc/arkoon/cluster allows to view counts and low-level system
information concerning active connection synchronization statistics. The proper operation of
synchronization can be estimated with the following values:
• The Packet handled field indicates the number of network packets managed by active connection
synchronization.
• The Sync-messages generated field indicates the number of synchronization messages sent to the
other node in order to keep active connection information up-to-date.

Active Connection Synchronization
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14.6.2. Time Synchronization
All the cluster nodes are time-synchronized so that audit traces can be sorted correctly. This is done
using the NTP standard protocol. By default, the cluster master node is the time reference for the other
node. For the HA cluster, the time reference will be the node in Working (active) state. For the HP cluster ,
the time reference will be the master node (with the IP address referenced in the Cluster tab. This cannot
be configured.

14.6.3. Unsynchronized Data
The state of proxies are not synchronized between the nodes of a cluster. Each proxy on a node performs
independently. In case of failure of a node, no proxy state is recovered.
If configured on one of the nodes, the Certification Authority is not synchronized with the other node. It
is then recommended to backup the configuration map after each modification (adding or revocating a
certification).

14.7. High Availability (HA) Failover Mechanisms
This section describes the failover mechanisms required for the successful operation of a cluster.
The failover process can be described as the whole process whereby one node goes from the working
state to the standby or disconnected state and the other node takes over the first node's services.
When a node failure is detected, the remaining node handles the traffic initially going through the failed
node. In order to do this, all the virtual IP addresses of the failed node are taken over by the remaining
node, as well as the VRRP MAC addresses.The change of MAC addresses related to a virtual IP address
is communicated to the active elements connected via a “free” ARP announcement.

14.7.1. Failover on Node Loss
When the node A is stopped, the node B retrieves its virtual IP addresses. This functioning is normal
and expected from the cluster. This behavior cannot be deactivated. When the primary appliance is
reconnected, the virtual IP addresses are then retrieved.
When the node B is off, no failover occurs. When the node B is reconnected, no failover occurs as the
node A keeps the virtual IP addresses.
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14.7.2. Manual Failover
Arkoon Monitoring enables to launch a manual failover to migrate the virtual IP addresses of the node
A towards the node B. After this failover, it is possible to return to the initial state by using Arkoon
Monitoring.

It is recommended not to let the node A “waiting” for long periods of time. Indeed, since this node A is
still waiting, a malfunctioning on the node B will make the cluster unstable. This “waiting” functioning
must only be used for maintenance tasks on the node A or for failover tests.

14.7.3. Failover on Link Loss
The VRRP protocol enables to failover the virtual addresses of the node A to the node B when the node
A detects a link loss on one physical interface.
This behavior can be deactivated interface after interface:
1.

Go to the Arkoon Manager configuration, in Cluster, and then on virtual interfaces.

2.

Select the Advanced tab and then unselect Include monitoring on this link (VRRP) in cluster state
calculation.

Manual Failover
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14.7.4. System Monitoring Failover
A system health state is updated on a regular basis for each node according to the various configured
systems monitoring. A configurable threshold defines the difference of levels when a node should
consider its peer to be at a lower level and then handle the traffic.

Important
The notion of weight associated to system monitoring is not taken into account for the calculation
of the cluster states.

Configuring System Level Failover Parameters:
System monitoring is configured in two steps:
a) Global configuration of failover launching
b) System monitoring configuration

a) global configuration of failover launching
1.

In the FAST360 appliance configuration tab, select the Cluster configuration form.

2.

In the Cluster configuration form, activate the System Monitoring option.

3.

In the Status send relay field, define the interval (in seconds) separating two comparisons of system
state between the nodes.

4.

In the Fail over delay field, enter the delay (in seconds) corresponding to the time expected by the
Standby node before taking control of Working node services.

b) configuring System monitoring
This section is described in Section 18.1, “Monitoring an Appliance”.
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This example describes a High Availability failover in case of Internet access failure.
To configure sytem monitoring:
• Create a new System monitoring.
• The monitoring Typeis Internet access.
• In Internet Access monitoring drag and drop the Internet Acces to monitor item.
• In Tested hosts, drag and drop the hosts items to check the Internet access status. .
The Internet access will be seen as down when the test hosts will not answer.
It is then possible to see this alert in the Alerts logs. in Arkoon Monitoring. The type of alert will be System
monitoring.

14.7.5. VRRP Internal Functioning
The following section details the VRRP functioning and is for expert administrators who want to know
the details of VRRP functioning as it was implemented by FAST360 appliance.

VRRP
VRRP (Virtual Router Redundancy Protocol) is a routing protocol defined by RFC 3768 policy and created
to increase the availability of routing gateways. This high availability is based on two different physical
routers sharing a “virtual” router. This virtual router has a floating virtual IP address between the two
physical routers, as well as a virtual MAC address. The MAC address is always 00-00-5E-00-01-XX,
the last octet is the VRID (VRID: Virtual Router Identifier, coded in hexadecimal). On a network segment,
a unique VRID must exist.
Each router which participates to the VRRP group has a priority configured from 1 to 254. An election
determines which router has the highest priority to define it as the one holding the virtual IP address.
Messages are exchanged on the 224.0.0.18 multicast address with the IP 112 protocol number and are
emitted at a regular interval (by default, every other second).
The group's routers monitor these messages, check the incoming messages are arriving regularly and
also that the master priority is always superior to theirs. Since the preemption option is configured, a
backup router becomes a master. If there is no other master router in the subnetwork sending a message
after 6.6 seconds by default, a backup router becomes master. If the preemption option is configured, a
backup router becomes master if the master's priority decreases under its own priority.

VRRP Implementation with Arkoon Network Scurity
Arkoon Network Security has been implementing VRRP version 2 since NPA appliances version 5.0.

Naming Conventions for Interfaces
The names for FAST360 appliances real interfaces always begin with eth. VRRP interfaces always begin
with vrrpv2g. v2 means VRRP version 2. The next number is the VRID identifier and it is incremented,
starting from 1. There must be no link between the real interface number and the virtual group number.

VRRP Internal Functioning
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Protocol Extension
VRRP as defined above only defines a virtual IP address for a pair of real IP addresses. Since a router has
several interfaces (like a FAST360 appliance), Arkoon Network Security uses several virtual IP addresses:
one per pair of real IP addresses related to appliances. They are referred to as a group of virtual IP
addresses. The failover for a VRRP virtual address creates the failover for the whole group from a node
to the other.

Basic Commands
The basic commands are the akutils vrrp commands.
The list of existing commands is executed with the -h switch:
root@clusterNode1:/root> akutils vrrp -h
usage: vrrp <-s|-g|-h|-a|-p|-m|-b|-w>;
-s : show VRRP state details
-g : show VRRP groups
-a : show all my active addresses
-p : show all peer active addresses
-m : show my arkoon state
-b : show peer arkoon state
-c : show cluster state
-w : show cluster warnings
-d : show DO action
-t : show tracking state
-h : help
root@clusterNode1:/root>

• The group is indicated by akutils vrrp -g command :
root@clusterNode1:/root> akutils vrrp -g
VRRP Group = mygroup
Virtual Routers in Group:
vrrpv2g1
vrrpv2g2
vrrpv2g3
vrrpv2g4
vrrpv2g5
Synchronize fault? no
Notify Master state? no
Notify Backup state? no
Support inter-switch failure? yes
Read timeout = no
State = MASTER
root@clusterNode1:/root>

A vrrpv2g2 failover leads to a failover for vrrpv2g1, vrrpv2g3, vrrpv2g4 and vrrpv2g5 interfaces.
This behavior is still not configurable and the failover is global to the group.
• The status provided by -s enables to have information regarding VRRP status:
root@clusterNode1:/root> akutils vrrp -s
(...snip...)
VRRP Instance = vrrpv2g5
(1)
State = MASTER
(2)
Master is 172.16.3.252 (local)
(3)
Running on device = eth4
(4)
Virtual Router ID = 5
(5)
Base priority = 254
(6)
Priority = 254
(6)
Advert interval = 1 seconds
(7)
Preempt = enabled
(7)
Preempt delay = 3 seconds
(7)
Gratuitous ARP delay = 5 seconds
(7)
Read timeout = yes
(8)
root@clusterNode1:/root>

1.
2.
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3.

The node with 172.16.3.252 IP address is the cluster master node.

4.

The virtual address replies on eth4 physical interface.

5.

The VRID is 5 (information already provided with the interface name).

6.

Its initial priority is equal to the actual priority: 254, which is the highest (this explains why it is
the master).

7.

These parameters correspond to what was configured into Arkoon Manager.

8.

Read Timeout indicates the real interface is expecting to receive VRRP messages from the second
node.

• The akutils vrrp -a command enables to know the virtual IP addresses held by the node on which
the command was launched:
root@clusterNode1:/root> akutils vrrp -a
<dynamicip>172.16.0.254</dynamicip>
<dynamicip>172.16.1.254</dynamicip>
<dynamicip>88.161.162.229</dynamicip>
<dynamicip>172.16.2.254</dynamicip>
<dynamicip>172.16.3.254</dynamicip>
root@clusterNode1:/root>

• The akutils vrrp -p command enables to know the virtual IP addresses held by the second node.
In the example, the virtual IP address is not held by the slave node:
root@clusterNode1:/root> akutils vrrp -p
root@clusterNode1:/root>

Failover Mechanisms
The choice for the node which will hold the IP addresses is done by comparing the VRRP weights of both
nodes. The initial weight for the node A is 254, the initial weight for the node B is 246. The following events
can decrease the weight of a VRRP router:
• Link loss on a physical interface: the node loses 16 points.
• Link present bu no reception of VRRP packets: the node loses 16 points.
• System monitoring: for a system monitoring failure, the node loses 16 points.
The list of information participating to the calculation of VRRP weight is provided by the akutils vrrp
-t command:
root@clusterNode1:/root> akutils vrrp -t
Interface eth0
Result = UP
Interface eth2
Result = UP
Interface eth3
Result = UP
Interface eth4
Result = UP
VRRP Script sysmon-1:
Command = "/config_card/etc/6wind/keepalive6d/vrrp_track.sh sysmon-1-HTTP_proxy"
Result = SUCCESS
root@clusterNode1:/root>

In the following example, theeth1 link monitoring is not followed. The HTTP relay monitoring is activated.
It is possible to put on hold the node A priority so that the node B always takes the virtual IP addresses.
The akutils vrrp -f command reduces the priority to zero, forcing the node B to retrieve the virtual
IP addresses with a superior priority. The akutils vrrp –f command is the command launched during
a failover done from Arkoon Monitoring.
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The akutils vrrp -r command restores the node's original priority. The akutils vrrp –r command
is the command launched during a failover done from Arkoon Monitoring.

Cluster States
There can be 3 cluster states in a VRRP interface:
• Master: the physical interface owns the virtual IP address.
• Backup: the physical interface has a priority lower than the other node and then, it does not own the
virtual IP address.
• Fault: there is a link present.
The global state of the node is based on the three previous states, and then takes the two following states:
• Working: it is the node owning all the virtual IP addresses from the VRRP group.
• Standby: it is the node owning the virtual IP addresses from the VRRP group.
To avoid instabilities, it is impossible to have two VRRP equipments with the same VRID identifier on the
same network segment. With this type of topology, it is necessary to configure a different VRID for each
equipment. As previously indicated, the VRIDs are numbered in an incremental way, starting from 1, as
vrrpv2g1 in this example. If VRID 1 is associated to the first interface, the baseid by default is 0. If the
baseid is 100, VRID 101 is associated to the first interface.

Modifying a VRID on a FAST360 Appliance
It is impossible to modify the interface VRID but only all the VRIDs from a node. This operation must be
done on both nodes.
To change this numbering behavior, you must modify a key in the /config_card/etc/arkoonconfig.local file. This key modifies the baseid. This baseid must be comprised between 1 and 255.
The command is:
echo "cluster.vrrp.baseid = [your_baseid]" >> /config_card/etc/arkoon-config.local

Each appliance needs to be rebooted.

Note
On a master/slave architecture, if the cluster.vrrp.baseid key is used by one appliance
at least, all appliances can take this baseid value as the reference value when the master
node checks the global configuration. In some cases, the configuration can thus be wrongly
considered as not valid and generate an error message such as * Error: Created VRID for -"Num
VLAN " is > 255. In order to avoid this configuration error, add the following configuration keys to
the master node. This deactivates the configuration global check:
• arkoon-amc.akslave.disable-global-verif = yes
• arkoon-amc.akha.disable-global-verif = yes
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14.8. Implementing High Performance (HP) Clustering
14.8.1. Initializing a High Performance (HP) Cluster
Initializing a HP cluster follows a similar procedure to initializing a HA cluster, except:
• One virtual IP address must be configured for each enabled interface of each node of the cluster.
• High Performance cluster mode must be selected in the appliance Cluster tab.
For example, if the IP address 10.1.1.1 is configured to be a virtual IP for interface eth0 on node 1,
another IP address (IP 10.1.1.2 for example) must be configured to be a virtual IP of interface eth0
on node 2.
The virtual addresses are configured in the Virtual IP Addresses table in the Interface configuration form
of the cluster interface object (eth0 in this example).

Note
A series of checks can be carried out in Arkoon Monitoring to ensure that everything is working
correctly after the initialization of the cluster configuration.

14.8.2. Configuring Services on a High Performance (HP) Cluster
The following table lists the reference sections for specific information to take into account when
configuring services on a High Performance (HP) cluster.

Table 14.2. Configuring FAST360 Appliance Services on a High Performance (HP)
Cluster
Feature

Reference Section

Authentication

See the section called “Authentication in HA/HP Cluster
Configurations” and Section 16.3, “Windows”.

Certificate authority

See Section 4.1, “Managing Authentication Certificates”.

Dynamic routing

See Section 19.3.2, “Constraints Imposed by Dynamic Routing”.

HTTP proxy

See the section called “Configuring Authentication”.

IPsec

See the section called “ on HA/HP Cluster Appliances”.

Note
It is necessary to import a certificate for VPN.
Master/slave architecture

See the section called “Master/Slave Management in HA/HP
Clusters”.

NAT

See the section called “NAT in HP Clusters”.

SNMP

See Section 18.7, “SNMP Agent”.

Update

See the section called “Installing System Updates on NPA/
Performance, XLarge and Virtual Edition appliances”.
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14.9. High Performance (HP) Audit
Managing a cluster involves configuring and monitoring state information and audit traces.
Each node has the following state information:
• Hardware information
• Configuration
• System monitoring state
• Node clustering state
There are 3 different clustering node states:
• Working — the node is running with virtual IP addresses and services up.
• Standby — the node is running, with no virtual IP address up. The node provides no service. This
state is the default state of the passive node in a High Availability (HA) cluster. It can also be triggered
by the administrator from Arkoon Monitoring or by the system monitoring feature.
• Disconnected or failed — the node is faulty.
The nodes states are replicated and stored on each appliance. Each node advertises its state to the other
one at a configurable interval. The state advertisement interval can be configured in Arkoon Manager.
The default value is 1 second.
The cluster state is displayed in Arkoon Monitoring.
When all the nodes in the cluster have been booted and are functioning correctly, the IP address of the
cluster is the one specified in the configuration
Audit traces are stored in a database on each appliance node. There are several types of logs:
• Alerts
• IP logs (IP logs in standard log policy)
• IDPS logs
• HTTP proxy logs
• SMTP proxy logs
In both cluster modes, each working or standby node exchanges its database logs with the other working
or standby node. The logs are exchanged via the interface marked as Cluster master node address from
the Cluster tab in the appliance configuration form. If a node is in the disconnected state, the other node
stores its logs in a queue (on the hard disk). When the disconnected node returns to working or standby
state, the other node sends the queued logs to this node.
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14.9.1. Failover Examples for a High Performance (HP) Cluster
This section provides examples of how to manage traffic in a HP cluster, including failover from the first
active to the second active node, recovery of traffic handling by the failed node, and manual failover.

Example 14.5. Failover from Active Appliance 1 to Active Appliance 2
Both appliances 1 and 2 are running normally and handling traffic. Both have a coherent state and data
synchronization is working properly.
1. Appliance 2 detects no activity from appliance 1.
2. Appliance 2 decides to take over appliance 1 traffic.
3. Appliance 2 starts the related services to handle the traffic.
After failover has occurred, appliance 2 handles both appliance 1 and appliance 2 traffic.

Example 14.6. Failed Appliance 1 Returns to Working (active) State
Appliance 2 is running and handles both appliance 1 and appliance 2 traffic. Appliance 2 has a coherent
state. Appliance 1 is out of service.
1. Appliance 1 returns to a healthy state and broadcasts its availability.
2. Appliance 2 detects that appliance 1 is available and decides to release traffic handling to appliance 1.
3. Appliance 1 is again responsible for handling its own traffic.
After recovery has occurred, both appliance 1 and appliance 2 handle their respective traffic.

Example 14.7. Appliance 2 Set to Standby State
Both appliances 1 and 2 are running normally and handling traffic. Both have a coherent state and data
synchronization is working properly.
1. The administrator manually sets appliance 2 to standby state in Arkoon Monitoring.
2. Appliance 1 detects no activity from appliance 2.
3. Appliance 1 decides to take over appliance 2 traffic.
4. Appliance 1 starts the related services to handle the traffic.
After appliance 2 is set to standby, appliance 1 handles both appliance 1 and appliance 2 traffic.

Example 14.8. Appliance 2 in Standby is set to Working (active) state
Appliance 2 is set to Standby mode.
Appliance 2 is working and is in Standby state and does not handle traffic. Appliance 1 handles its traffic
and appliance 2 traffic.
1. The administrator manually changes appliance 1 state from Standby to Working clicking on Reactivate
from Arkoon Monitoring in the Cluster window.
2. Appliance 2 detects appliance 1 is available and decides to give traffic handling to appliance 1.

Failover Examples for a High Performance (HP) Cluster
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3. Appliance 1 handles again its own traffic.
After reactivation, appliance 1 and 2 handle their own traffic.

14.9.2. Monitoring a High Performance (HP) Cluster
Arkoon Monitoring is used to monitor the cluster as a whole and its individual nodes. The Cluster window
in Arkoon Monitoring is accessible by:
• Clicking on General Information, then Cluster tab, or
• Going to the Arkoon tree view then right click on the Cluster object
The Cluster window in Arkoon Monitoring displays the following information:
• List of cluster nodes
• Cluster version
• For each node, the following information is displayed:
• Node Id : node system identifier
• State: Working or Standby or Disconnected
• Configured interfaces
For each configured interface:
• Real IP address
• Current virtual IP address(es)
• Arkoon Monitoring indicates for each node the alerts found by VRRP (link failure, etc.)
In an AMC architecture, the cluster appliance is shown in the Arkoon Monitoring hierarchical view.
Nodes in the cluster are shown as children of the appliance with their GOR state (Green Orange Red).
Arkoon Monitoring can also be used to attribute nodes in standby mode.
Other logs are listed in /var/log/messages using syslog. These logs can be useful for advanced
administration or diagnosting needs.
For information on alerts generated by VRRP and synchronization protocols of the FAST360 appliance,
see Section 18.13, “Alerts”. These alerts are auditable via the Alerts window in Arkoon Monitoring.

14.10. Integrating High Performance (HP) Cluster into the
Network Environment
This section provides several use cases describing how to deploy the FAST360 cluster solution in HP
mode.

Note
With VLAN interfaces, the corresponding circuits must be defined at switch level. Moreover, the
non-tagged VLAN corresponding to the nodes primary interfaces (ethernet) must be activated
onto the connected ports for the VRRP exchanges to establish.
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14.10.1. Integrating a HP Cluster
In a network architecture implementing a HP cluster, the network administrator must ensure that, for a
given IP connection, client-to-server packets and server-to-client packets are routed through the same
appliance.
To ensure traffic is handled correctly by the cluster nodes, either a technical or network environment
solution must be implemented.

Table 14.3. Technical Solutions for Integrating a HP Cluster
Objective

Solution

Route and
load-balancing
connection
answers

Implement source translation using masquerading with interface virtual IP
address.

Route and loadImplement destination translation using Port Address Translation by interface
balancing incoming virtual address.
connections

Table 14.4. Environment Solutions for Integrating a HP Cluster
Device

Description

Router with
connection
tracking/Switch
Level 4

Device able to memorize an incoming packet and route the corresponding
response accordingly (on the same node).

Load balancer

Implementation of the solution above and load balancing (a new connection is
routed on the less loaded node).

The administrator has several solutions for balancing traffic load between the cluster nodes; for more
information, see the section called “Load Balancing for High Performance (HP) cluster”.

14.10.2. LAN to DMZ (Demilitarized Zone) Traffic
The following two use cases describe how to configure the filtering of IP connections from the LAN to
internal servers in the Demilitarized Zone (DMZ).
In both cases, the source IP address and the destination IP address are controlled by the network
administrator.

Figure 14.4. LAN to DMZ Use Case

Integrating a HP Cluster
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Table 14.5. LAN to DMZ Use Case Solutions
Objective

Solution

A computer in the LAN can
1. Define on the LAN computer a route to reach the DMZ.
establish connection to a server in
• Destination is the DMZ.
the DMZ.
• Gateway is one of the cluster's virtual IP addresses of a
defined node.
Note
In this case, the firewall
administrator has
permission to manage the
server routing parameters.

2. In Arkoon Manager, create an ACCEPT rule from the LAN to the
DMZ.
3. Define on the DMZ server a route to the LAN computer.
• Destination is the LAN computer.
• Gateway is one of the cluster's virtual IP addresses of the
same node.

A computer in the LAN can
establish connection to another
server in the DMZ.

Note
In this case, the firewall
administrator does
not have permission
to manager the server
routing parameters.

1. Define on the LAN computer a route to reach the DMZ.
• Destination is the DMZ.
• Gateway is one of the cluster's virtual IP addresses of a
defined node.
2. In Arkoon Manager, create an ACCEPT rule from the LAN to the
DMZ.
• Create a new translation configuration with source
translation masquerading. The source translation ensures
that server packets are routed through the same node as
client packets.

These two solutions allow to balance loading in a static manner between the two HP cluster nodes.

14.10.3. LAN to Internet Traffic
The following use case describes how to configure the filtering of IP connections from LAN to the
Internet.
In this case, the source IP address is controlled by the network administrator, and must be translated,
but the destination IP address is not controlled.

Figure 14.5. LAN to Internet Use Case
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Table 14.6. LAN to Internet Use Case Solution
Objective

Solution

A computer in the LAN can establish connection
to a server in the Internet.

1. Define on the LAN computer a route to reach the
Internet.
• Destination is the Internet.
• Gateway is one of the cluster's virtual IP
addresses.
2. In Arkoon Manager, create an ACCEPT rule
from the LAN to the Internet.
• Create a new translation configuration with
source translation masquerading. The source
translation ensures that server packets will
be routed through the same node than client
packets.

14.10.4. Internet to DMZ Traffic
The following use case describes how to configure the filtering of IP connections from the Internet to
internal servers.
In this case, the source IP address is uncontrolled by the network administrator and the destination is
controlled. The destination can be translated.

Figure 14.6. Internet to DMZ Use Case

Table 14.7. Internet to DMZ Use Case Solution
Objective

Solution

A computer on the Internet
can establish connection to a
server in the DMZ.

In Arkoon Manager, create an ACCEPT rule from the Internet to the
server located in the DMZ with a service like HTTP.
• Define source translation masquerading. The source translation
ensures that server packets are routed through the same node as
client packets.
• Define destination translation (interface/port). The destination
translation allows load-balancing from Internet between both nodes
of the cluster (via a DNS mechanism or publishing different services
on different port or addresses.

Internet to DMZ Traffic
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14.11. High Performance (HP) Synchronization
Mechanisms
14.11.1. Connection Data Synchronization
Connection tables with applicative analysis data, including IDPS information, are synchronized between
the cluster nodes. Synchronization is performed using the unicast communication mode via TCP 1760
port. This is not configurable. All synchronization parameters can be customized in Arkoon Manager.
All the applicative analysis modules are supported by the synchronization mechanism. This mechanism
can be encrypted and/or authenticated. For security, the synchronization protocol can be protected using
a shared key that is set in Arkoon Manager.
Although protocol states are synchronized, nodes of a cluster do not operate in synchronous mode. In
other words, once a network session has been established through a node of the cluster, the whole
session must be routed through this node, unless the node fails.
It is possible to deactivate the replication of some connections configuring the appropriate option in
service parameters (TCP/UDP). This will allow to reduce the network load related to the replication and
then to optimise synchronization for critical flows.

14.11.2. Unsynchronized Data
The state of proxies are not synchronized between the nodes of a cluster. Each proxy on a node performs
independently. In case of failure of a node, no proxy state is recovered. If configured on one of the nodes,
the Certification Authority is not synchronized with the other node. It is then recommended to backup the
configuration map after each modification (adding or revocating a certification).

14.11.3. Mail Synchronization
There is no mail synchronization implemented between cluster nodes.
In Active/Passive mode, the Standby node sends its mail queue to the Working node so that mails are
not stuck and can be processed by the Working node.
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14.12. High Performance (HP) Failover Mechanisms
To know HP failover mechanisms, see Section 14.7, “High Availability (HA) Failover Mechanisms”.

14.13. Implicit Rules for Cluster Protocols
Implicit rules are automatically created to authorize state protocols, management protocols, and
synchronization protocols.
• Name of the rule, as it is shown in the IP logs of Arkoon Monitoring
• Source IP address
• Destination IP address
• Source port
• Destination port

Table 14.8. Filtering Rules for Connection Data Synchronization Protocol
Rule name

Source IP address Destination IP
address

Source port

Destination port

Sync Protocol
Unicast In

Real IP of another My real IP
FAST360 appliance declared in this
declared in the
interface
interface

ALL

UDP 1760

Sync Protocol
Unicast Out

Real IP declared in Real IP of another ALL
this interface
FAST360 appliance
declared in the
interface

UDP 1760

High Performance (HP) Failover Mechanisms
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Table 14.9. Filtering Rules for State Protocol (VRRP)
Rule name

Source IP address Destination IP
address

Source port

Destination port

VRRP In

All

224.0.0.18

Protocol IP 112

Protocol IP 112

VRRP Out

Local IP

224.0.0.18

Protocol IP 112

Protocol IP 112

Table 14.10. Filtering Rules for Management Data Synchronization Protocol
Rule name

Source IP address Destination IP
address

Source port

Destination port

Akha Input rule

Network
master
interface

ALL

TCP 1756

Akha Output rule

Local IP

Real IP address of ALL
the 'admin-syncaddress' interface.

TCP 1756

of

the Master node IP
node address

Table 14.11. Filtering Rules for Inter-Nodes Update Protocol
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Rule name

Source IP address Destination IP
address

Source port

Destination port

Arkupdate Input
rule

Network
master
interface

the Master node IP
node address

ALL

TCP 1752

Arkupdate Output
rule

Local IP

All adddresses.

ALL

TCP 1752
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Table 14.12. Filtering Rules for Logs Exchange Protocol
Rule name

Source IP address Destination IP
address

Akserver Input rule Network
master
interface
Akserver Output
rule

of

Source port

Destination port

ALL

TCP 1759

Real IP address of ALL
the 'admin-syncaddress' interface

TCP 1759

the Master node IP
node address

Local IP

14.14. Terminology
Administration data synchronization
protocol

This protocol deploys administration and monitoring data used
to configure and monitor the nodes composing the cluster.
Monitoring data includes information about the cluster states and
all security logs generated by the nodes composing the cluster.
The protocol is encapsulated in an SSL connection on TCP port
1756. The master node of the cluster listens to connections from
the second node.

Connection data synchronization
protocol

This protocol allows the two cluster nodes to share connection
states via the master node interface, including the applicative
state when available. This protocol uses UDP port 1760. These
states are used to recover connections if a node happens to fail.

Cluster

A cluster of FAST360 appliances is a collection of two FAST360
nodes, interconnected by the network, and managed by a
dedicated Arkoon daemon.

Failover

Process from one node going from the working state to the
standby or disconnected state and the other node taking over the
first node's services.

High Availability (HA)

One appliance is in active mode and the other is in passive mode,
on standby to take over in case of failure of the active node.

High Performance (HP)

Both appliances are active at the same time, working in active/
active mode. If one of the active FAST360 appliances fails, the
other takes over to handle all of the network traffic.

IP real address

IP address allocated to a specific cluster node.

IP virtual address

IP address used by the cluster to interoperate with other network
equipment and services.

Master node

The cluster master node is the cluster node that must be used
when connecting to the cluster with Arkoon Manager. This node is
responsible for relaying management requests to the other node
as well as replication for configuration files.

Node

A FAST360 appliance in a cluster.

Node state protocol

This protocol manages the state of the cluster nodes (starting,
active, passive, failing over). It is also responsible for switching

Terminology
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services from one (potentially failing) FAST360 appliance to
another (correctly functioning) one based on an administrator's
request or a node state threshold. This protocol relies on the
underlying VRRP protocol.
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VRRP

Virtual Router Redundancy Protocol. Routing protocol defined by
RFC 3768 policy and created to increase the availability of routing
gateways.

VRID

Virtual Router IDentifier. Sets for each virtual interface on a
network.
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Chapter 15. High Availability for XPA appliances
The High Availability feature of a network architecture is intended to minimize the downtime of the
services it offers. These downtimes can have various internal or external causes: physical incident
(fire, flood, etc.), hardware failure, network service failure, software failure, etc.

15.1. Introduction
The implementation of a high availability architecture requires a thorough control of the following:
• Any elements of the architecture that are subject to failure.
• The failure detection mode.
• Appropriate countermeasures for each failure.
These measures must be characterized by rapid activation and a minimal loss of service or state of
service.
The FAST360 appliance's high availability solution is based on two appliances considered as a single
FAST360 appliance. Connected in parallel architectures, the appliances guarantee a minimal downtime
for the firewall (several tens of seconds) in case of total hardware failure, failure of one of the interfaces,
failure of a network element related to one of the appliances (hub, router, switch, etc.) or software failure
of the HTTP proxy.
Only one of the two appliances is active at all times. The passive appliance is responsible for detecting
active appliance failures. If required, it swaps and becomes active, replacing the failing appliance.
Moreover, the option of keeping the FAST360 appliance's active HA connections minimizes the loss of
the current connections states and ensures an increased high availability in optimal security conditions.
The high availability solution documented in this chapter is only applicable for A10 to A2100 appliances
running FAST360 versions 4 and 5.

15.2. Basic HA Architecture
The HA FAST360 appliance is made up of two appliances which support each other. One appliance is
active and the other is passive. Only the active appliance filters the connections. The passive appliance
maintains a readiness to take over if the active appliance fails. The passive appliance implements only
the minimum requirements:
• Anti-spoofing default rules
• Administration default rules
• Various default rules specific to the passive HA
• Default blocking rules

Introduction

| 297

Chapter 15. High Availability for XPA appliances

15.3. Special Cases
The HA FAST360 appliance does not support ISDN router functionality.
It can be an ADSL router but does not manage multi-ADSL.

15.4. Mechanisms
15.4.1. Heartbeat
The hearbeat designates the communication between the two HA appliances. The heartbeat link is
redundant in order to secure the communication. It can be established:
• On a serial link and one or several Ethernet links.
• Or on several Ethernet links.

Note
The use of heartbeat links on Ethernet makes it possible to exceed the distance limitations
inherent to a serial connection.

Caution
Communication on the Ethernet heartbeat links is of broadcast type. Therefore, the link between
the two appliances must not be routed. Ideally, it will be direct by cross-over cable to avoid
service denial attacks, for instance.
On the heartbeat links, the FAST360 appliances transmit between themselves:
• Ongoing communication to control the activity of the other appliance.
• The configuration.
• The logs.
• The updates.
• The queued mails on the appliance that became passive, after a swap-over.
• The active connections (if the option is activated).
If you use more than one Ethernet link for the hearbeat, you will have to define in the HA configuration:
• The Ethernet link on which the logs, the configuration, the updates and the queued mails are
transmitted.
• The Ethernet link on which the active connections are transmitted, when the conservation of active
connections is configured.
The communication controlling the machines' activity is authenticated with a password that you are
asked during the definition of the HA. The active connections are exchanged via a protocol conceived
and developed by Arkoon. The other transmitted information is exchanged through an SSL connection.

Note
If the FAST360 appliance has enough available Ethernet ports, two Ethernet links should be used
for the heartbeat. One transmits the active connections, and the other the remaining information.
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15.4.2. Real Addresses and Virtual Addresses
The interfaces of each appliance of the HA FAST360 appliance must be configured with an address
specific to the appliance. These addresses are called real addresses and are permanently active,
regardless of whether the appliance is active or passive. The real addresses are entered using the HA
configuration menus, in minarkconf .
The functional addresses, also called virtual addresses, are entered using the configuration file, common
to both machines, with Arkoon Manager .

Note
The real and virtual addresses related to an interface can belong to different addressing plans.
In the case of an interface with public addressing, this allows to spare the public addresses:
virtual addresses are public whereas real addresses can be private.
The diagram below illustrates an example of real and virtual address selection. The virtual address of an
interface is related to the appliance that is active at a given moment.

Figure 15.1. Real Addresses and Virtual Addresses

15.4.3. Conservation of the Active Connections
The FAST360 appliances transmit the active connection table between themselves so that a service
recovery looks almost transparent to the users.
During the service recovery, the filtering parameters are weakened:
• The FAST360 appliance tolerates a broadened TCP window.
• The state of the inter-application level FAST connection is not retrieved.
Therefore, the functionalities of some protocols that are based on the FAST analysis are no longer
available on the recovered connections. In the case of the H323 protocol, the existing secondary
connections are recovered (i.e. the current transfers carry on normally) but the user will have to
reconnect to open new secondary connections.
The local connections to the active FAST360 appliance cannot be recovered by the passive FAST360
appliance.

Real Addresses and Virtual Addresses
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These connections are specific to:
• Administration of the FAST360 appliance
• HTTP, FTP, SMTP and POP3 proxies
• IPsec connections
The state of the connections can be viewed in the Active connections window of Arkoon Monitoring .
The column HA Status indicates the status of the connection:
• private: a local connection excluded from the replication process.
• active: this connection was created by the active machine with which you are connected and its status
is transmitted to the passive machine.
• passive: a connection transferred from the active machine.
• taken over: this connection was taken over after a swap.

15.4.4. FTP Connection Taken Over
Only the FTP protocol allows synchronization of FAST parameters. Therefore, in order to keep primary and
secondary connections in a correct state when a failover occurs, the active connection's synchronization
replicates FAST FTP states. But some particular FTP states do not allow correct failover. The following
diagram describes this issue:
<établissement connexion>
Server.
USER foo
for test.
PASS foobar
logged in.
PORT 10,10,192,38,128,44
successful.
RETR foo.cpt

-- 1 --

220 ProFTPD 1.2.5rc1

-- 2 --- 3 --

331 Password required

-- 4 --- 5 --

230 User foo

-- 6 --- 7 --

200 PORT command

-- 8 --- 9 --

150 Opening BINARY mode data
connection for foo.cpt (32112640 bytes).
-- 10 -226 Transfer
complete.
-- 11 -PASV
-- 12 -227 Entering
Passive Mode
(10,10,192,136,128,9).
-- 13 -RETR foo.cpt
-- 14 -150 Opening BINARY mode data
connection for foo.cpt (32112640 bytes).
-- 15 -226 Transfer
complete.
-- 16 -QUIT
-- 17 -221
Goodbye.
-- 18 --
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Full FTP connection recovery when a failover occurs is possible in all the states above except from 7, 8,
13 (FAST FTP applicative violation).

15.4.5. Status of the Passive Machine
The activity of the passive machine is reduced to the minimum: no filtering rule or Internet access are
activated; the only working rules are IN (administration, antispoofing, broadcasts) and OUT (specific to
HA – HA communication, NTP synchronization).

15.4.6. Swapping Criteria
An HA swapping is triggered when:
• There is no activity on the heartbeat links.
• The global state of the passive machine is more satisfactory than the global state of the active machine,
in the case where the use of the system monitoring is activated on the HA.
The global state of a machine can include several system monitoring criteria that are defined in the
FAST360 appliance's configuration, via the System monitoring folder of Arkoon Manager . System
monitoring can apply to the state of the interfaces, the Internet access and the HTTP proxy.
The HA configuration menus allow you to define the following parameters for the system monitoring:
• Enable system monitoring triggered failover:
This option allows swapping based on the system monitoring of each HA machine to be activated
• Interval between two systems status update:
Interval (in seconds) between two comparisons of the HA machines' assessments; the default value
is 10 seconds.
• System monitoring threshold:
This value defines the variance between the assessments of the machines that will trigger a swapping.
The default value is 1: if the passive machine's assessment is greater than one unit compared to the
other machine's assessment, it will become active.
• Delay before failing over after the threshold is reached:
Delay (in seconds), between the detection of an assessment variance greater than the swapping
threshold and triggering of swapping. The default value is 30 seconds.

Caution
This value must not be too low, otherwise swapping will be triggered falsely.
On the passive machine, the Internet access and the HTTP proxy are not activated: only the state
of the interfaces can be monitored; the Internet access and the HTTP proxy are supposed to be
functional. If the state of the active machine's Internet access or HTTP proxy becomes faulty,
swapping is triggered, depending on the configuration of the system monitoring.
However, if the machine that turned active also becomes faulty (due to a problem on the access
provider's side), no swapping will happen for 20 minutes. Nevertheless, a high-level alert will
be generated, which will inform the administrator that the problem is probably not related to the
FAST360 appliance.

Status of the Passive Machine
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15.4.7. High Availability and Certification Authority (CA)
For the HA FAST360 appliance to be able to establish VPNs, the two HA machines must have the same
Arkoon certificate.
• When the HA FAST360 appliance is CA, it is possible to configure the CA on the HA master. The FAST360
certificate will be exported from the master in order to import it later on the HA slave.
• If the HA FAST360 appliance is non-CA, a certificate must be generated by a CA with FIREWALLS rights,
in the PKCS#12 format. It is imported on the HA master and the HA slave at the same time.

15.5. Recommendations
Before starting configuration, it is better to draw an accurate schema of the topology to be implemented,
specifying all the IP addresses, whether they are real or virtual.

Caution
Do not confuse a master/slave architecture in multi-FAST360 appliances and an HA FAST360
appliance where there is a master appliance and a slave appliance. In minarkconf , both menus
specific to these configurations are side by side but well differentiated:
- Master/Slave (Config)
- Master/Slave (HA)
• If the master HA FAST360 appliance was first defined as CA, the slave HA FAST360 appliance uses the
same Arkoon certificate.
• If the heartbeat is defined on two Ethernet links, one for transmitting the active connections, the other
for transmitting configuration, logs, updates and mails that are pending during a swap.

Caution
There is a risk of saturating the HA link if there are too many logs. In HA mode, both equipments
regularly exchange their logs to alleviate this risk.

15.6. Configuration of the HA Master
15.6.1. Initialization of the FAST360 Appliance
Initialization of the FAST360 appliance is launched at the GRUB.
Initialization of the HA master is completely standard.

Note
The initial configuration file must contain the virtual addresses of the interfaces, and not the real
addresses.
The HA functionality can be set up on the A51 material in higher versions.
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15.6.2. Configuration of HA Functionality
1.

Launch minarkconf and select the Configuration menu then Master / Slave (HA). Check Master.
┌───────────── Configuration ─────────────┐
│
│
│ ┌─────────────────────────────────────┐ │
│ │ a Hostname
│ │
│ │ b Keyboard
│ │
│ │ c Date & Time
│ │
│ │ d Admin from...
│ │
│ │ e Primary/Secondary
│ │
│ │ f Master/Slave (Config)
│ │
│ │ g Master/Slave (HA)
│ │
│ │ h Load a configuration file
│ │
│ │ i Terminal on serial port
│ │
│ │ j Create initial configuration file │ │
│ │ k Back
│ │
│ └─────────────────────────────────────┘ │
│
│
├─────────────────────────────────────────┤
│
<OK> <Cancel>
│
└─────────────────────────────────────────┘
┌─────── Master/Slave (HA) ───────┐
│ ┌─────────────────────────────┐ │
│ │
(X) 1 Master
│ │
│ │
( ) 2 Slave
│ │
│ │
( ) 3 None
│ │
│ └─────────────(+)─────────────┘ │
├─────────────────────────────────┤
│
<OK> <Cancel>
│
└─────────────────────────────────┘

2.

Check the serial interface to activate the heartbeat on it. In this case (heartbeat on two Ethernet
interfaces), you must select no_serial.
┌──── Heartbeat serial device ────┐
│ serial port
│
│ ┌─────────────────────────────┐ │
│ │ ( ) tts/0
tts/0
│ │
│ │ (X) no_serial <none>
│ │
│ │
│ │
│ └─────────────(+)─────────────┘ │
├─────────────────────────────────┤
│
<OK> <Cancel>
│
└─────────────────────────────────┘

3.

Specify the Ethernet interfaces that will be used for the heartbeat.
┌──── Heartbeat UDP interface ────┐
│ Ethernet
│
│ ┌─────────────────────────────┐ │
│ │
[X] eth0 eth0
│ │
│ │
[X] eth1 eth1
│ │
│ │
[ ] eth2 eth2
│ │
│ │
[ ] eth3 eth3
│ │
│ │
[ ] eth4 eth4
│ │
│ │
│ │
│ └─────────────(+)─────────────┘ │
├─────────────────────────────────┤
│
<OK> <Cancel>
│
└─────────────────────────────────┘

4.

Specify the real addresses of the heartbeat interfaces of the slave appliance.
┌──────── Interfaces ────────┐
│ HA Peer Heartbeat Address │
│ ┌────────────────────────┐ │
│ │ eth0 10.0.1.2
│ │
│ │ eth1 10.0.2.2
│ │
│ │ x
Back
│ │
│ └────────────────────────┘ │
├────────────────────────────┤
│
<OK> <Cancel>
│
└────────────────────────────┘
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A password is requested to protect the heartbeat. Of course, this password must be identical on the
two machines. It allows them to identify one another on the heartbeat link.
┌ New Heartbeat authentication passphrase ┐
│ ┌──────────────────────────────────────┐ │
│ │**********
│ │
│ └──────────────────────────────────────┘ │
│
│
├──────────────────────────────────────────┤
│
<OK> <Cancel>
│
└──────────────────────────────────────────┘
┌ New Heartbeat authentication passphrase (Check) ┐
│ ┌──────────────────────────────────────────────┐ │
│ │**********
│ │
│ └──────────────────────────────────────────────┘ │
│
│
├──────────────────────────────────────────────────┤
│
<OK> <Cancel>
│
└──────────────────────────────────────────────────┘

5.

Then, specify the name of the HA slave to the master.
┌ Heartbeat Slave node name ┐
│ as returned by 'uname -n' │
│ ┌────────────────────────┐ │
│ │ha2.arkoon.test
│ │
│ └────────────────────────┘ │
├────────────────────────────┤
│
<OK> <Cancel>
│
└────────────────────────────┘

6.

Enter the real addresses of the interfaces. Do not forget to configure the heartbeat interface.
┌──────── Interfaces ────────┐
│ HA real addresses
│
│ ┌────────────────────────┐ │
│ │ eth0 10.0.1.1/24
│ │
│ │ eth1 10.0.2.1/24
│ │
│ │ eth2 192.168.1.254/24 │ │
│ │ eth3 <none>
│ │
│ │ eth4 <none>
│ │
│ │ x
Back
│ │
│ └────────────────────────┘ │
├────────────────────────────┤
│
<OK> <Cancel>
│
└────────────────────────────┘

7.

Specify the Ethernet interface where the pending configuration, logs, updates and mails should be
transmitted.
┌ Configuration and logs communication device ┐
│ Ethernet
│
│ ┌─────────────────────────────────────────┐ │
│ │
[X] eth0 eth0
│ │
│ │
[ ] eth1 eth1
│ │
│ │
│ │
│ └───────────────────(+)───────────────────┘ │
├─────────────────────────────────────────────┤
│
<OK> <Cancel>
│
└─────────────────────────────────────────────┘

NTP time synchronization is then proposed to allow a better readability of the two machines' logs.
Select OK to validate.
┌──────── NTP synchronization ─────────┐
│ ┌──────────────────────────────────┐ │
│ │ [X] X Enable NTP synchronization │ │
│ └──────────────────────────────────┘ │
├──────────────────────────────────────┤
│
<OK> <Cancel>
│
└──────────────────────────────────────┘

8.
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┌──────── HA Connections replication ─────────┐
│ ┌─────────────────────────────────────────┐ │
│ │ [X] X Enable HA Connections replication │ │
│ └─────────────────────────────────────────┘ │
├─────────────────────────────────────────────┤
│
<OK> <Cancel>
│
└─────────────────────────────────────────────┘

9.

If you do, you must then specify the heartbeat interface on which the information related to the
active connections will be transmitted.
┌─ Connection Replication Interface ─┐
│ Ethernet
│
│ ┌────────────────────────────────┐ │
│ │
[ ] eth0 eth0
│ │
│ │
[X] eth1 eth1
│ │
│ │
│ │
│ └──────────────(+)───────────────┘ │
├────────────────────────────────────┤
│
<OK> <Cancel>
│
└────────────────────────────────────┘

10. You can activate swapping related to system monitoring of the two HA machines.
┌──────── System monitoring triggered failover ─────────┐
│ ┌───────────────────────────────────────────────────┐ │
│ │ [X] X Enable System monitoring triggered failover │ │
│ └───────────────────────────────────────────────────┘ │
├───────────────────────────────────────────────────────┤
│
<OK> <Cancel>
│
└───────────────────────────────────────────────────────┘

11. Define the time interval (in seconds) separating two comparisons of the machines' state.
┌─ Interval between two system monitoring status updates ─┐
│ ┌─────────────────────────────────────────────────────┐ │
│ │10
│ │
│ └─────────────────────────────────────────────────────┘ │
├─────────────────────────────────────────────────────────┤
│
<OK> <Cancel>
│
└─────────────────────────────────────────────────────────┘

12. You must also define the delay threshold of the machines' state that will trigger a swapping.
┌─ System monitoring threshold ─┐
│ ┌───────────────────────────┐ │
│ │1
│ │
│ └───────────────────────────┘ │
├───────────────────────────────┤
│
<OK> <Cancel>
│
└───────────────────────────────┘

Note
This value must not be set to “0”.
13. Enter the delay (in seconds) that separates the moment when the threshold is reached and when
the swapping is triggered.
┌─ Delay before failing over the threshold is reached ─┐
│ ┌──────────────────────────────────────────────────┐ │
│ │30
│ │
│ └──────────────────────────────────────────────────┘ │
├──────────────────────────────────────────────────────┤
│
<OK> <Cancel>
│
└──────────────────────────────────────────────────────┘

14. The HA master's certificate must be exported so that it can be imported subsequently on the HA
slave. A password is asked to protect the .p12 file.
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┌─ Export Arkoon certificate file ─┐
│Start filename with a: to
│
│save it to floppy
│
│ ┌──────────────────────────────┐ │
│ │a:cert.p12
│ │
│ └──────────────────────────────┘ │
├──────────────────────────────────┤
│
<OK> <Cancel>
│
└──────────────────────────────────┘
┌──────── Password ─────────┐
│Password that will be
│
│used to protect PKS#12
│
│file
│
│ ┌───────────────────────┐ │
│ │
│ │
│ └───────────────────────┘ │
├───────────────────────────┤
│
<OK> <Cancel>
│
└───────────────────────────┘

Finally, a summary appears before you make the configuration effective.
┌────────────────────────── HA Information ──────────────────────────┐
│ The HA configuration below is ready to be saved to your ARKOON:
│
│
│
│ HA type:
Master
│
│ HA heartbeat serial device:
│
│ HA heartbeat UDP interface:
eth0 eth1
│
│ HA Peer heartbeat eth0 UDP address: 10.0.1.2
│
│ HA Peer heartbeat eth1 UDP address: 10.0.2.2
│
│ HA heartbeat Pass Phrase:
**********
│
│ HA Master Node Name:
ha1.arkoon.test
│
│ HA Master Node IP address:
10.0.1.1
│
│ HA Slave Node Name:
ha2.arkoon.test
│
│ HA Slave Node IP address:
10.0.1.2
│
│ HA NTP synchronization:
yes
│
│ HA Connections replication:
yes
│
│ HA Connections replication device:
eth1
│
├────────────────────────────────────────────────────────────── 63�──┤
│
<EXIT>
│
└────────────────────────────────────────────────────────────────────┘

15. Press Exit to see the installation of the configuration on screen then the required services are
started.
If you wish to modify one of the HA configuration's elements, go back to the Master / Slave (HA)
menu and modify the element of your choice.

15.6.3. Example Configuration Using Bonding Interfaces
To configure a bonding interface, first select the bonding interface you want to configure. Then, select
the physical interfaces that you want to aggregate with this virtual interface. Finally, assign an IP address
to the bonding interface.
Use the HA configuration screens to create bonding interfaces.
Launch minarkconf and select the Configuration menu then Master / Slave (HA) then Bonding.
Choose the bonding interface you want to configure:
┌───── Bonding interfaces ─────┐
│ ┌──────────────────────────┐ │
│ │
bnd0 <none> -│ │
│ │
bnd1 <none> -│ │
│ │
bnd2 <none> -│ │
│ │
bnd3 <none> -│ │
│ │
x
Back
│ │
│ └──────────────────────────┘ │
├──────────────────────────────┤
│
<OK> <Cancel>
│
└──────────────────────────────┘
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Select the Ethernet interfaces you want to aggregate :
┌──── Ethernet interface selection ────┐
│ bnd0
│
│ ┌──────────────────────────────────┐ │
│ │
[0] eth0 eth0
│ │
│ │
[0] eth1 eth1
│ │
│ │
[0] eth2 eth2
│ │
│ │
│ │
│ └──────────────────────────────────┘ │
├──────────────────────────────────────┤
│
<OK> <Cancel>
│
└──────────────────────────────────────┘

The following window appears, this means that you have created bonding interface bnd0, aggregating
the Ethernet interfaces, eth0 and eth1.
┌───────── Bonding interfaces ─────────┐
│ ┌──────────────────────────────────┐ │
│ │
bnd0 eth0 eth1 -- 0.0.0.0/0 │ │
│ │
bnd1 <none> -│ │
│ │
bnd2 <none> -│ │
│ │
bnd3 <none> -│ │
│ │
x
Back
│ │
│ └──────────────────────────────────┘ │
├──────────────────────────────────────┤
│
<OK> <Cancel>
│
└──────────────────────────────────────┘

By default, the IP address of the bonding interface is set to 0.0.0.0/0. You need to configure the real value
in the Real IP Addresses area of the HA menu.
Repeat the above steps for any other bonding interfaces you want to configure.
To delete a bonding interface, select it, then deselect the aggregated interfaces.
The remaining steps to configure HA are similar to those carried out for a standard configuration (without
bonding) however the Real IP Addresses window also displays the bonding interfaces.

15.6.4. Example Configuration Using a Virtual LAN (VLAN)
For a VLAN configuration, you need to create the VLAN interfaces and assign Real IP Addresses – unless
the VLAN interfaces are bridged.
Use the HA configuration windows to configure VLANs.
┌──── Interface VLAN ────┐
│ Action
│
│ ┌────────────────────┐ │
│ │ a Add Vlan
│ │
│ │ b Remove Vlan
│ │
│ │ c List Vlan
│ │
│ │ x Back
│ │
│ └────────────────────┘ │
├────────────────────────┤
│
<OK> <Cancel>
│
└────────────────────────┘

Choose the Ethernet or Bonding interface to configure, then assign a VLAN identifier:
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┌─────── Add Vlan ───────┐
│ On Interfaces
│
│ ┌────────────────────┐ │
│ │
eth0 eth0
│ │
│ │
eth1 eth1
│ │
│ │
eth2 eth2
│ │
│ │
eth3 eth3
│ │
│ │
eth4 eth4
│ │
│ │
x Back
│ │
│ └────────────────────┘ │
├────────────────────────┤
│
<OK> <Cancel>
│
└────────────────────────┘
┌───── Add Vlan eth3 ────┐
│ Vlan Id
│
│ ┌────────────────────┐ │
│ │ 2
│ │
│ └────────────────────┘ │
├────────────────────────┤
│
<OK> <Cancel>
│
└────────────────────────┘

A list of the configured VLAN interfaces is displayed. Repeat the above steps for each VLAN.
┌────────────────────────── List of Vlan ──────────────────────────┐
│
│
│
Interface
Address
│
│
----------- --------│
│
│
│
eth3.2
<none>
│
│
eth3.3
<none>
│
│
eth3.4
<none>
│
│
---------------------│
│
│
├─────────────────────────────────────────────────────────── 100�──┤
│
<EXIT>
│
└──────────────────────────────────────────────────────────────────┘

You can use the same menus to delete a VLAN interface (Remove VLAN) or list the available VLAN
interfaces (List VLAN).
┌──── Interface VLAN ────┐
│ Action
│
│ ┌────────────────────┐ │
│ │ a Add Vlan
│ │
│ │ b Remove Vlan
│ │
│ │ c List Vlan
│ │
│ │ x Back
│ │
│ └────────────────────┘ │
├────────────────────────┤
│
<OK> <Cancel>
│
└────────────────────────┘

The remaining steps are similar to those carried out for a standard configuration (without VLAN) however
the Real IP Addresses window also displays the VLAN interfaces.

15.7. Configuration of the HA Slave
15.7.1. Initialization of the FAST360 Appliance
Initilization of the FAST360 appliance is launched at the GRUB boot with the arkoon init command. This
procedure is described in the First-Time Installation Guide.
Initialization of the HA slave is standard. Note the following:
• If the slave is non-CA you will have to import the master Arkoon's certificate that was exported
previously; this step is essential to ensure that the certificates generated on the HA master are also
valid on the slave.
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• The HA functionality can be set up on the A51 material an higher versions.
• The initial configuration file must be empty. As soon as you configure the FAST360 HA slave (license
and HA parameters) create a new empty configuration (go to Configuration > Create an initial
configuration file, do not set any parameters but select Save and then launch the configuration. The
real configuration will be sent by the FAST360 HA master through the heartbeat.

15.7.2. Configuration of HA Functionality
Launch minarkconf and select the Configuration menu then Master / Slave ( HA ).
The configuration is similar to the one executed previously on the master, except that exporting the
certificate is not proposed.

15.8. Configuration and Maintenance of a HA Solution
15.8.1. Managing the HA FAST360 Appliance
You must connect to the active machine to administer the FAST360 appliance. To do so, you will use the
virtual address of an administration interface. When you install a configuration, it is also installed on the
passive machine.
However, you may want to connect to the passive machine in order to control the passive machine's
state (other than the logs), to generate certificates on the master, etc. To do so, you must connect to the
machine's real address.

Note
It is not possible to connect to a passive machine using the Internet. When a HA machine is
passive, it does not use its Internet access.
There are two solutions:
• Connect using the active machine (adding the corresponding rules)
• Add a static route to the administration network allowing correct routing of the packets without
using the Internet.

15.8.2. Using SNMP in HA Configurations
In High Availability configurations, the SNMP agent does not support the use of the virtual IP address
of a listening interface. SNMP network management platforms must use the real IP address to monitor
devices in HA configurations. This enables non-ambiguous monitoring of both devices, active and
passive, making up the configuration. For more information on the SNMP agent see Section 18.7, “SNMP
Agent”.

15.8.3. Configuration of the HA FAST360 Appliance
The configuration of an HA FAST360 appliance is similar to the that of a non-HA Arkoon. However, note
the following:
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• If you want to configure a new interface, it is not enough to configure it in Arkoon Manager : you must
specify the real addresses of the interfaces, an operation that can be executed only via the Master/
Slave ( HA ) menu of minarkconf .
• It is forbidden to set a virtual address for a heartbeat interfaces.
• It is forbidden to disconnect a heartbeat interface from Arkoon Manager , if you do so, the interface
will be set down and the associated functionality will be stopped.
• Certificate management must be done on the appliance defined as CA.

15.8.4. Certificate Management
Only the master HA FAST360 appliance is CA: certificate management is done exclusively on this machine.
However, the certificates generated on the master (administration certificate, certificate for a nomad
VPN, etc.) are valid on the HA slave.

Note
The CRL (Certificate Revocation List) is not automatically transmitted from the HA master to the
HA slave.

15.8.5. Master/Slave Architecture
If the HA solution is embedded in a centralized administration architecture (master/slaves), the master
and the slave must have the same settings in the Master/Slave ( Config ) menu of the minarkconf menu.

15.8.6. System Update
To minimize service interruption, update the passive machine before the active machine. Follow these
steps, respecting the order indicated:
1. Connect the passive machine via Arkoon Monitoring .
2. Select Check to verify that the patch or version are valid.
3. Click the Apply button to launch the upgrade; the passive machine reboots.
4. Check that the update was applied correctly on the passive machine.
5. Connect to the active machine via Arkoon Monitoring and launch the update; the active machine
reboots and the passive machine enters the active mode.

15.8.7. Maintenance
The status of the HA FAST360 appliance is visible in the High Availability window of Arkoon Monitoring .
This window provides the following information:
• Name of the FAST360 appliance to which you are connected.
• Name of the active FAST360 appliance.
• Name of the passive FAST360 appliance.
• Date of the last swapping.
• State of the serial link used for the heartbeat.
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• State of the Ethernet link(s) used for the heartbeat.
You can also trigger a swapping from this window by clicking the Swapping button.

15.9. HA and Dynamic Routing
For HA FAST360 appliances, there are certain requirements in the configuration of dynamic routing for
the different dynamic routing protocols:
• RIP
This protocol is not supported for FAST360 HA.
• OSPF
OSPF runs on both nodes of the HA pair (in order to avoid latency issues during HA switchovers).
Maximum OSPF costs are automatically assigned to routes via the passive node to prevent the network
from selecting these routes. This cost is readjusted appropriately during a switchover. You can set the
cost of using the passive node by editing the file /etc/arkoon-config.local. In an OSPF environment
with a FAST360 HA solution, it is mandatory to specify explicitly an OSPF "router-id".
• BGP
Since this is a peer-to-peer protocol, BGP only runs on the active node.
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16.1. User Authentication
This functionality is used to filter the output flows per user. It requires an authentication agent (AKauth)
to be installed on the user workstations.

16.1.1. Principle
FAST360 appliances support two modes to authenticate a user:
• Low authentication with login/password
Login/password authentication is based on:
• Users locally defined on the FAST360 appliance
• Users defined on an authentication server, such as LDAP, Windows NT or Radius. Detailed
information on how to configure these different types of authentication server can be found in
Section 16.2, “LDAP”, Section 16.3, “Windows”, and Section 16.4, “Radius”.
After configuring the server, it is necessary to import users from the authentication server in the
configuration. Refer to Section 16.5, “Importing users or groups of users from an authentication
server” to know how to import users.
• Authentication with X.509 certificate.
Authentication with a certificate requires interaction with a Certification Authority, and can be split
into two sub-modes according to the type of key storage used:
• Storage on hard disk: the keys are stored in a PKCS#12 file located on the hard disk of
the workstation. This file, protected by a password, contains the private key of the user, the
corresponding certificate signed by the Certification Authority of the FAST360 appliance and the
autosigned certificate of the Certification Authority of the FAST360 appliance.
• Storage on a strong authentication solution: the keys are stored on a USB token or on a chip card
with PKCS#11 interface. The autosigned certificate of the Certification Authority of the FAST360
appliance is stored on the workstation, outside the token or the card.
This section describes:
• The implication of users authentication in the filtering
• The mechanisms implied to ensure security
• The configuration of the different authentication modes

Warning
In case of approbation relationships between different Windows domains, (dom1.local and
dom2.lab, for example), the authentication via NT or LDAP is not possible.
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Note
If there are several controllers on the same domain, you must declare all the controllers in Arkoon
Manager configuration: you must all create and place them into the Auhentication servers zone
in the Authentication menu of the Security tab on an appliance.

16.1.2. Authentication of Users and Filtering
The authentication service of the users on the output flows is activated on the FAST360 appliance from
the moment that a user is specified in the definition of a filtering rule.
Two cases can occur when a flow, requiring authentication, is initiated through the FAST360 appliance:
1. Non-existing authentication: the couple (IP address and MAC address sources of the flow) is not yet
associated with an authenticated user, or the authentication failed.
2. Authentication in validity: an association (IP address and MAC address flow sources)/authenticated
user is still valid.
The mechanisms implemented in both cases are presented below.

Filtering Rules and Connections Filtering
The filtering rules permit to set the filtering of new active connections and to define the characteristics
of their later management.
The connections filtering mechanisms are described in detail in this guide. However, it is necessary to
know both following aspects:
• If the FAST360 appliance receives a packet which is a first connection packet, it will read the
filtering rules. Otherwise, it will try to associate this packet with a connection which is present in the
connections table.
• The process of ICMP packets is particular: the error messages are automatically processed by the
FAST360 appliance without going through the filtering rules, while the information messages are
processed through the filtering rules.
Particular case of the Arkoon objects: in order to make a FAST360 appliance apply for itself a filtering
rule, you must specifically select the Arkoon object. The FAST360 appliance does not apply itself rules
containing networks to which it belongs.

Non-existing Authentication
If the FAST360 appliance has not yet associated the couple (IP address and MAC address sources of the
flow) with an authenticated user, the mechanism is the following:
1. The FAST360 appliance suspends the filtering decision and initiates an authentication request toward
the source IP address of the flow;
2. The authentication agent (AKauth) must be operational to receive the request: the user must be
authenticated;
3. If the authentication is successful, the FAST360 appliance saves the source IP address, the MAC
address, the user name as well as its possible membership groups in the authentication table; the
FAST360 appliance resumes the filtering decisions of the pending flow for this IP address.
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Authentication in Validity
An entry of the authentication table associates the couple (IP address and MAC address sources of the
flow) with an authenticated user. On the FAST360 appliance, these entries have a timeout set to 5 minutes.
When filtering a new flow, the FAST360 appliance uses the identity and the groups of membership of the
associated user to meet the decision of filtering, if there is an authentication in validity for the couple (IP
address and MAC address sources of the flow).

Authentication Management
When the timeout value of the authentication table entry is reached, the FAST360 appliance ends an
authentication request to the client, in order to protect against an usurpation of rights by another user. To
limit the latent period, this request is sent as soon as a new authenticated connection is received, during
the 40 seconds preceding the timeout of the entry in the table.
When the client receives an authentication request, it automatically sends the parameters previously
entered by the user, if the last authentication (explicit or transparent) has been realized within the
preceding 30 minutes. This authentication is thus transparent for a legitimate user.
Thus, during the filtering of a new flow requiring an authentication, the authentication requests are
realized as follows:
Age (A) of association
(IP,MAC)/authentication
on
the
FAST360
appliance

Age of last explicit Action on
transparent
appliance
authentication
on
client

the

FAST360 Action on the client

No association

< 30 mn

Authentication
Decision
of
suspended

request; Transparent
filtering authentication

No association

> 30 mn

Authentication
Decision
of
suspended

request; Explicit authentication
filtering

(A) < 4 mn 20 s

—

No authentication request; —
Decision
of
filtering
immediate

4 min 20 s < (A) < 5 mn

—

Authentication
Decision
of
immediate

request; Transparent
filtering authentication

The graphic below illustrates these mechanisms:
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Figure 16.1. Authentications Flows

16.1.3. Security of the Client / FAST360 Appliance Communication
Authentication of the Communication Flows
Each party (the FAST360 appliance and the client) has mechanisms allowing authentication of remote
entities.

Authentication of the FAST360 Appliance by the Client
To be sure that the authentication agent (AKauth) communicates with the FAST360 appliance and not with
another machine, the authentication agent has, in its configuration, the certificate of the Certification
Authority (CA), which delivered a certificate to the FAST360 appliance. It checks that the CA transmitted
the certificate of the remote machine.
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Authentication of the Client by the FAST360 Appliance
Authentication by Login/Password
The user enters a login/password couple, which is transmitted encrypted to the FAST360 appliance via
the SSL connection. The client does not submit a certificate to the FAST360 appliance of which the SSL
authentication mechanisms cannot be used for the client.

Note
To ensure a reliable authentication, the login/password couple must strictly remain individual for
each user. The user must take the necessary measures to ensure that this password is secret
and must not be possible to guess or reproduce.
Authentication by Certificate

Note
The client must use a certificate transmitted by the CA of the FAST360 appliance with USER rights.
In this case, the SSL v3 authentication mechanisms are used to authenticate the user using its certificate.

Note
The file under PKCS#12 format (Private Information Exchange Standard), which is given
to FAST360 administrators and users, contains private information that is generated during
certificate creation. Some of this information, like the private key used for the authentication
and the negotiation of the SSL secured connections, is strictly confidential. The disclosure of
such information to a third party shall require the revocation of the certificate. The password
protecting the PKCS#12 file must be highly resistant and meet the password generation
requirements of minarkconf (see the First-Time Configuration guide for more details).

Communication of the Authentication Flows
The authentication requests are sent by the FAST360 appliance to the authentication agent (AKauth) on
the UDP/9271 port. When the agent receives such a request, it displays a window on the client workstation
allowing the user to authenticate according to the chosen mode (login/password or certificate).
To send this information to the FAST360 appliance, the authentication agent establishes a SSL v3
connection by using the TCP/1755 port. This exchange is encrypted with the AES-256 algorithm and is
authenticated by SHA-1.

Prevention of Usurpation of the Acquired Privileges
Different mechanisms are implemented to prevent a third party from usurping the privileges acquired by
the authenticated user:
• For 30 minutes following authentication (explicit or transparent), the agent replies to any request of
the FAST360 appliance by sending transparently for the user the authentication parameters.
• After 30 minutes without connection, the user must explicitly request authentication.
• During each passing in a filtering rule with authentication, the FAST360 appliance verifies that the
source MAC address of the packet corresponds to the MAC address present in the authentication
table for the concerned IP address.
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Prevention of “Brute Force” Attacks
When keys and certificates are stored on a hard disk, the number of access attempts to the certificate
protected by a password is unlimited. This working mode can thus be vulnerable to a "brute force"–type
attack (search by dictionary, …).
In case of storage via a PKCS#11 interface (USB token or chip card), the number of successive
unsuccessful access attempts to the certificate can be limited. If this number is exceeded, a
reinitialization of the strong authentication mechanism will be necessary. This authentication mode thus
constitutes an efficient protection against "brute force" attacks.

Authentication in HA/HP Cluster Configurations
Important
Authentication status is not replicated between the nodes of a cluster.
If traffic through the cluster is handled by load-balancers, users may have to authenticate twice, i.e. once
on each node of the cluster, depending on how the load-balancing algorithm behaves.

16.2. LDAP
This section explains how to configure the FAST360 appliance to authenticate users by connecting to an
LDAP authentication server. After these steps, you need to import users defined on the LDAP server in
the Arkoon Manager configuration following the procedure described in Section 16.5, “Importing users
or groups of users from an authentication server”.
1. In the Network objects explorer view, create a new host object by right-clicking on theHosts folder,
select New > Host. The Host configuration tab is displayed on the right.
2. Select the Properties configuration form.
a. Enter the name of the LDAP server in the Name field.
b. Enter a comment in the Description field.
3. In the Network configuration form, enter the IP address of the server in the IP address field.
4. Select the Services configuration form and check the LDAP Server option. The parameters to be
configured are displayed on the right.
5. Define how long the authentication is kept in the cache in the Cache lifetime field.
6. Define how long the connection will be maintained in case of inactivity in the Timeout field.
7. Select the connection mode from:
• Standard mode: by default, the connection is made on port 389.
• Secure mode: the information exchanged between the FAST360 appliance and the LDAP server is
encrypted in SSL.
a. The default port for SSL is 636.
b. Enter the domain name in the Server name field.
8. Define the communication method between the LDAP server and the client (the FAST360 appliance)
in the LDAP Protocol field. It is recommended to use the default value, 2.
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9. Specify to what level the search must be done among the objects under the search base in the Scope
field:
• To search among all the objects located under the search base, select subtree.
• To search among the objects located on the first level under the search base, select one-level.
10.Define the tree's element, its Distinguished Name (DN) from which the search must begin in the Search
Base field.
11.Check the Use custom user account option to deactivate the default connection (connection with the
LDAP server is established in anonymous mode) if the access rights of this mode are inadequate for
accessing users and groups. The FAST360 appliance will use the whole DN of the user to establish
a connection with the LDAP server.
• It is strongly recommended that you create a specific administrator account with the required
access rights. In the Login and Password fields, enter the account details required by the FAST360
appliance to connect to the LDAP server.
12.Configure the users queries in the Users fields:
a. Define the object class characterizing users on the LDAP server in the Users Object Class field.
b. Define the attribute containing the user's login in a user object in the User Login Attribute field.
c. Define the Relative Distinguished Name (such as common name/cn) used to retrieve a user's main
name in the Users RDN field.
13.Define the groups queries in the Groups fields:
a. Define the object class characterizing groups on the LDAP server in the Groups Object Class field.
b. Define the attribute containing the group's ID in a group object in the Group ID attribute field.
c. Define the attribute containing the group's member list in a group object in the Group Member
Attribute field.
d. Define the Relative Distinguished Name (such as common name/cn) used to retrieve a group's
main name in the RDN field.
14.Check the Retrieve user password option to enable the password to be returned encrypted to the
FAST360 appliance.

Note
Only iplanet (Netscape), IBM Directory Server and Open LDAP servers are allowed to return
the value of the userPassword attribute.
15.Check the UTF8 encoding option to allow the use of special characters, e.g. characters with accents,
in any data exchange.
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16.3. Windows
This section explains how to configure the FAST360 appliance to authenticate users by connecting
to a Windows authentication server. After these steps, you need to import users defined on the
Windows server in the Arkoon Manager configuration following the procedure described in Section 16.5,
“Importing users or groups of users from an authentication server”.
1. In the Network objects explorer view, create a new host object by right-clicking on the Hosts folder,
select New > Host. The Host configuration tab is displayed on the right.
2. Select the Properties configuration form.
a. Enter the name of the NT server in the Name field.
b. Enter a comment in the Description field.
3. In the Network configuration form, enter the IP address of the server in the IP address field.
4. Select the Services configuration form and check the NT Server option. The parameters to be
configured are displayed on the right.
5. Define how long the authentication is kept in the cache in the Cache lifetime field.
6. Define how long the connection will be maintained in case of inactivity in the Timeout field.
7. Enter the domain name of the authentication server in the Domain field.
8. Enter the Netbios name of the server in the Computer field.
9. Define the user account and password in the corresponding fields of the Binding the domain section
if you want to use the domain bind mode. If you do not configure the computer account, the default
anonymous bind mode will be used.
For a Active Directory server whose version is under Windows 2008 (Windows 2000 Server,
Windows 2003 Server), to bind a machine to a domain, a user must be part of the Domain
administrators group.
For a Active Directory server whose version is above or equal to Windows 2008, there are two
solutions:
• Solution 1: in order to bind a machine to a domain, a user must be part of the Domain administrators
group.
• Solution 2: in order to bind a machine to a domain, a user must own an administration delegation
on the specified Organizational Unit (OU).
10.Define the user account and password to be used to retrieve users and groups of the domain from the
authentication server in the corresponding fields of the Retrieving users and groups section.

Note
On the server, you must define a computer account with the host name of the FAST360 appliance
(as defined in minarkconf ). You do not need to do this if you have configured the Binding the
domain and Retrieving users and groups options.
• For a Windows 2000 server, you must re-initialize the computer account created for the FAST360
appliance once you have created it.
• For an NT server, the host name of the FAST360 appliance (as defined in minarkconf ) must reflect the
NT domain, for example, arkoon.NT_DOMAIN
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Note
In HA and HP cluster modes, each node must have its own host name which is used to identify
it when communicating with the NT authentication server. There is no relationship between the
nodes' authentication status.

16.4. Radius
This section explains how to configure the FAST360 appliance to authenticate users by connecting to a
Radius authentication server.
1. In the Network objects explorer view, create a new host object by right-clicking on theHosts folder,
select New > Host. The Host configuration tab is displayed on the right.
2. Select the Properties configuration form.
a. Enter the name of the Radius authentication server in the Name field.
b. Enter a comment in the Description field.
3. In the Network configuration form, enter the IP address of the server in the IP address field.
4. Select the Services configuration form and check the RADIUS Server option. The parameters to be
configured are displayed on the right.
5. Define how long the authentication is kept in the cache in the Cache lifetime field.
6. Define how long the connection will be maintained in case of inactivity in the Timeout field.
7. Define the port to be used in the Port field. Note, there is no standard port for a Radius authentication
server.
8. Enter the access key defined on the Radius server in the Shared secret field.

Note
The access key defined on the Radius server is communicated by the administrator who has
its responsibility.

16.5. Importing users or groups of users from an
authentication server
After creating the objects “authentication servers” in the folder Network objects in the explorer as
described in the previous sections, it is necessary to import the users defined on your authentication
server:
1. In the Authentication folder in the explorer, right-click on Users or Groups of users, and select
Import.
2. Select the authentication server from which you want to import users. The Select Server window
opens.
3. Right-click on the server of your choice and select the objects to be imported.

Note
It is not necessary to import users from a Radius authentication server.
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Importing users or groups of users with Arkoon Manager is only possible if it is directly connected to the
FAST360 appliance which is able to querry the authentication server.
In the case of a master-slaves or multi-appliances architecture, once connected to the master appliance
or to the AMC server with Arkoon Manager, it is not possible to import users from a server which can
only be reached from one of the slave appliances. You need to connect to this appliance to import users
in the Arkoon Manager configuration and then to connect again to the master appliance or to the AMC
server to install the new configuration. Apply the following procedure:
1. With Arkoon Manager, connect to the master appliance or to the AMC server and install the current
configuration in order to be sure all FAST360 slave appliances are synchronized. Then disconnect
from the master or the server.
2. Connect to the FAST360 slave appliance which is able to querry the authentication server and
download the current configuration.
3. Import users or groups of users from the authentication server following the procedure above.
4. Save the configuration on a local file and then disconnect from the appliance.
5. Connect again to the master appliance or to the AMC server with Arkoon Manager.
6. Open the previously saved configuration and install it.

16.6. Importing Certificates for FAST SSL/TLS
Authentication
The default configuration of the FAST SSL/TLS module, described in the section called “FAST SSL/TLS
Module”, blocks SSL/TLS connections with sites which have non-verifiable certificates. This means
certain sites will become unreachable, for example if they use self-signed certificates or the certificate
has expired or if the certificate is signed by a subordinate Certificate Authority of which the root Authority
is unknown. If necessary you can resolve problems this may cause by importing trusted certificates into
the FAST360 configuration using the following procedure.
1. Acquire the certificate
Before you can import a trusted certificate, you need to acquire it by asking the administrator of the
relevant service to supply it in PEM format, or by exporting from a browser such as Internet Explorer
or Mozilla Firefox (with the Cert Viewer Plus extension).

Note
In Internet Explorer, export the certificate as X.509, base 64 format, and save the file with a
.pem extension (not .cer)
2. Import the certificate
With the certificate file copied to the management PC, it can be imported into the FAST360 appliance
configuration.

Warning
These steps are to be applied in the configuration of the appliance and not in the configuration
of the certification authority.
a. In the Authentication explorer view, right-click on the Certificates folder, select New > Certificate.
The Certificate configuration tab is displayed on the right.
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b. Select the Properties configuration form and enter a name for the certificate, for example “intranetssl”, and a short description in the corresponding fields.
c. Select the X.509 Certificate configuration form and load the certificate by clicking on Import from
file and entering the file location.
3. Create a certificate store for FAST SSL/TLS certificates
The certificate store for FAST SSL/TLS trusted certificates is created as an “External PKI Server” (the
appliance itself is the server in this case).
a. In the Authentication explorer view, right-click on the PKI folder, select New > PKI . The PKI
configuration tab is displayed on the right.
b. Select the Properties configuration form and enter a name for the certificate bank, for example
“fast-ssl-tls”, and a short description, for example, FAST360 Internal PKI, in the corresponding
fields.

Note
You must use the name fast-ssl-tls for this configuration, to allow the FAST SSL/TLS
module to authenticate using these certificates.
c. Select the X.509 Certificate configuration form and drag and drop the trusted certificates from the
Certificates descriptive view into the X.509 Certificate field.
d. Define the hierarchy depth in the Maximum depth field. This field is not taken into account in the
case of an external PKI.

Importing Certificates for FAST SSL/TLS Authentication
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17.1. Introduction
17.1.1. Objective
This section introduces the Multi-FAST360 appliances principle and a guide for this type of installation.

17.1.2. Purpose of the Multi-FAST360 Appliance
The principle consists in centralizing the administration of a set of FAST360 appliances: the master/slave
architecture centralizes the configurations management whereas the primary/secondary architecture
centralizes the licenses management.
There are three independent functionalities:
• Master FAST360 appliance: you connect to the master to manage the configuration of all the FAST360
appliances. The other FAST360 appliances are slaves.
• Primary FAST360 appliance: its license possesses the options that can be activated on all the boxes.
The protected IP addresses are counted globally by the primary instead of on every site by each
FAST360 appliance. The other FAST360 appliances are secondary.
• CA Arkoon (Certification Authority): the FAST360 appliance hosts a CA that will create and manage all
the certificates. The other FAST360 appliances are said to be non-CA.
Most of the time, these three functionalities are found on the same FAST360 appliance, generally the one
at the central company site.
It is possible to choose a "master/slave only" or a "primary/secondary only" architecture, but in these two
cases, they have to be under the same trust authority: there can be only one CA.

17.1.3. Format of this Section
This section introduces:
• The master/slave, primary/secondary and CA/non-CA mechanisms.
• The procedure for implementing a master/slaves architecture.
• The particularities of managing a master/slave configuration with Arkoon Manager .

Introduction
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17.2. Operation of Multi-FAST360 Appliances
17.2.1. Master/Slave
Connections
The slaves must be permanently connected to the master, by an SSL connection on port 1754. This has
several consequences:
• The master and the slaves must have a permanent Internet connection.
• The master must be accessible on a permanent public address: either the FAST360 appliance has a
public address, or the Internet access router makes a translation to reroute port 1754 on the FAST360
appliance.

Mechanisms
You connect to the master with Arkoon Manager . When you install a configuration, the master
broadcasts it to all its slaves.
You can connect to a slave with Arkoon Manager , but the modifications you make will be overwritten
at the next configuration broadcast from the master, if the slave is still connected to it.

Caution
It is not possible to configure the same addressing plan on several sites.
It is possible to configure the uploading of the logs from the slaves toward the master. However, this can
impact the master's disk space and bandwidth if you have many slaves.
You can connect to the slaves with Arkoon Monitoring to view what is not specific to the logs (VPN,
bandwidth, system logs, etc.).

Caution
When you open a configuration file with Arkoon Manager on an FAST360 master to which a
slave just connected, an FAST360 object appears in the network objects folder, but this object is
not configured. If you install the configuration in this state, the interfaces of the slave FAST360
appliance will be reconfigured; then, it will not have access to the network anymore. Read
the topic entitled Configuration of the master and the slave with Arkoon Manager to avoid this
problem.

Configuration
The implementation of the master/slave mechanism is done in minarkconf . The steps are described
in the rest of this document. It consists in specifying on the master its master role and the slaves' IP
addresses (0.0.0.0/0 if they are dynamic); and on the slaves their slave role and the master's IP address
(you can indicate several addresses if the master has several Internet accesses).
For more details about the manipulations related to minarkconf , refer to the First-Time Configuration
Guide.
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17.2.2. Primary/Secondary
Connections
The secondary connect to the primary in SSL on port 1753, but they do not require a permanent
connection:
• A first connection is established to retrieve the characteristics of the primary's license.
• A connection every 24 hours allows the secondary to upload the protected IP addresses toward the
primary.

Caution
If the secondary cannot connect to the primary, it will try to connect every five minutes. After
one week of unsuccessful attempts, it invalidates the characteristics of the primary's license:
the related functions will no longer be operational (firewall, proxy, etc.).
The primary must be accessible on a permanent public address: either the FAST360 appliance has a
public address, or the Internet access router makes a translation to reroute port 1753 to the FAST360
appliance.

Mechanisms
To run, the secondary must have a valid secondary-type license (not a temporary license). This license
does not give them any functionality but allows them to retrieve the characteristics of the primary's
license in order to activate the related functionalities (firewall, proxies, etc.).

Configuration
The implementation of the primary/secondary mechanism is done in minarkconf . The manipulations are
described in the rest of this document. For more details about the manipulations related to minarkconf
, refer to the Commissioning Guide.
You will have to execute the following operations:
• Install on the primary a normal license taking into account the global number of IP addresses on all
the sites.
• Install secondary-type licenses on the secondary.

Caution
If you install a temporary license on the secondary, when this license will expire, it will invalidate
the information retrieved from the primary's license. Therefore, a permanent license must be
installed before the temporary license expires.
• Specify on the Primary its Primary role and the secondary' IP addresses (0.0.0.0/0 if they are dynamic);
and on the secondary their secondary role and the primary's IP address (you can indicate several
addresses if the primary has several Internet accesses).

Primary/Secondary
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Master/Slave Management in HA/HP Clusters
For a cluster in a master/slave or AMC architecture, the cluster master node is in charge of:
• Synchronizing management data with master or slaves
• Forwarding logs to master or AMC server if the cluster is slave
• Receiving logs from slave(s) if the cluster is master

Important
The following details must be taken into consideration when configuring clusters in master/slave
architecture:
• In active/active cluster mode where the cluster is master, the slave must use an IP address to
connect to the cluster. This IP address is the cluster master node address. This is mandatory
as only the cluster master node is listening to slave connections when the cluster is the master
of a master/slave architecture.
• In active/active cluster mode where the cluster is master, slaves connecting from the Internet
must be configured with the 2 IP addresses of the public IP addresses of the master (one for
each node) when ADSL is used. In this case, the slave appliances will try to connect to the
first IP address in the list. If the connection attempt fails, they will try to connect to the second
IP address of the cluster.

17.2.3. CA/non-CA
Connections
There is no connection for the CA. You take control in terminal mode (screen/keyboard, SSH connection,
connection via the serial port) to manage the certificates.

Mechanisms
The master/slave and primary/secondary connections are authenticated by certificates generated by the
same Certification Authority. Thus, you create the certificates (with Firewall rights) of all the FAST360
appliances on this Certification Authority (with minarkconf or Arkoon Manager ). The certificates are
generated in the PKCS#12 format. Import then these files on the corresponding FAST360 appliance using
the minarkconf tool.

17.3. Implementing a Multi-FAST360 Appliances
Architecture
17.3.1. Topology
The most common case, illustrated below, is a FAST360 appliance called “central-arkoon”, that acts as
the CA, master and primary, and a FAST360 appliance called “agency-arkoon”, that is non-CA, slave and
secondary.
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Figure 17.1. Multi-FAST360 Appliances Architecture

It is recommended to configure in the following order:
• The CA FAST360 appliance before the non-CA FAST360 appliances.
• The master FAST360 appliance before the slave FAST360 appliances.
• The primary FAST360 appliance before the secondary FAST360 appliances.

17.3.2. Configuration of the Master
Enter the Configuration menu, then select Master/Slave (Config).
┌───────────── Configuration ─────────────┐
│
│
│ ┌─────────────────────────────────────┐ │
│ │ a Hostname
│ │
│ │ b Keyboard
│ │
│ │ c Date & Time
│ │
│ │ d Admin from...
│ │
│ │ e Primary/Secondary
│ │
│ │ f Master/Slave (Config)
│ │
│ │ g Master/Slave (HA)
│ │
│ │ h Load a configuration file
│ │
│ │ i Terminal on serial port
│ │
│ │ j Create initial configuration file │ │
│ │ k Back
│ │
│ └─────────────────────────────────────┘ │
│
│
├─────────────────────────────────────────┤
│
<OK> <Cancel>
│
└─────────────────────────────────────────┘

Check Master. You must then indicate which IP addresses are authorized to connect as slaves. Specify
the public address of the “Agency-arkoon”.
┌───── Master/Slave (Config) ─────┐
│ ┌─────────────────────────────┐ │
│ │
(X) 1 Master
│ │
│ │
( ) 2 Slave
│ │
│ │
( ) 3 None
│ │
│ └─────────────(+)─────────────┘ │
├─────────────────────────────────┤
│
<OK> <Cancel>
│
└─────────────────────────────────┘
┌───────── Allow from (TCP/1754) ─────────┐
│ aa.bb.cc.dd/ee or aa.bb.cc.dd/ee(iface) │
│ ex: 192.168.1.0/24(eth0)
│
│ 192.168.2.33/32(eth1)
│
│ ┌─────────────────────────────────────┐ │
│ │
│ │
│ └─────────────────────────────────────┘ │
├─────────────────────────────────────────┤
│
<OK> <Cancel>
│
└─────────────────────────────────────────┘

Configuration of the Master
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17.3.3. Configuration of the Primary
Enter the Configuration menu, then select Primary/Secondary. Check Primary. You must then indicate
which IP addresses are authorized to connect as secondary. Specify the public address of the “agencyarkoon”.
┌────── Primary / Secondary ──────┐
│ ┌─────────────────────────────┐ │
│ │
(X) 1 Primary
│ │
│ │
( ) 2 Secondary
│ │
│ │
( ) 3 None
│ │
│ └─────────────(+)─────────────┘ │
├─────────────────────────────────┤
│
<OK> <Cancel>
│
└─────────────────────────────────┘
┌───────── Allow from (TCP/1753) ─────────┐
│ aa.bb.cc.dd/ee or aa.bb.cc.dd/ee(iface) │
│ ex: 192.168.1.0/24(eth0)
│
│ 192.168.2.33/32(eth1)
│
│ ┌─────────────────────────────────────┐ │
│ │
│ │
│ └─────────────────────────────────────┘ │
├─────────────────────────────────────────┤
│
<OK> <Cancel>
│
└─────────────────────────────────────────┘

Note
In the case of a cluster configuration, you must configure both appliances of the cluster as
configuration masters of the multi-appliances architecture.

17.3.4. Configuration of the Non-CA FAST360 Appliance
If the FAST360 appliance was CA, it is recommended to delete the CA (Certificate and Delete Certificate
Authority menus).
Enter the Certificates menu of the “agency-arkoon”, then select Import FAST360 certificate. Then
specify the .p12 certificate with FIREWALL_S rights previously created on the CA (refer to “Configuration
of the CA” above).
┌──────────────── Certificates ─────────────────┐
│
│
│ ┌───────────────────────────────────────────┐ │
│ │ a Initialize a Certificate Authority (CA) │ │
│ │ b Import new Arkoon certificate
│ │
│ │ c View Arkoon certificate
│ │
│ │ d Back
│ │
│ └───────────────────────────────────────────┘ │
│
│
├───────────────────────────────────────────────┤
│
<OK> <Cancel>
│
└───────────────────────────────────────────────┘

17.3.5. Configuration of the Slave
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Migration of an already configured Fast360 appliance to the master
Enter the Configuration menu, then select Master/Slave (Config). Check Slave and specify the public
address of the “central-arkoon”.
┌───── Master/Slave (Config) ─────┐
│ ┌─────────────────────────────┐ │
│ │
( ) 1 Master
│ │
│ │
(X) 2 Slave
│ │
│ │
( ) 3 None
│ │
│ └─────────────(+)─────────────┘ │
├─────────────────────────────────┤
│
<OK> <Cancel>
│
└─────────────────────────────────┘
┌───── Master IP ─────┐
│ ┌─────────────────┐ │
│ │
│ │
│ └─────────────────┘ │
├─────────────────────┤
│
<OK> <Cancel>
│
└─────────────────────┘

Configuration of a new Fast360 appliance directly on the master
1.

First, you must generate a FIREWALL certificate on the master appliance or on the certification
authority for the new appliance to install and then prepare its license file. To generate the certificate,
refer to the section called “Mechanisms”.

2.

Configure the new slave appliance with minarkconf. Refer to the First-Time Configuration Guide for
more information about the procedure. Be careful to follow the order of the steps described below
in order to get the hardsyscfg and hardsyscfgxml configuration files at the end of the procedure.
They will be sent to the master at the first connection:
1. Configure the appliance IP addresses.
2. Configure the Internet access.

Caution
The default Internet access creates an object named “Internet access” with the
“Internet Router” object as the LS/Routeur gateway. When the new appliance is added
to the multi-appliances configuration, both objects are created if they do not already
exist in the configuration. Then, they will be used by default by the next appliances added
to the configuration (even if addresses do not match).
3. Define the master appliance network's IP address as the “Admin from” address (IP address
allowed to remotely manage the Fast360 appliance).
4. Copy and install the appliance's certificate generated during the first step.
5. Copy and intall the appliance's license.
6. In the Configuration menu in minarkconf, select Master/Slave (Config) to configure the new
appliance as “slave” of the master appliance. Check Slave and specify the public address (or
addresses) of the master, as well as ports 1754 and 1759.

Caution
It is important that step 6 be the last step. After this step, the appliance's hardsyscfg
and hardsyscfgxml configuration files are issued and sent to the master. During this
step also, the CRL is updated and the role base is initialized on the new appliance (the
base of the master is copied).

Configuration of the Slave
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3.

Finally connect Arkoon Manager to the master appliance and load the remote configuration. The
master reports the presence of a new appliance and ask to add it to the configuration as new
hardware. Accept the request and check the information about the new appliance, in particular the
configuration of the Internet access.

4.

Deploy the configuration the first time without modifying it. The new appliance receives then the
master's XML configuration file.

17.3.6. Configuration of the Secondary
You must install a “secondary-type" license on the secondary. Enter the License menu then select Install
main license.
┌──────────────── License ────────────────┐
│
│
│ ┌─────────────────────────────────────┐ │
│ │ a Request license
│ │
│ │ b Install main license
│ │
│ │ c Add rescue license
│ │
│ │ d Remove license
│ │
│ │ e View HHID
│ │
│ │ f View license(s)
│ │
│ │ g Back
│ │
│ └─────────────────────────────────────┘ │
│
│
├─────────────────────────────────────────┤
│
<OK> <Cancel>
│
└─────────────────────────────────────────┘

Enter the Configuration menu then select Primary/Secondary. Check Secondary and specify the public
address of the “central-arkoon”.
┌────── Primary / Secondary ──────┐
│ ┌─────────────────────────────┐ │
│ │
( ) 1 Primary
│ │
│ │
(X) 2 Secondary
│ │
│ │
( ) 3 None
│ │
│ └─────────────(+)─────────────┘ │
├─────────────────────────────────┤
│
<OK> <Cancel>
│
└─────────────────────────────────┘
┌───── Primary IP ────┐
│ ┌─────────────────┐ │
│ │
│ │
│ └─────────────────┘ │
├─────────────────────┤
│
<OK> <Cancel>
│
└─────────────────────┘

Once you connected a slave FAST360 appliance onto its master, you must launch manually the roles
database instalaltion from the master.
If you do not launch the installation, the roles database will not be onto the slave FAST360 appliance and
as a consequence, the Arkoon Tools connection established on the slave with the certificate used for
the master FAST360 appliance will be denied.
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17.3.7. Master/Slave and Primary/Secondary Communication
The following step consists in establishing a communication link between master and slave, as well as
primary and secondary.

Communication Check
To make sure the secondary is successfully connected to the primary, type the following command on
the secondary:
/usr/akgetlicense/akgetlicense infos

If the secondary is connected, you will see the date at which it retrieved its license from the primary.
To make sure the slave is successfully connected to the master, type the following command on the
master:
/usr/akslave/akslave infos

If the slave is connected, its IP address and ID appear after those of the master.

Troubleshooting
If the Secondary is Not Connected to the Primary…
You must identify the communication problem. Does the secondary not query the correct IP address?
Does the primary accept the secondary connections from this address? Do the secondary's packets
reach the primary?
The simplest solution consists in restarting the "akgetlicense" service on the secondary, from the Services
window of Arkoon Monitoring . The secondary will then try to reconnect to the primary. You will be able
to check in its system logs that it tries to connect with the correct IP address. Finally, you will be able to
check in the primary's system logs that the connection is accepted.

If the Slave is Not Connected to the Master…
The procedure is similar to the one described above.
The service to be restarted on the slave is "akslave".

17.3.8. Addition of a cluster connected to the AMC server
This section explains how to add a cluster in an AMC architecture.

Prerequisite
On the AMC server's CA:
1. Generate two FIREWALL type .p12 certificates. For more information about certificate generation, refer
to Chapter 4, Managing Authentication Certificates and Administrator Rights.
2. Export the administrator's certificate in PEM format.
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1st step: Preparation of the Cluster
To implement the cluster, Arkoon Manager must be directly connected to the future master node.
1. Initialize the cluster using the certificates generated at the previous stage. You must initialize the
roles base with the administrator's certificate exported in PEM format. For more information, refer
to Section 14.3.1, “Initializing a High Availability (HA) Cluster” or Section 14.8.1, “Initializing a High
Performance (HP) Cluster”.
2. Configure the cluster:
• Configure at least one interface.
• Define the master node's address.
• Correct the hosts' names.
• Activate network communication between the cluster and the AMC server.
• Make sure that no error appears when deploying the configuration via Arkoon Manager.
For more information, refer to Section 14.3.2, “Configuring Services on a High Availability (HA)
Cluster”or Section 14.8.2, “Configuring Services on a High Performance (HP) Cluster”.

2nd step: Connection of the Cluster to the AMC Server
Connect the cluster to the AMC server via SSH or in console mode on both nodes of the cluster. A
confirmation message indicates that the master node is connected to the AMC server. On the slave node,
a message indicates that the node will only connect to the AMC server when it will become master node.

3rd step: Synchronization of the Cluster by the AMC Server
This stage consists in loading the remote configuration by connecting to the AMC server from Arkoon
Manager. When loading, Arkoon Manager indicates that an information update has been detected and
a new cluster has been discovered. Validate the addition of the cluster to make it operational and allow
the AMC server to configure it. Deploy the configuration at least once from the AMC server.

17.4. Configuration of the Master and the Slave with
Arkoon Manager
Once you checked the communication link between primary and secondary and between master and
slave, connect with the Manager to continue with the configuration.
A "central-arkoon" object and an "agency-arkoon" object should appear in Arkoon Manager .

Caution
None of the slave's configuration elements is retrieved, except for its name: even the addresses
of its interfaces are not integrated to the configuration of the master. Therefore, it is of the utmost
importance to correctly configure the slave's interfaces and Internet access before installing
the configuration for the first time; otherwise, you will lose the communication with the slave.
Each FAST360 appliance now has its own properties (interfaces, routes, proxies, etc.) whereas the rest
of the configuration is common to all the FAST360 appliances: definition of the hosts, networks, filtering
rules, VPN, etc.
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17.4.1. Installation of the Filtering Rules on each FAST360 Appliance
The same configuration file is installed on the master and the slave. Using the "arkoon ID", mentioned
in the configuration, each FAST360 appliance knows what its properties are. It can then deduct which
filtering rules it must implement according to its interfaces and routes addresses.
However, you can force a FAST360 appliance into installing or not a filtering rule with the rule's
Installation tab.

Important
In the case of FAST360 appliances without an Internet access, it becomes very important to use
the Installation tab. The rule installation will not be possible if one of the connected FAST360
appliances does not know all of the objects implied in the rule. You then have to either add a
static route, or add an Internet access, or specify on which FAST360 appliance to install the rule.

17.4.2. VPN Implementation
The configuration of LAN-to-LAN VPN is made easier by a master/slave architecture. Since there is no
need to exchange the certificates, you just have to configure the VPN module, networks' VPN gateway,
tunnel group and filtering rule.

Example 17.1. Authorizing Pings in VPN
Authorizing the ping of LAN-agency to LAN-central using the VPN: you only have to create a single rule
encrypting from “agency-arkoon” to “central-arkoon”.
For more details, see Chapter 13, Configuring IPsec VPN Tunnels.

Caution
The "agency-arkoon" is not CA; therefore, if you want to implement a nomad VPN on the "agencyarkoon", you must create a certificate (or sign the request) on the CA, i.e. the "central-arkoon".

17.5. Managing the CRL in an AMC context
The CRL internal to Arkoon services is not replicated by default in master / slaves. It is possible to activate
this feature, but it requires to have a HTTP web server.

Note
The documentation for installing a Web server is not addressed here. For a use with
administration connections:
• Generating Arkoon CRL: the lifetime of Arkoon CRL is 10 years by default. For Arkoon services
(manager, monitor, akslave, akha, akserver), the CRL is managed by the AMC server.

Note
The arkoon-config key enables to configure in days the lifetime of the CRL generated by
Arkoon CA. This value corresponds to the period between the thisUpdate and nextUpdate
parameters of the CRL. If the AMC server is a Certification Authority, you must add the key to
the instance configuration file.
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# Arkoon CA default CRL duration (10 years)
arkoon-ca.crl-days = 3650

It is possible to regenerate the CRL from minamcconf by using the menu Instances > Configure AMC
instance > Certificates -> Update Certificate revocation list. This enables to update the date for
nextUpdate and then distribute the CRL.
• Recovery: in a master / slave configuration, the CRLs updated by an AMC server are not automatically
deployed on the slaves appliances. We consider a Web server is installed on the AMC server, and it
ensures the distribution of CRL files. Adding arkoon-config keys on each of the appliances enables
to start the CRL download for the internal PKI via HTTP:
# Arkoon CA CRL fetch configuration (default=disabled)
arkoon-ca.crl.download.enable = yes
# Setup the distribution point:
arkoon-ca.crl.download.distrib_point = "http://IP_AMC/path-to/crl.pem"
# Arkoon CA CRL fetch period in minutes
arkoon-ca.crl.download.period-min = 30

Reinstall the configuration via Arkoon Manager.
• Integrating grace periods: when the nextUpdate date of the CRL for the internal PKI is reached (CRL
“expired”), it is possible to add (by arkoon-config key) a grace period enabling the following behavior,
if T is the CRL “expiration” date:
• before T: the CRL is valid,
• between T and (T + grace period): a PKI-CRL sysmon alert goes to Orange state, but the CRL remains
valid for the following tools: Administration connection with Arkoon Manager and Monitoring, interappliances dialog with akslave, akha and akserver.
• beyond (T + grace period): the certificates distributed by the Certification Authority are considered
as revoked, even if they are not part of the CRL list.
# Grace period for most Arkoon CA based applications
arkoon-amc.certificate.crl-grace-days = 7

The administrator is responsible for
• the creation of the flow rule allowing the http flows of the appliance to the server hosting the file;
• the provision of Arkoon internal CRL of the appliance via a URL HTTP (Web server installed on the
AMC server).
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18.1. Monitoring an Appliance
18.1.1. System Monitoring
System monitoring (sysmon) enables to configure the monitoring of different system elements. According
to the status of the element monitored, monitoring alerts can display a red, orange or green level in the
Alerts window in Arkoon Monitoring (System monitoring alert type). Modifying the status of these system
elements will generate alerts.
arkoon-config keys enable to customize the system monitoring configuration in the configuration file.

When connected to an appliance, use the sysmon client LIST command to display all system
monitoring options.

Note
No action is required to activate system monitoring. It is integrated by default in the basic
configuration of Arkoon Manager. Only system monitoring of types Interfaces, Internet access
and HTTP proxy are configured in Arkoon Manager.

Monitoring of HTTP proxy, interfaces and internet access
Warning
System monitoring of type Interfaces and Internet access are not taken into account when
working out of the priority of a cluster node and then do not affect the status of a cluster.
The status of the interfaces and Internet access is checked by sending a ping to a host configured in the
system monitoring. The status of the HTTP/FTP proxy is checked by submitting a request.
1. In the Network objects explorer view, double-click the FAST360 appliance icon. The FAST360
appliance configuration tab is displayed on the right.
2. Select the Audit configuration form.
3. Select the System Monitoring option.
4. To create a new entry, right-click in the blank System Monitoring table, select New > System
Monitoring . The System Monitoring dialog box is displayed.
5. Enter the name of the system monitoring and a short description in the corresponding fields.
6. Define the importance relative to the configured monitoring in the Weight. The default value is 1.
7. Select the type of network object to which the system monitoring will be applied from one of the three
options:
• To monitor an interface, check the Interface monitoring option.
a. Drag and drop the interface to be monitored into the Interface field.
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b. Drag and drop the hosts to be pinged into the Tested Hosts field.
• To monitor an Internet access, check the Internet Access monitoring option.
a. Drag and drop the Internet access to be monitored into the Internet Access field.
b. Drag and drop the hosts to be pinged into the Tested Hosts field.

Note
It is recommended to define several tested hosts in order to avoid false positives.
Detailed characteristics of interfaces and Internet access monitoring:
System name

aknetmon

System generic type

OUTCONN-PING

Available on platforms

XPA, P, XLARGE, NPA, VE

Orange level reached

if at least one host to be pinged is considered as
unreachable

Red level reached

if all hosts to be pinged are considered as
unreachable

• To monitor the HTTP proxy, check the HTTP Proxy monitoring option.
Detailed characteristics of the HTTP proxy monitoring:
System name

akhttpmon

System generic type

HTTP-PROXY

Available on platforms

XPA, P, XLARGE, NPA, VE

Orange level reached

not used

Red level reached

as soon as the waiting period for one request has
ended

8. In the Time between two tests field, define the time interval between two tests. By default this value
is 3 seconds.
9. In the Test timeout field, define the delay after which no reply from the monitored element will be
considered as a failure. The default value is 5 seconds.

Note
The values in the Time between two tests and Test timeout fields must be coherent to prevent
ill-founded alerts. When testing interfaces or Internet access, the Test timeout value must be
reasonable.

Monitoring of MySQL database size
Enables to monitor regularly the size of the MySQL database on the hard disk.
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Common name

logs size

System name

logs

System generic type

LOGS-SIZE

Available on platforms

Small, P-XS3, P-S4

Orange level reached

• if the size of the MySQL base is more than 75%
of the size of the 'max-db-size' key (550 Mb by
default);
• if the size of one of the MySQL base tables is
more than 75% of the size of the 'max-table-size'
key (180 Mb by default).

Red level reached

• if the size cannot be calculated for any reason;
• if the tables of the base cannot be listed for any
reason;
• if the size of the MySQL base is more than 90%
of the size of the 'max-db-size' key (550 Mb by
default);
• if the size of one of the MySQL base tables is
more than 90% of the size of the 'max-table-size'
key (180 Mb by default).

Interrogation frequency

every hours

arkoon-config customizable keys (displayed here with their default value in the configuration):

•

sysmon.alerts.config-X.orange-action = "/opt/arkoon/bin/akdbpurge -f"

Action to trigger if the orange level is reached.
•

sysmon.alerts.config-X.orange-action-dsc = "Force akdbpurge operation."

Description of the action above.
•

sysmon.alerts.config-X.red-action = "/etc/init.d/mysqld flush"

Action to trigger if the red level is reached.
•

sysmon.alerts.config-X.red-action-dsc = "Force flush of mysql database."

Description of the action above.

Example 18.1. Example of use of the configuration keys for the logs size system
monitoring
sysmon.alerts.config-14.name = "logs size"
sysmon.alerts.config-14.period = 3600
sysmon.alerts.config-14.orange-level = 75
sysmon.alerts.config-14.orange-action = "/opt/arkoon/bin/akdbpurge -f"
sysmon.alerts.config-14.orange-action-dsc = "Force akdbpurge operation."
sysmon.alerts.config-14.red-level = 90
sysmon.alerts.config-14.red-action = "/etc/init.d/mysqld flush"
sysmon.alerts.config-14.red-action-dsc = "Force flush of mysql database."
sysmon.alerts.config-14.max-table-size = 180
sysmon.alerts.config-14.max-db-size = 550

• The

sizes are in Mb. sysmon.alerts.config-14.max-table-size
=
180 and
sysmon.alerts.config-14.max-db-size = 550 keys indicate the maximal size for a table and the
maximal size for the complete database. The limit is by table and by complete database.
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• The orange level (75% reached) is a akdbpurge -f where -f forcing the flush for a configuration
which backups MySQL logs after 7 days (text format) and deletes these logs from the database. It also
deletes backups after 30 days. The red level is reached at 90% and the complete database is flushed.
• When a SMALL appliance starts, if /var available space is less than the value stored in the
hardware.free-space-limits.var key (by default, this key is at 400 Mb), the tar.gz SOPHOS
and ADVANCED_URL archives stored in /var/arkupdate as well as cteng*.dat, ngs*, av_check_*,
pop3_mail*, rak_pop3av*.mm, rak_*.mm, *.*AV and *.*-$ temporary files stored in /var/tmp are
deleted.

Monitoring of the MySQL database status
Enables to check that the database is working properly.
Common name

logs db

System name

logs

System generic type

LOGS-MEDIA

Available on platforms

XPA, P, XLARGE, NPA, VE

Orange level reached

if the status of the database is:
• getting fixed;
• updating (when the base format changes
between two versions);
• does not work (not available).

Red level reached

not used

Interrogation frequency

every 30 seconds

CPU load monitoring
Enables to check the average load over the five last minutes.
Common name

CPU load

System name

cpuload

System generic type

CPU-LOAD

Available on platforms

XPA, P, XLARGE, NPA, VE

Orange level reached

from 75 % of load

Red level reached

from 90 % of load

Interrogation frequency

every 30 seconds

arkoon-config customizable key (displayed here with the default value in the configuration):

•

sysmon.alerts.config-X.sampling = 300

Sampling frequency (300 seconds = 5 minutes), it means that the CPU load is calculated over the five
last minutes.

RAM occupancy monitoring
Enables to check the percentage of occupancy of the RAM.
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Common name

memory usage

System name

memusage

System generic type

MEM-USAGE

Available on platforms

XPA, P, XLARGE, NPA, VE

Orange level reached

from 75% of occupancy

Red level reached

from 90% of occupancy

Interrogation frequency

every 30 seconds

Monitoring of the occupancy of hard disk partitions
Enables to check the percentage of occupancy of the different partitions on the hard disk (/var, /
configcard and /tmp).
Common name

/var usage, /config_card usage or /tmp usage

System name

diskmon

System generic type

DISK-USAGE

Available on platforms

XPA, P, XLARGE, NPA, VE

Orange level reached

from 75% of occupancy

Red level reached

from 90% of occupancy

Interrogation frequency

every 30 seconds

arkoon-config customizable keys (displayed here with their default value in the configuration):

•

sysmon.alerts.config-3.akalert.low-level = 75

Occupancy percentage from which a low level alert is reported in the alerts table.
•

sysmon.alerts.config-3.akalert.med-level = 90

Occupancy percentage from which a medium level alert is reported in the alerts table.
•

sysmon.alerts.config-3.akalert.high-level = 95

Occupancy percentage from which a high level alert is reported in the alerts table.
•

sysmon.alerts.config-3.akalert.alert-kernel = yes

Boolean which indicates if a message must be sent to the kernel in order to report that the partition
on which logs are stored (/var most of the time) is complete. This can block network traffic under
saturation. For more information, refer to the section called “Recommended configuration for an
optimal protection against attacks of the type logs saturation”.

Monitoring of the user license validity
Enables to check the user license is not expiring or already expired.
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Common name

license

System name

license

System generic type

LICENSE

Available on platforms

XPA, P, XLARGE, NPA, VE

Orange level reached

when there are less than 240 hours (10 days)
remaining before the expiration

Red level reached

if the license is expired or when there are less than
144 hours (6 days) remaining before the expiration

Interrogation frequency

every 30 seconds

Logs queue monitoring
Enables to check the status of logs queues.
Common name

log queues

System name

logs

System generic type

LOGS-QUEUE

Available on platforms

XPA, P, XLARGE, NPA, VE

Orange level reached

if logs queues are:
• complete at the user level;
• complete at the kernel level;
• complete at the user and kernel levels.

Red level reached

not used

Interrogation frequency

every 30 seconds

Monitoring of the roles database of cluster nodes
Enables to check if the current roles database is the same between both nodes of a cluster.
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Common name

cluster role

System name

cluster_version

System generic type

CLUSTER-ROLE

Available on platforms

P (in cluster mode), NPA (in cluster mode),
VE (in cluster mode). For each platforms, this
system monitoring is activated only on the passive
appliance.

Orange level reached

if the current roles database is different between
both nodes

Red level reached

not used

Interrogation frequency

every 30 seconds
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arkoon-config customizable key (displayed here with the default value in the configuration):

•

sysmon.alerts.gencfg-X.ha-active-disable = yes

Indicates that this system monitoring is deactivated on the active node.

Monitoring of system update availabilities
Enables to check the system version is the latest version.
Common name

update

System name

update

System generic type

UPDATE

Available on platforms

XPA

Orange level reached

when the appliance has more than four updates of
delay

Red level reached

not used

Interrogation frequency

every two hours

arkoon-config customizable key (displayed here with the default value in the configuration):

•

sysmon.alerts.config-11.warn_asap = yes

Indicates that a warning will be displayed in the sysmon message in Arkoon Monitoring (updates
available, including ASAP) if an update must be installed ASAP.

Monitoring of the HA cluster (XPA) status
Enables to check the status of a High Availability cluster for XPA appliances.
Common name

hamon

System name

hamon

System generic type

HA

Available on platforms

XPA

Orange level reached

when the passive node is not connected or when
the system version is different between both nodes

Red level reached

not used

Interrogation frequency

every 30 seconds

Monitoring of the appliance services status
Enables to check that all the services of an appliance work properly.
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Common name

services

System name

servmon

System generic type

SERV

Available on platforms

XPA, P, XLARGE, NPA, VE

Orange level reached

not used

Red level reached

if at least one service no longer works

Interrogation frequency

every 30 seconds

Monitoring of the status of the declared external PKI
If using an external PKI, it enables to monitor different elements such as the validity of X509 certificates
and the CRL.
Common name

pki

System name

pki

System generic type

PKI-CRL

Available on platforms

XPA, P, XLARGE, NPA, VE

Orange level reached

• if the CRL is about to expire;
• if the CRL is about to expire and there are more
than four CRL updates which have not been
applied properly;
• if there are more than four CRL updates which
have not been applied properly;
• if the CRL has expired and there are more than
four CRL updates which have not been applied
properly but the grace period has not ended.

Red level reached

• if the CRL file of the PKI has not been found
on the appliance (because it has never been
downloaded for example);
• if the CRL is corrupted;
• if the CRL has expired;
• if the CRL has expired and there are more than
four CRL updates which have not been applied
properly;
• if the CRL has expired and the grace period has
ended;
• if the CRL has expired and there are more than
four CRL updates which have not been applied
properly and the grace period has ended.

Interrogation frequency

every 30 seconds

arkoon-config customizable keys (displayed here with their default value in the configuration):

•
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Name of the trusted certificate, as defined in the Arkoon Manager configuration.
•

sysmon.alerts.config-X.file

Name of the system file which includes the CRL for the concerned PKI.
•

sysmon.alerts.config-X.warn-before-expiration

Period remaining before the CRL expires: 120 minutes by default.
•

sysmon.alerts.config-X.warn-too-old-update

Number of failed CRL updates before the change of status.
•

sysmon.alerts.config-X.crl-grace-days

Grace period after the expiration of the CRL (0 days by default).

Hard disk(s) monitoring
Enables to monitor some parameters of the hard disk(s) (temperature, number of hours of use, etc.)
Common name

disk0, disk1, etc.

System name

harddrive

System generic type

DISKS

Available on platforms

XPA, P, XLARGE, NPA, VE

Orange level reached

• if the number of hours of use of the disk exceeds
30000 hours (configured in the power.orangelevel key);
• if the disk temperature exceeds 50 degrees
celsius.

Red level reached

• if the surface of the hard disk is damaged
(defective clusters or sectors for example);
• if the disk read heads are defective;
• if the disk has a mechanical problem;
• if the disk temperature exceeds 55 degrees
celsius.

Interrogation frequency

every 30 seconds

arkoon-config customizable keys (displayed here with their default value in the configuration):

•

sysmon.alerts.config-X.temperature.orange-level = 50

Maximum temperature to trigger the orange level.
•

sysmon.alerts.config-10.temperature.red-level = 55

Maximum temperature to trigger the red level.
•

sysmon.alerts.config-10.power.orange-level = 30000

Maximum number of hours of use to trigger the orange level.
•

sysmon.alerts.config-10.scsi.noncorrectable.red-level = 0

Maximum number of errors before considering that a SCSI hard disk has a problem and that a red alert
must be reported.
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Bandwidth monitoring
For each QoS rule in the Arkoon Manager configuration, enables to check QoS values are not exceeded,
which may mean there is bandwidth problem.
Common name

name of the class or of the TRTCM used in the
Arkoon Manager configuration

System name

qos

System generic type

QOS

Available on platforms

XPA, P, XLARGE, NPA, VE

Orange level reached

• if packets have been rejected by a QoS rule;
• if queues exceed thresholds configured in the
Arkoon Manager configuration.

Red level reached

not used

Interrogation frequency

every 30 seconds

Monitoring of the network link on an interface
Enables to check network link works properly on an interface.
Common name

link:eth0, link:eth1, etc.

System name

link

System generic type

LINK

Available on platforms

XPA, P, XLARGE, NPA, VE

Orange level reached

• if the link is UP but not RUNNING;
• if the link is RUNNING but not UP.

Red level reached

• if the link is neither UP, nor RUNNING (that is to
say “link down”);
• if the link is active but the interface has been
deactivated ('ifconfig ethX down' for example).

Interrogation frequency

every 30 seconds

Monitoring of the VRRP status of a cluster node
Enables to display the VRRP status of a cluster node.
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Common name

cluster

System name

cluster_state

System generic type

CLUSTER-STATE

Available on platforms

P (in cluster mode), NPA (in cluster mode), VE (in
cluster mode)

Orange level reached

not used

Red level reached

not used

Interrogation frequency

every 10 seconds

RAID status monitoring
Enables to monitor the RAID status (Redundant Array of Independent Disks).
Common name

raid1 (/tmp), raid2 (swap), etc. (as many as there are
partitions on the appliance)

System name

softraid

System generic type

SOFT-RAID

Available on platforms

P

Orange level reached

• when a disk is reconstructing;
• if the synchronization of disks/partitions of the
RAID is reported (for any reason).

Red level reached

• if the RAID has disappeared from the partitions
(for any reason);
• if the RAID is not working;
• if one disk/partition of the RAID has a problem.

Interrogation frequency

every 600 seconds (10 minutes)

Machines monitoring
Enables to monitor destination servers used in filtering rules using port translation (PAT) and load
balancing.
Common name

HostMon

System name

HostMon

System generic type

HOSTMON

Available on platforms

P, XLARGE, NPA

Orange level reached

if at least one of the monitored server no longer
answers to an ICMP request

Red level reached

if all servers no longer answer to an ICMP request

Interrogation frequency

every 5 seconds

arkoon-config customizable keys (displayed here with their default value in the configuration):

•

sysmon.alerts.gencfg-X.host.Y.ip = "xxx.xxx.xxx.xxx"
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Enables to add the IP address of a server to monitor.
•

sysmon.alerts.gencfg-X.host.Y.service = "PING"

Enables to define the monitoring service to use (PING service only).

18.1.2. Using the Reporting Tool
The Audit configuration tab allows you to configure the Arkoon Reporting tool (which can generate and
edit statistics on the use of the FAST360 appliance) from Arkoon Manager .
1. In the Policies explorer view, select the Reporting Policies folder.
2. To create a new reporting policy, right-click on the Reporting Policies folder, select New > Reporting
Policy. The Reporting Policy configuration tab is displayed on the right.
3. Select the Properties configuration form.
a. Enter the name for the reporting policy in the Name field.
b. Enter a comment in the Description field.
4. In the General configuration form:
a. Define, in hours and minutes, at what time the reports must be generated in the corresponding
Generate reports at fields.
b. Define, in hours and minutes, at what time the reports must be flushed in the corresponding Purge
old reports at fields.
c. Define (in Mb) the maximum size of the data in the Maximum data size field.
d. Define (in days) the lifetime of the data in the Maximum number of days reported field.
5. Select the Audit configuration tab in the FAST360 appliance and check the Reporting option.
6. Drag and drop the previously configured reporting policy into the Reporting policy field. The Arkoon
Reporting tool is configured according to the defined parameters.
7. In the Authorized clients field, drag and drop the hosts and/or networks which are allowed to connect
to the 1757 port of a FAST360 appliance (and not the machines) for which the Arkoon Reporting tool
will generate statistics.

18.2. Displaying Logs and Alerts
Arkoon Monitoring tool allows to display 5 types of logs:
• IP logs (see Section 18.2.1, “Displaying IP Logs”).
• Alerts (see Section 18.2.2, “Displaying Alerts”).
• IDPS logs (see Section 18.2.3, “Displaying IDPS Logs”).
• HTTP logs (see Section 18.2.4, “Displaying HTTP Relay Logs”).
• SMTP logs (see Section 18.2.5, “Displaying SMTP Relay Logs”).
To execute Arkoon Monitoring:
1.
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The Arkoon Monitoring interface is displayed.
2.

When the Arkoon Monitoring window is opened, click on
from the toolbar to connect to a firewall.
Once the connection is established, you have access to the following menus of the interface:

3.

Select the type of logs you want to display.
Each log window has the same toolbar
logs or tools to select what must be displayed.

as well as arrows to move within the

18.2.1. Displaying IP Logs
The IP logs window allows to view the information which relates to the packets accepted, blocked or
denied when their logging is set in the security policy installed on the FAST360 appliance.

Levels of IP packets logging
Three logging levels exist:
• No logging.
• Standard logging: display of main header fields, of flow rule processing the packet, etc.
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• Full logging: display of packet's content (hexadecimal format and ASCII format) added to information
of standard logging.
The logging level of a packet depends from the flow rule which takes it into account:
• Explicit rules: the logging level is defined in the flow rule (see Section 9.2, “Implicit and Explicit Filtering
Rules”).
• Implicit rules: all the rules do not log packets (see Section 9.2, “Implicit and Explicit Filtering Rules”).

Note
Regarding a rule logging and accepting the flow, only the first packet of a new connection will be
logged. Regarding a rule blocking or denying, all the packets blocked or denied will be logged.
An ICMP error message is logged according to the ICMP policy applied by the appliance. For
more details about the ICMP policy, seeSection 9.4.3, “Managing ICMP Policies”.

Detail of logged information
IP logs allow to display the following information:
• Date: date and time of the appliance at the moment where the packets arrives
• Arkoon: name of the appliance logging the packet.
• Source: source IP address.
• Destination: adresse IP destination.
• Service: service name and associated destination port.

Note
The name of the indicated service corresponds to the name of the destination port in the
services file of the administration station. For a Linux station, it is the /etc/services file. For
a Windows station, it is the C:\WINNT\system32\drivers\etc\services file.
• User: name of the appliance user.
• Action: action done on the packet (this field can be: Accepted, Blocked, or Denied).

Note
The color of the line depends on the action done on the packet: if the packet is accepted, the
line is green. If the packet is blocked or denied, the line is red.
• Protocol: name of protocol.
• Interface in: name of input interface.
• Interface out: name of output interface.

Note
In case of a VPN encrypted connection, the name of the interface is preceded by ipsec/. This
allows you to verify that a flow actually goes through a VPN.
• Flags (TCP): packet's flag, in case of TCP flow.
• Reason: in case of packet's deny, this column gives the cause.
• Description: this column provides details about the reason reported in the previous column.
• Rule name: name of flow which processes the packet.
• Translation: indicates the type of translation realized, if there is one.
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• Source IP NAT: indicates the translated IP source address, if needed.
• Source Port NAT: indicates the translated source port, if needed.
• Destination IP NAT: indicates the translated destination IP address, if needed.
• Destination port NAT: indicates the translated destination port, if needed.
• Length: packet's length (in bytes).
• Nb octets C->S: number of bytes sent by the client to the server.

Note
This value is defined when the active connection is suppressed from the table of active
connections.
• Nb octets S->C: number of bytes sent by the server to the client.

Note
This value is defined when the active connection is suppressed from the table of active
connections.
• TCP Seq: sequence number, in case of TCP flow.
• TCP Ack: acknowledgement number, in case of TCP flow.
• Source status: supposed status of the connection for the source.
• Destination status: supposed status of the connection for the destination.
• Src isn: initial sequence number of the source.
• Dst isn: initial sequence number of the destination.
• Source window: size of window for the source.
• Destination window: size of window for the destination.
• Expected NoSeq: expected sequence number.
• Expected NoAck: expected acknowledgment number.
• Date end of con: date and time of the appliance at the connection closing.
• Reason end of con: conditions in which the connection has been closed.
• IDPS Score.
• User: name of user if authenticated on flow rule.
• IDPS profile name
• IDPS profile description
• Compromised host: machine which already received IDPS matches.
• Log ID: unique identifier.

Note
The IDPS activity is viewed. Nevertheless, it is possible to choose to only view the IDPS activity
by enabling the IDPS only option. In this case, only the IDPS connections with non nil score
appear. In both cases, IDPS connections appear in bold.
You can view the detail of the matches associated with the connection as well as the detail of
corresponding signatures. Right-click the desired line and select Show IDPS matches details from the
displayed menu. The corresponding dialog box displays:
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This window permits to directly access a web page with explanations of the attack. For this, just click
the blue link in the References zone. For more details, see Section 12.2, “IDPS” and Section 18.6.9,
“Configuring IDPS Alerts”.
Besides, it is possible to view the content of a blocked packet by double-clicking it. The corresponding
window displays:
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It is possible to do a DNS resolution on the source or destination IP address. This functionality is
particularly interesting when the IP address is public.
1.

Right-click the public IP address.

2.

Click IP address resolution in the displayed menu.
The IP lookup window appears. It contains the name of the host corresponding to the public IP
address.

18.2.2. Displaying Alerts
The Alerts window allows to display the messages generated by some events ranging from an
administration connection to a protocol violation. Each message is associated with a gravity level.
From the Display menu, select Windows and then Alerts from the displayed submenu. The Alerts dialog
box displays.

Detail of logged information for each alert
This window allows to view the following information for each alert generated:
• Date: date and time of the appliance at the moment where the alert has been generated.
• Arkoon: name of the appliance concerned by this alert (this information is useful with a master/slaves
architecture where the slaves notify these alerts to the master).
• Type: the alerts are classified in categories (see the section called “Alerts meaning”).
• Level: the level indicates the gravity of the alert.
• Description: this column provides accurate information about the event corresponding to the alert.
• Administrator: this column indicates the certificate (case of Arkoon Manager or Arkoon Monitoring) or
the login (case of a connection in console mode) used by the administrator used by the administrator
to do the action which generated this alert.
A gravity level is associated with each alert . See the section called “Alerts meaning”.

Alerts meaning
The existing alerts levels are: None, Low, Medium, High:
• None: this is a simple information, there is no abnormal behavior.
• Low: this is an information which relates to an event that can have an impact on security.
• Medium: the alert indicates an event deserving to be analyzed by the administrator.
• High: the alert notifies a problem deserving to be quickly diagnosed (a corrective action must probably
be done by the administrator).

Note
In case you notify the alerts by e-mail, we advise you to select the only High alerts.
The alerts are divided as follows between the different levels:
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None:
• Internet access UP: the Internet access is operational.
• IKE alert: the VPN is established.
• Arkoon DOWN: the appliance has been switched off by one of the following means: stopping or
restarting by Arkoon Monitoring, stopping or restating in command line, stopping or restarting by short
pressure on the Power button of the case.
• Arkoon UP: the appliance has been electrically switched on (manually or after a voluntary restarting).
• Configuration installed: configuration installed via Arkoon Manager or in command line.
• Administration connection: administration connection successful.
• Creation of a new certificate: a new certificate has been created from Arkoon Manager or minarkconf.
• Date/time modified: the date and/or the time of the Arkoon has been modified from Arkoon Monitoring
or minarkconf.
• Interface DOWN: the Ethernet interface is down.
• Interface UP: the Ethernet interface is connected again.
• Interface disconnected: the ADSL (PPPoA) or ISDN interface is down.
• Interface reconnected: the ADSL (PPPoA) or ISDN is connected again.
• Database has been flushed: a log has manually been flushed with Arkoon Monitoring.
• Automatic flush and backup (table full): when the database's volume reaches 95 % of the available
space, 7 % of the database is automatically flushed.
• Admin from value modification
• Upgrade: download or upgrade correctly done.
• Certificate revoked: a certificate has been revoked via Arkoon Manager or minarkconf.
• Automatic flush and backup: backup and database flush were correct.
• Service started: one of the aklogd or mysqld services has been started.
• Service stopped: one of the aklogd or mysqld services has been stopped.
• User added or removed with minarkconf

Low:
• Encrypted file in mail
• Bad SPI: the SPI (Security Parameter Index) ID of the encrypted packet is not correct.
• New mail in quarantine
• Error while analyzing mail: the antiviral analysis did not work well.

Medium:
• IKE alert: problem while negotiating VPN tunnel.
• Authentication failure: a user failed to authenticate on a flow rule.
• Database flushed: a problem occurred during the manual flush of a log from Arkoon Monitoring.
• Automatic flush and backup (table full): when the database's volume reaches 95 % of the available
space, 7 % of the database is automatically flushed. There was a problem during flush.
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• Mail denied by applicative rule: a mail has been denied by a SMTP applicative rule.
• Packet blocked by filter: the packet has been blocked by a flow rule.
• Unsequenced packet:the packet sequence number is not correct.
• Automatic flush and backup: a problem occurred during backup or database flush.
• Application protocol violation

High:
• Internet access DOWN: the Internet access is not available.
• IKE alert: authentication failure during VPN negotiation.
• Arkoon UP: unwished restarting of FAST360 appliance.
• Administration connection: failure of administration connection (password, certificate, ...).
• HA host active: the HA appliance, previously passive, has become active
• HA host inactive: the HA appliance, previously active, has become passive.
• HA link DOWN: the link between both HA cases has been disconnected.
• HA link UP: the link between both HA cases has been connected.
• Bad packet: the packet has been blocked by a 3 or 4 level-control.
• Upgrade: problem during download or upgrade.
• Arkoon OS patch: system updated by administrator.
• Quarantine full
• Portscan
• Service restarted
• License violation
• Virus detected: virus detected by HTTP, SMTP or POP3 relay.

Display colors for alerts
The display color of the alerts within the dialog box corresponds to the filtering level:
• Black corresponds to None level.
• Brown corresponds to Low level.
• Purple corresponds to Medium level.
• Red corresponds to High level.
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Opening the IP log corresponding to the date of an alert
From the Alerts window, it is possible to open the IP log corresponding to the date of an alert.
In the Alerts window, right-click the desired alert.
Select Go to the IP logs to the date of this alert from the displayed pop-up menu:
• If the IP log is not already open, it gets open to the date of the alert.
• If the IP log is already open, it gets positioned to the date of the alert.

18.2.3. Displaying IDPS Logs
The IDPS logs window allows to view the main characteristics of the connection which released the
IDPS alert.

Filtering of connections
First select the IDPS profile which will abort a connection by using the IDPS profile drop-down menu. If
needed, define then the minimal score of the connection. For this, enable the Score min option and enter
then the score in the corresponding field.
For details, see Section 18.6.9, “Configuring IDPS Alerts”.

Details of logged information
IDPS logs allow to view following information:
• Date: date and time of the appliance when the connection aborted.
• Source: source IP address of aborted connection.
• Destination: destination IP address of aborted connection.
• Protocol: name of protocol.
• Source port
• Destination port
• IDPS profile name
• IDPS profile description
• Score end of con: score at the end of connection.
• Reaction: reaction implemented by the appliance
•

Note
IDPS logs regarding connections toward compromised hosts are displayed in purple.

Viewing of matches associated with connection
To view the details of matches associated with the connection as well as the details of the corresponding
signatures, double-click the concerned line. The corresponding details window then displays on the
screen.
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Note
This window permits to directly access a web page with explanations of the attack. For this, just
click the blue link in the References zone.

18.2.4. Displaying HTTP Relay Logs
The HTTP relay logs allow to display the details of HTTP, FTP, HTTPS and Gopher requests which are
relayed by the HTTP relay.

Details of logged information
•
•
•
•
•
•
•
•
•

Date: date and time of the appliance when the request arrives.
Arkoon: name of the appliance logging the packet.
Client IP: source IP of the client submitting the request.
User: name of user if authenticated.
Request: content of request.
Result Code: result code of request.
Reference: content of Referer header of HTTP packet.
Browser: browser used by the client, as specified in the User-Agent header of HTTP packet.
Nb bytes: size of received data in reply to the request in bytes.
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18.2.5. Displaying SMTP Relay Logs
The SMTP relay logs allow to display the detail of mails relayed by the SMTP relay.

Details of logged information
• Date: date and time of the appliance when the request arrives.
• Arkoon: name of the appliance logging the packet.
• Mail ID: identifier associated with the mail (randomly generated).
• Client IP:IP address of the SMTP client who submitted the mail.
• Origin: submitter's mail address.
• Recipients: email address(es) of the recipient(s).
• Subject: mail's object
• Nb bytes: mail's size in bytes
• Result: result of mail's processing.
This message can have the following values:
• Receipt OK (message in blue): the mail has been fully received and successfully matched the antirelaying rules (so is it in the first mail queue);
• Content OK (message in green): the mail successfully went through the applicative rules and the
anti-virus analysis (it arrived in the second mail queue);
• Relay denied (message in red): the mail has been denied by an anti-relaying rule.
• Virus detected in message: the mail is infected.
• Message denied by rule: the message has been denied by an applicative rule.
• Message denied: a problem occurred during the analysis.
• File corrected: the infected file has been repaired.
• File removed: the problematic file has been removed.
• File encrypted
• Bad file accepted
• Message size exceeds fixed limit.
• Message quarantined
• Message sent without anti-virus analysis
• Error while opening file : the message could not be analyzed.
The color of the line corresponds to the result of mail processing:
• Blue: receipt OK.
• Green: content OK.
• Black: erroneous file accepted.
• Red: all the other messages are in red because it is a question of problems or facts which must
be noticed by the administrator.
• Reason: size of received data in reply to the request in bytes.
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• Rule name

Case of an anti-relaying rule including use of DNSBL
If the mail has been processed by an anti-relaying rule including the use of DNSBL and if the address is
blacklisted, the result will appear in the Reason field of the SMTP relay logs.
The line is red and the result is Relay denied if the obtained score is greater than or equal to the configured
threshold.
The line is blue and the result is Receipt OK if the obtained score is lower than the configured threshold.
This permits to monitor the DSNBL working mode and to adjust the configuration if needed by using
Arkoon Manager.

18.3. Displaying System Logs
The Messages logs window allows to edit the last lines of the system logs and to view in real time the
new informations logged.
• messages: main system logs.
• jftpgw.log: FTP relay logs.
• jftpgw.commandlog: detail of FTP sessions going through the FTP relay.
• dmesg: kernel system logs.
• http: system logs of HTTP relay.
• mysqld.log: jsystem logs of audit database.

18.3.1. Interrupting/Starting again the Log Edition
You can interrupt the log edition for a while. This allows you to have a look at a particular line of the log.
• Interrupting the log edition: click the
has been interrupted.

icon. The icon changes into

, confirming that the log edition

Note
Interrupting the log edition does not interrupt the generation of the log and thus only concerns
the display.
• Starting again the log edition click the
edition has been started again.

icon. The icon changes into

, confirming that the log

18.3.2. Clearing the Log Content
To clear the content of the system log, click the

icon.
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18.4. Displaying Active Connections
The Active connections window allows to view the table of active connections.
•
•
•
•
•
•
•
•
•
•
•

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
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ID: identifier.
Parent ID: parent identifier (this column is only filled in if there is a secondary connection).
Creation date: appliance time and date during the active connection creation.
Protocol: protocol name.
Source IP: source IP address of the connection.
Source port: source port of the connection.
Destination IP: destination IP address of the connection.
Destination port: destination port of the connection.
Source NAT: translated source address and port.
Destination NAT: translated destination address and port.
Translation type: type of translation realized for this translation (the possible values are described
below).
• 1: masquerading by choosing the IP address which replaces the source IP address.
• 2: masquerading by using the IP address of the output interface to replace the source IP address.
• 4: static NAT.
• 32: static port translation (PAT).
• 256: local redirection (used for the transparent relay).
Client status: status of connection on client side.
Server status: status of connection on server side.
Internet access: number of Internet access used by the active connection.
IPSec tunnel C->S: VPN tunnel number when the connection is encrypted between the client and the
appliance.
IPSec tunnel S->C: VPN tunnel number when the connection is encrypted between the server and the
appliance.
Nb bytes C->S: number of bytes sent by the client to the server.
Nb bytes S->C: number of bytes sent by the server to the client.
Nb packets C->S: number of packets sent by the client to the server.
Nb packets S->C: number of packets sent by the server to the client.
Delay: timeout associated with the connection.
User name (relay): user name if the connection goes through the HTTP/FTP relay and that
authentication is requested.
User name (rules): user name if the connection goes through a flow rule which requires authentication.
User name (VPN): user name with which the VPN connection is associated (in Arkoon Manager, it is
the user login with which the certificate is associated).
Description: status of connection at the applicative level.
HA status: status of connection for an appliance (XPA range only). This parameter can have the
following values:
• 1: active (the connection is active on this appliance).
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• 2: private (the connection is local and will not be repeated when switching).
• 3: passive (the connection is passive on this appliance).
• 4: repeat (the connection has been created on the other HA appliance and has been repeated after
switching).
• IDPS Score: connection final score.
• IDPS profile name: IDPS profile name related to connection.
• Description : applicative profile name related to connection.

18.4.1. Hiding non established connections
When the table includes a huge number of active connections, it can be used to hide non established
TCP connections for more clarity. For this, activate the Hide non established connections option.

18.4.2. Delete a connection
1.
2.

From the Active connections window, select the connection to deactivate.
Click on

.

A message displays asking you to confirm the suppression of the connection.
3.

Click on Yes to confirm.

18.5. Displaying FAST360 Appliance State
18.5.1. Displaying CPU Load
To display the CPU load level, click on

, then on the CPU tab.

The graph allows to view the evolution of the CPU load during the last three minutes.
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If the CPU load is greater than 85%, there probably is a process abnormally using resources.
If it is greater than 95%, it urges to find the cause of this abnormal behavior.

18.5.2. Displaying Disk Space Use
To display the disk space use, click on

, then on the Disk tab .

The graphs allow to view the detail the occupation of the hard disk for the partitions /tmp, /config and
/var.

18.5.3. Displaying Memory Use
To display the memory use, click on

, then on Memory tab.

The graphs allow to view the detail of memory occupation (RAM, swap and total).
If the use of memory is greater than 85%, there probably is a process abnormally using resources.
If it is greater than 95%, it urges to find the cause of this abnormal behavior.
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18.5.4. Displaying Appliance Time and Date
To display time and date, click on

, then on the Time tab.

You can view the date and time of both local machines, that is to say the administration station (in the
Local machine zone) and the appliance (in the Arkoon zone).
To modify time and date:
1.

Click on the Time tab.

2.

Click Change Arkoon time. (or press Alt + O).
The Arkoon time dialog box displays. You can either enter the new time and date or activate the Set
to local time option, which sets the appliance to the same time and date than the administration
station.

3.

After you modified the time and/or date, click on Validate or press on Alt + V.

18.6. Managing Logs and Alerts
This section explains how to manage logs generated by the FAST360 appliance. There are types of
different logs (alerts, IP logs, SMTP relay logs, HTTP proxy logs), which are implicitly managed with a
database. This configuration can be modified to allow transmission to a syslog server.
The FAST360 appliance also generates system logs. These are not managed by a database, so the same
filtering and selection options available for the different logs mentioned above are not possible. However,
the system logs can be sent to a syslog server.
The following table shows the different types of logs generated by the FAST360 appliance and their
corresponding storage media.

Table 18.1. Logs Generated by the FAST360 Appliance and their Storage Media
Alerts

IP and
IDPS logs

HTTP
proxy logs

SMTP
relay logs

X

X

X

X

Syslogs

X

X

X

X

Mail

X

SNMP traps

X

Forward
to
master/AMC

X

X

X

X

Database

System logs

• Archiving
• Flushing logs
X

This section covers:
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• Accessing the database
• Managing controls on the database
• Storing logs in the database and/or a syslog server
• Exporting logs
• Flushing the database
• Configuring alerts
• Configuring IP, SMTP relay, and HTTP proxy logs
• Configuring system logs
• Configuring IDPS logs

18.6.1. Accessing the Database
The database engine is configured to only accept queries from local processes. Queries emitted from
another network station are systematically denied. The only interface conceived for accessing and
managing the database is Arkoon Monitoring .

18.6.2. Managing Controls on the Database
Integrity Control
When starting the appliance, the FAST360 appliance checks the integrity of the database.
If the base was abruptly powered down, there is a risk that it may be damaged. In such a case, the
FAST360 appliance starts with the option delay_db, that triggers the following behavior:
• The FAST360 appliance starts normally so that it does not affect the operation of the network.
• Once the startup is finished, the database repair begins; during this process, no information is logged.
• The logging resumes as soon as the base is repaired; a Service started (Service started) alert is
generated for the mysqld service.
The option delay_db as well as the option flush_db can be chosen at startup of the FAST360 appliance.
Press the Ctrl key until the following menu is displayed:
┌──────────────────────────────────────────────────────────────────┐
│ GRUB version 0.93 (639K lower / 64512K upper memory)
│
│ ┌──────────────────────────────────────────────────────────────┐ │
│ │ arkoon
│ │
│ │ arkoon flush_db
│ │
│ │ arkoon rescue
│ │
│ │ arkoon-undo
│ │
│ │ arkoon init
│ │
│ │ arkoon preinit
│ │
│ │ memtest
│ │
│ │ arkoon delay_db
│ │
│ └──────────────────────────────────────────────────────────────┘ │
├──────────────────────────────────────────────────────────────────┤
│
Use the ^ and v keys to select which entry is highlighted.
│
│
Press enter to boot the selected OS, 'e' to edit the
│
│
command before booting, or 'c' for a command-line.
│
└──────────────────────────────────────────────────────────────────┘

The option flush_db allows you to flush the entire database.
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Database Protection
As described in the section called “Protection against the Loss of Security Audit Trails”, alerts are
generated to flag an overload of the /var partition which stores the database containing the FAST360
appliance's logs. These alerts, of a progressively low, intermediate or high level depending on the
threshold reached, allow you to take the required actions early enough to prevent saturation of this
partition. See Section 18.13, “Alerts” for more information.

Note
This protection is not activated on FAST360 appliances without a hard disk as its logs are
managed by other mechanisms. The two logs generated by FAST360 appliance without a hard
disk (IP logs and alerts) are flushed at 75% when the occupation rate of the /var partition reaches
93%. The rate of deletion can be configured in the System configuration form of a log policy in
Arkoon Manager .

18.6.3. Managing and Storing FAST360 Appliance Alerts and Logs
Log policies can be used to:
• Configure the FAST360 appliance to prevent the loss of security audit trails
• Define where the alerts and the generated logs will be sent (to syslogs servers and/or into the SQL
base)

Protection against the Loss of Security Audit Trails
To prevent the loss of security audit trails, the FAST360 appliance can block non-administrative events
when it is overloaded for one of the following reasons:
• The /var is 95% full.
• The logs queue is 95% busy.
• The kernel queue is overloaded.

Note
This protection is not activated on a FAST360 appliance without a hard disk because its logs are
flushed as soon as they reach 93% of the /var partition.
In these risk cases, the FAST360 appliance blocks all network flows except for the administrative flows
authorized by the Admin from parameter of minarkconf until the situation is resolved. Therefore, the
users' actions are interrupted as long as they cannot be logged. Administrative tasks can still be carried
out from the administrator's workstation or the FAST360 terminal.

Caution
In the default configuration, this option is not activated. For optimal security, it must be activated.
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Storing Logs
The logs are implicitly sent to the SQL database, which allows them to be viewed with Arkoon Monitoring
. It is also possible to send them to a syslog server. Syslog server logs are sent in an Arkoon format
compatible with WELF (Webtrends Enhanced Log Format).
1. In the Policies explorer view, select the Log Policies folder.
2. To create a new log policy, right-click on the Log Policies folder, select New > Log Policy. The Log
Policy configuration tab is displayed on the right.
3. Select the Properties configuration form and enter a name and short description of the policy in the
corresponding fields.
4. Follow the procedure for configuring the flushing and archiving options as outlined in the section
called “Daily Flushing and Archiving”.
5. Select the Alerts configuration form:
• To send logs to the database, check the To Database option. By default, this option is checked. For
more information on configuring IP, SMTP, and HTTP logs, see Section 18.6.7, “Configuring IP, SMTP
and HTTP Logs”; for IDPS logs, see Section 18.6.9, “Configuring IDPS Alerts”.
• To send logs to a syslog server, check the To Syslog option and drag and drop the host object
corresponding to the syslog server into the Syslog servers field.

Caution
Specifying syslog servers defines an implicit rule authorizing the FAST360 appliance to send
a UDP 514 syslog flow to the selected syslog server. For more information on implicit rules,
see the section called “Implicit vs. Explicit Filtering Rules”.
6. If the FAST360 appliance is working in slave mode, check the To Master option and select the logs to
be sent to the master FAST360 appliance.

Note
You can choose to select one, several or all the different types of logs but you should take
into account the flow involved; this is particularly important in configurations with many slave
FAST360 appliances depending on the same master FAST360 appliance.

Recommended configuration for an optimal protection against attacks of the
type logs saturation
To guarantee the maximum security in case of attacks by saturation of audit trails logs, we recommend
you to configure the FAST360 appliance as follows:
• activate the option allowing the blocking of non-administrative flows;
• set up the log policy to send logs to a syslog server.

18.6.4. Exporting Logs
Logs can be exported in two different formats:
• Text format
• WELF format (Webtrends Enhanced Log Format)
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You can use the logs in WELF format using the “Firewall Sequence” module of Webtrends, from version
5.0 and up.

Manual Export
You can export some of the logs manually using Arkoon Monitoring by opening the concerned log and
clicking the icon.

Note
It is recommended that you limit the quantity of stored logs to 1 Gb on the FAST360 appliance.
Beyond that, the client can face overload problems. To limit the quantity of stored log, set
automatic and regular exports and flushing of the logs in Arkoon Manager . You can also limit
the logs to the “professional” flows.

18.6.5. Flushing the Database
There are several mechanisms to flush the database:
• Manual flush at startup of the FAST360 appliance.
• Manual flush via Arkoon Monitoring
• Daily flushing and archiving

Manual Flush at Startup of the FAST360 Appliance
To flush the entire database at startup of the FAST360 appliance, hold down the Ctrl key until the following
menu is displayed:
┌──────────────────────────────────────────────────────────────────┐
│ GRUB version 0.93 (639K lower / 64512K upper memory)
│
│ ┌──────────────────────────────────────────────────────────────┐ │
│ │ arkoon
│ │
│ │ arkoon flush_db
│ │
│ │ arkoon rescue
│ │
│ │ arkoon-undo
│ │
│ │ arkoon init
│ │
│ │ arkoon preinit
│ │
│ │ memtest
│ │
│ │ arkoon delay_db
│ │
│ └──────────────────────────────────────────────────────────────┘ │
├──────────────────────────────────────────────────────────────────┤
│
Use the ^ and v keys to select which entry is highlighted.
│
│
Press enter to boot the selected OS, 'e' to edit the
│
│
command before booting, or 'c' for a command-line.
│
└──────────────────────────────────────────────────────────────────┘

Then, enter “arkoon flush_db”

Note
The keyboard is still in “qwerty” mode.

Manual Flush Using Arkoon Monitoring
Arkoon Monitoring allows you to flush a log completely or partially by deleting the exported data.
To completely flush a log, open this log then click on the icon.
To flush the exported data, check the Delete exported data from the FAST360 appliance option.
1. To archive flushed data, check the Enable archiving of deleted logs option in the Storage folder of the
Alerts configuration form of the log policy being configured.
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2. Select the export format from the Format drop-down list.
3. Enter the number of days the archived flushed data will be kept in Arkoon Monitoring in the Keep
logs in database for field.
4. To compress the archived data, check the Enable compression option. The archive can be accessed
from Arkoon Monitoring (General information window).

Daily Flushing and Archiving
In Arkoon Manager , you can configure daily flushing and archiving of the database towards archive files
located on the FAST360 appliance. The logs' most recent entries remain accessible in Arkoon Monitoring
. The default configuration does not activate archiving and defines the daily flushing of data older than
30 days.
The archived data is accessible via Arkoon Monitoring , in the General information window. There is
one file per day. The window allows you to select and save the logs.

Note
It is recommended that you limit the quantity of stored logs to 1 Gb on the FAST360 appliance.
Beyond that, the client can face overload problems. To limit the quantity of stored logs, set
automatic and regular exports and flushing of the logs in Arkoon Manager . You can also limit
the logs to the “professional” flows.
1. In the General configuration form of the Log Policy configuration tab:
a. Check the Block non-administrative flows in case of a log storage failure option to limit the logs
to “professional”, non-administrative flows to prevent overloading of stored logs.

Note
Alerts are implicitly generated to flag an overload of the /var partition or the logs queues.
These alerts, of a progressively low, intermediate or high level depending on the threshold
reached, allow you to act quickly to avoid losing security audit trails or blocking the traffic.
See Section 18.13, “Alerts” for more details.
b. In the Archiving frequency section, define at what time the alerts and the logs will be archived.
Two configuration modes are possible:
• Check the Daily at option and enter the values in the corresponding fields for the archive to start
every day at a specific hour. For example, every day at 4 AM.
• Check the Every option and enter the values in the corresponding fields to set the archive at a more
frequent interval. For example, every 6 hours and 35 minutes.
For more information on configuring IP, SMTP, and HTTP logs, see Section 18.6.7, “Configuring IP, SMTP
and HTTP Logs”; for IDPS logs, see Section 18.6.9, “Configuring IDPS Alerts”.

18.6.6. Sending Alerts by Email or to an SNMP Server
Configuring alerts follows a similar procedure to configuring logs; however, the alerts viewed in Arkoon
Monitoring can be sent to a certain number of recipients by email or as SNMP traps to one or several
SNMP server(s).
1. In the Alerts configuration form of the log policy being configured, select whether to send the alerts
to the database or a syslog server following step 5 of the procedure outlined in the section called
“Storing Logs”.
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2. If the FAST360 appliance is working in slave mode, check the To Master option and select the logs to
be sent to the master FAST360 appliance.

Note
You can choose to select one, several or all the different types of logs but you should take
into account the flow involved; this is particularly important in configurations with many slave
FAST360 appliances depending on the same master FAST360 appliance.
3. To send alerts viewed in Arkoon Monitoring to a certain number of recipients by email, check the
To Email option.
a. Check the Handle slave alerts option to enable email recipients to receive alerts from slaves if
there is a master FAST360 appliance.
b. To create a new recipient address in the Recipients table, right-click in the blank table, select New
> Email address. A new entry appears in the table.
c. To enter the recipient's address in the table, right-click in the Email address column, select Modify
Email address and enter the email address in the available field.
d. Define in minutes the minimum amount of time between two emails in the Minimum time interval
field.
e. You can configure the source email address of these emails by editing the FAST360->Mail->Local
postmaster field.

Note
This source address will also be the one used by the SMTP relay to send notification
messages such as detection of a virus or when an email is quarantined.
f. Select the alert levels you want to notify and enter the maximum duration (in minutes) before alerts
are submitted in the Information level fields. The alert level of the Information level fields are in
ascending order.

Note
We advise you to only notify the high level alerts and to regularly connect to the FAST360
appliance via Arkoon Monitoring to view the other alerts. This way, only information
essential for security is sent.
4. To send alerts viewed in Arkoon Monitoring as SNMP traps to one or several SNMP server(s), check
the To SNMP option.
a. In the Community field, enter the category ID.
b. Drag and drop the destination hosts which will receive the alert messages into the SNMPv1
Servers or SNMPv2 Servers field. Note, the hosts have already been configured with SNMP server
capability; for more information on configuring hosts.

Note
You can find the MIBs required for the configuration of your SNMP server in the /usr/
share/snmp/mibs folder of the FAST360 appliance.

Caution
Selecting destination hosts defines an implicit rule authorizing the FAST360 appliance to
send an SNMP flow to these servers. For more information on implicit rules, see the section
called “Implicit vs. Explicit Filtering Rules”.
5. To define the frequency with which the data should be flushed, select the Storage folder, check the
Keep logs in database for option and then enter an appropriate value in the corresponding field.
6. To archive flushed data, check the Enable archiving of deleted logs option:
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a. Select the export format from the Format drop-down list.
b. Enter the number of days the archived flushed data will be kept in Arkoon Monitoring in the Keep
for field.
c. To compress the archived data, check the Enable compression option. The archive can be
accessed from Arkoon Monitoring (General information window).

18.6.7. Configuring IP, SMTP and HTTP Logs
Configuration of IP, SMTP and HTTP logs follows a similar procedure.
1. Select either the IP, SMTP or HTTP configuration form.
2. Select whether to send the logs to the database or a syslog server following step 5 of the procedure
outlined in the section called “Storing Logs”.
3. If the FAST360 appliance is working in slave mode, check the To Master option and select the logs to
be sent to the master FAST360 appliance.

Note
You can choose to select one, several or all the different types of logs but you should take
into account the flow involved; this is particularly important in configurations with many slave
FAST360 appliances depending on the same master FAST360 appliance.
4. To define the frequency with which the data should be flushed, check the Purge option and then enter
an appropriate value in the Keep logs in database for field.
5. To archive flushed data, check the Enable archiving of deleted logs option:
a. Select the export format from the Format drop-down list.
b. Enter the number of days the archived flushed data will be kept in Arkoon Monitoring in the Keep
for field.

Note
If the Keep logs in database for field contains the value 0, only events starting after
midnight on the day of the purge are kept into the database.
c. To compress the archived data, check the enable compression option. The archive can be
accessed from Arkoon Monitoring (General information window).
d. For IP logs, it is possible to archive and compress the IP packets; to do this, check the Archive
logged IPpPackets and Compress archived packets options in the IP Logs folder.

18.6.8. Configuring System Logs
As system logs are not managed by a database, the same filtering and selection options available for the
other types of logs are not possible. Instead, the system logs are sent to a syslog server in an Arkoon
format compatible with WELF (Webtrends Enhanced Log Format).
1. Select the System configuration form.
2. Check the Issue the system logs with Syslog option and drag and drop the host object corresponding
to the syslog server into the Syslog servers field. For more information on configuring hosts.
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Caution
Specifying syslog servers defines an implicit rule authorizing the FAST360 appliance to send
a UDP 514 syslog flow to the selected syslog server. For more information on implicit rules,
see the section called “Implicit vs. Explicit Filtering Rules”.
3. Enter the suppression rate of system logs in the Suppression threshold field.

18.6.9. Configuring IDPS Alerts
Intrusion Detection and Prevention System (IDPS) detects and neutralizes application layer attacks. For
more detailed information on the FAST360 appliance's IDPS, see Section 12.2.1, “Intrusion Detection and
Prevention”.
1. Select the IP configuration form.
2. To define the frequency with which the IDPS alerts should be flushed, check the IDPS Alerts option
and enter an appropriate value in the Keep logs in database for field.
3. To archive flushed IDPS alerts, check the Enable archiving of deleted logs option:
a. Select the export format from the Format drop-down list.
b. Enter the number of days the archived flushed data will be kept in Arkoon Monitoring in the Keep
for field.
c. To compress the archived data, check the Enable compression option. The archive can be
accessed from Arkoon Monitoring (General information window).
4. To define the frequency with which the IDPS alerts for matches (IDPS has detected an attack
signature) should be flushed, check the IDPS Matches option enter an appropriate value in the
corresponding field to the right.
5. To archive the flushed IDPS alerts for matches, check the corresponding Enable archiving of deleted
logs option:
a. Select the export format from the Format drop-down list.
b. Enter the number of days the archived flushed data will be kept in Arkoon Monitoring in the Keep
for field.
c. To compress the archived data, check the Enable compression option. The archive can be
accessed from Arkoon Monitoring (General information window).

18.7. SNMP Agent
18.7.1. Introduction
FAST360 appliances include an SNMP agent implementing industry-standard networking and system
MIBs, allowing appliances to be monitored by SNMP-enabled network management consoles. The
SNMP agent on the FAST360 appliance is read-only; it only accepts GET and GET-NEXT commands (so,
for example, SET requests are rejected).
Note that the FAST SNMP module can be used to filter the FAST360 appliance's own SNMP traffic.
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18.7.2. Enabling the SNMP Agent
The SNMP agent does not run by default on the FAST360 appliance; you must explicitly enable it.
1. In the Audit configuration form of the FAST360 appliance, check the SNMP Agent folder. The
parameters to be configured are displayed on the right.
2. In the Listening port field, enter the listening port number for SNMP. This must be a positive integer
less than 65535. The default value is 161 and there is normally no need to change the value.
3. In the Name field, enter the system name, up to 255 characters. This information is used for sysName
in the system group of the standard MIB and is the node's fully-qualified domain name.
4. In the Description field, enter a description of the system, up to 255 characters. This is used as
sysDescr in the system group of the standard MIB. You should include the full name and version of
the system's hardware type, its software operating system, and the networking software used. You
must only use printable ASCII characters.
5. In the Contact field, enter the name and contact details of the system administrator, up to 255
characters. This information is used for sysContact in the system group of the standard MIB.
6. In the Location field, enter a description of the physical location of the system, e.g. building, floor,
room, etc. (maximum 255 characters). This information is used for sysLocation in the system group
of the standard MIB.
For further information on the standard MIB, refer to Table 18.2, “Supported MIBs”.
7. Expand the SNMP Agent tree and select the Listening Interfaces option.
8. Drag and drop the authorized interfaces for the listening agent into the Interface field.

Note
In High Availability configurations, the SNMP agent does not support the use of the virtual
IP address of a listening interface. SNMP network management platforms must use the
real IP address. This allows for non-ambiguous monitoring of both devices, active and/or
passive, making up the HA configuration. For more information about HA configurations,
see Chapter 15, High Availability for XPA appliances. For more information about cluster
configurations, see Chapter 14, HA and HP Clustering.
9. To configure the standard MIB, see Section 18.7.3, “Configuring the Standard MIB”.

18.7.3. Configuring the Standard MIB
1. In the Audit configuration form of the FAST360 appliance, check the SNMP Agent folder and expand
the tree.
2. Select the MIBs option. The parameters to be configured are displayed on the right.
3. In the Community name field, enter the SNMP community name, using up to 255 characters (if left
blank, the MIB will not be accessible). This is the name that the network management tools will use
to communicate with the FAST360 SNMP agent.
4. Drag and drop the objects corresponding to the networks and hosts to be authorized into the
Authorized networks field.
5. In the Enable MIBs section, select the required MIB views by checking the appropriate boxes. These
are listed and described in the table Table 18.2, “Supported MIBs”.
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6. In the Average Loads section, specify the load levels for the three periods: One minute, Five minutes
and Fifteen minutes. In each case, an alert will be produced if the average load level for the given
period is at, or above, the specified value. The specified load level is a positive integer. Note that the
default settings are high, and will allow the system to become heavily loaded.

Table 18.2. Supported MIBs
View

Reference

OID

Description

System

RFC 1213

.1.3.6.1.2.1.1

Describes the system,
including hardware and
software types, where it
is located, the services
it provides, how long it
has been running, and
contact information for
the system manager.

Interfaces

RFC 1213

.1.3.6.1.2.1.2

A
table
containing
information
on
the
entity's interfaces. Each
interface is thought of
as being attached to a
“subnetwork”.

IPS

RFC 1213

.1.3.6.1.2.1.3

Contains
information
relating to IP transfers,
including counters to
follow IP datagram
exchanges.

TCP

RFC 1213

.1.3.6.1.2.1.6

Contains
information
relating
to
TCP
connections, including
imposed limits and
connection status.

UDP

RFC 1213

.1.3.6.1.2.1.7

Contains
information
relating to UDP transfers,
including counters to
follow UDP datagram
exchanges.

SNMP

RFC 1213

.1.3.6.1.2.1.11

Contains information and
statistics relating to
SNMP traffic.

Memory

UCD-SNMP-MIB

.1.3.6.1.4.1.2021.4

Contains objects that
carry
out
memory
usage monitoring and
reporting.

Processor

UCD-SNMP-MIB

.1.3.6.1.4.1.2021.2

A
table
containing
information on running
programs/daemons
configured
for
monitoring
in
the
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View

Reference

OID

Description
file of
the agent. Processes
violating the number
of running processes
required by the agent's
configuration file are
flagged with numerical
and textual errors.
snmpd.conf

Disk

UCD-SNMP-MIB

.1.3.6.1.4.1.2021.9

Disk
watching
information.
Partions
to be watched are
configured
in
the
snmpd.conf file of the
agent.

Load

UCD-SNMP-MIB

.1.3.6.1.4.1.2021.10

Average
information.

Sysstats

UCD-SNMP-MIB

.1.3.6.1.4.1.2021.11

Statistics relating to the
different parts of the
system, such as memory,
CPU usage and block
devices.

Performance

RFC 1514

.1.3.6.1.2.1.25.4

Performance metrics for
each distinct piece of
software that is running
or loaded into physical
or virtual memory in
preparation for running.
This includes the host's
operating system, device
drivers and applications.

.1.3.6.1.2.1.25.5

18.8. Reading the Logs
18.8.1. IP
Introduction
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Objective
This section introduces the IP log messages that flag problems. The information provided by Arkoon
Monitoring is located in the Reason and Description columns.

Format of this Section
This section lists, in alphabetical order, the statements that can appear in the Reason column and, for
each, provides the possible descriptions.
The situations in which these messages appear and/or the actions required to solve the problems are
described.

Message Description
LAND Attack
The blocked packet corresponds to a LAND attack: the source IP address is identical to the destination
IP address, and this is not one of FAST360's addresses.

Blocked by the Inter-application Control
The reason “Blocked by the inter-application control” means that the packet was blocked by a FAST
module. The Description column provides more details on the cause.
You will find below the list of the possible Description messages for the DNS, FTP, HTTP and SMTP
modules. In some cases, it is advisable to change the behavior of the FAST modules by re-configuring
their options (for instance, to accept a proprietary command).
FAST DNS module:
• Bad DNS packet: invalid packet
• Bad DNS Packet – too short (xx): packet too short
• DNS message too short (xx bytes): packet too short
• DNS packet denied by options: packet denied by the inter-application options
• DNS packet response without any query [id=xx]: answer without corresponding query
• DNS packet too long (xx bytes): packet too long, in the case of a UDP packet
• DNS packet too short (xx bytes): packet too short
• Decode_packet returned BAD Packet: invalid packet
• Decode_packet returned denied by options: packet denied by the inter-application options
• Wrong DNS packet [xxx]: state of the exchange invalid; this state is specified in brackets
FAST FTP module:
• (xx,xx,xx,xx,xx,xx) detected in yyy reply: information leak detected
• Can’t find command (x char): impossible to find the command
• Can’t find end of command (\n): invalid command format
• Can’t find end of command (\r): invalid command format
• Command line too long (xx bytes / max: yy): authorized maximum size reached
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• Command xxx forbidden: use of a forbidden command
• Garbage behind command xxx: no space or end of line after a command
• Invalid PASV dest IP: xx.xx.xx.xx): invalid IP address in the answer to the PASV command
• Invalid PASV dest port: xx: invalid port in the answer to the PASV command
• Invalid PASV reply: the answer to the PASV command has an invalid format
• Invalid PORT dest IP: xx.xx.xx.xx: Invalid IP address in the PORT command
• Invalid PORT dest port: xx: invalid port in the PORT command
• Invalid PORT param: invalid format of the PORT parameters
• Invalid command xxx: use of an unknown command
• No params allowed for cmd xxx: use of parameters for a command that does not accept any
parameters
• Params needed for cmd xxx: no parameter for a command requiring one
FAST HTTP module:
• Bad HTTP Version xxx: invalid HTTP version
• Bad Header xxx: wrong parameter in the header
• Client header forbidden by options: xx: forbidden parameter
• Client header line too long: at least xx bytes, max xx bytes: parameter size too long for the options
• Client header not allowed by options: xx: unauthorized parameter
• HTTP status-code too long: xx: invalid status
• Incomplete HTTP version: invalid HTTP version
• Invalid HTTP Server version: invalid HTTP version presented by the server
• Invalid method (invalid token): presence of forbidden characters in the method
• Method forbidden by options xxx: use of a method forbidden by the option methods_forbidden
• Method not allowed by options xxx: use of a method that is not authorized by the option methods_allow
• Method too long: method size too long
• Server header forbidden by options: xx: forbidden parameter
• Server header line too long: at least xx bytes, max xx bytes: size of the parameter too long for the
options
• Server header line too long: at least xx bytes, max xx bytes: unauthorized parameter
• URL too long (at least xx bytes, max=yy): URL size exceeds the limit maxsize_url
• Word (xxx) forbidden in URL: yyy: forbidden word in the URL
FAST SMTP module:
• Already got helo/ehlo: HELO/EHLO command resent
• Can’t find end of command (\n): invalid command format
• Can’t find end of command (\r): invalid command format
• Client has not said hello: begins sending an email without having used HELO/EHLO
• Command TURN forbidden: use of the TURN command
• Command line too long (xx bytes / max: yy): authorized maximum size reached
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• Command xxx forbidden: use of a forbidden command
• Forward path invalid: invalid recipient
• Garbage behind command xxx: no space or end of line after a command
• Got no MAIL FROM: email sent without transmitter
• Got no RCPT TO: email sent without recipient
• I was waiting for a reply number: xyz: answer has invalid format
• Invalid command xxx: use of an unknown command
• No params allowed for cmd xxx: use of parameters for a command that does not accept any
• Params needed for cmd xxx: no parameter for a command requiring one
• Reply too short: invalid format of the answer
• Reverse path invalid: invalid transmitter

Blocked by the Filter
If no message appears in the Description column, this means that the packet has been blocked by a
filtering rule or the ICMP policy. If the packet is blocked or rejected by a filtering rule, you see the name of
this rule in the Name column. The possible messages shown in the Description column are listed below.
Dst addr received from Internet is private
The specific packet is intended for a private address different from the FAST360's, and the option Deny
private addresses was activated on the Internet access through which the packet arrives.
Dst addr to be sent to Internet is private
The packet has a private destination address which is different from that of the FAST360 and its gateway.
The packet must go out via an Internet access on which the option Deny private addresses is activated.
ICMP not related to any connection
This is an ICMP error message that could not be related to a connection.
IP options not allowed in config
This message means that the packet has IP options but the FAST360 has been configured to block and
log packets with IP options.
The default behavior of the FAST360 removes the IP options. This operating mode can be modified via the
pseudo-file /proc/sys/arkoon/drop_ip_options. The possible values are the following:
• DROP_FLAG_NO (0): no action is taken on a packet with IP options;
• DROP_FLAG_RAZ (1): if the packet has IP options, they are removed (default value);
• DROP_FLAG_YES (2): if the packet has IP options, it is blocked and logged.
Null SPI
The FAST360 blocks the ESP and AH packets having a null SPI field (Security Parameter Index). These
packets do not correspond to a “normal” flow.
Packet outside allowed time frame
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The specific packet is related to a connection with a time limitation. The date and time of the packet are
not included in the authorized time frame.
Src addr received from Internet is private
The packet has a private source address and is intended for a private address different from that of the
FAST360, but the option Deny private addresses has been activated on the Internet access through
which the packet arrives.
Src addr to be sent to Internet is private
The packet has a private source address, is not masked with the FAST360's address and must go out via
an Internet access on which the option "Deny private addresses" has been activated.

Wrong Flags
This message appears when the TCP flags do not correspond to the current state of the active
connection.

Wrong Packet
The possible messages shown in the Description column are listed below.
Bad IP options
This message appears when the packet contains IP options with invalid values. The FAST360 checks the
validity of the size and parameters, depending on the option.
Bad TCP flags:
This message appears if the behavior of the FAST360 was modified in relation to the ECE and CRW flags.
The flags used to manage the ECN (Explicit Congestion Notification), namely ECE and CRW, are deleted.
This operating mode can be modified via the pseudo-file /proc/sys/arkoon/drop_tcp_ecncrw. The
possible values are the following:
• DROP_FLAG_NO (0): no action is taken;
• DROP_FLAG_RAZ (1): if the packet contains the ECE or CRW flags, they are removed (default value);
• DROP_FLAG_YES (2): if the packet contains the ECE or CRW flags, it is blocked and logged.
Bad TCP flags: Null TCP packet
The FAST360 blocks packets with no flag.
Bad TCP flags: Reserved flags set
The FAST360 blocks packets in which the Reserved field is used.
Bad TCP flags: Xmas packet
The FAST360 blocks packets containing the URG, PSH and END flags.
Bad TCP header: Offset too high
This message means that the value of the data offset field is greater than the size of the TCP header.
Bad TCP header: Stealth FIN
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The FAST360 blocks packets having an END flag but no ACK flag.
No connection found for TCP packet
The packet could not be related to an active TCP connection.
Undersized packet
The packet was blocked because the size of the IP packet data is less than the size of the header of the
level-4 encapsulated protocol (20 bytes for TCP, 8 bytes for ICMP, etc.).

Wrong License
The possible messages shown in the Description column are listed below.
No license
The FAST360's license is invalid and blocks the packet. In this case, the FAST360 does not block the
following flows, nevertheless:
• flows intended for the FAST360
• SNMP traps emitted by the FAST360
• connections initiated by the FAST360 for an ADSL PPTP connection, a primary/secondary connection,
a master/slave connection or a high-availability connection.
Too many IPs used
The number of IP addresses protected by the FAST360 exceeds the number of addresses authorized by
the license. The packets are accepted. You can view the IP addresses protected by the FAST360, as well
as the associated timeout, in the List of the IP addresses tab of the General Infos window.

Maximum Number of Pending Connections Reached
The packet is related to a rule on which the maximum number of pending TCP connections has been
configured. The number of pending TCP connections related to this rule has already been reached.
• To change the maximum number of pending TCP connections, refer to Section 9.3.1, “Creating an IP
Filtering Rule” .

Maximum Number of Established Connections Reached
The packet is related to a rule on which the maximum number of established connections has been
configured. The number of established connections related to this rule has already been reached.
• To change the maximum number of established connections, refer to Section 9.3.1, “Creating an IP
Filtering Rule”.

Unsequenced Packet
The sequence number of the packet is invalid: it is not between the last acknowledged sequence number
and this value increased by the size of the TCP window.
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• Check the TCP Seq, NoSeq attendu (NoSeq awaited) and Fenêtre Src (Src window) columns of the IP
logs of Arkoon Monitoring for more details on this problem.

Unsequenced ACK Packet
The acknowledgement number of the packet is invalid: it is not between the last acknowledged sequence
number and the next awaited sequence number.
• Check the TCP Ack, NoAck attendu (NoSeq awaited) and NoSeq columns of the IP logs of Arkoon
Monitoring for more details on this problem.

Encryption Problem for the Destination
The possible messages shown in the Description column are listed below.
No ipsec route available
There is no tunnel which allows the encryption of this packet.
• Check the configuration of the VPN with Arkoon Manager .
No tunnel available
There is no mounted tunnel with characteristics that allow the encryption of this packet.
• In the VPN tunnels window of Arkoon Monitoring , make sure that there is a tunnel with a topology
that corresponds to this packet and that it is correctly mounted.
Tunnel not in allowed list
There is a tunnel with characteristics that correspond to the received packet, but the filtering rule
accepting the packet does not authorize the use of this tunnel.
• Review the Encryption tab of the filtering rule accepting the packet. The selected group of tunnels is
probably not the correct one.

Encryption Problem for the Source
The possible messages shown in the Description column are listed below. All these messages are related
to packets that are associated with an active connection but do not have encryption corresponding to that
of the active connection. These messages do not appear in case of a new connection: if the encryption
of the packet does not correspond to that of the filtering rule, the rule is not applied and rules monitoring
continues.
Should be encrypted
The received packet is not encrypted but is related to an active connection that includes encryption.
Should not be encrypted
The received packet is encrypted but is related to an active connection without encryption.
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Wrong encryption
The encryption of the received packet does not correspond to that of the active connection to which it
is related.

18.8.2. IDPS
Use of Services in the Filtering Rules
The last stage of the IDPS configuration is the implementation of filtering rules using the services
embedded with applicative profiles.

Visible IDPS Information Types in Arkoon Monitoring
Alerts Window
An IDPS type alert (high level) is generated as soon as the alert's threshold is reached when "Warn only"
mode is not configured.

IP Logs Window
The IP logs window displays the following information: applicative profile's name, profile's description,
IDPS score.
You can view the IDPS activity by activating the IDPS only option. This displays only the connections
with a non-nil score and the ones towards a compromised.
The connections in bold have a non-nil score. An IDPS match is always displayed in bold. If the match's
score is not enough, the line is displayed in green (since the session is not down as long as the threshold
is not exceeded).
As soon as the alert threshold is exceeded, the connection is down (a line in red shows that the
connection is stopped).

Note
In the case of an attacked connection the following is displayed: a first line in green and bold
(showing that the active connection has encountered a signature) and an identical second line
in red and bold (showing that the match released the active response).
Right-clicking a connection in bold lists the associated matches with the details of the corresponding
signatures (see the section called “Detail of IDPS Alerts”).

Note
The IDPS score and the associated matches are displayed in the IP logs window only when the
connection is down.
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IDPS Logs Window
Note
This window only lists the connections which are down because of the IDPS. This window allows
you to follow the IDPS activity in "Active response" mode.
Each time a connection is down, you know its main characteristics: source and destination IP addresses,
source and destination ports. Double-click the line to view the matches associated with the connection
as well as the detail of the corresponding signatures (see the section called “Detail of IDPS Alerts”).
IDPS logs toward compromised hosts are displayed in purple.

Active Connections Window
The Active connections window lists the current IDPS score of the connections, as well as the name
and the description of the associated applicative profile. The connections with a non-nil IDPS score are
displayed in red.

Detail of IDPS Alerts
Double-clicking an IDPS alert (red or purple line in the IDPS logs window) displays a window detailing
its characteristics and particularly its associated matches.
The first section of the detail window contains a description of the alert in which the connection final
score is displayed among others.

Note
In the case of a compromised host, the connection end's score makes the initial score (bonus)
appear in parenthesis. For example, a 40 initial level compromised host for which the connection
is down because of a match on a signature of 50 score will have a 90 final score displayed as
follows: 50 (+40).
The following sections describe the matches associated with the alert. The source and the destination,
the time and the date of the match are indicated as well as the detail of the detected signature.

Note
In an IDPS alerts detail window, the connection's source and destination are distinguished from
the match's source and destination. Actually, a connection can be initiated by a host, then victim
of an attack from the server to which it connects. In this case, the attacked host is the source
of the connection and the destination of the match.

List of Compromised Hosts Diagnostic
This diagnostic lists the compromised hosts, as well as the last connection during which they have this
status.
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IDPS Alert Release
Visualization of IDPS Matches
The detail of the IDPS matches can be viewed in the IDPS logs window. See the section called “Detail
of IDPS Alerts” for more details.

Submit of IDPS Alerts
An IDPS alert is a high level alert. Like other high level alerts, it can be sent to mail addresses configured
in Arkoon Manager or it can be submitted as SNMP trap to the configured SNMP server.
For more details, see Section 18.6, “Managing Logs and Alerts”.

In Case of Compromised Host
As soon as an IDPS alert is generated, the destination server of the connection is considered
compromised host.
The IP address of the compromised host is listed in the title of the high level alert. You can then check
the IDPS alerts window for the matches corresponding to the attack.
You can then identify the traffic to this host since the IDPS logs to the compromised hosts appear in purple.

In 'Warn only' Mode
When the "Warn only" mode is configured, no IDPS alert is generated (no trace in the IDPS logs window).
No information is sent by mail or by SNMP trap.
Nevertheless, you can follow up the IDPS activity as described below:
• In the IP logs, view the IDPS score associated with the connection; you can filter them by activating
the IDPS only option; the associated matches can be viewed by right-clicking the line;
• In the active connections window, the lines with a non-nil IDPS score appear in red.

18.8.3. VPN
VPN Tunnels
This window lists the VPN tunnels defined on the FAST360 with their characteristics (topology, algorithms,
etc…) and their status (DOWN, UP, TRYING). It also allows to make a VPN tunnel down, as well as restarting
its negotiation.

VPN
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IP Logs
When a flow is encrypted, the interface receiving the flow is named [name of the interface]/ipsec,
like eth0/ipsec for the eth0 interface.

System Logs
The system logs allow you to view the messages emitted by the 'pluto' daemon at the moment of the
VPN negotiation. Arkoon support website (https://support-https.arkoon.net/index.php?lang=en) the most
common error messages.

Alerts
The alerts of IKE type allow you to view the events relative to the establishing of a tunnel. The low level
IKE alert indicates that a VPN is established; the Description column shows the IP address of the remote
VPN server as well as the name given to the VPN tunnels group in the configuration of the FAST360.

18.8.4. DNSBL
If the mail was processed by an anti-relaying rule including the use of the DNSBLs, and if the address is
blacklisted, the result appears in the Raison (Reason) field of the SMTP logs.
The line is red and the result is Relaying denied if the score obtained is superior or equal to the
configured threshold.
The line is blue and the result is Received OK if the score obtained is inferior to the configured threshold.

This allows you to watch the operation of the DNSBLs and to adjust the configuration if needed.

18.9. Arkoon Manager Error Messages
The error messages generated by Arkoon Manager can be of three different types:
• Information messages: a simple informational message that does not involve security or require
corrective action.
• Warnings: an indication that signals a potential problem to the Administrator.
• Errors: a serious problem that prevents the configuration from being deployed successfully on the
appliance.

18.9.1. Information Messages
"Connection warning"
"Read only authorized connection"

This message appears when another administration session is already active on the appliance.
Therefore, only read-only operations are authorized to avoid administration conflicts.
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• If you need write access, check who is currently connected to the appliance and determine with that
person which administration task should take place first.
"Upload successful"
"The configuration '�s' has been correctly uploaded"

This message indicates the successful completion of a configuration transfer from Arkoon Manager to
a connected appliance.
"Action interrupted"
"Action interrupted by user"

This message indicates that an action was interrupted upon administrator request.
"Action successful"
"The configuration '�s' has been correctly applied"

This message indicates the successful completion of a configuration installation.
"Download successful"
"The configuration '�s' has been correctly downloaded"

This message indicates the successful download of a configuration from a connected appliance to
Arkoon Manager .
"Hardware synchronization"
"Configuration has been synchronized with hardware"

This message indicates the successful synchronization of remote hardware configuration into the
currently opened security policy in Arkoon Manager .
"Information"
"You are now disconnected"

This message indicates the end of a connected session between Arkoon Manager and an appliance.
"License"
"The new license has been installed"

This message indicates the successful completion of a license installation.
"License"
"License request has been done"

This message indicates the successful completion of a license request.
"Information"
"Certificates Revocation List has been sent"

This message indicates the successful completion of the CRL distribution.
"Information"
"Snapshot report has been done"

This message indicates the successful completion of a Snapshot report request.
"Information"
"Config card has been done"

This message indicates the successful completion of a configuration card backup request.
"Coherency OK"
"The configuration is coherent and can be deployed"

This message indicates the successful completion of a configuration coherency check. The configuration
is ready to be applied on the appliances.
"Information"
"Closing this window will close all child windows"
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This message indicates to the administrator that the window about to be closed has one or more children
windows open. For instance, the administrator closes a FAST360 item window while there is still a HTTP
rule item open.
• Click Cancel to keep the window and all its children open or click Close and Continue to close all the
concerned windows.

18.9.2. Warning Messages
"Confirmation"
"This file already exist: �s. Do you really want to overwrite it?"

This message indicates that the administrator is trying to save a configuration and that this operation
will overwrite an existing file.
• Check whether you want to overwrite the existing file. Click Cancel to choose another file destination.
"Delete �s"
“You can’t delete �s. The following items are still referencing it:”

To be deleted from a configuration, an item must have no other item still referencing it. In other words,
it must not be used anywhere in the configuration.
• Use the provided list of referencing items to inspect them and remove any dependency with the item
to be removed.
"Delete �s"
"You're trying to delete this item(s) while editing it(them):"

This message indicates that the administrator is trying to delete an item from the configuration while an
edit window is still open for this item.
• Click Cancel if you want to resume editing the open item or click Close and Continue to close the open
item and delete it.
"Warning"
"You are about to download a configuration that is in old version.
Do you want to convert this file to the current application version?"

This message indicates the downloaded configuration must be converted to be processed by the current
Arkoon Manager version.
• Click Cancel if you want the configuration to be converted.
"Undo/redo conflict"
"You are trying to undo the creation of ‘�s’ while editing it"

Some undo/redo operations may conflict with currently opened items. For example, an undo/redo
operation cancels the creation of a FAST360 object while the object is open for edition.
• Click Cancel if you do not want to close the open object, or click Continue to close the open object
and perform the undo/redo operation.
"Confirmation"
"The document '�s' is not saved! Close document and lose your
modifications?"

This message indicates the administrator is closing an unsaved configuration.
• Click Cancel to keep the document opened, or click Continue to close the document and lose
modifications.
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18.9.3. Error Messages
"File error"
"This file cannot be saved �s"

This message indicates an error has occurred while saving a configuration file. This can be caused by
a hardware problem, missing disk space, etc.
• Check the destination disk or try to save to another location.
"Fail to process coherency checks"
"A critical exception occurs during coherency checks."

A software error occurred while checking the configuration coherency.
• Provide Arkoon Support with a report of the failure and, if possible, the faulty configuration.
"Error"
"Can't get users list"

This message indicates a list of users could not be retrieved from an authentication server.
• Check the authentication server definition in the configuration.
• Check that the authentication server has been correctly associated to the appliance you are
connected to.
• Check that the configuration with the authentication server has been applied so that implicit rules
authorizing connections between the appliance and the authentication server are properly activated.
"Authentication failed"
"The CA password you provided is not correct"

This message indicates that the administrator entered an incorrect password to access the Certificate
Authority.
• Enter the correct password.
"Certificate creation failed"
"The certificate's password you provided is too simple"

This message indicates that the administrator did not follow the Password Security Policy while creating
a new certificate.
• Refer to the Password Security Policy presented in the First-Time Configuration guide.
"Signature request failed"
"The signature request file you provided has been refused by the CA"

This message indicates the Certificate Authority encountered a problem while handling a certificate
signature request.
• Check the request parameters or provide a new request.
"Signature request failed"
"The signature request file you provided cannot be read."

This message indicates that Arkoon Manager encountered a problem while loading a certificate signing
request.
• Check the provided file name and location.
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"Certificate error"
"This certificate cannot be imported: �s"

This message indicates that Arkoon Manager encountered a problem while importing a certificate.
• Check the provided file name and location for the certificate.
"File error"
"This file cannot be read: �s"

This message indicates that Arkoon Manager encountered a problem while loading a file.
• Check the provided file name and location.
"Error"
"Can't launch Arkoon Monitoring tool"

This message indicates Arkoon Manager encountered a problem while launching Arkoon Monitoring .
• Check Arkoon Monitoring path and connection parameters.
"Error"
"Can't launch Arkoon Reporting tool"

This message indicates Arkoon Manager encountered a problem while launching Arkoon Reporting .
• Check Arkoon Reporting path and connection parameters.
"Upload error"
"The configuration '�s' was NOT uploaded"

This message indicates Arkoon Manager encountered a problem while uploading a configuration from
the connected appliance.
• Check Arkoon Manager is correctly connected to the appliance.
"Connection error"
"You are NOT currently connected"

This message indicates Arkoon Manager encountered a connection problem.
• Check the session parameters
• Check all network cables are properly plugged
• Check the appliance is reachable
"Apply error"
"The configuration '�s' was NOT applied"

This message indicates Arkoon Manager encountered a problem while applying a configuration. Lack
of disk space and undetected local coherency error are potential causes of such problem.
• Check there is sufficient free disk space available on the connected appliance.
• Check the console logs for detailed error descriptions.
"Document corrupted"
"The access control document '�s' is broken. Please Reset this file
from Minarkconf using the Access Control Menu."

This message indicates Arkoon Manager encountered a problem while loading an Access Control policy
configuration.
• Check for other corruption errors indicating a potential hardware problem on the appliance.
• Provide Arkoon Support with a report of the failure and, if possible, the faulty configuration.
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• Load instead a backup configuration or reset the current one as documented in the First-Time
Configuration guide.
"Document corrupted"
"The access control document '�s' is broken. Please load on another
backup file or create a new one."

This message indicates Arkoon Manager encountered a problem while loading a Security Policy
configuration.
• Check for other corruption errors indicating a potential hardware problem on the appliance.
• Provide Arkoon Support with a report of the failure and, if possible, the faulty configuration.
• Load instead a backup configuration or create a new one using Arkoon Manager .
"Download failed"
"The configuration '�s' could not be downloaded"

This message indicates Arkoon Manager encountered a problem while downloading a configuration.
• Check network connectivity between the administration station and the appliance.
"Error"
"Cannot load file �s"

This message indicates Arkoon Manager encountered a problem while loading a configuration stored
locally on the administration station.
• Check the provided file name and location.
• Check that the provided file is a FAST360 appliance configuration.
"Error"
"Can't decrypt file �s. Check password."

This message indicates Arkoon Manager encountered a problem while loading an encrypted file stored
locally on the administration station.
• Check the provided file name and location.
• Check that the provided file is a FAST360 appliance configuration.
• Check the password you provided to Arkoon Manager to load the encrypted configuration.
"File Error"
"Can't read file license."

This message indicates Arkoon Manager encountered a problem while loading a license file provided
by the administrator.
• Check the provided file name and location.
"Error"
"The license installation has failed."

This message indicates that a license installation failed.
• Check the console window for further information.
• Check the license is properly defined for the target appliance.
"Error"
"Could not save the CRL file"

This message indicates that Arkoon Manager encountered a problem while saving the CRL on the
administration station.
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• Check sufficient free disk space is available on the administration station.
• Try to save the CRL to another location.
"Error"
"Could not get the Certificate Revocation List file"

This message indicates that Arkoon Manager encountered a problem while downloading the CRL from
the appliance’s certificate authority.
• Check the appliance’s certificate authority is properly configured using minarkconf .
"Error"
"Could not read PEM file"

This message indicates that Arkoon Manager failed to read and open a PEM file.
• Check the PEM file is not corrupted.
"Error"
"Can't send Certificates Revocation List"

This message indicates that Arkoon Manager failed to distribute the CRL.
• Check the console window for further information about the failure.
• Check sufficient free disk space is available on the concerned appliance and the administration
station.
"Error"
"Support snapshot has failed"

This message indicates that Arkoon Manager could not complete a Support Snapshot request.
• Check the console window for further information about the failure.
• Check sufficient free disk space is available on the concerned appliance and the administration
station.
"Error"
"Configuration card backup has failed"

This message indicates that Arkoon Manager could not complete a configuration card backup request.
• Check the console window for further information about the failure.
• Check sufficient free disk space is available on the concerned appliance and the administration
station.
"Coherency error"
"The configuration is NOT coherent."

This message indicates that Arkoon Manager detected some coherency errors in the current
configuration.
• Use the Coherency Check window to fix remaining errors in the configuration.
"Build error"
"The configuration has errors, please fix them before deployment."

This message indicates that Arkoon Manager detected some configuration coherency errors while
preparing the configuration for deployment.
• Use the Coherency Check window to fix remaining errors in the configuration.
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"Access control error"
"You currently have no administration rights. Please, make sure your
X.509 certificate has roles associated to it in the Access Control
database."

This message indicates that the Access Control server could not find any administration right associated
to the X.509 certificate you provided to authenticate with the remote appliance.
• Check, or have a Security Officer check the rights defined for you as a FAST360 appliance administrator
in the Access Control database.
"Access Control Error"
"Arkoon Manager could not retrieve your administrator rights from the
server."

This message indicates Arkoon Manager encountered a problem while checking your administrator
rights with the server.
• Check, or have a Security Officer check that your administrator rights are properly defined in the
Access Control database.
• Check that the Access Control server is running on the remote appliance or AMC platform.
"Error"
"Communication initialization failure. Please check connection
parameters"

This message indicates Arkoon Manager encountered a problem while initializing communication with
a remote appliance.
• Check network connectivity.
• Check connection parameters in the Session object used to initialize communication.

18.10. Arkoon Authentication Error Messages
18.10.1. Introduction
Objective
This section introduces the messages that can appear in a pop-up window in Arkoon Authentication .

Format of this Section
This section lists the messages in alphabetical order. Messages that can appear during connection to
the FAST360 appliance are described in detail in Section 18.11, “Error Messages During Connection”
because they are common to Arkoon Manager , Arkoon Monitoring , Arkoon Reporting and Arkoon
Authentication . For each, the meaning of the message, the conditions in which it appears, and the action
to be taken in order to solve the problem are listed.

18.10.2. Message Description
An error occurred during data submit to the Arkoon; 'sslcom_error'

This type of message is detailed in Section 18.11, “Error Messages During Connection”.
An error occurred during the data receipt from Arkoon: 'sslcom_error'
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This type of message is detailed in Section 18.11, “Error Messages During Connection”.
Authentication failure

The authentication parameters sent to the FAST360 appliance do not correspond to a user known by
the FAST360 appliance.
• Check the parameters set in Arkoon Authentication and the user definition.
Impossible to connect to the Arkoon: 'sslcom_error'

This type of message is detailed in Section 18.11, “Error Messages During Connection”.
No CA certificate configured

The selected authentication mode is "Login/password authentication" or "PKCS#11 authentication
(Token)" but the CA certificate is not configured.
• Import the CA certificate or select another authentication mode.
No certificate usable on Token

The PKCS#11 certificate authentication mode has been chosen but there is no certificate available on
the token.
• Check that the certificate is present on the token or select another authentication mode.
No user certificate configured

The PKCS#12 certificate authentication mode has been selected but no user certificate is configured.
• Import the user certificate or selects another authentication mode.

18.11. Error Messages During Connection
18.11.1. Introduction
Objective
This section introduces the error messages that can appear while connecting to Arkoon Monitoring .

Format of this Section
This section lists the messages in alphabetical order.
For each, the meaning of the message, the conditions in which it appears and the action to be taken in
order to solve the problem, is described.

Indications
In this section, you will be instructed to create a new administration certificate. To achieve this, you
will have to use the minarkconf program. For more information on the use of this program, refer to the
Commissioning Guide.
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Also, you could be recommended to consult the FAST360's system logs to get more information. In these
cases, the problem is related to the SSL communication: if you do not have a screen and a keyboard
available on the FAST360, it is possible for you to connect in SSH. To view the system logs, you must login
and enter the following command: tail –f /var/log/messages.

18.11.2. Message Description
Can’t open PKCS#12 file ‘xxx’

The .p12 file could not be open.
• It is possible that the .p12 file was damaged. Retrieve it again. Otherwise, generate an administration
certificate using the minarkconf program.
Certificate refused: bad certificate

This message usually indicates that the administration certificate is not valid yet. In the FAST360
appliance's system logs, you must view the Verification failed: certificate is not yet valid
message.
• Check the FAST360 appliance's date. If needed, generate a new certificate with the help of the
minarkconf program.
Certificate refused: bad permissions

The PKCS#12 certificate does not have the adequate rights: to connect to the FAST360 appliance, you
must have a certificate with ADMIN rights. You can view the rights of the certificate that you use in the
lower part of the connection window.
• Generate a new administration certificate using the minarkconf program.
Certificate refused: certificate has expired

The administration certificate that you use has expired.
• Generate a new certificate using the minarkconf program.
Certificate refused: certificate has been revoked

The administration certificate that you use has been revoked.
• Generate a new certificate using the minarkconf menu.
Connection aborted

The connection initialization could not be done.
• Try to connect again. In case of failure, consult the system logs for more information.
Connection refused (‘xxx :yyy’)

The port ‘yyy’ of the machine ‘xxx’ is not open. This machine cannot be the FAST360 appliance: the
FAST360 appliance does not deny the connection if its port is not open, it does not answer and then you
get this message: Connection timed out.
• Make sure that you have specified the correct IP address.
Connection timed out
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The connection is timed out; the remote host does not answer.
• Make sure that you have specified the correct IP address.
• Make sure that the Admin from parameter of minarkconf is correct, i.e. that the authorized IP
addresses are correct and the 1750 and 1751 ports are authorized (for Arkoon Manager and Arkoon
Monitoring respectively).
Host ‘xxx’ unreachable

The FAST360 appliance is not reachable for routing reasons.
• Make sure that your administrator's workstation disposes of the required routes to reach the IP
address that you have specified.
• Make sure that the network connection of your station is correct and that the FAST360 appliance's
specific interface is correctly mounted.
Host not found ‘xxx’

The name resolution is impossible for the name that you have entered in the IP address field.
• Check the name that you have entered or specify the FAST360 appliance's IP address.
Invalid PKCS#12 file ‘xxx’

The PKCS#12 certificate that is specified is incorrect.
• It is possible that the .p12 file was damaged. Retrieve it again. Otherwise, generate an administration
certificate again on the FAST360 appliance's CA.
Verification failed: peer CA is not trusted

This message indicates that the CA that transmitted the administration certificate is not the same as the
one that emitted the FAST360 appliance's certificate.
• Use an administration certificate that was emitted by the same CA as the FAST360 appliance.
Wrong password for PKCS#12 file ‘xxx’

The password that you have entered is incorrect. Re-enter the certificate password.

18.12. Coherency Check
18.12.1. Introduction
Objective
This section presents messages that are generated while checking the coherency of the configuration.
These messages can be seen in the three following cases:
• You launch the coherency check from Arkoon Manager .
• You launch the deployment of the configuration from Arkoon Manager and a coherency check is
automatically launched.
• You launch the configuration deployment from minarkconf (Load a configuration file menu).
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Purpose of the Coherency Check
The coherency check detects most cases where:
• An object is referenced by another but has not been defined.
• A field contains an incorrect or unacceptable value.
• A functionality is defined in an incomplete or contradictory way.
• The FAST360 appliance's routing and addressing does not allow it to reach all the referenced objects.
It does not detect:
• Problems with the order of rules, including filtering rules, anti-relaying rules, applicative rules, QoS
rules.
• General problems of addressing and routing logic.

Message Types
The generated messages can be of three different types:
• Errors: a serious problem that prevents the configuration from being deployed successfully on the
appliance.
• Warnings: an indication that signals a potential problem to the Administrator.
• Information messages: a simple informational message that does not involve security or require
corrective action.

Note
Only error messages prevent the successful deployment of the configuration.

Format of the Messages
The coherency check presents the messages in the following format:
• In the Coherency check window of Arkoon Manager .
• In the Coherency check window of Arkoon Manager when you attempt to deploy a configuration
without checking its coherency first.
• In minarkconf :
WAR-000000004118 <arkoon:Arkoon update>
* You provided an internet name for the update server.
* Please provide its IP address instead, or configure at least one DNS
Server.

Each message contains:
• An unique identifier: three letters (INF, WAR or ERR) followed by 10 digits.
• The name of the object to which the message applies; if this is an object belonging to a FAST360
appliance (for instance, its Internet access), the specific FAST360 appliance is specified.
• A short description of the message.
• A longer description, in some cases, which usually indicates how to solve the problem.
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Format of this Section
This section introduces all the non-obsolete messages, classified by type and number. Each message is
listed with an explanation of its meaning as well as the action to ensure that it is not generated again.
The description of the action does not give the steps to be executed in detail.
The icon indicates that the error does not occur if the configurations management has always been done
with Arkoon Manager or minarkconf . If you did not respect FAST360 appliance's normal configuration,
you should reload a valid configuration. Otherwise, contact Arkoon support.
In case of errors followed by this icon, no other specific action is recommended.
The characters 'xxx', 'yyy' and 'zzz' designate a variable specific to the message's context.

18.12.2. Error Messages
ERR-0000000000
Unknown errror’
ERR-0000000001
Error: �s

This error occurs in specific and punctual cases. The statement ‘%s’ clearly explains the nature of the
problem.
ERR-0000000002
Cannot open the file 'xxx' (yyy)

The gencfg program cannot open the file 'xxx' with the access rights 'yyy' to achieve its task. It can be
a disk problem (full disk or damaged sectors).
• In Arkoon Monitoring , check the occupation of the disk with the State of the FAST360 appliance
window.
• Look in the system logs if there are error messages about the disk.
• Otherwise, contact Arkoon support.
ERR-0000000003
Cannot find the host '�s' (or it hasn't got any IP address)

The host '%s' is referenced but is not declared as a host in the configuration.
ERR-0000000004
'�s' needs at least one DNS server to activate the proxy

No DNS server is configured on an appliance which has its HTTP proxy or SMTP relay activated.
ERR-0000000005
You can't activate both 'Correct file' and 'Remove file"
ERR-0000000006
The object '�s' is not unique

Two objects share the same name in the configuration.
ERR-0000000007
Object '�1$s' is implicitly used but not allowed in a list of networks
or hosts.
ERR-0000000008
Invalid value '�s'='�d'
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ERR-0000000009
Invalid value '�s'='�s'
ERR-0000000010
Invalid values for processes: �d,�d,�d,�d

There are inconsistencies in the configuration related to the minimum number of pending processes,
the default number, the maximum number pending, and the maximum number of processes of the HTTP
proxy. Indeed, the minimum number of pending processes must be less than or equal to the number of
processes at the beginning, this value must be in turn inferior or equal to the maximum number of pending
processes, and this value must be in turn less than or equal to the maximum number of processes.
• Edit the properties of the HTTP proxy and change the values related to the number of processes.
ERR-0000000011
Cannot find interface '�s'

The interface '%s' is referenced but is not declared as an interface in the configuration.
ERR-0000000012
Interface '�1$s' is not enabled.

The interface '%s' is referenced but not enabled in the configuration.
ERR-0000000013
Interface '�s' has no IP address

An interface with a permanent IP address does not have a configured IP address.
ERR-0000000014
Can't find user '�s'

The user '%s' is referenced but is not declared as a user in the configuration file.
• Review the definition of the user ‘%s’.
ERR-0000000015
Cannot find the schedule '�s'

The schedule '%s' is referenced but is not declared as a schedule in the configuration.
ERR-0000000016
Time '�s' is invalid (reason)

The schedule '%s' contains invalid days or time intervals.
ERR-0000000017
Group '�s' is not a valid type (type)

An object references a group '%s' that is not of the correct type (Hosts/Networks/Appliances, Users,
Services, etc.).
• Review the definition of the group ‘%s’.
ERR-0000000018
Cannot find any preshared key in '�s'

No shared key was configured for a VPN with a shared key.
• Define a shared key and select the hosts that can use it.
ERR-0000000019
Cannot find host or appliance '�s'

An object references a host or an appliance '%s' that is not declared in the configuration.
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ERR-0000000020
Can't find host/network/appliance/user '�s'

An object references host '%s', network, FAST360 appliance or user that is not declared in the
configuration.
ERR-0000000021
Network '�s' has no VPN gateway

A network is used to define a VPN tunnel, but no VPN gateway is defined for this network.
• Define the VPN gateway of the network ‘%s’: this is the host or the FAST360 appliance that will be the
VPN server for the targeted VPN.
ERR-0000000022
Both sides ('xxx' and 'yyy') are local for appliance 'zzz'

Both tunnel-end network objects, 'xxx' and 'yyy', are local networks for appliance 'zzz'. Defining a tunnel
in this case is meaningless (it would be encrypted from appliance 'zzz' to itself).
• Review the definition of the group of VPN tunnels and the VPN gateways of the selected networks.
ERR-0000000023
Appliance '�1$s' has no RSA key

A tunnel with RSA authentication is configured, but appliance '%1$s' ' has no RSA key defined.
• Enter the appliance's RSA key in the VPN form.
ERR-0000000024
Appliance '�s' has no X.509 certificate

A tunnel with X.509 certificate authentication is configured, but the appliance '%s' has no X.509 certificate
defined.
ERR-0000000025
Invalid X.509 certificate: �s

An X.509 certificate's string found in the configuration is invalid or incomplete. Information %s might be
missing (Subject, Public key, etc.).
• Import the X.509 certificate again.
ERR-0000000026
Interface '�s' can't have any alias

An alias was configured on an interface '%s' which is of type ADSL or Cable.
ERR-0000000027
Can't find interface or host '�s' (or host hasn't got any IP address)
ERR-0000000028
Gateway '�s' is unreachable

The gateway '%s', defined for an appliance's Internet Access, cannot be reached from the appliance.
No corresponding network is configured on the appliance.
• Check the definition of the interfaces and the Internet Access: the gateway selected for the Internet
access must be in the same addressing plan as the appliance.
ERR-0000000029
No user/password specified for the interface '�s'

No user/password is specified for the ADSL interface '%s'.
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• Edit the characteristics of the interface, and enter the user name and the password.
ERR-0000000030
Bad system name for interface '�1$s' (�2$s expected)

The name of the interface '%1$s' is not consistent with its type. It should be in the format '%2$s'.
ERR-0000000031
No modem specified for the interface '�1$s'

ADSL interface '%1$s' is configured without modem information: in in PPPoE, the interface related to the
modem must be provided; in .
• PPTP: the IP address of the modem must be provided;
• PPPoE: the interface related to the modem must be provided;
• PPPoA: the VPI and VCI parameters must be specified
• Specify the required information for the ADSL interface '%1$s'.
ERR-0000000032
Interface '�s' mustn't be enabled to use the modem

Interface '%s' specified for a Cable interface is activated whereas it should not.
ERR-0000000033
Choose between PPPoE or PPTP for ADSL modem
ERR-0000000034
Can't reach modem '�1$s'

IP address '%1$s'' of the ADSL modem does not belong to any of the appliance's configured networks.
• Change the address of the modem specified in the ADSL interface in PPTP or the address of the
interface linked to the modem, so that both these addresses are on the same network.
ERR-0000000035
Remote phone number missing
ERR-0000000036
Maximum number of IPsec interfaces (�d) reached

The IPsec object has more configured interfaces than allowed.
• There cannot be more than 4 interfaces that manage a VPN end.
ERR-0000000037
Interface name is too long (maximum length is �d)
ERR-0000000038
Can't find network '�s'

An object references network '%s' that is not defined in the configuration.
ERR-0000000039
Connected network '�s' is invalid on this interface

Network 0.0.0.0/0 was specified as a network connected to this interface. This is not compatible with the
generation of the antispoofing rules.
• Delete network 0.0.0.0/0 from the list of networks connected to the interface.
ERR-0000000040
Roadwarriors can't have static NAT enabled
ERR-0000000041
Can't find the appliance performing static NAT
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ERR-0000000042
Static NAT IP address (�s) is already used by one of the appliance's
interfaces
(�s:�s)
ERR-0000000043
The IP address �s, defined in static NAT or Port Translation,
is not defined on the appliance's interfaces
ERR-0000000044
Port translation interface xxx:yyy is not valid (not found or not
enabled)

A filtering rule contains a port translation by interface. The interface 'yyy' is not configured correctly or
does not belong to appliance 'xxx'.
• Edit the characteristics of the interface or include the interface object in the appropriate field of the
configuration.
ERR-0000000045
Service '�s' used in rule '�s' for Port Translation is invalid
(only TCP or UDP allowed)

A port translation cannot be performed with a protocol that is neither TCP nor UDP.
• Use static NAT to translate non-TCP/UDP traffic.
ERR-0000000046
Too many NAT entries for '�1$s' in rule '�2$s'

A filtering rule requires several port or masking translations on the same appliance.
ERR-0000000047
Can't find host/network/appliance '�s'

An object references host, network or appliance '%s' that is not defined in the configuration.
ERR-0000000048
Encryption entry contains '�s' in source AND destination

A filtering rule is configured with appliance '%s' as both source and destination of an encryption rule. An
appliance cannot be the start and the end of a VPN tunnel at the same time.
ERR-0000000049
Too many encryption entries with '�s' in source

A filtering rule is configured in which appliance '%s' is defined as the source of several encrypted
segments. This is not possible.
• Modify the encrypted segments table of the filtering rule so that the appliance is the beginning of a
single tunnel.
ERR-0000000050
Too many encryption entries with '�s' as destination

A filtering rule is configured in which appliance '%s' is defined as the destination of several encrypted
segments. This is not possible.
• Modify the encrypted segments table of the filtering rule so that the appliance is the end of a single
tunnel.
ERR-0000000051
Host '�1$s' with no static IP address is not allowed in rule '�2$s'

A host with no static IP address defined was selected in a filtering rule as a source or destination. This
is not allowed.

400

| Error Messages

Chapter 18. Monitoring, Logging, Error Messages

ERR-0000000052
Host 'yyy' (xxx) unreachable by 'zzz'

Object 'yyy' IP address 'xxx' cannot be reached by appliance 'zzz'. No suitable interface was found.
• Check the definition of the appliance's interfaces, routes and Internet Access.
ERR-0000000053
Network '�s' (�s/�d) unreachable by '�s'
ERR-0000000054
Can't find service '�s'

Service '%s' is referenced by an object of the configuration but it is not defined.
ERR-0000000055
Can't find Internet Access '�s'

Internet Access '%s' is referenced by an object of the configuration but it is not defined.
ERR-0000000056
Port translation incompatible with static NAT (host �s)
ERR-0000000057
Rule '�s' with port translation requires a destination

A filtering rule with port translation requires a unique service defined with a unique port and a unique
destination.
• Specify a host in the destination of the filtering rule.
ERR-0000000058
Rule '�s' with port translation requires a service

A filtering rule with port translation requires a unique service defined with a unique port and a unique
destination.
• Specify a service in the filtering rule. This service must rely on TCP or UDP protocol and use a single
port.
ERR-0000000059
Rule '�s' with port translation requires a service with no port range

A filtering rule with port translation requires a unique service defined with a unique port and a unique
destination.
• Choose another service or change the definition of the selected service.
ERR-0000000060
Can't find IPsce VPN connection '�s'

A filtering rule references a group of VPN tunnels that does not exist.
ERR-0000000061
Static NAT IP address (�s) is already used (by static NAT or port
translation)
ERR-0000000062
Port translation with no IP address or interface on '�s'
ERR-0000000063
Unable to handle an appliance other than myself (stranger appliance is
'�s')
ERR-0000000064
Invalid frequency: �s

The frequency of a task (updates, mails retransmission, etc.) is invalid. '%s' indicates which field is invalid.

Error Messages

| 401

Chapter 18. Monitoring, Logging, Error Messages

ERR-0000000065
Interface netmask can't be 0.0.0.0

A null netmask was specified for an interface subnetwork.
• Specify a non-null netmask for the interface subnetwork.
ERR-0000000066
Keyword(s) missing

Information is missing to correctly generate the configuration of the HTTP proxy.
ERR-0000000067
Unknown authentication server type for '�s'

An appliance's authentication server has an unknown type. Known types are: "nt", "ldap" and "radius".
ERR-0000000068
Can't find gateway '�s'

An Internet Access object or a Route object references a gateway host that is not defined.
ERR-0000000069
Roadwarrior '�s' not allowed in a route

A route to a nomad '%s' was configured. This is not allowed.
• Create an Internet access to define access to an unknown address.
ERR-0000000070
Internet Access '�s' has no gateway

An Internet Access of type LS/router was configured without a gateway. Specify a gateway.
ERR-0000000071
Roadwarrior ''�s' ' not allowed as gateway

A nomad ''%s' ' without known address cannot be declared as the gateway of an Internet Access or a
static route.
ERR-0000000072
Invalid Internet access '�1$s'

• Check the Internet access parameters.
ERR-0000000073
The appliance has no main Internet access
ERR-0000000074
Interface '�1$s:�2$s' must be an IPSec interface to be used with '�3$s'

A group of VPN tunnels requires interface '%2$s' of appliance '%1$s' to be an IPsec monitoring interface.
• Select interface ‘%2$’ in the monitoring interfaces of the VPN form of the appliance ‘%1$s’.
ERR-0000000075
Can't find the host/appliance/user '�s'

An object (probably a shared key) references a FAST360 appliance, a host or a user which is not defined.
ERR-0000000076
Host '�1$s' has no RSA key

VPN server ‘%1$s' has no RSA key defined but is configured in a tunnel with RSA authentication.
• Change the authentication type in the group of VPN tunnels or enter the RSA key for the host.
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ERR-0000000077
Host '�s' has no X.509 certificate

VPN server '%s' has no X.509 certificate defined but is configured in a tunnel with X.509 certificate
authentication.
• Change the authentication type of the group of VPN tunnels or define an X.509 certificate for the host.
ERR-0000000078
Can't use IP address for the certificate ID if there is no IP address
in host '�s'

The Custom IPsec ID option was enabled on a host defined as a nomad station.
• Uncheck the option or assign an IP address to this host.
ERR-0000000079
IPsec VPN not enabled on '�s'

An IPsec tunnel is configured from appliance '%s' but '%s'’s VPN module is not enabled.
• Enable '%s'’s VPN module.
ERR-0000000080
Roadwarrior '�s' not allowed in the "allow from" rule

It is not possible to select a nomad host in the authorized VPN servers list.
• Select a 0.0.0.0/0 network object instead of the nomad in the authorized VPN servers list.
ERR-0000000081
Appliance '�s' not allowed in "allow from" rule (it's me!!!)

An appliance was selected in the VPN servers list of its own VPN module, which triggers the creation of
an implicit rule from the appliance to itself. This is not allowed.
ERR-0000000082
User '�s' has no X.509 certificate

User '%s' has no X.509 certificate defined but is configured in a tunnel with X.509 certificate
authentication.
• Import a X.509 certificate and associate it with user ‘%s’.
ERR-0000000083
Service '�s' can't be used in bandwidth limitation because it uses a
port range
ERR-0000000084
Can't find Internet access '�s:�s'

An Internet Access was selected in a filtering or bandwidth rule but it is not defined.
ERR-0000000085
Couldn't create directory '�s'
ERR-0000000086
Couldn't remove directory '�s'
ERR-0000000087
Couldn't erase table '�s' from the database
ERR-0000000088
Couldn't initialize database '�s'
ERR-0000000089
Couldn't connect to database '�s'
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ERR-0000000090
Bad category name '�s'; only [a-z] [A-Z] [0-9] '_' characters are
allowed

Category name '%s' does not comply with known syntactic rules.
ERR-0000000091
Object 'xxx' unreachable by 'yyy'

Object 'xxx' is not reachable from appliance 'yyy'.
• Review the definitions of interfaces and routes on appliance ‘yyy’. It is likely that an Internet access
is missing.
ERR-0000000092
Invalid RSA key '�s'

The format of a VPN server’s authentication RSA key is invalid: odd length, key too short, invalid format.
• Import the RSA key of the VPN server again.
ERR-0000000093
Rule '�s': can't find group '�s'
ERR-0000000094
Can't find rule '�s'
ERR-0000000095
Appliance '�s' unreachable by '�s'
ERR-0000000098
Your license doesn't allow you to enable '�s' (flag '�s')

You must have a suitable license in order to activate some functions.
ERR-0000000099
FAST policy must be POP3.

A service object is configured with a redirection to the POP3 proxy but selected FAST policy is not POP3.
ERR-0000000100
Proxy POP3 AV must be enabled on at least one appliance -- rule 'xxx',
service 'yyy'

Filtering rule ‘xxx’ specifies a service ‘yyy’ using a redirection to the POP3 proxy, whereas no POP3 proxy
is enabled.
• Enable and configure a POP3 proxy or delete the redirection to the proxy in the POP3 service.
ERR-0000000101
Provide only file types to be analyzed or only file types that should
not be analyzed
ERR-0000000102
'�1$s' is not an NT Domain server

Authentication server '%1$s' specified as a PDC for the appliance is not declared as an NT authentication
server.
ERR-0000000103
No Primary Domain Controller defined. Choose the Primary Domain
Controller of the NT Domain the appliance should join.

If NT authentication servers are selected for an appliance, a main PDC must be selected from these
servers.
ERR-0000000104
Authentication server �s not found.
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The authentication server '%s' is configured as a PDC for an appliance but it is not defined in the
configuration.
ERR-0000000105
Encryption and Internet Access are not compatible on the same
appliance (�s)
ERR-0000000106
POP3 proxy can't correct bad files when it is configured in
synchronous mode
ERR-0000000107
Quarantine option must be enabled to create rule �s

Applicative rule '%s' on the appliance's SMTP relay requires email quarantining although quarantining
is not activated on the relay.
ERR-0000000108
You cannot activate both quarantining and the 'remove_file' option
ERR-0000000109
The pre-shared key of community '�s' contains invalid characters
(double-quote character not allowed)

A shared key contains the invalid character " (quotation mark).
• Use characters other than " as a shared secret.
ERR-0000000110
ICMP policy not found

The object specified as the appliance's global ICMP policy is not defined in the configuration.
ERR-0000000111
Rule '�s' with port translation enabled requires a unique destination

A filtering rule with port translation requires a unique service defined with a unique port and a unique
destination.
• Specify a single host as the destination filtering attribute.
ERR-00000000112
Rule '�s' with port translation enabled requires a unique service

A filtering rule with port translation requires a unique service defined with a unique port and a unique
destination.
• Specify a single service as the service filtering attribute.
ERR-0000000113
Lifetime of �s keys is too big is '�s'. Current �d, maximum �d.

The lifetime defined for the IKE or IPsec keys of a VPN tunnel is too long. Maximum value is 28,800 s.
ERR-0000000114
Lifetime of �s keys is too small (according to rekeymargin and
rekeyfuzz).
Current �d, minimum �d.

The lifetime defined for the IKE or IPsec keys of a VPN tunnel is too short. Minimum value depends on
the time interval before renegotiating and the stochastic negotiating range: Min = Time interval before
Renegotiating * (100 + Range) / 100.
ERR-0000000115
No default message provided to redirect HTTP error codes

Error codes redirection on an appliance's HTTP proxy uses a default message that is not defined in the
configuration.
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ERR-0000000116
Maximum bandwidth is greater than 100�

The maximum bandwidth configured in a bandwidth rule exceeds 100%.
ERR-0000000117
Bandwidth reservation is greater than bandwidth limitation

In a bandwidth reservation rule, the minimum bandwidth configured exceeds the maximum configured.
• Change the bandwidth limitation/reservation parameters so that the minimum is less than the
maximum.
ERR-0000000118
Remove < and > characters in anti-spam rule "�s", address:"�s"

Email addresses in the SMTP relay's anti-relaying rules must not be defined between the characters '<'
and '>'.
• Correct the email addresses definitions.
ERR-0000000119
Domain name for LDAP server '�s' is required in secure mode.
ERR-0000000120
HTTP proxy must be enabled -- rule '�s', service '�s'
ERR-0000000121
Interface '�1$s:�2$s' must be an IPSec interface to be used with
roadwarrior '�3$s'
ERR-0000000122
The anti-relaying rule '�s' uses DNSBL but this feature has not been
enabled

You must configure the DNSBL functionality to use it in the anti-relaying rules.
ERR-0000000123
Unknown system alert type for '�s'

Defined system monitoring types are "Internet access", "Interfaces" and "HTTP proxy".
ERR-0000000124
HTTP proxy is not available on appliances without hard disk

HTTP proxy is enabled on an appliance without hard disk. This is not supported.
ERR-0000000125
SMTP relay is not available on appliances without hard disk

SMTP relay is enabled on an appliance without hard disk. This is not supported.
ERR-0000000126
POP3 relay is not available on appliances without hard disk

POP3 proxy is enabled on an appliance without hard disk. This is not supported.
ERR-0000000127
Bad VLAN interface name, should be '�1$s' instead of '�2$s'

The name of the VLAN interface must be of the format ethx.y, where x is the name of the interface and
y is the VLAN ID.
ERR-0000000128
Bad VLAN ID. ID must be between 0 and 4095

The VLAN ID must be between 0 and 4095 inclusive.
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ERR-0000000129
No '�s' interface found

The ‘%s’ interface is bridged but has not been defined.
ERR-0000000130
Bad '�s' interface type

It is not possible to bridge interfaces which are not of the Ethernet type.
ERR-0000000131
'�s' interface is not a bridged interface

The ‘%s’ interface is bridged but does not show the corresponding characteristics.
ERR-0000000132
Only one bridge can be configured

It is not possible to define several bridge interfaces on an appliance.
ERR-0000000133
Cannot use bridged interface '�s'

A module cannot use an interface included in a bridge interface.
ERR-0000000134
A bridge requires at least 2 interfaces
ERR-0000000135
When using a shadow bridge, a route to the bridged networks via �s
must be created

In the case of a bridge interface in furtive mode, it is necessary to create a static route to route the
addresses of the bridged networks to the br0 bridge interface. This route permits an appliance to manage
fragmented packets or to submit TCP RST packets in the case of protocol violation.
ERR-0000000136
Speed can't be specified for interface '�s' (�d)

It is not possible to select a speed on this type of interface.
ERR-0000000137
Unknown interface speed: '�s'

The defined interface speed is unknown.
ERR-0000000138
User '�1$s' has no X.509 certificate or no DN configured

The user selected in the VPN tunnel has no means of authentication.
• Associate a certificate or a DN with the user.
ERR-0000000139
Group '�1$s' used in IPsec VPN rule has no DN

The ‘%1$s’ user group selected in the group of VPN tunnels has no specified DN.
• Specify the DN of the ‘%1$s’ user group.
ERR-0000000140
Can’t find certificate ‘�s’

The certificate object cannot be found in the configuration.
ERR-0000000141
No cRLDistributionsPoints extension found in certificate ‘�s’
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Certificate '%s' does not contain the X.509v3 cRLDistributionPoint field. This field is required to configure
the retrieval of the CRL.
ERR-0000000142
LDAP groups in IPsec VPN requires a LDAP server as authentication
server

If you select an LDAP group in the group of VPN tunnels, you must select the “Authentication Server”
object representing the LDAP server in the Authentication form in the Security configuration form of the
appliance.
ERR-0000000143
DHCP-over-IPsec selected but no DHCP server has been set

The group of VPN tunnels specifies the Enable DHCP over IPsec option but no DHCP server is specified
in the VPN configuration form of the appliance.
• Select the VPN Policy object configured with a DHCP server (in the Settings configuration form) in the
VPN Policy field of the VPN form of the appliance.
ERR-0000000144
Interfaces '�1$s' and '�2$s' belong to the same IP network

Two different interfaces cannot have an IP address on the same logical subnetwork.
• Modify the addressing and/or the mask of one of the interfaces, or configure a bridge interface.
ERR-0000000145
Parse error in local IDPS database

One of the IDPS custom signatures causes an internal syntax error in the IDPS signatures database.
• Check the conformity of your custom IDPS signatures and profiles.
ERR-0000000146
Parse error in IDPS database
ERR-0000000147
Error while parsing hardware and system configuration
ERR-0000000148
Signature �s uses an applicative state not implemented on this
appliance (�s)

One of the IDPS signatures uses a protocol state which is not implemented.
• You probably have appliances of different versions and are using an IDPS base which is too recent
an appliance's version.
ERR-0000000149
Authentication server �s is defined by name but you didn't specify any
DNS server

LDAP server ‘%s’ is identified by a DNS name, but no DNS server is configured on the appliance.
ERR-0000000150
Bonded interface '�s' is already in use. It should be disabled before
being bonded.

Interface %s is configured, and the administrator attempts to aggregate it.
ERR-0000000151
Interface �s is bonded twice or more

An interface cannot be aggregated several times.
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ERR-0000000152
Bad type of VLAN primary interface: �s

The primary interface of a VLAN interface is not of the Ethernet or Bonding types.
ERR-0000000153
Can't find VLAN primary interface for '�s'

The primary interface of the configured VLAN interface cannot be found.
ERR-0000000154
VLAN ID �d is already in use

A VLAN ID is used several times for the same interface.
ERR-0000000155
Bad primary interface '�s' type for bridged VLAN interface '�s'

The primary interface of a bridged VLAN interface is a bonding interface.
ERR-0000000156
No bonded interface

A configured bonding interface has no aggregated interface.
ERR-0000000157
Profile '�s' does not exist

Authentication profile ‘%s’ is not defined in the configuration although it is referenced by another object.
ERR-0000000158
Server �s not found

An authentication profile refers to server %s which is not defined in the configuration.
ERR-0000000159
Rule �s not found

An authentication profile refers to rule %s which is not defined in the configuration.
ERR-0000000160
FTP proxy is not available on appliances without hard disk

FTP proxy is enabled on an appliance without hard disk. This is not supported.
ERR-0000000161
'�1$s' is a bridged VLAN primary interface

The primary interface of a VLAN interface should not be bridged.
ERR-0000000162
'�1$s' is a bonded VLAN primary interface

The primary interface of a VLAN interface should not be bound.
ERR-0000000163
Bad interface '�s' type.

Only Ethernet interfaces can be bound.
ERR-0000000165
The interface name must be shorter than 16 characters.
Please choose a lower VLAN ID, or delete aliases

The interface name has more than 16 characters (version 3.1/1 and above only).
ERR-0000000166
Antispam filtering has been enabled on the SMTP proxy but no antispam
configuration has been defined for '�s'
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You need to configure antispam (either an heuristic or real-time antispam engine) before it is enabled.
ERR-0000000167
Antispam filtering has been enabled on the POP3 proxy but no antispam
configuration has been defined for '�s'

You need to configure antispam (either an heuristic or real-time antispam engine) before it is enabled.
ERR-0000000168
Antispam filtering can't be enabled on the POP3 proxy configured in
synchronous mode for '�s'

Antispam cannot be used on POP3 proxies in synchronous mode. Configure the proxy to operate in
asynchronous or hybrid mode.
ERR-0000000169
Bandwidth management can only be applied on Ethernet and Bonding
interfaces

Other interface types do not allow bandwidth management.
ERR-0000000170
'�s' doesn't have nominal bandwidth

For filtering rules to operate correctly on an Ethernet interface or an Internet access point, you need to
assign a nominal bandwidth to the access or interface.
ERR-0000000171
An appliance requires at least one DNS server to enable DNS-based
antispam filtering

Configure at least one DNS server for use by the appliance.
ERR-0000000172
Object '�s' used as remote entity is local for '�s' (star center)

Objects that are local to the hub of a VPN star topology cannot be defined as remote objects.
ERR-0000000173
Cannot use bonded interface �s
ERR-0000000174
SAt least one host must be selected in '�s'

You must select at least one host in an interface or Internet Access system monitoring object.
ERR-0000000175
Dynamic routing is enabled, static routes must be set up with Quagga

When dynamic routing is enabled, static routes must be configured through Quagga rather than Arkoon
Manager .
ERR-0000000176
RIP routing protocol cannot be enabled on appliances in a HA cluster
ERR-0000000177
Multicast must be enabled on a listening RIP or OSPF interface �s

When a dynamic routing protocol is used, multicast must be authorized on the RIP and OSPF listening
interfaces.
ERR-0000000178
A disclaimer must be defined in the SMTP relay properties to be used
in the SMTP applicative rule '�s'

A protocol rule requires a disclaimer to be added, while the latter is not configured in the SMTP relay
properties.
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ERR-0000000179
The specific IP address (�s/�d) set on interface '�s' is not in the
same subnet as the primary IP address

Specific IP addresses assigned by appliance ID must be in the same subnet as the primary IP address.
ERR-0000000180
HA real interface �s and virtual interface �s have the same IP address
ERR-0000000181
LDAP groups handling in PKI requires an LDAP server in PKI object or
as authentication server
ERR-0000000182
�s proxy can't have a listening ADSL interface
ERR-0000000186
No HA real interface found
ERR-0000000187
No defined key in preshared key object
ERR-0000000188
Can't find interface or Internet Access '�1$s'
ERR-0000000189
External antispam quarantine is enabled, but no mailbox address is set
ERR-0000000190
Aliases '�1$s' and '�2$s' have identical IP address
ERR-0000000191
Interface '�1$s' and alias '�2$s' have identical IP address
ERR-0000000192
No Internet Access defined in system monitoring '�s'
ERR-0000000193
No interface defined in system monitoring '�s'
ERR-0000000194
Host '�1$s' does not have DNS capability enabled
ERR-0000000195
Host '�1$s' does not have NTP capability enabled
ERR-0000000196
RSA key string has odd size in object '�s'
ERR-0000000197
RSA key is too short in object '�s'
ERR-0000000198
RSA key must be in hexadecimal in object '�s'
ERR-0000000199
Interface '�s' is already used by a bridge interface.
ERR-0000000200
No appliance defined in NAT entry for rule '�s'
ERR-0000000206
No network object is defined for SNMP manager
ERR-0000000207
Cannot use a SNMP listening ADSL or Bridge interface '�s' on HA node
ERR-0000000208
Host '�1$s' does not have SNMP �2$s capability enabled
ERR-0000000209
IPsec VPN is enabled but no policy is defined for '�s'
ERR-0000000210
No community defined for IPsec VPN tunnel '�s'
ERR-0000000211
No update server
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ERR-0000000212
Host '�1$s' has no Update server capability
ERR-0000000213
Update server is configured to use a HTTP proxy but no proxy is defined
ERR-0000000214
Update is enabled but no policy is defined for '�s'
ERR-0000000215
External PKI is enabled but no PKI is defined
ERR-0000000216
No gateway is defined for this static route '�s'
ERR-0000000217
No destination is defined for this static route '�s'
ERR-0000000218
Host '�1$s' does not have Syslog capability enabled
ERR-0000000219
Host '�1$s' does not have FTP proxy capability enabled
ERR-0000000220
No server defined for FTP authentication in '�1$s'
ERR-0000000221
Host '�1$s' does not have HTTP proxy capability enabled
ERR-0000000222
Filtering is enabled on '�1$s' but no server is defined
ERR-0000000223
Proxy chaining does not have any proxy defined
ERR-0000000224
Proxy chaining does not have any destination defined.
ERR-0000000225
No object defined for route with domain '�s'
ERR-0000000226
Rejecting mails with maximum file size criteria is not allowed in rule
'�s'
ERR-0000000227
Cannot use keywords in accept rule '�s'
ERR-0000000228
Antispam is enabled but no policy is defined for '�s'
ERR-0000000229
Host '�1$s' does not have spamd server capability enabled
ERR-0000000230
'�1$s' (0.0.0.0/0) not allowed in antispam black/white list for
appliance '�2$s'
ERR-0000000231
No spamd server defined for '�s'
ERR-0000000232
No certificate defined in spamd configuration for '�s'
ERR-0000000233
Host '�1$s' has no router capability enabled
ERR-0000000234
Host '�1$s' has no ICAP server capability enabled
ERR-0000000235
Host '�1$s' has no LDAP server capability enabled
ERR-0000000236
Host '�1$s' has no NT server capability enabled
ERR-0000000237
Host '�1$s' has no RADIUS server capability enabled
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ERR-0000000238
Network interface '�s' does not belong to appliance '�s'
ERR-0000000239
Internet Access '�s' does not belong to appliance '�s'
ERR-0000000240
No appliance defined for static NAT in object '�1$s'
ERR-0000000241
IDPS profile '�1$s' is empty
ERR-0000000242
IDPS profile '�1$s' references itself
ERR-0000000243
IDPS profile '�1$s' seems to have an inclusion loop
ERR-0000000244
IDPS profile '�1$s' uses an empty profile ('�2$s')
ERR-0000000245
Host '�1$s' has no PPTP modem capability enabled
ERR-0000000246
Host '�1$s' with '�2$s' capability must be statically addressed
ERR-0000000247
Host '�1$s' with '�2$s' capability must be identified by a FQDN
ERR-0000000248
Host '�1$s' with '�2$s' capability must be identified by an IP address
or a FQDN
ERR-0000000249
No appliance defined for static NAT in network '�1$s'
ERR-0000000250
Missing MAC address for host '�1$s'
ERR-0000000251
DHCP server and relay cannot be both active at the same time on
appliance '�1$s'
ERR-0000000252
DHCP server is enabled on appliance '�1$s', and it uses a VPN policy
in which DHCP is enabled
ERR-0000000253
Incorrect global DHCP server lease settings
ERR-0000000254
Incorrect lease settings in DHCP server pool '�1$s'
ERR-0000000255
The host '�1$s' must be either defined as a static host or excluded
from pool '�2$s', as it is configured as a DNS server in that pool
ERR-0000000256
The host '�1$s' must be either defined as a static host or excluded
from pool '�2$s', as it is configured as an NTP server in that pool
ERR-0000000257
The host '�1$s' must be either defined as a static host or excluded
from pool '�2$s', as it is configured as a WINS server in that pool
ERR-0000000258
The host '�1$s' must be either defined as a static host or excluded
from pool '�2$s', as it is configured as the default gateway in that
pool
ERR-0000000259
No interface is configured within the subnet of DHCP server pool '�1$s'
ERR-0000000260
The range of IP addresses '�1$s'-'�2$s' defined for DHCP server pool
'�3$s' is invalid

Error Messages

| 413

Chapter 18. Monitoring, Logging, Error Messages

ERR-0000000261
The range of allocatable IP addresses '�1$s'-'�2$s' is not included in
the subnet of DHCP server pool '�3$s'
ERR-0000000262
No client interface is configured for DHCP server '�1$s'
ERR-0000000263
The subnets defined for DHCP server pools '�1$s' and '�2$s' overlap.
ERR-0000000264
The ranges of allocatable addresses in DHCP server pool '�s' overlap
ERR-0000000265
No subnet is configured for pool '�1$s'
ERR-0000000266
Host '�1$s' is defined as a DNS server for pool '�2$s', yet it has no
DNS server capability enabled
ERR-0000000267
Host '�1$s' is defined as a NTP server for pool '�2$s', yet it has no
NTP server capability enabled
ERR-0000000268
Host '�1$s' is defined as a WINS server for pool '�2$s', yet it has no
WINS server capability enabled
ERR-0000000269
The 'ignore-broadcast' option on interface '�1$s' of DHCP server '�2$s'
should be removed
ERR-0000000270
DHCP relay is enabled on '�1$s', but no client interface is configured
ERR-0000000271
DHCP relay is enabled on '�1$s', but no DHCP server is configured
ERR-0000000272
DHCP relay is enabled on '�1$s', but no authorized network is configured
ERR-0000000273
DHCP server '�1$s' is not reachable from DHCP relay '�2$s'
ERR-0000000274
DHCP server '�1$s' configured in DHCP relay '�2$s' is behind
client-interface '�3$s'
ERR-0000000275
DHCP server '�1$s' cannot be the local appliance
ERR-0000000276
The 'ignore-broadcast' option on interface '�1$s' should be disabled
as broadcast is used by DHCP relay '�2$s'
ERR-0000000277
DHCP relays '�1$s' cannot use bridge or bridged interfaces
ERR-0000000278
DHCP relay '�1$s' cannot use bridge or bridged interfaces
ERR-0000000279
Host '�1$s' is defined as a DHCP server for DHCP relay '�2$s', yet it
has no DHCP server capability enabled
ERR-0000000280
Main PDC '�1$s' for appliance '�2$s' does not belong to the
authentication server list
ERR-0000000281
The appliance needs at least one DNS server to have antispam filtering
enabled
ERR-0000000282
A relay is activated, but no host is configured
ERR-0000000283
Maximum rate must be greater than commited rate in '�1$s'
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ERR-0000000284
Commited rate must be lower than commited depth in '�1$s'
ERR-0000000285
Peak rate must be lower than peak depth in '�1$s'
ERR-0000000286
Committed rate must be lower than peak rate in '�1$s'
ERR-0000000287
Committed depth must be lower than peak depth in '�1$s'
ERR-0000000288
A DSCP mark must be specified as green action is to mark packets
('�1$s')
ERR-0000000289
A DSCP mark must be specified as yellow/red action is to mark packets
('�1$s')
ERR-0000000290
Borrowing must be activated also for the root class ('�1$s')
ERR-0000000291
A parent class of traffic must be specified ('�1$s')
ERR-0000000292
Children of '�1$s' request more than 100� of the bandwidth
ERR-0000000293
The HTB tree of '�1$s' must have a root HTB class on top of it
ERR-0000000294
A traffic conditioner must be specified in the Ingress rule '�1$s'
ERR-0000000295
Interface or Internet Access must be specified in the Ingress rule
'�1$s'
ERR-0000000296
A class of traffic must be specified in the Egress rule '�1$s'
ERR-0000000297
Interface or Internet Access must be specified in the Egress rule '�1$s'
ERR-0000000298
Host '�1$s' has no SMTP server capability enabled
ERR-0000000299
Host '�1$s' has no DHCP server capability enabled
ERR-0000000300
IP address �1$s for host '�2$s' is not a valid one
ERR-0000000301
Only one internal ADSL interface is allowed for '�1$s'
ERR-0000000302
HTTP proxy on '�1$s' is used by '�2$s' but not enabled
ERR-0000000303
Only one type of traffic conditioner is allowed for interface '�1$s'
ERR-0000000304
Only one scheduler type is allowed for interface '�1$s'
ERR-0000000305
Local postmaster is enabled on '�1$s', but value is empty
ERR-0000000306
Heartbeat HA interface '�1$s' must accept broadcast packets
ERR-0000000307
Domain name for host '�1$s' is not a valid one
ERR-0000000308
FTP proxy on '�1$s' is used by '�2$s' but not enabled
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ERR-0000000309
Appliance '�1$s' is present in the SMTP Id List
ERR-0000000310
The delay value '�1$s' for Dead Peer Detection in VPN '�2$s' is too
small
ERR-0000000311
The timeout value '�1$s' for Dead Peer Detection in VPN '�2$s' is too
small
ERR-0000000312
Appliance '�1$s' is mentioned in the authorized virtual IP addresses
for a VPN policy.
Only networks are allowed.
ERR-0000000313
Appliance '�1$s' is mentioned in the forbidden virtual IP addresses
for a VPN policy.
Only networks are allowed.
ERR-0000000314
The gateway host in VPN tunnel '�1$s' has no VPN gateway capability
enabled
ERR-0000000315
The gateway host for network '�1$s' has no VPN gateway capability
enabled
ERR-0000000316
Heuristic antispam quarantine email must not be empty
ERR-0000000317
External antispam quarantine email must not be empty
ERR-0000000318
Signature '�1$s' is deprecated
ERR-0000000319
Interface '�1$s' with QoS for VPN capability is not an IPsec interface.
ERR-0000000320
Host '�1$s' with no static IP address belongs to the SMTP Id list
ERR-0000000321
Host '�1$s' with no static IP address is used in an anti relay rule.
ERR-0000000322
Host '�1$s' with no static IP address can't be a VPN gateway.
ERR-0000000323
Too many translations for '�1$s' in rule '�2$s'
ERR-0000000324
No translation for '�1$s' in rule '�2$s'
ERR-0000000325
'�1$s' in the anti-spoofing list of interface '�2$s' is not a network.
ERR-0000000326
Host '�1$s' with no static IP address can't be configure as a source
in Ingress rule '�2$s'
ERR-0000000327
Host '�1$s' with no static IP address can't be configured as a
destination in Ingress rule '�2$s'
ERR-0000000328
Host '�1$s' with no static IP address can't be configured as a
source in Egress rule '�2$s'
ERR-0000000329
Host '�1$s' with no static IP address can't be configured as a
destination in Egress rule '�2$s'
ERR-0000000330
Host '�1$s' with no static IP address can't be configured as a RIP
peer for appliance '�2$s'
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ERR-0000000331
Host '�1$s' with no static IP address can't be configured as an OSPF
peer for appliance '�2$s'
ERR-0000000332
Host '�1$s' with no static IP address can't be configured as a BGP
peer for appliance '�2$s'
ERR-0000000333
Host '�1$s' with no static IP address can't be present in a DHCP pool's
list of excluded IP addresses on appliance '�2$s'
ERR-0000000334
Host '�1$s' with no static IP address can't be present in the DHCP
relay's list of authorized clients for appliance '�2$s'
ERR-0000000335
Host '�1$s' with no static IP address can't be configured as an
authorized client of the HTTP proxy on appliance '�2$s'
ERR-0000000336
Host '�1$s' with no static IP address can't be configured as a source
of a HTTP rule '�2$s'
ERR-0000000337
Host '�1$s' with no static IP address can't be configured as an
authorized client of the FTP proxy on appliance '�2$s'
ERR-0000000338
Host '�1$s' with no static IP address can't be configured as an
authorized reporting client on appliance '�2$s'
ERR-0000000339
Host '�1$s' with no static IP address can't be configured as an SNMP
client on appliance '�2$s'
ERR-0000000340
VLAN interface '�1$s' can't have a higher MTU(�2$s) than its primary
interface '�3$s' (�4$s)
ERR-0000000341
Host '�1$s' with no static IP address can't be configured as an update
client on appliance '�2$s'
ERR-0000000342
DHCP server '�1$s' cannot be a network
ERR-0000000343
Appliance '�1$s' is defined as a DHCP server for DHCP relay '�2$s',
yet it has no DHCP server capability enabled
ERR-0000000344
Host '�1$s' is identified by a FQDN. Therefore it can't be configured
as an entity of VPN community '�2$s'
ERR-0000000345
HTTP proxy is used by '�1$s' but not defined
ERR-0000000346
Host '�1$s' is identified by a FQDN. Therefore it can't be the hub
center of VPN community '�2$s'
ERR-0000000347
Network '�1$s' is not allowed in the authentication server list
ERR-0000000348
Appliance '�1$s' is not allowed in the authentication server list
ERR-0000000349
Appliance '�1$s', whose SMTP relay is disabled, is included in the
SMTP server list of appliance '�2$s'
ERR-0000000350
Host '�1$s' with no static IP address can't be included in the
blacklist of policy '�2$s'
ERR-0000000351
Host '�1$s' with no static IP address can't be included in the
whitelist of policy '�2$s'
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ERR-0000000352
Host '�1$s' is present in the VPN policy's list of authorized virtual
IP addresses.
Only networks are allowed.
ERR-0000000353
Host '�1$s' is present in the VPN policy's list of forbidden virtual
IP addresses.
Only networks are allowed.
ERR-0000000354
The tagging prefix must not be empty
ERR-0000000355
The group or folder '�1$s' is used although it is empty.
ERR-0000000356
Users �1$s have the same login '�2$s'.
ERR-0000000357
DHCP relay is enabled on '�1$s', but the client interface is not
enabled '�2$s'
ERR-0000000358
DHCP relay is enabled on '�1$s', but the client interface '�2$s' is
not owned by this fast
ERR-0000000359
DHCP server is enabled on '�1$s', but the client interface is not
enabled '�2$s'
ERR-0000000360
DHCP server is enabled on '�1$s', but the client interface '�2$s' is
not owned by this fast
ERR-0000000361
The network '�1$s' is not allowed in the sysmon internet access tested
hosts list
ERR-0000000362
The appliance '�1$s' is not allowed in the sysmon internet access
tested hosts list
ERR-0000000363
The host '�1$s' with no static ip can't be present in the internet
access host list of the sysmon '�2$s'
ERR-0000000364
The network '�1$s' is not allowed in the sysmon tested interface
monitoring hosts list
ERR-0000000365
The appliance '�1$s' is not allowed in the sysmon tested interface
monitoring hosts list
ERR-0000000366
The host '�1$s' with no static ip can't be present in the interface
monitoring host list of the sysmon '�2$s'
ERR-0000000367
External authentication is enabled but no server is defined
ERR-0000000368
DHCP server '�1$s' for DHCP-over-IPSec feature of VPN Policy '�2$s' is
not reachable by appliance '�3$s'
ERR-0000000369
The host '�1$s' with no static ip can't be present in the SNMP V1
server list of the log policy '�2$s'
ERR-0000000370
The host '�1$s' with no static ip can't be present in the SNMP V2
server list of the log policy '�2$s'
ERR-0000000371
SNMP v1 server '�1$s' cannot be a network
ERR-0000000372
SNMP v1 server '�1$s' cannot be an appliance
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ERR-0000000373
SNMP v2 server '�1$s' cannot be a network
ERR-0000000374
SNMP v2 server '�1$s' cannot be an appliance
ERR-0000000375
The host '�1$s' with no static ip can't be present in the Syslog
server list of the log policy '�2$s'
ERR-0000000376
Syslog server '�1$s' cannot be a network
ERR-0000000377
Syslog server '�1$s' cannot be an appliance
ERR-0000000378
Host '�1$s' with '�2$s' capacity must be addressed by ip or Nomad
ERR-0000000379
'vrrp-preempt-timer' must be greater than 'vrrp-advertise-timer'

The preemptive timer must be greater than the advertisement timer.
ERR-0000000380
'admin-sync-address' must be one of the 'vrrp-IP' address
(associated to an interface)

The cluster master node address must be one of the virtual addresses.
ERR-0000000381
For a cluster, 'static-IP' and 'vrrp-IP' must be unique.

For a cluster, 'real address' and virtual address must be unique.
ERR-0000000382
'vrrp-IP' must be associated to a node

A virtual address must be associated to a node.
ERR-0000000383
There is no IP address for the node '�1$s'

There is no real IP address for the node '%1$s'.
ERR-0000000384
There is no mask IP address for the node '�1$s'

There is no real IP address mask for the node '%1$s'.
ERR-0000000385
'send-delay' must be lower than 2x'delay'
ERR-0000000386
Cluster node number must be smaller than 2

The maximum cluster node number must be 2.
ERR-0000000387
Ip dynamic number must be at least equals to the number of node

The number of virtual IP must be at least equals to the number of node.
ERR-0000000388
Interface needs at least one Ip dynamic

Interface needs at least one virtual IP configured.
ERR-0000000389
Ip dynamic must specified a node.
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An virtual IP must specified a node.
ERR-0000000390
DHCP protocol and ignore broadcast option on the same interface,'�1$s',
are incompatible
ERR-0000000391
VPN PSK contains invalid character in fast360 '�s' (cannot contains '"').
ERR-0000000392
In High Availability cluster mode all the virtual addresses must be set on the same node.
ERR-0000000393
Data synchronization interface is disabled.
ERR-0000000394
The Cluster functionality is not available on this type of appliance: '�s'.
ERR-0000000395
Administration interface (interface of master node address) can't be disabled, bridged or bonded.
ERR-0000000396
Administration interface (interface of master node address) must be an ethernet interface.
ERR-0000000397
Data synchronization interface is missing.

ERR-0000000398
The cluster master node address must be the first virtual address associated to a given node, for a given i
ERR-0000000399
Http cache is not available on Arkoon SMALL series.

ERR-0000000400
Rule '�s': destination must be an Host or an Appliance when destination translation is enabled, but '�s' is
ERR-0000000401
The link monitoring (VRRP protocol) can't be disabled on all available cluster '�1$s' interfaces.

ERR-0000000402
Option 'Apply to all the following interfaces' is selected in QoS rule '�1s', but no interface is reference
ERR-0000000403
Option 'Apply to the following internet accesses' is selected in QoS rule '�1s', but no internet access is

ERR-0000000404
Option 'Authenticate the following users' is selected in applicative rule '�1s', but no user is referenced.

ERR-0000000405
�1$s' Cluster Master Node Interface '�2$s:�3$s', '�4$s/�5$s' is unreachable by Interface '�6$s:�7$s', '�8$s
ERR-0000000406
Cluster '�1s' can't use bridge interface '�2s' because link monitoring (VRRP) is disabled on all available
ERR-0000000407
In static route '�1s', the network corresponding to gateway '�2s' equals destination network '�3s'. Please

ERR-0000000408
The tested hosts configured in the '�s' system monitoring must be reachables by real IP addresses of both n

ERR-0000000409
In static route '�1s', the network corresponding to the interface '�2s' reaching gateway '�3s' equals desti
ERR-0000000410
It is not allowed to apply QoS Rule '�1$s' to internet access '�2$s' when parameter 'Enable QoS On Vpn' is
ERR-0000000411
It is not allowed to apply QoS Rule '�1$s' to internet access '�2$s' when parameter 'Enable QoS On Vpn' is
ERR-0000000412
VPN tunnel '�1$s': impossible to establish a tunnel between

'�2$s' and '�3$s' since appliance '�4$s' does

ERR-0000000413
QoS Ingress rule '�1$s' uses an 'Arkoon Token Bucket' traffic conditionner. This rule is applied to interfa
ERR-0000000414
The name length of '�1$s' authentication server has exceeded the allowed limit of �2$s characters.
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ERR-0000000415
The maximum size for downloading a file in the '�s' appliance HTTP relay, cannot be inferior to the maximum

ERR-0000000416
The total number of URL filtering categories used by the '�s' appliance (�s) exceeds the maximum allowed va
ERR-0000000417
The flow rule '�s' cannot be installed both on Virtual Edition Web & Mail appliances and on other types of

ERR-0000000418
The maximum number of '�1s' flow rules for the '�2s' Virtual Edition Web & Mail appliance has been exceeded
ERR-0000000419
In flow rule '�1$s', the selective installation is enabled but no appliance is specified.
ERR-0000000420
In the FAST policy '�1$s', the IDPS analysis is enabled but no IDPS policy is specified.

ERR-0000000421
In an encrypted segment, the source must contain only appliances, but 'MyObject' is not of the right type.

ERR-0000000422
In an encrypted segment, the destination must contain only appliances, but 'MyObject' is not of the right t

ERR-0000000423
When the source of an encrypted segment contains more than one appliance, its destination must be empty (al

ERR-0000000424
When the destination of an encrypted segment contains more than one appliance, its destination must be empt
ERR-0000000425
The VPN community '�s' must

contain at least two end entities.

ERR-0000000426
In flow rule '�1$s', the destination translation (PAT) is selected, but more than one translating appliance

ERR-0000000427
In flow rule '�1$s', the source translation (NAT by IP) is selected, but more than one translating applianc
ERR-0000000428
The SmartSSL feature is not available on the XPA appliances.
ERR-0000000429
The SmartSSL feature requires a main Internet Access.
ERR-0000000430
Remote authentication of the SmartSSL feature si selected, but no authentication server is specified.
ERR-0000000431
The SmartSSL feature requires a DNS server.
ERR-0000000432
The list of servers reachable via the ClousSSL Service is empty.
ERR-0000000433
The server '�1$s' is unreachable by the appliance '�2$s'.
ERR-0000000434
Access Rules should have a server defined.
ERR-0000000435
Access Rules should have a service defined.
ERR-0000000436
The authentication server for SmartSSL should be the same as main Primary Domain Controller.
ERR-0000000437
The authentication server for SmartSSL must have NT Server capacity.

XML Error Messages
XML-0000000000
Error : �s
XML-0000000001
The number provided is greater than the allowed limit
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XML-0000000002
The number provided is greater than the allowed limit
XML-0000000003
The number provided is smaller than the allowed limit
XML-0000000004
The number provided is smaller than the allowed limit
XML-0000000005
This string is longer than the allowed size
XML-0000000006
This string is shorter than the allowed size
XML-0000000007
The current string doesn't match the expected pattern
XML-0000000008
The number provided doesn't match digit number restriction
XML-0000000009
This list must contain more elements
XML-0000000010
The string length is invalid

Field Type Error Messages
TYPE-0000000000
'from' value (�d) can't be greater than 'to' value (�d)
TYPE-0000000001
a name cannot be left empty
TYPE-0000000002
the name '�s' is used by several objects
TYPE-0000000003
the current object's name contains invalid characters
TYPE-0000000004
The current object's name starts or ends with spaces
TYPE-0000000005
Password is invalid
TYPE-0000000006
FAST option is invalid
TYPE-0000000007
An hour can't be greater than 24h00
TYPE-0000000008
Password must have at least 8 characters
TYPE-0000000009
Password must include characters from at least 3 of the following sets:
lower case alphabetics, upper case alphabetics, digits 0 thru 9,
others (punctuation marks, ...)
TYPE-0000000010
Email in the antispam blacklist must not be empty
TYPE-0000000011
Email in the antispam whitelist must not be empty
TYPE-0000000012
A custom ICMP policy must specified
TYPE-0000000013
The start hour can't be later than the end hour
TYPE-0000000014
An unqualified error has occurred
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TYPE-0000000015
DN '�s' is used by several administrators
TYPE-0000000016
The Arkoon identifier '�s' is used by several appliance

18.12.3. Warning Messages
WAR-0000004096
Warning: �s
Select interfaces from which the appliance will handle requests
WAR-0000004097
HTTP proxy enabled but no listening interface specified - no one will
be able to access it.
Specify networks/hosts from which the appliance will handle requests
WAR-0000004098
HTTP proxy enabled but no authorized network specified - no one will
be able to access it.
WAR-0000004099
IPSec is enabled but no access for IKE has been defined
WAR-0000004100
Update Proxy has been enabled but no allow_from specified

The appliance is configured as an update proxy server (antivirus, blacklists, system), but no authorized
client was configured.
• Open the Update configuration form of the appliance configuration tab and configure the authorized
sources in the Source field.
WAR-0000004101
TCP desequencing enabled with a service which is not TCP - Ignoring

The desequencing option of TCP traffic was configured for a filtering rule specifying at least one service
that is not TCP based. The option is ignored.
WAR-0000004102
TCP maximum number of waiting connections specified with a service
which is not TCP - Ignoring

The TCP maximum number of pending connections was configured for a filtering rule specifying at least
one service that is not TCP based. The option is ignored.
WAR-0000004103
Appliance '�s' has no IPsec ID although it uses RSA keys.

An IPsec tunnel with RSA authentication is configured with an appliance that does not have any defined
IPsec identifier.
• Configure the appliance's IPsec identifier in the IPsec ID field in the VPN form of the Security
configuration form.
WAR-0000004104
Host '�s' has no IPsec ID although it uses RSA keys.

An IPsec tunnel with RSA authentication is configured with a host that does not have an IPsec identifier
defined.
• Configure this host's IPsec identifier by editing its characteristics.
WAR-0000004105
Use Internet Access rather than route '�1$s' to 0.0.0.0/0.

Warning Messages

| 423

Chapter 18. Monitoring, Logging, Error Messages

A default static route was defined. It is recommended to use an Internet Access that brings additional
functionalities: bandwidth management, anti-DoS controls, etc.
• Replace the route to 0.0.0.0/0 by a LS/router-type Internet access.
WAR-0000004106
The appliance has an Internet Access defined but no main
Internet Access.
WAR-0000004107
Couldn't scan directory '�s', probably missing.
WAR-0000004108
Couldn't delete table '�s' from database.
WAR-0000004109
Bad category name "�s", only characters [a-z] [A-Z] [0-9] '_' are
allowed

The name of a URL or keywords category contains unauthorized characters.
• Change the name of this category.
WAR-0000004110
Accept rule without any service selected
WAR-0000004111
Object 'xxx' defined in OtherValid for 'yyy' seems to come from 'zzz'.
If it is the case, this will deny all trafic from 'zzz'

If a host 'xxx' or network is directly accessible via an interface 'yyy', it must not be listed in the networks
connected to another interface ‘zzz’. Otherwise, the antispoofing rules will block all the packets emitted
by this host or network.
• Unselect object 'xxx' from the connected networks list on interface 'zzz'.
WAR-0000004112
IPsec ID '�1$s' doesn't start with '@' - it is usually a bad idea

It is recommended that the IPsec ID of a VPN server begins by the '@' character. Otherwise, the IPsec
ID must have a standard format (IP address, email address, machine name).
• Change the IPsec ID of the specific object by editing the host object or the properties of the VPN form.
WAR-0000004113
Strange RSA key size (�d bits) in object '�s'

The size of an RSA key differs from standard values: 512, 1024, 2048 bits.
• Make sure that the RSA key of the specific object is correct by editing the host object or the properties
of the VPN form.
WAR-0000004114
Rule has not been installed on any appliance

A rule is installed on an appliance if, according to its interfaces and routes, it is located between the
source and the destination or it is itself a source or destination. In such a case, no appliance was found
to apply the specified rule.
• Review the rule to make sure that this message is normal.
WAR-0000004115
Appliances '�s' and '�s' in parallel - this is not supported
WAR-0000004116
No interface...
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An appliance has no interface defined.
• Configure at least one interface.
WAR-0000004117
Monitoring ISDN Internet Access will force ISDN to dial for every
ping
Please provide an IP address instead, or configure at least one
DNS Server.
WAR-0000004118
You provided an Internet name for the update server and no DNS server
is defined.

An appliance's update server is configured with its name and no DNS server is specified.
WAR-0000004119
Object '�s' is local (detected on �s) but you defined an Internet
Access to use.
WAR-0000004120
N-1 translation address �s does not belong to any known appliance's
subnet.

A masking address is specified in the configuration of a filtering rule, but no corresponding network is
defined on the appliance. Take special care of the routing configuration on the other machines of the
network so that the return packets of this masked packet can reach the appliance.
• If needed, change the address used to translate the traffic.
WAR-0000004121
N-1 translation and more than one Internet Access selected in rule '�s'.

In the case of an N-1 translation, you define the address that must replace the source IP address. Of
course, a similar address cannot be used if the packet has to exit via two different Internet Accesses.
• If you wish to define several Internet Accesses for this flow, you must choose Masking to automatically
use the IP address of the output interface.
WAR-0000004122
Domain name for LDAP server '�s' required in secure mode.

An LDAP authentication server using the SSL secured mode must have its domain name specified in the
configuration.
• When configuring an LDAP server, check the Secure Mode option and enter the domain name in the
corresponding Server field.
WAR-0000004123
Two bandwidth reservations/limitations are defined for the ESP
protocol.
Only the first one will be used.
WAR-0000004124
Can't find file '�s' on the appliance.

The customized error file '%s' of the HTTP proxy could not be found on the appliance.
• Make sure that a file with this name is present on the appliance, in the /var/http/ErrorDocument
directory.
WAR-0000004125
Reserved bandwidth is greater than 100�� for '�s'

The sum of the reserved bandwidth for an Internet access exceeds 100%, all bandwidth rules being
considered.
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• If competition of several flows is a problem, review these specific bandwidth rules and lower the sum
to less than 100%.
WAR-0000004126
User password attribute missing for authentication server '�s'

An LDAP authentication server is configured so that the FAST360 appliance retrieves a signature of the
password on the server during an authentication. No LDAP attribute name was specified to find this
information in a User object.
• Edit the characteristics of this LDAP server. Specify an Object Class and Login Attribute in the Users
section of the LDAP Server configuration form.
WAR-0000004127
Limitation is lower than MTU, rule �s may block flow
WAR-0000004128
Update server type has been set to 'Appliance with same CA' but
hostname is still support.arkoon.net
WAR-0000004129
Appliance '�s' is selected as a potential source in a rule with
authentication.
It will never match this rule
WAR-0000004130
Proxy POP3 disabled on 'xxx' but used in service 'yyy', check this
isn't an error -- rule 'zzz'

Rule 'zzz' specifies a service 'yyy' in which the redirection toward the POP3 proxy is configured, whereas
the POP3 proxy of appliance 'xxx' is not activated.
• Activate the appliance's POP3 proxy and configure its properties.
WAR-0000004131
HTTP proxy disabled on appliance '�s' but used in service '�s', check
this isn't an error -- rule '�s'

Rule 'zzz' specifies a service 'yyy' in which the redirection toward the HTTP proxy is configured, whereas
the HTTP proxy of appliance 'xxx' is not activated.
• Activate the appliance's HTTP proxy and configure its properties.
WAR-0000004132
DNSBL feature has been enabled but no domain defined

You checked Enable Anti-relaying in the SMTP AntiRelaying configuration form in the Mail configuration
form of the appliance's configuration tab but you did not add any DNSBL domain.
• Configure at least one DNSBL domain as well as the weight that must be associated to it in the Domain
table of the AntiRelaying configuration form.
WAR-0000004133
The anti-relaying rule '�s' accepts mails from blacklisted sources

There is an anti-relaying rule calling the DNSBLs, and its action is to Accept. This is probably an error.
• Make sure that you want the rule to be permissive.
WAR-0000004134
There is no IP address to ping

The system monitoring rules for interfaces and Internet Accesses must define at least one host on which
the ping test is performed.
• Select at least one host in the corresponding table in the System Monitoring configuration form.
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WAR-0000004135
HTTP proxy disabled on '�s', but monitored by Sysmon rule '�s'

The system monitoring is enabled on a disabled HTTP proxy. This is probably a mistake.
• Remove system monitoring on the HTTP proxy if the HTTP proxy is not active.
WAR-0000004136
Bad Sysmon port (�d) for HTTP proxy monitoring. Must be �d.

The HTTP proxy is configured on a port different than the port configured in the system monitoring.
WAR-0000004137
Object '�s' is reachable by '�s', but sysmon alert is not an '�s' alert

This warning corresponds to one of the following cases:
• You have defined system monitoring on the Internet Access but you have selected a host located
behind another interface than the one used by this Internet access;
• You have defined system monitoring on an Ethernet interface but you have selected a host located
behind the Internet access.
• Check the system monitoring to make sure it is coherent.
WAR-0000004138
An '�s' interface monitoring is going to ping object '�s' reachable by
'�s'

You have defined a system monitoring on an Ethernet interface but you have selected a host located
behind another Ethernet interface (which is not used for another Internet access).
• Check that the selected host can be reached by the monitored interface.
WAR-0000004139
VLAN ID is lower than 2. Be careful with other VLAN equipments
administrative IDs

The VLAN 0 and 1 ID are not supported by some hardware.
• Check that the VLAN hardware used on this network supports ID 0 and 1.
WAR-0000004140
Bridged interface has non zero IP address

The address of the bridged Ethernet interface has not been forced to 0.0.0.0/0.
WAR-0000004141
'�1$s' has a non null IP address and is the primary interface of a
bridged VLAN interface.
Possible problems

It is recommended to configure the 0.0.0.0/0 address on the primary Ethernet interface on which is
configured a bridged VLAN interface. Otherwise, some hardware devices can refuse the appliance’s
ARP requests in specific cases.
• Configure the 0.0.0.0/0 address on the ‘%1$s’ interface.
WAR-0000004142
Port xx is defined for yy and zz

Port xx is used for different protocols in the HTTP proxy authorized destination port lists.This can cause
problems, particularly for the FTP and HTTP protocols with a FAST module.
• Check authorized destination ports on the HTTP proxy.
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WAR-0000004143
Bad MIME type: "�s", all characters after ';' will be ignored

The quoted MIME type includes a semi-colon. It will be truncated; only the first part, semi-colon included,
will be taken into account.
WAR-0000004144
Arkoon Reporting has been enabled on '�s' but no authorized client is
specified
WAR-0000004145
No anti-relaying rule allowing incoming or outgoing mails

There is no anti-relaying rule configured. No mail can then be transmitted by the appliance.
• Create rules to authorize submit and/or receipt of mails. Caution! These rules are essential to the
security of the SMTP relay.
WAR-0000004146
No mail address provided for postmaster

Alerts have been configured to be sent to the address of the postmaster which is not defined.
• Configure the postmaster's address in the General configuration form in the Mail configuration form
of the appliance's configuration tab.
WAR-0000004147
Proxy POP3 enabled on '�s' but never used in flow rules

POP3 proxy is enabled but no filtering rule uses it.
• Configure a filtering rule that uses the POP3 proxy or disable it.
WAR-0000004148
No mail address found to send alerts

Mail alerts are configured but no destination mail address is defined.
• Add at least one mail address in the To Email Address Type table in the Alert configuration form of the
log policy being configured.
WAR-0000004149
No DNS server found to send alert mails

Mail alerts are configured but no DNS server has been defined: the appliance cannot submit mails.
• Configure at least one DNS server in the DNS form in the Network configuration form of the appliance.
WAR-0000004150
Using invalid signature �1$s: �2$s

The configuration uses a signature marked as invalid because of reason ‘%2$s’ in the IDPS signatures
base. Use this signature at your own risk: it is not supported on the appliance.
WAR-0000004151
FTP proxy enabled but no listening interface specified - no one will
be able to access it
Select interfaces from which the appliance will handle requests

The FTP proxy is activated, but no listening interface has been specified. The FTP proxy service cannot
be used, the corresponding network port will not be reachable.
WAR-0000004152
FTP proxy enabled but no authorized network specified - no one will be
able to access it
Specify networks/hosts from which the appliance will handle requests
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The FTP proxy is activated, but no address has been authorized to access it. No implicit rule will be
created to authorize proxy access.
WAR-0000004153
On appliance '�s', FTP Proxy runs on privileged port

The FTP proxy has been activated, but it is configured to work on a privileged port (<1024). This forces it
to give it super-user rights and impacts partitioning on the appliance.
WAR-0000004154
NAT-static and PAT cannot be used simultaneously. Will use PAT only

Only the PAT functionality will work.
WAR-0000004155
https:// should not be used in category �s, use your_url:443 instead

You should put the port used after the URL, rather than specifying https.
WAR-0000004156
Speed �s won't be applied on interface

The requested speed cannot be applied to the specified interface since it is a VLAN interface.
WAR-0000004157
Domain xxx matches the hostname of this appliance -- mail to yyy won't
be routed

Domain routing for xxx domain has been configured, but appliance yyy is generating a conflict.
WAR-0000004158
An antispam configuration has been defined for '�s' but not enabled
neither on SMTP relay, nor on POP3 proxy

Antispam must be activated on the relay before the configuration can be used.
WAR-0000004159
Hybrid mode threshold (�d kB) on POP3 proxy is lower than maximum size
(�d kB) in antispam configuration. Mails with size bigger than hybrid
mode threshold will not be handled by the antispam engine.

In hybrid mode, only messages smaller than the configured threshold are analyzed by the Antispam
engine – even if the analysis threshold (part of the Antispam configuration) is set to a larger value.
Increase the value of the hybrid mode threshold.
WAR-0000004160
Using bandwidth management on '�s' and '�s' is not recommended

If an Internet Access is defined on an interface with bandwidth management then the bandwidth
management will be applied to the Internet Access but not to the interface itself.
WAR-0000004161
Both days_bd and hours_bd parameters set for table �s

It is not possible to set the time interval between log purges in both days and hours; these two parameters
are mutually exclusive.
WAR-0000004162
Object '�s' (�s/�d) used in whitelist or blacklist contains a private
IP address which will be ignored

In order to ignore internal emails, you must enable the relevant option and not pass via a white list.
WAR-0000004163
Search base DN missing for LDAP server �s

The configuration object LDAP Server requires the parameter Search Base to be configured.
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WAR-0000004164
Computer (NetBIOS) name missing for NT server �1$s
WAR-0000004165
Appliance '�s' has specific IP addresses on interface '�s' but is seen
by '�s' with its primary IP address (�s) with its primary IP address
(�s)

An appliance with specific IP addresses per appliance ID in a multi-appliance system is seen by other
appliances only with its primary IP address. For example, if an appliance masks a flow, other appliances
will use the principal IP address as the source.
WAR-0000004166
�s IP address is the network broadcast address
WAR-0000004167
Object '�1$s' can be located on several interfaces (at least �2$s and
�3$s)
Select the interfaces from which your appliance will handle requests
WAR-0000004168
SNMP agent enabled but no listening interface specified - no one will
be able to access it
WAR-0000004169
Internal ADSL PCI configuration seems to be external
WAR-0000004171
Appliance needs at least one syslog server to enable �s log storage in
syslog
WAR-0000004172
FTP proxy disabled on appliance '�1$s' but used in service '�2$s',
check this isn't an error -- rule '�3$s'
WAR-0000004173
VPN tunnel '�1$s' has multiple links with the same gateways.
DPD is highly recommended in that case to quickly detect dead links
WAR-0000004174
Roadwarriors do not share the same IKE algorithms (at least between
'�1$s' and '�2$s')
WAR-0000004175
At least one of the extremities ('�1$s' and '�2$s') should be an
appliance
WAR-0000004176
At least one of the entities of the mesh should be an appliance in
community '�1$s'
WAR-0000004177
Interfaces '�1$s' and '�2$s' are on the same IP network
WAR-0000004178
ISDN interfaces are no longer supported
WAR-0000004179
Token Ring interfaces are no longer supported
WAR-0000004180
No filters defined in '�s', rule will reject all authenticated users
WAR-0000004181
Object '�1$s' has no IPsec ID although it uses RSA keys
WAR-0000004182
There is no NT server using defined main PDC '�1$s' on appliance '�2$s'
WAR-0000004183
A relay with authentication is set in policy '�1$s', but no user login
is set
WAR-0000004184
A relay with authentication is set in policy '�1$s', but no password
is set
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WAR-0000004185
A tagging threshold is set in policy '�1$s', but antispam quarantine
is always called before tagging.
The threshold value is useless.
WAR-0000004186
A quarantine threshold is set in policy '�1$s', but reject always
occurs before quarantine.
The threshold value is useless.
WAR-0000004187
A tagging threshold is set in policy '�1$s', but reject always occurs
before tagging.
The threshold value is useless.
WAR-0000004188
The host '�1$s' is static and also excluded from pool '�2$s'
WAR-0000004189
The host '�1$s' has the 'assign by DHCP' option on, but is not
included in any DHCP pool
WAR-0000004190
The host '�1$s' has an IP address within the allocable range of the
pool '�2$s' of the DHCP server, but is neither excluded from it,
not configured as a static host.
WAR-0000004191
Host '�1$s' is excluded from DHCP server pool '�2$s',
but is not included in allocable range of addresses of that pool.
WAR-0000004192
DHCP server is enabled, but no DHCP pool is configured
WAR-0000004193
Ranges of available addresses in DHCP server pool '�1$s' only contain
excluded addresses and static hosts.
WAR-0000004194
Interface '�1$s' has addresses included in more than one DHCP server
pool
WAR-0000004195
With DHCP over IPsec enabled, agent-option should be set to 'append'
WAR-0000004196
Using furtive mode instead of IP 0.0.0.0/0 is more suitable for
interface '�1$s'
WAR-0000004197
System syslog is not available on appliance with hard disk '�1$s'
WAR-0000004198
If drop action is selected for Yellow traffic then Red traffic should
have a drop action selected too in '�1$s'
WAR-0000004199
External ADSL interface should not be named 'adsl0' ('adsl1'-'adsl-9')
WAR-0000004200
The object '�1$s' is reachable by '�2$s', but the connection ping test
used by the Internet Access '�3$s' can't reach this object by the
interface '�4$s'
WAR-0000004201
The fast policy '�1$s' will be not used because checksum verification
is disabled
WAR-0000004202
The lan '�1$s', using '�2$s' as gateway has the same IP's value as the lan '�3$s', using '�4$s'
as gateway. It might cause errors on the vpn tunnel '�5$s'.
WAR-0000004203
Rule '�1$s' : source translation using IP address is not recommended on a cluster in
High Performance mode ('�2$s').
WAR-0000004204
Rule '�1$s' : destination translation using IP address is not recommended on a cluster in High Performance

Warning Messages

| 431

Chapter 18. Monitoring, Logging, Error Messages

WAR-0000004205
"Host '�1$s' : static NAT is not recommended on a cluster in high performance mode ('�2$s').
WAR-0000004206
"Network '�1$s' : static NAT is not recommended on a cluster in high performance mode ('�2$s').
WAR-0000004207
System Monitoring cluster state change is activated but no system monitoring is configured.
WAR-0000004208
It is recommended not to have a Cluster : '�1$s' and a network 0.0.0.0/0 : '�2$s' as extreme
entities of the same VPN tunnel.
WAR-0000004209
It is recommended to use a Dead Peer Detection delay value upper than 10 sec for VPN '�2$s'.
WAR-0000004210
It is recommended to use a Dead Peer Detection timeout value upper than 30 sec for VPN '�2$s'.
WAR-0000004211
�1$s' Interface '�2$s:�3$s', '�4$s/�5$s' is unreachable by Interface '�6$s:�7$s', '�8$s/�9$s'.
WAR-0000004212
Using a traffic conditionner of type 'Arkoon token Bucket' on QoS Rule '�1$s' applied to
internet access '�2$s' means that this rule will not be applied to ingress traffic from
VPN, although parameter 'Enable QoS on VPN is enabled on the interface used by this internet
access ('�3$s').
WAR-0000004213
The '�s' category must have at least one keyword.
WAR-0000004214
The use of the * joker is very resource-consuming. You can replace the keyword '�1$s' with '�2$s'.
We recommend you check the section about categories in the Administration Guide if the use of
a joker is necessary.
WAR-0000004215
The SmartSSL DNS name '�s' seems to be incorrect: it should end with ".smartssl.arkoon.net".
Please specify the name provided with SmartSSL activation information.
WAR-0000004216
SmartSSL is set to use local authentication but no users are defined.
WAR-0000004217
Your configuration has some invalid references, please use previous configuration.

18.12.4. Information Messages
INF-0000008192
Info: �s
INF-0000008193
VPN type has been changed to OnDemand between xxx and RoadWarrior yyy

A permanent-type tunnel, defined between appliance 'xxx' and a nomad 'yyy', was changed for an onrequest tunnel. Indeed, only the “on-request” type is possible in this case. An appliance cannot initiate
a VPN negotiation with a remote IP address it does not know.
INF-0000008194
Signature �1$s is disabled (null score), it won't be loaded

A local IDPS signature %1$s with a zero score will not be loaded.
INF-0000008195
Local signature �1$s is disabled (null score), it won't be loaded

A local IDPS signature %1$s with a zero score will not be loaded.
INF-0000008196
Radius authentication in Challenge/Response mode may be problematic
with some browsers
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RADIUS authentication is enabled on the HTTP proxy and is known not to work with some browsers.
INF-0000008197
Four bonding interfaces are enabled on appliance by default.

By default, an appliance has 4 bonding interfaces. To increase this number, you must modify the
parameter max_bonds in the file /etc/modules.conf
INF-0000008198
Dynamic routing interfaces must accept multicast packets

If the configuration requires dynamic routing to be enabled, the interfaces on which OSPF and RIP will
be used must authorize multicast traffic.
INF-0000008199
Heartbeat HA interfaces must accept broadcast packets
INF-0000008200
The appliance �1$s contains Arkoon identifier not initialised
INF-0000008201
The flow rules to use external PKI are not automatically created, you
have to do this
INF-0000008202
A good practice consists in setting 'vrrp-advertise-timer' between 1
and 5
INF-0000008203
A good practice consists in setting 'vrrp-preempt-timer' between 1
and 10
INF-0000008204
A good practice consists in setting 'vrrp-timer-gndp' between 1
and 10
INF-0000008205
The node '�1$s' contains Node identifier not initialised
INF-0000008206
The link monitoring protocol VRRP is disabled on interface '�1$s' (�2$s)

18.12.5. Appliance Synchronization Messages
These messages are displayed after a configuration has been compared with its appliance’s embedded
parameters and before these parameters are synchronized into the configuration.
HWD-0000065536
Information: �s
HWD-0000065537
The IDPS database will be imported into your configuration
HWD-0000065538
The IDPS database will be updated from your appliances
HWD-0000065539
A new appliance (�s) will be added
HWD-0000065540
An appliance (�s) will be updated
HWD-0000065541
Factory categories will be updated
HWD-0000065542
The services database will be updated from your appliances
HWD-0000065543
The FAST policies database will be updated from your appliances
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18.13. Alerts
18.13.1. Introduction
Objective
This section introduces the alerts generated by the FAST360 appliance. These alerts can be broadcast
in four different ways:
• In the Alerts window of Arkoon Monitoring (default configuration).
• By syslog (if configured in the Alert configuration form of a log policy in Arkoon Manager ).
• By email (if configured in the Alert configuration form of a log policy in Arkoon Manager ).
• By SNMP traps (if configured in the Alert configuration form of a log policy in Arkoon Manager ).

Alerts Levels
Each alert has an associated level that corresponds to its severity.
There are four alert levels:
• None level: This level is simply for information purposes and does not imply any abnormal behavior.
• Low level: This level corresponds to events that may possibly affect security.
• Intermediate level: This level corresponds to events that warrant closer inspection by the
administrator.
• High level: This level corresponds to problems that need to be quickly diagnosed; administrator action
will probably be required.

Format of this Section
This section lists the alerts, classified by level. For each alert, you will find:
• Its name, as specified in Arkoon Manager
• Its meaning
• The action to take, if required

18.13.2. Alert Description
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None Level
Internet Access up

The Internet access is operational. The Description column indicates the specific Internet access and
specifies the interface used for this access or the IP address of the gateway.
IKE Alert

The none-level IKE alert indicates that a VPN link is mounted. The Description column indicates the IP
address of the remote VPN server as well as the name given to the group of VPN tunnels in the FAST360
appliance's configuration.
Arkoon down

The FAST360 appliance has been switched off by one of the following means:
• A stop or restart via Arkoon Monitoring
• A stop or restart via the command line
• A stop through a short press on the appliance’s Power key
Arkoon up

The FAST360 appliance has been powered up (manually or following a voluntary restart).
Configuration installed

This message indicates that a new configuration is installed. The Description column indicates the
name of the installed configuration as well as the backup file name where the configuration is
copied. All subsequently installed configurations are copied into the /var/config.backup directory.
The Administrator column contains the certificate or the login of the Administrator who installed the
configuration. In the case of a master/slave topology, you see the master's certificate.
Administration connection

This indicates a successful administration connection. The Description column specifies the type of
administration connection (SSH, Manager, Monitoring or master/slave), the IP address and the source
port of the Administrator's workstation. The Administrator column indicates the login used (in the case
of an SSH connection) or the certificate used (in the case of the Manager or Monitoring).
In the case of a connection with the Manager, the characters [W] in the Description column specify that
the certificate has Read/Write rights. In the case of a master/slave topology, the alert is generated when
creating the master/slave connection. The Description column contains the slave's certificate.
New certificate created

A new certificate has been created. The Description column indicates the name of the new certificate.
The Administrator column specifies the certificate (modified via Arkoon Monitoring ) or the login
(modified in terminal mode) of the Administrator who performed the operation.
Date/time changed

The FAST360 appliance's date has been modified. The Administrator column specifies the certificate
(modified via Arkoon Monitoring ) or the login (modified in terminal mode) of the Administrator who made
the modification.
Denial of service detected
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This alert is generated when the previously detected denial of service (high-level “Denial of service
detected” alert) is finished. The Description column indicates the name of the specific Internet access,
the specific type of packets (ICMP or TCP-SYN) and the number of denied packets during the attack.
New IPsec tunnel established

This alert indicates that a new IPsec tunnel has been established. The alert is raised when a tunnel is
first negotiated (re-negotiation without collapse of the tunnel generates a separate alert). The networks
negotiated in the tunnel appear in the description and allow the use of virtual IP addresses obtained
through DHCP. The particular case of a tunnel established for DHCPover-IPsec negotiation is specifically
identified. The description of the group of VPN tunnels given in the alert corresponds to the object
description in the configuration or, by default, to its name. The algorithms negotiated by the IPsec SA are
also present. The use of a port allows NAT-Traversal to be detected.
Network traffic unblocked

The network traffic was previously blocked for one of the following reasons: logs queue overloaded,
kernel queue overloaded or disk full. The situation has returned to normal and the network traffic is no
longer blocked.
Interface down

The Ethernet interface has been disconnected. This operation could have been automatic (installation of
a configuration modifying the interfaces), manual (via the Arkoon Monitoring Interfaces window or on
the command line) or caused by the FAST360 appliance being stopped.
Interface up

The Ethernet interface has been connected. This operation could have been automatic (installation of a
configuration modifying the interfaces), manual (via the Arkoon Monitoring Interfaces window or on the
command line) or caused by the FAST360 appliance being started.
Interface disconnected

The interface (ADSL in PPPoA) has been disconnected. The Description column gives the name of the
specific interface, the IP address of this interface and the gateway IP address at the ISP.
Interface reconnected

The interface (ADSL in PPPoA) has been (re)connected. The Description column gives the name of the
specific interface, the IP address of this interface and the gateway IP address at the ISP.
“Admin from” has changed

The Admin from parameter has been changed via the Configuration menu of the minarkconf program.
The Description column indicates the new value of this parameter. The Administrator column specifies
the login of the Administrator who made the change.
Upgrade

This alert is concerned with the download of updates (antivirus, blacklists, system patches). The
Description column indicates the specific module by update (SOPHOS, BLACKLISTS or ARK-PATCHES).
A first alert indicates that the download was successful; a second alert indicates that the updates were
taken into account.
IPsec SA successfully negotiated

This alert indicates that an IPsec SA has been successfully negotiated. The description of the group of
VPN tunnels given in the alert corresponds to the object description in the configuration or, by default, to
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its name. The field username gives the login of the user object, as indicated in the configuration (which
therefore requires a tunnel that uses objects of the type user).
Log flush via Arkoon Monitoring

This alert is generated when one of the logs is manually flushed via Arkoon Monitoring . The Description
column indicates the name of the specific database. The Administrator column specifies the certificate of
the Administrator who performed the operation. This alert indicates that the flush was correctly executed.
Log flush on reached threshold

This alert is only relevant to the case of a FAST360 appliance without a hard disk. When the logs take
up to 93% of the disk space, 75% of them are flushed (percentage configurable in Arkoon Manager ).
This alert indicates that the flush was successful and the Description column contains the name of the
log that was flushed.
Already established IPSec tunnel re-negotiated

This alert indicates that an already established IPsec tunnel has been re-negotiated. This alert is only
raised when a tunnel is re-negotiated (the initial negotiation generates a separate alert). The alert carries
the same information as the alert raised when a new IPsec tunnel is established.
Certificate revoked

A certificate was revoked. The Description column contains the name of the certificate. The
Administrator column specifies the certificate (modified via Arkoon Monitoring ) or the login (modified
in terminal mode) of the Administrator who performed the operation.
Scheduled log flush

The automatic backup and flush of the database were successful. They were compliant with the visible
configuration in the Alerts and logs Archiving folder of Arkoon Manager . The Description column
contains the names of the logs referred to by this alert.
• If the backup was configured, you will be able to download the files from Arkoon Monitoring : they are
available from the Logs Backup Infos tab of the General Info window.
Service started

One of the aklogd or mysqld services has been started. The Description column indicates the particular
service.
Service stopped

One of the aklogd or mysqld services has been stopped. The Description column indicates the particular
service.
An IPsec tunnel has collapsed

This alert is raised when an IPsec tunnel collapses. It is not raised when an IPsec SA is removed
or expires and another SA corresponding to the same tunnel is negotiated. The alert takes the same
information as for the establishment of a new IPsec tunnel. The level of the alert depends on the reason
for the alert, which can be any of the following:
• Latest IPsec SA has expired (Intermediate)
• Considered as dead by 'Dead Peer Detection' (Intermediate)
• Delete notification received (Information)
• IPsec service is stopped (Information)
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• Terminated by administrator (Information)
• Peer now uses another IP address (Information)
• Removed by administrator (Information)
user added or removed with minarkconf

A user has been created or removed via the Users menu of the minarkconf program. The Description
column contains the user's name, as well as their login in the case of user creation. The Administrator
column contains the login of the Administrator who performed the operation.

Low Level
Warning on log queue

The logs queue is 50% busy.
• Consult the IP Logs to find out which flows are generating so many logs. Consequently, modify the
logging filtering rules or the anti-DoS configuration.
Warning on

/var

The /var partition is 75% busy.
• Consult the Disk tab of the State of the FAST360 appliance window to view the general and detailed
occupancy of the /var partition. If the database takes a lot of space, export or delete all or part of
the logs.
Warning on /config_card

The /config_card partition is 75% busy.
• Consult the Disk tab of the State of the FAST360 appliance window to view the occupancy of the /
config_ card partition.
Encrypted file in mail

The email contains an encrypted file, and therefore cannot be analyzed by the antivirus mechanism.
The email will be processed according to the options configured in the Arkoon Manager :
• If the options EncryptedFile and Accept are checked, the email will be transmitted.
• If the options EncryptedFile and Quarantine are checked, the email will be quarantined.
• If the options EncryptedFile and Reject and RemoveDeniedFromServer are checked, the email will be
deleted.

Note
If the mail was quarantined, open the Quarantine window of Arkoon Monitoring in order to
choose how to process the email.
Bad SPI

The packet contains a bad SPI (Security Parameters Index). This means that the packet does not go
through the correct VPN tunnel, but goes through a VPN when it should not (or the opposite case).
• Check the cause of the blocking in the Reason and IP Logs Description columns. Refer to Section 18.8.1,
“IP” for more details.
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• There are two possible cases: either the tunnel is not mounted, or the filtering rule that takes the packet
into account does not make it go through this tunnel. Look in the VPN window to determine whether
the tunnel is mounted.
• If the tunnel is not mounted, open the System logs to determine why the tunnel is not mounting.
• If the tunnel is mounted, open Arkoon Manager and check the configuration:
• Either the packet has not been taken into account by the correct rule; in such a case, review the
order of the rules and/or their definition.
• Or the packet follows the rule created for this purpose, but the encryption was incorrectly
configured.
New mail in quarantine

A new email has been quarantined.
• Open the Quarantine window in Arkoon Monitoring to see this particular email and the reason for
the quarantine.
Analyze error in mail

The antivirus analysis could not be applied. The email will be processed according to the options
configured in the Arkoon Manager :
• If the options NonAnalysableFile and Accept are checked, the email will be transmitted.
• If the options NonAnalysableFile and Quarantine are checked, the email will be quarantined.
• If the options EncryptedFile and Reject and RemoveDeniedFromServer are checked, the email will be
deleted.
• If the email has been quarantined, open the Quarantine window of Arkoon Monitoring in order to
choose how to process the email.
DHCP Lease renewed for < IP @> : < MAC @>

This alert is generate every time a lease is renewed.
DHCP Lease assigned to < IP @> : < MAC @>

This alert is generated for every lease ACKed.
DHCP Request from < IP @> : < MAC @>

Logs every DHCP request, with source IP (if any)/MAC address
DHCP Offer to < IP @> : < MAC @>

Logs every DHCP offer from the server, with offered IP/MAC address.

Intermediate Level
IKE alert

The intermediate-level IKE alert indicates a problem during VPN negotiation. The Description column
provides details on the nature of this problem.
• For more details on VPN negotiation, open the system logs and read the messages of the pluto daemon.
Warning on log queue
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The logs queue is 75% busy.
• Consult the IP Logs to find out which flows are generating so many logs. Modify consequently the
logging filtering rules or the anti-DoS configuration.
Warning on /var

The /var partition is 90% busy.
• Consult the Disk tab of the State of the FAST360 appliance window to view the general and detailed
occupancy of the /var partition. If the database takes a lot of space, export or delete all or part of the
logs.
Warning on /config_card

The /config_card partition is 90% busy.
• Consult the Disk tab of the State of the FAST360 appliance window to view the occupancy of the /
config_card partition.
Authentication failure

A user's authentication failed during authentication on a filtering rule. The Description column provides
the name of the particular user.
Failure in negotiating on ISAKMP/IPsec SA

This alert indicates an error in negotiating an ISAKMP or IPsec SA. The error codes in the Description
column correspond to the standard notification types defined in RFC2408;

Example 18.2. RFC2408 Error Codes
NO_PROPOSAL_CHOSEN
INVALID_KEY_INFORMATION
BAD_PROPOSAL_SYNTAX
Database purged

There was a problem during the manual flush of one of the logs via Arkoon Monitoring . The Description
column indicates the name of the particular database. The Administrator column specifies the certificate
of the Administrator who performed the operation.
• Open the System logs for the details of this problem.
Mail denied by applicative rule

An email has been denied by an SMTP inter-application rule requesting a quarantine.
• Open the Logs of the SMTP relay; the Reason column provides the name of the inter-application rule
that blocked the email.
Packet blocked by filter

The packet has been rejected by a filtering rule.
• Refer to the IP logs to find out which filtering rule blocked or rejected the packet. If you do not see
any log corresponding to the blocked packet, this means that the packet was processed by a rule that
rejects but does not log. This can be:
• A specific rule written by the Administrator
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• An implicit filtering rule generated by the option Ignore broadcast traffic.
• An implicit filtering rule generated if, in the antispoofing protection, you uncheck Log Input (logs the
packets intended for the FAST360 appliance) or Log Forward (logs the packets going through the
FAST360 appliance).
• An ICMP policy that does not log this code nor this type of ICMP message.
Unsequenced packet

An unsequenced TCP packet has been received.
• Refer to the IP logs for details of the sequence numbers: check the TCP Seq and NoSeq awaited
columns, in particular. There was probably a routing problem: the up flow goes through the FAST360
appliance but not the down flow (or the opposite case).
Log flush on reached threshold

This alert is only relevant to the case of a FAST360 appliance without a hard disk. When the logs take
up to 93% of the disk space, 75% of them are flushed (percentage configurable in Arkoon Manager ).
This alert indicates that the flush was unsuccessful and the Description column provides the name of
the log that should be flushed.
• Refer to the system logs for more information on this problem.
Scheduled log flush

The automatic backup and flush of the database were unsuccessful. The Description column provides
the name of the specific logs.
• Open the System logs for more information on this problem.
Attempt to establish on unknown IPsec SA

This alert indicates that an attempt has been made to establish an unknown IPsec SA. The IPsec SA
cannot be established since there is no corresponding tunnel (in terms of IP, mask and ultimately protocol/
port). The field phase2-requested-tunnel shows the requested tunnel in the same format as the topology
of a VPN tunnel (that can be viewed through Arkoon Monitoring , for example).
An IPsec tunnel has collapsed

This alert is raised when an IPsec tunnel collapses. It is not raised when an IPsec SA is removed
or expires and another SA corresponding to the same tunnel is negotiated. The alert takes the same
information as for the establishment of a new IPsec tunnel.
The level of the alert depends on the reason for the alert, which can be any of the following:
• Latest IPsec SA has expired (Intermediate)
• Considered as dead by 'Dead Peer Detection' (Intermediate)
• Delete notification received (Information)
• IPsec service is stopped (Information)
• Terminated by administrator (Information)
• Peer now uses another IP address (Information)
• Removed by administrator (Information)
Unauthorized IPsec ID used
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This alert indicates that an unauthorized IPsec ID has been used. The ISAKMP SA cannot be established
since there is no defined tunnel which corresponds to the IPsec ID used by the remote machine. In the
case in which LDAP groups are used, this is because the DN of the certificate does not correspond to
any defined group. This alert is also raised when an IP user attempts to connect using either a shared
secret or a certificate for which no connection is defined.
Application protocol violation

A FAST module detected a protocol violation.
• Refer to the IP Logs Description column for more details on the protocol violation. If the flow is blocked
because of a specific command, you can add it in the FAST module's options for this service.
"traffic conditioner name" on "interface name" interface
is dropping packets

This alert is generated for TRTCM traffic conditioners on packet dropping.
"traffic conditioner name" on "interface name" interface
is queuing packets

This alert is generated for TC (Arkoon) traffic conditioners on packet queuing.
"traffic conditioner name" on "interface name" interface
is dropping packets

This alert is generated for TC (Arkoon) traffic conditioners on packet dropping.
"class name" on "interface name" interface is borrowing
bandwidth from "borrowed class name"

This alert is generated for taildropped HTB or CBQ classes on class borrowing.
"class name" on "interface name" interface is dropping
packets

This alert is generated for taildropped HTB or CBQ classes on class dropping.
"class name" on "interface name" interface is borrowing
bandwidth to "borrowed class name"

This alert is generated for RED dropped HTB or CBQ classes on class borrowing.
"class name" on "interface name" interface is probably
dropping packets at "probability" �

This alert is generated for RED dropped HTB or CBQ classes on class probably dropping.
"class name" on "interface name" interface is dropping
packets

This alert is generated for RED dropped HTB or CBQ classes on class dropping.
Static host < MAC @> requested another IP address
< IP @>

This alert is generated when a static hosts requests an address different from the configured one.

High Level
Internet access down

Internet access is not available. The Description column indicates the specific Internet access that
provides the interface used for this access.
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• For more information on the nature of the problem, open the System logs window.
IKE alert

The high-level IKE alert indicates an authentication failure during VPN negotiation. The Description
column provides details of the nature of this problem.
• For more details on VPN negotiation, open the system logs and read the messages of the pluto daemon.
System monitoring alert

This alert indicates that the level of a system monitoring criterion has been modified. The Description
column provides the criterion name, as defined in Arkoon Manager , and indicates the modification of
its state. The value 0 indicates that the monitored element is failing and the value 1 indicates normal
operation.
Arkoon up

The FAST360 appliance underwent an undesired restart.
• Open the System logs to get information on the cause of this undesired restart.
Warning on log queue

The logs queue is 95% busy. All subsequent flows are blocked, except the administration flows. Action
must be taken so that the logs queue is no longer overloaded and standard traffic is reinstated.
• Consult the IP Logs to find out which flows are generating so many logs. Consequently, modify the
logging filtering rules or the anti-DoS configuration. Contact Arkoon support, if needed.
Warning on /var

The /var partition is 95% busy. All subsequent flows are blocked, except the administration flows. An
action must be taken so that the /var partition is no longer overloaded and standard traffic is reinstated.
• Consult the Disk tab of the State of the FAST360 appliance window to view the general and detailed
occupancy of the /var partition. If the database takes a lot of space, export or delete all or part of the
logs. For other cases, contact Arkoon support.
Warning on /config_card

The /config_card partition is 99% busy.
• Consult the Disk tab of the State of the FAST360 appliance window to view the general and detailed
occupancy of the /config_card partition. Contact Arkoon support.
Network traffic blocked due to Aklogd

All flows are blocked, except the administration flows, due to one of the following reasons: disk full (the
/var partition is more than 95% busy), logs queue overloaded (more than 95% used) or kernel queue
overloaded. The Description field shows which of these three reasons is responsible for blocking the
traffic.
• In the case where the blocking is related to disk space use, consult the Disk tab of the State of the
FAST360 appliance window to view the general and detailed occupancy of the /var partition. If the
database takes a lot of space, export or delete all or part of the logs. For other cases, contact Arkoon
support
Administration connection
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An administration connection attempt failed. The Description column specifies the type of administration
connection (SSH, Manager, Monitoring or akslave), the source IP address and the source port, as well
as the cause of the failure.

Example 18.3. Administration Connection Attempt Failed
SSH:
1.1.1.1 :1024 - Authentication failed (root)
Manager: 1.1.1.1 :1025 - Certificate refused : bad certificate
Denial of service detected

This alert is generated when a denial of service is detected. This happens when the protection against
denials of service is activated on an Internet access and the maximum number of TCP-SYN packets or
maximum number of ICMP packets is exceeded. A none-level Denial of service detected alert
is generated when the attack comes to an end.
HA host active

A host swap has occurred: the HA FAST360 appliance that was passive has become active. The
Description column indicates the complete name (host name) of this HA FAST360 appliance.
HA host inactive

A host swap has occurred: the HA FAST360 appliance that was active has become passive. The
Description column indicates the complete name (host name) of this HA FAST360 appliance.
Interface up

The Ethernet interface could not be connected. The Description column provides the name of the
interface and describes the problem.
• Open the System logs for more details.
HA link down

One of the links which maintains communication between the two HA FAST360 appliances (called the
heartbeat) has been disconnected. The Description column provides the name of the particular interface
(Ethernet interface or serial port).
HA link up

One of the links which maintains communication between the two HA FAST360 appliances (called the
heartbeat) has been connected. The Description column provides the name of the particular interface
(Ethernet interface or serial port).
Bad packet

The received packet is faulty: a problem was detected at level 3 or level 4. It can be a Land attack or an
ICMP packet that cannot be related to a connection.
• Refer to the IP logs to find out why the packet was rejected. Look in the Description column, in
particular.
Upgrade

There was a problem while downloading updates (antivirus, blacklists, system patches).
The Description column may provide more information on the nature of this problem:
• - SSLConnecte(support.arkoon.net, 1752) failed: connection timed out can indicate an
Internet access problem
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• SSLConnecte(support.arkoon.net, 1752) failed: gethostbyname() error means there was
a problem accessing the DNS

Note
If needed, consult the system logs to get additional information. If this is a problem accessing
Internet or the DNS, make sure that the access is operational again. In any cases, relaunch the
update manually from the Update window of Arkoon Monitoring .
Arkoon OS patch

A system patch has been installed or uninstalled. The Description column indicates the former version
as well as the new version.
Shared secret authentication problem

This alert indicates that there was a problem decoding an ISAKMP packet encoded using a shared secret.
Bad use of a shared secret is the most probable explanation, but there are other possible causes (such
as corruption of the packet) which cannot be determined.
Quarantine full

The space dedicated to quarantine and its archives are full. New files that must be quarantined will not
be stored and will be deleted.
• Delete some quarantined messages via Arkoon Monitoring . You can also flush the archives via Arkoon
Monitoring or delete a part of the archives on the command line. Finally, you can change the amount
of space allocated to quarantine and the archives in the Mail configuration form General option of the
FAST360 appliance's configuration tab in Arkoon Manager .
Portscan detected

A portscan attempt has been detected. The portscan detection is based on the following conditions:
• At least three packets were rejected and logged (the packets rejected by non-logging rules will not
generate any alerts)
• The packets were received in a time interval shorter than five minutes
• They came from the same IP source
• They were intended for at least three different pairs (IP, port)
The alert frequency for the same IP source is limited to one every five minutes. After this time, any new
packet coming from the IP source generates an alert. This is repeated every five minutes.
• The Description column shows the source IP address that triggered the portscan. Refer to the IP logs
to find out which packets caused this alert.
Service restarted

A service has been restarted for no apparent reason. The Description column indicates the cause of this
restart.
Rejected certificate used

This alert indicates that the ISAKMP SA cannot be established because the certificate used has been
rejected (based on information from the CRL). The rejection of a certificate prevents it from being used to
establish or re-negotiate a VPN tunnel, but does not cause a previously established tunnel to be removed.
License violation
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The FAST360 appliance does not have a license which allows it to let this packet through. In most cases,
the license has not been installed, the primary license has not been retrieved by the secondary or the
license has expired.
• Connect in terminal mode and launch minarkconf .
• If you did not install a license, refer to the Commissioning Guide to generate a license request and
install the license.
• If you have installed a license, select View license in the License menu to make sure that it is installed.
If it is not installed, redo the installation.
• If this is a secondary FAST360 appliance, make sure that it retrieved the license of the primary by typing
the command /usr/akgetlicense/algetlicense infos. If this is not the case, restart the service
'akgetlicense' (via Arkoon Monitoring ) so that it tries to reconnect to the primary. Consult the system
logs for more details, if required.
Virus detected

A virus has been detected by one of the FAST360 appliance's proxies (HTTP, SMTP or transparent POP3
proxy). The Description column provides details: name of the proxy that detected the virus, name of
the virus, possible details about the connection. The processing of the infected data is executed in
compliance with the FAST360 appliance's configuration.
• In the case of the HTTP proxy, its logs show the query with the infected data: this is the one with result
code 494.
• In the case of the SMTP or POP3 relay, the infected messages are shown in the quarantine part of
Arkoon Monitoring , if quarantine was configured.
No more IP address available

A client requests an IP address but all available addresses are currently being used.
Malformed DHCP request

Unsuitable DHCP request received.
Received unmatched DHCP reply

When a reply received from the server does not match any previously sent request.
Malformed DHCP request

Unsuitable DHCP request received.
Malformed DHCP reply

Unsuitable DHCP reply received.
Node state change from �s to �s

Indicates a node state change. State can be “Working”, “Standby”, “Disconnected”.
Data synchronisation failed

Data synchronisation lost between two nodes.
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This chapter describes how to configure the FAST360 appliance for advanced network topologies
including operating in bridge mode, in VLAN architectures, as an IP router, and managing bandwidth
and so Quality of Service.

19.1. Bridge Mode Configuration
This section describes how to configure the FAST360 appliance for bridge mode operation. It covers:
• The mechanisms and characteristics of the bridge mode on the FAST360 appliance ;
• The differences between “furtive” and “non-furtive” modes ;
• Configuring bridge mode on the FAST360 appliance.

19.1.1. Why Use Bridge Mode?
Using a FAST360 appliance in bridge mode facilitates integration of the appliance into existing network
architectures. In bridge mode, the FAST360 interfaces which have been configured for bridging are seen
as layer 2 bridge interfaces by network traffic. Pre-existing IP network and subnet configurations on
network devices need not be changed even if communications pass through the FAST360 appliance.
This approach can be useful in simple installations where the FAST360 appliance is installed on a LAN
between client devices and an Internet router. Using bridge mode, there is no need to modify the IP
configuration of the clients or the router.

Figure 19.1. Simple LAN with FAST360 Appliance

Bridge mode may also be used to analyze and control traffic between LAN segments, once again without
the need to modify IP addressing.

Bridge Mode Configuration
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19.1.2. The Bridge Interface
To configure bridge mode on the FAST360 appliance, configure a bridge interface as one of the interfaces
of the device, then add physical interfaces (eth0, eth1, etc.) to the bridge interface. You can also configure
VLANs as part of the bridge (see Section 19.2, “VLAN Topologies” for VLAN bridging).
As far as network traffic is concerned, the FAST360 appliance is merely a layer 2 bridge. Internally,
however, the bridge interface transparently bridges all traffic into the FAST360 appliance for filtering and
analysis.
There are two types of bridge interface, furtive and non-furtive. In furtive mode the bridge interface has
no IP address, making it essentially invisible to other network devices, but restricting its functionality. In
non-furtive mode most of the security features of the FAST360 appliance are supported. The following
sections detail supported features and how to configure furtive and non-furtive bridge mode operation.

19.1.3. Bridge Interface - Furtive Mode
In furtive mode, the bridge interface does not have an IP address. While this makes the device essentially
invisible to devices connected to the bridged interfaces, it has some restrictions:
• Because there is no IP address, devices connected to networks which form part of the bridge cannot
communicate with the appliance. In particular, this means that management consoles cannot be
placed on bridged networks and you must insure that at least one physical interface is not bridged,
for management connections.
• Proxies, transparent or not, are not supported. This means traffic over the bridge cannot be analyzed
by FAST360 content analysis features (antivirus, antispam, web/URL filtering, etc.)
• VPNs are not supported.
• Interface-based port address translation and IP masquerading with no IP address is not supported.

Note
The FAST360 appliance in furtive bridge mode, while invisible to IP and higher level protocols,
can still be detected by the MAC addresses of the bridged interfaces in a layer 2 analysis of the
network.

19.1.4. Configuring Furtive Bridging
1. In the Network objects explorer view, expand the FAST360 appliance tree and right-click on the
Interfaces folder.
2. From the displayed menu, select New > Bridge Interface. The bridge interface configuration tab is
displayed on the right.
3. Select the Interface configuration form and then in the Bridged interfaces field, drag and drop the
interfaces that are to be bridged together.

Note
Bridged interfaces do not have an IP address. If you add an interface for which an IP address
has been configured, the address will be deleted from its configuration.
4. Select the Advanced form:

Note
Ignore broadcast traffic and Ignore multicast traffic options are activated by default during
the configuration of a new interface.
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a. Leave the Ignore broadcast traffic option checked to prevent broadcast traffic from the
local network being forwarded by this interface.
b. Leave the Ignore multicast traffic checked to prevent this interface from listening for
multicast traffic. Unselect this option if this interface needs to listen for multicast traffic
(for example, for dynamic routing protocols).
c. If the topology requires, check the Custom MTU option modify the MTU value (1500 by
default).

Routing Traffic to Furtive Bridged Networks
As the bridge interface in furtive bridging does not have an IP address, you need to configure a static
route between the bridged network and the bridge interface. This will allow the FAST360 appliance to
manage fragmented packets and to forward TCP RST commands when necessary.
To configure a static route on the bridge interface:
1. In the Network objects explorer view, double-click on the FAST360 appliance icon. The FAST360
appliance configuration tab is displayed on the right.
2. Select the Network configuration form.
3. Select the Static Routes option. The Static Routes table is displayed on the right.
4. Right-click in the blank section of the table.
5. From the displayed menu, select New > Static Route. The Static Route dialog box is displayed and
the entry is displayed in the table.
6. Enter a name and short description of the route in the corresponding fields.
7. In the Destination field, drag and drop the destination bridged host or network.
8. In the Gateway field, drag and drop the bridge interface.

19.1.5. Bridge Interface - Non-furtive Mode
A bridge interface in non-furtive mode has its own IP address and supports most of the functions available
on non-bridged interfaces. However, antispoofing is not supported on the bridge interface (furtive or nonfurtive).

Management Connections and Bridged Interfaces
While it is possible to open administrative connections to the FAST360 appliance from the management
console on a non-furtive bridge interface, this is not recommended as a mis-configuration of the bridge
may result in the management connection being dropped.

19.1.6. Configuring Non-Furtive Bridging
1. In the Network objects explorer view, right-click on the Interfaces folder.
2. From the displayed menu, select New > Bridge Interface. The bridge interface configuration tab is
displayed on the right.
3. Select the Interface configuration form:
a. Check the Enable this interface option.

Bridge Interface - Non-furtive Mode
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b. Enter the IP address and subnet mask for the Bridge interface in the corresponding fields. The IP
address must be in the same network and use the same subnet mask as the hosts connected to
the bridge interfaces.
c. In the Bridged interfaces field, drag and drop the interfaces that are to be bridged together.

Note
Bridged interfaces do not have an IP address. If you add an interface for which an IP
address has been configured, the address will be deleted from its configuration.
d. Select the Advanced form:

Note
Ignore broadcast traffic and Ignore multicast traffic options are activated by default during
the configuration of a new interface.
i. Leave the Ignore broadcast traffic option checked to prevent broadcast traffic from the
local network being forwarded by this interface.
ii. Leave the Ignore multicast traffic checked to prevent this interface from listening for
multicast traffic. Unselect this option if this interface needs to listen for multicast traffic
(for example, for dynamic routing protocols).
iii. If the topology requires, check the Custom MTU option modify the MTU value (1500 by
default).

19.1.7. Managing Security in Bridge Mode
Antispoofing and Bridging
Because bridged interfaces are part of the same IP subnet, it is not possible for Arkoon Manager to
automatically generate implicit antispoofing filtering rules (either in furtive or non-furtive mode). You can
implement antispoofing on bridged interfaces by creating filtering rules as follows:
1. For each bridged interface, configure a group including all the hosts on the network connected to
that interface.
2. Then create filtering rules to block traffic when source and destination addresses are in the same
group. Place these rules at the top of your list of filtering rules.

Table 19.1. Filtering Rules for Protection for Antispoofing
N°

Source

Destination

Service

Action

1

bridged eth0 group bridged eth0 group *

Block

2

bridged eth1 group bridged eth1 group *

Block

Configuring Filtering Rules for Bridged Interfaces
Because bridged interfaces are part of the same IP subnet, when you configure filtering rules you cannot
use the LAN address to filter traffic between interfaces. To filter traffic on a bridged interface, you have to
first create a group of hosts including all the host devices connected to the interface, then use that group
in your filtering rules. For example, in the rule below, setting the LAN as “Source” instead of the group of
hosts would allow somebody who had control of the router to access hosts on the eth0 interface.
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Table 19.2. Filtering Rules for Bridged Interfaces
N°

Source

Destination

1

bridged eth0 group Internet

Service

Action

*

accept

DHCP and Bridge Mode
To enable DHCP exchanges between clients and a server through furtive or non-furtive bridged
interfaces, you will need to proceed as follows:
1. Unselect IgnoreBroadcast in the bridge interface configuration, and in the configuration of interfaces
included in the bridge.
2. Create a filtering rule for the DHCP traffic:
a. Create the following objects:
• A LAN object representing the LAN on which the DHCP server is located;
• A “DHCP Server” host object, with the IP address of the DHCP server ;
• A “DHCP Source” network object with an IP address of 0.0.0.0 and a subnet mask of
255.255.255.255;
• A “DHCP Destination” network object with an IP address of 255.255.255.255 and a subnet mask
of 255.255.255.255;
• A “DHCP” UDP service object, destination port 67, source port 68.
b. Define the following filtering rule:
• Source: “LAN”, “DHCP Source”;
• Destination: “FAST360”, “DHCP Server”, “DHCP Destination”;
• Service: “DHCP”;
• Action: “Accept”.

Using an HTTP Proxy in Bridge Mode
Non-furtive bridge mode supports the use of the FAST360 HTTP proxy (in standard or transparent proxy
configuration). In the HTTP proxy configuration, add the bridge interface (br0) to the proxy’s configuration
by a drag-and-drop action into the Interfaces field.

Note
The proxy is accessible from all bridged interfaces. You can use the Authorized Networks folder
of HTTP/FTP proxy configuration to restrict access to a specified group of hosts if necessary.
The HTTP proxy is not supported by furtive bridge interface configurations.

19.1.8. Bridging and Master/Slave Configurations
In master/slave deployments, filtering rules defined as Automatic will always be installed on appliances
with a furtive bridge interface configured. For more information about master/slave configurations, see
Chapter 14, HA and HP Clustering and Chapter 17, Multi-FAST360 Appliances.

Bridging and Master/Slave Configurations
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19.1.9. Bridging and High Availability Configurations
In high availability configurations, “real” addresses must not be configured on the interfaces to be
bridged. The bridge interface is only started on the active node, which means that the passive node
cannot be managed using the bridge interface. The configuration in Arkoon Manager is identical
to the standard case. For more information about high availability configuration, see Chapter 15, High
Availability for XPA appliances.

Note
In high availability configurations, you must create a virtual IP address for each IP performing a
translation (static translation or port translation) on the interface concerned.

19.1.10. Bridging and transparent proxy
It is not possible to configure transparent proxy (HTTP or POP3) on a bridge interface.

19.2. VLAN Topologies
This section describes how the FAST360 appliance can be integrated into a VLAN architecture to improve
its security.
It details:
• The main integration cases of an FAST360 appliance into a VLAN architecture;
• The configuration of a VLAN on the FAST360 appliance;
• The specific cases of VLAN configuration.
Integrating an FAST360 appliance into a VLAN architecture enables filtering between the VLANs.
Among the existing VLAN standards, the FAST360 appliance implements the most common norm called
802.1q. VLANs can be define by subnetworks, by MAC address or by port. The FAST360 appliance only
fits into VLAN architectures defined by subnetworks. In such architectures, inter-switch communication
is set using tags specifying the VLAN to which it belongs.
The FAST360 appliance can be used for inter-VLAN filtering and inter-switch filtering. It acts as a simple
"filtering" gateway between the networks composed by the VLANs.

19.2.1. Architectures
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Inter-VLAN Filtering on Distinct Subnetworks
The FAST360 appliance can fit into a VLAN architecture as illustrated in the diagram below. The "trunk"
shows that the FAST360 appliance belongs to the VLANs 4, 5 and 6 on one of its interfaces.

Figure 19.2. Filtering on Distinct Subnetworks

In this case, the FAST360 appliance must be explicitly defined as the inter-VLANs routing gateway. This
architecture allows the traffic to be filtered between the VLANs.

Note
If the VLANs do not have distinct addressing, you must define a bridge interface on the FAST360
appliance. For more information on this topic, see the section called “Inter-VLAN Filtering on
Common Subnetworks”.

Particular Case of Inter-switch Filtering
If the architecture has several VLAN switches, the FAST360 appliance can be included as illustrated
below.
In this case, the FAST360 appliance must be explicitly defined as the inter-VLANs routing gateway.

Figure 19.3. Inter-switch Filtering
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Inter-VLAN Filtering on Common Subnetworks
If VLANs share the same addressing, you need to define a bridge interface between all corresponding
VLANs on the FAST360 appliance. This bridge interface can be in furtive mode or in non-furtive mode. It
can bridge more than two interfaces.

Caution
This configuration allows inter-VLAN filtering to the detriment of the level 2 partitioning of the
bridged VLANs.

Note
It is not possible to define several bridge interfaces on the FAST360 appliance. Each VLAN
sharing a subnetwork with another VLAN must thus be integrated into the same bridge interface.

19.2.2. Configuring a VLAN
Configuring a VLAN Interface
Before configuring the VLANs, you must first activate the physical Ethernet interfaces over which the
VLANs will be running. To do this, you need to define an IP address for the physical interface (eth0, eth1
etc). You should use an address which is not part of other address ranges on your network.
For example, if your VLANs are 192.168.1.x, 192.168.2.x, and 192.168.3.x, you can use 192.168.254.x for
physical interfaces on the FAST360 appliances.
Then create a VLAN interface and define:
• The associated Ethernet interface (eth0 in our example)
• The VLAN ID
• The IP addressing
• The possible specific parameters (specific MTU, no logging of IP broadcasts)
The name of the VLAN interface includes the name of the associated Ethernet interface and the VLAN
ID: for instance, a VLAN with 4 as ID on the eth0 interface will be automatically labelled as the eth0.4
interface.

Note
The VLAN ID value is between 0 and 4095 inclusive. The 0 and 1 IDs are rarely used as they are
not recognized by all equipments.
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Configuring Filtering Rules
Flow rules can be used to configure inter-VLAN filtering by IP address.

Note
It is not possible to filter by VLAN ID.

19.2.3. Specific Configurations
HA and VLAN Configuration
In the case of High Availability, the configuration of a VLAN interface is similar to that of a standard
Ethernet interface. You must then configure a real address and a virtual address for each interface (in
our example: eth0, eth0.4, eth0.5 and eth0.6).

Note
The real addresses and the virtual address of eth0 are only used to activate the interfaces: it
has no effect on the routing. In the example, the addresses of the 192.168.254.0/24 is a
subnetwork, which is not used in the network.
On the other hand, it can be useful to choose "significant" addresses for the real addresses of the VLAN
interfaces: if you choose a real address belonging to VLAN 4 for the eth0.4 interface, this will allow
you to administrate the FAST360 appliance from VLAN 4. The graphic below illustrates this situation: the
VLAN real addresses belong to the addressing of the corresponding VLANs.

Figure 19.4. VLAN Real Addresses
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Configuring the Bridged VLANs
The configuration is similar to that of a standard bridge interface.
You must first configure the primary Ethernet interface (eth0 in our example) with the 0.0.0.0/0 address.
You can then define the VLAN interfaces which will belong to the bridge interface by assigning them the
0.0.0.0/0 IP address. Finally, create the bridge interface and select the bridged VLANs.

Figure 19.5. Bridged VLANs

Configuring HA and Bridged VLANs
This configuration is similar to the HA configuration of the bridge interface: no real address must be
configured on the interfaces to be bridged.
In our example, we want to bridge the eth0.5 and eth0.6 VLAN interfaces. You must:
• Configure a false address for the eth0.5 and eth0.6.
• Choose the 0.0.0.0/0 address when configuring the virtual addresses of eth0.5 and eth0.6 in Arkoon
Manager .
• Create the bridge interface by selecting the eth0.5 and eth0.6 VLAN interfaces.
• Assign a non nul address to the bridge interface if it is not in furtive mode.
The example below also includes a VLAN interface which is not bridged (eth0.4). The configuration of
this interface follows the principles presented in the section called “HA and VLAN Configuration”.
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Figure 19.6. HA and Bridged VLANs

19.3. Dynamic Routing
A FAST360 appliance can act as an IP router and offers dynamic routing based on industry-standard
routing protocols.

19.3.1. Routing Methods and Protocols
As an IP network element, the FAST360 appliance can be configured to route IP packets but does not
necessarily have a complete knowledge of the possible paths through the network.
Two types of routing are generally available:
• Static routing: This routing method is based on manually created routing tables (which detail
the possible network paths from source to destination). As such, it is difficult to maintain by the
administrator and is only suitable for small networks.
• Dynamic routing: This routing method is based on automatically updated routing tables. The dynamic
routing mechanism in a router detects changes in the network, automatically updates its routing
table and broadcasts the updated information to its neighbouring routers. As such, it is a very
practical solution in large networks for which routing tables are difficult to manually maintain by the
administrator.
Dynamic routing is implemented in FAST360 appliances from release 3.3 onwards. The three major
Internet routing protocols are supported and described below.
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RIP (Routing Information Protocol)
RIP is a distance vector dynamic routing protocol. Its only criterion for determining the optimum path
through a network is the number of hops to the destination (where a hop is the transfer of information
from one router to the next one in the network). A maximum of 15 hops are allowed.
RIP also exists in an enhanced version, RIPv2, which adds to the functionality of the distance vector
protocol. In addition to the normal periodic broadcasts for routing table updates, RIPv2 also allows routing
table updates to be broadcast as soon as they occur.
RIP and RIPv2 are only suitable for small networks or point-to-point links.

Note
Both RIP and RIPv2 are supported by FAST360 appliance. However, you are recommended to use
RIPv2 rather than RIP. If you wish to use RIP, you must add filtering rules to accept broadcast
flows.

OSPF (Open Shortest Path First)
OSPF is a link-state dynamic routing protocol, developed for Internet IPv4 routing. Its criteria for finding
the optimum path through the network are as follows:
• The costs of the different paths;
• The sum of the available bandwidths between the source and destination points;
In an OSPF environment, a segment hub must be defined which acts as the origin of the network and
to which all other regions of the network are connected. All traffic routed between these other regions
must pass through the segment hub. The routers situated between the different regions are referred to
as Area Border Routers.
OSPF is suitable for large networks which are subject to change and expansion.

BGP (Border Gateway Protocol)
BGP is a link-state dynamic routing protocol which uses TCP transport and is the Internet standard for
connections between operators. Since this protocol is used with external operators, it is not possible
to determine the optimum path to take to the destination. Instead, the aim is to prevent the routers from
using undesirable routes. In doing so, BGP takes the following factors into account:
• The cost involved in paying suppliers for information on external routes;
• The relationship and charging agreements between pairs of operators (i.e. whether money needs to
be exchanged).
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19.3.2. Constraints Imposed by Dynamic Routing
The following constraints are imposed on an FAST360 appliance when dynamic routing has been
activated:
• In a system with multiple appliances, during configuration it is difficult to determine which routes will
be configured on each FAST360 appliance. To avoid ambiguity, all rules are configured on all appliances
which have dynamic routing enabled.
• For appliances with dynamic routing enabled, it is not possible to perform the usual coherence checks
on the FAST360 configuration (for example, to check that filtering rules and any VPNs are correctly
configured for the network topology).
• Static routes must be configured in the normal way in Arkoon Manager on FAST360 appliances with
dynamic routing enabled.
• For XPA appliances, the static routing configuration can also be done using the command interface of
minarkconf routing module or with commands, logging to zebra dameon /usr/zebra/vtysh.

Note
In high availability FAST360 configurations, the way dynamic routing is implemented depends on
the protocol used.
• OSPF and BGP protocols run on a working node;
• OSPF runs on the standby node, but BGP does not;
• On a state change, the OSPF protocol configuration is updated, but the service is not restarted.

Important
RIP is not supported on cluster appliances.

19.4. Quality of Service (QoS)
The FAST360 appliance implements the IETF Diffserv model to provide IP Quality of Service.
Administrators can configure the FAST360 appliance to prioritize network services, monitor network
performance and manage congestion in IP-based networks.

19.4.1. QoS Overview
Standard IP-based networks deliver traffic on a “best-effort” basis and do not differentiate traffic
according to the type of flow. When traffic demands exceed the network's available bandwidth, the
service is degraded. Quality of Service (QoS) enables a network element (e.g. an application, host or
router) to have some level of assurance that its traffic and service requirements will be satisfied. QoS
enables certain flows to be guaranteed a better service than other flows. This is done by either raising
the priority of a flow or limiting the priority of another flow. Implementing QoS requires the cooperation
of all network layers as well as every network element.
The FAST360 appliance implements the IETF Differentiated Services (Diffserv) model to provide IP Quality
of Service.

Important
Until now, the ingoing and outgoing QoS could only be configured in OR out of VPN tunnels. It can
now be done simultaneously in AND out of VPN tunnels in NPA/Performance appliances. To do
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so, you need to select Enable QoS for VPN, from the Interface/Advanded tab of the interface used
to implement the QoS. Moreover, any QoS rule in a VPN tunnel must be configured by interface
and not by Internet access.

Diffserv Model
The Diffserv model [RFC2474, RFC2475] contains the modules that are used to implement IP QoS. They are:
• Rate limiters;
• Markers;
• Classifiers;
• Shapers.

Rate Limiters
Rate limiters evaluate whether the incoming flow conforms to its rate in the defined profile. The FAST360
appliance uses the Token Bucket and Two-Rate Three Color traffic conditioners as rate limiters. For more
detailed information, see the section called “Traffic Conditioning”.

Markers
Markers mark the DS field of the packet header with a value, called the Differentiated Services codepoint
(DSCP), that indicates how to forward the packet to the network. A Diffserv-aware router can then use
the DS codepoint to apply the appropriate forwarding behavior, known as the per-hop behavior (PHB)
to the packet.
The packet marking in the DSCP field complies with the IETF standards for Assured Forwarding (AF)
and Expedited Forwarding (EF) PHBs. Refer to DiffServ QoS standards [RFC2474, RFC2475] for detailed
information.
The 101110 (0x2E) pattern is reserved for the EF class. The EF class ensures highest priority treatment
and traffic marked with an EF DSCP is not queued. For this reason, EF class is used typically for real-time
applications as it provides the highest level of QoS, low latency and minimizes jitter.
The following tables summarize the DSCP codepoints for AF classes. The AF classes are defined by the
3 Most Significant Bits of the DSCP. The 3 Least Significant Bits are the drop precedence bits; they are
defined by the drop precedence of the flow command.
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Table 19.3. DSCP Codepoints for IETF AF Classes
AF1 class

AF2 class

AF3 class

AF4 class

Low
precedence

drop 001010 (0xA)

010010 (0x12)

011010 (0x1A)

100010 (0x22)

Medium
precedence

drop 001100 (0xC)

010100 (0x14)

011100 (0x1C)

100100 (0x24)

High
precedence

drop 001110 (0xE)

010110 90x16)

011110 (0x1E)

100110 (0x26)

Table 19.4. DSCP Codepoints for Cisco QoS Marks
Cisco class

Value

CS1 class

001000 (0x08)

CS2 class

010000 (0x10)

CS3 class

011000 (0x18)

CS4 class

100000 (0x20)

CS5 class

101000 (0x28)

CS6 class

110000 (0x30)

CS7 class

111000 (0x38)

Classifiers
Classification of packets is essential for implementing QoS. Packet classification can be based on various
fields in the IP headers (e.g. source/destination addresses, protocol type) and higher layer protocol
headers (e.g. source/destination port numbers for TCP or UDP). The main use cases are based on a 5tuple classifier. Inside the FAST360 appliance packet classification is carried out by the Arkoon Packet
Filter, in accordance with FAST module analysis. Secondary connections (such as a FTP DATA connection
used by a FTP session) will be handled within the same classifier.

Shapers
Classes are used to discriminate packets. There may be several classes on outgoing interfaces, including
at least the best-effort class. They are filled by the outgoing classifier and emptied by the scheduler.
The scheduling algorithms determine which packets to send next on the network according to the QoS
class in which they are stored. Class scheduling mechanisms manage the sharing of bandwidth among
outgoing flows and forward the packets according to their classification and conditioning. For more
detailed information, see the section called “Scheduling”.

Note
In a master/slave environment, if you create classes or traffic conditioners, even if there is no
QoS rules for an appliance, it is possible to view the bandwith for these classes or conditioners
(by connecting directly) on an appliance where thre is no QoS rule. By default, these classes and
traffic conditioners are installed on all nodes of the master/slave architecture.
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QoS Implementation Principles
1. Inbound packets arriving at different input interfaces are checked against defined QoS ingress rules.
Packets that match the filtering criteria in the ingress rules are sent to the different traffic conditioners
that have been declared.
2. Traffic conditioners either limit the rate of packets per seconds or mark and forward packets if they
are within the defined profile.
3. Packets are then sent to upper layer stacks. Once upper layer processing is done, packets are filtered
by the QoS egress rules.
4. If the packets match the egress rules, they are sent into the different classes, which have their own
queuing, dropping and dequeuing algorithms. These classifiers are grouped by interfaces or outgoing
connection.
5. If the queue is full, dropping algorithms determine whether to queue a packet or to drop it.
6. When a link is available, the scheduler of the interface chooses the packet that should be dequeued
according to the dequeuing algorithm.

Note
It is not possible to use QoS on traffic coming from a VLAN interface.

19.4.2. Ingress Traffic
Ingress traffic refers to incoming flows that originate from outside the network's routers and are destined
for inside the LAN. The FAST360 appliance can use traffic conditioners to control ingress traffic. Incoming
traffic can be processed differently by the traffic conditioners according to the following criteria defined
in the ingress rule:
•
•
•
•
•
•
•

Source (host or network);
Destination (host or network);
Service;
Users;
Date and time;
Internet access (incoming router);
Interface.

The different actions that can be applied to a specific flow are:
• Place the packet inside a Token Bucket or Two-Rate Three Color traffic conditioner to ensure that the
specified flow will use a maximum bandwidth.
• Reserve the bandwidth for the specified flow using a dedicated input queuing mechanism.
• Monitor the bandwidth for the specified flow.
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Traffic Conditioning
A traffic conditioner performs a control process on incoming packets that meters, marks or drops
incoming packets according to the algorithm selected.
The algorithms can be used to control incoming traffic by either:
• Limiting the rate of incoming packets per second (token bucket mechanism)
• Marking the packet (token bucket and TRTCM algorithm)
The packets may be deleted or marked and then forwarded if the traffic is within the defined profile. Each
traffic conditioner is bound to one incoming interface at any time. Traffic conditioning is used to reduce
the burstiness of a traffic stream.

Token Bucket
The token bucket algorithm is a classless queuing mechanism that can be used to transmit inbound
packets on an interface if the fixed rate is not exceeded. The token bucket accumulates tokens at a given
fixed rate. When a packet arrives on the input interface, the traffic conditioner verifies if the size of the
packet is less than the number of tokens.
• If the condition is true, the packet is in profile and the number of tokens is removed from the bucket;
• If the condition is not verified, the packet is out of profile and it will be queued.
With the token bucket mechanism, the FAST360 appliance provides a non-dropping mechanism with
bandwidth reservation for ingress flows. It can be used to police flows, without loosing packets.

Note
The Arkoon token bucket mechanism can be used in the same way for QoS and traffic
management as the Bandwidth Reservation mechanism available in previous releases 3.0 and
4.0 of the FAST360 appliance.
Configuring Token Buckets
1. In the default layout, select the QoS navigation tab from the left hand side of the main window.
2. In the explorer view, expand the Ingress tree and create a new Token Bucket by right-clicking
on the Traffic Conditioners folder, select New > Arkoon Token Bucket. The Arkoon Token Bucket
configuration tab is displayed on the right.
3. In the Properties configuration form, enter the name and a short description in the corresponding
fields.
4. Select the Rates configuration form:
a. Set the value for the committed rate in the Percentage of available bandwidth field. The committed
rate is the guaranteed amount of bandwidth available for the specific flow. The actual transmission
rate of the incoming flow is measured against this configured rate to determine whether it conforms
to the rate defined for its class.
b. Set the value for the maximum rate of bandwidth available for the specific flow in the corresponding
field.
c. Set the queue limit in the corresponding field. This value is the maximum number of packets allowed
to accumulate in the queue for the class.
d. Check the Monitor this conditioner option to monitor the bandwidth of the ingress flow.
5. In the Action configuration form, select the action to be performed on the packets:
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• To allow through packets that are in profile, check the Pass packet option in the Packets below
maximum rate section.
• To allow through and mark the DS field of packets that are in profile, check the Pass packet and
mark it option and drag and drop the appropriate DSCP marker into the DSCP Marker field. The
DSCP marker determines the priority and drop precedence of the flow.
• To allow through packets that are out of profile, check the Pass packet option in the Packets above
maximum size section.
• To allow through and mark the DS field of packets that are out of profile, check the yellow/red Pass
packet and mark it option and drag and drop the appropriate DSCP marker into the DSCP Marker
field.

Two-Rate Three Color Marker
The Two-Rate Three Color Marker [RFC2698] is made up of two token buckets. One token bucket is used
for incoming packets that are in the committed profile; the green action is applied to these packets. The
other token bucket is used for packets that are in the peak profile; the yellow action is applied to these
packets. When a packet does not conform to either of these profiles, the red action is applied.
Configuring Two-Rate Three Color Marker
1. In the QoS explorer view, create a new Two-Rate Three Color Marker (TRTCM) by right-clicking on
the Traffic Conditioners folder, select New > TRTCM. The TRTCM configuration tab is displayed on
the right.
2. In the Properties configuration form, enter the name and a short description in the corresponding
fields.
3. Select the Rates configuration form:
a. Set the value for the committed rate in the Committed rate field. The committed rate is the token
rate for the committed profile.
b. Set the value for the bucket depth for the committed profile in the Committed depth field.
c. Check the Monitor this TRTCM option to monitor the committed rate of incoming traffic.
4. Select the Peaks configuration form:
a. Set the value for the peak rate in the Peak rate field. The peak rate is the token rate for the peak
profile.
b. Set the value for the bucket depth for the peak profile in the Peak depth field.
5. In the Action configuration form, select the action to be performed on the packets:
• To allow through packets that are in the committed profile (rate and depth), check the green Pass
packet option.
• To allow through and mark the DS field of packets that are in the committed profile, check the green
Pass packet and mark it option and drag and drop the appropriate DSCP marker into the DSCP
Marker field. The DSCP marker determines the priority and drop precedence of the flow.
• To allow through packets that are in the peak profile (rate and depth), check the yellow Pass packet
option.
• To allow through and mark the DS field of packets that are in the peak profile, check the yellow
Pass packet and mark it option and drag and drop the appropriate DSCP marker into the DSCP
Marker field.
• To drop packets that are in the peak profile (rate and depth), check the yellow Drop packet option.
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• To allow through packets that are not in the committed or the peak profile (rate and depth), check
the red Pass packet option.
• To allow through and mark the DS field of packets that are in neither profile, check the red Pass
packet and mark it option and drag and drop the appropriate DSCP marker into the DSCP Marker
field.
• To drop packets that are in neither profile, check the red Drop packet option.

Configuring Ingress Rules
1. In the QoS explorer view, expand the Ingress tree.
2. Create a new ingress rule by right-clicking on the QoS Ingress rules folder, select New > QoS Ingress
rule. The QoS Ingress rules configuration tab is displayed on the right.
3. In the Properties configuration form, enter the name of the new ingress rule and a short description
in the corresponding fields.
4. In the Criteria configuration form, select the criteria according to which packets of the incoming flow
will be filtered:
a. Drag and drop the source object into the Sources field.
b. Drag and drop the destination objects into the Destinations field.

Note
If you are using Port Address Translation, the QoS rule must be defined using the FAST360
appliance object as destination.

Note
When selecting Arkoon objects, the FAST360 appliance must be explicitly selected for an
ingress rule to accept it as source or destination.
c. Drag and drop the service objects into the Services field.
d. Drag and drop the user objects into the Users field.

Note
A QoS rule including a selection of users and groups will be used only if the user has
been previously authenticated by a filtering rule. To systematically track the bandwidth
used by the user on a given service, you need to create an authenticated filtering rule
corresponding to the authenticated bandwidth rule.
e. Drag and drop the schedule objects into the Schedules field.

Note
The selected schedule is checked against the FAST360 clock.

Note
If you do not complete the fields with a specific, configured object, any object of the field
type may be taken into account. For example, neglecting to complete the Sources field is
equivalent to accepting any source IP address.
f. To specify an incoming router, check the Internet Access option and drag and drop the Internet
access object into the corresponding field.
g. To specify an interface, check the Interfaces option and drag and drop the interface object into
the corresponding field.
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5. In the Action configuration form, drag and drop the appropriate traffic conditioner object into the
Traffic conditioner field. The selected traffic conditioner acts on the packets that have been filtered
according to the previously defined criteria.

Note
As rules regarding Internet access are applied first, and those regarding interfaces are applied
subsequently, we recommend that you split ingress rules and use only one of these two criterion
in a single rule, that's to say, do not mix Internet Access and Interfaces in the same rule.

19.4.3. Egress Traffic
Egress traffic refers to outgoing flows that originate from inside the network's routers and are destined
for outside the LAN. The FAST360 appliance uses queuing and scheduling algorithms to control egress
traffic, manage congestion and treat traffic according to its priority.

Queuing
Queuing algorithms are used to manage congestion before the packet is sent on the network. Queuing
algorithms determine how packets are dropped when congestion occurs in a router, i.e. when a queue is
full. The FAST360 appliance uses the traditional tail drop mechanism and Random Early Detection, RED
[RFC2309], an active queue management algorithm.

Tail Drop
The tail drop algorithm is a FIFO (First In, First Out) queue. When the maximum length of the queue is
reached, subsequent incoming packets are dropped until the length of the queue decreases (because
packets have been transmitted). Tail drop is the default dropping algorithm.

RED
The Random Early Detection (RED) drop policy randomly drops or marks incoming packets when the
average queue length exceeds a minimum threshold (qmin). The drop probability increases with the
average queue length, up to a maximum dropping probability (pmax).
When the average queue length reaches an upper threshold (qmax), all packets are dropped. The
average queue length is calculated with an Exponential Weighted Moving Average (EWMA), defined with
the averaging parameter P.
This can be summarized in the following formula: Qt = Qt-1 + P (Mt - Qt-1) where:
• Mt is the measured queue length at time t
• Qt is the average queue length at time t
• P is the averaging parameter
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Configuring RED Parameters
The RED algorithm parameters are configured in the Dropper configuration form of the appropriate traffic
scheduler, i.e. the CBQ or HTB class.
1. In the Maximum queue size field, set the limit of the queue size. This value is not an average and is
set in packets. Beyond this limit, all packets are dropped. This value should be set higher than the
minimum threshold added to the maximum threshold. It is advisable to set this value a few times higher
than the maximum threshold.
2. In the Drop probability field, set the probability with which a packet will be dropped when the queue
reaches the maximum threshold. Drop probability increases as the estimated average queue size
grows. It is specified in percent.
3. In the Maximum threshold field, set the average queue size above which all packets will be dropped.
This value is set in packets.
4. In the Minimum threshold field, set the average queue size at which dropping packets becomes a
possibility. Thus, below this value, no packets will be dropped. This value is set in packets.
5. In the Maximum burst field, set the maximum burst size used to determine how fast the average queue
size is influenced by the real queue size.
Experiments support the following guideline: (2 * min threshold + max threshold) / 3 (value in packets)

Scheduling
Scheduling algorithms are used to determine which packets to send next on the network according to the
QoS class in which they are stored. Scheduling mechanisms manage the sharing of bandwidth among
outgoing flows and forward the packets according to their classification and conditioning. A scheduler
(and only one) is declared on each interface where QoS is activated on outgoing traffic.
To respond to the QoS needs of different connections, nodes need to have priority and scheduling
mechanisms. The priority feature typically refers to the capability of providing different delay treatments,
e.g., higher priority packets are always served before lower priority ones, both in the context of packet
processing and transmission on outbound links. Nodes also implement different loss priority treatment,
i.e. higher loss priority packets are lost less often than lower loss priority ones. Nodes also need to have
the closely related scheduling mechanisms, to ensure that different connections obtain their promised
share of resources (i.e. processing and link bandwidth). This mechanism also ensures that any spare
capacity is distributed in a fair manner.

Classes
Classes are used to discriminate packets. There may be several classes on outgoing interfaces, including
at least the best-effort class. They are filled by the outgoing classifier and emptied by the scheduler.
In the basic case, classes share the bandwidth in a rather fair way. In a more complex case, classes
can be organized in a hierarchical way, for a more flexible bandwidth sharing. You can create as many
classes as you want. A parent class must be defined, derived from the predefined root class. The default
(root/parent) class can always borrow bandwidth from its children class as long as excess bandwidth
is available. A child class can borrow bandwidth from its parent class as long as excess bandwidth is
available if borrowing is enabled. By default, borrowing is disabled.
The FAST360 appliance supports the Class Based Queuing (CBQ) and Hierarchical Token Bucket (HTB)
scheduling mechanisms.
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Class Based Queuing
CBQ (Class Based Queuing) achieves both partitioning and sharing of bandwidth by hierarchically
structured classes. Each class using CBQ has its own queue and is assigned its share of bandwidth. A
CBQ class can only be linked with a CBQ root class.
Configuring Class Based Queuing Root Class
1. In the QoS explorer view, create a new CBQ Root Class by right-clicking on the CBQ folder, select New
> Root CBQ Class. The Root CBQ Class configuration tab is displayed on the right.
2. In the Properties configuration form, enter the name of the root class and a short description in the
corresponding fields.
3. Select the Parameters configuration form:
a. Set the absolute value for the bandwidth to be assigned to the root class in the Available bandwidth
field. The bandwidth assigned to the class is the guaranteed bandwidth delivered to the class
during congestion, this is typically the bandwidth of the Internet access or of the interface.

Note
To obtain greater precision using the CBQ mechanism, set the CBQ root bandwidth value
close to that of the interface speed value.
b. Check the Enable children class to borrow bandwidth option to enable the child class to borrow
bandwidth from this parent class.
c. Check the Enable class monitoring option to monitor the dequeuing rate.
4. To configure advanced root class parameters, select the Advanced configuration form and check the
Customize advanced parameters option:
a. Set the maximum allowed number of packets per burst in the Maximum burst field. By default, this
value is set to 50 packets per burst.
b. Set the minimum required number of packets per burst in the Minimum burst field. By default, this
is set to 0 packets per burst.
c. Set the maximum packet size in the Maximum packet size field. By default, this value is set to 1518
bytes.
d. Define the average packet size to use to convert packets to byte size (to use for limit computations)
in the corresponding field. By default, this is set to 512 bytes.
Configuring Class Based Queuing
1. In the QoS explorer view, create a new CBQ Class scheduler by right-clicking on the CBQ folder, select
New > CBQ Class. The CBQ Class configuration tab is displayed on the right.
2. In the Properties configuration form, enter the name of the class and a short description in the
corresponding fields.
3. Select the Paramaters configuration form:
a. Set the value for the bandwidth to be assigned to the class in the Bandwidth fields. You can
set either an absolute value or percentage value for bandwidth in the corresponding field. The
bandwidth assigned to the class is the guaranteed bandwidth delivered to the class during
congestion, this is typically the bandwidth of the Internet access or of the interface.
b. Check the Enable class monitoring option to monitor the dequeuing rate.

468

| Egress Traffic

Chapter 19. Advanced Network Topologies

c. Check the Marker option to mark the packet header and drag and drop the appropriate DSCP
marker into the DSCP marker field.
d. Drag and drop a root/parent class into the Parent class field.
4. Select the Borrowing configuration form and check the Enable borrowing/sharing of bandwidth
between classes option to enable the sharing of bandwidth between classes. By default, borrowing is
disabled. If borrowing is activated in the child class, it also needs to be enabled in the root class. Note
also that the total bandwidth for all child classes must not be greater than the bandwidth of the parent.
5. Select the Dropper configuration form:
• Leave the Taildrop option checked to use the tail drop algorithm to determine how packets are
dropped. Tail drop is the default dropping mechanism.
• Check the RED (Random Early Detection) option and set the corresponding parameters as
described in the section called “Configuring RED Parameters” to use the RED algorithm to
determine how packets are dropped.
6. To configure advanced class parameters, select the Advanced configuration form and check the
Customize advanced parameters option:
a. Set the maximum allowed number of packets per burst in the Maximum burst field. By default, this
value is set to 50 packets per burst.
b. Set the minimum required number of packets per burst in the Minimum burst field. By default, this
is set to 0 packets per burst.
c. Set the maximum packet size in the Maximum packet size field. By default, this value is set to 1518
bytes.
d. Define the average packet size to use to convert packets to byte size (to use for limit computations)
in the corresponding field. By default, this is set to 512 bytes.
e. Set the hard priority in the corresponding field. This value is the priority of the leaf class (a leaf
class is a terminal class thus it never contains a child class); lower priority leaf classes are served
first. By default, this value is set to 4.

Hierarchical Token Bucket
Hierarchical Token Bucket (HTB) is based on a structure of class traffic which is hierarchical. A HTB
class can be linked with a root class or another HTB class.
Configuring Hierarchical Token Bucket Root Class
1. In the QoS explorer view, create a new HTB Root Class by right-clicking on the HTB folder, select New
> Root HTB Class. The Root HTB Class configuration tab is displayed on the right.
2. In the Properties configuration form, enter the name of the root class and a short description in the
corresponding fields.
3. Select the Parameters configuration form:
a. Set the absolute value for the bandwidth to be assigned to the root class in the Available bandwidth
field. The bandwidth assigned to the class is the guaranteed bandwidth delivered to the root class
during congestion, this is typically the bandwidth of the DSL or of the interface.
b. Check the Enable children classes to borrow bandwidth option to enable the child class to borrow
bandwidth from this parent class.
c. Check the Enable class monitoring option to monitor the dequeuing rate.
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Configuring Hierarchical Token Bucket
1. In the QoS explorer view, create a new HTB Class scheduler by right-clicking on the HTB folder, select
New > HTB Class. The HTB Class configuration tab is displayed on the right.
2. In the Properties configuration form, enter the name of the class and a short description in the
corresponding fields.
3. Select the Parameters configuration form:
a. Set the value for the bandwidth to be assigned to the class in the Bandwidth fields. You can
set either an absolute value or percentage value for bandwidth in the corresponding field. The
bandwidth assigned to the class is the guaranteed bandwidth delivered to the class during
congestion, this is typically the bandwidth of the DSL or of the interface.
• The absolute value is the rate allowed for the class.
• The percentage value is the percentage allowed of the parent class.
b. Check the Enable class monitoring option to monitor the dequeuing rate.
c. Check the Marker option to mark the packet header and drag and drop the appropriate DSCP
marker into the DSCP Marker field.
d. Drag and drop a root/parent class into the Parent Class field.
4. Select the Borrowing configuration form:
a. Check the Enable bandwidth borrowed option to enable the borrowing/sharing of bandwidth
between classes. By default, borrowing is disabled. If borrowing is activated in the child class, it
also needs to be enabled in the root class. Note also that the total bandwidth for all child classes
must not be greater than the bandwidth of the parent.
b. From the Maximum bandwidth borrowed options, select either an absolute or percentage value
and enter the maximum bandwidth the class can borrow in the corresponding field. This bandwidth
must be greater than the nominal bandwidth defined in the class.
5. Select the Dropper configuration form:
• Leave the Taildrop option checked to use the tail drop algorithm to determine how packets are
dropped. Tail drop is the default dropping mechanism.
• Check the RED (Random Early Detection option and set the corresponding parameters as described
in the section called “Configuring RED Parameters” to use the RED algorithm to determine how
packets are dropped.
6. To configure advanced class parameters, select the Advanced configuration form and check the
Override custom parameters option:
a. Set the maximum allowed number of packets per burst in the Maximum burst field. By default, this
value is set to 50 packets.
b. Set the amount of bandwidth that can be borrowed in case of bursty flows in the Minimum burst
field. By default, this is set to 0 packets.
c. Set the maximum packet size in the Maximum packet size field. By default, this value is set to 1518
bytes.
d. Set the minimum packet size in the Minimum packet size field. By default, this value is set to 64
bytes.
e. Define the overhead packet size in the Average overhead per packet field. The overhead packet
size can be defined as the average size of data per packet utilized by non applicative network
layers. By default, this is set to 38 bytes: Ethernet media layer header size (8 bytes) + IP network
layer header size (20 bytes) + TCP transport layer header size (10 bytes).
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f. Set the hard priority in the Hard Priority field. This value is the priority of the leaf class (a leaf class
is a terminal class thus it never contains a child class); lower priority leaf classes are served first.
By default, this value is set to 4.

Note
The Hard Priority parameter can be useful when defining low latency queueing for VoIP
flows.

Note
Only attempt to modify HTB advanced parameters if you are a confident and experienced QoS
administrator; otherwise, leave the default values.

Configuring Egress Rules
1. In the QoS explorer view, expand the Egress tree.
2. Create a new egress rule by right-clicking on the QoS Egress rules folder, select New > QoS Egress
rule. The QoS Egress rule configuration tab is displayed on the right.
3. In the Properties configuration form, enter the name of the new egress rule and a short description
in the corresponding fields.
4. In the Criteria configuration form, select the criteria according to which packets of the outgoing flow
will be controlled:
a. Drag and drop the source object into the Sources field.
b. Drag and drop the destination objects into the Destinations field.

Note
If you are using Port Address Translation, the QoS rule must be defined using the FAST360
appliance object as destination.

Note
When selecting Arkoon objects, the FAST360 appliance must be explicitly selected for an
egress rule to accept it as source or destination.
c. Drag and drop the service objects into the Services field.
d. Drag and drop the user objects into the Users field.

Note
A QoS rule including a selection of users and groups will be used only if the user has
been previously authenticated by a filtering rule. To systematically track the bandwidth
used by the user on a given service, you need to create an authenticated filtering rule
corresponding to the authenticated bandwidth rule.
e. Drag and drop the schedule objects into the Schedules field.

Note
The selected schedule is checked against the FAST360 clock.

Note
If you do not complete the fields with a specific, configured object, any object of the field
type may be taken into account. For example, leaving the Sources field blank is equivalent
to accepting any source IP address.
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f. To specify an outgoing router, check the Internet Access option and drag and drop the Internet
access object into the corresponding field.
g. To specify an interface, check the Interfaces option and drag and drop the interface object into
the corresponding field.
5. In the Action configuration form, drag and drop the appropriate traffic scheduler object into the Traffic
class field. The selected queuing mechanism schedules outgoing packets according to the QoS class
in which they are stored.

19.4.4. Use Case
The majority of Internet applications, such as email, FTP, etc., function reasonably well during delays and/
or variations in packet delivery caused by traffic bursts. Real-time applications such as VoIP, however,
are noticeably affected by latency and jitter which results in a “choppy” conversation punctuated with
echoes. The FAST360 appliance can be configured to prioritize the real-time flows over the lower priority
data flows.

Real-time Flows vs. Non-urgent Traffic
A customer with a 8Mb ADSL line needs to manage real-time Voice over IP (VoIP) traffic and data traffic
in the network.

Figure 19.7. Real-time Flows vs. Non-urgent Traffic

To do this, the network administrator needs to configure the ingress and egress rules for the VoIP and
data flows to:
• Prevent bursts of data traffic from downgrading VoIP latency
• Optimize the ADSL bandwidth
The administrator needs to configure the ingress rules as follows:
1. Configure ingress rule for data flows from LAN to Internet with the TRTCM, mark packets “DSCP Best
Effort” for yellow packets and drop red packets. This will prevent bursts of data from affecting the
VoIP traffic as the data packets are forwarded only when there is bandwidth available.
2. Configure ingress rule for real-time flows from VoIP LAN with a TRTCM with a high limit value and
mark with EF marker. This will ensure that VoIP flows are given the highest priority and are not queued,
and so provides low loss, latency and jitter for the voice connection.
The egress rules need to be configured so that a part of the bandwidth is reserved for VoIP flows and
data flows are restricted:

472

| Use Case

Chapter 19. Advanced Network Topologies

1. Configure egress rule from the VoIP LAN with EF DSCP marker or CBQ class unit 6Mb reserve without
borrowing.
2. Configure egress rule from data LAN with CBQ mechanism and the RED dropping algorithm. This will
smooth/slow down the TCP/data flow.
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Chapter 20. Updating, Replacing, and Reinitializing
FAST360 Appliances

20.1. Managing Updates
This section presents:
• Management of FAST360 appliance versions
• Procedure for automatic downloads
• Updates procedure
• Procedure for updates in disconnected mode
• Explanation of how to reinstall the previous system version

20.1.1. Update Principles
To maintain your FAST360 UTM appliance in a state-of-the-art operational state, several updates are
available automatically or manually on Arkoon update servers.
• System updates, depending on their type can contain functional patches, security fixes and new
product features. All FAST360 appliances with a valid license can download the system updates.
• IDPS signatures updates contain evolutions of current signatures and/or new signatures to counter
the most recent security weaknesses. Downloading and installing these updates requires a specific
license on the FAST360 appliance.
• Antivirus updates contain evolutions of the antivirus analysis engine and/or new virus signatures.
Downloading and installing these updates requires a specific license on the FAST360 appliance.
• Filtering categories updates contain evolutions of the blacklisted URLs and their categorization.
Downloading and installing these updates requires a specific license on the FAST360 appliance.

20.1.2. System Updates
Principles
A system update consists of installing a completely new version of the whole system (distribution and
kernel) instead of the currently running version of the system. This is done using Arkoon Monitoring .
The FAST360 appliance is first and foremost a security gateway, its system update procedures are thus
paramount to ensuring the security of the whole infrastructure. The key to a successful update can be
described in three words:
Reliability

No matter what happens, the appliance's system is left in a consistent state
after the update. In case of error, the old system remains untouched. This is

Managing Updates

| 475

Chapter 20. Updating, Replacing, and Reinitializing FAST360 Appliances

primarily achieved by ensuring all update steps are carried out appropriately, and
implementing rollback strategies where needed. However it is good practice to
backup all configurations and log files before updating the appliance’s system.
Integrity

The installed system is guaranteed to be identical to the image distributed by
Arkoon. In case of error, the running system still satisfies all integrity checks.

Accountability

Like all operations involving the security of the system running on the FAST360
appliance, system updates leave a complete audit trail visible in Arkoon alerts.
All steps of the update process are logged and any failures properly reported.

Types of FAST360 Releases
Arkoon Network Security offers two types of releases, major and intermediate, corresponding to different
user requirements.

Major Releases
A major release – 4.0, 5.0 – is maintained for an extended life cycle, with security corrections and bug
fixes as necessary but with no additional features introduced. A major release is the optimum platform
choice for installations where long-term stability is important, and where the new features introduced
by intermediate releases are not required.
Each new major release “rolls up” new features introduced by the intermediate releases on the previous
major release – for example, major release 5.0 includes the new features introduced by intermediate
releases 4.1, 4.2 etc.
A major release is identified by the .0 version number (currently 5.0), followed by a revision level, for
example 5.0/3 for the third revision (security patches or fixes) for major release 5.0.

Intermediate Releases
An intermediate release adds new features to a major release. We recommend upgrading to an
intermediate release only if you need the new functionality delivered by that release.
Intermediate releases are cumulative; that is, each new intermediate release builds on and adds to the
previous intermediate release. Support for an intermediate release ends with the introduction of the
subsequent intermediate release, or a new major release. This means that when you choose to upgrade
to an intermediate release, you are also committing to more frequent upgrade cycles for your FAST360
appliances.
An intermediate release is identified by a non-zero decimal: 5.1, 5.2, etc., followed by a revision number:
5.2/3, for example.

Update Modes
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Axx Appliances
Two types of updates exist, namely version updates and patch updates.
A version update allows you to:
• Update from a major release to a new major release (example: 4.0 to 5.0), or to an intermediate release
(example: 4.0 to 4.2).
• Update from an intermediate release to another intermediate release (example: 4.1 to 4.2), or to a major
release (example: 4.2 to 5.0).
A patch update contains maintenance fixes (functionalities or security). Updating by installing a patch is
not a version update: it increases the patch number of this version.

Note
A10W or A20W types are only updated by installing the image of the desired version (for installing
an upgradeable version, a major version or a maintenance patch).

NPA and XLarge Appliances
Updates on these appliances are referred to as ‘sysupdate’ updates. A short description of each available
version is displayed in the System Update window in Arkoon Monitoring .
A 'sysupdate' update allows you to update to all higher revisions.
Updates to lower versions are also possible, as long as the major version remains above 5.0.

20.1.3. Managing Updates
This section explains how to download and install updates, whether connected or not to an update server
(respectively referred to as connected and disconnected mode in this section).

Downloading Updates (connected mode)
There are several ways to download the updates, depending on the Internet connectivity available to
the appliance:
• If the FAST360 appliance has direct access to Internet, it can use an SSL connection on port 1752 to
download the updates from the Arkoon support server.
• If the FAST360 appliance accesses the Internet via an HTTP proxy, it can download the updates via
this proxy.
• If the FAST360 appliance has no Internet access but can connect to another FAST360 appliance which
can update itself, it can download the updates from this FAST360 appliance.
• If the FAST360 appliance has no Internet access, it is possible to download the updates to another
machine and to manually transfer them to the FAST360 appliance later.

Note
A10W and A20W appliances cannot download antivirus and filtering categories updates since
they do not implement proxy services. For more details of updates on these appliances, refer to
the section called “System Updates on a FAST360 Appliance without a Hard Disk”.
Configure the automatic download of updates using Arkoon Manager . In the Update configuration form
of the FAST360 appliance configuration tab, you can configure the following:
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• Connection settings to the server
• Update frequency

Connection Settings
Default configuration: the FAST360 appliance is configured to update from support.arkoon.net via an
SSL connection on the TCP 1752 port. This update mechanism is used when the FAST360 appliance has
unrestricted access to the Internet.

Important
Port 443 can be used for updates but it is necessary to create a flow rule. Select the FAST360
appliance as source, the update servers as destination and the TCP 443 service without the FAST
analysis.
The update servers are:
• ArkoonUpdate-1 195.167.226.86
• ArkoonUpdate-2 195.167.226.87
• ArkoonUpdate-3 195.167.226.88
• ArkoonUpdate-4 195.167.226.89
Without this rule, the update flow would be blocked by the FAST analysis because the certificate
used to be identified on the server is self-signed.

Unrestricted Internet Access
Conditions: the FAST360 appliance can connect to Internet servers on the TCP 1752 and UDP 53 ports.
On the FAST360 appliance, you must:
• Indicate at least one DNS server in the FAST360 appliance configuration.
• Keep the default update configuration.
1. In the Network objects explorer view, double-click on the FAST360 appliance icon. The FAST360
appliance configuration tab is displayed on the right.
2. Select the Update configuration form.
3. Drag and drop a default update policy into the Update policy field.
4. To view the properties of the default update policy, double-click on its icon. A new configuration form,
labeled Update policy is displayed.
5. In the Update server field, double-click on the Arkoon Update icon to view its properties. A new tab,
labeled Arkoon Update is displayed.
6. Select the Services form.
• Check that Update Server is selected.

Access via a HTTP Proxy
Conditions: the FAST360 appliance can connect to Internet via an HTTP proxy. You must know the port
on which this HTTP proxy is accessible, as well as a user name and a password if the proxy requires
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authentication. This HTTP proxy must connect to Internet servers on port 1752 or 443 (standard HTTPS
port).
On the FAST360 appliance, you must:
• Indicate port 443 instead of 1752 port 1752, if the HTTP proxy cannot open connections to the 1752 port
• Create a host with an IP address of the HTTP relay.
• Define the proxy access settings in the update configuration.
1. Select the Update configuration form.
2. Drag and drop a default update policy into the Update policy field.
3. To view the properties of the default update policy, double-click on its icon. A new configuration form,
labeled Update policy is displayed.
4. In the Update server field, double-click on the Arkoon Update icon to view its properties. A new tab,
labeled Arkoon Update is displayed.
5. Select the Services form.
• Check that Update Server is selected.
• Select the HTTP Proxy option and indicate the connection port.
6. Return to the Update Policy configuration form and select the Update Proxy form.
• Check the Use proxy option and then drag and drop the host representing the HTTP proxy into the
Update proxy field.
• Check the Enable authentication option and complete the Username Password and Confirmation
fields, if required.

Access via an Update Relay FAST360 Appliance
Conditions: the FAST360 appliance being configured must be able to connect to a FAST360 appliance
which can receive updates. Both these FAST360 appliances must have certificates signed by the same
CA.
The update relay FAST360 appliance must be configured as follows:
• The Serve as update proxy option must be enabled and the hosts corresponding to the internal FAST360
appliances must be specified.
• A DNS server must be specified in the FAST360 appliance configuration.
1. Select the Update configuration form.
2. Drag and drop a default update policy into the Update policy field.
3. To view the properties of the default update policy, double-click on its icon. The Update Policy
configuration form is displayed.
4. In the Update server field, double-click on the Arkoon Update icon to view its properties. A new tab,
labeled Arkoon Update is displayed.
5. Select the Services form.
• Check that UpdateServer is selected.
6. Return to the Update configuration form in the FAST360 appliance configuration tab.
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7. Check the Serve as update proxy option.
8. Drag and drop hosts corresponding to the internal FAST360 appliances into the Authorized clients
field.

Note
Using the update mechanisms implies you trust the security of the Arkoon server. This
mechanism creates an implicit filtering rule from the FAST360 appliance to the update server.

Note
A FAST360 appliance without a hard disk cannot serve as update relay for another FAST360
appliance.

Note
A FAST360 appliance cannot serve as system update relay (patch or system image) for another
FAST360 appliance with a different distribution base (for instance a FAST360 5.0SMP appliance
cannot serve as update relay for FAST360 5.0EMB appliances).
On the FAST360 appliance which will connect to the update relay FAST360 appliance, you must:
• Indicate the IP address and the port on which to connect to the relay FAST360 appliance.
• Select Arkoon in the Certificate Authority field in the Update Server configuration form of the Update
Policy configuration tab.

Update Frequency
Default configuration: for an appliance with a hard disk, the default frequency is 24 hours. It is set to a
random time at night. FAST360 appliances without a hard disk do not have a predefined frequency value
set, they do not download updates automatically.
Frequency of updates can be defined in the Update Server form of the Update Policy configuration tab.
Three different options are available:
• Every mn for the frequency expressed in minutes
• Every h at th minute for the frequency expressed in hours and minutes
• Every day at h mn for a specific time expressed in hours and minutes within 24 hours

Note
If you have a permanent Internet connection, it is recommended that you configure hourly update
requests. This will have little impact on bandwidth as downloads only occur when necessary.

Installing Updates (connected mode)
Installing System Updates on Axx Appliances
There are two update methods for a FAST360 appliance with hard-disk:
• patch update
• version update
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Updates are not taken into account automatically since the installation requires a reboot of the FAST360
appliance. It requires that the administrator intervenes and chooses the version to install.
When a new system patch is available, a message is displayed in the status bar of Arkoon Monitoring .
The downloaded patch is available in the left column of the Updates window of Arkoon Monitoring .

Note
The system systematically downloads on the FAST360 appliance the available patches for the
current version, when the system downloads the image of the version to be installed only when
the administrator asks for the version.
When you select a patch in Arkoon Monitoring , the right column shows the detail of the fixes and
improvements brought by this patch. Release Notes regarding the patches can be found at http://
client.arkoon.net. From this site, you can also download the new versions of Arkoon Tools .
To activate this patch, you must:
1. Check the status of this patch by clicking the Check button.
When you install a patch, there are several statuses possible:
• to be checked: you must check the patch by clicking the Check button;
• valid: the patch is valid, you can apply it;
• to install as soon as possible: this patch includes security updates, it must be applied as
soon as possible;
• caution: this patch requires to take some precautions indicated in the right column;
• forbidden: this patch must not be installed: the next patch will fix the problem included in this patch;
• error: this patch could not be checked: see the system logs to have more information on the
encountered problem, and launch the check again.
2. If the status is valid, install the patch by clicking the Apply button.

Caution
This will launch the installation of the patches as soon as you have confirmed your choice. The
FAST360 appliance is then restarted.

Note
It is possible to install several patches at the same time. To do so, check and apply the latest
one (last one in the list).

Note
If a problem occurs during the installation of the patches, the previous system version will be
automatically reinstalled.
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Updating High Availability (HA) Configurations
The specificity of the update for an HA FAST360 appliance comes from the fact that the passive FAST360
appliance retrieves the patches on the active FAST360 appliance as soon as this one has downloaded
them. Nevertheless, it cannot check the status of theses patches on the support server. The check of this
status must be done on the active FAST360 appliance.
To minimize the number of switches and thus service interruptions, proceed as follows:
1. Connect to the active FAST360 appliance using Arkoon Monitoring and check the status of the patch.
2. If the patch is valid, connect via Arkoon Monitoring to the passive appliance.
3. Click the Check button. An "error" status papers with a message indicating that the FAST360 appliance
could not connect to the support server. The Apply button is then enabled.
4. Click the Apply button to apply the patch on the passive FAST360 appliance. The passive FAST360
restarts and is updated.

Caution
If the patch includes a modification of the HA mechanisms, the replication of the active
connections (if configured) will not be operational while the two appliances do not have the
same system version.
5. Connect to the active FAST360 appliance using Arkoon Monitoring . Click the Apply button to take
the patch into account.
6. The active FAST360 appliance restarts and initiates a switch.
Updating Master/Slave Configurations
In a multi-appliance architecture, proceed as follows:
1.

First, update the slave appliances. Since backward compatibility is guaranteed, the slave appliances
can always receive and install the master configurations that are still in the previous version.

2.

Once the slave appliances are updated, update the master appliance with the same version as the
slave ones.
It is recommended to use the same version for all your Arkoon appliances.

System Updates on a FAST360 Appliance without a Hard Disk
For FAST360 appliances without a hard disk, there is only one system update method, which consists in
directly installing the desired version (like the version update in the case of an FAST360 appliance with
a hard disk).
The procedure is:
1. Connect to the FAST360 appliance with Arkoon Monitoring and open the Update window. This
automatically establishes a connection to the update server.
2. The FAST360 appliance downloads the list of the images available on the server. The status of these
images is automatically checked and is displayed in the right column.
3. Select the system image you want to install and click the Install button.
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This:
• Downloads the system image (kept in RAM);
• Clears the logs to free space on the /var partition;
• Saves the former system on the /var partition;
• Installs the new system image;
• Restarts the FAST360 appliance.
4. If the installation is successful, the former system saved on the /var partition is suppressed.
Otherwise, it is restored after a new restart.

Installing System Updates on NPA/Performance, XLarge and Virtual Edition Appliances
Arkoon Monitoring is also used to install system updates on appliances in the NPA/Performance, XLarge
and Virtual Edition range.
The procedure for installing updates on these appliances is:
1.

Connect to the FAST360 appliance with Arkoon Monitoring and open the Update window. This
automatically establishes a connection to the update server.

2.

The FAST360 appliance downloads the list of the 'sysupdates' files available on the server. The status
of these files is automatically checked and is displayed in the right column.

3.

Select the system update you want to install and click the Install button.
This:
• Downloads the system update completely
• Saves the former system
• Installs the new system update
• Restarts the FAST360 appliance

Note
During each update, the download and the complete copy of the new version are performed.
That's why updating can take some time and depends on the quality of your Internet access.

Important
It is recommended you first update the non-master node and then update the master node. The
non-master node connects to the master node in order to download the update files. If the master
node has already perform an update, then it already has the files to transmit to the non-master
node (in /var/arkupdate). Otherwise it downloads the files from the update server and transmit
them to the non-master node.
Updating a High Availability (HA) cluster leads to 2 failovers:
• Non-master node 2 update: failover.
• Master node 1 update: 2 failovers.
• When master node 1 applies the update, it restarts and delegates its services: first failover
for node 1 to node 2.
• When node 1 has restarted, it becomes master again and handles services: second failover
for node 2 to master node 1.
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Updating a High Performance (HP) cluster leads to 4 failovers:
• Non-master node 2 update: 2 failovers.
• When non-master node 2 applies the update, it restarts and delegates its services: first
failover.
• When node 2 has restarted, it handles its services: second failover.
• Master node 1 update: 2 failovers.
• When master node 1 applies the update, it restarts and delegates its services: first failover.
• When node 1 has restarted, it becomes master again and handles its services: second
failover.

Installing Antivirus, Filtering Categories and IDPS Updates
The antivirus, filtering categories and IDPS signatures updates are automatically taken into account as
soon as they are downloaded.
With Arkoon Small S90 and S150, P-XS3 and P-S4 appliances with no hard drive or low-capacity hard
drive, antivirus and ADVANCED_URL categories updates are not automatically downloaded if these
functionalities are not used in your configuration. In some cases, it can be useful to force the download of
all modules (for example, in cases of off-network use or when preparing appliances ready to use although
they do not have configuration or license file).
To force the update of all modules, add the following line to the file /config_card/etc/arkoonconfig.local :
arkupdate.heavy-downloads.enable=true

The behavior on other types of appliances keeps unchanged. It is nevertheless possible to make them
apply this behavior via the configuration key above by changing its value.

Downloading Updates (disconnected mode)
Manual Download
The http://client.arkoon.net site indicates the procedure for accessing the FAST360 appliance customer
space. In the FAST360/Downloads section, you will find the update files corresponding to your type of
appliance. The use of this file (updated with each new version) allows for a simplified updates.

Important
The initial name of the downloaded files must be kept. Verify that your browser did not truncate
the name of the files while downloading them. If they are truncated, rename the files according
to the names of the links visible on the customer space.
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Transferring Updates to the FAST360 Appliance
You can transfer the files on the FAST360 appliance by using a tool relying on SSH protocol.

Installing Updates (disconnected mode)
Installing System Updates on A10W and A20W Appliances
You can perform a system update of a FAST360 appliance without a hard disk by copying the full image
of the system release you want. For example, to update a FAST360 appliance without a hard disk from
version 3.0EMBW/16 to version 3.0EMBW/19, you only have to download and install the image of the
version 3.0EMBW/19 (in this case, the image file is image_3.0EMBW_040629 1059).
The image downloaded from the HTTPS server must be copied in the following directory: /vtmp/ARKIMAGES/.
To launch the installation, type the following command:
[root@mon-arkoon
/root]#
pre_install_image<name_of_the_image_to_be_installed>

/usr/imageinstall/

Installing System Updates on the other Axx Appliances
Case of a patch update:
• All patches allowing to update from the current version to the system version (patch_* files) must be
downloaded from http://client.arkoon.net, in the FAST360/downloading section.
• These files must then be copied to the FAST360 appliance, into the /var/tmp directory.
• You must then launch the following commands:
• cd /var/tmp
• /usr/versioninstall/arkoon-install <name_of_patch>
To install several patches, you just need to launch this command by specifying the name of the last
patch.
• This command then installs the patch and all intermediary patches if necessary and then reboots the
FAST360 appliance. If at least one patch is missing to update from current version to desired version,
an error warning displays and the procedure is interrupted.
Case of a version update:
• You just need to download from http://client.arkoon.net, in the FAST360/Downloading section, the file
corresponding to the version to be installed (file beginning with version_*)
• This file must then be copied to the FAST360 appliance, into the /var/tmp directory.
• Launch the following commands:
• cd /var/tmp
• /usr/versioninstall/arkoon-install <name_of_version>
This command installs the chosen version and restarts the FAST360 appliance.

Managing Updates

| 485

Chapter 20. Updating, Replacing, and Reinitializing FAST360 Appliances

Installing System Updates on NPA/Performance, XLarge and Virtual Edition appliances
The procedure for installing system updates on NPA/Performance, XLarge and Virtual Edition appliances
is:
• Download the required update file (sysupdate*) to be installed from the Arkoon client site (FAST360/
downloading section).
• Copy the update file into the /var/tmp directory of the appliance, using a tool relying on the SSH
protocol.
• Launch the following commands to start the update manually:
• cd /var/tmp
• /opt/arkoon/share/distrib/arkoon-install install <sysupdate filename>
This command installs the chosen update file and reboots the FAST360 appliance into the new system
automatically.

Installing Antivirus and Filtering categories Updates
Standard Procedure
The standard procedure only requires the arkupdate_MODULE_YYYYMMJJ_HHMM.tar.gz file which
contains all updates.

Note
The files in this archive are also available for administrators who want to avoid downloading the
same data several times. For this, refer to the section called “Advanced Procedure”.
Once the file is available on the FAST360 appliance, you only need to uncompress the file (by positioning
yourself at the root of the system) and to launch the second step of arkupdate (installation of the available
updates).

Example 20.1. SOPHOS_RTV2 Module (Standard Procedure)
[root@mon_FAST360 /root]# cd /
[root@mon_FAST360 /]# tar xzvf tmp/arkupdate_SOPHOS_RTV2_20020930_1759.
tar.gz
var/arkupdate/SOPHOS_RTV2/index
var/arkupdate/SOPHOS_RTV2/SOPHOS_RTV2_3.62.tar.gz
var/arkupdate/SOPHOS_RTV2/SOPHOS_RTV2_3.62_0001.tar.gz
var/arkupdate/SOPHOS_RTV2/SOPHOS_RTV2_3.62_0002.tar.gz
var/arkupdate/SOPHOS_RTV2/SOPHOS_RTV2_3.62_0003.tar.gz
[root@mon_FAST360 SOPHOS_RTV2]# /opt/arkoon/bin/arkupdate upgrade
SOPHOS_RTV2
Upgrading module SOPHOS_RTV2 [(null)/0] -> [3.62/2]...
[(null)/0] -> [3.62/0] using SOPHOS_RTV2_3.62.tar.gz
SOPHOS_RTV2: [/0] -> [3.62/0]
[3.62/0] -> [3.62/1] using SOPHOS_RTV2_3.62_0001.tar.gz
SOPHOS_RTV2: [3.62/0] -> [3.62/1]
[3.62/1] -> [3.62/2] using SOPHOS_RTV2_3.62_0002.tar.gz
SOPHOS_RTV2: [3.62/1] -> [3.62/2]
XPA command line: /usr/arkupdate/arkupdate upgrade <MODULE>

Advanced Procedure
The advanced procedure allows you to avoid downloading all updates each time. Only use this procedure
if you are comfortable with the update process. Otherwise, use the standard procedure.
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With the advanced procedure, you can download only the files still missing on the FAST360 appliance.
After download, it is necessary to put them in their respective directories (/var/arkupdate/<MODULE>).
It is then necessary to update the index file/var/arkupdate/<MODULE>/index which contains all
information concerning the updates. There are two possibilities:
• Retrieve the index file from the HTTPS site each time;
• Complete the index file by adding the description of the new downloaded files.
Once all the files are present on the FAST360 appliance and the index file is updated, you can launch the
second step of arkupdate.

Example 20.2. SOPHOS_RTV2 Module (Advanced Procedure)
[root@mon_FAST360 /root]# cd /var/arkupdate/SOPHOS_RTV2
[root@mon_FAST360 SOPHOS_RTV2]#
echo "3.62 0003 D SOPHOS_RTV2_3.62_0003.tar.gz" >>index
[root@mon_FAST360 SOPHOS_RTV2]#
echo "3.62 0004 D SOPHOS_RTV2_3.62_0004.tar.gz" >>index
[root@mon_FAST360 SOPHOS_RTV2]# /opt/arkoon/bin/arkupdate upgrade
SOPHOS_RTV2
Upgrading module SOPHOS_RTV2 [3.62/2] -> [3.62/4]...
[3.62/2] -> [3.62/3] using SOPHOS_RTV2_3.62_0003.tar.gz
SOPHOS_RTV2: [3.62/2] -> [3.62/3]
[3.62/3] -> [3.62/4] using SOPHOS_RTV2_3.62_0004.tar.gz
SOPHOS_RTV2: [3.62/3] -> [3.62/4]
XPA command line: /usr/arkupdate/arkupdate upgrade <MODULE>

Installing IDPS Updates
You can update signatures in disconnected mode. For this, you need to download the last IDPS update file
from http://client.arkoon.net, copy it to the FAST360 appliance (in /tmp for instance) and type the following
command: /usr/arkupdate/IDPS_upgrade /tmp/IDPS_date.gz. This checks the file signature before
installing it.

Reinstalling the Previous System Version
When you launch a system update, the FAST360 appliance copies the current version of its system into
the dedicated directory /os.backup.
This copy of the former system allows to:
• automatically come back to the previous version if a problem occurs during the installation of the new
patch;
• manually start the reinstallation of the previous version if necessary (for example, for tests).

Note
Seeing that it is possible to install several patches at the same time, "reinstalling the previous
version" does not mean "removing a patch" but coming back to the version previously installed
on the system.
There are three ways to reinstall the previous system version:
• From Arkoon Monitoring : in the Updates window, click the Undo button, check it and install it.
• At boot time, select the arkoon-undo target.
• Using the following command on NPA/Performance and XLarge appliances only:
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/opt/arkoon/share/distrib/arkoon-install install UNDO

20.2. Maintaining a Diskless FAST360 Appliance
As there is no mass storage capacity in diskless FAST360 appliances such as the A10 Series, a reduced
set of features is supported. Non-supported features include the HTTP/FTP, SMTP, and POP3 relays, and
because the relays are not available features such as antivirus and heuristic antispam anlaysis are also
not available. Non-supported features are greyed out as configuration choices in Arkoon Manager and
Arkoon Reporting when a diskless device is selected.
Certain other restrictions of diskless devices are detailed below.

20.2.1. Security Logs
As there are no proxies on a diskless appliance, only three logs are maintained:
• Alerts
• IP logging
• IDPS logging
To optimize memory usage, the content of IP packets is not logged, even if “Complete logging” has been
defined in a filtering rule. When the /var partition reaches 93% of capacity, the log files are partially
flushed to roll back to 75% capacity. An alert is generated when the logs are flushed.

20.2.2. System Logs and Alerts
System messages are not logged locally on diskless appliances. Instead they are sent to:
• Arkoon Monitoring if the system logs window is open;
• syslog servers configured in Arkoon Manager.
Domain routing for email alerts is defined at the level of Interface configurations in Arkoon Manager, as
the SMTP proxy (where domain routing is normally configured) is not available on a diskless device.

20.2.3. File System and Partitions
The system card capacity is 64 MB (instead of 32 MB on a FAST360 appliance with a hard disk) and
it contains all the partitions, except the one on which the /tmp directory is located, which is a virtual
partition in RAM.

Caution
Because the /tmp directory is located in RAM, its content is flushed at each restart.
Four partitions are located on the PCMCIA card:
• System (26 MB);
• Undo (2.5 MB);
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• Config (1.9 MB): equivalent to the configuration card;
• Var (31 MB) (located on the hard disk of FAST360 appliances with hard disk).
There is no swap partition on a diskless FAST360 appliance.
If the appliance fails to restart correctly with the newly installed system, the old system is recovered
from the /var partition and reinstalled after a fresh reboot. Otherwise it is deleted. Installation history To
optimize memory usage, the installation history usually stored in /var/config.backup is not available.

20.2.4. System Update
Note
Before updating the software on a FAST360 appliance, you are recommended to back up all
configuration and log files.

20.2.5. Update Process
To update a diskless appliance, use Arkoon Monitoring to view the available update versions and click
the Install button to select the version to be installed. The update proceeds as follows:
1. The checksum is automatically verified.
2. The update image is downloaded and stored in RAM.
3. The logs are erased from the /var partition to make space to save the old system.
4. The downloaded image is installed.
5. The FAST360 appliance restarts automatically.
Normally system updates (patches) are stored on the FAST360 appliance’s hard disk, and the system is
updated with these patches. In a diskless configuration, there is nowhere to store the patches locally.
Instead an entirely new system image must be downloaded and installed.

20.3. Redeploying a FAST360 Appliance
All the FAST360 appliances have /config_card partition gathering all the elements of the FAST360
appliance's configuration (parameters set by minarkconf – CA definition, root password, HA
configuration, … - and configuration files created with Arkoon Manager ).
The configuration history that is necessary to redeploy an appliance is stored in the directory /var/
config.data.
These two directories must be retrieved in order to create the backup of a FAST360 appliance.
The procedure includes the following steps:
• Retrieval of the /config_card partition and the /var/config/data directory of the former FAST360
appliance.
• Update of the new appliance with the type of version (major/intermediate) of the former appliance.
• Installation on the new FAST360 appliance of the saved /config_card partition and the /var/config/
data directory.
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• Installation of the license corresponding to the new FAST360 appliance.
• Restarting of the appliance for taking into account of the new configuration.

Note
Refer to the Update and Migration Help on the Arkoon Customer Area to obtain the complete
procedure.

20.3.1. Retrieving the redeployment data
Via Arkoon Manager :
The Actions / Advanced Administration / Configuration card backup menu in Arkoon Manager allows
you to save all the data necessary to redeploy an Arkoon appliance.
In console mode:
1.

Connect via an SSH connection.

2.

Open a session as root.

3.

Go to the /tmp directory by typing the command cd /tmp.

4.

Create a tar format archive of all the configuration files (in the example below, it is
named config_card_and_configurations.tgz) by typing the following command: tar cvzf
config_card_and_configurations.tgz /config_card/ /var/config.data/

5.

Then retrieve the config_card_and_configurations.tgz file located in the /tmp directory using
an SSH connection on port 822.

In both cases, save this file in a reliable and secure location.

Note
You should save this backup as soon as the FAST360 appliance is installed. If there are no
changes other than modifications of the configuration file, save each new configuration version
using the administration workstation via Arkoon Manager .

Note
The resulting archive that contains the redeployment data also contains the whole history of the
configurations installed on the appliance. Thus, the archive can be quite big and generating it
can be lengthy.

20.3.2. Installing the /config_card Partition
Pre-requisite: the spare appliance must be initialized with the minimum parameters so that you can
connect to it via SSH from the administration workstation.
The appliance must be in the same version (major or intermediate) as the appliance where the
configuration backup comes from.
You must first copy the backup configuration file on the new appliance.
Open an SSH connection on port 822 to copy the config_card_and_configurations.tgz file into the
/tmp directory of the new appliance.
1.
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2.

Open a root session.

3.

Go to the root directory by typing cd / command.

4.

Remove all the files previously created on the /config_card directory and /var/config.data/ by
typing the command:
rm -Rf /config_card/* /var/config.data/*

Caution
Be careful when typing this command as a mistake in the command could damage the
system.
5.

Uncompress the archive by typing the command:
tar xvzf /tmp/config_card_and_configurations.tgz

Particular case
When redeploying the master node of a VRRP cluster (HP or HA), if configurations have been installed or
if the configuration history has been modified on the second node during production whereas the master
node was not available, apply the following procedure after restoring the /config_card partition in order
to copy the configuration history from the secondary node to the new master node:
1.

Open an SSH connection.on the second node in production.

2.

Open a root session.

3.

Go to the directory /tmp by typing cd /tmp.

4.

Create a tar format archive of all the configuration files by typing:
tar cvzf current_config_and_configurations.tgz /config_card/etc/config.current /
var/config.data/

5.

Retrieve the file /tmp/current_config_and_configurations.tgz thanks to an SSH connection
on port 822 and move it to the directory /tmp of the restoring master node.

6.

Open an SSH connection.on the restoring master node.

7.

Open a root session.

8.

Go to the root directory by typing cd /

9.

Remove all the files previously created on the /var/config.data/ directory by typing the command
(be careful when typing this command as a mistake in the command could damage the system) :
rm -Rf /var/config.data/*

10. Uncompress

the

archive

by

typing

the

command:

tar

xvzf

/tmp/

current_config_and_configurations.tgz

20.3.3. Installing the License
The next step consists in installing the license corresponding to the spare appliance.
Refer to the First-Time Configuration Guide which shows you how to:
• Generate the license request using the Arkoon Manager .
• Use the supplied activation key to obtain on the web site the temporary license and then the final one.
• Install the license from the Arkoon Manager .
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Particular case
A specific procedure must be applied to restore a cluster node which is a configuration master (HP and
HA case).
If some configurations were installed or if the configuration history were modified on the second mode
when the master node was unavailable, these changes will not be taken into account while the master
node is restarted.
For the changes to be taken into account:
1.

Connect in SSH on the seconde node.

2.

Open a session ass root.

3.

Go to /tmp directory entering cd /tmp command.

4.

Create a .tar format archive for all the configuration files by entering the following command:
tar cvzf current_config_and_configurations.tgz
/config_card/etc/config.current /var/config.data/

5.

Retrieve the /tmp/current_config_and_configurations.tgz file with an SSH connection on
port 822, and deposit it into the master node/tmp directory.

6.

Connect in SSH on the master node being restored.

7.

Open a session as root.

8.

Go to the root directory by entergin the cd / command.

9.

Delete all the files previously created on /var/config.data/ directories by entering the following
command (make sure you enter it correctly before you execute it in order to avoid damaging the
system: rm -Rf /var/config.data/*

10. Unzip

the

archive

by

entering

the

following

command:

tar

xvzf

/tmp/

current_config_and_configurations.tgz

20.3.4. Restarting the Appliance
The last step consists in restarting the appliance in order to take the new configuration into account.
Therefore, you can:
• Click the Restart icon in the Maintenance/Diagnostics window in Arkoon Monitoring .
• Type the reboot command (SSH connection).

20.4. Restoring a configuration on a USB key
The following procedure describes the restoration of a configuration (config_card) for Performance
and NPA appliances only, using a USB key.

Important
This mode is supported only on Performance and NPA Small S90/S150 appliances. For other
types of appliance, follow the procedure described in Section 20.3, “Redeploying a FAST360
Appliance”.
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1. To retrieve the configuration of the appliance to update, refer to the procedure described in
Section 20.3.1, “Retrieving the redeployment data”
2. Rename the configuration archive in config_card.tgz and copy it to the root of the USB key (the key
must be formated in FAT16 or FAT32).
3. If available, name the license file of the replacement appliance in license.akl and copy it to the root
of the USB key.
4. Plug the USB key to the appliance on which you wish to restore the config_card (as well as the
license if it is available).
5. Reboot the appliance (or switch it on if it is off).
When booting, the appliance detects the connected USB devices and searches for the config_card.tgz
file.
The following operations are automatically launched:
• check the compliance of the archive format: the structure of files contained in the archive is checked
• backup the current config_card and create a log file on the USB key or hard drive in the /var/
config_card.backup/ folder

Note
If the backup of the current config_card is impossible on the USB key (not enough space,
key in read-mode), the procedure still continues but if the backup on the hard drive fails, the
procedure stops and the appliance starts a usual.
• restore the current config_card on the USB key. In case of error, the boot is blocked, and you must
retrieve the USB and reboot the appliance
• restore the license file if it is present.
If successful: on a Performance appliance (P, P-XL or P-S), the status is displayed on the LCD screen
and the start-up goes on. On an NPA Small or Performance P-XS3 or P-S4 appliance, the “status”
led blinks three times and the start-up goes on. It is then essential to retrieve the USB key once the
config_card is restored.
If failure: n a Performance appliance (P, P-XL or P-S), the status is displayed on the LCD screen and
the start-up is blocked. On an NPA Small or Performance P-XS3 or P-S4 appliance, the “status” led
blinks three times and the start-up blocked. It is then essential to retrieve the USB key and restart the
appliance.

Important
Only the presence of files is checked but not their content. Make sure you do not deploy an
archive originally for another appliance.
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Chapter 21. Managing RAID
21.1. Minarkconf menu for RAID management
The P-80XL, P-150XL and P-250XL appliances support hard drives management in RAID 1 (Redundant
Array of Independent Disks). This management is possible via minarkconf (only with Performance XL
appliances) via minarkconf > Maintenance > RAID utility.
The following submenus are available:
• View RAID status: to see the detailed state of the RAID status of the appliance
• View RAID recovery in real-time: to see the progress of the reconstruction of a disk in real time.
This submenu appears only if a disk is being reconstructed.
• Deactivate hard disk: to deactivate a disk to swap it. This allows to swap a hot disk without
switching off the appliance. This submenu is available only if both disks were detected. It is
inaccessible when the RAID reconstruction operation on one disk is in progess.
• Activate hard disk: to activate a disk. This function is used to swap a hot disk without switching
off the appliance. Once activated, the RAID reconstruction begins. This submenu is only available if
a disk has been detected.

Warning
Reconstructing a disk may take more than an hour. If the appliance has started with a single
disk, adding a second drive requires a restart of the appliance for it to be taken into account,
despite its activation. If the appliance has started with two disks, a restart is not necessary.
• Back: to leave the RAID menu.
When a hard drive is removed or added to the appliance (after minarkconf > Maintenance > RAID
utility > (de)activate), error or warning messages are sent from the Linux kernel to specify the
hardware changes. These messages appear in a disorderly manner on the screen but this does not
indicate a problem. To find a clean screen, simply connect (if not already) and run the command: clear.

21.2. Using RAID
In this section, we will call a "clean" disk , a disk that has the following characteristics:
• A brand new disk
• A disk already used but not part of a RAID
• A disk already used and part of a RAID but correctly swapped (on a Performance XL appliance:
minarkconf >Maintenance >RAID utility > Deactivate hard disk)
• Any other type of disk cannot be used on a P-80XL, P-150XL or P-250XL appliance.
• Deleting a hot disk is removing a disk without switching off the appliance.
• Deleting a cold disk is removing a disk when the appliance is switched off and then switched on.
• Adding a hot disk is adding a disk without switching off the appliance.
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• Adding a cold disk is adding a disk when the appliance is switched off and then switching it on.
The following procedures list the various processes that you can do or are not supported with RAID on
a Performance XL appliance.

Warning
It is not supported to physically remove a hot disk without first deactivating it via the menu
minarkconf >Maintenance >RAID utility > Deactivate hard disk.
Hot removal and hot addition
1.

To delete the disk, go to minarkconf > Maintenance > RAID utility > Deactivate hard disk
and remove the disk.

2.

To add the disk, it needs to be clean: add the disk and go to minarkconf > Maintenance > RAID
utility > Activate hard disk.

Cold removal and hot addition
Case not supported.
Hot removal and cold addition
1.

To delete the disk, go to minarkconf > Maintenance > RAID utility > Deactivate hard disk
and remove the disk.

2.

To add the disk, it needs to be clean: add the disk and start the appliance.

3.

Go to minarkconf > Maintenance > RAID utility > Activate hard disk.

Cold removal and cold addition
1.

Remove the disk.

2.

To add the disk, it needs to be clean: add the disk and start the appliance.

3.

Go to minarkconf > Maintenance > RAID utility > Activate hard disk.

21.3. Reconstructing a disk in RAID
There is a disk reconstruction when:
• the RAID is created during the appliance initialization.
• a new disk is activated on the appliance.
A reconstruction operation is activated successively on different partitions of the new hard disk. It takes
place in the background and does not impact the use of the appliance. This will completely synchronize
the partitions of the two discs. Depending on the size and type of disks, the operation lasts about an hour
for all file system partitions of the appliance. It is possible to follow this operation from minarkconf >
RAID Utility > View RAID recovery in real-time. The estimated duration of the operation is also
indicated.
The reconstruction is performed only on a partition at a time. Other non-synchronized partitions are
marked with the label "DELAYED" to plan the operation. When a RAID reconstruction operation is in
progress:
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• It is possible to restart the appliance. The operation restarts when booting the appliance.
• It is impossible to deactivate a disk from RAID with minarkconf. You must wait for the end of the
operation.

21.4. System monitoring related to RAID
The addition of RAID implies a system monitoring. There is a "SOFT-RAID" type of monitoring per partition
(named raid1, raid2, raid3 and raid4):
root@localhost:/root> sysmon client LIST
CPU load
CPU-LOAD
RDY GRE CPU load below 75�
Memory usage
MEM-USAGE
RDY GRE Memory usage below 75�
/var usage
DISK-USAGE
RDY GRE Filesystem is 0� full
/tmp usage
DISK-USAGE
RDY GRE Filesystem is 0� full
/config_card usa DISK-USAGE
RDY GRE Filesystem is 1� full
license
LICENSE
RDY RED No license installed!
config
CONFIG
RDY GRE Configuration is valid
logs db
LOGS-MEDIA
RDY GRE Database OK
log queues
LOGS-QUEUE
RDY GRE Log queues OK
services
SERV
RDY GRE All services are OK
disk0
DISKS
RDY GRE SATA - S:clean, H:ok, M:ok, T°C<50, P<30000h
config-slave
CONFIG-SLAVE
RDY GRE Configuration installed by server
logs size
LOGS-SIZE
RDY GRE
link:eth0
LINK
RDY GRE eth0 Link is up
disk1
DISKS
RDY GRE SATA - S:clean, H:ok, M:ok, T°C<50, P<30000h
raid1
SOFT-RAID
RDY GRE /dev/md1 switched to state OK
raid2
SOFT-RAID
RDY GRE /dev/md2 switched to state OK
kraid3
SOFT-RAID
RDY GRE /dev/md3 switched to state OK
raid4
SOFT-RAID
RDY GRE /dev/md4 switched to state OK

This system monitoring is checked every 10 minutes. For more information on the RAID status system
monitoring, refer to the Section 18.1.1, “System Monitoring”.
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Chapter 22. IPMI management interface
22.1. Introduction
Performance XL models of FAST360 appliances have an interface named IPMI (Intelligent Platform
Management Interface). This interface can remotely control the appliance, restart it (either soft or hard
restart), have a remote console, monitor the appliance (temperature, speed of fans, etc.).
IPMI is a generic technology of Intel present in the servers machines. For detailed information on the
IPMI standard, refer to the Intel website: http://www.intel.com/design/servers/ipmi/ipmi.htm.
This interface uses its own integrated circuit and its own mini-processor. It is completely detached
from the rest of the appliance and has a complete autonomy, allowing to switch on or off the appliance
electrically from the interface. IPMI allows you to control all aspects of the hardware appliance without
installing any additional agent.

22.2. Use and Connection
Use
The following IPMI features are useful on FAST360 appliances and have been validated by Arkoon:
• Soft or electrical switching on / off and soft reboot (soft or electric) of the appliance
• Hardware events monitoring
• Use of minarkconf via the remote console
• Diagnostic procedures described
• Debug of the appliance in case of failure, via the remote console

Important
All the features useless to FAST360 appliances have not been validated: Arkoon makes no implied
warranty or support for changes in this part and accepts no liability for the use of these features.
The interface is activated by default in the appliance BIOS and its default addressing is
• IP address: 192.168.1.100
• Default mask: 255.255.255.0 (/24)
• Default gateway: none
The use of the IPMI interface can be:
• from a Web browser (Interne Explorer 7 as a minimum or Firefox 3 as a minimum), entering the interface
address: http://192.168.1.100
• from a workstation, by using utilities like IPMItool.
Only the use of IPMI via its web interface is presented in this section.
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Connection
To connect to the IPMI interface, launch a web browser and enter the following address:
http://192.168.1.100.

Note
The default login / password is: ADMIN/ADMIN. For safety, we recommend that you change the
password (via Configuration > Users. It is also possible to create other users.
The following page displays the status of the VGA output of your appliance:

22.3. Menus overview
For more details on the various menus that are presented below, see the full documentation of the
manufacturer, available in FAST360 documentation package.

Server Health Menu
This menu allows you to obtain information on the various sensors of the appliance (fans, temperature, ...)
and view the various events (logs) related to the appliance hardware (loss of power supply, opening the
appliance, ...).
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Configuration Menu
This menu allows you to configure various parameters directly related to the use of the IPMI protocol.
Arkoon makes no implied warranty or support for changes to this part and accepts no liability for the use
of this menu. From this menu, you can change the default IP address of the IPMI, thanks to the submenu
Network.

Remote Control Menu
This menu provides the following submenus:
• Console Redirection to open a console on the appliance. This console is the equivalent of a VGA
console (keyboard + screen).

Note
The remote console is not operational by default. The grub is configured to send data to the
COM port whereas the IPMI interface receives the VGA/keyboard information only.
In order to change this, choose the menu Arkoon FAST360 VGA (P-XL series only) when the
appliance is booting. In this case, the console is no longer accessible via the COM port but
only via the VGA console or the IPMI Remote Control.
• Power Control to switch on and off the appliance remotely. Power off (lectrical and soft) can be
operated from this menu.
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Virtual Media Menu
This menu allows you to mount a virtualized CD or a virtualized floppy drive. Arkoon makes no implied
warranty or support for changes to this part and accepts no liability for the use of this menu.

Maintenance Menu
This menu allows you to perform maintenance on the IPMI interface. Arkoon makes no implied warranty
or support for changes to this part and accepts no liability for the use of this menu.

Miscellaneous Menu
This menu provides access to various functions. Arkoon makes no implied warranty or support for
changes to this part and accepts no liability for the use of this menu.
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Appendix A. Migration and Update Procedures
A.1. Migration and Update Procedures
The migration or update procedure corresponding to your case can be generated on the Arkoon Customer
area thanks to the Update and Migration Help : http://client.arkoon.net/.

A.2. Specific Update Procedures
In the following cases, specific update procedures need to be applied and are detailed in the mentioned
Release Notes:
• Cluster in pre-5.0/9 version: refer to Release Notes 5.0/9.
• Passive node of an HA cluster in version 5.0/11: refer to Release Notes 5.0/12.
• NPA or XLarge appliance in version 5.0/11 getting updated via an update relay: refer to Release Notes
5.0/12.
• XPA appliance in version previous to 5.0/22: refer to Release Notes 5.0/22.
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Appendix B. Migrating a CA with an imminent
expiration
B.1. Migrating a CA with an imminent expiration
For technical reasons (the certificate of the Certification Authority is included in all user certificates)
and security reasons (the lifespan of a private key), it is impossible to extend the life of the Certification
Authority. You must then recreate it.

Prerequisite
• Ssh connection on each of the FAST360 appliances
• Ssh connection on B nodes (in HA or cluster cases). If necessary, create a flow rule to bounce back
from the master node on the slave node
• Back up all the config_card and all FAST360 appliances of the architecture

Warning
During the application of this procedure, it is impossible to install configurations and VPN or
master / slave connections are unavailable. In general, all the services based on a certificate
are available.
To clarify the configuration, it is recommended to delete unused objects before starting the procedure.
To do this in Arkoon Manager configuration, click on Find > Find unused items....

Identifying certificates
1.

Identify the administration certificates (ADMIN) still in use by opening the basic roles and inventory
the existing administrators in the roles database still active.

2.

Identify the appliances certificates (FIREWALLS) still in use by opening the configuration and
inventory all the appliances of the architecture included in the configuration file still in production.

Important
In the case of a cluster appliance, it takes one certificate per node plus a certificate if the
cluster mounts VPNs with certificates.
3.

Identify the users certificates (USER) still in use by opening the configuration and inventory all the
certificates objects used by hosts / users included in the flow rules / VPN communities.

Renewing the Certification Authority
1.

SSH

— Delete the existing Certification Authority: go to minarkconf > Certificates > Delete
certificate authority and confirm.

2.

SSH

— Create the new Certification Authority: go to minarkconf > Certificates > Initialize a
certificate authority (CA) and fill in the various parameters of the Certification Authority.
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3.

SSH — Create a new instance certificate (AMC case) or FIREWALLS (FAST360 case): minarkconf >

Certificates > Create this Arkoon certificate.
4.

SSH — Create a new ADMIN certificate: minarkconf > Certificates > New Certificate, then initialize

the roles database with this certificate via minarkconf > Access Control > Reset Access Control
Database, then retrieve the .p12 file of the certificate.
5.

Arkoon Manager

— Log on the AMC appliance / instance with the created certificate and go to
section Certification Authority and create all the required appliances' certificates (FIREWALLS).

6.

SSH

7.

Arkoon

8.

Install the roles database, then install the architecture configuration.

9.

Distribute the certificates to the administrators: all the administrators can now log on via Arkoon
Manager or Arkoon Monitoring.

— Copy the certificates on the appliances in SCP and install them by logging on appliances
via SSH, then minarkconf > Certificates > Import new FAST360 certificate. For a cluster solution,
install on each node the specific VPN certificate of the cluster via minarkconf > Certificates > Import
external certificate for VPN: the master / slave relationship is restored. It is possible to install new
configurations, and the VPNs between FAST360 appliances are functional.
Manager — Create all the administration certificates (ADMIN) and the administrators
associated to the roles database and associate the appropriate certificates and roles.

10. Arkoon Manager — Create the users certificates (USER) then go to the Configuration part.
11. Accept the system synchronization, then modify the certificates referenced in the Certificats
objects, then install the configuration.
12. Distribute the certificates to the users and ask them to modify the configuration of the VPN client
in order to use the new certificate: the mobile VPNs with certificate authentication can now be put
into production.
13. If VPNs with certificates were mounted with remote third-party VPNs gateways, you can provide
the certificate to the gateways administrators: all the VPNs with authentication are functional.
The migration is finished and all the features related to certificates are now operational.
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Appendix C. Reference Documents

C.1. Standards Documents
C.1.1. FAST DNS Module
The DNS protocol is described in the following documents:
• RFC 1034 - Domain Names - Concept and facilities - November 1987
• RFC 1035 - Domain Names - Implementation and specification - November 1987
• RFC 2671 - Extension Mechanisms for DNS (EDNS0) - August 1999

C.1.2. FAST FTP Module
The FTP protocol, its extensions and use are described in the following documents:
• RFC 765 - File Transfer Protocol (FTP) - June 1980
• RFC 959 - File Transfer Protocol (FTP) - October 1985
• RFC 2577 - FTP Security Considerations - May 1999
• draft-ietf-ftpext-mlst-xx.txt: Extensions to FTP

C.1.3. FAST HTTP Module
The different versions of the HTTP protocol are described in the following documents:
• RFC 1945 - Hypertext Transfer Protocol -- HTTP/1.0 - May 1996
• RFC 2068 - Hypertext Transfer Protocol -- HTTP/1.1 - January 1997
• RFC 2616 - Hypertext Transfer Protocol -- HTTP/1.1 - June 1999

C.1.4. FAST SMTP Module
The SMTP protocol and its extensions are described in the following documents:
• RFC 821 - Simple Mail Transfer Protocol - August 1982
• RFC 1869 - SMTP Service Extensions - November 1995
• RFC 1985 - SMTP Service Extensions - ETRN - August 1996
• RFC 2487 - SMTP Service Extensions for Secure SMTP over TLS - January 1999
• RFC 2554 - SMTP Service Extensions for Authentication - March 1999
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• RFC 2821 - Simple Mail Transfer Protocol - April 2001

C.1.5. FAST SNMP Module
The above versions of the SNMP protocol and their extensions are described in the following documents:
SNMPv1
• RFC 1157 - A Simple Network Management Protocol (SNMP) - May 1990
SNMPv2c
RFC 1901 - Introduction to Community-based SNMPv2 - January 1996
RFC 1905 - Protocol Operations for Version 2 of the Simple Network Management Protocol (SNMPv2) January 1996
Other relevant documents (for both versions) are:
• RFC 3416 - Version 2 of the Protocol Operations for the Simple Network Management Protocol (SNMP)
- December 2002
• RFC 3584 - Coexistence between Version 1, Version 2, and Version 3 of the Internet-standard Network
Management Framework - August 2003

C.1.6. FAST SQLNET Module
The FAST SQLNET module applies to security functions applied to exchanges of SQL requests that
conform to the SQL*NET/Net9 protocol.

C.1.7. FAST SIP Module
The SIP protocol is defined in the following documents:
• RFC3261 - SIP: Session Initiation Protocol - June 2002
• RFC3265 - Session Initiation Protocol (SIP) - Specific Event Notification - June 2002
• RFC3853 - S/MIME Advanced Encryption Standard (AES) Requirement for the Session Initiation
Protocol (SIP) - July 2004
• RFC4320 - Actions Addressing Identified Issues with the Session Initiation Protocol's (SIP) Non-INVITE
Transaction - January 2006
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C.1.8. FAST MGCP Module
The MGCP protocol is defined in the following documents:
• RFC3435 - Media Gateway Control Protocol (MGCP) Version 1.0 - January 2003
• RFC3661 - Media Gateway Control Protocol (MGCP) Return Code Usage - December 2003

C.1.9. FAST RTP/RTCP Module
The RTP and RTCP protocols are defined in the following documents:
• RFC3550/STD0064 - RTP: A Transport Protocol for Real-Time Applications - July 2003
• RFC3611 - RTP Control Protocol Extended Reports (RTCP XR) - November 2003

C.2. ICMP Types and Codes
C.2.1. Error Messages
• type 3: destination unreachable
code 0

net unreachable

code 1

host unreachable

code 2

protocol unreachable

code 3

port unreachable

code 4

fragmentation needed and DF set

code 5

source route failed

code 6

destination network unknown

code 7

destination host unknown

code 8

source host isolated

code 9

communication with destination network is administratively prohibited

code 10

communication with destination host is administratively prohibited

code 11

destination network unreachable for type of service

code 12

destination host unreachable for type of service

code 13

communication administratively prohibited

code 14

host precedence violation

code 15

precedence cutoff in effect

• type 4: source quench
code 0

source quench

• type 5: redirect
code 0

redirect for network error

code 1

redirect for host error
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code 2

redirect for type of service and network error

code 3

redirect for type of service and host error

• type 11: time exceeded
code 0

time to live exceeded in transit

code 1

fragment reassembly time exceeded

• type 12: parameter problem
code 0

pointer indicates the error

code 1

a required option is missing

code 2

bad length

C.2.2. Information Messages
The code of all the messages listed below is 0.
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type 0

echo reply

type 8

echo request

type 9

router advertisement

type 10

router solicitation

type 13

timestamp request

type 14

timestamp reply

type 16

information request

type 17

information reply
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Appendix D. URL Filtering Categories
The following is a list and brief description of the URL filtering categories available in the FAST360
configuration.

D.1. Arkoon URL Filtering Categories
ads

Advertizing servers and banned URLs

aggressive

Similar to violence but more promoting than depicting

audio-vidéo

Sites with audio or video downloads

drugs

Drug-related sites

gambling

Gambling sites including stocks ans shares

hacking

Hacking/cracking information

mail

Webmail and email sites

porn

Pornography

proxy

Sites with proxies to bypass filters

radio

Non-news related radio

tv

Non-news related television

violence

Sites containing violence

warez

Sites with illegal pirate software

D.2. Advanced URL Filtering Categories
ADVANCED_URL_ads

Advertizing servers and banned URLs

ADVANCED_URL_adult

Sites containing adult material such as swearing but not porn

ADVANCED_URL_aggressive

Similar to violence but more promoting than depicting

ADVANCED_URL_antispyware

Sites to prevent spyware

ADVANCED_URL_artnudes

Art sites containing artistic nudity

ADVANCED_URL_astrology

Sites about astrology

ADVANCED_URL_audio_video

Sites with audio or video downloads

ADVANCED_URL_banking

Sites about banks

ADVANCED_URL_beerliquorinfo

Sites with information only on beer or liquors

ADVANCED_URL_beerliquosale

Sites selling alcohol

ADVANCED_URL_blog

Sites hosting blogs

ADVANCED_URL_cellphones

Stuff for mobile/cell phones

ADVANCED_URL_chat

Sites with chat rooms

ADVANCED_URL_childcare

Sites to do with childcare

ADVANCED_URL_cleaning

Sites dealing with antivirus software
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ADVANCED_URL_clothing

Sites about and selling clothing

ADVANCED_URL_culinary

Sites about cooking/food

ADVANCED_URL_dating

Sites about daintg

ADVANCED_URL_desktopsillies

Sites with desktop sillies

ADVANCED_URL_dialers

Sites with dialers such as those for pornography or trojans

ADVANCED_URL_drugs

Drug related sites

ADVANCED_URL_ecommerce

Sites that provide online shopping

ADVANCED_URL_entertainment

Sites that promote movies, books, magazines, etc.

ADVANCED_URL_filehosting

Sites hosting files

ADVANCED_URL_financial

Sites on finances

ADVANCED_URL_frencheducation

Sites to do with French education

ADVANCED_URL_gambling

Gambling sites including stocks ans shares

ADVANCED_URL_games

Games sites

ADVANCED_URL_gardening

Gardening sites

ADVANCED_URL_government

Military sites and schools

ADVANCED_URL_guns

Sites about guns

ADVANCED_URL_hacking

Hacking/cracking information

ADVANCED_URL_homerepair

Sites about home repair

ADVANCED_URL_hygiene

Sites about hygiene and other personal grooming-related stuff

ADVANCED_URL_instantmessaging

Sites that contain messenger client download and web-based
messaging

ADVANCED_URL_jewelry

Sites about and selling jewelry

ADVANCED_URL_jobsearch

Sites for finding jobs

ADVANCED_URL_kidstimewasting

Sites kids often waste time on

ADVANCED_URL_mail

Webmail and email sites

ADVANCED_URL_marketingware

Sites about marketingware

ADVANCED_URL_medical

Sites about medical issues

ADVANCED_URL_mixed_adult

Sites for adults

ADVANCED_URL_mobile_phone

Sites about mobile phones

ADVANCED_URL_naturism

Sites about naturism

ADVANCED_URL_news

News sites

ADVANCED_URL_onlineauctions

Online auctions

ADVANCED_URL_onlinegames

Online games sites

ADVANCED_URL_onlinepayment

Online payment

ADVANCED_URL_personalfinance

Personal finance sites

ADVANCED_URL_pets

Pet sites

ADVANCED_URL_phishing

Sites attempting to trick people into giving out private information

ADVANCED_URL_porn

Pornography

ADVANCED_URL_proxy

Sites with proxies to bypass filters

ADVANCED_URL_radio

Non-news related radio and television

| Advanced URL Filtering Categories

Appendix D. URL Filtering Categories

ADVANCED_URL_reaffected

Reaffected sites

ADVANCED_URL_religion

Sites promoting religion

ADVANCED_URL_ringtones

Sites containing ring tones, games, pictures and other

ADVANCED_URL_searchengines

Search engines such as Google

ADVANCED_URL_sect

Sites about sects

ADVANCED_URL_sexual_education Site about sexual education
ADVANCED_URL_sexuality

Sites dedicated to sexuality, possibly including adult material

ADVANCED_URL_shopping

Shopping sites

ADVANCED_URL_socialnetworking

Social networking sites

ADVANCED_URL_sportnews

Sport news sites

ADVANCED_URL_sports

All sports sites

ADVANCED_URL_spyware

Sites which download or run spyware or have software available
for download

ADVANCED_URL_updatesites

Sites where software updates are available for download,
including virus signatures

ADVANCED_URL_vacation

Holiday/vacation/travel information

ADVANCED_URL_verisign

Verisign

ADVANCED_URL_violence

Sites containing violence

ADVANCED_URL_virusinfected

Siteshosting virus-infected files

ADVANCED_URL_warez

Sites with illegal pirate software

ADVANCED_URL_weapons

Sites detailing or selling weapons

ADVANCED_URL_weather

Weather news sites and weather related

ADVANCED_URL_webmail

Just webmai lsites

ADVANCED_URL_whitelist

Contains sites specifically 100% suitable for kids
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Appendix E. Implicit Filtering Rules
E.1. Default Antispoofing Rules
The notations used in this appendix are the following:
• ethx: name of the Ethernet interface (eth0, eth1, etc.)
• any: designates any object of this type.

Note
In the case of a source or destination, the object “any” does not include the FAST360
appliance.
• FAST360 appliance: the Arkoon object is selected as a source or destination.
Name: ethx antispoofing (IN)
Exception: this antispoofing blocking rule is not applied to flows whose destination is one of the addresses
of the FAST360 appliance and whose service is the one selected in a filtering rule with PAT. It is not apply
either to the connections from a VPN.
Input interface: not ethx
Source: any
Destination: ethx addresses
Service: any
Action: block
Logging: standard
Name: ethx antispoofing (FW)
Input interface: not ethx
Source: networks directly connected to ethx or specified in the Authorized networks of the interface in
Arkoon Manager
Destination: networks directly connected to ethx or specified in the Authorized networks of the interface
in Arkoon Manager
Service: any
Action: block
Logging: standard
Name: lo antispoofing (IN)
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Input interface: not lo
Source: any
Destination: 127.0.0.0/8
Service: any
Action: block
Logging: standard
Name: lo antispoofing (FW)
Input interface: not lo
Source: 127.0.0.0/8
Destination: any
Service: any
Action: block
Logging: standard

E.2. Default Administration Rules
Name: Admin-From
Input interface: the interfaces specified in the admin from parameter of minarkconf
Source: the addresses specified in the admin from parameter of minarkconf
Destination: Arkoon
Service: TCP 1750, 1751, 822 (it is possible to remove some of these ports in minarkconf )
Action: accept
Logging: standard
Name: Akslave-From
Input interface: the interfaces specified in the allow
minarkconf

from

parameter of master/slave(config) of

Source: the addresses specified in the allow from parameter of master/slave(config) of minarkconf
Destination: Arkoon
Service: TCP 1754Action: accept
Logging: Standard
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E.3. Various Implicit Filtering Rules
Name: myArkoon: Arkoon Reporting allow from
Source: addresses specified in Authorized networks of Arkoon Manager 's Reporting folder
Destination: FAST360
Service: TCP 1757
Action: accept
Logging: none
Name: myArkoon: Proxy-SMTP allow_from
Input interface: any
Source: any
Destination: FAST360
Service: SMTP (with the FAST analysis)
Action: accept
Logging: none
Name: myArkoon: Proxy-SMTP Access

Note
This rule is implemented even if the SMTP relay is not activated.
Input interface: any
Source: FAST360
Destination: any
Service: TCP 25 (with the FAST analysis)
Action: accept
Logging: none
Name: myArkoon: Proxy HTTP allow_from
Input interface: the interfaces specified in Monitoring interfaces of HTTP/FTP proxy of Arkoon Manager
Source: the addresses specified in Authorized networks of HTTP/FTP proxy of Arkoon Manager
Destination: FAST360
Service: well-known port specified in the characteristics of the proxy (with the FAST analysis)
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Action: accept
Logging: none
Name: myArkoon: Proxy HTTP Access
Input interface: any
Source: FAST360
Destination: any
Service: TCP ports defined in the HTTP/FTP proxy of Arkoon Manager (with the FAST analysis if the port
is specified in the HTTP or FTP window)
Action: accept
Logging: none
Name: myArkoon: IKE Access
Input interface: any
Source: the addresses specified in Authorized VPN servers of VPN module of Arkoon Manager
Destination: FAST360
Service: UDP 500 UDP 4500 if NAT-T is activated
Action: accept
Logging: none
Name: myArkoon: IKE Output
Input interface: any
Source: FAST360
Destination: any
Service: source port and destination port:UDP 500UDP 4500 if NAT-T is activated
Action: connection acceptation
Logging: none
Name: myArkoon: DNS Access
Input interface: any
Source: FAST360
Destination: the addresses specified in DNS of Arkoon Manager
Service: TCP and UDP 53 (with the FAST analysis)
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Action: accept
Logging: none
Name: myArkoon: SNMP Traps Access
Input interface: any
Source: FAST360
Destination: the addresses specified in Traps SNMP of Alerts and logs in Arkoon Manager
Service: UDP 162
Action: accept
Logging: none
Name: myArkoon: Syslog Access
Input interface: any
Source: FAST360
Destination: the addresses specified in Syslog servers of Alerts and logs in Arkoon Manager
Service: UDP 514
Action: accept
Logging: none
Name: myArkoon: Authentication queries
Input interface: any
Source: FAST360
Destination: any
Service: UDP 9271
Action: accept
Logging: none
Name: myArkoon: Proxy POP3 Access
Input interface: any
Source: any
Destination: any
Service: TCP 110 (with the FAST analysis)
Action: accept
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Logging: none
Name: Akha-From Rule installed on the active appliance.
Input interface: any
Source: IP address of the other appliance specified in the master/slave(HA) parameter of minarkconf
Destination: FAST360
Service: TCP 1756
Action: accept
Logging: standard
Name: Heartbeat-From Rule installed on the active and passive appliances.
Input interface: any
Source: IP address of the other appliance specified in the master/slave(HA) parameter of minarkconf
Destination: FAST360
Service: UDP 694
Action: accept
Logging: standard
Name: HaNTP-From Rule installed on the active appliance.
Input interface: any
Source: IP address of the other appliance specified in the master/slave(HA) parameter of minarkconf
Destination: FAST360
Service: UDP 123
Action: accept
Logging: standard
Name: HaUpdate-From Rule installed on the active appliance.
Input interface: any
Source: IP address of the other appliance specified in the master/slave(HA) parameter of minarkconf
Destination: FAST360
Service: TCP 1752
Action: accept
Logging: standard

520

| Various Implicit Filtering Rules

Appendix E. Implicit Filtering Rules

Name: Akha-To Rule installed on the passive appliance.
Input interface: any
Source: FAST360
Destination: IP address of the other appliance specified in the master/slave(HA) parameter of
minarkconf .
Service: TCP 1756
Action: accept
Logging: standard
Name: Heartbeat-To Rule installed on the active and passive appliances.
Input interface: any
Source: FAST360
Destination: broadcast address of the heartbeat network specified in the master/slave(HA) parameter
of minarkconf .
Service: UDP 694
Action: accept
Logging: standard
Name: HA-NTP-To Rule installed on the passive appliance.
Input interface: any
Source: FAST360
Destination: IP address of the other appliance specified in the master/slave(HA) parameter of
minarkconf .
Service: UDP 123
Action: accept
Logging: standard
Name: HA-Update-To Rule installed on the passive appliance.
Input interface: any
Source: FAST360
Destination: IP address of the other appliance specified in the master/slave(HA) parameter of
minarkconf .
Service: TCP 1752
Action: accept
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Logging: standard
Name: SMTP-To Rule installed on the passive appliance.
Input interface: any
Source: FAST360
Destination: IP address of the other appliance specified in the master/slave(HA) parameter of
minarkconf .
Service: TCP 25
Action: accept
Logging: standard
Name: Sync Protocol Unicast In
Source: Real IP of another FAST360 appliance declared in the interface
Destination: My real IP declared in this interface.
Destination port: UDP 1760
Name: Sync Protocol Unicast Out
Source: Real IP declared in this interface
Destination: Real IP of another FAST360 appliance declared in the interface.
Destination port: UDP 1760
Name: VRRP In
Input interface: any
Destination: 224.0.0.18
Source port: Protocol IP 112
Destination port: Protocol IP 112
Name: VRRP Out
Source: Local IP
Destination: 224.0.0.18
Source port: Protocol IP 112
Destination port: Protocol IP 112
Name: Akha Input rule
Source: Network of the admin-syncaddress interface
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Destination: Local IP
Destination port: TCP 1756
Name: Akha Output rule
Source: Local IP
Destination: Real IP address of the 'admin-syncaddress' interface.
Destination port: TCP 1756

E.4. Default Blocking Rules
Name: Default deny on input
Input interface: any
Source: any
Destination: FAST360
Service: any
Action: block
Logging: complete
Name: Default deny on forward
Input interface: any
Source: any
Destination: any
Service: any
Action: block
Logging: complete
Name: Default deny on output
Input interface: any
Source: FAST360
Destination: any
Service: any
Action: refuse
Logging: complete
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Appendix F. Types of logs
This section describes the different types of Arkoon FAST360 appliances logs.
The following types of logs can be generated with an FAST360 appliance, depending on the features
and configuration :
• Alerts: general logs related to security functions.
• IP: filtering policy logs (flow rules, IP/TCP/UDP controls and FAST360 applicative controls).
• IDPS: logs specific to IDPS (Intrusion Detection and Prevention System) feature.
• HTTP: HTTP relay logs.
• SMTP: SMTP relay logs.

F.1. General description
F.1.1. Alerts logs
AKLOG - id=firewall time="2004-02-25 17:38:51" pri=4 fw=myArkoon aktype=ALERT gmtime=1077727131
alert_type="Blocked by application control" user="userName" alert_level="Low" alert_desc="TCP from
10.10.192.61:33027 to 10.10.192.156:25 [default rule]"

F.1.2. IP logs
AKLOG-id=firewall time="2004-02-25 17:38:57" fw=myArkoon aktype=IP gmtime=1077727137
ip_log_type=ENDCONN src=10.10.192.61 dst=10.10.192.255 proto="137/udp" protocol=17 port_src=137
port_dest=137 intf_in=eth0 intf_out= pkt_len=78 nat=NO snat_addr=0 snat_port=0 dnat_addr=0
dnat_port=0 user="userName" pri=3 rule="myRule" action=DENY reason="Blocked by filter"
description="dst addr received from Internet is private"

F.1.3. IDPS logs
AKLOG-id=firewall time="2004-02-25 17:38:57" fw=myArkoon aktype=IDPSMATCH gmtime=1077727137
src=10.10.192.61 dst=10.10.192.255 proto="137/udp" protocol=17 port_src=137 port_dest=137 profile=1
sid=123 score=50
AKLOG-id=firewall time="2004-02-25 17:38:57" fw=myArkoon aktype=IDPSALERT gmtime=1077727137
src=10.10.192.61 dst=10.10.192.255 proto="137/udp" protocol=17 port_src=137 port_dest=137 profile=1
endcnx_score=100 ch=1 reaction=0

F.1.4. HTTP logs
AKLOG-id=firewall time="2004-02-25 17:42:54" fw=myArkoon pri=6 aktype=HTTP gmtime=1077727374
src=10.10.192.61 proto=http user="userName" op="GET" dstname=www arg="http://www/ HTTP/1.1" ref=""
agent="Mozilla/5.0 (X11; U; Linux i686; en-US; rv:1.0.0) Gecko/20020623 Debian/1.0.0-0.woody.1" rcvd=355
result=407
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F.1.5. SMTP logs
AKLOG-id=firewall time="2004-02-25 18:01:46" fw=myArkoon pri=6 aktype=SMTP gmtime=1077728506
proto=smtp
id_mail=nPhgMW
src=10.10.192.61
sent=5
srcname="source@arkoon.dev"
dstname="dest@arkoon.dev" subject="Subject" result="Received OK" reason="" rule="Smtp relay"

F.2. Fields
F.2.1. Fields present in all logs
There are four fields required for each record:
• Record identifier (id=)
• Date/time (time=)
• Firewall IP address or name (fw=)
• Priority of the record (pri=)
The first two fields for each record are (after “AKLOG - “) id= and time= in that order.
• id=
This field identifies the type of record. For FAST360 logs, the type is always firewall to respect the
compatibility with Webtrends Welf format.
id=firewall

• time=
The date/time field shows the date and time of the event, local time. The form of the date/time field is
(enclosed in double quotes):
time=”yyyy-mm-dd hh:mm:ss”
yyyy: year (always 4 digits)
mm: number between 1 and 12 (inclusive) to represent the month (1 or 2 digits)
dd: day of the month, (1 or 2 digits)
hh: hour, based on 24-hour clock (1 or 2 digits)
mm: minute (1 or 2 digits)
ss: second (1 or 2 digits)

For example, 8:00 am on January 1, 2004 is represented as:
time=”2004-01-01 06:00:00”

8:00 pm on the same day is represented as:
time=”2004-01-01 20:00:00”

• gmtime=
The time is also represented in Utime-unix time, that is to say in number of seconds since1970-01-01
00:00:00
gmtime=1077727131

• fw=
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This field identifies the firewall which generated the log record. This is most often represented as an
IP address or a machine name. If the firewall is logged, the IP address is always the IP address of the
internal network interface or the IP address of the external network interface, not a mixture of the two.
fw=10.10.192.162

fw=myArkoon

• pri=
Event priority. Possible values are:
0
1
2
3
4
5
6
7

-

emergency
alert
critical
error
warning
notice
information
debug

pri=0
pri=5

• aktype=
Type of log which can be one of the following:
ALERT – for alerts logs
IP – for IP firewall logs
IDPSMATCH – for IDPS matches logs
IDPSALERT – for IDPS alerts logs
HTTP- for HTTP proxy logs
SMTP – for SMTP proxy logs
aktype=HTTP

F.2.2. Fields specific to alerts logs
• alert_type=
This field identifies the type of alert which can be one of the following (alert_type ID, alert_type name)
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0
None
1
Bad packet
2
Blocked by filter
3
Blocked by application control
4
Unsequenced packet
5
Bad SPI (VPN)
6
No license
7
Portscan detected
8
Virus found
9
Upgrade
10
Interface Up
11
Interface Down
12
Service restarted
13
Interface disconnected
14
Interface reconnected
15
HA Active
16
HA Passive
17
HA Link Up
18
HA Link Down
19
Admin Connection
20
Config file installed
21
IKE Alert
22
Arkoon Up
23
Arkoon Down
24
Mail Quarantine FULL
25
Outconn UP
26
Outconn DOWN
27
New mail in quarantine
28
Rule denied mail
29
Encrypted file in mail
30
Analyze error in mail
31
Authentication failure
32
Patch kernel Arkoon
33
Automatic Flush and Backup
34
DoS Attack Detection
35
Service started
36
Service stopped
37
Date/Time modification
38
Certificate created
39
Certificate revoked
40
DB Table flushed
41
Admin user added/removed
42
Automatic Flush and Backup (Table full)
43
AdminFrom value modification
44
Warning on log queue
45
Warning on /var
46
Warning on /config_card
47
Network traffic blocked due to Aklog
48
Network traffic unblocked
49
System Monitoring alert
50
Flush database
51
NTP (de)synchronization
52
IDPS alert
53
Routing alert
54
Mail Disclaimer fail
55
FireConverge blacklist alert
56
Media alert
57
DHCP Relay
58
DHCP Server
59
Admin unauthorized access
60
Real Time Antispam
Unknown (�u) (where �u is an unsigned long integer)
alert_type="Blocked by filter"

• user=
Name of user who generated this particular alert.
user=”userName”

• alert_level=
This field identifies the alert level, which can be one of the following: None (Information), Low, Medium
or High (alert_level ID, alert_level name)
0
1
2
3

None (Information)
Low
Medium
High

alert_level=”Low”
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• alert_desc=
This is the alert description which can be one of the following:
TCP from ipS:portS to ipD:portD [desc]
UDP from ipS:portS to ipD:portD [desc]
ICMP:portD.portS from ipS to ipD [desc]
PROTO:protocol from ipS to ipD [desc]
Unsequenced packet on non-TCP proto from ipS:portS
Unsequenced TCP packet from ipS:portS to ipD:portD
ACK unsequenced packet on non-TCP proto from ipS:portS
ACK unsequenced TCP packet from ipS:portS to ipD:portD
Bad flags on non-TCP proto from ipS:portS
Bad TCP flags (�s) from ipS:portS to ipD:portD
Bad packet from ipS:portS to ipD:portD [desc]
Land attack from ipS to ipD
New value: ipS/Mask [ports]
No license installed

with
ipS: IP address of the source of the event
portS: Port number of the source of the event
ipD: IP address of the destination of the event
portD: Port number of the destination of the event
Mask: network Mask
ports: List of authorized ports separated by a space
desc: Description
protocol: see below for a description of protocol

Example:
alert_desc="TCP from 10.10.192.61:33027 to 10.10.192.156:25

[default rule]"

F.2.3. Fields specific to IP logs
• ip_log_type=
This field identifies the type of IP log. The possible values are NEWCONN, ENDCONN, BADPACKET,
APPVIOLATION or an empty string value.
ip_log_type=NEWCONN
ip_log_type=

• src=
Src is the IP address that generated the event.
src=10.10.192.155

• dst=
Dst is the IP address that received the event.
dst=10.10.192.61

• proto=
The protocol used by the event formatted like this “destination port number/name of protocol”.
proto=”631/udp”
proto=”1751/tcp”

• protocol=
Id of the protocol. Example of esp protocol:
protocol=50

• port_src=
Port number of the event source.
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port_src=137

• port_dest=
Port number of the event destination.
port_dest=137

• intf_in=
This field identifies the name of the incoming interface. It can be empty.
intf_in=eth0
intf_in=

• intf_out=
This field identifies the name of the outcoming interface. It can be empty.
intf_out=eth0
intf_out=

• pkt_len=
Identifies the length (in bytes) of the packet that triggered the event.
pkt_len=78

• nat=
This field identifies the type of NAT (Network address Translation) used. Values can be NO, HIDE, PAT
or STATIC.
nat=STATIC

• snat_addr=
Address of the nat-ed source or “0” if Network Address Translation is not used.
snat_addr=194.3.2.1

snat_addr=0

• snat_port=
Port number of the nat-ed source or “0” if Network Address Translation is not used.
snat_port=4378

snat_port=0

• dnat_addr=
Address of the nat-ed destination or “0” if Network Address Translation is not used.
dnat_addr=196.5.4.8

dnat_addr=0

• dnat_port=
Port number of the nat-ed destination or “0” if Network Address Translation is not used.
dnat_port=80

dnat_port=0

• user=
The name of the user who generated the event (if known).
user=”userName”

user=””

• vpn-src=
For a packet which was encrypted in an IPSec tunnel, this is an ID of the tunnel (either the login name
or the IPSec-ID used to negociate the IPSec SA).
vpn-src=”C=fr,..., CN=John Doe”

• rule=
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This field identifies the name of the rule that produced the event.
rule="myRule"

• action=
Three types of action are possible: ACCEPT, DENY or REJECT
action=ACCEPT

• reason=
Reason of this event log which can be one of the following messages:
Blocked by filter / Unsequenced packet / ACK unsequenced packet / Bad Flags packet / Blocked by
application control / Bad packet / Bad SPI / Land Attack / Bad License / Bad encryption source / Bad
encryption destination / Maximum waiting connections reached / Maximum established connections
reached / No module found / Ident Hack
reason="Blocked by filter"

• description=
This is a description of the event which can also be an empty string. Possibles values are:
src addr received from Internet is private / dst addr received from Internet is private / src addr to be
sent to Internet is private / dest addr to be sent to Internet is private / Oversized IP packet / Bad IP
Options / IP Options not allowed by config
description="dst addr received from Internet is private"
description=””

• sent=
This field only exists into exported logs and not into logs sent to a Syslog server. It identifies the number
of bytes sent to the connection corresponding to this packet.
sent=655

• rcvd=
The number of bytes transferred from the destination to the source.
rcvd=655

• end_reason=
Description or reason of the end of connection.
end_reason=”Closed by Client”
end_reason=”Reset by Server”

F.2.4. Fields present in all IDPS logs
These fields can be found in IDPSMATCH or IDPSALERT:
• src=
Source IP address which generated the event.
src=194.3.2.1

• dst=
Dst is the IP address that received the event.
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dst=10.10.192.61

• proto=
The protocol used by the event formatted the following way: “destination port number/name of
protocol”.
proto=”631/udp”
proto=”1751/tcp”

• protocol=
Id of the protocol. Example of esp protocol:
protocol=50

• port_src=
Port number of the event source.
port_src=137

• port_dest=
Port number of the event destination.
port_dest=137

• profile=
This field identifies the id of the IDPS profile with the following correspondence (07/01/04):
1
FTP_BADFILES
Suspicious filenames in commands
2
FTP_SCAN
Scanning attempts
3
FTP
General FTP signatures
4
HTTP
General HTTP signatures
5
HTTP_BADURL
URLs of known attacks and vulnerabilities in CGIs
6
HTTP_COLDFUSION Vulnerabilities in ColdFusion applications
7
HTTP_FRONTPAGE
Vulnerabilities in Microsoft Frontpage
applications
8
HTTP_IIS
Vulnerabilities in Microsoft IIS
9
HTTP_PHP
Vulnerabilities in PHP applications
10 HTTP_NETSCAPE
Vulnerabilities in Netscape Enterprise httpd
11 HTTP_TOMCAT
Vulnerabilities in Apache Tomcat
12 HTTP_APACHE
Vulnerabilities in Apache httpd
13 HTTP_WINDOWS
Vulnerabilites in HTTP applications specific to
Microsoft Windows
14 HTTP_ORACLE
Vulnerabilities in Oracle
15 HTTP_TALENTSOFT Vulnerabilities in Talentsoft applications
16 HTTP_LOTUS
Vulnerabilities in Lotus applications
17 HTTP_UNIX
HTTP attacks specific to Unix-like systems
18 HTTP_CISCO
HTTP attacks against Cisco products
19 HTTP_WEBLOGIC
HTTP attacks against Weblogic applications
20 HTTP_MYSQL
HTTP attacks related to the MySQL database
server
21 HTTP_MACOS
HTTP attacks specific to MacOS systems
22 HTTP_VIRUSWALL
HTTP attacks against Viruswall products
23 SMTP
SMTP attacks
24 IMAP4
IMAP attacks
25 POP3
POP3 attacks
26 DNS
DNS attacks
Example:
profile=23
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F.2.5. Fields specific to IDPS matchs logs (IDPSMATCH)
• sid=
Id of the ARKOON IDPS signature that generated the match.
sid=125

• score=
Numeric field which identifies the score of the ARKOON IDPS match.
score=80

F.2.6. Fields specific to IDPS alert logs (IDPSALERT)
• endcnx_score=
Numeric field providing the score value when the connection ends.
endcnx_score=125

Product Eng

• ch=
Boolean indicating if the connection was for a host seen as jeopardized by the IDPS (e.g. a host to
which there has already been an IDPS power connection ).
ch=0 (if the host is a compromised one)
ch=1 (if it is not)

• reaction=
Numeric field which identifies the type of reaction the IDPS had.
reaction=0 (for a RESET)
reaction=1 (for a DROP)
reaction=2 (for a HALF/DROP)

F.2.7. Fields specific to HTTP logs
• src=
Source IP address which produced the event.
src=194.3.2.1

• proto=
This field identifies the protocol of the event.
proto=https

proto=http

• user=
This is the name of the user who generated the event (if known).
user=”myName”

• op=
For HTTP and FTP requests, it is an operation such as GET, POST, HEAD, etc.
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op=”GET”

• dstname=
The IP address or URL that received the event and the port.
dstname=www.arkoon.net:80
dstname=195.167.226.90:80

• arg=
For HTTP and FTP requests, it is the accessed URL .
arg=”http://www.arkoon.net:80 HTTP/1.1”
arg=”http://195.167.226.90:80 HTTP/1.0”

• ref=
For incoming web records, this field contains the referring site.
arg=”http://www.securityfocus.com”

• agent=
For incoming or outgoing web records, this field contains the agent (usually the browser).
agent="Mozilla/5.0 (X11; U; Linux i686; en-US; rv:1.0.0
Gecko/20020623 Debian/1.0.0-0.woody.1"
agent="Microsoft Internet Explorer/4.40.308 (Windows 95)"

• rcvd=
The number of bytes transferred from the destination to the source.
rcvd=355

• result=
For HTTP requests, this is the standard result code, such as 200 for success, 304 for returned from
cache, etc.
result=407

F.2.8. Fields specific to SMTP logs
• proto=
This field identifies the event protocol.
proto=smtp

• id_mail=
The id of the mail.
id_mail=nPhgMW

• src=
Source IP address which produced the event.
src=194.3.2.1

• sent=
Number of bytes transferred from the source to the destination.
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sent=5

• srcname=
Mail source name.
srcname="source@arkoon.dev"

• dstname=
Mail destination name.
dstname="dest@arkoon.dev"

• subject=
Mail subject
subject="Subject of my message"

• result=
Result message, which can be:
Content OK / Virus found in message / Message denied by rule / Mail denied / File repaired / File
removed / File encrypted / Received OK / Message too big / Relaying denied / Mail put in quarantine /
Mail sent without analyze / Mail removed from quarantine / Analyze file error
result=”Received OK”

• reason=
This field identifies the reason of the event.
Virus / Virus virusName found in file/ Name File fileName encrypted / File fileName : analyze error /
Quarantine full! / Denied by rule ruleName / Denied by rule ruleName, put mail in quarantine.
with: virusName: name of the virus
fileName: name of the file
example:
reason="File document.pif encrypted"
reason=”Virus found in document.pif”

• rule=
The name of the rule which created the event.
rule=”Smtp Relay”
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F.3. IDPS signatures
ID
1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
29
30
31
32
33
34
35
36
37
38
39
40
41
42
43
44
45
46
47
48
49
50
51
52
53
54
55
56
57
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Name
FTP_CWD_C_COLON
FTP_SITE_ZIPCHK
FTP_SITE_NEWER
FTP_SITE_EXEC
FTP_STAT_STAR
FTP_STAT_QUESTION
FTP_TAR_PARAMETERS
FTP_CWD_ROOT
FTP_CWD_DOTS
FTP_CWD_NEWLINE
FTP_CWD_CR_NEWLINE
FTP_SERVU_TRAVERSAL
FTP_FORMAT_STRING
FTP_RNFR
FTP_DOT_FORWARD
FTP_DOT_RHOSTS
FTP_DOT_AUTHKEYS
FTP_PASSWD
FTP_SHADOW
FTP_ADMWORM
FTP_ADMSCAN
FTP_ISS_SCAN
FTP_PASS_WHOOT
FTP_PISS_SCAN
FTP_SAINT_SCAN
FTP_SATAN_SCAN
HTTP_BIN_PS
HTTP_BIN_WGET
HTTP_BIN_UNAME
HTTP_BIN_ID
HTTP_BIN_ID_2
HTTP_BIN_ECHO
HTTP_BIN_KILL
HTTP_BIN_CHMOD
HTTP_BIN_CHGRP
HTTP_BIN_CHOWN
HTTP_BIN_CHSH
HTTP_BIN_TFTP
HTTP_BIN_GCC
HTTP_BIN_GCC_2
HTTP_BIN_CC
HTTP_BIN_CC_2
HTTP_BIN_CPP
HTTP_BIN_CPP_2
HTTP_BIN_GPP
HTTP_BIN_GPP_2
HTTP_BIN_PYTHON
HTTP_BIN_PYTHON_2
HTTP_BIN_TCLSH
HTTP_BIN_TCLSH_2
HTTP_BIN_NASM
HTTP_BIN_NASM_2
HTTP_BIN_PERL
HTTP_BIN_PERL_2
HTTP_WIN_NT_ADM
HTTP_BIN_TRACEROUTE
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58
59
60
61
62
63
64
65
66
67
69
70
71
72
73
74
75
76
77
78
79
80
81
82
83
85
86
87
88
89
90
92
93
94
95
96
97
98
99
100
101
102
104
105
106
107
108
109
110
111
112
113
114
115
116
117
118
119
120
122
123
124

HTTP_BIN_PING
HTTP_BIN_NETCAT
HTTP_BIN_NMAP
HTTP_BIN_XTERM
HTTP_X_DISPLAY
HTTP_BIN_LSOF
HTTP_BIN_RM
HTTP_BIN_MAIL
HTTP_BIN_MAIL_2
HTTP_BIN_LS
HTTP_INETD
HTTP_MOTD
HTTP_ETC_SHADOW
HTTP_HTTPD_DOT_CONF
HTTP_HTGROUP
HTTP_OUTLOOK_DOT_EML
HTTP_XMLHTTPREQUEST
HTTP_README_DOT_EML
HTTP_README_DOT_EML_2
HTTP_JAVASCRIPT_DOC_DOMAIN
HTTP_URL_SPOOFING
HTTP_CGI_HYPERSEEK
HTTP_YABB_ACCESS
HTTP_CGI_WWWBOARD_PASSWD
HTTP_CGI_WEBDRIVER
HTTP_CGI_WHOIS_RAW_2
HTTP_CGI_WEBPLUS_ABOUT
HTTP_CGI_WEBSENDMAIL
HTTP_CGI_DCFORUM
HTTP_CGI_DCBOARD
HTTP_CGI_MMSTDOD
HTTP_CGI_IMAGEMAP_2
HTTP_CGI_CVSWEB
HTTP_CGI_GLIMPSE
HTTP_CGI_HTMLSCRIPT
HTTP_CGI_INFO2WWW
HTTP_CGI_MAILLIST
HTTP_CGI_NPH_TEST
HTTP_CGI_NPH_PUBLISH
HTTP_CGI_NPH_PUBLISH_2
HTTP_CGI_RGUEST
HTTP_CGI_RWWWSHELL
HTTP_CGI_TEST_CGI
HTTP_CGI_TEST_CGI_2
HTTP_CGI_TEST_CGI_3
HTTP_CGI_TESTCOUNTER
HTTP_CGI_UPLOADER
HTTP_CGI_WEBGAIS
HTTP_CGI_FINGER
HTTP_CGI_PERLSHOP
HTTP_CGI_PFDISPLAY
HTTP_CGI_AGLIMPSE
HTTP_CGI_ANFORME2
HTTP_CGI_ARGS_BAT
HTTP_CGI_ARGS_CMD
HTTP_CGI_AT_ADMIN
HTTP_CGI_AT_GENERATED
HTTP_CGI_BNBFORM
HTTP_CGI_CAMPAS
HTTP_CGI_VIEW_SOURCE
HTTP_CGI_WAIS
HTTP_CGI_WWWWAIS
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125
126
127
128
129
130
132
133
134
135
136
137
138
140
142
143
144
145
146
147
148
149
150
152
153
154
155
156
157
158
160
161
162
163
164
165
167
168
169
171
172
173
176
177
178
179
180
181
182
183
184
186
187
189
190
191
192
193
194
195
196
197

538

HTTP_CGI_FILES_PL
HTTP_CGI_WGUEST
HTTP_CGI_WRAP
HTTP_CGI_CLASSIFIEDS
HTTP_CGI_ENVIRON
HTTP_CGI_FAXSURVEY
HTTP_CGI_MAN
HTTP_CGI_SNORK
HTTP_CGI_W3MSQL
HTTP_CGI_DAY5DATACOPIER
HTTP_CGI_POST_QUERY
HTTP_CGI_VISADMIN
HTTP_CGI_DUMPENV
HTTP_CGI_CALENDAR
HTTP_CGI_CALENDER
HTTP_CGI_USER_UPDATE
HTTP_CGI_SURVEY
HTTP_CGI_WIN_C_SAMPLE
HTTP_CGI_W3TVARS
HTTP_CGI_ADMIN
HTTP_CGI_LWGATE
HTTP_CGI_ARCHIE
HTTP_CGI_FLEXFORM
HTTP_CGI_PHF
HTTP_CGI_WWW_SQL
HTTP_CGI_WWWADMIN
HTTP_CGI_PPDSCGI
HTTP_CGI_SENDFORM
HTTP_CGI_UPLOAD
HTTP_CGI_ANYFORM2
HTTP_CGI_BBHIST
HTTP_CGI_BBHISTLOG
HTTP_CGI_HISTSVC
HTTP_CGI_BBREP
HTTP_CGI_BBREPLOG
HTTP_CGI_REDIRECT
HTTP_CGI_PALSCGI
HTTP_CGI_COMMERCE
HTTP_CGI_AMAYA_TEMPLATE
HTTP_CGI_TSTISAPI
HTTP_CGI_SENDMESSAGE
HTTP_CGI_LASTLINES
HTTP_CGI_AGORA
HTTP_CGI_RKSH
HTTP_CGI_BACH
HTTP_CGI_PERLEXE
HTTP_CGI_PERLCOMMAND
HTTP_CGI_ZSH
HTTP_CGI_CSH
HTTP_CGI_RSH
HTTP_CGI_KSH
HTTP_CGI_CGIFORUM
HTTP_CGI_DIRECTORYPRO
HTTP_CGI_LISTREC
HTTP_CGI_MAILNEWS
HTTP_CGI_BOOK
HTTP_CGI_NEWSDESK
HTTP_CGI_CALMAKE
HTTP_CGI_MAILIT
HTTP_CGI_SDBSEARCH
HTTP_CGI_SWC
HTTP_CGI_TTAWEBTOP
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198
199
200
201
202
203
204
205
206
207
208
209
210
211
212
213
215
217
218
219
220
223
225
226
227
228
229
231
232
233
234
235
236
237
238
239
240
242
243
245
246
248
249
251
252
253
254
256
257
258
261
262
263
264
265
266
267
268
270
271
272
275

HTTP_CGI_UPLOAD_2
HTTP_CGI_VIEWSOURCE
HTTP_CGI_USTOREKEEPER
HTTP_CGI_ICAT
HTTP_CGI_BUGZILLA_EDITVOTES
HTTP_CGI_HTSEARCH
HTTP_CGI_A1STATS
HTTP_CGI_ALCHEMY
HTTP_CGI_ALIBABA
HTTP_CGI_TEST_BAT
HTTP_CGI_INPUT_BAT
HTTP_CGI_INPUT2_BAT
HTTP_CGI_ENVOUT_BAT
HTTP_CGI_ECHO_BAT
HTTP_CGI_HELLO_BAT
HTTP_CGI_TST_BAT
HTTP_CGI_CGIMAIL
HTTP_CGI_CART
HTTP_CGI_DBMAN
HTTP_CGI_DCSHOP
HTTP_CGI_ESHOP
HTTP_CGI_ECHO_EXE
HTTP_CGI_GUESTBOOK
HTTP_CGI_SEARCH
HTTP_CGI_ENIVRON
HTTP_CGI_CAMPUS
HTTP_CGI_CART32
HTTP_CGI_AD
HTTP_CGI_BBS_FORUM
HTTP_CGI_BSGUEST
HTTP_CGI_BSLIST
HTTP_CGI_CGFORUM
HTTP_CGI_NEWDESK
HTTP_CGI_REGISTER
HTTP_CGI_GBOOK
HTTP_CGI_SIMPLEGUEST
HTTP_CGI_STATUSCONFIG
HTTP_CGI_ADCYCLE
HTTP_CGI_MACHINEINFO
HTTP_CGI_DOCUMENT_D2W
HTTP_CGI_DB2WWW
HTTP_CGIDOS
HTTP_CGI_WEBSTOE
HTTP_CGI_CACHEDFEED
HTTP_CGI_TALENTSOFT
HTTP_CGI_POLLIT
HTTP_CGI_COUNT
HTTP_CGI_BIGCONF
HTTP_CGI_JJ
HTTP_CGI_BIZDBSEARCH
HTTP_CGI_AX_ADMIN
HTTP_CGI_CACHEMGR
HTTP_CGI_RESPONDER
HTTP_CGI_WEBMAP
HTTP_CGI_MINISTATS
HTTP_CGI_DFIRE
HTTP_CGI_TXT2HTML
HTTP_CGI_STORE
HTTP_CGI_SPINCLIENT
HTTP_CGI_CSPASSWORD
HTTP_CGI_NORTEL
HTTP_CGI_STORY
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276
277
279
280
281
282
283
284
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HTTP_CGI_USERMOD
HTTP_CGI_CGICSO
HTTP_CGI_PRINTENV
HTTP_CGI_RPC_NLOG
HTTP_CGI_RPC_SMB
HTTP_CGI_VPASSWD
HTTP_CGI_ALYA
HTTP_CGI_VIRALATOR
HTTP_CGI_SMARTSEARCH
HTTP_CGI_OVERFLOW
HTTP_CGI_WAYBOARD
HTTP_CGI_PROCESSBUG
HTTP_CGI_PARSEXML
HTTP_CGI_CHIPCFG
HTTP_CGI_IKONBOARD
HTTP_CGI_SRSRV
HTTP_CFM_CFCACHE
HTTP_CFM_EXAMPLEAP
HTTP_CFM_APPLICATION
HTTP_CFM_GETFILE
HTTP_CFM_ADDCONTENT
HTTP_CFM_ADMINACCESS
HTTP_CFM_DATASOURCE
HTTP_CFM_FILEXISTS
HTTP_CFM_PARKS
HTTP_CFM_APPMAN
HTTP_CFM_BEANINFO
HTTP_CFM_EVALUATE
HTTP_CFM_GETODBCDSN
HTTP_CFM_DBCONNECT
HTTP_CFM_EXPEVAL
HTTP_CFM_DATASOURCE_3
HTTP_CFM_ADMINENCRYPT
HTTP_CFM_GETODBCIN
HTTP_CFM_ADMINDECRYPT
HTTP_CFM_MAINFRAMESET
HTTP_CFM_SETODBCINI
HTTP_CFM_REFRESH
HTTP_CFM_CFUSION_VERIFYMAIL
HTTP_CFM_CFMLSYNTAXCHECK
HTTP_CFM_ONREQUESTEND
HTTP_CFM_STARTSTOP
HTTP_CFM_GETTEMPDIR
HTTP_CFM_SENDMAIL
HTTP_CFM_MODEDEBUG
HTTP_FRONTPAGE_RAD_FP30REG
HTTP_FRONTPAGE_RAD_FP4AREG
HTTP_FRONTPAGE_VTI_RPC
HTTP_FRONTPAGE_SHTML_DLL
HTTP_FRONTPAGE_CONTENTS
HTTP_FRONTPAGE_ORDERS
HTTP_FRONTPAGE_FPSRVADM
HTTP_FRONTPAGE_FPREMADM
HTTP_FRONTPAGE_FPADMIN
HTTP_FRONTPAGE_FPADMCGI
HTTP_FRONTPAGE_ORDERS_TXT
HTTP_FRONTPAGE_FORM_RESULTS
HTTP_FRONTPAGE_REGISTRATIONS
HTTP_FRONTPAGE_CFGWIZ
HTTP_FRONTPAGE_AUTHORS_PWD
HTTP_FRONTPAGE_AUTHOR_EXE
HTTP_FRONTPAGE_ADMINISTRATORS_PWD
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HTTP_FRONTPAGE_FORM_RESULTS_2
HTTP_FRONTPAGE_ACCESS_CNF
HTTP_FRONTPAGE_REGISTER_TXT
HTTP_FRONTPAGE_REGISTRATIONS_TXT
HTTP_FRONTPAGE_SERVICE_CNF
HTTP_FRONTPAGE_SERVICE_PWD
HTTP_FRONTPAGE_SERVICE_STP
HTTP_FRONTPAGE_SERVICES_CNF
HTTP_FRONTPAGE_SHTML_EXE
HTTP_FRONTPAGE_SVCACL_CNF
HTTP_FRONTPAGE_USERS_PWD
HTTP_FRONTPAGE_WRITETO
HTTP_FRONTPAGE_FOURDOTS
HTTP_FRONTPAGE_REGISTER
HTTP_FRONTPAGE_DVWSSR
HTTP_IIS_REPOST
HTTP_IIS_HTR
HTTP_IIS_STORECVS
HTTP_IIS_USERS_XML
HTTP_IIS_AS_WEB
HTTP_IIS_AS_WEB4
HTTP_IIS_PBSERVER
HTTP_IIS_TRACE_AXD
HTTP_IIS_TSTISAPI
HTTP_IIS_MKILOG
HTTP_IIS_CTSS
HTTP_IIS_WEBDAV_LOCK
HTTP_IIS_PRINTER
HTTP_IIS_PCT2E
HTTP_IIS_DATAACCESS
HTTP_IIS_BATACCESS
HTTP_IIS_CNFACCESS
HTTP_IIS_CGIMAIL
HTTP_IIS_UNICODE_TRAVERSAL
HTTP_IIS_UNICODE_TRAVERSAL_2
HTTP_IIS_UNICODE_TRAVERSAL_3
HTTP_IIS_UNICODE_TRAVERSAL_4
HTTP_IIS_MSPROXY
HTTP_IIS_CODEFRAGMENT
HTTP_IIS_SAMCONTENT
HTTP_IIS_SENSEPOST
HTTP_IIS_VTI_INF
HTTP_IIS_ACHG
HTTP_IIS_ISM_DLL
HTTP_IIS_ANOT_HTR
HTTP_IIS_ASPDOT
HTTP_IIS_ASPSRCH
HTTP_IIS_CMD32
HTTP_IIS_CMD
HTTP_IIS_CROSSSCRIPTING
HTTP_IIS_CROSSSCRIPTING_2
HTTP_IIS_DEL
HTTP_IIS_DIRLISTING
HTTP_IIS_ENCODING_ACCESS
HTTP_IIS_EXEC_SRC
HTTP_IIS_FPCOUNT
HTTP_IIS_GETDRVS
HTTP_IIS_GLOBAL_ASA
HTTP_IIS_IDC_SRCH
HTTP_IIS_IISADMPWD_AEXP
HTTP_IIS_ISC_DATA
HTTP_IIS_ISM
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HTTP_IIS_JET_VBA
HTTP_IIS_MSADCS
HTTP_IIS_NEWDSN
HTTP_IIS_PERL
HTTP_IIS_SEARCH97
HTTP_IIS_SHOWCODE
HTTP_IIS_SITE_CONFIG
HTTP_IIS_SRCH_HTM
HTTP_IIS_SRCHADM
HTTP_IIS_UPLOADN
HTTP_IIS_VIEW_SOURCE
HTTP_IIS_VIEWCODE
HTTP_IIS_WEBHITS
HTTP_IIS_DOCTODEP
HTTP_IIS_IISAMPLES
HTTP_IIS_CODERED_V2
HTTP_IIS_SCRIPTS_SAMPLES
HTTP_IIS_MSADC_SAMPLES
HTTP_IIS_SAMPLES
HTTP_IIS_IISADMIN
HTTP_IIS_MEMBIN
HTTP_IIS_HTIMAGE
HTTP_IIS_SITESERVER
HTTP_IIS_POSTINFO
HTTP_IIS_EXCHANGE_ROOT
HTTP_IIS_BATTLEAXE_FORUM
HTTP_IIS_NSIISLOG
HTTP_IIS_IISPROTECT
HTTP_IIS_IISPROTECT_2
HTTP_IIS_SYNCHROLOGIC
HTTP_IIS_BIZTALK
HTTP_IIS_REGISTER
HTTP_PHP_BBSMILIES
HTTP_PHP_BLAHZDNS
HTTP_PHP_PHP_EXE
HTTP_PHP_PASSWD
HTTP_PHP_PHORUM_CODE
HTTP_PHP_PHORUM_AUTHENTIFICATION
HTTP_PHP_STRING_OVERFLOW
HTTP_PHP_STRING_OVERFLOW_2
HTTP_PHP_REMOTE_COMMAND
HTTP_PHP_PHPLIB_INCLUDE
HTTP_PHP_BLNEWS_OBJECTS
HTTP_PHP_TURBA_STATUS
HTTP_PHP_TTCMS
HTTP_PHP_AUTOHTML
HTTP_NETSCAPE_ENTERPRISE_DOS
HTTP_NETSCAPE_ENTERPRISE_DIRLISTING
HTTP_IPLANET_GETPROPERTIES
HTTP_WEBLOGIC_VIEWSOURCE
HTTP_TOMCAT_TRAVERSAL
HTTP_TOMCAT_VIEWSOURCE
HTTP_FTP_ACCESS
HTTP_XP_ENUMDSN
HTTP_XPFILELIST
HTTP_XPAVAILABLEMEDIA
HTTP_XPCMDSHELL
HTTP_NETCAT_EXE
HTTP_WSH_EXE
HTTP_RCMD_EXE
HTTP_TELNET_EXE
HTTP_NET_EXE
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HTTP_TFTP_EXE
HTTP_XPREGREAD
HTTP_XPREGWRITE
HTTP_XPREGDELETEKEY
HTTP_WEBDAV_SEARCH
HTTP_HTPASSWD
HTTP_QUERYHIT
HTTP_COUNTER_EXE
HTTP_WEBDAV_PROPFIND
HTTP_EWAVE_SERVLET
HTTP_NETSCAPE_SERVERSSUITE_DOS
HTTP_ICQ_WEB_DOS
HTTP_TALENTSOFT_SOURCE_VIEW
HTTP_TALENTSOFT_IP_DISCLOSURE
HTTP_SMARTWIN_CYBEROFFICE
HTTP_CYBERCOP
HTTP_NESSUS_PROBE
HTTP_NETSCAPE_ADMIN_PASSWD
HTTP_FTP_PERL
HTTP_ROXEN_DIRLISTING
HTTP_SOURCE_ASP
HTTP_TOMCAT_EXPLOIT
HTTP_LOTUS_DELETEDOC
HTTP_LOTUS_EDITDOC
HTTP_LS_L
HTTP_PHP_MLOG
HTTP_ETC_PASSWD
HTTP_PAGESERVICES
HTTP_CONVERT_BAS
HTTP_CPSHOST
HTTP_HTACCESS
HTTP_TILDE_ROOT
HTTP_TILDE_FTP
HTTP_DOMINO_CATALOG_NSF
HTTP_DOMINO_DOMCFG_NSF
HTTP_DOMINO_DOMLOG_NSF
HTTP_DOMINO_LOG_NSF
HTTP_DOMINO_NAMES_NSF
HTTP_DOMINO_MAN_NSF
HTTP_DOMINO_CERSVR_NSF
HTTP_DOMINO_SETUP_NSF
HTTP_DOMINO_STATREP_NSF
HTTP_DOMINO_WEBADMIN_NSF
HTTP_DOMINO_EVENTS4_NSF
HTTP_DOMINO_NTSYNC4_NSF
HTTP_DOMINO_COLLECT4_NSF
HTTP_DOMINO_MAILW46_NSF
HTTP_DOMINO_BOOKMARK_NSF
HTTP_DOMINO_AGENTRUNNER_NSF
HTTP_DOMINO_MAILBOX
HTTP_APACHE_DOS
HTTP_NETSCAPE_PUBLISHING_XPERT
HTTP_WINDMAIL
HTTP_WEBPLUS
HTTP_NETSCAPE_DIRLISTING
HTTP_CART32_ADMINPWD
HTTP_SHOPPING_CART_ACCESS
HTTP_NOVELL_GROUPWISE_2
HTTP_WSFTP_INI
HTTP_RPMQUERY
HTTP_WWWBOARD
HTTP_GET32_EXE
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HTTP_ANNEX_TERMINAL
HTTP_CGITEST_EXE
HTTP_SALESLOGIX_EVIEWER_CMD
HTTP_ORACLE_WEBAPP_ACCESS
HTTP_HTGREP_ACCESS
HTTP_NSCONFIG_ACCESS
HTTP_ADMIN_FILES_ACCESS
HTTP_BACKUP_ACCESS
HTTP_INTRANET_ACCESS
HTTP_FILEMAIL_ACCESS
HTTP_PLUSMAIL_ACCESS
HTTP_ADMINLOGIN_ACCESS
HTTP_ULTRABOARD_ACCESS
HTTP_MUSICAT_EMPOWER_ACCESS
HTTP_VIRUSWALL_FTPSAVE
HTTP_TOMCAT_SOURCEVIEW
HTTP_HP_OPENVIEW_DOS
HTTP_CARBO_DLL_ACCESS
HTTP_CONSOLE_EXE_ACCESS
HTTP_CS_EXE_ACCESS
HTTP_SADMIND_WORM
HTTP_DOT_HISTORY
HTTP_DOT_BASH_HISTORY
HTTP_TILDE_NOBODY
HTTP_MKPLOG_EXE_ACCESS
HTTP_PCCS_MYSQL_ADMIN_ACCESS
HTTP_DS_STORE
HTTP_FBCINDEX
HTTP_EXAIR_ACCESS
HTTP_APACHE_SERVER_INFO_ACCESS
HTTP_APACHE_SERVER_STATUS_ACCESS
HTTP_AXISSTORPOINT_CD
HTTP_BASILIX_SENDMAIL_ACCESS
HTTP_BASILIX_MYSQL_ACCESS
HTTP_BBOARD_ACCESS
HTTP_CISCO_CATALYST_CMD
HTTP_CISCO_DOS_ATTEMPT
HTTP_CVS_ENTRIES_ACCESS
HTTP_CVSWEB_VERSION_ACCESS
HTTP_HOME_FTP_ACCESS
HTTP_HOME_WWW_ACCESS
HTTP_GLOBAL_INC_ACCESS
HTTP_SECURESITE_AUTH_BYPASS
HTTP_NETSCAPE_UNIXWARE_OVERFLOW
HTTP_VIRUSWALL_CATINFO
HTTP_APACHE_CHUNKED_ENCODING_WORM
HTTP_CISCO_VOIP_DOS
HTTP_IBM_NETCOMMERCE_ORDERDSPC
HTTP_WEBINF_ACCESS
HTTP_XSS
HTTP_JIGSAW_DOS_ATTEMPT
HTTP_WEBALIZER_ACCESS
HTTP_WEBFIND_EXE
HTTP_ACTIVE_LOG_ACCESS
HTTP_ROBOTS_TXT_ACCESS
HTTP_ROBOT_TXT_ACCESS
HTTP_CISCO_FIX_DIR_TRAVERSAL
HTTP_LINKSYS_ROUTER_DEFAULT_LOGIN
HTTP_ORACLE_XSQL_CONFIG_ACCESS
HTTP_ORACLE_DMS_ACCESS
HTTP_GLOBALS_JSA_ACCESS
HTTP_ORACLE_JAVA_PROCESS_ACCESS
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HTTP_APACHE_CHUNKED_ENC_EXPLOIT
HTTP_CARELLO_ADD_ACCESS
HTTP_ECWARE_ACCESS
HTTP_IONP_ACCESS
HTTP_SITESCOPE_ACCESS
HTTP_ANSWERBOOK2_ADMIN_ATTEMPT
HTTP_MSMMASK_EXE_ACCESS
HTTP_DB4WEB_ACCESS
HTTP_TOMCAT_NULL_BYTE_DIR
HTTP_IPLANET_PERF_ACCESS
HTTP_CHIP_INI_ACCESS
HTTP_POST32_EXE_ACCESS
HTTP_LYRIS_PL_ACCESS
HTTP_GLOBALS_PL_ACCESS
HTTP_PHILBOARD_MDB
HTTP_PHILBOARD_ADMIN_ACCESS
HTTP_LOGICWORKS_INI_ACCESS
HTTP_STAR_SHTML
HTTP_APACHE_MOD_GZIP_STATUS_ACCESS
SMTP_EXCHANGE_MIME_DOS
SMTP_EXPN_DECODE
SMTP_EXPN_ROOT
SMTP_EXPN_STAR_AT
SMTP_MAJORDOMO_IFS
SMTP_SENDMAIL_5_5_5_EXPLOIT
SMTP_RCPT_TO_SED
SMTP_RCPT_TO_DECODE
SMTP_SENDMAIL_5_6_5_EXPLOIT
SMTP_SENDMAIL_8_6_10_EXPLOIT
SMTP_VRFY_DECODE
SMTP_VRFY_ROOT
SMTP_EHLO_CYBERCOP
SMTP_EXPN_CYBERCOP
SMTP_FROM_OVERFLOW
IMAP_LOGIN_LITERAL_OVERFLOW
IMAP_AUTHENTICATE_LITERAL_OVERFLOW
IMAP_AUTH_OVERFLOW_ATTEMPT
IMAP_LSUB_OVERFLOW_ATTEMPT
IMAP_LIST_LITERAL_OVERFLOW_ATTEMPT
IMAP_RENAME_LITERAL_OVERFLOW
IMAP_CREATE_LITERAL_OVERFLOW
POP3_BSD_EXPLOIT
POP3_BSD_EXPLOIT_2
POP3_LINUX_EXPLOIT
POP3_SCO_EXPLOIT
POP3_QPOPPER_EXPLOIT
HTTP_SQL_INSERT_INTO
DNS_EXPLOIT_NAMED
DNS_EXPLOIT_NAMED_TSIG
DNS_EXPLOIT_NAMED_TSIG_2
DNS_EXPLOIT_NAMED_OVERFLOW
DNS_EXPLOIT_NAMED_OVERFLOW_2
DNS_EXPLOIT_NAMED_OVERFLOW_3
DNS_EXPLOIT_X86_OVERFLOW
DNS_EXPLOIT_X86_OVERFLOW_2
DNS_EXPLOIT_X86_OVERFLOW_3
DNS_EXPLOIT_FREEBSD_OVERFLOW
DNS_EXPLOIT_SPARC_OVERFLOW
HTTP_IIS_CHUNKED_ENCODING
HTTP_FRONTPAGE_VTI_ADM
HTTP_WEBDAV_SEARCH_EXPLOIT
HTTP_SQL_COMMENTS_DASH
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HTTP_SQL_COMMENTS_C_1
HTTP_SQL_COMMENTS_C_2
HTTP_SQL_OR
HTTP_SQL_OR_2
HTTP_SQL_ONE_EQ_ONE
HTTP_SQL_ONE_EQ_ONE_2
HTTP_SQL_AND
HTTP_USERAGENT_KAZAA
HTTP_GNUTELLA_1
HTTP_GNUTELLA_2
HTTP_GNUTELLA_3
HTTP_GNUTELLA_4
FTP_EXPLOIT_OPENBSD
FTP_EXPLOIT_OVERFLOW
FTP_EXPLOIT_WUFTPD_SOLARIS
FTP_EXPLOIT_WUFTPD_FREEBSD
FTP_EXPLOIT_WUFTPD_LINUX
FTP_WUFTPD_FORMAT_STRING
FTP_WUFTPD_EXPLOIT
FTP_EXPLOIT_MKD_OVERFLOW
HTTP_IIS_NTLMASN1
HTTP_IIS_ISAPI_IDQ
HTTP_IIS_MSDAC
HTTP_EWAVE_SERVLET_2
HTTP_NESSUS_PROBE_2
HTTP_NESSUS_PROBE_3
HTTP_RBS_ISP
HTTP_WEBDAV_DELETE
HTTP_ORDER_LOG
HTTP_CGI_NPH_EXPLOITSCAN
HTTP_EMUMAIL_INIT
HTTP_EMUMAIL_FCGI
HTTP_CGI_ENVIRON_PL
HTTP_CGI_STATSCONFIG
HTTP_IIS_PING_ASP
SMTP_SENDMAIL_8_6_10_EXPLOIT_2
FTP_SERVU_LIST_OVERFLOW_EXPLOIT
IMAP_COURIER_LOGIN_FORMAT_STRING_ATTEMPT_1
IMAP_COURIER_LOGIN_FORMAT_STRING_ATTEMPT_2
IMAP_COURIER_LOGIN_FORMAT_STRING_ATTEMPT_3
IMAP_COURIER_LOGIN_FORMAT_STRING_ATTEMPT_SM00NY
HTTP_XSS_2
HTTP_P2P_ARES_1
HTTP_P2P_ARES_2
HTTP_CFM_JRUN_SOURCE_DISCLOSURE_1
HTTP_CFM_JRUN_SOURCE_DISCLOSURE_2
HTTP_CFM_JRUN_SOURCE_DISCLOSURE_3
HTTP_CFM_JRUN_SOURCE_DISCLOSURE_4
HTTP_IIS_NTFS_SOURCE_DISCLOSURE_1
HTTP_IIS_NTFS_SOURCE_DISCLOSURE_2
HTTP_IIS_NTFS_SOURCE_DISCLOSURE_3
HTTP_IIS_NTFS_SOURCE_DISCLOSURE_4
HTTP_IIS_NTFS_SOURCE_DISCLOSURE_5
HTTP_IIS_NTFS_SOURCE_DISCLOSURE_6
HTTP_IIS_NTFS_SOURCE_DISCLOSURE_7
HTTP_IIS_NTFS_SOURCE_DISCLOSURE_8
HTTP_IIS_NTFS_SOURCE_DISCLOSURE_9
HTTP_IIS_NTFS_SOURCE_DISCLOSURE_10
HTTP_IIS_NTFS_SOURCE_DISCLOSURE_11
HTTP_IIS_NTFS_SOURCE_DISCLOSURE_12
HTTP_IIS_NTFS_SOURCE_DISCLOSURE_13
HTTP_IIS_NTFS_SOURCE_DISCLOSURE_14
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HTTP_MAC_HFSPLUS
HTTP_PHP_BB_HIGHLIGHTING_CODE_EXEC
HTTP_PHP_BB_HIGHLIGHTING_SQL_INJECT
HTTP_PHP_BB_HIGHLIGHTING_FILE_XFER
HTTP_PHP_BB_HIGHLIGHTING_SYSTEM_1
HTTP_PHP_BB_HIGHLIGHTING_SYSTEM_2
HTTP_PHP_BB_HIGHLIGHTING_SYSTEM_3
HTTP_PHP_BB_HIGHLIGHTING_SYSTEM_4
HTTP_PHP_BB_HIGHLIGHTING_EXEC_1
HTTP_PHP_BB_HIGHLIGHTING_EXEC_2
HTTP_PHP_BB_HIGHLIGHTING_EXEC_3
HTTP_PHP_BB_HIGHLIGHTING_EXEC_4
HTTP_PHP_BB_HIGHLIGHTING_PASSTHRU_1
HTTP_PHP_BB_HIGHLIGHTING_PASSTHRU_2
HTTP_PHP_BB_HIGHLIGHTING_PASSTHRU_3
HTTP_PHP_BB_HIGHLIGHTING_PASSTHRU_4
HTTP_PHP_BB_HIGHLIGHTING_POPEN_1
HTTP_PHP_BB_HIGHLIGHTING_POPEN_2
HTTP_PHP_BB_HIGHLIGHTING_POPEN_3
HTTP_PHP_BB_HIGHLIGHTING_POPEN_4
HTTP_PHP_BB_HIGHLIGHTING_SHELL_EXEC_1
HTTP_PHP_BB_HIGHLIGHTING_SHELL_EXEC_2
HTTP_PHP_BB_HIGHLIGHTING_SHELL_EXEC_3
HTTP_PHP_BB_HIGHLIGHTING_SHELL_EXEC_4
HTTP_PHP_BB_HIGHLIGHTING_PROC_OPEN_1
HTTP_PHP_BB_HIGHLIGHTING_PROC_OPEN_2
HTTP_PHP_BB_HIGHLIGHTING_PROC_OPEN_3
HTTP_PHP_BB_HIGHLIGHTING_PROC_OPEN_4
HTTP_PHP_BB_HIGHLIGHTING_FOPEN_1
HTTP_PHP_BB_HIGHLIGHTING_FOPEN_2
HTTP_PHP_BB_HIGHLIGHTING_FOPEN_3
HTTP_PHP_BB_HIGHLIGHTING_FOPEN_4
HTTP_PHP_BB_HIGHLIGHTING_FWRITE_1
HTTP_PHP_BB_HIGHLIGHTING_FWRITE_2
HTTP_PHP_BB_HIGHLIGHTING_FWRITE_3
HTTP_PHP_BB_HIGHLIGHTING_FWRITE_4
HTTP_PHP_BB_HIGHLIGHTING_MYSQL_QUERY_1
HTTP_PHP_BB_HIGHLIGHTING_MYSQL_QUERY_2
HTTP_PHP_BB_HIGHLIGHTING_MYSQL_QUERY_3
HTTP_PHP_BB_HIGHLIGHTING_MYSQL_QUERY_4
HTTP_USERAGENT_SKYPE
HTTP_CGI_AWSTATS_PL_1
HTTP_CGI_AWSTATS_PL_2
HTTP_WINDOWS_SYSTEM_INI
HTTP_SQL_SELECT
HTTP_SQL_UPDATE
HTTP_SQL_FROM
HTTP_SQL_WHERE
HTTP_CGI_AWSTATS_PL_3
HTTP_CGI_EASYMSG_BOARD_PRINT
HTTP_IIS_KILL_BILL_EXPLOIT
HTTP_XMLRPC_CODE_EXEC
IMAP_MAILUTILS_FORMAT_STRING_ATTEMPT_1
IMAP_MAILUTILS_FORMAT_STRING_ATTEMPT_2
IMAP_MAILUTILS_FORMAT_STRING_ATTEMPT_3
HTTP_SUSPICIOUS_ECHO_IFS
HTTP_OPENVIEW_CONNECTEDNODE_PIPE_1
HTTP_OPENVIEW_CONNECTEDNODE_SCOLON_1
HTTP_OPENVIEW_CONNECTEDNODE_PIPE_2
HTTP_OPENVIEW_CONNECTEDNODE_SCOLON_2
HTTP_OPENVIEW_CONNECTEDNODE_PIPE_3
HTTP_OPENVIEW_CONNECTEDNODE_SCOLON_3
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HTTP_OPENVIEW_CONNECTEDNODE_PIPE_4
HTTP_OPENVIEW_CONNECTEDNODE_SCOLON_4
FTP_SITE_PIPE
HTTP_URL_SC_DEC_PEXFNSTENV
HTTP_URL_SC_DEC_COUNTDOWN
HTTP_URL_SC_DEC_PEX
HTTP_URL_SC_DEC_JMPCALLADDITIVE
HTTP_URL_SC_DEC_ALPHA_WIN32
HTTP_URL_SC_DEC_ALPHA_WIN32UP
HTTP_URL_SC_DEC_ALPHA_DEFAULT
HTTP_URL_SC_DEC_ALPHA_RESTRIC
HTTP_URL_SC_DEC_OSXPPCLONGXOR
HTTP_URL_SC_DEC_OSXPPCLONGXORTAG
HTTP_URL_SC_DEC_QUACKQUACK
HTTP_URL_SC_DEC_SPARC
HTTP_URL_SC_DEC_SIMPLEFNSTENV
HTTP_URL_SC_DEC_BYTEXORRANDTAG
HTTP_URL_SC_DEC_SIMPLEBYTEXOR
HTTP_HEADER_SC_DEC_PEXFNSTENV
HTTP_HEADER_SC_DEC_COUNTDOWN
HTTP_HEADER_SC_DEC_PEX
HTTP_HEADER_SC_DEC_JMPCALLADDITIVE
HTTP_HEADER_SC_DEC_ALPHA_WIN32
HTTP_HEADER_SC_DEC_ALPHA_WIN32UP
HTTP_HEADER_SC_DEC_ALPHA_DEFAULT
HTTP_HEADER_SC_DEC_ALPHA_RESTRIC
HTTP_HEADER_SC_DEC_OSXPPCLONGXOR
HTTP_HEADER_SC_DEC_OSXPPCLONGXORTAG
HTTP_HEADER_SC_DEC_QUACKQUACK
HTTP_HEADER_SC_DEC_SPARC
HTTP_HEADER_SC_DEC_SIMPLEFNSTENV
HTTP_HEADER_SC_DEC_BYTEXORRANDTAG
HTTP_HEADER_SC_DEC_SIMPLEBYTEXOR
FTP_PARAMETER_SC_DEC_PEXFNSTENV
FTP_PARAMETER_SC_DEC_COUNTDOWN
FTP_PARAMETER_SC_DEC_PEX
FTP_PARAMETER_SC_DEC_JMPCALLADDITIVE
FTP_PARAMETER_SC_DEC_ALPHA_WIN32
FTP_PARAMETER_SC_DEC_ALPHA_WIN32UP
FTP_PARAMETER_SC_DEC_ALPHA_DEFAULT
FTP_PARAMETER_SC_DEC_ALPHA_RESTRIC
FTP_PARAMETER_SC_DEC_OSXPPCLONGXOR
FTP_PARAMETER_SC_DEC_OSXPPCLONGXORTAG
FTP_PARAMETER_SC_DEC_QUACKQUACK
FTP_PARAMETER_SC_DEC_SPARC
FTP_PARAMETER_SC_DEC_SIMPLEFNSTENV
FTP_PARAMETER_SC_DEC_BYTEXORRANDTAG
FTP_PARAMETER_SC_DEC_SIMPLEBYTEXOR
SMTP_PARAMETER_SC_DEC_PEXFNSTENV
SMTP_PARAMETER_SC_DEC_COUNTDOWN
SMTP_PARAMETER_SC_DEC_PEX
SMTP_PARAMETER_SC_DEC_JMPCALLADDITIVE
SMTP_PARAMETER_SC_DEC_ALPHA_WIN32
SMTP_PARAMETER_SC_DEC_ALPHA_WIN32UP
SMTP_PARAMETER_SC_DEC_ALPHA_DEFAULT
SMTP_PARAMETER_SC_DEC_ALPHA_RESTRIC
SMTP_PARAMETER_SC_DEC_OSXPPCLONGXOR
SMTP_PARAMETER_SC_DEC_OSXPPCLONGXORTAG
SMTP_PARAMETER_SC_DEC_QUACKQUACK
SMTP_PARAMETER_SC_DEC_SPARC
SMTP_PARAMETER_SC_DEC_SIMPLEFNSTENV
SMTP_PARAMETER_SC_DEC_BYTEXORRANDTAG
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SMTP_PARAMETER_SC_DEC_SIMPLEBYTEXOR
POP3_PARAMETER_SC_DEC_PEXFNSTENV
POP3_PARAMETER_SC_DEC_COUNTDOWN
POP3_PARAMETER_SC_DEC_PEX
POP3_PARAMETER_SC_DEC_JMPCALLADDITIVE
POP3_PARAMETER_SC_DEC_ALPHA_WIN32
POP3_PARAMETER_SC_DEC_ALPHA_WIN32UP
POP3_PARAMETER_SC_DEC_ALPHA_DEFAULT
POP3_PARAMETER_SC_DEC_ALPHA_RESTRIC
POP3_PARAMETER_SC_DEC_OSXPPCLONGXOR
POP3_PARAMETER_SC_DEC_OSXPPCLONGXORTAG
POP3_PARAMETER_SC_DEC_QUACKQUACK
POP3_PARAMETER_SC_DEC_SPARC
POP3_PARAMETER_SC_DEC_SIMPLEFNSTENV
POP3_PARAMETER_SC_DEC_BYTEXORRANDTAG
POP3_PARAMETER_SC_DEC_SIMPLEBYTEXOR
IMAP4_PARAMETER_SC_DEC_PEXFNSTENV
IMAP4_PARAMETER_SC_DEC_COUNTDOWN
IMAP4_PARAMETER_SC_DEC_PEX
IMAP4_PARAMETER_SC_DEC_JMPCALLADDITIVE
IMAP4_PARAMETER_SC_DEC_ALPHA_WIN32
IMAP4_PARAMETER_SC_DEC_ALPHA_WIN32UP
IMAP4_PARAMETER_SC_DEC_ALPHA_DEFAULT
IMAP4_PARAMETER_SC_DEC_ALPHA_RESTRIC
IMAP4_PARAMETER_SC_DEC_OSXPPCLONGXOR
IMAP4_PARAMETER_SC_DEC_OSXPPCLONGXORTAG
IMAP4_PARAMETER_SC_DEC_QUACKQUACK
IMAP4_PARAMETER_SC_DEC_SPARC
IMAP4_PARAMETER_SC_DEC_SIMPLEFNSTENV
IMAP4_PARAMETER_SC_DEC_BYTEXORRANDTAG
IMAP4_PARAMETER_SC_DEC_SIMPLEBYTEXOR
SIP_REQUEST_SC_DEC_PEXFNSTENV
SIP_REQUEST_SC_DEC_COUNTDOWN
SIP_REQUEST_SC_DEC_PEX
SIP_REQUEST_SC_DEC_JMPCALLADDITIVE
SIP_REQUEST_SC_DEC_ALPHA_WIN32
SIP_REQUEST_SC_DEC_ALPHA_WIN32UP
SIP_REQUEST_SC_DEC_ALPHA_DEFAULT
SIP_REQUEST_SC_DEC_ALPHA_RESTRIC
SIP_REQUEST_SC_DEC_OSXPPCLONGXOR
SIP_REQUEST_SC_DEC_OSXPPCLONGXORTAG
SIP_REQUEST_SC_DEC_QUACKQUACK
SIP_REQUEST_SC_DEC_SPARC
SIP_REQUEST_SC_DEC_SIMPLEFNSTENV
SIP_REQUEST_SC_DEC_BYTEXORRANDTAG
SIP_REQUEST_SC_DEC_SIMPLEBYTEXOR
SIP_HEADER_SC_DEC_PEXFNSTENV
SIP_HEADER_SC_DEC_COUNTDOWN
SIP_HEADER_SC_DEC_PEX
SIP_HEADER_SC_DEC_JMPCALLADDITIVE
SIP_HEADER_SC_DEC_ALPHA_WIN32
SIP_HEADER_SC_DEC_ALPHA_WIN32UP
SIP_HEADER_SC_DEC_ALPHA_DEFAULT
SIP_HEADER_SC_DEC_ALPHA_RESTRIC
SIP_HEADER_SC_DEC_OSXPPCLONGXOR
SIP_HEADER_SC_DEC_OSXPPCLONGXORTAG
SIP_HEADER_SC_DEC_QUACKQUACK
SIP_HEADER_SC_DEC_SPARC
SIP_HEADER_SC_DEC_SIMPLEFNSTENV
SIP_HEADER_SC_DEC_BYTEXORRANDTAG
SIP_HEADER_SC_DEC_SIMPLEBYTEXOR
SDP_LINE_SC_DEC_PEXFNSTENV
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SDP_LINE_SC_DEC_COUNTDOWN
SDP_LINE_SC_DEC_PEX
SDP_LINE_SC_DEC_JMPCALLADDITIVE
SDP_LINE_SC_DEC_ALPHA_WIN32
SDP_LINE_SC_DEC_ALPHA_WIN32UP
SDP_LINE_SC_DEC_ALPHA_DEFAULT
SDP_LINE_SC_DEC_ALPHA_RESTRIC
SDP_LINE_SC_DEC_OSXPPCLONGXOR
SDP_LINE_SC_DEC_OSXPPCLONGXORTAG
SDP_LINE_SC_DEC_QUACKQUACK
SDP_LINE_SC_DEC_SPARC
SDP_LINE_SC_DEC_SIMPLEFNSTENV
SDP_LINE_SC_DEC_BYTEXORRANDTAG
SDP_LINE_SC_DEC_SIMPLEBYTEXOR
HTTP_PHP_HORDE_HELP
TCP_SKYPE_OVER_HTTPS
HTTP_PHP_GLOBALS_OVERWRITE_1
HTTP_PHP_GLOBALS_OVERWRITE_2
HTTP_SUPER_PROXY_SCANNER_1
HTTP_SUPER_PROXY_SCANNER_2
HTTP_AWSTATS_MIGRATE_CMDEXEC_1
HTTP_AWSTATS_MIGRATE_CMDEXEC_2
HTTP_MOD_REWRITE_LDAP_OFFBYONE
HTTP_APACHE_CGIBIN_CASE_1
HTTP_APACHE_CGIBIN_CASE_2
HTTP_APACHE_CGIBIN_CASE_3
HTTP_APACHE_CGIBIN_CASE_4
HTTP_APACHE_CGIBIN_CASE_5
HTTP_APACHE_CGIBIN_CASE_6
HTTP_APACHE_CGIBIN_CASE_7
HTTP_APACHE_CGIBIN_CASE_8
HTTP_APACHE_CGIBIN_CASE_9
HTTP_APACHE_CGIBIN_CASE_10
HTTP_APACHE_CGIBIN_CASE_11
HTTP_APACHE_CGIBIN_CASE_12
HTTP_APACHE_CGIBIN_CASE_13
HTTP_APACHE_CGIBIN_CASE_14
HTTP_APACHE_CGIBIN_CASE_15
HTTP_APACHE_CGIBIN_CASE_16
HTTP_APACHE_CGIBIN_CASE_17
HTTP_APACHE_CGIBIN_CASE_18
HTTP_APACHE_CGIBIN_CASE_19
HTTP_APACHE_CGIBIN_CASE_20
HTTP_APACHE_CGIBIN_CASE_21
HTTP_APACHE_CGIBIN_CASE_22
HTTP_APACHE_CGIBIN_CASE_23
HTTP_APACHE_CGIBIN_CASE_24
HTTP_APACHE_CGIBIN_CASE_25
HTTP_APACHE_CGIBIN_CASE_26
HTTP_APACHE_CGIBIN_CASE_27
HTTP_APACHE_CGIBIN_CASE_28
HTTP_APACHE_CGIBIN_CASE_29
HTTP_APACHE_CGIBIN_CASE_30
HTTP_APACHE_CGIBIN_CASE_31
HTTP_APACHE_CGIBIN_CASE_32
HTTP_APACHE_CGIBIN_CASE_33
HTTP_APACHE_CGIBIN_CASE_34
HTTP_APACHE_CGIBIN_CASE_35
HTTP_APACHE_CGIBIN_CASE_36
HTTP_APACHE_CGIBIN_CASE_37
HTTP_APACHE_CGIBIN_CASE_38
HTTP_APACHE_CGIBIN_CASE_39

| IDPS signatures

Appendix F. Types of logs

1019
1020
1021
1022
1023
1024
1025
1026
1027
1028
1029
1030
1031
1032
1033
1034
1035
1036
1037
1038
1039
1040
1041
1042
1043
1044
1045
1046
1047
1048
1049
1050
1051
1052
1053
1054
1055
1056
1057
1058
1059
1060
1061
1062
1063
1064
1065
1066
1067
1068
1069
1070
1071
1072
1073
1074
1075
1076
1077
1078
1079
1080

HTTP_APACHE_CGIBIN_CASE_40
HTTP_APACHE_CGIBIN_CASE_41
HTTP_APACHE_CGIBIN_CASE_42
HTTP_APACHE_CGIBIN_CASE_43
HTTP_APACHE_CGIBIN_CASE_44
HTTP_APACHE_CGIBIN_CASE_45
HTTP_APACHE_CGIBIN_CASE_46
HTTP_APACHE_CGIBIN_CASE_47
HTTP_APACHE_CGIBIN_CASE_48
HTTP_APACHE_CGIBIN_CASE_49
HTTP_APACHE_CGIBIN_CASE_50
HTTP_APACHE_CGIBIN_CASE_51
HTTP_APACHE_CGIBIN_CASE_52
HTTP_APACHE_CGIBIN_CASE_53
HTTP_APACHE_CGIBIN_CASE_54
HTTP_APACHE_CGIBIN_CASE_55
HTTP_APACHE_CGIBIN_CASE_56
HTTP_APACHE_CGIBIN_CASE_57
HTTP_APACHE_CGIBIN_CASE_58
HTTP_APACHE_CGIBIN_CASE_59
HTTP_APACHE_CGIBIN_CASE_60
HTTP_APACHE_CGIBIN_CASE_61
HTTP_APACHE_CGIBIN_CASE_62
HTTP_APACHE_CGIBIN_CASE_63
HTTP_UTF7_XSS_1
HTTP_UTF7_XSS_2
HTTP_UTF7_XSS_3
HTTP_UTF7_XSS_4
DNS_EXPLOIT_WIN_NAT_HELPER
HTTP_IM_MSN_SERVER
HTTP_IM_WEBMESSENGER_SERVER
HTTP_IM_WEBMESSENGER_HOST
HTTP_IM_GOOGLETALK_UA
HTTP_IM_GOOGLETALK_HOST
HTTP_IM_YAHOO_SHTTP_HOST
HTTP_IM_AIM_KDC_UAS_HOST
HTTP_IM_AIM_MY_SCREENNAME_HOST
HTTP_IM_AIM_EXPRESS_HOST
HTTP_IM_ICQ_PROXY_HOST
HTTP_IM_ICQ_SERVER_AIM
HTTP_IM_ICQ_CTYPE_AIM
TLS_IM_AIM_KDC_UAS_DN
TLS_IM_AIM_MY_SCREENNAME_DN
TLS_IM_ICQ_DN
HTTP_RANGE_HDR_ABUSE
HTTP_JS_ABOUT_CACHE_ENTRY
HTTP_XSS_VB
HTTP_XSS_VB_HTML
HTTP_XSS_VB_UTF7_1
HTTP_XSS_VB_UTF7_2
HTTP_XSS_VB_UTF7_3
HTTP_XSS_VB_UTF7_4
HTTP_XSS_JAVASCRIPT
HTTP_XSS_JAVASCRIPT_HTML
HTTP_XSS_JAVASCRIPT_UTF7_1
HTTP_XSS_JAVASCRIPT_UTF7_2
HTTP_XSS_JAVASCRIPT_UTF7_3
HTTP_XSS_JAVASCRIPT_UTF7_4
HTTP_VLC_CONNECTION
HTTP_SQL_DECLARE
HTTP_SQL_FETCH_NEXT_FROM
HTTP_SQL_CLOSE
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HTTP_SQL_DEALLOCATE
HTTP_SQL_VARCHAR
HTTP_SQL_HAVING
HTTP_SQL_GROUPBY
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